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Chapter 1

Introduction

What is HyperChem?

HyperChem® is a molecular modeling and simulation program 
that lets you perform complex chemical calculations. 

Use the Glossary at the back of this book to look up terms and con-
cepts you might be unfamiliar with. Use the master index to find 
subjects in Getting Started, Computational Chemistry, and the Hyper-
Chem for Windows Reference Manual. 

HyperChem includes these functions:

• Drawing molecules from atoms and converting them to three-
dimensional (3D) models

• Constructing proteins and nucleic acids from standard resi-
dues

• Using molecules from other sources; for example, Brookhaven 
Protein Data Bank (PDB) files

• Rearranging molecules by, for example, rotating and translat-
ing them

• Changing display conditions, including stereo viewing, ren-
dering models, and structural labels

• Setting up and directing chemical calculations, including 
molecular dynamics, by various molecular mechanical or ab 
initio or semi-empirical quantum mechanics methods

• Determination of isotope effects in vibrational analysis calcu-
lations for semi-empirical and ab initio SCF methods

• Graphing the results of chemical calculations

• Solvating molecules in a periodic box
1



What is HyperChem?
HyperChem: Summary of Major Functions
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Starting HyperChem
Calculation Methods

HyperChem provides these methods for chemical calculations:

• MM+, AMBER, BIO+, and OPLS force fields for molecular 
mechanics calculations

• Extended Hückel, CNDO, INDO, MINDO3, MNDO, AM1, 
PM3, ZINDO/1 and ZINDO/S semi-empirical, and ab initio, 
quantum mechanics calculations

HyperChem can mix molecular mechanics and semi-empirical or 
ab initio (quantum mechanics) calculations for a molecular system. 
You can use these two types of methods on selected portions of the 
same molecule.

Starting HyperChem

To start HyperChem:

1. Start Windows or Windows 95 or Windows NT if you have not 
already done so.

2. If you are using Windows or Windows NT, position the mouse 
pointer on the Windows Applications icon and double-click 
the left mouse button. A new window appears containing the 
HyperChem Program icon, labeled HyperChem. Double-click 
on the HyperChem icon. A HyperChem window appears.

double-click to see
HyperChem program 
icon
Introduction 3



HyperChem Windows
3. If you are using Windows 95, position the mouse pointer on 
the tool bar, and click on “Start”. Move or drag the mouse 
pointer across “Programs”, “HyperChem50”, and “Hyper-
Chem”. If you have dragged the mouse, HyperChem will start; 
if you have moved the mouse without holding down the 
mouse button, you will need to click on “HyperChem” to start 
the program.

Note: HyperChem can take a file name as a command line argu-
ment. If the file has extension HIN or ENT, HyperChem will read 
the molecular system in HIN or PDB format respectively (see 
“Open” on page 52). If the file has the extension SCR, then Hyper-
Chem will run the file as a script file (see “Open Script” on page 
75).

If you have a file of script commands named chem.scr in the 
HyperChem directory, it will be executed automatically when 
HyperChem starts.

HyperChem Windows

HyperChem works with Microsoft Windows™, Version 3.1, Win-
dows for Workgroups™, Version 3.11, Windows 95™, and Win-
dows NT™ 3.51 for Intel machines, and follows the rules for a 

click to start
HyperChem program
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HyperChem Windows
Windows application. See the Microsoft Windows User’s Guide for 
information about Windows organization and operation.

When you start HyperChem, you see an empty HyperChem win-
dow. A typical window looks like this:

Control-menu 
button

Double-click on this box to close the window. 
Click to see the Control menu, containing items to 
let you move or reorganize the window you are 
using. You can also do most of these tasks by using 
the mouse on other parts of the window.

Title bar Shows HyperChem plus the filename of the molec-
ular system in the workspace. If there is more than 
one HyperChem window, the title bar of the active 
window has a distinct color. (The color depends on 
your choice in the Windows Control Panel.)

Minimize 
button

L-click to reduce the window to an icon.

Maximize 
button

L-click to enlarge the window to fill the whole 
screen. Once selected, this button turns into a 
Restore button, which returns the window to its 
previous size.

tool icons

menu bar

window 
border

title bar

status line

mouse pointer
workspace

Control-menu button minimize button
maximize/restore button

toolbar icons

Exit 
button

current calculation method
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HyperChem Windows
Exit button Click to exit HyperChem. You can also exit 
HyperChem from the File menu item.

Restore 
button

L-click to reduce a window from full-screen size to 
fill part of the screen. This button appears only 
after you use the Maximize button.

Menu bar Shows the names of available pull-down menus. 
L-click on a menu name to pull down the menu.

Tool icons Controls the HyperChem tools for drawing, select-
ing, and moving molecules, and for zooming and 
setting the clipping slab. A setting in the Hyper-
Chem initialization file can toggle a shaded 
appearance for these icons.

Toolbar icons These buttons provide shortcuts for menu items 
such as file opening and saving, cutting and past-
ing, etc.

Workspace Contains the molecular system you work on.

Mouse 
pointer

The mouse cursor for choosing menu items, choos-
ing and operating tools, and working with win-
dows. When you move this cursor into the work-
space, it looks like a HyperChem tool.

Status line Shows the function of menu items and the results 
of selections and calculations.

Window
border

To change the size of a window, place the mouse 
pointer on this border, L-click and hold down the 
button, and then drag. Different parts of the bor-
der provide different types of size adjustments. The 
border for the active window has a distinct color; 
for example, a gray window border signifies that 
the window is active, and a white border that it is 
inactive.

Note: For improved legibility, 3D shading has been turned off for 
some of the tool icons and dialog boxes shown in this manual. The 
appearance of tool icons and dialog boxes is controlled by the 
Look3D setting in your Registry or chem.ini file (see “Default Set-
tings in Registry or Chem.ini” on page 541).
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Using the Mouse
Using Multiple Windows

You can have several HyperChem windows on screen at once.

To start another HyperChem window:

1. If the HyperChem window is filling the screen, L-click on the 
Minimize or the Restore button in the active HyperChem win-
dow. 

The Minimize button reduces the window to an icon named 
HyperChem - [FILENAME]. The Restore button reduces the win-
dow to a smaller window. In either case, the window is smaller 
but still active.

2. Follow the original instructions for starting HyperChem to 
open a new window named HyperChem - [untitled].

3. Double-click on the original HyperChem icon or window to 
expand it.

Only one HyperChem window is active at a time. 

4. L-click anywhere on the window to activate it. 

Warning: If you are using a network licensed version of Hyper-
Chem, you must have sufficient licenses to open multiple Hyper-
Chem windows. 

Each HyperChem window can contain a different molecular sys-
tem and have different preference settings (see “Preferences” on 
page 65), display conditions (see “Display Menu” on page 155), 
and computational choices.

Using the Mouse

You can move the mouse cursor and HyperChem tools by moving 
the mouse. Outside the HyperChem workspace, the cursor 
becomes a mouse cursor and looks like an arrowhead. Inside the 
workspace, the cursor becomes a HyperChem tool and looks like 
one of the following tool icons (see chapter 3, “Tools”):
Introduction 7



Using the Mouse
Use a mouse for these tasks:

• Drawing, selecting, or moving molecules

• Choosing items on the menu bar

• Choosing options in dialog boxes

• Editing text in dialog boxes

To use the mouse with menus and dialog boxes, follow standard 
procedures for Microsoft Windows or Windows 95 or Windows 
NT; you can learn about these procedures from the Microsoft Win-
dows User’s Guide. 

Drawing tool

Selection tool

XY rotation tool

Z rotation tool

XY translation tool

Z translation tool

Zoom tool

Z clipping tool

mouse pointer

text cursor
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Using the Mouse
To use the mouse with HyperChem, first position the cursor on a 
molecular structure or icon. Then use one of the following proce-
dures, depending on the task:

Procedure How to do it What it does

L-click
R-click

Press and release the left or 
right mouse button

Do this to choose 
menu items and 
options in dialog 
boxes, and to select 
atoms. L-click and R-
click have opposite 
effects when using 
tools, for example, 
when selecting and 
deselecting atoms

L-drag
R-drag

Press and hold down a mouse 
button (left or right), and then 
move the mouse to perform an 
operation; release the mouse 
button to complete the opera-
tion

Use L-drag to choose 
menu items and 
text, to select atoms, 
and to draw mole-
cules (with the 
Drawing tool). 
Use R-drag to dese-
lect atoms or to 
move molecules in 
the Molecular Coor-
dinate System

LR-drag 
RL-drag

Hold down both mouse but-
tons, but press the left first. 
RL-drag reverses the order of 
holding down the mouse but-
tons. With both mouse buttons 
held down, move the mouse to 
adjust the size of a selection 
rectangle or circle (see “Select 
Sphere and Group Selecting” 
on page 139). Then release 
both mouse buttons

Use LR-drag to select 
groups of atoms; use 
RL-drag to deselect a 
group of atoms
Introduction 9



Using Keyboard Alternatives for Windows
Using Keyboard Alternatives for Windows

Microsoft Windows provides keyboard alternatives to using the 
mouse. The keyboard might be easier and faster for some users. Use 
these standard Windows procedures to open menus, to choose 
menu items, or to choose options in dialog boxes:

Opening a 
menu

Press [Alt], then the key corresponding to the under-
lined letter in the menu name. For example, to 
open the Select menu, press [Alt] and then [S].

Closing a 
menu

Press [Esc].

Choosing a 
menu item

Press the key corresponding to the underlined let-
ter. For example, for Open, press [O].

[Shift]+L-click 
[Shift]+R-click

Hold down [Shift] while you 
press and release the left or 
right mouse button

Use this for chang-
ing chirality (with 
the Drawing tool) or 
stepwise operation 
of the HyperChem 
tools (see chapter 3, 
“Tools”). The left 
button moves all 
molecules, and the 
right button moves 
selected molecules

Double-click Press and release the left mouse 
button twice rapidly

This is usually a 
shortcut for a com-
mon operation. In 
some dialog boxes, 
double-click on the 
option instead of L-
clicking on an option 
and then on OK. 
Double-clicking on 
a bond with the 
Drawing tool cre-
ates an aromatic 
bond

Procedure How to do it What it does
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Using Keyboard Alternatives for HyperChem
Closing a 
dialog box

Press [7] to close a dialog box and to accept the 
choices you made. This usually corresponds to 
L-clicking on OK.

Choosing a 
dialog box 
option

Press the key corresponding to the underlined let-
ter. For example, for No, press [N].

Moving
within a 
dialog box 

Press [Tab] to move between sections of a dialog 
box.

Moving 
through 
a list 

Press the [4] and [3] keys. The list can be a scroll box 
containing filenames or a set of check boxes or but-
tons. 

Checking a
box 

Press [Spacebar] to place an 3 in a check box or to 
remove an 3. You find these check boxes in dialog 
boxes. Checking a box turns on an option.

Using Keyboard Alternatives for HyperChem

HyperChem has special keyboard shortcuts for using HyperChem 
tools; see “Keyboard Equivalents for Tools” on page 48. 

You can also use these keys for HyperChem functions:

Keys Function Description

[F1] Help Shows the Help contents or, if you high-
lighted a menu item or have a dialog box 
active, the Help for that menu item or 
dialog box.

[Shift]+ [F1] Help Shows context-sensitive Help. If no menu 
or dialog is active this will change the cur-
sor to the Help cursor. You click on a Tool 
icon, menu item or other part of the 
HyperChem window for Help on that 
topic.

[Alt]+[F4] Exit Duplicates Exit on the File menu
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Using Keyboard Alternatives for HyperChem
[Ctrl]+[N] New Clears the HyperChem workspace. This 
duplicates New on the File menu.

[Ctrl]+[O] Open Presents the Open File dialog box to read 
in a molecular system stored in a file. This 
duplicates Open on the File menu.

[Ctrl]+[S] Save Presents the Save File dialog box for stor-
ing a molecular system in a file. This 
duplicates Save on the File menu.

[Ctrl]+ [A] Save As Presents the Save File dialog box for stor-
ing a molecular system in a file. This 
duplicates Save As on the File menu.

[Del] Clear Removes selected atoms from the work-
space. This duplicates Clear on the Edit 
menu. You cannot recover these atoms 
from the Clipboard.

[Ctrl]+ [X] Cut Transfers selected atoms from the work-
space to the Clipboard. This duplicates 
Cut on the Edit menu.

[Ctrl]+ [C] Copy Copies selected atoms from the work-
space to the Clipboard. This duplicates 
Copy on the Edit menu.

[Ctrl]+ [V] Paste Copies selected atoms from the Clip-
board to the workspace. This duplicates 
Paste on the Edit menu.

[F9] Copy Image Places a picture of all or part of the moni-
tor screen in a file or on the Windows 
Clipboard. [F9] duplicates functions of 
Copy Image on the Edit menu, and lets 
you save images of the workspace, pull-
down menus, and dialog boxes. Use 
Setup Image on the Edit menu to tell 
HyperChem how [F9] should work.

[Esc] Cancel Duplicates Cancel on the menu bar. Stops 
a calculation or reading of a large file. 

Keys Function Description
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HyperChem Menus
HyperChem Menus

You select HyperChem commands and settings from pull-down 
menus on the menu bar above the workspace. When you highlight 
a menu item, a description of that item and its action appears on 
the status line (see “HyperChem Windows” on page 4).

Use menu items to set HyperChem conditions (like the type of 
labels on atoms) and to start HyperChem procedures and calcula-
tions. Menu items work as follows:

• Menu items with ellipsis points, such as Select... on the Select 
menu, open dialog boxes with buttons, text fields, and check 
boxes for making choices.

• Some menu items turn on or off (toggle) a condition. Turning 
on a menu item places a check mark (3) to the left of the item. 
The condition remains on until you select the same item again 
or, in some cases, select an alternative item.

Turning on a menu item can have an immediate effect on a 
molecular system. For example, Show Hydrogens on the Dis-
play menu shows hydrogens for the molecules in the work-
space and for all molecules that you later draw. Other items, 
such as Explicit Hydrogens on the Build menu, change the way 
the Drawing tool works, but do not affect existing molecules.

[Spacebar] Scale to Fit Duplicates Scale to Fit on the Display 
menu (see page 157). This brings the 
molecular system or selected atoms to 
the center of the screen so that they fit in 
the workspace. This is useful after you 
move molecules with a Translation tool or 
the Zoom tool.
Also sets the clipping planes for Z clip-
ping and adjusts the y axis of the data 
plot in the Molecular Dynamics Results 
dialog box.

Keys Function Description
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HyperChem Dialog Boxes
Gray Menu Items

HyperChem changes gray menu items to black to show that the 
item is available. You must satisfy a condition to activate this type 
of menu item. For example, Invert on the Edit menu is gray until 
you select atoms and give the selection the predefined name 
POINT. This activates Invert (and changes it from gray to black) so 
that you can invert the molecule.

HyperChem Dialog Boxes

Choosing most menu items displays a dialog box for entering 
information, choosing options, or starting a HyperChem function. 
Choosing some dialog boxes displays additional dialog boxes. 
Message dialog boxes appear showing warning or error conditions. 

You can change the position of a dialog box by placing the mouse 
cursor on its title bar and L-dragging it anywhere on screen. 

HyperChem has two ways of removing a dialog box when you 
have finished with it:

• To close a dialog box without using new settings, L-click on 
Cancel or click on the Exit button in the upper-right corner of 
the dialog box. 

• To close a dialog box and accept new settings or to start a cal-
culation, L-click on OK or Proceed in the dialog box.

Most dialog boxes temporarily inactivate HyperChem menus and 
tools. When you close the dialog box, HyperChem regains its full 
capabilities. Persistent dialog boxes (see the next section) are an 
exception to this rule.

Note: You can control whether HyperChem dialog boxes are gray 
with three-dimensional shading or not by changing a setting in 

click exit button to 
close dialog box and 
cancel new settings

closes dialog box and 
uses new settings

closes dialog box and 
cancels new settings
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HyperChem Dialog Boxes
the HyperChem initialization data (for details see “Default Settings 
in Registry or Chem.ini” on page 541). In this manual dialog boxes 
are shown without three dimensional shading.

Persistent Dialog Boxes

The Default Element, Amino Acids, Nucleic Acids, and Ab Initio 
dialog box es are persistent. You can leave these dialog boxes on 
screen and still use HyperChem menus and tools. When you have 
finished using one of these dialog boxes, double-click on the Con-
trol-menu box to remove it. The structure remains in the work-
space.

Working in Dialog Boxes

HyperChem dialog boxes contain these standard Windows com-
ponents:

• Buttons and check boxes. L-click to choose the items associ-
ated with a button or check box. The center of a button turns 
black and a 3 appears in a check box. These remain activated 
until you L-click again. 

• Lists with scroll bars. L-click on a list item. A highlight (black 
background) appears and the text turns white. If the list is 
longer than the list box, a scroll bar appears on the right to let 
you move through the list.

• Text boxes. You can enter information into text boxes. See the 
procedures in the next section.

Editing Text

HyperChem dialog boxes contain text boxes for entering text or 
numbers. Follow these rules:

• L-click with the text cursor (I-shaped) anywhere in the text to 
move the insertion point (a vertical, flashing bar).

• L-drag the text cursor to select text that you want to delete or 
replace.

• To delete text, select it and press [Delete] or [Backspace].
Introduction 15



HyperChem Dialog Boxes
• To replace text, select it and start entering new text. 

Editing Keys

You can use these keys for editing:

[Enter] Moves the insertion point to a new line.

[Backspace] Erases the character (or selected text) to the left of 
the insertion point.

[Delete][Del] Erases the character (or selected text) to the right of 
the insertion point. 

[4] [3]
[1] [2]

Moves the insertion point.

Case Preferences

For filenames, upper- and lowercase letters are equivalent. For 
example, HyperChem recognizes molecule.hin and Molecule.HIN 
as the same filename. 

Entering Exponents

When entering numbers, use this format for scientific notation 
(exponents): Yx10N = YeN. 

For example, for 1.05x104, enter 1.05e4. HyperChem warns you 
about numbers that are out of range or in the wrong format.
16 Chapter 1



Chapter 2

The Basics of HyperChem

Levels of Molecular Organization

HyperChem uses four levels of molecular organization. It is impor-
tant to understand these levels:

Atoms Single atoms, either free or in a chemical com-
pound. The HyperChem Drawing tool (see “Draw-
ing Molecules” on page 29) creates atoms and 
bonds between them.

Residues Groups of bonded atoms, such as amino acid or 
nucleic acid subunits of a protein or polynucle-
otide. Residues come only from database files or 
HyperChem Input (HIN) files. HyperChem sup-
plies database files of amino acid and nucleic acid 
residues (see “Databases Menu” on page 98). Pro-
teins and polynucleotides from PDB files (see page 
319) are also composed of residues. Water mole-
cules in either a periodic box or from a PDB file are 
residues. They show the residue labels HOH or 
WAT.

Residues have these properties:

• They have standard structures.

• Their atoms may have partial charges.

• You can select them with the Selection tool in 
the residues mode.

• You can add labels characteristic of residues 
(see “Labels” on page 176).

Amino acids or nucleotides that you construct 

from atoms do not have these properties. 
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Coordinate Systems
Molecules A molecule is composed of covalently bonded 
atoms or residues. You can create molecules with 
the Drawing tool, construct polymers by using the 
Databases menu, or display molecules stored in a 
HIN or PDB file (see “Protein Data Bank Files” on 
page 319 and “HIN Files” on page 515). 
HyperChem does not have a fixed limit on struc-
ture size. However, the memory capacity or speed 
of your computer might impose practical limits on 
the size of molecule you can draw.

Molecular 
System

A molecular system is one or more molecules dis-
played in the HyperChem workspace or stored in a 
file. 

Coordinate Systems

HyperChem has two coordinate systems for displaying molecules: 
the Viewer's Coordinate System and the Molecular Coordinate Sys-
tem. Each coordinate system has x, y, and z Cartesian axes. 
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Coordinate Systems
Each molecular system also has its own internal axes, called iner-
tial axes (primary, secondary, and tertiary). These axes are fixed in 
the Molecular Coordinate System.

Viewer’s Coordinate System

The Viewer’s Coordinate System defines the positions of atoms rel-
ative to you, the viewer. The Viewer’s Coordinate System is fixed 
by the screen geometry. The y axis is vertical, the x axis is horizon-
tal, and the z axis is perpendicular to the plane of the screen. 

In the Viewer’s Coordinate System, you can move molecules with-
out changing their atomic coordinates. With HyperChem tools, 
use the left mouse button to move molecules in the Viewer’s Coor-
dinate System. Molecules move as if you were changing your view-
point and moving past the molecules. This works only for whole 
molecular systems. 

With some HyperChem dialog boxes, like Align Viewer, move-
ment is automatically in the Viewer’s Coordinate System if there 
are no selected atoms.

When you first create a molecule, HyperChem aligns the Viewer’s 
and the Molecular Coordinate System so that the x, y, and z axes 
correspond. As you move molecules, the coordinate systems might 
lose this correspondence. Use Align Viewer on the Edit menu (see 
page 127) to move the Viewer’s Coordinate System so that it once 
again corresponds to the Molecular Coordinate System.

When you save a molecular system in a HIN file, HyperChem 
includes information about the Viewer’s Coordinate System (see 
“view” on page 518). Opening a file restores the previous view of 
the molecular system stored in the file.

Molecular Coordinate System

The Molecular Coordinate System is attached to a molecular sys-
tem and determines its atomic coordinates, which are the coordi-
nates used in all HyperChem chemical calculations. 

You can determine the molecular coordinates of any atom by 
selecting the atom (see “Measuring with the Selection Tool” on 
page 35). The coordinates appear in the status line.
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Inertial Axes
With HyperChem tools, you move the atoms in the Molecular 
Coordinate System by using the right mouse button. This works 
only for selected atoms, residues, and molecules. This table sum-
marizes the right mouse button functions:

With some HyperChem dialog boxes, like Align Molecules, move-
ment is automatically in the Molecular Coordinate System.

Inertial Axes

For either selected atoms or whole molecular systems, HyperChem 
can calculate the moments of inertia and inertial axes. Hyper-
Chem reports the moments of inertia on the status line and dis-
plays the inertial axes as dotted white lines, fixed in the Molecular 
Coordinate System. These three moments and axes (primary, sec-
ondary, and tertiary axes) are functions of the location and mass 
of atoms. The inertial axes belong to a molecular system and are 
independent of the Viewer’s or Molecular Coordinate System.

Turn on Show Axes (✓) on the Display menu to show the inertial 
axes. These are orthogonal and are numbered 1, 2, and 3, for pri-
mary, secondary, and tertiary axes respectively. The axes remain in 
the workspace until you turn off Show Axes (no check mark).

The primary inertial axis usually marks the longest distance 
through a molecular system, and the tertiary axis marks the short-
est distance.

a. Right button function is limited to whole molecules if Whole molecule 
translation is on (✓) in the Tool Preferences dialog box.

Tool Right Mouse Button Function

XY rotation Rotates selected molecules only

Z rotation Rotates selected molecules or selected, rotatable side 
chains

XY translation Moves selected atoms or whole moleculesa

Z translation Moves selected atoms or whole moleculesa
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Inertial Axes
HyperChem uses inertial axes for rearranging molecules (see 
“Align Molecules” on page 128) in the workspace and when defin-
ing POINT, LINE, and PLANE (see “Select Dialog Box” on page 145). 
These definitions are in terms of inertial axes.

POINT The intersection of the inertial axes at the center of 
mass of the selected atoms.

LINE The primary inertial axis of the selected atoms.1

PLANE The plane formed by the primary and secondary 
inertial axes, perpendicular to the tertiary axis of 
the selected atoms.

1. The primary inertial axis corresponds to the smallest eigenvalue of the moment of inertia matrix.
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Constructing a Molecule
Constructing a Molecule

This section describes creating a molecule in HyperChem and indi-
cates where you can find more information. You can draw mole-
cules “from scratch” or construct them from residues.

To draw a molecule:

1. Use the Drawing tool to sketch atoms in a molecule and con-
nect them with covalent bonds. (See “Drawing Tool” on page 
28.)

• Select and change the element from the Default Element 
dialog box. (See “Changing the Drawing Element” on page 
293.)

• L-click or L-drag to create individual atoms or bonded 
atoms. (See “Drawing Molecules” on page 291.)

• Specify the bond order by clicking bonds with the Drawing 
tool. L-clicking a bond increases the bond order, and R-
clicking decreases it. Double-clicking a bond creates a con-
jugated bond; double-clicking a bond in a ring creates an 
aromatic ring. (See “Changing the Bond Order” on page 
295.)

LINE

POINT

PLANE
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Constructing a Molecule
• With wedges turned on in stick rendering (see“Rendering” 
on page 159), specify stereochemistry by [Shift]+L-clicking 
on bonds before model building. (See “Drawing Mole-
cules” on page 291 and “Changing Chirality” on page 
303.)

2. Invoke the Model Builder on the Build menu to create a 3D 
molecule from the 2D structure you drew. (See “Model 
Build/Add H & Model Build” on page 85.)

Use any of the following options to make changes to the resulting 
structure:

1. Edit the system with the Drawing tool and with Cut, Copy, and 
Paste commands on the Edit menu. (See “Edit Menu” on page 
113.)

2. Specify the molecular conformation.

• If necessary, change the bond length, bond angle, or tor-
sion angles of selected atoms by using one of the Set com-
mands on the Edit menu. (See “Set Bond Length” on page 
130, “Set Bond Angle” on page 131, and “Set Bond Tor-
sion” on page 132.)

• Establish Model Builder constraints for the geometry, 
bond length, bond angle, or torsion angles by using the 
Constrain commands on the Build menu. (See “Constrain 
Geometry” on page 92, “Constrain Bond Length” on page 
95, “Constrain Bond Angle” on page 96, and “Constrain 
Bond Torsion” on page 97.)

• Set the chirality by shift-clicking on atoms using the Draw-
ing tool or by using Invert and Reflect commands on the 
Edit menu. (See “Invert” on page 118 and “Reflect” on 
page 120.)

Important: Run the Model Builder again after you have set the 
conformation.

3. Choose Geometry Optimization on the Compute menu to 
improve the conformation of the system or selected subset, 
using either molecular mechanics or semi-empirical or ab initio 
quantum mechanics. (See “Geometry Optimization” on page 
239.)

Important: Do not run the Model Builder again, or you will 
lose the optimization.
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To build a polypeptide from residues:

1. Choose Amino Acids on the Databases menu. (See “Amino 
Acids” on page 99.) 

2. Specify the conformation of the first residue in the Conforma-
tion section of the dialog box.

3. L-click the first amino acid residue. L-click Ace if you want an 
N-terminal cap.

4. Continue specifying conformations and clicking residues until 
the polypeptide is complete.

5. L-click Nme if you want a C-terminal cap.

6. If you did not cap the ends of the polypeptide, you can make 
it a zwitterion by choosing Make Zwitterion on the Databases 
menu. (Remove Ionic Ends reverses this action.) (See “Make 
Zwitterion” on page 103.)

7. Change an individual amino acid within the protein by select-
ing it and choosing Mutate on the Databases menu. (See
 “Mutate” on page 110.)

To build a polynucleotide from residues:

1. Choose Nucleic Acids on the Databases menu. (See “Nucleic 
Acids” on page 104.)

2. Specify the conformation of the polynucleotide in the Confor-
mation section of the dialog box.

3. L-click the first nucleic acid residue. L-click on 5CAP if you 
want a 5' cap. 

4. Continue specifying conformations and clicking residues until 
the polynucleotide is complete.

5. L-click 3CAP if you want a 3' cap.

6. If you want sodium ions to balance the negative charge on 
each phosphate group, choose Add Counter Ions on the Data-
bases menu. (See “Add Counter Ions” on page 109.)

7. Change an individual nucleic acid within the polynucleotide 
by selecting it and choosing Mutate on the Databases menu. 
(See “Mutate” on page 110.)
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Constructing a Molecule
To add water molecules:

1. If you want the molecular system in a periodic box containing 
water molecules (rather than in vacuo), choose Periodic Box on 
the Setup menu. (See “Periodic Box” on page 219.)

2. Specify the options for the periodic box in the Periodic Box 
Options dialog box.
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Chapter 3

Tools

This chapter explains the eight HyperChem tools you use to con-
struct, model, select, and move molecules. A Tool menu appears at 
the left edge of the HyperChem workspace. 

Each tool is represented by an icon, or symbol. When you use the 
tool, the cursor takes the shape of the icon.

You can use the tool icons in these ways:

L-click Place the mouse cursor on a tool icon and click the 
left mouse button to turn the cursor into a tool. 
When you move the cursor to the workspace, the 
cursor changes to a tool, with the appearance of 
the tool icon. 

Double-click Place the cursor on a tool icon and click the left 
mouse button twice, rapidly, to begin a procedure 
or to show a dialog box related to the tool.

For mouse fundamentals, see “Using the Mouse” on page 7. The 
following descriptions give you more information on HyperChem 
tools.

Pop-up Help for Tool Icons

By default, when the cursor pauses over one of the tool icons, a 
message briefly describing the tool will pop up. You can disable 
this feature by changing the line ToolHelpPopup=Yes to 
ToolHelpPopup=No in your Registry or in the chem.ini file (see 
“Default Settings in Registry or Chem.ini” on page 541).

Drawing

Selecting

XY rotation

Z rotation

XY translation

Z translation

Zoom

Z clipping
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Drawing Tool
Drawing Tool

With the Drawing tool, you can construct molecules in two 
dimensions (2D). You supply information about types of atoms 
and their bonding, without concern for accurate geometry. You 
can later ask HyperChem to turn the 2D drawing into a 3D struc-
ture. You can then use a geometry optimization calculation (see 
“Geometry Optimization” on page 239) to improve the 3D struc-
ture.

You can do the following with the Drawing tool:

• Create molecules containing any element from the 
periodic table

• Add or remove atoms from existing molecules

• Create covalent bonds and change bond order

• Change chirality and local conformation

To use the Drawing tool icon:

L-click L-click to turn the cursor into the Drawing tool.

Double-click Double-click on the Drawing tool to see the Draw 
dialog box. You can set the default element (the 
type of atom you are using for drawing, for exam-
ple, carbon) or turn on or off Allow Ions and Explicit 
Hydrogens. You can also reach this dialog box by 
choosing Default Element on the Build menu.
28 Chapter 3



Drawing Tool
Drawing Molecules

To draw molecules:

1. L-click on the Drawing icon and move the Drawing tool into 
the workspace.

2. To create individual atoms, L-click anywhere in the workspace.

3. To remove an atom, R-click near the atom. 

4. To create two singly bonded atoms, L-drag then release the 
mouse button.

5. To add another bond and atom, L-click near an atom, L-drag, 
and then release the mouse button.

6. To change an element, choose the new element from the Ele-
ment Table dialog box (see page 83), and then 
L-click on the atom you want to change.

7. To create a double bond, L-click on a single bond. To create a 
triple bond, L-click on a double bond. 

8. To create a conjugated bond, double-click on a bond. To create 
an aromatic ring, double-click on a bond in the ring.

9. To decrease the order of a bond (conjugated to single; triple to 
double; double to single), R-click on it. 

10. To remove a single bond and an atom connected only through 
that bond, R-click on the bond.

11. To specify the chirality or local conformation of an atom, 
[Shift]+L-click on one of its bonds (with sticks and wedges ren-
dering turned on) to specify constraints for the model builder. 
You can also [Shift]+L-click on an atom to change the chirality 
of that atom after model building.

For more information about drawing and revising molecules, see 
chapter 8, “Constructing Molecules.”

Choosing and Changing Elements

Normally, the Drawing tool places only heavy (nonhydrogen) 
atoms in a molecule. You choose the heavy atom (from helium 
through lawrencium) from the Element Table dialog box. This 
choice is also known as the default element. To see the Element 
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Selection Tool
Table dialog box, double-click on the Drawing icon or choose 
Default Element on the Build menu.

You can change the default element any time while drawing by 
changing the choice in the Element Table dialog box. Then con-
tinue drawing.

To change an element after drawing a molecule:

1. From the Element Table dialog box, choose a new element. For 
example, if you drew your molecule with carbon as the default 
element and you want to change a carbon atom to an oxygen, 
click on oxygen in the dialog box.

2. With the Drawing tool, L-click on the atom you want to 
change.

Note: You can change atoms in 2D drawings or, after using the 
Model Builder, in 3D structures.

Adding Hydrogen Atoms

HyperChem can automatically add the hydrogen atoms needed to 
complete the normal valence structure of heavy atoms if you draw 
the molecule with Explicit Hydrogens off. Use the Model Builder 
(Add H & Model Build on the Build menu) to add hydrogen atoms, 
and then create a 3D structure.

You can also add hydrogens manually while drawing. Choose 
Explicit Hydrogens from the Element Table dialog box or on the 
Build menu. When Explicit hydrogens is on, Add H & Model Build 
on the Build menu changes to Model Build. The Model Builder does 
not automatically add hydrogens. 

You can always ask HyperChem to add required hydrogens to a 
structure by choosing Add Hydrogens on the Build menu. This 
choice is independent of whether the Explicit Hydrogens setting is 
on or off.

Selection Tool

The Selection tool lets you mark atoms or molecules, preparing 
them for specific operations or procedures, such as labeling or cal-
culations, for example.
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Selection Tool
Remember: If there is a selection, HyperChem usually acts only on 
the selected atoms.

You can select these structures:

• Atoms

• Bonds

• Bond angles

• Residues (in proteins or polynucleotides and some water mol-
ecules)

• Backbones (in proteins or polynucleotides)

• Shortest path between atoms, bonds or residues

• Side chains

• Rings

• Groups of atoms

• Several or all molecules in the workspace

You can also use the Selection tool to measure these values:

• Bond lengths and distances between nonbonded atoms

• Bond angles and torsion angles

To use the Selection icon:

L-click L-click on the Selection icon to turn the cursor into 
the Selection tool.

Double-click Double-click on the Selection icon to start the 
Model Builder. The Model Builder turns selected 
atoms into a 3D chemical model. Double-clicking 
is the same as choosing Model Build or Add H & 
Model Build on the Build menu. For a discussion of 
the Model Builder, see “Converting 2D Drawings 
into 3D Structures” on page 304.

Note: As you select structures, information about these structures 
appears in the status line.
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Selection Tool
Selection Levels

The Selection tool always works at one of these levels of molecular 
organization:

Atoms The smallest unit of selection is an atom or bond. 
L-clicking an atom selects the atom. L-clicking a 
bond selects the two atoms that the bond con-
nects.

Residues The smallest unit of selection is a residue from a 
database or, if there are no residues, an atom or 
bond.

Molecules The smallest unit of selection is a whole molecule.

These are the first three items on the Select menu. Only one of 
these items can be active (✓) at a time. The remaining items on the 
Select menu make selection easier. For a complete discussion of 
this menu, see page 132.

Selecting

HyperChem provides several ways to select atoms or molecules:

• Use the Selection tool to select atoms, residues, molecules, and 
groups of atoms.

• Use the Select menu to select classes of structures and named 
structures.

Using the Selection Tool

For these procedures, you must first L-click on the Selection tool 
icon to obtain the Selection tool. 

Procedure What to do

Selecting single 
structures

Choose the selection level (Atoms, Residues, or Mole-
cules) on the Select menu. This determines the small-
est unit you can select. Choose Multiple Selections 
on the Select menu to turn it off (no check mark). L-
click on a structure to select it. Each selection 
replaces the previous selection
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Selection Tool
Accumulating 
selections

Choose Multiple Selections on the Select menu to 
turn it on (✓). Then use the procedure for selecting 
single structures (above). Each selection adds to pre-
vious selections

Canceling a selec-
tion

R-click on a structure to deselect it

Selecting all atoms L-click on an empty part of the workspace. Or choose 
Select All on the Select menu

Deselecting all 
atoms

R-click on an empty part of the workspace

Selecting a group 
of atoms

LR-drag (hold both mouse buttons, first the left, then 
the right) a selection rectangle around a group of 
structures. Release both mouse buttons to select all 
atoms that project onto the 2D plane of the screen. 
To select all structures in a sphere (3D) instead of a 
rectangle (2D), first choose Select Sphere on the 
Select menu (✓). Then starting at an atom, LR-drag a 
circle to the radius that you want. Release both 
mouse buttons to complete the selection. Group 
selection works with Multiple Selections either on or 
off. For more information, see “Select Sphere and 
Group Selecting” on page 139

Deselecting a 
group of atoms

RL-drag (hold both mouse buttons, first the right, 
then the left) a selection rectangle or sphere around 
a group of atoms (see above). Release both mouse 
buttons to complete the deselection

Selecting back-
bone atoms in any 
molecule

With Atoms on (✓), L-drag from one atom to a dis-
tant atom in the same molecule. This selects all 
atoms and bonds in the shortest continuous path 
connecting these atoms, but not side groups. With 
Residues on in the Select menu, this action selects all 
residues that the shortest path of bonds pass through

Deselecting 
backbone atoms

With Atoms on (✓), R-drag from one atom to a dis-
tant atom in the same molecule. This deselects atoms 
and bonds in the continuous path connecting these 
atoms. With Residues on, the residues along the path 
are deselected

Procedure What to do
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Selection Tool
Using the Select Menu

These items on the Select menu select structures directly, without 
the Selection tool. 

Selecting side 
chains

With Atoms on (✓), double-click on the side of the 
bond that is connected to the side chain. This 
selects all atoms on the side of the bond that you 
clicked as well as the atom on the other side of the 
bond

Selecting rings With Atoms on (✓), double-click on an atom or 
bond in a ring. This selects the atoms in the small-
est ring. With Residues on, double-clicking a ring 
selects all residues the ring passes through

Procedure What to do

Selecting all 
structures

Choose Select All to select all atoms in a molecular 
system

Complementing a 
selection

Choose Complement Selection to deselect the exist-
ing selection and to select all atoms previously not 
selected

Saving and recall-
ing selections

Use Name Selection to name selected atoms and to 
store this selection. HyperChem provides three pre-
defined selection names (POINT, LINE, and PLANE) 
that store the selection and add geometric properties 
to the selection. You can also store a selection with 
any name that you provide (see “Name Selection 
Dialog Box” on page 148). Use Select, also on this 
menu, to recall a named selection for a molecular 
system

Selecting atoms 
and molecules by 
name or number

Choose Select . . . to select atoms by a previously 
defined name or to select atoms, residues, and mole-
cules by sequence number (see “Name Selection 
Dialog Box” on page 148)

Selecting a ring Choose Extend Ring to select all atoms in a ring, if 
one bond or atom in the ring is already selected

Procedure What to do
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Selection Tool
Measuring with the Selection Tool

Selecting atoms, residues, molecules, and bonds gives you infor-
mation about these structures. You can measure bond lengths, 
angles, and torsion angles, and the equivalent structural factors 
among nonbonded atoms. Measurements appear on the status 
line. 

Selecting a rotat-
able side chain

Choose Extend Side Chain to select all atoms in a 
rotatable side chain if the first two atoms in the side 
chain are already selected. The order of selection for 
the first two atoms determines the direction of side 
chain selection (see page 152)

Selecting all 
atoms up to the 
sp3–sp3 bonds

Choose Extend to sp3 to select all atoms, starting 
from an existing selection, until all bonds with only 
one atom selected are single bonds between sp3 
atoms. Use this to prepare a selection for a mixed 
mode quantum mechanics calculation

Selecting a 
polypeptide or 
polynucleotide 
backbone

Choose Select Backbone to select only the backbone 
atoms and bonds in polynucleotides and polypep-
tides constructed with residues from the Databases 
menu or from PDB files. For polypeptides, disulfide 
bridges are also selected

Procedure What to do

Identifying an atom Turn on Atoms (✓) on the Select menu, and then 
L-click on an atom. You see the number of the 
atom in a molecule, the element name, the PDB 
atom name (if available), the atom type (for the 
active force field), the atomic charge, and its coor-
dinates in the Molecular Coordinate System

Identifying a residue Turn on Residues (✓) on the Select menu, and 
then L-click on a residue. You see the residue 
name, number, and charge of the residue. A num-
ber in parenthesis, if present, is the residue num-
ber from the PDB file

Procedure What to do
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XY Rotation Tool
These measurements use the Selection tool with Atoms on (✓) and 
Multiple Selections on (✓): 

XY Rotation Tool

With the XY rotation tool, you can rotate one or more molecules 
around the x or y axis, or around both axes at once. 

Identifying a mole-
cule

Turn on Molecules (✓) on the Select menu, and 
then L-click on a molecule. You see the molecule 
number and charge

Procedure What to do

Measuring bond 
lengths

Select two atoms or the bond between them. 
Alternatively, select the atom at one end of the 
bond, and L-drag to the atom at the other end of 
the bond

Measuring bond 
angles

Select two adjacent bonds or the three bonded 
atoms. Alternatively, select the atom at one end of 
the angle, and L-drag to the atom at the other end 
of the angle

Measuring torsion 
angles

Select three bonds or four atoms that define a tor-
sional rotation. Alternatively, select an atom at one 
end of the four-atom torsion, and L-drag to the 
atom at the other end of the torsion

Measuring distances 
between atoms

Select one atom, and then select the second atom. 
The atoms can be in different molecules. Do not 
L-drag. Multiple Selections must be on

Measuring improper 
angles

Select any two bonds or three atoms. The 
“improper angle” depends on the order of selec-
tion

Measuring improper 
torsion angles

Select any three bonds or four atoms. The 
“improper torsion angle” depends on the order of 
selection

Procedure What to do
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XY Rotation Tool
To use the XY rotation tool icon:

L-click L-click on the XY rotation icon to turn the cursor 
into the XY rotation tool. You can then move the 
XY rotation tool into the workspace and rotate 
molecules by dragging. 

Double-click Double-click on the XY rotation icon to see the 
Rotate dialog box. Use this dialog box for setting 
exact rotation conditions (see page 121). You can 
also see this dialog box by choosing Rotate on the 
Edit menu.

Using the XY Rotation Tool

To use the XY rotation tool:

1. L-click on the XY rotation icon and move the XY rotation tool 
into the workspace.

2. L-drag to rotate the molecular system. 

This rotation leaves the atomic coordinates unchanged, as if 
the viewer is moving around the molecules.

3. R-drag to rotate whole, selected molecules.

These molecules rotate around a center of atomic mass, chang-
ing individual atomic coordinates. 

4. Move the XY rotation tool horizontally to rotate around the y 
axis, and vertically to rotate around the x axis. Movement in 
other directions produces rotation around both the x and y 
axes.
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Z Rotation Tool
Setting the Amount of XY Rotation

Normally, moving the XY rotation tool horizontally from one 
edge of the workspace to the other rotates a molecule by 360 
degrees. You can change this amount by entering a number from 
0 to 3600 degrees for Tool, XY rotation, in the Tool Preferences dia-
log box (see page 65). Thirty-six-hundred degrees increases the 
sensitivity of the rotation tool 10-fold compared to the default of 
360 degrees.

Z Rotation Tool

With the Z rotation tool, you can rotate molecules around the z 
axis or rotate a selected side chain around a bond. The side chain 
cannot be part of a ring.

To use the Z rotation tool icon:

L-click L-click on the Z rotation icon to turn the cursor 
into the Z rotation tool. You can then move the Z 
rotation tool into the workspace to rotate mole-
cules by dragging. 

rotation around X axis 

rotation around Y axis
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Z Rotation Tool
Double-click Double-click on the Z rotation icon to see the 
Rotate dialog box. Use this dialog box for setting 
exact rotation conditions (see “Rotate Dialog Box” 
on page 121). You can also see this dialog box by 
choosing Rotate on the Edit menu.

Using the Z Rotation Tool

To use the Z rotation tool:

1. L-click on the Z rotation icon and move the Z rotation tool 
into the workspace.

2. L-drag horizontally to rotate the molecular system. 

This rotation leaves the atomic coordinates unchanged, as if 
the viewer is moving around the molecules.

3. R-drag horizontally to rotate whole, selected molecules or a 
selected side chain that is not part of a ring. If there is no selec-
tion, this rotates the whole molecular system.

Molecules rotate around their centers of atomic mass. Side 
chains rotate around the selected bond connecting to the rest 
of the molecule. Individual atomic coordinates change during 
this rotation. 

Note: If you try to rotate part of a molecule that cannot rotate, 
HyperChem beeps, shows a warning message on the status line, 
and temporarily inactivates the Z rotation tool until you release 
the mouse button. Change the selection and try again.
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Setting the Amount of Z Rotation

Normally, moving the Z rotation tool horizontally across the 
workspace rotates a molecule by 360 degrees. You can change this 
amount by entering a number from 0 to 3600 degrees for Tool, Z 
rotation, in the Tool Preferences dialog box (see page 65). Thirty-
six-hundred degrees increases the sensitivity of the rotation tool 
10-fold compared to the default of 360 degrees.

XY Translation Tool

The XY translation tool lets you move molecules or selected atoms 
along the x and y axes (in the plane of the computer screen). 

To use the XY translation tool icon:

L-click L-click on the XY translation icon to turn the cur-
sor into the XY translation tool. You can then 
move the XY translation tool into the workspace 
and translate molecules by dragging.

Double-click Double-click on the XY translation icon to see the 
Translate dialog box. Use this dialog box for setting 
exact translation conditions (see “Translate Dialog 

counterclockwise 
rotation

clockwise 
rotation
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XY Translation Tool
Box” on page 123). You can also see this dialog box 
by choosing Translate on the Edit menu.

Using the XY Translation Tool

To use the XY translation tool:

1. L-click on the XY translation icon and move the XY transla-
tion tool into the workspace.

2. L-drag to move the molecular system. 

This translation leaves the coordinates of all molecules 
unchanged, as if the viewer is moving around the molecules.

3. R-drag to move selected molecules, residues, and atoms. You 
can move selected residues or atoms only if you turn off Whole 
molecule translation (see page 65). The default setting is Whole 
molecule translation on (✓).

Atomic coordinates change during this translation. 

Caution: When translating selected residues or atoms in a 
larger molecule, HyperChem might stretch bonds and angles 
to accommodate the new atomic positions. These bonds are 
often unnatural. To avoid distorting bonds, turn Whole mole-
cule translation on (see page 65). 

4. Molecules move in the same direction as the XY translation 
tool. 

5. You can drag molecules only to the edges of the workspace. 

To increase the relative range for XY translation, use the Zoom 
tool to reduce the apparent sizes of the molecules. This pro-
vides a relatively larger workspace for moving molecules.
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Fast Translation

To translate molecules faster, turn on Fast translation in the Tool 
Preferences dialog box (see page 65). This choice substitutes a pic-
ture of the molecules, called a bitmap. HyperChem can move a bit-
map faster because it does not need to compute new atomic coor-
dinates for each step in the translation. When you finish translat-
ing and release a mouse button, HyperChem computes the new 
atomic coordinates and converts the bitmap back to a normal 
molecular rendering.

Z Translation Tool

With the Z translation tool, you can move molecules or selected 
atoms along the z axis (toward you or away from you). Molecules 
appear larger and the degree of perspective increases as they move 
closer to you. 

Note: Perspective (see “Rendering: Sticks” on page 161) affects Z 
translation. With Perspective on, molecules change size. With Per-
spective off, molecules remain the same size, but atoms disappear 
from the display as you move them out of the clipping slab (see 
page 46). 

X translation

Y translation
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Z Translation Tool
To use the Z translation tool icon:

L-click L-click on the Z translation icon to turn the cursor 
into the Z translation tool. You can then move the 
Z translation tool into the workspace and L-drag or 
R-drag to move molecules. 

Double-click Place the cursor on the Z translation icon and dou-
ble-click to see the Translate dialog box. Use this 
dialog box for setting exact translation conditions 
(see “Translate Dialog Box” on page 123). You can 
also see this dialog box by choosing Translate on 
the Edit menu.

Caution: If atoms disappear after a z axis translation, you have 
moved them outside the clipping slab. Use the Z clipping tool to 
adjust the clipping planes (see page 47) or press [Spacebar], making 
the atoms visible in the workspace.

Using the Z Translation Tool

To use the Z translation tool:

1. L-click on the Z translation icon and move the Z translation 
tool into the workspace.

2. L-drag to translate the molecular system. 

This translation leaves the coordinates of all molecules 
unchanged, as if you were moving toward or away from the 
molecules.

3. R-drag to translate selected molecules, residues, and atoms. 
You can move selected residues or atoms only if you turn off 
Whole molecule translation (see page 65). The default setting is 
Whole molecule translation on (✓).

Atomic coordinates change during this translation. 

Caution: To avoid distorting bonds, turn on Whole molecule 
translation (see page 65). When translating selected residues or 
atoms in a larger molecule, HyperChem stretches bonds to 
accommodate the new atomic positions. These bonds are 
often unnatural. 

4. Move the Translation tool from the top to bottom of the work-
space to translate molecules toward you. Move the tool from 
bottom to top to translate molecules away from you. Moving 
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Zoom Tool
the tool the vertical height of the workspace moves molecules 
the default distance of 10 Ångstroms (see “Setting the Amount 
of Z Translation” on page 44).

In this example, Z translation (back) moved the molecule through 
the back clipping plane (see page 46), hiding the back of the mol-
ecule.

Setting the Amount of Z Translation

Normally, moving the Z translation tool vertically across the work-
space translates molecules by 10 Ångstroms. You can change this 
amount by entering a number between >0 and ≤1000 in the Tool 
Preferences dialog box (see page 65). 

Zoom Tool

The Zoom tool lets you change the magnification of the molecular 
system. For example, you can magnify large molecules to observe 
atomic organization.

translate back (-Z)

translate 
forward (+Z)
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Zoom Tool
To use the Zoom tool icon:

L-click L-click on the Zoom icon to turn the cursor into 
the Zoom tool. Then move the Zoom tool into the 
workspace, and L-drag to change the apparent size 
of the molecular system. 

Double-click Double-click on the Zoom icon to see the Zoom 
dialog box. Use this dialog box for setting exact 
zoom conditions (see “Zoom Dialog Box” on 
page 124). You can also see this dialog box by 
choosing Zoom on the Edit menu.

Caution: Use a Sticks rendering for bonds with high magnifications 
of molecular systems. High magnifications (Zoom Factor) of all 
molecular renderings except Sticks might require more memory 
than your computer has available. 

Using the Zoom Tool

To use the Zoom tool:

1. L-click on the Zoom icon and move the Zoom tool into the 
workspace.

2. L-drag the Zoom tool vertically, from the top to the bottom of 
the workspace, to enlarge molecules. L-drag the tool from the 
bottom to the top to reduce the size of molecules. Moving the 
tool the vertical height of the workspace magnifies molecules 
by the default factor of 10 (see below).
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Z Clipping Tool
Important: If you accidentally lose sight of a molecule or increase 
its size beyond the edges of the workspace, press [Spacebar] to bring 
it back to the center of the workspace.

The right mouse button has no effect on the Zoom tool.

Setting the Zoom Sensitivity

Normally, moving the Zoom tool vertically across the workspace 
changes the magnification by a factor of 10. You can change this 
amount by entering a number >1 and ≤1000 in the Tool Prefer-
ences dialog box (see page 65). 

Z Clipping Tool

With the Z clipping tool, you can look inside molecules by show-
ing only the atoms within a “slice.” The slice is called the clipping 
slab. 

The clipping slab is present for every molecular system. The clip-
ping slab has front and back planes that are parallel to each other 
and to the plane of the computer screen. Only atoms between the 
planes are visible. HyperChem first sets the clipping planes so that 
you can see a complete molecular system.

smaller

larger
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Z Clipping Tool
With the Z clipping tool, you can move each clipping plane rela-
tive to the molecular system; the atomic coordinates are fixed. The 
status line shows the positions of the front and back clipping 
planes as distances, in Ångstroms, from the viewer (along the 
Viewer’s z axis). The viewer is at zero relative to the clipping 
planes. 

The Z clipping tool can show you successive slices through mole-
cules. You can do this two ways: 

• Use the Z clipping tool to move the clipping planes through a 
molecular system. 

• Use the Z clipping tool to set the depth of the clipping slab, 
and then use the Z translation tool to move molecules through 
the clipping slab. 

To use the Z clipping tool icon:

L-click L-click on the Z clipping icon to turn the cursor 
into the Z clipping tool. You can then move the Z 
clipping tool into the workspace and L-drag or R-
drag to adjust the front or back planes of the clip-
ping slab. 

Double-click Double-click on the Z clipping icon to see the Z 
Clip dialog box (see page 126). Use this dialog box 
to set exact positions of the clipping planes, either 
graphically or numerically. You can also see this 
dialog box by choosing Z Clip on the Edit menu.

Using the Z Clipping Tool

To use the Z clipping tool:

1. L-click on the Z clipping icon and move the Z clipping tool 
into the workspace.

2. L-drag vertically to adjust the position of the front clipping 
plane. 

3. R-drag vertically to adjust the position of the back clipping 
plane.
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Keyboard Equivalents for Tools
4. Dragging from the top to the bottom of the screen moves a 
clipping plane forward. Dragging from the bottom to the top 
of the screen moves a clipping plane back. Moving the tool the 
vertical height of the workspace moves a clipping plane by the 
default setting of 10 Ångstroms (see the next section).

Important: If the molecular system disappears from the workspace 
while you are using the Z clipping tool, press [Spacebar] to bring it 
back to the center of the clipping slab.

Setting the Amount of Clipping Plane Movement

Normally, moving the Z clipping tool vertically across the work-
space moves a clipping plane by 10 Ångstroms. You can change 
this amount by entering a number > 0 and ≤ 1000 in the Tool Pref-
erences dialog box (see page 65). 

Keyboard Equivalents for Tools

You can use keys on the numeric keypad instead of using a mouse 
to operate HyperChem tools. The Key settings in the Tool Prefer-

move plane
forward

move plane
backward

L - drag = front plane
R - drag = back plane
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Keyboard Equivalents for Tools
ences dialog box give the size of the change for each keystroke. 
Pressing a key or a combination of keys gives these results:

a. [Shift] changes the operation from rotation to translation.
b. Pressing [Ctrl] is like using the right mouse button to move selected atoms.
[Ctrl] modifies the effect of either pressing a key or [Shift] plus a key.

Key [Shift]+ Keya [Ctrl]+ Key or
[Ctrl]+ [Shift]+ Keyb

[4] X rotates down Y translates down XY translates or 
rotates selection,
if any, down

[3] X rotates up Y translates up XY translates or
rotates selection, 
if any, up

[1] Y rotates to left X translates to left XY translates or
rotates selection,
if any, left

[2] Y rotates to 
right

X translates to right XY translates or
rotates selection, 
if any, right

[Home] Z rotates clock-
wise

Z translates into screen Z translates or 
rotates selection, 
if any

[End] Z rotates coun-
terclockwise

Z translates out of 
screen

Z translates or 
rotates selection, 
if any
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Keyboard Equivalents for Tools
a. [Shift] changes the operation from zooming to clipping plane movement.

Key [Shift]+ Keya [Ctrl]+ [Shift]+ Key

[PgUp] Zooms smaller Moves front clipping 
plane into screen

Moves back clip-
ping plane into 
screen

[PgDn] Zooms larger Moves front clipping 
plane out of screen

Moves back clip-
ping plane out of 
screen
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Chapter 4

Managing Files

This chapter describes the commands on the File, Script, and Help 
menus. It explains opening and saving files, setting up Hyper-
Chem display conditions, running script files to automate Hyper-
Chem functions, and obtaining help while using HyperChem.

For accessing files, HyperChem uses the standard Windows File 
dialog boxes. See the Microsoft Windows User’s Guide for informa-
tion about specifying drives, directories and files with Windows 
File dialog boxes.

File Menu

The File menu contains these file management and utility com-
mands:  

New Clears the workspace for drawing new molecules.
You can also press [Ctrl]+[N]

Open . . . Clears the workspace and shows a molecular system 
stored in a file. 
You can also press [Ctrl]+[O]

Merge . . . Adds the contents of a file (molecular system) to the 
molecules in the workspace

Save Stores the molecules now in the workspace to a file. 
You can also press [Ctrl]+[S]

Save As  . . . Stores the molecules now in the workspace in a file, 
with a new filename. You can also press [Ctrl]+[A]

Start Log  . . .a Stores the results of chemical calculations in a log file
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File Menu
New

New clears the workspace and prepares HyperChem for creating 
new molecules.This option asks if you want to save the molecules 
present in the workspace if you made changes to the molecular 
system.

Open

Open clears the workspace and lists the molecules stored in files. 
The Open File dialog box lets you choose a filename and copy the 
molecules from this file to the workspace. 

Before you can see the contents of a file, HyperChem asks if you 
want to save the molecular system presently in the workspace if 
you made changes since last saving it.

a. When this item is gray, it is temporarily unavailable. You must change some
condition in HyperChem to make it available. You must start a log before you
can stop it or log comments, and you must stop a log before you can start a
new one.

Stop Loga Turns off the log for recording calculation results in a 
log file

Log
Comments . . .a

Adds comments to a log file

Import . . . Import orbital data

Export . . . Export orbital data

Print . . . Sends a copy of the molecules in the workspace to a 
printer

Preferences  . . . Sets HyperChem operating conditions. HyperChem 
remembers these settings from one session to the 
next

Exit Ends your session with HyperChem. You can also 
press [Alt]+[F4]
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File Menu
Open File Dialog Box

Use the Open File dialog box to copy a molecular system from a 
file to the workspace. The dialog box provides several ways to spec-
ify a filename.

File Name You can enter the filename, with or without path, 
in this text box and L-click on Open. If you choose 
a file name from the file list, the name will appear 
in this box.

Directories This reports the current directory. The files appear-
ing in the file list are in this directory. The direc-
tory list box can be used to change the current 
directory.

Drives This reports the current drive. The files appearing 
in the file list are on this drive in the current direc-
tory. The drives list box can be used to change the 
current disk drive.

File Type Use this list to choose the file type and the exten-
sion filter for listing file names. The standard file 
types that HyperChem can read and write are:

HyperChem 
(*.HIN)

Files containing complete information 
about molecules created with HyperChem 
(see page 515). These filenames have the 
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File Menu
.hin extension. HIN stands for HyperChem 
INput file.

Brookhaven 
PDB (*.ENT)

Files stored in the format used by the 
Brookhaven Protein Data Bank (see 
page 319). Before showing you these 
chemical structures, HyperChem uses 
information in the chem.tpl file to add 
hydrogen atoms and bonding when neces-
sary.

ISIS Sketch 
(*.SKC)

The Sketch file format used by ISIS/Draw 
from MDL Information Systems. These 
filenames have the .skc extension.

MDL MOL 
(*.MOL)

The format used by many programs from 
MDL Information Systems. These file-
names have the .mol extension.

MOPAC 
Z-Matrix 
(*.ZMT)

The molecular definition portion of a 
MOPAC file, with geometry given by inter-
nal coordinates. HyperChem expects files 
in this format to have the .zmt extension.

Tripos MOL2 
(*.ML2)

The format used by many programs from 
Tripos Associates. HyperChem expects files 
in this format to have the .ml2 extension.

ChemDraw 
(.CHM)

The format used by ChemDraw from 
CambridgeSoft. Files in this format usually 
have the .chm extension.

Caution: If you choose an inappropriate file format, 
for example HIN instead of PDB, and then open a 
file, HyperChem might not succeed in reading the 
file. HyperChem does not automatically detect the 
file format that you are reading.

Comments This box shows any comments stored in the file 
currently selected, which might describe the 
molecular system and its source. You can scroll 
through the comments in this box. For a PDB file, 
only some of the comments appear. You cannot 
enter new comments here. Use Save As on the Files 
menu to add new comments. Comments are not 
available from Z-Matrix format files.
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File Menu
OK L-click to copy the contents of a file, appearing in 
the File Name text box, to the workspace. You can 
also double-click on the filename in the file list.

Reading Non-standard PDB Files

PDB files written by some other programs may not conform 
strictly to the Brookhaven Protein Databank specifications. In par-
ticular, PDB files written by some other programs may have left-
justified atom names. In order to read these files in, you may try 
running a script containing the command “non-standard-pdb-
names = true“. HyperChem will then try interpreting the PDB file 
according to a non-standard form. You should reset HyperChem 
by running a script with the command “non-standard-pdb-names 
= false” in order to re-enable reading of standard PDB files.

Reading ChemDraw Files

Since ChemDraw is a drawing program and not a modelling pro-
gram, it handles some structural elements in ways that must be 
corrected manually in order that they be read properly by Hyper-
Chem.

When an “aromatic” ring is drawn in ChemDraw, the result is a 
circle — a picture element — attached to a structure with single 
bonds. When a ChemDraw file (type .CHM) is read by Hyper-
Chem, it ignores the picture elements and processes only the 
chemical structures, so an “aromatic” ring shows up with single 
bonds. To have the ring brought into HyperChem drawn with aro-
matic bonds, you must change the bond type for the ring bonds to 
“aromatic” in ChemDraw by selecting the ring and using the 
Object/Bond Properties menu item.  Alternately, you can change 
the bonding to aromatic after the structure is imported to Hyper-
Chem by double-clicking on a bond.

Using the Z-Matrix File Filter

You should note that the algorithm for reading and writing Z-
matrix files involves a step proportional to the square of the num-
ber of atoms present, which takes a long time for large molecules. 
The algorithm for inferring connectivity and bond order from a Z-
matrix file is heuristic, and may not always give the bond orders 
you want. You should check the connectivities and bond-orders 
yourself before carrying out operations that require connectivity 
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information, such as model building or molecular mechanics cal-
culations.

Saving a file in Z-Matrix format and then reading it back in to 
HyperChem is a way of automatically generating bonds between 
unconnected atoms. This can be useful for processing structures 
imported from other sources. Also, a structure which is imported 
from a Z-Matrix file is reoriented such that the first atom in the file 
is placed at the origin, the second atom on the positive x axis, and 
the third atom in the xy plane. This can be useful for such opera-
tions as vibrational analysis.

Merge

Merge adds molecules from a file to the molecular system in the 
workspace. Merge is useful for comparing or “docking” molecules. 
Docking involves positioning molecules to simulate possible inter-
actions, for example, enzyme-substrate interactions. 

The added molecules appear a few Ångstroms away from the exist-
ing molecular system. (You can use a script command to prevent 
this movement. See the script command translate-merged-systems.)

When you choose Merge, the Open File dialog box (see page 53) 
appears for you to supply the name of a file to merge. HyperChem 
retains the first file name as the current file name.

You can repeat Merge, adding several files to the workspace. 

Save 

Save copies the molecular system from the workspace to a file. If 
this is a new file, you enter a filename in the Save File dialog box 
that appears (see page 57). If the file already has a name, Save 
stores the molecular system in this file without showing you the 
Save File dialog box, replacing the last version of the molecular sys-
tem. The filename has a limit of eight characters plus a three-char-
acter extension. 

Save As 

Save As stores the molecular system in a file. This option is the 
same as Save, except that the Save File dialog box always appears. 
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Use Save As to copy a file or to store new versions of a molecular 
system in different files. 

Save File Dialog Box

File Name Enter the path and name of the file in this text box 
using any combination of upper- and lowercase 
letters. If you choose a file name from the file list, 
the name will appear in this box.

Note: You must replace the filename wild card (*) 
in the File Name text box.

Directories This reports the current directory. The files appear-
ing in the file list are in this directory. The direc-
tory list box can be used to change the current 
directory.

Drives This reports the current drive. The files appearing 
in the file list are on this drive in the current direc-
tory. The drives list box can be used to change the 
current disk drive.

File Type Use this list to choose the file type and the exten-
sion filter for listing file names. The standard file 
types that HyperChem can write are:
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HyperChem 
(*.HIN)

Files containing complete information 
about molecules created with HyperChem 
(see page 515). These filenames have the 
.hin extension. HIN stands for HyperChem 
INput file.

Brookhaven 
PDB (*.ENT)

Files stored in the format for the 
Brookhaven Protein Data Bank (see 
page 319). Before showing you these 
chemical structures, HyperChem uses 
information in the chem.tpl file to add 
hydrogen atoms and bonding when neces-
sary.

ISIS Sketch 
(*.SKC)

The Sketch file format used by ISIS/Draw 
from MDL Information Systems. These 
filenames have the .skc extension.

MDL MOL 
(*.MOL)

The format used by many programs from 
MDL Information Systems. These file-
names have the .mol extension.

MOPAC 
Z-Matrix 
(*.ZMT)

The molecular definition portion of a 
MOPAC file, with geometry given by inter-
nal coordinates. HyperChem expects files 
in this format to have the .zmt extension.

Tripos MOL2 
(*.ML2)

The format used by many programs from 
Tripos Associates. HyperChem expects files 
in this format to have the .ml2 extension.

HIN Options This area becomes active when File Type is set to 
HyperChem HIN format. For a complete descrip-
tion of a HIN file, see page 515.

Velocities Check this box to store atomic velocities 
calculated in a molecular dynamics simula-
tion. This lets HyperChem start another 
molecular dynamics simulation where the 
last one ended.

PDB Options This area becomes active when File Type is set to 
Brookhaven PDB format. PDB files have the exten-
sion .ent (see page 319 for further information 
about PDB files).

Hydrogens Check this box to add coordinates for 
hydrogen atoms to the file. Most PDB files 
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do not have coordinates for hydrogen 
atoms. 

Connectivity Check this box to add information on 
bonding. HyperChem creates CONECT 
records in the file. PDB files normally use 
CONECT records only for nonstandard res-
idues (see “Creating PDB-type Files” on 
page 321). If you use PDB files to store 
molecules not composed of standard resi-
dues, turn on this option.

Comments This text box is only active if File Type is set to 
HyperChem HIN format or Brookhaven PDB for-
mat. Enter notes here about the molecular system. 
When you have clicked in this text box you see a 
flashing vertical bar, the insertion point for text, 
and a standard I-shaped text cursor. Text you enter 
appears to the left of the insertion point.

OK L-click to copy the system in the workspace to a 
file, using the name appearing in the File Name 
text box. You can also double-click on the filename 
in the file. list. 

Editing Comments

To add or change text, remember these rules:

• L-click with the text cursor (I-shaped) anywhere in the text to 
move the insertion point.

• L-drag the text cursor to select text that you want to delete or 
replace.

• To delete text, select it and press [Del] or [Backspace].

• To replace text, select it and enter new text. 

You can use these keys for editing:

[7] Moves the insertion point to a new line.

[Backspace] Erases the character (or selected text) to the left of 
the insertion point (text cursor).

[Del] Erases the character (or selected text) to the right of 
the insertion point (text cursor). 
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[3] [4]
[1] [2]

Moves the insertion point (text cursor).

Start Log . . . 

Start Log stores the results of HyperChem chemical calculations in 
a log file. Log files contain comments appearing on the status line 
during a calculation, plus starting conditions and additional 
results. 

When you choose Start Log, enter a log filename in the Start Log 
dialog box that appears. You can accept the default filename 
(chem.log) or enter another filename, which can have any exten-
sion. If you use an existing filename, HyperChem lets you either 
add (append) results to this file or replace the contents of the file.

Using the Start Log dialog box, you can have only one log file 
active at a time. The amount of information stored in a log file 
depends on the settings used for Mechanics Print Level and Quan-
tum Print Level (see page 441). Allowed values range from 1 to 9.

For more information on using log files see “Storing Results in a 
Log File” on page 426 and “Log Files” on page 441.

Note: Start Log is gray and unavailable if HyperChem is already 
using a log file.

Open Log Dialog Box

Use this dialog box to name a log file. L-click OK to accept 
chem.log as the log filename or a different filename you’ve 
entered, and start the log recording.
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If the log file is already present, HyperChem asks if you want to 
append to it or replace it. The log file is usually located in the cur-
rent directory. The “Append” option specifies that you wish to 
append to the current file.

To add comments to a log file, choose Log Comments on the File 
menu. To stop recording, choose Stop Log on the File menu (see 
the next section).

Stop Log

Stop Log turns off the recording of a log file and also adds the date 
and time you stopped recording. Use Start Log to begin recording.

To see or print the log contents, you can use Windows Write or 
Notepad. Enter the filename (for example, \hyper\chem.log), 
L-click OK, and then choose No conversion in the next dialog box 
that appears (for Windows Write, only).

For more information on using log files see “Storing Results in a 
Log File” on page 426 and “Log Files” on page 441.

Note: Stop Log is gray and unavailable unless HyperChem is 
already using a log file.

Log Comments 

Use Log Comments to add notes to a log file when a log file is open 
and recording results. Use Start Log to begin recording in a log file. 
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You see the Log Comments dialog box to enter your comments.

Enter your comments in text box of the Log Comments dialog box 
that appears and press OK to save them in the open log file.:

For more information on using log files see “Storing Results in a 
Log File” on page 426 and “Log Files” on page 441.

Note: Log Comments is gray and unavailable unless HyperChem is 
using a log file.

Import . . .

This dialog box allows you to import orbital data that have been 
calculated by HyperChem and stored, or have been provided by 
other software. The data must be consistent with the structure in 
the workspace.

Orbitals If this box is checked (✓) and the data are in the 
file, the orbital data are imported.

Dipole 
moment

If this box is checked (✓) and the data are in the 
file, the dipole moment vector is imported.

UV spectrum If this box is checked (✓) and the data are in the 
file, the UV/visible spectrum is imported.

IR spectrum If this box is checked (✓) and the data are in the 
file, the IR spectrum is imported.

OK This opens the Property Import dialog box, which 
allows you to specify the file that the data should 
be imported from.
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The default extension for these Property files is .EXT.

Export . . .

This dialog box allows you to save orbital data that have been cal-
culated by HyperChem, so that they can be read back in later or 
sent to other software. Items in the dialog box are gray and inac-
tive unless the relevant data have been calculated with a semi-
empirical or ab initio calculation (or imported) and are available for 
storage.

Orbitals If this box is checked (✓), the orbital data are saved 
in a file.

Dipole 
moment

If this box is checked (✓), the dipole moment vec-
tor is saved in a file.

UV spectrum If this box is checked (✓), the UV/visible spectrum 
is saved in a file. For information about calculating 
a UV/visible spectrum, see “Electronic Spectrum” 
on page 285.

IR spectrum If this box is checked (✓), the IR spectrum is saved 
in a file. For information about calculating an IR 
spectrum, see “Vibrations” on page 261.
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OK This opens the Property Export dialog box, which 
allows you to specify the file that the data should 
be imported from.

The default file extension for saving electronic data in a property 
file is .EXT.

Print 

Print reproduces the molecules in the workspace on your printer. 

This command displays the standard Windows Print dialog box, 
where you can set page orientation and other printer options.

Note: You can speed up printing by choosing Sticks from the Ren-
dering option on the Display menu. 

Be sure that your printer is on and ready. HyperChem does not 
inform you of printer problems, but relies on Windows to manage 
printing.

General tips for printing or copying images

Some experimentation may be required to obtain the best quality 
molecular images, depending on your display and printer settings. 
Some suggestions are:

• For spheres renderings, use at least 256 colors if available for 
your display. This will improve monochrome as well as color 
printing or clipboard images.

• For spheres renderings or images copied as bitmaps, using the 
highest resolution of your display will produce the smoothest 
images (and printed atom outlines for spheres rendering). For 
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spheres it is usually best to use the highest resolution display 
settings that also have at least 256 colors.

• For printers with “dots” that are not square (i.e. not a 1:1 
aspect ratio), best results may be obtained using the lowest res-
olution settings in the printer's Setup dialog box.

• The quality of black and white images copied to the clipboard 
on 256-color display devices can be improved by using the 
“window-color = monochrome” script command.

Preferences

Using Preferences, you can set some conditions for using Hyper-
Chem. When you leave HyperChem, it stores your choices in the 
Registry or in a file (chem.ini) and uses these settings for your next 
session. The settings that will be used when you start HyperChem 
will be the same as when you last exited the program, and not 
(necessarily) the same as the settings of any other HyperChem 
windows you may have open at the same time.

Preferences Property Sheet

When you choose Preferences, the Preferences dialog box appears. 
It has nine property sheets, marked by “tabs”, which you use to set 
the different kinds of HyperChem options.

Window Color

Choose a color for the workspace background. The default is black.
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Bond Color

Choose a color for atoms and covalent bonds. The default is By ele-
ment, which colors each element and half bond in a Sticks render-
ing according to the settings in the Element Color dialog box  (see 
page 180). Bond color does not affect hydrogen bonds, which are 
drawn as dotted white lines.

Note: See “Using Black-and-white Output” on page 74 for infor-
mation about working without color.

Selection Color

Choose a color that HyperChem applies to selected atoms and 
bonds. The color returns to Bond color (see above) when you dese-
lect the atoms. The default selection color is green. The choice of 
Thick line does not change the color, but replaces the lines repre-
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senting selected bonds with heavier lines. Thick line works only for 
Sticks renderings.

Note: The Thick line option slows the movements of molecules 
(translation and rotation) when you are using HyperChem tools.

Tool

These settings regulate the behavior of a tool in the workspace, 
whether you are dragging to rotate or translate molecules, to 
change the Zoom Factor, or to set the clipping planes.

XY rotation Normally, moving the XY rotation tool completely 
across the workspace rotates a molecule by 360 
degrees. You can change this amount by entering a 
number >0 and up to 3600.

Z rotation Normally, moving the Z rotation tool completely 
across the workspace rotates a molecule by 360 
degrees. You can change this amount by entering a 
number >0 and up to 3600.

Z translation Normally, moving the Z translation tool vertically 
completely across the workspace translates mole-
cules by 10 Å. You can change this amount by 
entering a number >0 and up to 1000.

Zoom Normally, moving the Zoom tool vertically com-
pletely across the workspace magnifies molecules 
by 10 ×. You can change this amount by entering a 
number >0 and up to 1000.
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Clip Normally, moving the Z clipping tool vertically 
completely across the workspace moves a clipping 
plane by 10 Å. You can change this amount by 
entering a number >0 and up to 1000.

Fast
translation

Check this box (✓) to increase the speed of moving 
a molecule with a translation tool. This substitutes 
a picture of the molecule, called a bitmap, for the 
molecular structure on the display. HyperChem 
can move bitmaps more quickly because it does 
not need to compute atomic coordinates. When 
you complete a translation and release the mouse 
button, HyperChem computes the new atomic 
coordinates and discards the bitmap.

Whole 
molecule 
translation

Check this box (✓) to restrict translation to whole 
molecules. If you use the Translation tool to try to 
translate a selected portion of a molecule, Hyper-
Chem will translate the entire molecule. If you use 
the Translate dialog box to move a selected whole 
molecule to a point, the center of mass moves to 
the new point. When this option is off (no ✓), you 
can translate selected parts of molecules, distorting 
bond geometry.

Key

These settings regulate the stepwise rotation and translation of the 
contents of the workspace in response to your using the [3], [4], [1], 
[2], [PgUp], [PgDn], [Home], and [End] keys (see “Keyboard Equivalents for 
Tools” on page 48.)
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XY rotation This is the amount that the system rotates around 
the x or y axis when you use one of the [3], [4], 
[1],and [2] keys.

Z rotation This is the amount that the system rotates around 
the z axis when you use the [Home] and [End] keys.

XY translation This is the amount that the system translates in the 
x or y direction when you use [Shift], and one of the 
[3], [4], [1],and [2] keys.

Z translation This is the amount that the system translates in the 
z direction when you use [Shift], and one of the 
[Home] and [End] keys.

Zoom This is the factor that the system grows or shrinks 
by if you use the [PgUp] or [PgDn] key.

Clip This is the amount that the clipping plane moves 
by if you use [Shift], and one of the [PgUp] and [PgDn] 
keys.

Setup Image

The settings in this section control how an image is saved when 
you use the “Copy Image” command or press the [F9] key. (See 
page 118.) You can set the extent of the picture from the full 
screen to a specific menu or dialog box. You also choose the desti-
nation (Clipboard or File), file format (Bitmap or Metafile), and 
whether the image should be color or monochrome. You can use 
these images with other programs to prepare reports or publica-
tions.
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Window This setting determines the part of the screen to 
copy.

Top level This copies any active pull-down menu or 
visible dialog box. If these are not visible, it 
copies the active HyperChem window. You 
must use [F9] instead of Copy Image for 
menus and dialog boxes.

Workspace This copies only the workspace of the 
active HyperChem window.

HyperChem This copies the entire active HyperChem 
window, including its borders.

Full screen This copies everything on screen, includ-
ing other program windows.

File format You can choose either bitmapped (BMP) or Win-
dows metafile (WMF) formats, or both, to store a 
picture. HyperChem can store only one picture at 
a time in each file format. The next time you use 
the same file format, the new picture replaces the 
last one. You can also use a 24-bit RGB Bitmap 
(BMP) file format. Because this operation disables 
the standard color set used for display, specifying 
this format disables most other Setup Image 
options, including saving to the other formats and 
saving to the Clipboard.

Bitmap This saves the picture as a reproduction of 
the pixels on screen in the file chem.bmp. 
The resolution of this image is the same as 
the resolution of your monitor, which you 
chose when setting up Windows. Use 
Bitmap to save Spheres renderings or con-
tour plots from a single point, 
semi-empirical calculation (see “Single 
Point” on page 237).

RGB Bitmap This is like the regular Bitmap format 
above, but instead of using the standard 
color set which is used for ordinary display, 
the image pixels are stored in full 24-bit 
color. The appearance of regular bitmap 
pictures can change if you import them to 
other software that is using a different 
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color set, but an RGB bitmap does not 
change because it does not depend on an 
external color set. However, an RGB bit-
map can be displayed properly only by 
software that can process 24-bit color. Soft-
ware that cannot work in 24-bit color may 
be able to read an RGB bitmap but the 
resulting picture will look very strange. 
These pictures cannot be saved to the Clip-
board.

Metafile This saves the picture as a line drawing in 
the file chem.wmf1. Metafile is best for 
Sticks, Disks, Dots and Stick & Dots render-
ings. Metafiles require about 10 times less 
storage space than bitmap files containing 
the same renderings. The resolution of a 
metafile image does not depend on the 
monitor, but on the resolution of the out-
put device. For example, if you print a 
metafile on a laser printer, the resolution 
might be 300 dpi.

Destination You can choose one or both locations to store a pic-
ture.

File HyperChem stores the picture in the files 
chem.bmp and chem.wmf. You can use 
either or both files. Each file can hold only 
one picture at a time.

Clipboard HyperChem stores the picture as a bitmap 
or a metafile, or both, on the Windows 
Clipboard. The Display menu in the Win-
dows Clipboard program refers to a Meta-
file as a Picture. The Clipboard can hold 
only one image of each type at a time.

Color Check this box (✓) to store a picture in full color. 
Turn Color off to produce a black-and-white pic-
ture and to substitute dotted lines for certain col-
ored lines (see “Using Black-and-white Output” on 
page 74). For a BMP file format, color results in a 
file at least four times larger. For a WMF file, Color 
produces only a small difference in file size. For an 
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RGB bitmap file, Color makes no difference in file 
size.

Cursor Check this box (✓) for the cursor to appear in the 
picture. The cursor can be the mouse pointer, a 
HyperChem tool, or a text cursor (in a dialog box).

Isosurface Colors

These settings show the colors used for drawing the positive and 
negative lobes of isosurfaces. For Gouraud shaded surfaces and 
translucent surfaces, these colors are the two endpoints for the 
range of colors used for rendering.

Paths
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These settings show the directories which are used to hold Hyper-
Chem’s files.

Executable 
files

This is the directory that stores HyperChem’s exe-
cutable (program) files.

Parameter 
files

This is the directory that holds the molecular 
mechanics and semi-empirical parameter files, and 
the ab initio basis set files.

Log files This is the directory in which, by default, Hyper-
Chem saves a log file which you open.

Script files This is the directory which, by default, Hyper-
Chem looks in to find script files.

Ab initio 
integrals 

This is the directory in which HyperChem stores 
the temporary files that hold the 2-electron inte-
grals during ab initio calculations.

Network License

These settings control HyperChem’s network operations if you are 
using a network (rather than a stand-alone) version of Hyper-
Chem.

Local Access If this option is marked (✓), HyperChem will try to 
get a license to run from a network hardware lock 
installed on the machine that it is running on

NETBIOS/
NETBEUI/
NETAP

If this option is marked (✓), HyperChem will try to 
get a license to run over a NETBIOS/NETBEUI/ 
NETAP network.
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IPX/SPX If this option is marked (✓), HyperChem will try to 
get a license to run over an IPX/SPX network.

TCP/IP If this option is marked (✓), HyperChem will try to 
get a license to run over a TCP/IP network.

License 
Timeout 
Interval

If HyperChem is left running without user interac-
tion (that is, use of menu items), it will eventually 
release its network license so that other people can 
use it. This prevents people who forget to exit 
HyperChem from using up the licenses indefi-
nitely. This option allows you to specify how long 
(in minutes) HyperChem should wait before 
releasing its license for others to use. Even if you 
lose your network license due to timing out, the 
next time you try a menu operation, HyperChem 
will attempt to obtain another license. The license 
timeout interval should be set for a time somewhat 
longer than you expect that your calculations will 
take, since you cannot use a menu item while a cal-
culation is in progress.

TCP/IP 
options

These settings affect HyperChem’s interaction 
with TCP/IP networks.

Using Black-and-white Output

If you set Window color to White and Bonds to Black, HyperChem 
uses dotted and solid lines when it would normally use two colors. 
For example, when HyperChem draws contour lines for quantum 
mechanics calculations, positive contours appear solid and nega-
tive contours appear dashed (see “Plot Molecular Properties” on 
page 265).

Use Thick line to distinguish selected atoms from unselected atoms.

Exit 

Choose Exit or press [Alt]+ [F4] to end the HyperChem session. Hyper-
Chem asks if you want to save changes, if any, to the molecular 
system in the workspace. As HyperChem closes, it stores informa-
tion about its present state (for example, display conditions and 
calculation settings) in the Registry or in the file chem.ini. When 
you start HyperChem again, it uses these settings.
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Script Menu

Scripts use instructions from a file to automate HyperChem proce-
dures. These instructions include all normal HyperChem opera-
tions, including selecting menu items. You can use a script file to 
manipulate molecules, automate chemical calculations, and per-
form structural analyses. 

You see the Run Script dialog box (see the next section), which lets 
you choose a script file and start running the script.

You must use an editor, for example Windows Notepad, to write a 
script file. See “Automatic Operation with Scripts” on page 325 for 
the rules and procedures for writing a script.

Open Script 

When you choose Open Script, you see the Run Script dialog box 
to start a set of instructions, stored in a script file (usually with the 
extension .scr), that tells HyperChem what to do. 

The Run Script dialog box has the same components as the Open 
File dialog box (see page 53), except that the only file type listed is 
Script (*.SCR). If the script begins with comments, these will appear 
in the Comments text box when the file is selected in the list.

Note: When you start HyperChem, it automatically opens and 
runs the script in chem.scr. This script can contain any operations 
that you need. For example, you can use the script command 
change-user-menuitem to place scripts on the Script menu in place 
of Script One, and so on. Chem.scr must be in the Program direc-
tory, with the program executable files.

Open Script . . . Starts a script from a file that you choose

Script One These items are replaced by names of scripts that you 
can choose

. . . 

Script Ten 
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Script One . . . Script Ten

These items, inactive and in gray, indicate the locations for script 
names. To replace these items with names of scripts, you must 
write a script containing specific instructions (see the next exam-
ples). To start a script from this menu, double-click on the script 
name.

Example: :

This script adds the script name RedSelectionColor to the Script 
menu in place of Script One:

change-user-menuitem 1 RedSelectionColor color1.scr
script-menu-enabled(1) = true

RedSelectionColor appears in place of Script One on the Script 
menu. The second command is necessary in order to enable the 
command — that is, to make it active instead of gray and inactive.

Example:

This script adds the script name “Torsion 180” to the second entry 
in the script menu, and specifies that when it is selected by the 
user, a script command is executed:

script-menu-caption (1) “Torsion 180”
script-menu-enabled (1) yes
script-menu-command (1) “set-bond-torsion 180”

The new menu item executes the “set-bond-torsion” command. 
The command could instead be an instruction to run a script file, 
load a structure file, etc.

Note: If you name a script file chem.scr and place it in the Hyper-
Chem main directory, HyperChem runs the script automatically 
when you start up HyperChem. You can use this feature to cus-
tomize the script menus every time you start HyperChem.
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Help Menu

HyperChem Help is similar to Help for Microsoft Windows and all 
other Windows applications. See Microsoft Windows User’s Guide 
for information about using Help. 

You can use these keyboard shortcuts as alternatives to using the 
Help menu:

[F1] Shows the Help contents or, if you highlighted a 
menu item or have a dialog box active, the Help for 
that menu item or dialog box.

[Shift]+ [F1] Shows context-sensitive Help. If no menu or dialog 
is active this will activate the Help cursor. You click 
on the Tool icon, menu item or other part of the 
HyperChem window for Help on that topic.

About HyperChem

Choosing this item shows the About HyperChem dialog box with 
the version number of the HyperChem software, your serial num-
ber and the copyright notice. 

Index Lists topics available in the Help window

Keyboard Provides information for using keyboard keys with 
HyperChem

Commands Explains the commands (items) in each menu, with 
step-by-step instructions for using commands and 
descriptions of options in all dialog boxes

Tools Explains how to use HyperChem tools

Scripts & DDE Defines terms used in HyperChem commands, dialog 
boxes, and reference materials

Glossary Defines terms used in HyperChem commands, dialog 
boxes, and reference materials

Using Help Explains the HyperChem Help system

About Hyper-
Chem . . . 

Shows the release information (including version 
number) and serial number for HyperChem
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Chapter 5

Building Molecules

This chapter describes menu items and associated dialog boxes on 
the Build and Databases menus for building molecules. 

Build Menu

Use the Build menu to draw molecules and operate the Hyper-
Chem Model Builder. The Model Builder converts 2D drawings 
into 3D chemical models. The Build menu has these commands:

✓ Explicit Hydrogensa You add hydrogen atoms while drawing. 
HyperChem does not automatically add 
hydrogens during model building

Default Element ... You choose the element that the Drawing tool 
uses

Add 
Hydrogens 

Adds hydrogen atoms to a drawing to satisfy 
the valence requirements of heavy atoms 

Model Build 
/Add H & Model Build 

Creates a 3D model from a 2D drawing. Acts 
on selected atoms or on all atoms in the 
molecular system. Calculates atom types for 
molecular mechanics calculations. If Explicit 
Hydrogens is on, “Add H &” disappears from 
this item, and the Model Builder does not add 
hydrogen atoms to the structure
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✓Allow ions a You may add more bonds to an atom than the 
normal valence rules allow if you select this 
option

United Atoms b Reverses All Atoms (see below) and includes 
bonded hydrogen atoms as part of atom types 
for certain heavy atoms, simplifying molecular 
mechanics calculations. This item applies to 
selected atoms or, if there are no selections, to 
the whole molecular system

All Atoms b Reverses United Atoms (above) and represents 
all hydrogens as individual atoms for molecular 
mechanics calculations. This item applies to 
selected atoms or, if there are no selections, to 
the whole molecular system

Calculate Types Assigns the atom types necessary for molecular 
mechanics calculations. The Model Builder 
includes this function. This item applies to 
selected atoms or, if there are no selections, to 
the whole molecular system

Compile Type Rules If you change the atom types in the text file 
chem.rul, use this item to update the binary 
file, typerule.bin, that HyperChem uses for 
molecular mechanics calculations

Set Atom Type . . . c Changes the atom type for all selected atoms

Set Charge . . . c Sets the atomic charge for all selected atoms

Constrain 
Geometry . . . c

Specifies the geometry around a single, 
selected atom. The Model Builder can use this 
constraint when constructing a 3D model

Constrain Bond 
Length . . . c

Specifies the bond length for a single, selected 
bond. The Model Builder can use this con-
straint when constructing a 3D model

Constrain Bond 
Angle . . . c

Specifies the bond angle for a single, selected 
bond angle. The Model Builder can use this 
constraint when constructing a 3D model
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Explicit Hydrogens

If Explicit Hydrogens is on (✓), you can add hydrogen atoms while 
you draw molecules. As you use the Drawing tool, all singly 
bonded atoms appear first as hydrogens. Adding another bond 
changes a hydrogen atom to the default element (for example, car-
bon).

When Explicit Hydrogens is on, Add H & Model Build changes to 
Model Build. The Model Builder does not add additional hydrogen 
atoms.

When Explicit Hydrogens is off (no check mark), the Drawing tool 
places only the default element. Use the Model Builder or Add 
Hydrogens option (see page 84) later to add the necessary hydro-
gen atoms to complete the valence requirements of heavy atoms.

a. A check mark appears next to this item when it is on. Turning it on af-
fects all further drawing, until you choose it again to turn it off.

b. United Atoms and All atoms apply to selected atoms in a molecular sys-
tem, and are not alternatives for a whole molecular system.

c. When this item is gray, it is temporarily unavailable. You must select 
an appropriate group of atoms to make it available. 

Constrain Bond 
Torsion . . . c

Specifies the bond torsion angle for a selected 
torsion. The Model Builder can use this con-
straint when constructing a 3D model

drawn with Explicit 
Hydrogens on

drawn with Explicit 
Hydrogens off
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Default Element 

When you choose Default Element, you see the Element Table dia-
log box for choosing the element for drawing. The Drawing tool 
places atoms of the default element into the workspace. You can 
also display this dialog box by double-clicking the Drawing tool.

Choose an element in the periodic table (hydrogen through 
lawrencium) or a lone pair of electrons (useful for certain molecu-
lar mechanics calculations). The default element is changed to the 
element that you clicked on and the drawing tool is selected so 
that you can immediately draw in the HyperChem workspace. The 
dialog box remains on screen until you dismiss it. You can change 
the default element while you are drawing a molecule. Choose a 
new element from the Element Table dialog box and continue 
drawing. Double clicking on an element will change the default to 
that element and dismiss the dialog box.

You can also change an element after you draw it. Choose a new 
element from the Element Table dialog box and, using the Draw-
ing tool, L-click on the atom you want to change. For example, if 
you are drawing with carbon atoms, choose oxygen from the Ele-
ment Table dialog box; then L-click on a carbon to change it to an 
oxygen.

drawn with Explicit Hydrogens off, 
then used Add H & Model Build

drawn with Explicit Hydrogens on, 
then used Model Build
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Element Table Dialog Box

Double-click on the Drawing icon or choose Default Element on the 
Build menu to display this dialog box.

The dialog box lets you select the default element by clicking on 
the atomic symbol. This will change the cursor to the Drawing 
Tool and you can immediately start drawing in the workspace with 
the new default element. Single clicking will leave the dialog box 
open and double clicking will close it. This dialog box also lets you 
turn these drawing options on or off:

Allow ions Relaxes the valence rules for an element so that 
you can draw more than the normal number of 
bonds. You can also set this condition by choosing 
Allow Ions on the Build menu.

Explicit 
hydrogens

Lets you add hydrogen atoms with the Drawing 
tool. Singly bonded atoms appear first as hydro-
gens, then change to the default element when 
you add the next bond. If this setting is off, you 
draw only heavy atoms, and HyperChem adds 
hydrogens during model building. You can also 
turn this condition on or off by choosing Explicit 
Hydrogens on the Build menu (see page 81). See 
also “Add Hydrogens” in the next section.

Properties Shows the Element Properties box for the current 
default element (see below).
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You can dismiss the Element Table dialog box by double clicking 
on the control-menu box or by double clicking on an element. The 
latter will also change the default element.

Note: To draw a hydrogen with multiple bonds, choose hydrogen 
as the default element and turn Allow ions on. 

Caution: You can use any elements from the periodic table for 
drawing. However, for some elements the Model Builder might not 
provide appropriate bond lengths or angles for all atoms. Also, 
semi-empirical and ab initio calculations cannot accommodate all 
elements.

Element Properties

If you click on the Properties... button in the Element Table dialog 
box, the Element Properties box will appear, showing the physical 
properties of the current default element. Alternately, if you shift-
click on an element button in the Element Table dialog box, the 
properties of the element that you selected will be shown. This 
does not change the default drawing element.

Add Hydrogens

Add Hydrogens supplies hydrogen atoms to complete the valence 
shells of heavy atoms. This item works on selected atoms or on all 
atoms in the molecular system, and works with either a 2D draw-
ing or a 3D model.
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Add Hydrogens works with Explicit Hydrogens turned either on or 
off. If  Explicit Hydrogens is on, Add Hydrogens provides hydrogen 
atoms in addition to the hydrogens already in the molecule.

Add Hydrogens uses a limited portion of the Model Builder (see the 
next section) to determine the number and location of hydrogen 
atoms. However, it does not convert a 2D drawing into a 3D 
model.

Model Build/Add H & Model Build

Model Build uses the Model Builder to convert your 2D drawing 
into a 3D molecular model. Model Build works on selected atoms 
or, if there is no selection, on all atoms in the molecular system.

Caution: The Model Builder acts only on selected atoms, if you 
select any. This can lead to distortion of the molecule if the selec-
tion is not a functional group.

Model Build appears on the Build menu if Explicit Hydrogens is on. 
HyperChem does not add hydrogen atoms while building a 3D 
model. This item changes to Add H & Model Build if Explicit Hydro-
gens is off. The Model Builder then adds all needed hydrogen 
atoms.

The Model Builder uses a set of rules to construct an approximate 
3D model. These rules might have limitations with some struc-
tures. For a better 3D model, first use the Model Builder, then use 
Geometry Optimization on the Compute menu, with either a 

Add 
Hydrogens
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molecular mechanics or semi-empirical quantum mechanics 
method.

The Model Builder does not add charges (ionic or partial) to mole-
cules. You can add charges to selected atoms using Set Charge on 
the Build menu. Or, you can use a semi-empirical or ab initio quan-
tum mechanical calculation to determine atomic charges (see 
“Single Point” on page 237).

The Model Builder assigns atom types (see page 89). Sometimes 
these types need to be applied manually.

For a discussion of the Model Builder, see “Converting 2D Draw-
ings into 3D Structures” on page 304.

Allow Ions

When Allow Ions is on (✓), you can draw up to twelve bonds to an 
atom. With Allow Ions off, you can draw only four bonds to carbon, 
three to nitrogen, two to oxygen, and so on.

HyperChem does not add ionic groups to molecules. You can do 
this by using Set Charge (see page 91) or by using a semi-empirical 
or ab initio quantum mechanical calculation (see “Semi-empirical” 
on page 190, and “Ab Initio” on page 204).

Allow Ions remains on until you turn it off by choosing this item 
again.

Model Build

2D drawing 3D model
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United Atoms

United Atoms simplifies a molecular structure and calculations on 
this structure by including hydrogen atoms in the definition of a 
carbon atom. Force fields have different atom types (see “Atom 
Types” on page 464) for these composite atoms. United Atoms acts 
on selected atoms, or, if there is no selection, on the whole molec-
ular system. This choice remains on until you select the atoms 
again and choose All Atoms (see the next section).

Note: United Atoms applies to selected atoms, so you can use both 
a united-atom and an all-atom representation in the same molec-
ular system.

Note: When you change between United Atoms and All Atoms, 
HyperChem changes atom types, as needed, for the force field in 
effect.

Note: United Atoms and All Atoms are available only after you 
choose a molecular mechanics force field on the Setup menu (see 
“Force Field Options Dialog Box” on page 188).

The united atom rules for simplifying a structure depend on the 
force field that you choose in the Setup menu (see “Force Field 
Options Dialog Box” on page 188) and the residue templates for 

United Atoms

All Atoms

= united atom types for AMBER force field
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the force field (see “Residue Template Files” on page 527). In the 
literature on force fields, united atoms are also known as extended 
atoms or extended hydrogens.

All Atoms

All Atoms reverses the United Atoms choice, so that the molecular 
system represents every hydrogen as a separate atom. All Atoms 
applies to selected atoms or, if there is no selection, to the whole 
molecular system. 

Note: All Atoms applies to selected atoms, so you can use both a 
united atom and an all atom representation in the same molecular 
system.

In the literature on force fields, ‘all atoms’ is also known as ‘explicit 
hydrogens’.

Calculate Types

Calculate Types assigns atom types to selected atoms or to all atoms 
in the molecular system. Atom types represent the stereochemical 
properties of each atom (for example, CO for sp2 carbonyl carbon, 
CT for tetrahedral carbon, and CH for a united atom representa-
tion of an sp3 carbon with no separate hydrogen). Each molecular 
mechanics force field uses a different set of atom types. Calculate 
Types applies types for the last force field you chose in the Molec-
ular Mechanics Force Field dialog box (see page 185).

Molecular mechanics calculations require atom types. Since the 
Model Builder (see “Model Build/Add H & Model Build” on page 
85) automatically makes these assignments, you need only to use 
Calculate Types when you do not plan to use the Model Builder. If 
you change force fields, HyperChem automatically assigns new 
types. In some cases it may be necessary to assign atom types man-
ually (see page 89).

To check that all atoms in the workspace have an atom type, 
choose Labels on the Display menu and then choose Type for the 
label. Atoms without assigned types appear with a ** label.

If you are using a new or altered set of atom types (a new chem.rul 
file or type parameter file), use Compile Type Rules on the Build 
menu before you do a molecular mechanics calculation.
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Compile Type Rules

Use Compile Type Rules if you change the rules for assigning atom 
types that HyperChem uses for molecular mechanics calculations 
(see “Atom Types” on page 464). You can change the rules for 
assigning atom types in the file chem.rul by using a text editor. 
Then use Compile Type Rules to create the new binary version of 
this file, typerule.bin, which HyperChem uses for calculations.

Caution: If you change the file chem.rul, be sure to back up or save 
copies of the original files. Errors in the new chem.rul can prevent 
HyperChem calculations.

Set Atom Type 

When you select one or more atoms and then choose Set Atom 
Type, a dialog box appears for changing the type for selected 
atoms. HyperChem uses atom types for molecular mechanics cal-
culations. 

HyperChem assigns atom types when you choose Model Build or 
Calculate Types on the Build Menu (see page 85 and page 88), 
when you use a residue from the Databases menu, when you add 
water molecules to a periodic box, or when you open a PDB or 
MOL2 file. The types depend on the molecular mechanics method 
that you choose (see page 185).

Note: If you select multiple atoms, Set Atom Type assigns the same 
atom type to each of the selected atoms.
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Set Atom Type Dialog Box

The Set Atom Type dialog box lists atom types for the active force 
field. The selected atom appears highlighted. For example, the 
Model Builder might show the type CT for a carbon atom. You can 
change this to another atom type in the list. 

Caution: HyperChem does not check your choice. Be sure to pick 
an atom type appropriate for the element.

To check existing atom types in a molecular system, choose Labels 
on the Display menu and then choose Type for the label. Atoms 
without assigned atom types have a ** label.

The MM+ calculation method can work with unknown atom types 
using its Default Force Field (see the Computational Chemistry refer-
ence manual).(The other molecular mechanics force fields require 
that types be assigned to all atoms.) The MM+ Default method is 
able to assign force field parameters on the basis of bonding char-
acteristics. This can be used to work around some limitations of 
the molecular mechanics methods. For example, in structures like 
biphenyl, all of the carbon atoms are assigned types appropriate 
for sp2 atoms. The bond between the rings joins two sp2-type 
atoms, and so is given the characteristics of a double bond: it is rel-
atively short, and all of its neighboring atoms are forced towards a 
single plane, even though the bond actually is single, and the rings 
should be tilted with respect to each other. If the two atoms where 
the rings are joined are set to the unknown (**) type, an MM+ cal-
culation can give the proper results.

Note: Set Atom Type is gray unless you select one or more atoms.
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Set Mass 

The Set Mass Dialog box is used to set the mass for selected atoms. 
By default, when an atom is drawn it is assigned the average 
atomic mass for that element. For vibrational analysis (see “Vibra-
tions” on page 261) it is sometimes desirable to use different val-
ues.

Note: If you select multiple atoms, Set Mass assigns the same atom 
mass to each of the selected atoms.

Set Atom Mass Dialog Box

In the Set Atom Mass dialog box, enter a positive real number, the 
mass of the selected atom in atomic units.

Caution: HyperChem does not check to see if the mass you assign 
is a reasonable value for the atom(s) selected.

To check existing atomic masses, choose Labels on the Display 
menu and then choose Mass for the labels. When you assign a new 
mass, the label changes to show the new mass, but only after you 
deselect the atom.

Note: Set Mass is gray unless you select one or more atoms.

Set Charge 

You use Set Charge to change the net charge on selected atoms. 
Atoms you draw in HyperChem do not have atomic charges. To 
add charges to the atoms, you can use Set Charge or run a semi-
empirical or ab initio calculation. 

For amino acid and nucleic acid residues and for water molecules 
in a periodic box, HyperChem provides atomic charges. Molecular 
mechanics calculations use net atomic charges to predict electro-
static interactions.
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Note: If you select multiple atoms, Set Charge assigns the same 
atom charge to each of the selected atoms.

Set Atom Charge Dialog Box

In the Set Atom Charge dialog box, enter a positive or negative 
charge, either a fraction or a whole number. For example, –0.20 
indicates a slight excess of electrons; +2.0 indicates a cation defi-
cient in two electrons. 

Caution: HyperChem does not check the sign or magnitude of the 
charge. Be sure it is appropriate for an atom. Also, HyperChem 
does not check the charge distribution in a molecule.

To check existing atomic charges, choose Labels on the Display 
menu and then choose Charge for the labels. Atoms without a 
charge have a 0.000 label. When you assign a new charge, the label 
changes to show the new charge, but only after you deselect the 
atom.

Note: Set Charge is gray unless you select an atom.

Constrain Geometry 

Constrain Geometry specifies the geometry of the bonds around a 
selected atom when you use the Model Builder. (It does not affect 
the geometry during optimizations; see “Restraints” on page 224.) 
When you choose Constrain Geometry, you see the Constrain 
Geometry dialog box with choices for geometry. To constrain the 
chirality of an atom for the Model Builder, [Shift]+L-click on one of 
its bonds with the drawing tool (see “Changing Chirality” on page 
303).

HyperChem uses the Computed option as the default setting for 
geometry. With Computed, the Model Builder decides on the 
geometry.

Note: This constraint is a high priority for the Model Builder (see 
“Converting 2D Drawings into 3D Structures” on page 304). How-
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ever, additional constraints can affect the model and might alter 
the final results.

You can eliminate the constraint and return to the Model Builder’s 
geometry by choosing Computed in this dialog box, and then by 
choosing Model Build on the Build menu.

Note: Constrain Geometry is gray unless you select an atom.

Constrain Geometry Dialog Box

These are the choices for geometry. All bond angles are relative to 
one selected atom:

Computed No constraint. The Model Builder decides on the 
geometry.

Linear Two bonds at 180 degrees. If the selected atom has 
more than two bonds, the Model Builder con-
strains two bonds only to 180 degrees. 

Trigonal Three bonds in a plane, with 120 degrees between 
each pair of bonds. If the selected atom has more 
than three bonds, the Model Builder constrains 
three bonds only to a plane and 120 degrees. If the 
selected atom has only two bonds, the Model 
Builder constrains the two bonds to a 120 degree 
angle. 

Tetrahedral Four bonds, in a tetrahedral arrangement, with 
109.47 degrees between each pair of bonds (in 
every pair-wise combination). If the selected atom 
has more than four bonds, only four are in a tetra-
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hedral arrangement. If the selected atom has three 
bonds, all pairs have 109.47 degree angles. 

Square Planar Four bonds in a plane, with 90 degrees between 
each cis pair of bonds. If the selected atom has 
more than four bonds, the Model Builder con-
strains only four of them to the plane and to angles 
of 90 degrees. If it has two or three bonds, then one 
or two bond angles, respectively, will be con-
strained to the plane and to 90 degree angles.

Bipyramidal Five bonds, with three bonds in a plane (120 
degrees from each other), and two bonds perpen-
dicular to the plane and 180 degrees apart. If the 
selected atom has six bonds, the Model Builder 
constrains four bonds to a plane, but only three are 
separated by 120 degrees. If the selected atom has 
two or three bonds, these atoms lie in a plane with 
120 degree angles. The fourth bond is orthogonal 
to this plane at 90 degrees to the other bonds.

Octahedral Six bonds, with all angles at 90 or 180 degrees. If 
the selected atom has less than six bonds, all bond 
angles are 90 or 180 degrees.

To use Constrain Geometry:

1. Select an atom. 

2. Choose Constrain Geometry on the Build menu. 

3. Choose one of the geometries provided. This geometry 
remains with this atom during this HyperChem session until 
you choose another geometry. A HIN file does not store infor-
mation about geometry constraints.

linear trigonal tetrahedral bipyramidal octahedral
94



Build Menu
4. Deselect the atoms or select all atoms in the molecule.

5. Choose Model Build on the Build menu.

Constrain Bond Length 

Constrain Bond Length limits the length, in Ångstroms, of a 
selected bond when you use the Model Builder. (It does not affect 
the bond length during optimizations; see “Restraints” on page 
224.) First select a bond or two bonded atoms, then choose Con-
strain Bond Length. The Constrain Bond Length dialog box appears 
for entering a bond length. 

Note: This constraint is a high priority for the Model Builder (see 
“Converting 2D Drawings into 3D Structures” on page 304). How-
ever, additional constraints can affect the model and might alter 
the final result.

You can eliminate the constraint and return to the Model Builder’s 
default bond length by selecting the bond, choosing Computed in 
this dialog box, and then choosing Model Build on the Build menu. 

Note: Constrain Bond Length is gray unless you select two 
covalently bonded atoms.

Constrain Bond Length Dialog Box

Computed No constraint. The Model Builder decides on the 
bond length.

Other Enter a positive value > 0 to 1000 Ångstroms. The 
practical range is 0.75 to 4 Ångstroms.

You can return to the Model Builder’s bond length by choosing 
Computed in this dialog box and then choosing Model Build on the 
Build menu. 
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Constrain Bond Angle 

Constrain Bond Angle specifies the angle between two adjacent 
bonds when you use the Model Builder. (It does not affect the 
bond angle during optimizations; see “Restraints” on page 224.) 
First select three atoms or the two included bonds, then choose 
Constrain Bond Angle. The Constrain Bond Angle dialog box 
appears for you to choose one of the angles provided or to enter a 
new bond angle, in degrees.

Note: This constraint is a high priority for the Model Builder (see 
“Converting 2D Drawings into 3D Structures” on page 304). How-
ever, additional constraints can affect the model and might alter 
the final result.

You can eliminate the constraint and return to the Model Builder’s 
default bond angle by selecting the bond, choosing Computed in 
this dialog box, and then choosing Model Build on the Build menu. 

Note: Constrain Bond Angle is gray unless you select three atoms 
that form a bond angle.

Constrain Bond Angle Dialog Box

These are the choices for a bond angle:

Computed No constraint. The Model Builder decides on the 
bond angle.

Linear 180 degrees.

Trigonal 120 degrees.

Tetrahedral 109.47 degrees.
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Orthogonal 90 degrees.

Other Enter a value in the range of ±360 degrees.

Constrain Bond Torsion 

Constrain Bond Torsion specifies a torsion angle when you use the 
Model Builder. (It does not affect the torsion angle during optimi-
zations; see “Restraints” on page 224.) First select the four atoms 
or the three included bonds that define a torsion angle. Then 
choose Constrain Bond Torsion. When the dialog box appears, 
choose one of the standard torsion angles or enter a new torsion 
angle.

Note: This constraint is a high priority for the Model Builder (see 
“Converting 2D Drawings into 3D Structures” on page 304). How-
ever, additional constraints can affect the model and might alter 
the final result. 

You can eliminate the constraint and return to the Model Builder’s 
default torsion angle by selecting the angle, choosing Computed in 
the dialog box, and then choosing Model Build on the Build menu. 

Note: Constrain Bond Torsion is gray unless you select four atoms 
that form a torsion.

Constrain Bond Torsion Dialog Box

These are the choices for a torsion angle:

Computed No constraint. The Model Builder decides on the 
torsion angle.
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Trans 180 degrees.

Cis 0 degrees.

Gauche+ 60 degrees.

Gauche– –60 degrees.

Other Enter any value ±180 degrees.

Databases Menu

Use the Databases menu to create proteins and nucleic acids (DNA 
and RNA) from a library of residues. The residues have a standard 
chemical structure. HyperChem provides residue structures (in 
template files) and rules for connecting these residues to make 
macromolecules. The Databases menu has these commands: 

a. When this item is gray, it is temporarily unavailable. You must change 
some condition in HyperChem to make it available. 

Amino 
Acids... 

Creates polypeptides, starting from the N-terminus. The 
Amino Acids dialog box appears for selecting amino acid 
residues and polypeptide conformation

Make 
Zwitterion 

Changes a polypeptide, constructed from database resi-
dues, into a zwitterion, with charged C-terminal (COO–) 
and N-terminal (NH3

+) groups

Remove 
Ionic Ends 

Reverses Make Zwitterion, returning the C- and N-termi-
nal groups to –NH and –CO

Nucleic 
Acids... 

Creates single- or double-stranded DNA or RNA. You can 
select nucleotide residues, polynucleotide conformations, 
and sugar conformations

Add Counter
Ions 

Adds sodium ions to the polynucleotides in the work-
space, neutralizing the phosphate groups’ charges

Mutate...a You can change one selected animo acid or nucleotide 
residue into another. This item applies only to peptides or 
polynucleotides constructed from database residues or to 
molecules from PDB files
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Proteins and nucleic acids from Brookhaven PDB files (see 
page 319) are composed of residues. You can use all the menu 
items to modify molecules from those files.

Amino Acids 

Choose Amino Acids to construct polypeptides from amino acid 
residues. These amino acids have standard chemical structures. 

In the Amino Acids dialog box, choose the secondary conforma-
tion of the polypeptide (Alpha helix, Beta sheet, or Other for your 
own Phi, Psi, and Omega angles). Then choose from these residues, 
starting at the N-terminus:

• 20 standard amino acids.

• Two neutral and one protonated form of histidine (Hid, Hie, 
and His). At physiological pH, the side group of histidine is 
either positively charged or neutral, depending on its local 
environment.

• Half-cystine residues (Cyx) for constructing disulfide links (see 
“Cross-linking with Cyx” on page 311).

• One N-terminal blocking group (Ace). Use this as the first resi-
due only.

• One C-terminal blocking group (Nme). Use this as the last res-
idue only.

Note: Residues from this dialog box are not equivalent to amino 
acids you construct atom by atom. You can add new residues to the 
choices in the Amino Acids dialog box or modify residues obtained 
from this dialog box (see “Adding Unusual Residues” on page 312).

HyperChem links residues together in the order you select them. 
A C-terminal blocking group (cap) prevents further addition. After 
adding a cap, choosing additional residues begins another 
polypeptide. 

If the polypeptide has no cap, you can later add more residues to 
the C-terminus. If you turn the polypeptide into a zwitterion (see 
the following section), you cannot add more residues to this mol-
ecule; choosing additional residues begins another polypeptide.

As you extend the polypeptide, you can change these properties of 
the next residues that you add:
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• Secondary structure (Alpha helix, or Beta sheet, or Other)

• Conformation of the peptide bond (Omega)

• D or L isomer of each residue

These choices remain in effect until you make other choices. You 
cannot change these properties after you add the residues.

Note: Do not use the Model Builder on a whole constructed 
polypeptide. The Model Builder discards the optimized geometry 
in these molecules and cannot accurately reproduce the structure. 
You can, however, use the Model Builder on selected atoms; for 
example, for small modifications of standard residues.

For detailed instructions on building molecules from residues, see 
“Building Molecules from Residues” on page 308.

Amino Acids Dialog Box

HyperChem provides these amino acid residues:

Ala Alanine, neutral aliphatic, nonpolar.

Gly Glycine, neutral, polar.

Ser Serine, neutral polar.

Thr Threonine, neutral, polar.

Leu Leucine, neutral, aliphatic, nonpolar.

Ile Isoleucine, neutral, aliphatic, nonpolar.

Val Valine, neutral, aliphatic, nonpolar.

Asn Asparagine, neutral, polar.

Gln Glutamine, neutral, polar.

Arg Arginine, positively charged.
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Hid Histidine, neutral, with hydrogen in the delta 
nitrogen.

Hie Histidine, neutral with hydrogen in the epsilon 
nitrogen.

Hip, His Histidine, positively charged, with a hydrogen on 
both the delta and epsilon nitrogens.

Trp Tryptophan, neutral aromatic, nonpolar.

Phe Phenylalanine, neutral aromatic, nonpolar.

Tyr Tyrosine, neutral aromatic, polar.

Glu Glutamic acid, negatively charged.

Asp Aspartic acid, negatively charged.

Lys Lysine, positively charged.

Pro Proline, neutral, nonpolar.1

Cys Cysteine, neutral, polar.

Cyx Half-cystine, neutral, polar. Cyx in a molecule 
from a PDB file is a full (cross-linked) cystine resi-
due. Cyx stands for a whole cystine residue if a 
molecule comes from a PDB file.

Met Methionine, neutral, nonpolar.

Ace Acetyl, N-terminal blocking group.

Nme N-methyl amino; C-terminal blocking group.

HyperChem gives you these choices for the conformation of the 
next residues that you add. Each amino acid that you add to a 
polypeptide can have a different secondary conformation. In this 
way, the polypeptide can have stretches of alpha-helical structure, 
beta-pleated structure, and other transitional conformations.

Alpha helix Sets standard Phi and Psi torsional angles of –58 
and –47 degrees for an alpha helix, with a 
transpeptide bond (Omega = 180 degrees).

1. When you incorporate proline into a polypeptide, HyperChem cannot use the Phi or Psi torsional 
angles in this dialog box. Instead, it uses the angles required by the pyrrolidine ring.
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Beta sheet Sets standard Phi and Psi torsional angles of 180 
and 180 degrees for a beta pleated sheet, with a 
transpeptide bond (Omega = 180 degrees).

Other Accepts nonstandard values for Phi, Psi, and 
Omega torsional angles.

Phi Torsional angle (φ) for C–N–Cα–C. Range: ± 360 
degrees.

Psi Torsional angle (ψ) for N–Cα–C–N. Range: ± 360 
degrees.

Omega The peptide bond torsional angle (ω), normally 
trans, from 107 to 180 degrees. Applies to the next 
amino acid residue. Range:± 360 degrees.

Isomer Lets you choose the usual L stereoisomer (S chiral-
ity) or the D stereoisomer (R chirality).

Conformation Phi Psi Other

Alpha  -58.00 -47.00 180

Beta 180  180 180

Other ±180 ±180 ±180

ω

φ

ω

ψ

α ALA

α 
VAL

α 
GLY
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Note: The Amino Acids dialog box stays on screen. You can leave 
this dialog box in the workspace while using tools or other menu 
items (for example, Labels on the Display menu).

Make Zwitterion

 At neutral pH in solution, polypeptides exist as zwitterions, with 
–NH3

+ and –COO– terminal groups. Make Zwitterion converts a 
selected polypeptide, constructed from the Databases menu or a 
PDB file, into a zwitterion. If there are no selected molecules, Make 
Zwitterion acts on all polypeptides in a molecular system. The 
polypeptide must have the usual terminal groups (–NH and –CO), 
without terminal caps (Ace or Nme). 

When you construct polypeptides with HyperChem, the ends are 
incomplete (–N–H and –C–O). Make Zwitterion converts the ends 
to –NH3

+ and –COO–.

Note: Amino acid residues from a database (the Databases menu or 
a PDB file) are composed of atoms with partial charges. Make Zwit-
terion changes the partial charges on the terminal atoms. It does 
not change the charges on side groups of amino acids (for exam-
ple, acidic, basic, or imidazole side groups).

Make Zwitterion prevents adding more amino acid residues to 
existing polypeptides. If you choose additional residues from the 
Amino Acids dialog box, they start a new polypeptide.

Remove Ionic Ends (see the next section) reverses the results of 
Make Zwitterion.
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Remove Ionic Ends

Remove Ionic Ends reverses the results of Make Zwitterion. This con-
verts –NH3

+ and –COO– terminal groups in a polypeptide to –NH 
and –CO.

Nucleic Acids 

Choose Nucleic Acids to construct polynucleotides (DNA and RNA) 
from nucleic acid residues. These residues have standard chemical 
structures.

carboxyl end

amino end

-0.463

0.252

0.616

-0.504

Remove Ionic Ends

-0.706 -0.706

0.524

0.312

0.312

-0.263

0.312

Make Zwitterion
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In the Nucleic Acids dialog box, you can choose the secondary 
structure for added residues (A, B, Z, or Other for your own confor-
mational angles). 

You can create a polynucleotide, starting at the 5′ or 3′ end, by 
choosing from these nucleic acid residues:

• Four deoxyribonucleotides (monophosphate)

• Four ribonucleotides (monophosphate)

• A 3′ cap to block elongation

• A 5′ cap to block elongation

Note: Residues from this dialog box are not equivalent to nucleic 
acids that you construct atom by atom. You can add new residues 
to the Nucleic Acids dialog box or modify residues obtained from 
this dialog box (see “Adding New Residues” on page 538).

HyperChem links residues together in the order that you select 
them, starting from the 5′ end. This is the natural order for DNA 
or RNA synthesis. If you want to build the polymer from the 3′ 
end, turn Backward on (✓) in the dialog box. 

Caps prevent further addition of residues to either the 5′ or 3′ ends. 
After adding a cap, additional residues begin another polynucle-
otide. If the polynucleotide has no cap, you can add more residues 
later. 

As you extend a polynucleotide, you can change these properties 
of the next residues that you add:

• Secondary conformation (A, B, Z, or Other). 

• Either a 2′ Endo or a 3′ Endo pucker for the sugar ring. The A 
form of DNA normally contains deoxyribose sugar in the more 
stable C3′–endo form. The B form of DNA contains the C2′–
endo sugar.

• Double-stranded. This adds the residue you select, plus its 
complementary, hydrogen-bonded, base. HyperChem is 
primarily concerned with base pairing; some bonds in the 
complementary strand might have incorrect bond lengths and 
some base pairs might not have the correct twist angles. Use 
geometry optimization to correct any errors in structure.
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Caution: Do not use the Model Builder on a constructed polynu-
cleotide. The Model Builder discards the geometry in these mole-
cules and cannot accurately reproduce the structure.

These choices remain in effect until you make other choices. You 
cannot change these properties after you add the residues.

For detailed instructions on building molecules from residues, see 
“Building Molecules from Residues” on page 308.

Nucleic Acids Dialog Box

HyperChem provides these nucleotide residues:

dA Deoxyadenosine 5′–monophosphate, a compo-
nent of DNA.

dT Deoxythymidine 5′–monophosphate, a compo-
nent of DNA.

dC Deoxycytidine 5′–monophosphate, a component 
of DNA.

dG Deoxyguanosine 5′–monophosphate, a compo-
nent of DNA.

rA Adenosine 5′–monophosphate, a component of 
RNA.

rU Uridine 5′–monophosphate, a component of RNA.

rG Guanosine 5′–monophosphate, a component of 
RNA.

rC Cytidine 5′–monophosphate, a component of 
RNA.

5CAP A cap (–OH) for terminating a strand at its 5′ end.
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3CAP A cap (–OH) for terminating a strand at its 3′ end.

HyperChem gives you these choices for the next residues that you 
add:

Helix Form This gives the secondary conformation of polynu-
cleotide strands. Each helix form has characteristic 
torsional angles, twist (amount of rotation for each 
residue), and pitch (the height of one turn). 

A Form A right-handed helical conformation 
found in dehydrated, double-stranded 
DNA, with about 11 residues per turn. 

B Form A right-handed helical conformation 
found in hydrated, double-stranded DNA, 
with about 10 residues per turn. 

Z Form A left-handed helical conformation found 
in double-stranded DNA, with about 12 
residues per turn. Alternate residues (odd- 
and even-numbered) on one strand of Z 
DNA have different torsion angles (see the 
next table).

Other Accepts your values for torsion angles in 
the polynucleotide backbone (see follow-
ing table).

Alpha (α) Torsion angle (see diagram following). 
Acceptable range: ±360 degrees.

a. Torsion angles for odd- and even-numbered residues in a strand of Z DNA.

Conf. Alpha Beta Gamma Chi Delta Epsilon Zeta

A –74.82 –179.1 58.9 –158.97 78.42 –154.98 –67.21

B –39.17 –151.44  30.89 –95.44 156.56 159.19  –98.97

Za (odd)  47  179  –165  68  99  –104  –69

Za (even)  –137  –139  56  –159  138  –94  80

Other  ± 180  ± 180  ± 180  ± 180  ± 180  ± 180  ± 180
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Beta (β) Torsion angle (see diagram following). 
Acceptable range: ±360 degrees.

Gamma (γ) Torsion angle (see diagram following). 
Acceptable range: ±360 degrees.

Chi (χ) Torsion angle (see diagram following). 
Acceptable range: ±360 degrees.

Delta (δ) Torsion angle (see diagram following). 
Acceptable range: ±360 degrees.

Epsilon (ε) Torsion angle (see diagram following). 
Acceptable range: ±360 degrees.

Zeta (ζ) Torsion angle (see diagram following). 
Acceptable range: ±360 degrees.

Sugar Form Conformations of the ribose ring.

2′ Endo C2′ is out of the plane of the ring, on the 
same side as C5′. 

3′ Endo C3′ is out of the plane of the ring, on the 
same side as C5′.
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Double 
Strand

When this option is on (✓), HyperChem adds the 
complementary residue, according to Watson-
Crick base-pairing rules, and constructs an antipar-
allel polynucleotide. You can switch between dou-
ble strand and single strand to construct partially 
base-paired molecules. 

Backward When this option is on (✓), HyperChem starts 
polymerization from the 3′ end, adding nucle-
otides to the 5′ end. This is opposite to the normal 
direction of DNA or RNA synthesis. This choice 
affects an entire polynucleotide and you must set 
it before starting a molecule.

Note: The Nucleic Acids dialog box stays on screen. You can leave 
this dialog box in the workspace while you use the Tools or other 
menu items (for example, Labels on the Display menu).

Add Counter Ions

Add Counter Ions places a sodium ion near each phosphate group 
on a polynucleotide backbone. The Na+ ion is 1.688 Ångstroms 
equidistant from each oxygen atom in a phosphate group.

counter ions
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If you choose Add Counter Ions and then add more residues, only 
the original residues have counter ions. Choose Add Counter Ions 
again to add Na+ ions to the new residues.

Note: To remove Na+ ions, use Clear or Cut on the Edit menu.

If you store the system in a HIN file, the file also contains the 
counter ions.

Mutate

Mutate substitutes a residue for a residue already in a polypeptide 
or polynucleotide. This biopolymer must contain residues from 
the Databases menu or it must come from a PDB file (see page 319) 
or MOL2 file. The Mutate dialog box lists amino acids or nucle-
otides for substitution.

Note: Mutate is gray until you select a residue.

Mutate Dialog Box

The dialog box shows a list of the available residues (see 
Appendix E). If you are mutating an amino acid residue, you can 
specify whether you want the new residue to be the Levorotatory 
Isomer or the Dextrorotatory Isomer. If you are mutating a nucle-
otide residue, these buttons are gray and inactive.
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To change a residue:

1. Set the Selection tool to Residues (L-click on the Selection icon, 
then choose Residues on the Select menu).

2. Select a single residue from the molecular system.

3. Choose Mutate on the Databases menu.

4. In the Mutate dialog box, L-click on a new residue and 
L-click OK.

HyperChem substitutes the new residue for a selected residue.

Choices of Nucleotide Residues

The Mutate dialog box provides residues listed in the Nucleic Acids 
dialog box, plus residues from the template (TPL) files that are not 
available in the Nucleic Acids dialog box. The additional residues 
(see “Nucleic Acid Residues” on page 536) include less common 
nucleotides for constructing tRNA molecules. To use these resi-
dues, build a polynucleotide—by using the Nucleic Acids dialog 
box—using temporary nucleic acids. Then use the Mutate dialog 
box to substitute the final nucleotide. For example, to construct a 
rU–rG base pair, start with rU–rA, then mutate rA to rG.
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Chapter 6

Edit, Select, and
 Display Menus

This chapter describes the functions on the Edit, Display, and 
Select menus. These functions let you change the structure of mol-
ecules, alter their appearance in the workspace, and regulate how 
the Selection tool works.

Edit Menu

The Edit menu contains items using the Clipboard (for example, 
Cut and Paste) and items for manipulating molecules in the work-
space. The Edit menu has these commands: 

Cleara Removes selected atoms from the workspace. You 
cannot recover these structures with Paste. You can 
also press [Del]

Cuta Moves selected atoms from the workspace onto the 
Clipboard. You can also press [Ctrl]+ [X]

Copya Copies selected atoms to the Clipboard in HIN for-
mat. You can also press [Ctrl]+ [C]

Copy ISIS Sketcha Copies selected atoms to the Clipboard in MDL 
ISIS/Draw clipboard format.

Pastea Copies atoms from the Clipboard to the workspace. 
You can also press [Ctrl]+ [V]

Copy Image Takes a picture of a HyperChem window. You can 
also press [F9]
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a. When this item is gray, it is temporarily unavailable. An appropriate entity
must be selected or defined to make it available.

Inverta Turns all molecules or selected atoms upside down, 
through a POINT that you choose. Coordinates x, y, 
and z (relative to a point) become –x, –y, and –z

Reflecta Produces a mirror image of all molecules or selected 
atoms relative to a PLANE that you choose. For the 
XY plane, coordinates x, y, and z become x, y, and –
z

Rotate . . . Provides rotation by an exact amount (in degrees) 
about an axis (x, y, and z)

Translate . . . Provides translation by an exact amount (in Ång-
stroms) along each axis (x, y, and z) or to a defined 
point

Zoom . . . Provides an exact amount of magnification

Z Clip . . . Shows the molecular system from the top (along 
the y axis) and provides exact settings of the clip-
ping planes

Align Viewer  . . . Changes the viewer’s vantage point to any other 
axis or line in the Molecular Coordinate System

Align
Molecules  . . . 

Changes the alignment of whole molecules so that 
their internal (primary, secondary, or tertiary) axes 
correspond to the viewer’s x, y, or z axes

Set Bond 
Lengtha . . . 

Changes the length of a selected bond in a 
molecule

Set Bond 
Anglea . . . 

Sets a selected bond angle in a molecule

Set Bond 
Torsiona . . . 

Sets a selected torsion angle in a molecule
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Clear  

Clear permanently removes selected atoms from the workspace. 
You cannot recover these atoms. HyperChem asks you to confirm 
your decision.

Cut

Cut moves selected atoms from the workspace to the Clipboard, 
replacing its previous contents. You can then use Paste to copy the 
atoms back to the workspace of the same HyperChem window or 
to a different HyperChem window. HyperChem asks you to con-
firm your decision.

Note: Cut is gray and inactive unless you select an atom in the 
molecular system.

Cut removes selected atoms plus all bonds connecting these atoms 
to each other and to the rest of the molecular system. For Cut, 
Copy, and Paste, HyperChem keeps track of atoms rather than 
bonds.

, 

Copy

Copy places a duplicate of selected atoms onto the Clipboard in 
HIN format, replacing its previous contents. You can use Paste to 
copy the atoms back to the workspace of the same HyperChem 
window or to a different HyperChem window. 

Cut

selected atoms
(appear in
Thick line)
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Note: Copy duplicates selected atoms and the bonds connecting 
these atoms, but does not remember the bonds between this selec-
tion and the rest of the molecular system.

Copy ISIS Sketch 

Copy ISIS Sketch places a duplicate of selected atoms onto the Clip-
board in MDL ISIS/Draw Sketch format, replacing its previous con-
tents. HyperChem can Paste using ISIS/Draw Sketch format, so you 
can use Paste to copy the atoms back to the workspace of a Hyper-
Chem window or to ISIS/Draw.

You can paste structures back and forth between HyperChem and 
ISIS/Draw. ISIS™ (Integrated Scientific Information System) by 
MDL Information Systems provides drawing, storage, search, and 
retrieval capabilities for 2D and 3D chemical structures and related 
data. For example, you can use HyperChem to analyze or modify 
a structures, and then transfer the structures into ISIS for registra-
tion into a 3D database.

To copy a structure from HyperChem to ISIS Draw:

1. Build a molecule in HyperChem.

2. Choose Molecule as the selection level, and L-click on the mol-
ecule.

3. Choose Copy ISIS Sketch on the Edit menu.

A copy of the molecule in ISIS/Draw format (.skc) is stored in 
the Clipboard.

4. Open ISIS/Draw. 

5. Choose Paste on the Edit menu.

The molecule appears in the ISIS/Draw window. 

Paste 

Paste copies the contents of the Clipboard to the workspace of a 
HyperChem window. Use Paste to duplicate atoms and molecules 
in the same window or to transfer them to another HyperChem 
window.

Caution: Paste does not transfer a molecular model (graphic) to 
another Windows application (for example, Windows Write). If 
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you use Paste to move information to another application, you see 
only a text version of the molecular structure, as it appears in a 
HIN file. Use Copy Image (see the next section) to transfer graphic 
images to other applications.

The atoms from the Clipboard appear 1 Ångstrom to the right of 
the center of mass of the molecular system previously in the work-
space.

Note: Paste might not be the exact reverse of Cut. Cut removes 
selected atoms and all bonds connecting these atoms to each other 
and to the rest of the molecular system. Paste provides only the 
atoms and the bonds connecting these atoms to each other. For 
Cut, Copy, and Paste, HyperChem keeps track of atoms rather than 
bonds.

Note: Paste is gray and unavailable until you use Cut or Copy to 
place atoms on the Clipboard.

Pasting Superatoms From ISIS/Draw

When cutting or copying molecules from ISIS/Draw for pasting 
into HyperChem, you should expand any superatoms in the struc-
ture before transferring the molecules to the clipboard from ISIS.

If you are unable to do this, (for instance, if you have an ISIS sketch 
file embedded in a word-processing document), HyperChem 
expands each superatom in the correct position, but considers it as 
a separate molecule. Two atoms of the superatom are superim-
posed on two atoms of the main structure around the connection 
point. You will need to delete one atom of each superimposed pair 

Paste Paste
again

selected atoms 
appear in 
Thick line
Edit, Select, and Display Menus 117



Edit Menu
and reconstruct the proper connectivity in order to make a single 
molecule.

Copy Image

Copy Image takes a picture of all or part of the screen and places it 
either in a file or on the Windows Clipboard (see “Setup Image” on 
page 69). HyperChem stores a Windows metafile picture in the file 
chem.wmf and a bitmap picture in the file chem.bmp. 

Note: Press [F9] for Copy Image. You must use [F9] to save images of 
pull-down menus and dialog boxes (see page 69).

Each time you use Copy Image, HyperChem replaces the picture 
that is already on the Clipboard or in a file. To collect several pic-
tures, you must use one of these methods with another Windows 
application:

For a file If the picture is in a file, copy the file to a file with 
another name. You can use the Windows File Man-
ager to copy a file.

For the 
Clipboard

If the picture is on the Clipboard, paste it into a 
file, using another program that accepts metafile 
or bitmap images. For example, a Word® for Win-
dows file can store both bitmap and metafile 
graphics.

Use the Setup Image section of the Preferences dialog box  (see 
page 69) to give instructions for copying an image. 

Use Print on the File menu to send a copy of the workspace directly 
to a printer.

Invert

Invert carries out a molecular symmetry operation (inversion) 
through a POINT. POINT is the center of mass of one or more 
selected atoms. Use the Name Selection dialog box to define 
POINT. If the coordinates of an atom are x, y, and z (relative to the 
POINT), Invert changes them to –x, –y, and –z. 

Once you establish a POINT, you can invert any selected atoms or, 
if there is no selection, a whole molecular system. 
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Note: Invert is gray unless the molecular system contains a POINT 
selection.

To invert atoms and molecules:

1. Select one or more atoms to define the inversion POINT.

2. Choose Name Selection on the Select menu (see 147). Then 
choose POINT in the dialog box. L-click OK.

3. Deselect all atoms.

4. Select atoms or molecules to invert. Without a selection, 
HyperChem inverts the whole molecular system.

5. Choose Invert on the Edit menu.

Caution: If you invert selected atoms in a molecule, HyperChem 
inverts only these atoms and might distort the bonds connecting 
those atoms to the rest of the molecule.

Example:

This example shows HyperChem inverting the amino acid ala-
nine. Since the alpha carbon is a chiral center, inversion changes 
the chirality of this atom.

You can also, for example, use inversion to convert a chair to a 
boat conformation.

Invert

molecule
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Reflect

Reflect carries out a molecular symmetry operation (reflection) 
through a PLANE. This molecular operation can produce a mirror 
image of selected atoms or of a whole molecule. If PLANE is the XY 
plane, then Reflect changes an atom’s coordinates from x, y, and z 
(relative to PLANE) to x, y, and –z.

Use the Name Selection dialog box (see page 148) to define PLANE. 
PLANE is the surface defined by the primary and secondary inertial 
axes (see “Inertial Axes” on page 20) of the atoms used to name 
PLANE.

Reflect acts on selected atoms or, if there is no selection, the whole 
molecular system. If the reflected atoms contain one or more 
chiral centers, HyperChem changes their chirality.

Note: Reflect is gray unless the molecular system contains a PLANE 
selection.

To reflect atoms and molecules:

1. Select at least three atoms to define a reflection PLANE.

2. Choose Name Selection on the Select menu (see page 147). 
Then choose PLANE in the dialog box. L-click OK.

3. Deselect all atoms.

4. Select the atoms or molecules to reflect. Without a selection, 
HyperChem reflects the whole molecular system.

5. Choose Reflect on the Edit menu.

Example:

This example shows HyperChem reflecting the selected side group 
of cyclohexane.
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Rotate 

Choosing Rotate displays the Rotate dialog box to produce an 
exact rotation of molecules. This dialog box duplicates the effects 
of a rotation tool (see “Using the XY Rotation Tool” on page 37 
and “Using the Z Rotation Tool” on page 39).

Note: You can also double-click on a Rotation tool icon to reach 
the Rotate dialog box.

Rotate Dialog Box

Rotate About You can rotate selected atoms or, without a selec-
tion, a whole molecular system, around an axis in 
either the Viewer’s or Molecular Coordinate Sys-
tem or around a LINE. LINE is a named selection 
(see “Name Selection” on page 147) that belongs to 
a molecular system. If you cannot rotate selected 

select and Reflect

side group

PLANE
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atoms, HyperChem shows a message on the status 
line.

X Axis This axis is in the horizontal plane of the 
screen. 

Y Axis This axis is in the vertical plane of the 
screen.

Z Axis This axis is perpendicular to the screen.

LINE LINE is a named selection. Use Name selec-
tion on the Select menu to define a LINE for 
a molecular system.

Angle Enter a rotation angle. The practical range is ±360 
degrees.

Apply to Rotates selected atoms or the whole molecular sys-
tem in either of these ways:

Molecules Rotates selected molecules in the Molecu-
lar Coordinate System, changing atomic 
coordinates. This works for selected whole 
molecules, for selected side chains that can 
rotate, or, if there is no selection, for the 
whole molecular system.

Viewer Rotates all molecules in the workspace in 
the Viewer’s Coordinate System, leaving 
the atomic coordinates unchanged.

Translate

Translate displays the Translate dialog box to produce an exact 
translation of molecules. This dialog box duplicates the effects of 
a Translation tool (see “XY Translation Tool” on page 40 and “Z 
Translation Tool” on page 42), moving the center of mass of 
selected atoms or molecules to another position in the Molecular 
Coordinate System.

Note: You can also double-click on the Translation tool icon to dis-
play the Translate dialog box.
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Translate Dialog Box

Translate
Viewer

Moves all molecules in the workspace, but leaves 
the atomic coordinates unchanged, as if the viewer 
is moving. This is the same as using a translation 
tool in the workspace with the left mouse button.

dx Amount of translation to the right, in Ång-
stroms.

dy Amount of translation up, in Ångstroms.

dz Amount of translation toward you, in Ång-
stroms.

Translate 
Selection

Moves the center of mass of selected atoms to a 
new point, changing the atomic coordinates. This 
is the same as using a translation tool in the work-
space, with the right mouse button. Translation 
places the center of mass of the selected atoms at a 
new point (POINT, Origin, or Other) in the Molecu-
lar Coordinate System (see “Coordinate Systems” 
on page 18). If the selection is part of a molecule, 
HyperChem can move only the selected atoms if 
Whole Molecule translation is off (see “Preferences 
Property Sheet” on page 65).

Note: You can translate selected residues or atoms away from the 
molecule that they comprise by turning off Whole molecule trans-
lation (see “Tool” on page 67). To accomplish this translation, 
HyperChem stretches bonds beyond their normal lengths and 
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angles. The default setting, Whole molecule translation on (✓), pre-
vents this distortion. 

POINT Moves molecules or selected atoms to a 
POINT defined in the Name Selection dia-
log box (see page 148). 

Origin Moves molecules or selected atoms to the 
origin of the Molecular Coordinate System.

Other Moves molecules or selected atoms to the 
same point you chose the last time you 
used this dialog box, or to new coordinates 
that you enter for X, Y, Z (see below).

X, Y, Z For POINT, this shows the location associated with 
the predefined, named selection, POINT. For 
Origin, this shows 0, 0, 0, for the origin of the 
Molecular Coordinate System. For Other, you can 
set a point in the Molecular Coordinate System.

Zoom 

Zoom displays the Zoom dialog box to produce an exact magnifi-
cation of molecules in the workspace. This dialog box duplicates 
the effects of the Zoom tool (see page 44). The dialog box reports 
the present zoom factor (magnification) for the molecular system 
in the workspace. You can enter a new value, from 0.01 to 50. A 
Zoom Factor of 1 produces the same magnification as Scale to Fit 
(see page 157).

Note: You can also double-click on the Zoom tool icon to reach the 
Zoom dialog box.

Zoom Dialog Box

Zoom Factor This shows the present magnification of the 
molecular system, if there is no selection, or of 
selected atoms. A Zoom Factor of 1 is the same as 
Scale to Fit, which fits the selection or the whole 
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molecular system into the workspace (see “Scale to 
Fit” on page 157). Smaller values for Zoom Factor 
decrease the apparent size and larger values mag-
nify the molecules. For example, a Zoom Factor of 
2 doubles the size.

Caution: Use a Sticks rendering with high magnifications of molec-
ular systems. High magnifications (Zoom Factor) of all other 
molecular renderings (except Sticks) might require more memory 
than your computer has available.

Z Clip

Z Clip shows the Z Clip dialog box (see page 126), which you use 
to move the clipping planes. This dialog box duplicates the effects 
of the Z clipping tool (see page 46) and shows a top view of the 
molecular system (along the y axis) to aid in setting the clipping 
planes. Use this dialog box to set the clipping planes, either 
numerically or graphically.

The dialog box shows a Sticks rendering of the molecules in the 
workspace. You view the molecules from above, down the y axis of 
the Viewer’s Coordinate System. A green bar represents the front 
clipping plane; a violet bar represents the back clipping plane. 
Whenever you open this dialog box, the clipping planes are set 1/3 
and 2/3 down from the top of the display.

Note: You can also double-click on the Z clipping tool icon to 
reach the Z Clip dialog box.
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Z Clip Dialog Box

The dialog box provides this information:

System The extreme front and back positions of all mole-
cules in the workspace. The viewer is at zero. A new 
molecular system is at 40.

Slab The positions of the front and back clipping planes 
relative to the viewer, who HyperChem takes to be 
at zero. As you move the clipping planes by using 
the scroll bars, these numbers change. Entering 
numbers changes the position of a clipping plane 
on screen. 

Press [Tab] or L-click to move between Slab/Front 
and Slab/Back. This highlights the number. Enter a 
new value from 0 to 3200 Ångstroms. The front 
slab must remain in front of the back slab.

Note: If a molecular system disappears from the workspace while 
you are using the Z clipping tool, press [Spacebar] or use the numeric 
settings in this dialog box to display the molecules again. Adjust 
the slab positions (Front and Back) to include the System (Front and 
Back).

back clipping
slab plane

front clipping
slab plane

distances in
Ångstroms
from viewer

molecular system
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You can adjust the positions of the clipping planes using two 
methods:

• Use the scroll bars at the sides of the molecular model to move 
the clipping planes. Movement is along the z axis of the 
Viewer’s Coordinate System.

• Enter values, to the right, for the positions of the clipping 
planes. Values represent the distance from the viewer in Ång-
stroms.

Align Viewer

Align Viewer modifies the Viewer’s Coordinate System so that it has 
a simple correspondence with the Molecular Coordinate System. 

The Viewer’s Coordinate System is relative to the plane of the com-
puter screen (see “Viewer’s Coordinate System” on page 19). You 
always view the screen and the HyperChem workspace along the 
viewer’s z axis. The molecular system has its own coordinate sys-
tem (see “Molecular Coordinate System” on page 19).

When you first construct a molecular system, the viewer’s z axis 
aligns with the molecular z axis. If you rotate the viewer’s position 
(for example, using the Rotation tools and the left mouse button), 
this alignment is lost. Align Viewer returns the workspace to the ini-
tial state or to another standard orientation.

Align Viewer Dialog Box

X Axis Aligns the viewer’s z axis and the molecular x axis.

Y Axis Aligns the viewer’s z axis and the molecular y axis.
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Z Axis Re-aligns the viewer’s z axis and the molecular z 
axis.

LINE Aligns the viewer’s z axis with a LINE in the Molec-
ular Coordinate System. A LINE is the best-fit to 
two or more atoms in a molecular system or to the 
primary inertial axis.1 This choice is inactive (gray) 
until you set a LINE in the Name Selection dialog 
box (see page 148).

For more information about coordinate systems, see page 18. 

Align Molecules

Align Molecules rotates selected whole molecules so that their iner-
tial axes correspond to the viewer’s x, y, or z axes. You can also 
align an inertial axis with a LINE in the Molecular Coordinate Sys-
tem. 

If you do an alignment with at least one atom selected, the align-
ment “moves” the atoms, changing their coordinates in the 
Molecular Coordinate System. If there is no selection, the align-
ment maintains the same atomic coordinates, but moves your 
viewpoint (the Viewer’s Coordinate System).

A molecular system has an inertial axis system independent of the 
Molecular or Viewer’s Coordinate Systems. Inertial axes are fixed 
in a molecular system and depend only on the number, type 
(mass), and positions of atoms. The inertial axes have their origin 
at the center of mass and are orthogonal (at right angles to each 
other). The primary inertial axis is often the longest distance from 
the center of mass to the edge of the molecular system. Inertial 
axes are computed for the selected atoms, or if there is no selec-
tion, for all atoms in the molecular system. 

You can see the inertial axes of a molecular system by choosing 
Show Axes on the Display menu. See “Coordinate Systems” on 
page 18 for more information about coordinate systems and axes.

With the Align Molecules dialog box, you can do one or two align-
ments of a molecular system:

• The first alignment is known as the major alignment. This 
positions one inertial axis with one viewer axis. 

1. The primary inertial axis corresponds to the smallest eigenvalue of the moment of inertia matrix.
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• You can then choose to do a second, minor alignment. This 
rotates the molecules around the first alignment axis, until a 
second inertial axis aligns with a second axis in the Viewer’s 
Coordinate System. 

Align Molecules Dialog Box

Primary This is the primary inertial axis1, passing through 
the center of mass of a molecular system. This is 
often the longest distance from the center of mass 
to the edge of a molecular system. 

Secondary This axis is orthogonal (at right angles) to the pri-
mary and tertiary axes. If the molecular system is 
planar, the secondary axis is in this plane.

Tertiary This axis is orthogonal (at right angles) to the pri-
mary and secondary axes. If the molecular system 
is planar, the tertiary axis is perpendicular to this 
plane.

X Axis Aligns the viewer’s x axis with an inertial axis.

Y Axis Aligns the viewer’s y axis with an inertial axis.

Z Axis Aligns the viewer’s z axis with an inertial axis.

1. The primary inertial axis corresponds to the smallest eigenvalue of the moment of inertia matrix.
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LINE Aligns the chosen inertial axis with a LINE in the 
Molecular Coordinate System. A LINE is the best-fit 
to two or more atoms in a molecular system, or to 
the primary inertial axis. This choice is inactive 
(gray) until you set a LINE in the Name Selection 
dialog box (see page 148).

Minor Turn on Minor (✓) if you want to align a second 
inertial axis with a second coordinate axis. This 
alignment rotates the molecular system around 
the first alignment axis to make the second align-
ment. You have the same choices as for the first 
alignment, except you cannot use the same inertial 
or coordinate axes that you used for the major 
alignment.

To use Align Molecules:

1. Select atoms in a molecular system, or deselect all atoms for 
the whole molecular system. This selection determines the 
inertial axes for alignment.

2. Choose Align Molecules on the Edit menu.

3. Choose the inertial axis for the major alignment from the 
upper-left section of the dialog box.

4. Choose an axis or LINE from the lower-left section of the dialog 
box.

5. Turn on Minor (✓) if you want to align a second inertial axis 
with a second coordinate axis. This alignment rotates the 
molecular system around the first alignment axis to make the 
second alignment.

6. For a minor alignment, repeat steps 2 and 3 using the right-
half of the dialog box.

You can see the inertial axes of a coordinate system by choosing 
Show Inertial Axes on the Display menu (see page 174). For more 
information about coordinate systems, see “Coordinate Systems” 
on page 18. 

Set Bond Length

Set Bond Length displays the Set Bond Length dialog box for 
changing the length of a selected bond. 
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Select either a bond or the two atoms that form this bond, and 
then choose Set Bond Length. This bond must not be part of a ring 
structure. The bond length changes as soon as you L-click OK in 
the dialog box.

The Model Builder (see page 85) might remove this new bond 
length. To influence a bond length during model building, use 
Constrain Bond Length (see page 95). 

You can also influence a bond length during a geometry optimiza-
tion calculation (see “Restraints” on page 224).

Set Bond Length Dialog Box

The dialog box first shows the existing bond length. Enter a new 
bond length, usually between 0.75 and 3 Ångstroms.

Set Bond Angle

Set Bond Angle displays the Set Bond Angle dialog box for chang-
ing a selected bond angle. 

Select either two bonds or the three atoms that include these 
bonds (see “Selecting” on page 32), and then choose Set Bond 
Angle. One but not both of the bonds can be part of a ring. The 
bond angle changes as soon as you L-click OK in the dialog box.

The Model Builder (see page 85) might remove this new bond 
angle. To influence a bond angle during model building, use Con-
strain Bond Angle (see page 96).

You can also influence a bond angle during a geometry optimiza-
tion calculation (see “Restraints” on page 224).
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Set Bond Angle Dialog Box

The dialog box first shows the existing bond angle. Enter a number 
from 0 to 180 for the new bond angle.

Set Bond Torsion

Set Bond Torsion displays the Set Bond Torsion dialog box for 
changing a torsion angle. 

You can select either the four atoms or the three bonds forming the 
torsion angle, and then choose Set Bond Torsion. Only one end 
bond can be part of a ring structure. The bond torsion changes as 
soon as you L-click OK in the dialog box.

The Model Builder (see “Model Build/Add H & Model Build” on 
page 85) might remove this new torsion angle. You can also influ-
ence a torsion angle during model building, by using Constrain 
Bond Torsion (see page 97).

You can also influence a torsion during a geometry optimization 
calculation (see “Restraints” on page 224).

Set Bond Torsion Dialog Box

The dialog box first shows the existing bond torsion angle. Enter a 
number from –360 to +360 for the torsion angle.

Select Menu

The Select menu regulates the Selection tool. The Selection tool 
marks specific atoms, bonds, residues, or molecules for Hyper-
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Chem operations. Selected atoms take on a different appearance 
(line width or color). If there are selected atoms in a molecular sys-
tem, HyperChem acts usually only on these atoms. 

The items on this menu instruct the Selection tool to work at dif-
ferent levels of molecular organization or to make specific types of 
selections: 

√ Atomsa The smallest unit of selection is an individual atom 
or bond

√ Residuesa The smallest unit of selection is an amino acid or 
nucleotide residue from a database or, if there are 
no residues in a molecular system, an atom or bond

√ Moleculesa The smallest unit of selection is a whole molecule

√ Multiple 
Selectionsb 

Changes the Selection tool so that you can either 
accumulate selections (√) or replace the previous 
selection with each new selection (no check mark)

√ Select Sphereb Changes the Selection tool so that you can select all 
atoms within a 3D sphere, plus atoms within a 2D 
rectangle (√), or only atoms within a 2D rectangle 
(no check mark)

Select All Selects the whole molecular system

Complement 
Selection 

Cancels the existing selections and selects all atoms 
previously not selected

Select . . .c Selects atoms using either a previous selection 
saved with a specific name, or the number of an 
atom, residue, or molecule

Name 
Selection . . . c

Assigns a predefined name (POINT, LINE, or PLANE) 
or any name that you supply (up to 19 characters 
long) to selected atoms, and stores this selection for 
later use. Named selections apply only to this 
molecular system

Extend Ringc Selects all atoms in a ring if one bond or two 
bonded atoms in the ring are already selected
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Visible Atoms

The items on the Select menu act on all atoms in the molecular 
system, whether they are visible or not. The visibility of an atom 
depends on these factors:

• The type of model you are using. For example, a spheres model 
hides atoms on the far side of a molecule.

• Settings on the Display menu. For example, Show Hydrogens 
can turn off the appearance of hydrogen atoms, but these 
atoms are still part of the molecular system.

• Location and size of molecules. For example, you can translate 
part of a molecular system off screen, but it is still part of the 
molecular system.

• Clipping slab settings. For example, the clipping slab might 
show only part of a molecular system.

Atoms

When you choose Atoms (✓), the smallest unit of selection is an 
individual atom. With the Selection tool, you can then select indi-

a. Only one of these items can be active at a time, and only the active item has
a check mark. 
b. A check mark appears next to this item when it is on. Turning it on affects
all further selecting, until you select it again to turn it off.
c. When this item is gray, it is temporarily unavailable. You must change some
condition in HyperChem to make it available. 

Extend Side Chain Selects all atoms in a rotatable side chain if the first 
two atoms in the side chain are already selected

Extend to sp3 Selects all atoms, starting from the current selec-
tion, until all bonds with only one atom selected are 
single bonds between sp3 atoms. Use this to find 
the boundaries for a mixed mode quantum 
mechanics calculation

Select Backbone Selects all atoms in the backbones of proteins or 
polynucleotides constructed from residues on the 
Databases menu or from a PDB file. For polypep-
tides, disulfide bridges are also selected
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vidual atoms, bonds, and angles. This item remains active until 
you choose Residues or Molecules. 

Note: Use Atoms for selection unless you specifically want to select 
residues or molecules. 

To select atoms with the Selection tool:

• L-click on an atom or bond to select this component.

• R-click on an atom or bond to deselect it.

• Choose Multiple Selections on the Select menu to accumulate 
selections, without deselecting atoms.

• See “Selecting” on page 32 for methods of selecting bond 
angles and torsion angles.

• L-click on an empty area of the workspace to select all atoms 
in the workspace. R-click on any empty area of the workspace 
to deselect all atoms.

How the selection looks depends on your choice in the Preferences 
dialog box. A description of a single, selected atom appears on the 
status line with this information (from left to right):

Atom
number

A number indicating the creation order of an atom 
within the molecule.

Element
name

From the periodic table, for example, carbon.

bond torsion

atom

bond

bond angle

Note: all selections appear 
in Thick line
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Atom name The atom name from the Brookhaven Data Bank or 
HIN file. By default, these names appear only for 
atoms found in proteins and nucleic acids.

Force Field The force field that supplied the atom types for this 
molecular system (amber, mm+, bio+, or opls).

Atom type The atom type for the force field.

Charge The charge, if any, on this atom.

Atomic 
coordinates

The x, y, and z coordinates in the Molecular Coor-
dinate System.

Examples: 

These messages can appear on the status line when you select at 
the Atoms level.

For one atom: 

Atom number 2 is Carbon C (mm+ * C0) at -1.6188 0.6548 0

For two nonbonded atoms: 

Distance from atom CA197 to atom 1 HD1 108 is 3.3846Å

For two bonded atoms: 

Bond distance from atom C86 to CA85 is 1.5364Å

For three bonded atoms: 

Angle of atoms N96 - C86 - CA85 is 102.45°

For three nonbonded atoms: 

Improper angle of atoms C98 - CD102 - C 85 is 88.703°

For four bonded atoms: 

Torsion angle of atoms C98 - C 97 - N96 - CD102 is 116.38°

For four nonbonded atoms: 

Improper torsion angle of atoms C98 - CA97 - C86 - CA85 is 
126.95°

For five or more atoms: 

Selected n atoms

where n= 5, 6, 7...
1. Atom names in this and the following examples are from the Brookhaven Data Bank, for example,
CA, C, HD.
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Residues

When you choose Residues (✓), the smallest unit of selection is 
individual residues (amino acids or nucleotides). Residues must 
come from the Databases menu (see page 98) or from Protein Data 
Bank files (see page 319). HyperChem does not recognize as resi-
dues amino acids or nucleotides that you draw from individual 
atoms. 

This item remains active until you choose Atoms or Molecules. 

Note: If there are no residues in a molecule, this item works like 
Atoms.

To select residues:

• L-click on a residue to select it. If the Selection tool is on a mol-
ecule, it selects the nearest residue.

• R-click on a residue to deselect it.

• Choose Multiple Selections on the Select menu to accumulate 
selections, without deselecting any atoms.

• L-click on an empty area of the workspace to select all atoms 
in the molecular system. R-click on an empty area to deselect 
all atoms.

A description of your latest selection appears on the status line 
with this information:

Note: selected residue appears 
in Thick line
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Number of 
residues 
selected

This number can be from 0 to all residues in the 
molecular system.

Residue name 
and number

This is the name and sequence number for the first 
four residues you select, plus the last residue you 
select.

Example:

This message appears on the status line when you select at the 
Residues level.

30 residues selected: THR 1 THR 2 CYX 3 CYX 4 ... ASN 46

Molecules

When you choose Molecules (✓), the smallest unit of selection is 
an individual molecule. This item remains active until you choose 
Atoms or Residues. 

To select molecules:

• L-click on a molecule to select it. If the Selection tool is close 
to two molecules, it selects the nearest molecule.

• R-click on a molecule to deselect it.

• Choose Multiple Selections on the Select menu to accumulate 
selections, without deselecting atoms.

• L-click on an empty area of the workspace to select all atoms 
in the workspace. R-click on an empty area to deselect all 
atoms.

The numbers of the selected molecules appear on the status line.

Example: 

This is an example of the message that appears on the status line 
when you select at the Molecules level:

2 molecules selected
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Multiple Selections: Accumulating Selections

With Multiple Selections on (✓), you can accumulate selections. 
When this item is off (no check mark), each new selection replaces 
the previous selection. 

Note: You can also select more than one structure at a time by 
using group selection (see the next section). Group selection does 
not require Multiple Selections to be on.

The type of structure selected depends on your choice of the 
Atoms, Residues, or Molecules on this menu. The number of 
selected atoms, residues, or molecules appears on the status line.

Select Sphere and Group Selecting

Select Sphere controls group selection with the Selection tool. 

Group selection means that you can select all atoms, residues, and 
molecules in part of a molecular system. Group selection is the eas-
iest way to select a set of atoms. 

To prepare for group selection:

1. Choose Atoms, Residues, or Molecules on the Select menu. This 
choice regulates the level of group selection. For example, if 
you choose Molecules, group selection works only for whole 
molecules.

2. L-click on the Selection tool icon to activate the Selection tool.

Note: Group selecting does not require Multiple Selections to be on. 

Selecting in Two Dimensions

This procedure selects all atoms that project onto a 2D selection 
rectangle. You can adjust the location and size of the selection rect-
angle. The Selection tool ignores information about the depth of 
the molecular system and treats all atoms as if they were in the 
plane of the screen.

To select in two dimensions:

1. Turn off Select Sphere on the Select menu. There should be no 
check mark to the left of this item.
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2. Move the Selection tool to one corner of the region you want 
to select. 

Note: You can also do this selection with Select Sphere on. At 
step 2, start your selection in an empty area of the workspace.

3. Hold down both mouse buttons, but press the left button first.

4. Move the Selection tool diagonally across the structures to 
select. A selection rectangle appears. Adjust the size and posi-
tion of the rectangle by moving the mouse.

5. Release both mouse buttons. The number of structures selected 
appears on the status line.

6. To deselect part of a selection, repeat steps 1–5, but at step 3 
hold down the right mouse button before holding down the left 
button.

To select:
LR-drag

To deselect:
RL-drag

Click: L R

group selection using a combination of mouse buttons

L R
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selection rectangle

selected residues
(in Thick line)
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Selecting in Three Dimensions

This procedure selects all structures within a 3D sphere. You select 
only the atoms that are within a specified distance and in all direc-
tions from an atom. You adjust the diameter of a circle that repre-
sents the selection sphere. You must start this selection at an atom. 

To select in three dimensions:

1. Turn on Select Sphere (✓) on the Select menu.

2. Move the Selection tool to the atom at the center of the 
selection. 

Note: If you begin group selecting away from an atom, the 
Selection tool uses a 2D rectangle for selection, even if Select 
Sphere is on.

3. Hold down both mouse buttons, but press the left button first.

4. Move the Selection tool diagonally across the structures to 
select. A circle, representing a sphere, appears. Adjust the size 
of the circle by moving the mouse in any direction. The num-
ber of the first atom selected and the radius of the sphere, in 
Ångstroms, appear on the status line.

5. Release both mouse buttons. The number of structures selected 
appears on the status line.

6. To deselect atoms within a sphere, repeat steps 1–5, but at step 
3 hold down the right mouse button before holding down the 
left button. 
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Select All

Select All changes the selection to include all visible atoms (see 
“Visible Atoms” on page 134) in the molecular system. Choosing 
this item is equivalent to L-clicking in an empty part of the work-
space. 

selection sphere

selection from this atom

selected residues
(in Thick line)
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Complement Selection

Complement Selection deselects the existing selection and, instead, 
selects all atoms that were not selected before. When you have 
selected the only molecule in a molecular system, Complement 
Selection deselects this molecule.

Select 

Using Select you can select atoms, residues, and molecules by 
number or by a previously assigned name. These selections occur 
immediately and either replace previous selections (with Multiple 
Selections off) or add to existing selections (with Multiple Selections 
on).

Note: Select is gray until there is a molecular system in the work-
space.

When you choose Select, the Select dialog box (see page 145) 
appears listing selection names that apply only to the molecular 
system in the workspace (see Name Selection in the following sec-
tion). You can also select atoms, residues, and molecules by their 
numbers. 

Note: Selecting atoms, residues, and molecules in this dialog box 
is independent of the Atoms, Residues, and Molecules items on the 
Select menu. Those menu items affect only the operation of the 
Selection tool.

Complement
Selection
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Select Dialog Box

By name L-click to turn on your selection by a previously 
assigned name. These names belong to the molec-
ular system in the workspace. This turns off the 
alternative, By number.

Names Lists named selections previously assigned using 
the Name Selection dialog box (see page 148). The 
list can include the predefined choices (LINE, 
POINT, and PLANE) if they have been assigned, and 
other names you set up. When this list box is filled 
with names, you can scroll down to see additional 
choices.

By number L-click to turn on selection of an atom, residue, or 
molecule by its number.

Numbers L-click on one of these items:

Atom Selects an atom. You must supply the atom 
number and the molecule number. If there 
is only one molecule in a molecular sys-
tem, use 1 for the Molecule number.

Residue Selects a residue. You must supply the resi-
due number and the molecule number. If 
there is only one molecule in a molecular 
system, use 1 for the Molecule number.

Molecule Selects a molecule in the molecular system 
if there is more than one. You must supply 
the Molecule number.
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Molecule Enter a molecule number from 1 to the number of 
molecules in the molecular system in the text box. 
HyperChem numbers molecules starting from 1 in 
the order you put them into a system.

Residue
/Atom

Enter an atom or residue number from 1 to the 
number of atoms or residues in a molecule (maxi-
mum of 32,767) in the text box. In general, residue 
numbers and atom numbers reflect the order you 
incorporated them into molecules.

Remove After specifying a selection name above, you can 
remove that name from the list of named selec-
tions.

Selecting by Name

To select atoms or molecules by an assigned name:

1. Choose Select on the Select menu.

2. L-click on By name in the Select dialog box.

Note: By name is gray unless you previously selected atoms and 
assigned a name to them (see “Naming Selections” on page 
149). Selection names might be associated with a molecular 
system from a previous HyperChem session. HyperChem 
stores named selections in HIN files.

3. Double-click on a selection name in the Names list.

HyperChem uses the predefined names, POINT, LINE, and 
PLANE to indicate particular properties of a selection. You can 
use these predefined names to recall a selection, and Hyper-
Chem can use the special properties of these selections for 
other operations. For example, you can translate molecules to 
a POINT (see “Translate Dialog Box” on page 123) or invert a 
molecule through a POINT (see “Invert” on page 118).

Note: Selection names belong to individual molecular systems 
and appear in the Select dialog box only when that molecular 
system is in the workspace. 
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Selecting by Number

To select atoms, residues or molecules by number:

1. Choose Select on the Select menu.

2. L-click on By number in the Select dialog box.

3. L-click on Atom, Residue, or Molecule on the Numbers list.

4. For a molecule, enter the molecule number in the Molecule 
text box. 

5. For an atom or residue, enter the molecule number in the Mol-
ecule text box. The molecule number is 1 if there is only one 
molecule in the molecular system. Then enter a single atom or 
residue number in the Residue/atom text box.

6. L-click OK.

Selecting atoms, residues, and molecules by number is inde-
pendent of selection level (Atoms, Residues, or Molecules).

Also see “Numbering,” below.

Numbering 

HyperChem assigns a number to each atom, residue, and mole-
cule, starting with 1 for each type of structure. This is the number-
ing order:

• Atoms: If you draw molecules in HyperChem, atoms are num-
bered in the order you draw them. Molecules from the Protein 
Data Bank have defined numbering. Atom numbering starts 
from 1 for each molecule.

• Residues: In polypeptides, residue 1 is at the N-terminus. In 
polynucleotides, residue 1 is at the 5′ end, unless you con-
structed a polynucleotide starting from the 3′ end (Backwards). 
Residue numbering starts from 1 for each molecule.

• Molecules: Molecules are numbered in the order you added 
them to the molecular system. 

Name Selection 

Name Selection shows you the Name Selection dialog box for 
assigning a name to selected atoms. When atoms have a selection 
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name, you can easily select them again. The name can be “special” 
(POINT, LINE, PLANE, REACTANT, or PRODUCT) or any name that 
you supply, up to 19 characters long (Other). “Special” selections 
have properties in addition to describing a set of atoms (see the 
next section).

Note: Name Selection is gray until you select at least one atom. 
Some special names are available only under some conditions.

Name Selection Dialog Box

POINT The center of mass of the selected atom or atoms.

LINE The best-fit straight line between two or more 
atoms, or the primary inertial axis.1

PLANE The best-fit plane connecting three or more atoms, 
or the plane formed by the primary and secondary 
inertial axes.

REACTANT This selection contains the reactant atoms for set-
ting up a Synchronous Transit transition-state 
search (see “Reaction Map . . .” on page 231). This 
line in the dialog box is active only if you have 
selected half of the atoms in the workspace.

PRODUCT This selection contains the product atoms for set-
ting up a Synchronous Transit transition-state 
search (see “Reaction Map . . .” on page 231). This 
line in the dialog box is active only if you have 
selected half of the atoms in the workspace.

1. The primary inertial axis corresponds to the smallest eigenvalue of the moment of inertia matrix.
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Other A name that you supply, up to 19 characters long, 
with at least one lowercase character, and no 
spaces. 

Naming Selections

To name a selection:

1. Using the Selection tool, select any set of atoms, residues, or 
molecules.

2. Choose Name Selection on the Select menu.

3. L-click on POINT, LINE, PLANE, REACTANT, PRODUCT, or 
Other. If you choose Other, enter a name, from one to 19 char-
acters long, but don’t use all uppercase letters. Names with all 
uppercase characters are reserved for HyperChem’s special 
selections, like POINT.

4. L-click OK. 

Each molecular system can have only one POINT, LINE, or PLANE 
selection, but any number of other selection names. For example, 
if you use POINT a second time, the new selection replaces the last 
POINT selection. HyperChem requests confirmation of this 
replacement.

To remove a named selection, use the Remove function of the 
Select Dialog Box (page 145).

Using Named Selections

You can use these names any time during a HyperChem session to 
select a set of atoms. The names belong to a molecular system. You 
can store these names, with the molecular system, in a HIN file 
and use them for another HyperChem session. 

HyperChem uses the special names POINT, LINE, and PLANE to 
indicate particular properties of a selection. You can use these spe-
cial names to recall a selection, and HyperChem can use the spe-
cial properties of these selections for other operations. For exam-
ple, you can translate molecules to a POINT (see “Translate Dialog 
Box” on page 123) or invert a molecule through a POINT (see 
“Invert” on page 118).

HyperChem uses the special names REACTANT and PRODUCT for 
setting up a Synchronous Transit transition-state search (see 
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“Reaction Map . . .” on page 231). These lines in the dialog box are 
active only if you have selected half of the atoms in the workspace.

Note: Selection names belong to individual molecular systems and 
appear in the Select dialog box only when that molecular system 
is in the workspace. If you save a molecular system in a HIN file, 
HyperChem also stores named selections.

You can also use named selections (Other) for setting restraints in 
a calculation (see the next section) and for defining lengths and 
angles that are averaged or plotted in a molecular dynamics simu-
lation (see “Molecular Dynamics Averages Dialog Box” on page 
254).

Each molecular system can have only one POINT, LINE, or PLANE 
selection, but any number of other selection names. For example, 
if you use POINT a second time, the new selection replaces the last 
POINT selection. 

Using Named Selections for Restraints

HyperChem can use 1, 2, 3, or 4 atom named selections to restrain 
a molecular system during a calculation (see “Setting Up 
Restraints” on page 227). These selections can be either predefined 
(POINT, LINE, and PLANE) or you can define them yourself (Other).

• A single atom can be tethered to a point in space

• Distances between any two atoms, including bond lengths

• Angles formed by any three atoms, including bond angles

• Torsion angles formed by any four atoms, including improper 
torsions

The named selections appear in the Restraint Forces dialog box 
with a prefix indicating the number of atoms in the selection. For 
example, a selection named C11/N78 that describes the distance 
between two nonbonded atoms appears as 2-C11/N78.

HyperChem stores these restraints, along with the named selec-
tions and the molecular system, in a HIN file.

Using Named Selections in MD Calculations

HyperChem can use 2, 3, or 4 atom named selections to plot 
changing values or to calculate averages during a molecular 
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dynamics simulation (see “Molecular Dynamics Averages Dialog 
Box” on page 254). These selections can be either predefined 
(POINT, LINE, and PLANE) or definitions of your choice (Other). The 
named selections represent these values:

• Distances between any two atoms, including bond lengths

• Angles formed by any three atoms, including bond angles

• Torsion angles formed by any four atoms, including improper 
torsions

The named selections appear in the Molecular Dynamics Averages 
dialog box, described on page 254.

Extend Ring

Extend Ring selects all atoms in a ring, starting with two selected, 
covalently bonded atoms.

To use Extend Ring:

1. Choose Atoms on the Select menu.

2. With the Selection tool, select one bond or two adjacent atoms 
in a ring. To select two atoms, first turn on Multiple Selections.

3. Choose Extend Ring.

Note: You can also select a ring by double-clicking with the Selec-
tion tool on an atom or bond in the ring. You must first choose 
Atoms on the Select menu.

Extend
Ring
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Extend Side Chain

Extend Side Chain selects all atoms in a side chain that can rotate. 
For HyperChem, each bond that is not part of a ring defines two 
side chains, one to either side of the bond.

To use Extend Side Chain:

1. Choose Atoms and turn on Multiple Selections on the Select 
menu.

2. With the Selection tool, select two adjacent atoms that are not 
part of a ring. The order of selection determines the direction 
of the search for a side chain. HyperChem selects the side 
chain past the second selected atom.

3. Choose Extend Side Chain.

Note: You can also extend a side chain by double-clicking with the 
Selection tool on a bond. You must first choose Atoms on the Select 
menu. Then double-click on one end of a bond (from the mid-
point of the bond to the bonded atom). HyperChem selects the 
side chain connected to the nearest atom. 

Extend to sp3 

Extend to sp3 starts at selected atoms and selects additional atoms, 
in all directions, until it meets sp3–sp3 single bonds or singly 
bonded atoms. The extended selection includes the near half of 
the sp3–sp3 bonds. 

select first

select second

Extend Side
Chain
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Use this item if you are going to apply a semi-empirical quantum 
mechanical calculation to part of a molecule. This HyperChem fea-
ture lets you use both molecular mechanical and quantum 
mechanical calculations on parts of the same molecule.

HyperChem considers these as sp3 atoms:

• A carbon bonded to four other atoms.

• A nitrogen bonded to three other atoms.

• An oxygen bonded to two other atoms.

• The nitrogen bonded to the alpha carbon in a peptide bond. 
This assignment for the peptide bond nitrogen allows bound-
aries between amino acid residues.

To extend a selection to sp3–sp3 single bonds, first select at least 
one atom, bond, or residue. Then choose Extend to sp3 on the 
Select menu.

Note: When you run a semi-empirical calculation on a selected 
part of a molecule, HyperChem replaces C, O, and N atoms on the 
far half of the sp3-sp3 bonds with parameterized fluorine atoms. 
These capping atoms have the appropriate electronegativity or 
electropositivity to represent the replaced atoms during quantum 
mechanical calculations (see HyperChem Computational Chemistry).

Extend to
sp3
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Select Backbone

Select Backbone automatically selects all atoms that provide struc-
tural continuity in proteins and nucleic acids constructed with res-
idues from the Databases menu or from PDB files. Select Backbone 
works on all polymers, constructed from residues, in the molecular 
system.

For proteins, the backbone includes alpha carbons, peptide bonds, 
and disulfide bonds. For polynucleotides, the backbone includes 
all phosphodiester bonds, alternating with the C3′–C4′ carbons in 
the sugar (ribose or deoxyribose).

This command does not work with polymeric molecules that you 
construct, atom by atom, with the Drawing tool. To select a back-
bone in those molecules, use the Selection tool to select the atom 
at one end of the backbone. Then L-drag to the atom at the other 
end of the backbone. Multiple Selections does not have to be on.

ferredoxin single strand of DNA
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The Display menu determines the appearance of molecules in the 
workspace. The Display menu has these commands: 

Scale to Fit Changes the magnification to fit all selected atoms 
into the workspace. If there is no selection, this item 
fits the whole molecular system into the workspace. 
Same as pressing [Spacebar]

Overlay Places two selected molecules on top of one 
another

Show All Displays all atoms in the workspace, canceling 
Show Selection Only or Hide Selection

Show Selection 
Only 

Displays only the selected atoms that are presently 
visible in the workspace. Hides atoms that are not 
selected

Hide Selection Turns off the display of selected atoms. Leaves visi-
ble only atoms that are not selected

Rendering . . . Chooses options for representing all molecules in a 
molecular system. This model applies to the whole 
molecular system

Last Rendering Restores the previous mode of rendering in the 
Workspace. Same as pressing [F2]. This option is not 
available (grayed out) while an isosurface is being 
displayed

√ Show Isourfacea If an isosurface has been calculated and is available 
for display, this controls whether it will be displayed 
or not. Same as pressing [F3]

Isosurface . . . If an isosurface has been calculated and is available 
for display, this opens the Contour Isosurface 
Options dialog box or the Orbital Isosurface 
Options dialog box. Same as pressing [F4]
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a. A check mark appears next to this item when it is on. Turning it on affects
all further displays, until you choose it again to turn it off.
b. When this item is gray, it is temporarily unavailable. You must change
some condition in HyperChem to make it available. 

✓ Show 
Hydrogensa 

Shows molecules with (✓) or without (no check 
mark) their hydrogen atoms

✓ Show Periodic 
Boxa,b 

Shows the outline of a periodic box (✓) or removes 
the outline (no check mark), leaving all molecules 
and the periodic boundary conditions. To place a 
periodic box in the workspace and to set up peri-
odic boundary conditions, choose Periodic Box on 
the Setup menu

✓ Show Multiple 
Bondsa 

Shows double, triple, and aromatic bonds with dif-
ferent types of lines (✓) or shows all bonds as single 
lines (no check mark)

✓ Show Hydrogen 
Bondsa 

Shows hydrogen bonds as dotted lines (✓) or not at 
all (no check mark)

Recompute H 
Bonds 

Calculates hydrogen bonding and shows hydrogen 
bonds if Show Hydrogen Bonds is on

✓ Show Inertial 
Axesa 

Calculates and displays the inertial axes of selected 
atoms or of the molecular system

✓ Show Dipole 
Moment

Displays the dipole moment of the selected atoms 
or of the molecular system, if a semi-empirical or ab 
initio calculation has been performed

Labels . . . Adds labels to identify atoms or residues in Sticks 
renderings of molecules. A Labels dialog box gives 
nine choices of labels for atoms, three choices for 
residues, or no labels at all

Color . . . Changes the color applied to selected atoms, resi-
dues, or molecules. This color remains after you 
deselect the atoms

Element Color . . . Changes the default color for each element
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Scale to Fit

Scale to Fit centers selected atoms or the whole molecular system 
in the workspace. HyperChem changes the magnification so that 
the molecules occupy about three quarters of the height of the 
workspace. This sets Zoom Factor to 1 (see “Zoom Dialog Box” on 
page 124).

Scale to Fit also resets the clipping planes to include the selection 
or the whole molecular system.

Note: Press [Spacebar] as a shortcut to choosing Scale to Fit.

You can use Scale to Fit for these adjustments:

• Focusing on selected atoms or molecules. 

Group select (see “Select Sphere and Group Selecting” on page 
139) atoms of interest, and then press [Spacebar]. The selected 

Scale to Fit
(no selection)

Scale to Fit
(1 residue selected)
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structures fill the workspace. To reverse this enlargement, dese-
lect the atoms and press [Spacebar].

• Locating molecules that are out of the workspace.

Deselect all atoms (R-click with the Selection tool in an empty 
part of the workspace) and press [Spacebar] to return the whole 
molecular system to the center of the workspace.

Overlay

Overlay places one molecule on top of another so that you can 
make structural comparisons. 

To use Overlay:

1. Choose Atoms and turn on Multiple Selections on the Select 
menu.

2. Select three atoms in one molecule. These can be, for example, 
the three atoms defining a bond angle. This becomes molecule 
number 1.

3. Select three atoms in a second molecule. These can be any 
three atoms, but your selection should correspond to selected 
atoms in molecule 1. This becomes molecule 2.

4. Choose Overlay. HyperChem moves molecule 1 to coincide 
with molecule 2.

geometry 
optimized

select 1
select 2

select 3 overlay

after Model Building (left) then geometry optimization with AM1 (right)
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HyperChem remembers the order in which you selected the atoms 
(1, 2, and 3). It first places atoms numbered 1 at the same coordi-
nates. Then it superimposes the bonds between atoms 1 and 2. 
Finally, it rotates the first molecule so that atoms 1, 2, and 3 in 
both molecules are in the same plane.

Show All

Show All cancels Show Selection Only and Hide Selection. You can 
then see all molecules in the molecular system. 

Note: You might not see all atoms in a molecule or all molecules 
in the molecular system. This depends on the other display condi-
tions (for example, Show hydrogens and Perspective View) and the 
viewpoint you use (for example, the zoom setting and the clipping 
slab settings). 

Show Selection Only

Show Selection Only displays only the selected atoms and mole-
cules that are visible (see “Visible Atoms” on page 134). It hides all 
atoms that are not selected. 

Use Show All to reverse Show Selection Only.

Hide Selection

Hide Selection makes all selected atoms invisible. Use Show All to 
reverse Hide Selection.

Rendering 

Rendering displays the Rendering property sheet for choosing the 
type of molecular rendering model and options. Not all options 
are supported with all models and this is indicated by grayed items 
in the dialog box. The dialog box has several pages which can be 
accessed by clicking on the appropriate “tab control”.

Rendering: Rendering Method

This page shows options for the rendering of atoms and bonds in 
the structure.
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Sticks This shows a line for every bond. Each half bond 
has the color of the element at the end of the bond. 
This is the most efficient rendering and requires 
the least amount of computing time when you 
make changes in position or rotational angle.

Balls Atoms are drawn as spheres (if Shaded is on) or as 
flat disks (if Shaded is off). Atoms are drawn in 
strict order of appearance, back to front; they are 
not shown as overlapping. With shading, the qual-
ity of this rendering increases significantly when 
using a video display with 256 or more colors.

Balls and 
Cylinders

Show bonds as solid objects. When Shaded is on, 
bonds are drawn as shaded cylinders; otherwise 
they are drawn without shading. Atoms are drawn 
as with the Balls option, above.

Overlapping 
Spheres

Atoms are drawn as overlapping, with CPK radii, as 
unshaded disks (if Shaded is off) or as shaded 
spheres (if Shaded is on). With shading, the quality 
of this rendering increases significantly when 
using a video display with 256 or more colors.

Dots These are transparent, space-filling models with a 
surface constructed of dots. The surface shows the 
CPK radii of the atoms. Stereo is not available and 
the Wedges option is ignored.

Sticks & Dots These models are a combination of Sticks and Dots. 
They show bonding and give an impression of the 
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space-filling properties of a molecular system. Ste-
reo is not available.

Note: You can apply labels (see “Labels” on page 176) only to Sticks 
and Sticks & Dots renderings.

Rendering: Sticks

This page shows options for rendering structures as Sticks.

Stereo Turn this option on with Sticks to see duplicate 
images of the molecular system for stereo viewing 
(see “Using Stereo” on page 168). With Stereo on, 
you can use the Selection tool only with the image 
on the right to select atoms or residues. You cannot 
use the Drawing tool. With Stereo off you see the 
normal, single image of a molecular system. 

Perspective Check this to have all molecules appear to be in 
perspective, with closer atoms appearing larger. 
Perspective must be on to see changes with the Z 
translation tool (see page 42). This option also 
shows the periodic box in perspective (see “Show 
Periodic Box” on page 171 and “Periodic Box” on 
page 219). 

With Perspective View off (no check mark), all 
atoms appear projected onto the plane of the 
screen; you have fewer visual clues to the depth of 
atoms within a molecule. 
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Ribbons Use Ribbons to highlight the secondary and ter-
tiary structure of a polypeptide chain or protein. 
Ribbons can be shown for polypeptides with resi-
dues that have originated from the amino acids 
database, or have been defined in a template file.

The ribbons follow the backbone of the polypep-
tide as a five-point spline curve, consisting of nine 
lines. The ribbons are displayed for the whole mol-
ecule, regardless of the selection or the segment of 
the molecule currently displayed. If you choose 
Hide Selections, this does not affect the visibility of 
the ribbons.

Wedges This option toggles the display of bonds with ste-
reochemistry constraints as either solid (wide end 
closer to you) or dashed (pointed end closer to 
you) wedges for Sticks and Stick & Dots. The wedges 
are used to depict stereochemistry constraints for 
the Model Builder, with the pointed end being 
connected to the constrained atom. Wedges can 
also be used for purely visual purposes as well. 
Wedges will appear with an exclamation point if 
the depicted stereochemistry constraint is not yet 
satisfied — use the Model Builder for it to take 
effect. See “Using Wedges to Display and Specify 
Stereobonds” on page 300.

IR Vectors Turn on this option with Sticks, Dots or Stick & Dots 
after performing a vibration calculation to display 
normal mode displacement vectors. See “Vibra-
tional Spectrum” on page 280.

Stick Width The slider and number box indicate the width used 
to draw sticks, in units of pixels.

Rendering: Cylinders

This page shows options for rendering bonds as cylinders.
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Color Scheme In this section, you can specify whether bonds 
should all be drawn with the same color, or colored 
according to the elements they join.

Use uniform 
colors

If this option is selected, all bonds will be 
drawn as shades of gray.

Color by 
element

If this option is selected, each bond is col-
ored according to the atoms that it joins. If 
the atoms are drawn in different colors, 
then the bond is drawn half in one color, 
and half in the other.

Cylinder width The slider and number box indicate the scaling fac-
tor which shows the cylinders’ radius as a fraction 
of the maximum allowed value. This maximum 
value is the radius at which a boron atom is drawn; 
boron has the smallest drawing radius of all the 
atoms.

Default Restores the scale factors to values that will display 
atoms with their default radii, or cylinders to a 
standard value.

Rendering: Balls

This page shows options for rendering atoms as balls.
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Shading This options toggles the display of atoms rendered 
as Balls, and bonds rendered as Cylinders, between 
a flat appearance and a shaded three-dimensional 
appearance. The flat display is much faster to draw, 
but the three-dimensional display looks much bet-
ter.

Highlight This option adds bright highlights to a structure, 
enhancing its three-dimensional appearance. This 
option is available only when Shaded is turned on.

Ball Radius The slider and number box give the scaling factor 
which shows the spheres’ radii as a fraction of the 
maximum allowed values.

Default Restores the scale factor to 0.5, which will display 
atoms with their default radii. For each atom, the 
default drawing radius is 0.75 × the van der Waals 
radius except when that value was not available, in 
which case the covalent radius is used. Setting the 
scale factor to 0.667 will therefore draw atoms with 
van der Waals radii.

Rendering: Overlapping Spheres

This page shows options for rendering atoms as Overlapping 
Spheres.
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Shading This options toggles the display of atoms rendered 
as Overlapping Spheres between a flat appearance 
and a shaded three-dimensional appearance. The 
flat display is much faster to draw, but the three-
dimensional display looks much better.

Highlight This option adds bright highlights to a structure, 
enhancing its three-dimensional appearance. This 
option is available only when Shaded is turned on.
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Sticks

Dots Sticks and Dots
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Balls, Shading off Overlapping Spheres, Shading and 
Highlights on

Balls and Cylinders, Shading off Balls and Cylinders, Shading and 
Highlights on
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Using Stereo

With the Stereo option on, you see duplicate images of the molec-
ular system for stereo viewing. You can turn Show Stereo on only 
when you are using the Sticks rendering model (see page 159). If 
you see only part of a molecular system in the workspace, Show 
Stereo presents a stereo pair of the atoms in the workspace only.

Note: Turning Perspective View on might increase the stereo effect.

When the stereo view is on, you can use the Selection tool only 
with the image on the right to select atoms or residues. You cannot 
use the Drawing tool.

HyperChem uses two different methods for presenting stereo 
images: walleyed or cross-eyed. You can set HyperChem to use one 
or the other by changing this setting in the Registry or the 
chem.ini file (see “Ab Initio Settings” on page 544):

WallEyedStereo=Yes (or No)

Walleyed Stereo

For walleyed stereo viewing, the images for the left and right eyes 
are on the left and right sides of the workspace respectively. The 
advantage of walleyed viewing is that you see one, fused 3D image. 
It is not suitable for large molecules, because the images might 
overlap in the workspace. 

Note: You might have to adjust the width of the HyperChem win-
dow to get the best stereo effect. This changes the separation of the 

backbone of tRNA, with walleyed stereo and Perspective View on 
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two images. The separation between images should be less than 
the distance between your eyes (about 8 centimeters). 
To see a stereo effect, you must merge these images into one. To do 
this you can use a stereo viewer, or place a sheet of paper against 
the screen to block your view of each image from the opposite eye. 
Then change your focus as if you were looking at a distant object. 
You can also aid image fusion by squinting or removing your 
glasses (if you are short-sighted) to blur your vision.

Cross-eyed Stereo

For cross-eyed stereo viewing, the images for the left and right eyes 
are reversed in the workspace: the image for the left eye is on the 
right side of the workspace. You must cross your eyes so that you 
see the left image with your right eye. The advantage of cross-eyed 
viewing is that you can see larger molecules in 3D.

This method requires more practice. You must learn to cross your 
eyes and to concentrate on the central, fused image in the presence 
of left and right images.

Last Rendering

Last Rendering returns the rendering mode to the mode that was 
used before the most recent change. Two modes can therefore be 
alternated by using this option repeatedly. This option can be acti-
vated by pressing [F2]. This menu item is not available while an iso-
surface is being displayed; displaying an isosurface automatically 
switches the rendering mode to Sticks.

Show Isosurface

If an isosurface has been calculated after a semi-empirical single-
point calculation, Show Isourface controls whether or not that sur-
face will be displayed in the workspace. This option can be turned 
on and off by pressing [F3]. Displaying an isosurface automatically 
switches the rendering mode to Sticks.

Note: While the Stereo or Perspective options of the Sticks render-
ing are turned on, you cannot display a contour plot or isosurface 
(see page 265). If the Wedges option is on, the wedges will not be 
shown while an isosurface is being displayed.
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Isosurface . . .

If an isosurface has been calculated after a semi-empirical single-
point calculation, Isosurface opens the Plot Molecular Properties 
property sheet (see page 265) or the Orbital Options property sheet 
(see page 275), which can also be opened from the Compute menu 
or Orbitals dialog box, respectively. This feature can also be acti-
vated by pressing [F4]. The isosurface can be displayed only if the 
structure is rendered in Sticks mode. The property sheets displayed 
by this option allow you to change the way that the stored values 
are drawn but not to recalculate the isosurface values themselves. 
These reduced property sheets allow you to change the Isosurface 
Rendering options and the Transparency Level options; the 
reduced Plot Molecular Properties sheet also allows you to change 
the Mapped Function options.

Show Hydrogens

Turn on Show Hydrogens (✓) to display all hydrogen atoms in the 
molecular system. The existence of hydrogens depends on your 
previous choices on the Build menu (Explicit Hydrogens, Add 
Hydrogens, and Add H & Model Build), plus the composition of the 
molecules.

Turn off Show Hydrogens (no check mark) to hide all hydrogens 
and simplify the rendering of molecules in the workspace. Only 
heavy atoms remain visible.

Hydrogens with a coordination number greater than 1 remain dis-
played when Show Hydrogens is unchecked. 

Show
Hydrogens
170 Chapter 6



Display Menu
Show Periodic Box

You create a periodic box, including water molecules, by choosing 
Periodic Box on the Setup menu (see page 219). Show Periodic Box 
turns off (no check mark) or on (✓) the display of the periodic box. 

Note: Turn on Perspective View on the Display menu to see the 
depth of the periodic box.

Turning off Show Periodic Box hides the outline of the box but 
leaves water molecules and periodic boundary conditions in the 
molecular system. To permanently remove the periodic box, you 
must edit the HIN file (see “box” on page 519), removing the box 
record.

Note: Show Periodic Box is gray until you create a periodic box.

Show Multiple Bonds

With Show Multiple Bonds on (✓), HyperChem uses different types 
of lines for single, double, triple, and aromatic bonds in Sticks or 
Sticks & Dots renderings.

Show Periodic Box on Show Periodic Box off
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With Show Multiple Bonds off (no check mark), all bonds appear as 
single lines.

If Show Multiple Bonds is off and you change the bond order with 
the Drawing tool (see “Changing the Bond Order” on page 295), 
the order of the bond (single, double, triple, or aromatic) appears 
on the status line.

Show Hydrogen Bonds

Show Hydrogen Bonds displays possible hydrogen bonds between 
selected atoms or, with no selection, for all molecules in the molec-
ular system. 

aromatic bond

triple bond

Show Multiple Bonds on Show Multiple Bonds off

double bond

single bond
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With Show Hydrogen Bonds on (✓), you see hydrogen bonds as 
white, dotted lines. 

To show hydrogen bonds:

1. Select specific molecules or deselect all atoms.

2. Make sure Show Hydrogen Bonds is on.

3. Choose Recompute Hydrogen Bonds on the Display menu (see 
the following section).

Caution: If you change the arrangement of molecules in the work-
space (for example, by XY translation) or if HyperChem changes 
the conformation during a calculation, choose Recompute Hydro-
gen Bonds to see up-to-date hydrogen bonds. 

With Show Hydrogen Bonds off (no check mark), hydrogen bonds 
are hidden. You cannot choose Recompute Hydrogen Bonds.

Recompute Hydrogen Bonds

Recompute Hydrogen Bonds determines hydrogen bonds between 
selected molecules or, if there is no selection, between all atoms in 
the molecular system. HyperChem creates a hydrogen bond if the 
distance between the donor hydrogen and acceptor atom is less 
than 3.2 Ångstroms and the angle made by covalent bonds to the 

hydrogen
bond
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donor and acceptor atoms is greater than 150 degrees. You can 
change these criteria in the Registry or the chem.ini file (see “Ab 
Initio Settings” on page 544).

Caution: HyperChem stretches apparent hydrogen bonds as you 
move molecules or during a calculation (geometry optimization or 
molecular dynamics). You must use Recompute Hydrogen Bonds to 
determine correct hydrogen bonding.

To use this item, Show Hydrogen Bonds must be on.

Show Inertial Axes

When you turn on Show Inertial Axes (✓), HyperChem computes 
and displays the inertial axes of selected atoms or, if there is no 
selection, the molecular system. The axes appear as three orthogo-
nal (perpendicular) dotted lines intersecting at the center of mass 
of the atoms. The lines are numbered 1, 2, and 3 for primary, sec-
ondary, and tertiary axes. The status line shows the moments of 
inertia in units of a.m.u.-Ångstroms2.

>150°

< 3.2Å
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Note: Inertial axes appear only with Sticks and Sticks & Dots ren-
derings of a molecular system.

Inertial axes are fixed in the Molecular Coordinate System and 
depend only on the number, type (mass), and position of atoms. 
The inertial axes have their origin at the center of mass and are 
orthogonal. The primary inertial axis is often the longest distance 
from the center of mass to the edge of the molecular system. See 
“Coordinate Systems” on page 18 for more information about 
coordinate systems and axes.

You can align a molecular system relative to its inertial axes (see 
“Align Molecules” on page 128).

Once Show Inertial Axes is on, it applies to any selection or molec-
ular system in the workspace. For example, if you change the 
selected atoms or use Merge (on the File menu) to add other mol-
ecules, HyperChem automatically computes and displays new 
inertial axes.

3

2

1

Edit, Display, and Select Menus 175



Display Menu
Show Dipole Moment

When you turn on Show Dipole Moment (✓), HyperChem displays 
the dipole moment that has been calculated for the selected atoms 
or for the molecular system. The menu item is gray and unavail-
able if a single-point calculation has not been performed to calcu-
late the dipole. The dipole moment appears as a dotted line inter-
secting the center of mass of the atoms. The status line shows the 
total dipole moment, followed in brackets by its x, y, and z com-
ponents, in units of Debyes.

Note that the sign convention used in the quantum mechanical 
calculation of dipoles is opposite to that used in molecular 
mechanics dipole calculations; this reflects the differing sign con-
ventions of physics and chemistry.

Labels 

Labels lists names identifying individual atoms or residues in a 
molecular system. For atoms, you can use only one type of label at 
a time. For residues, you can show both atom and residue labels at 
the same time.
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Labels applies to selected atoms or, if there is no selection, to the 
whole molecular system. By selecting atoms, applying different 
labels, and removing the selection, you can mix the types of labels 
that appear in the workspace. 

Note: You can apply labels only to Sticks and Sticks & Dots render-
ings (see “Rendering” on page 159).

When you open the Labels dialog box, the default choice is always 
set to None. You can either accept this choice to remove all labels 
or choose another label. Each time you use the Labels dialog box, 
your choices replace the previous choices for selected atoms, or, if 
there is no selection, for all atoms.

Labels Dialog Box

Atoms

None Removes all labels. This is the default.

Symbol Atomic symbol, for example, C, O, Na, or P.

Name The names of atoms from the Brookhaven 
Protein database; for example, CA and CB 
for the alpha and beta carbons.

Number Atom number.

Type Atom type, according to the force field in 
effect; for example, CT for a tetrahedral 
carbon in the AMBER force field.

Charge Net atomic charge, for example, –0.23.

Mass Atomic mass.
Edit, Display, and Select Menus 177



Display Menu
Basis set Basis set applied to each atom (may be 
None).

Chirality R or S.

Residues

None Removes all labels. This is the default.

Name Residue name, for example, TRP, or ILE.

Sequence Sequence number from the N-terminus: 
1, 2, 3 ... 25 ... .

Name + Seq Both Name and Sequence.

Color

Color shows the Selection Color dialog box for marking selected 
atoms with a distinct, persistent color. Atoms keep this color after 
you deselect them. If there is no selection, the whole molecular 
system takes on this persistent color. Use this feature to keep track 
of a set of atoms in a larger molecular system.

When you make a selection, atoms first take the color for a selec-
tion set in the Preferences dialog box (see page 65). The default is 
Green. The color you choose from the Selection Color dialog box 
replaces a color chosen in the Preferences dialog box. 

Note: You see the persistent selection color only after you deselect 
the atoms. However, if you are using Thick line to highlight selec-
tions (see “Preferences Property Sheet” on page 65), the persistent 
color appears immediately.

To remove the persistent color from a molecular system, open this 
dialog box again and choose the default, By element.
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Selection Color Dialog Box

To apply a color to a selection:

1. Select a set of atoms.

2. Choose Color on the Display menu.

3. Choose a color from the dialog box.

4. L-click OK.

To remove a persistent color:

1. Select a set of atoms or, for the whole molecular system, dese-
lect all atoms.

2. Choose Color on the Display menu.

3. L-click OK in the dialog box to choose By element.
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Element Color 

Element Color shows you the Element Color dialog box for chang-
ing the color assigned to each element. This establishes the By ele-
ment choice you see in other dialog boxes:  

Element Default Color

Lone pair broken white line

Carbon cyan

Nitrogen blue

Oxygen red

Fluorine yellow

Sodium violet

Sulfur yellow

Potassium violet

Iron red

Cobalt blue

Copper green

Bromine yellow

Iodine red

Gold yellow

All other 
elements

white
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You have a choice of six standard colors, plus black and white. 
HyperChem uses a default set of colors (for example, cyan for car-
bon and red for oxygen). If you change an element color, you can 
always return to the default set of colors by choosing Revert in this 
dialog box.

Element Color Dialog Box

To set a new element color:

1. L-click on the element name in the Element list.

2. L-click on the new color assignment in the Color list.

3. L-click OK.

To return to the default colors:

1. L-click on Revert.

Note: This dialog box establishes the By element color scheme 
referred to in other dialog boxes (see “Preferences Property Sheet” 
on page 65 and “Selection Color Dialog Box” on page 179).
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Chapter 7

Chemical Calculations

This chapter describes functions in the Setup and Compute menus 
for carrying out chemical calculations. The calculations always 
involve molecules in the workspace.

Setup Menu

The Setup menu provides options for running energy calculations. 
After you choose Setup menu options, use the Compute menu to 
begin a calculation.

HyperChem performs molecular mechanics calculations using any 
of four methods (MM+, AMBER, BIO+, and OPLS), semi-empirical 
quantum mechanics using any of nine methods (Extended 
Hückel, CNDO, INDO, MINDO3, MNDO, AM1, PM3, ZINDO/1, 
and ZINDO/S), or ab initio quantum mechanics calculations.

The Setup menu has these items:  

✓ Molecular 
Mechanics. . .a 

Choose Molecular Mechanics to use a Newtonian 
method instead of a quantum mechanical (semi-
empirical or ab initio) method for a calculation. 
Molecular mechanics remains on (✓) until you 
choose Semi-empirical or Ab Initio

✓ Semi- 
empirical . . .a 

Choose Semi-empirical to use one of these quan-
tum mechanics methods instead of a molecular 
mechanics or ab initio method for a calculation. 
Semi-empirical remains on (✓) until you choose 
Molecular Mechanics or Ab Initio
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a. Only one of these items can be active at a time. A check mark appears next
to the active item.

✓ Ab Initio. . .a Choose Ab Initio to use this quantum mechanics 
method instead of a molecular mechanics or 
semi-empirical method for a calculation. Ab Initio 
remains on (✓) until you choose Molecular 
Mechanics or Semi-empirical

Periodic Box . . . Choose this item to enclose the molecular system 
in a periodic box containing water molecules

Restraints . . . Choose this item to add restraining forces to 1, 2, 
3 or 4 atom named selections for molecular 
mechanics and quantum mechanics. This item is 
gray if there are no named selections with 1 to 4 
atoms

Set Velocity . . . Choose this item to specify velocities for atoms. 
The velocities can be used in molecular dynamics 
calculations by using the Restart option. It is gray 
if there are no atoms

Network . . . Choose this item to specify a remote server to 
perform molecular mechanics, semi-empirical, or 
ab initio calculations

Select Parameter 
Set . . . 

Choose this item for an alternative set of com-
piled parameters (see the following section) for a 
molecular mechanics calculation 

Compile Parameter 
File 

Choose this item to convert a new parameter set 
(see Select Parameter Set) from text or database 
files to a binary file. HyperChem uses a binary file 
for molecular mechanics calculations

Reaction Map . . . Choose this item to map reactants to products for 
a Synchronous Transit transition state search. This 
item is gray and unavailable unless both REAC-
TANT and PRODUCT named selections have been 
defined, with the same numbers of atoms in each
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Molecular Mechanics

Choose Molecular Mechanics to use a classical Newtonian calcula-
tion method instead of a quantum mechanical (semi-empirical or 
ab initio) method. This choice remains on (✓) until you choose one 
of the alternatives, Semi-empirical or Ab Initio. You can use any of 
these methods for Single Point, Geometry Optimization and 
Molecular Dynamics calculations on the Compute menu.

Molecular mechanics calculations treat atoms as Newtonian parti-
cles interacting through a potential energy function. The potential 
energies depend on bond lengths, bond angles, torsion angles, and 
nonbonded interactions (including van der Waals forces, 
electrostatic interactions, and hydrogen bonds). In these calcula-
tions, the forces on atoms are functions of atomic position.

Note: If only part of the system in the workspace is selected, then 
only interactions which involve at least one selected atom will be 
included in the calculations. Interactions involving only unse-
lected atoms will be omitted. For structural-optimization calcula-
tions, only selected atoms are allowed to move, while unselected 
atoms remain fixed in space.

The Molecular Mechanics Force Field dialog box is displayed to 
choose a force field (potential function) for a calculation.

From the Molecular Mechanics Force Field dialog box, you can go 
to either the MM+ Options dialog box (see page 186) or the Force 
Field Options dialog box (see page 188). Use these dialog boxes to 
change the conditions for a calculation.

Molecular Mechanics Force Field Dialog Box

MM+ Developed for organic molecules. This is an “all 
atom” force field. HyperChem supplements MM2 
by providing additional parameters (force con-
stants) using two alternative schemes (see 
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HyperChem Computational Chemistry, Theory and 
Methods). This extends the range of chemical 
compounds that MM+ can accommodate. MM+ 
also provides cutoffs for calculating nonbonded 
interactions (see “MM+ Options Dialog Box” on 
page 186), periodic boundary conditions, and a 
modified bond-stretch energy term that avoids 
repulsions at long bond lengths (see HyperChem 
Computational Chemistry, Theory and Methods).

AMBER Developed for proteins and nucleic acids. You can 
choose an all-atom or a united-atom simulation. 
The united-atom option treats certain atom groups 
as one atom, with one atom type.

BIO+ Developed for biological macromolecules. You can 
choose an all-atom or a united-atom simulation. 
The united-atom option treats certain atom groups 
as one atom, with one atom type.

OPLS Developed for proteins and nucleic acids. It is sim-
ilar to AMBER but treats more accurately non-
bonded interactions. This force field provides only 
a united-atom simulation (see AMBER).

Options . . . L-click to go to the MM+ Options dialog box (see 
page 186) when MM+ is chosen or to the Force 
Field Options dialog box (see page 188) for AMBER, 
BIO+ or OPLS.

Each type of molecular mechanics method (force field) has an 
extensive set of rules for determining atom types. See HyperChem 
Computational Chemistry, and appendix B of this book on 
page 463, for discussions of force fields, how to use them, and lit-
erature references. 

MM+ Options Dialog Box

Use the MM+ Options dialog box to set the conditions for the 
MM+ molecular mechanics force field. HyperChem stores these 
option settings, except for Cutoffs, in the Registry or in the 
chem.ini file and uses them for future HyperChem sessions.
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Electrostatics Nonbonded electrostatic interactions are calcu-
lated using bond dipole interactions or partial 
atomic charges.

Bond dipoles This uses bond dipoles to calculate non-
bonded electrostatic interactions. The 
bond dipole values come from the MM+ 
stretch parameter file (see page 474).

Atomic charges This uses partial atomic charges to calcu-
late nonbonded electrostatic interactions. 
You can assign partial atomic charges via 
the Build/Set Charge menu item (see 
page 91) or you can do a semi-empirical or 
ab initio calculation first that calculates 
partial charges for each atom using a Mul-
liken population analysis.

Cutoffs These options determine the distance limits for 
calculating nonbonded interactions. Choosing
Periodic Box on the Setup menu automatically sets 
Switched with default values. Cutoffs are necessary 
to prevent calculating interactions with neighbor-
ing periodic images.1

None Calculates all nonbonded interactions. 
This is the default for systems in vacuo. Do 
not use this option for periodic boundary 
conditions because it results in an implicit 

1. A periodic box implies a sharp, rectangular cutoff. An atom interacts only with one nearest image of
all other atoms and never with an image of itself. This sharp cutoff can cause discontinuities in
the potential surface that interfere with geometry optimization and molecular dynamics calcula-
tions. To avoid this, HyperChem uses Switched or Shifted cutoffs for a molecular system in a peri-
odic box.
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undamped cutoff and causes discontinui-
ties in the potential surface.

Switched A smoothing function, applied from the 
inner radius to the outer radius, gradually 
reduces nonbonded interactions to zero. If 
the molecular system is in a periodic box, 
HyperChem chooses Switched and sets the 
Outer and Inner Radius. You can also use 
Shifted.

Shifted A smoothing function, applied over the 
whole nonbonded distance, from zero to 
outer radius, gradually reduces nonbonded 
interactions to zero. 

Outer radius For Switched and Shifted cutoffs, this is the 
minimum distance at which nonbonded 
interactions are set to zero. This should 
normally be set to at least 4 Ångstroms 
larger than the Inner radius. With periodic 
boundary conditions, this value is half the 
smallest dimension of the periodic box.

Inner radius For Switched cutoffs only, this is the maxi-
mum interatomic distance for full non-
bonded interactions. With periodic bound-
ary conditions, this value is 4 Ångstroms 
less than half the smallest dimension of 
the periodic box or a minimum of zero.

Note: The Cutoffs settings return to their default values if you place 
a new molecular system in the workspace.

Force Field Options Dialog Box

Use the Force Field Options dialog box to set the conditions for the 
molecular mechanics force fields AMBER, BIO+, and OPLS. Hyper-
Chem stores these option settings, except for Cutoffs, in the Regis-
try or in the chem.ini file and uses them for future HyperChem ses-
sions.
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Dielectric 
permittivity
(epsilon)

Constant or Distance dependent determine the 
method of calculating epsilon, a factor that modi-
fies charge-charge interactions (and the electro-
static potential). Epsilon is the dielectric constant. 

Constant This makes epsilon a constant. This is the 
form appropriate for systems in a gas phase 
or in an explicit solvent. Use this option 
for systems in a periodic box.

Distance 
dependent

This makes epsilon proportional to the 
interatomic separation. This approximates 
solvent effects in the absence of an explicit 
solvent, and allows for faster calculations. 
Use Distance dependent with the OPLS 
force field. Since this option simulates the 
presence of a solvent, you normally choose 
Constant when solvent is present.

Scale factor For Constant, epsilon = (permittivity of free 
space) x (Scale factor). For Distance depen-
dent, epsilon = (permittivity of free space) 
x (Scale factor) x (interatomic separation). 
Scale factor must be ≥1.0. The default of 1.0 
is appropriate for most systems.

1–4 Scale
factor

Nonbonded interactions (van der Waals and elec-
trostatic) between atoms separated by exactly three 
bonds are multiplied by this factor.

Electrostatic This modifies the magnitude of charge 
interactions between atoms separated by 
three bonds. The range is 0 to 1. For 
AMBER and OPLS, use 0.5. For BIO+, use 
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1.0, 0.5, or 0.4 depending on the parameter 
set.

van der Waals This modifies the magnitude of van der 
Waals interactions between atoms sepa-
rated by three bonds. The range is 0 to 1. 
For AMBER, use 0.5; for OPLS, 0.125; for 
BIO+, the value is fixed at 1.0.

Cutoffs These options determine the distance limits for 
calculating nonbonded interactions and are iden-
tical to those for MM+ (see “Cutoffs” on page 187).

Semi-empirical

Choose Semi-empirical to use a semi-empirical quantum-mechani-
cal calculation method instead of a molecular mechanical or ab 
initio quantum-mechanical method. This choice remains on (✓) 
until you choose Molecular Mechanics or Ab Initio. You can use a 
semi-empirical method for all calculations on the Compute menu.

Semi-empirical calculations solve the SchrÖdinger equation, with 
certain approximations, to describe the electronic properties of 
atoms and molecules. To simplify and shorten these calculations, 
semi-empirical methods make many simplifications, including 
these: calculating only for valence electrons; neglecting the inte-
grals for certain interactions; using standard, non-optimized, elec-
tron orbital basis functions; and using parameters derived from 
experiments. Experimental parameters eliminate the need to cal-
culate certain quantities and to correct for errors resulting from 
approximations. See HyperChem Computational Chemistry for fur-
ther information about semi-empirical quantum mechanics.

Important: The semi-empirical methods in HyperChem can treat 
all main group elements for which there are parameters in the 
parameter files, up to and including xenon. Extended Hückel, 
ZINDO/1, and ZINDO/S can treat the first two rows of transition 
metals as long as there are entries in the parameter files. See the 
periodic tables in “Available Elements” on page 194 for availability 
of parameters.

Most of the available semi-empirical methods include a scheme for 
eliminating time-consuming calculations of certain integrals for 
overlapping orbitals. The Intermediate Neglect of Differential 
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Overlap method (see later) does not calculate certain repulsion 
integrals that would have small values.

HyperChem also allows you to treat only part of a system quantum 
mechanically, using mixed mode calculations, so that you can study 
interesting portions of a molecular system at a better level of the-
ory than would be feasible for the whole system. For instance you 
can analyze binding of a substrate at the active site of a protein 
quantum mechanically, with the rest of the protein and solvent 
modeled classically.

Important: Unless you wish to perform a mixed mode calculation, 
deselect all atoms before using the Semi-empirical Options dialog 
box or the Compute menu. If there is a selection, HyperChem only 
treats the selected atoms quantum mechanically. The remaining 
atoms are treated as a fixed potential field, and are not moved dur-
ing structural optimizations.

Important: If you want to perform a mixed mode calculation, use 
Extend to sp3 on the Select menu before using the Semi-empirical 
Options dialog box or the Setup menu. See “Mixed Mode Calcula-
tions” on page 203.

Note: If you store a molecular system in a HIN file after a semi-
empirical calculation, the file includes atomic charges determined 
in these calculations (see “atom” on page 520).

From the Semi-empirical Method dialog box, you can go to the 
Semi-empirical Options dialog box (see page 198) to change the 
conditions for a calculation.
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Semi-empirical Method Dialog Box

Extended
Hückel

Useful for calculating molecular orbitals of mole-
cules. Not available for geometry optimization or 
molecular dynamics calculations. Uses the “one-
electron” simplification that assumes no explicit 
interactions between electrons. This is not a Self-
Consistent Field (SCF) method (see HyperChem 
Computational Chemistry, Practical Guide).

CNDO Complete Neglect of Differential Overlap. This is 
the simplest of the SCF methods. It is useful for cal-
culating ground-state electronic properties of 
open- and closed-shell systems, geometry optimi-
zation, and total energy. 

INDO Intermediate Neglect of Differential Overlap. 
Improves on CNDO by accounting for certain one-
center repulsions between electrons in the same 
atom. Useful for calculating ground-state elec-
tronic properties of open- and closed-shell sys-
tems, geometry optimization, and total energy. 
This is an SCF method.

MINDO3 An extension of INDO that uses parameters, 
instead of calculations, for many interactions. Use-
ful for large organic molecules, calculating 
electronic properties, geometry optimization, and 
total energy calculations. This is an SCF method.
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MNDO Useful for various organic molecules containing 
elements from long rows 1 and 2 of the periodic 
table, but not transition metals. Eliminates some 
errors in MINDO3. Calculates electronic 
properties, optimized geometries, total energy, and 
heat of formation. This is an SCF method.

AM1 An improvement of the MNDO method and one of 
the most accurate methods. Useful for organic 
molecules containing elements from long rows 1 
and 2 of the periodic table, but not transition met-
als. Possibly better than MNDO for compounds 
containing both nitrogen and oxygen. Calculates 
electronic properties, optimized geometries, total 
energy, and heat of formation. This is an SCF 
method.

PM3 A reparameterization of AM1. PM3 differs from 
AM1 only in the values of the parameters. The 
parameters for PM3 were derived by comparing a 
much larger number and wider variety of experi-
mental versus computed molecular properties. 
Typically, nonbonded interactions are less repul-
sive in PM3 than in AM1. PM3 is primarily used for 
organic molecules, but is also parameterized for 
many main group elements. This is an SCF 
method.

ZINDO/1 A variation of INDO extended to transition metals. 
Equivalent to the most recent version of the 
INDO/1 method which differs from the original by 
using constant orbital exponents. ZINDO/1 lets 
you calculate the energy states and geometries of 
molecules containing transition metals.

ZINDO/S An INDO method parameterized to reproduce 
UV/visible spectroscopic transitions when used 
with the CI singles method. Useful for predicting 
UV/visible spectra but not suitable for geometry 
optimization or molecular dynamics.

Options . . . L-click to display the Semi-empirical Options dia-
log box for setting the conditions for calculation. 
There are two versions of this dialog box, depend-
ing on the semi-empirical method that you choose 
(see the next two sections).
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See: HyperChem Computational Chemistry for a discussion of these 
methods, how to use them, and literature references.

Available Elements

The following tables show the elements that can be treated by the 
semi-empirical methods in HyperChem. Where the element sym-
bol is shown it indicates that HyperChem includes the program 
code necessary to evaluate integrals for the principal and angular 
quantum numbers of the valence orbitals. In order to perform cal-
culations for an element, HyperChem also needs to know param-
eters to use in evaluating the integrals. Parameters for some ele-
ments are not currently available in the literature. Once these 
parameters become available, you can add them to the appropriate 
parameter files (see “Semi-Empirical Files” on page 487). Elements 
for which parameters are available in the standard HyperChem 
distribution are shaded in the tables. Unless you have extended 
parameter files, use only the shaded elements with each method.

Extended Hückel

The Extended Hückel method can be used with any element in the 
periodic table; the default parameter set includes all necessary 
parameters.

CNDO, INDO

H

Li Be

Na Mg

B C

Al Si

N O

P S

F Ne

Cl Ar

AsGe

He

Se BrK Ca

Rb Sr ISb

GaZn Kr

XeTeSnInCd
194 Chapter 7



Setup Menu
MINDO3

MNDO

AM1

H

B C

Si

N O

P S

F

Cl

Li Be

Al

Ne

Ar

Ge

He

ISb

GaZn Kr

XeTeSnInCd

As Se Br

Na Mg

K Ca

Rb Sr

H

B C

Al Si

N O

P S

F

Cl

Li Be

I

Ge

Ne

Ar

He

GaZn Kr

XeTeSnInCd

Se

Na Mg

K Ca

Rb Sr Sb

As Br

H

B C

Al Si

N O

P S

F

Cl

Br

Li Be

Ge

I

Zn

Na Mg

K Ca

Rb Sr

Ne

Ar

He

Ga Kr

XeTeSnInCd

Se

Sb

As
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PM3

ZINDO/1

ZINDO/S

H

C N O F

Si P S Cl

Ge As Se Br

Sn Sb Te I

Ga

Cd In

Al

Be

Mg

Zn

Li

Na

B Ne

Ar

He

K Ca

Rb Sr

Kr

Xe

H

NiV Cr

Nb Mo

Fe Co

Ru Rh

CuMn

Mg

Zn

Cd

C N O

S

F

Sc Ti

Y Zr Tc Pd Ag

H

Al Si P Cl

ISb

GeGa As Se Br

TeSnIn

K

Rb Sr

B Ne

Ar

He

Kr

Xe

Li Be

Na

Ca

H

NiV Cr Fe Co CuMn ZnTi

Mg

C N O

S

F

Sc

Be

Na

Ca

Cl

I

Br

Ne

Ar

He

Kr

Xe

Al Si P

Sb

GeGa As Se

TeSnIn

B

K

Rb Sr Nb Mo Ru Rh CdY Zr Tc Pd Ag

Li
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Semi-empirical Options (Hückel) Dialog Box

This dialog box provides settings for the Extended Hückel semi-
empirical method. All other semi-empirical methods use a differ-
ent dialog box (see the next section).

Total charge This is the net excess of nuclear charge over elec-
tronic charge. It is zero for a neutral system, a 
positive integer for a cation, and a negative integer 
for an anion.

Spin
multiplicity

This is the total spin multiplicity, 2S+1, where S is 
the total electron spin of the system. Each 
unpaired electron counts for 1/2. A closed-shell 
system (singlet) has a multiplicity of 1. A doublet 
or triplet state has a multiplicity of 2 and 3, respec-
tively. Enter an integer from 1 to 6.

Hückel 
Constant

A constant of proportionality between off-diago-
nal matrix elements and diagonal matrix elements. 
The usual value is 1.75. Larger values give more 
weight to the role of atomic orbital overlap in 
determining the energy, while smaller values give 
more weight to binding energies of electrons in the 
atomic orbitals.

Unweighted 
constant

Uses the Hückel constant without modifi-
cation.

Weight 
diffuseness

Multiplies the Hückel constant by a factor 
that accounts for the diffuseness of atomic 
orbitals. This factor is only significant for 
molecular systems containing orbitals of 
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very different diffuseness. This is rarely the 
case for organic molecules and main group 
elements. 

d orbitals Check this box (✓) to add d orbitals for Si, P, S, and 
Cl atoms. 

Scale Factor This parameter scales the inclusion of the classical 
partial charges in a mixed mode calculation. See 
HyperChem Computational Chemistry, Theory and 
Methods, for details.

Semi-empirical Options Dialog Box

This dialog box provides settings for any semi-empirical, quantum 
mechanical method that you chose, except for Extended Hückel. 
Extended Hückel has a separate Semi-empirical Options dialog box 
(see the previous section).

Total charge This is the net excess of nuclear charge over elec-
tronic charge. It is zero for a neutral system, a 
positive integer for a cation, and a negative integer 
for an anion.

Spin 
multiplicity

This is the total spin multiplicity, 2S+1, where S is 
the total electron spin of the system. Each 
unpaired electron counts for a spin of +1/2. A 
closed-shell system has a multiplicity of 1 (singlet). 
An open-shell system can have a multiplicity of 2, 
3, 4 (doublet, triplet, quartet), or higher. Use inte-
gers from 1 to 6.
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State This describes the excitation state of the valence 
electrons in the system.

Lowest The lowest electronic state of a given spin 
multiplicity. 

Next lowest This is the first electronically excited state 
of a given spin multiplicity (singlet, dou-
blet, triplet, or quartet).

Convergence 
limit

An SCF calculation ends when the difference in 
energy after two consecutive iterations is less than 
this amount. This is the convergence limit for total 
electron energy during iterations of an SCF calcu-
lation. The default is 0.01 kcal/mol. The practical 
range is 1 to 10–3. The calculation might not reach 
values less than 10–3 because of round-off errors. It 
is better to use small values for the convergence 
limit if you are doing a transition state search (see 
page 263).

Iteration
limit

This sets the maximum number of iterations for an 
SCF calculation. The calculation ends after this 
iteration, even if it has not reached the Conver-
gence limit (see above). The results might be incor-
rect if the calculation was far from convergence or 
the energy of the system is oscillating. The default 
of 50 should be correct for most cases, though 
larger values may be better for transition state 
searches (see page 263). The practical range is 50 to 
200.

Accelerate
convergence

Check this box (✓) to reach faster convergence for 
SCF iterations, using a procedure known as Direct 
Inversion of Iterative Subspace (DIIS), (see 
HyperChem Computational Chemistry).

Spin pairing This sets the method for calculating spin interac-
tions, of which there are two:

UHF The Unrestricted Hartree-Fock method 
provides separate spatial orbitals (alpha 
and beta) for electrons with each type of 
spin. This method is useful for open- and 
closed-shell systems. For closed-shell sys-
tems, it can accommodate dissociation 
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reactions. Takes longer than an RHF calcu-
lation.

RHF The Restricted Hartree-Fock method 
requires that a spin pair of electrons 
occupy the same spatial orbital. Single elec-
trons can also occupy an orbital. This 
method is useful for open- and closed-shell 
systems.

Overlap 
Weighting
Factors

Additional parameters for the two ZINDO methods 
which modify the relative contributions of sigma 
and pi bonding. See HyperChem Computational 
Chemistry, Theory and Methods, for further details.

Sigma-Sigma Adjusts the weighting for sigma-sigma 
atomic orbital overlap. This should be 1.0 
for ZINDO/1 and 1.267 for 
ZINDO/S.Adjusts the weighting for sigma-
sigma atomic orbital overlap. 

Pi-Pi Adjusts the weighting for pi-pi atomic 
orbital overlap. This should be 1.0 for 
ZINDO/1. The default of 0.640 for 
ZINDO/S is appropriate for transition 
metal complexes, but 0.585 has been used 
for organic molecules in the literature.

Configuration
interaction

Use this option to activate and set options for a 
Configuration Interaction calculation in the Con-
figuration Interaction dialog box. This is necessary 
if you wish to compute UV visible spectra. Choos-
ing this option significantly increases calculation 
time.

Configuration Interaction Dialog Box

CI calculations can be used to improve the quality of the wave-
function and state energies. Self-consistent field (SCF) level calcu-
lations are based on the one-electron model, wherein each elec-
tron moves in the average field created by the other n-1 electrons 
in the molecule. Actually, electrons interact instantaneously and 
therefore have a natural tendency to avoid each other beyond the 
requirements of the Exclusion Principle. This correlation results in 
a lower average interelectronic repulsion and thus a lower state 
energy. The difference between electronic energies calculated at 
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the SCF level versus the exact nonrelativistic energies is the corre-
lation energy.

There are two types of electron correlations: static and dynamic. 
Static correlation refers to a near degeneracy of a given state; a 
dynamic correlation refers to the instantaneous avoidance of elec-
trons with each other.

CI calculations are perhaps the most widely used method of going 
computationally beyond an SCF description. An SCF computation 
yields a configuration describing the orbital occupancy of the elec-
trons. Other configurations may be generated from this reference 
configuration by exciting electrons from the set of occupied orbit-
als to the set of virtual (unoccupied) orbitals. A CI calculation yields 
a set of improved states, each of which is represented by a linear 
combination of these configurations.

Note: Only single point calculations can be performed with Con-
figuration Interaction activated. It is not available for extended 
Hückel calculations.

Use the Configuration Interaction dialog box to control settings 
for a CI calculation. To access this dialog box, choose CI in the 
Semi-empirical Options dialog box.

CI Method Choose None, Singly Excited, or Microstate.

None Choose None if you do not want to use 
configuration interaction.

Singly Excited Only singly excited configurations are 
involved in a CI calculation.
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Microstate Includes multiply excited states, as well as 
singly excited states.

Orbital
Criterion

Set the range of orbitals to and from which elec-
trons are excited to generate a set of interacting 
configurations.

Occupied Range of occupied orbitals starting from 
HOMO from which electrons are excited.

Unoccupied Range of virtual orbitals starting from 
LUMO to which electrons are excited.

Energy
Criterion

As an option to Orbital Criterion, this value sets the 
cutoff energy for generating a set of interacting 
configurations. This option is available only if you 
use Singly Excited as the CI method.

Maximum 
Excitation

Highest orbital energy difference in (eV) between 
the occupied and unoccupied orbitals to be 
included in the CI calculation. Generally configu-
rations of high energy do not interact strongly 
with the reference calculation. The higher the 
maximum energy, the greater the number of con-
figurations included in the CI calculation.

Practical Applications

You can use CI calculations to do the following:

• Calculate UV spectra

• Calculate the energy of excited states

• Study the making or breaking of bonds, and change of spin 
couplings (e.g. dissociation of H2)

• Capture the effects of London dispersion forces

• Describe a nearly degenerate state

• Study singlet-triplet splittings more accurately

The Microstate CI Method lowers the energy of the uncorrelated 
ground state as well as excited states. The Singly Excited CI Method 
is particularly appropriate for calculating UV visible spectra, and 
does not affect the energy of the ground state (Brillouin’s 
Theorem).
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Be careful when you use the Orbital Criterion for symmetrical sys-
tems. To get correct results, you must include all or none of any set 
of degenerate orbitals in the CI, not just some of them. Carrying 
out an RHF calculation first and studying the Orbitals dialog box 
will help you to spot degenerate orbitals and avoid this pitfall.

You should also be careful when you use the Energy Criterion that 
the cutoff energy is large enough to include occupied and unoccu-
pied orbitals.

In large systems there can be many orbitals in a small energy 
range, and the size of the CI matrix can be very sensitive to the 
value of the maximum excitation if you use Energy Criterion. Since 
calculation time depends heavily on the size of the CI matrix, you 
can end up with very long calculations, especially if you use the 
MNDO, AM1, or PM3 methods. Again, inspecting the results of an 
RHF (no CI) calculation will help you avoid these pitfalls.

For information on specific guidelines for calculating UV visible 
spectra, see “Electronic Spectrum” on page 285.

Mixed Mode Calculations

In mixed mode calculations, HyperChem treats a selected part of a 
molecule quantum mechanically; the remainder is treated classi-
cally. You can do mixed mode calculations using any of the 
choices in the Semi-empirical Methods dialog box.

Note: If only some atoms in the workspace are selected, then only 
the selected atoms will move during a structural optimization. The 
unselected atoms are treated as producing a fixed potential field; 
the selected atoms interact with that field and with each other.

To perform a mixed mode calculation, you tell HyperChem which 
atoms to treat quantum mechanically by selecting them. If some 
molecules are partially selected, the boundary atoms must be sp3 
centers to avoid an abrupt termination of conjugation effects. To 
ensure that the boundary is between sp3 atoms, you need to use 
Extend to sp3 on the Select menu (see page 152) before using the 
Semi-empirical Options dialog box or using the Compute menu. 
This extends the current selection in all directions until the 
selected region reaches the end of a molecule or finds an sp3-sp3 
bond.
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Ab Initio

Choose Ab Initio to use an ab initio quantum-mechanical calcula-
tion method instead of a molecular mechanical or semi-empirical 
quantum-mechanical method. This choice remains on (✓) until 
you choose Molecular Mechanics or Semi-empirical. You can use an 
ab initio method for all calculations on the Compute menu.

Geometry optimization using an ab initio method may take much 
longer than using a semi-empirical method. You might first run a 
molecular mechanics optimization to get close to the optimized 
geometry, and refine with a semi-empirical method, before run-
ning an ab initio geometry optimization. For some inorganic struc-
tures in particular, molecular mechanics and/or semi-empirical 
optimizations may give poor results for lack of appropriate param-
eters, but running the Model Builder on your structure should pro-
vide at least a reasonable starting point.

Choosing a Basis Set

Any set of one-electron functions can be a basis set in the LCAO 
approximation. However, a well-defined basis set will predict elec-
tronic properties using fewer terms than a poorly-defined basis set. 
So, choosing a proper basis set in ab initio calculations is critical to 
the reliability and accuracy of the calculated results1.

There may be as many basis sets defined for polyatomic calcula-
tions as there are quantum chemists! One would like to define, in 
advance, the standard basis sets that will be suitable to most users. 
But, one also wants to allow sophisticated users the capability to 
modify existing basis sets or define their own basis sets. We have 
thus defined a HyperChem basis set file format and included with 
HyperChem a number of these *.BAS files that define standard 
basis sets. Users, however, can define as many of their own basis 
sets as they like using this file format. The HyperChem basis set file 
format is described in Appendix C of this manual.

Many conventional and commonly-used ab initio basis sets are 
supported in HyperChem. These basis sets include:
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• STO-1G and STO-1G* (H and He)1;

• STO-2G and STO-2G* (H to Xe)1;

• STO-3G and STO-3G* (H to Xe)1;

• STO-4G and STO-4G* (H to Xe)1;

• STO-5G and STO-5G* (H to Xe)1;

• STO-6G and STO-6G* (H to Xe)1;

• 3-21G, 3-21G*, and 3-21G** (H to Ar)2;

• 4-21G, 4-21G*, and 4-21G** (H to Ne)3;

• 6-21G, 6-21G*, and 6-21G** (H to Ar)2;

• 4-31G, 4-31G*, and 4-31G** (H to Ne)3;

• 5-31G, 5-31G*, and 5-31G** (H to F)3;

• 6-31G, 6-31G*, and 6-31G** (H to Ar)3;

• 6-311G, 6-311G*, and 6-311G** (H to Ar)4;

• D95, D95* and D95** (H to Cl)5.

Ab Initio Method Dialog Box

You can use multiple basis sets in a single molecular system. The 
Apply Basis Set button in this dialog box applies the currently 
selected basis set to the selected atoms or to all the atoms in Hyper-
Chem if there is no current selection. For example, some heavy 
atoms might have a 6-31G basis set (s and p only) while other 
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heavy atoms might use a 6-31G* basis set (with d-orbitals). This is 
an unusual but flexible option for ab initio calculations.

Basis Set Specify a basis set for the current selection (if any) 
or for the whole molecular system.

No basis set Do not use any basis set for the current 
selection (if any) or for the whole molecu-
lar system. This option may be useful only 
when applying an extra basis function to 
atoms.

Minimal
(STO-3G)

Selects the STO-3G basis set.

Small
(3-21G)

Selects the 3-21G basis set.

Medium
(6-31G*)

Selects the 6-31G* basis set.

Large
(6-31G**)

Selects the 6-31G** basis set.

Other Choose this option and invoke Assign 
Other Basis Set in order to choose another 
basis set.

Assign Other 
Basis Set...

Click on this button to bring up the Assign 
Other Basis Set dialog box, which contains 
a full list of basis sets (except for the basis 
sets already listed in this dialog box).

Extra Basis 
Function...

Click on this button to bring up the Extra Basis 
Function dialog box, which lets you add an extra 
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basis function to the selected atoms (or to all the 
atoms).

Options... Click on this button to bring up the Ab Initio 
Options dialog box, which contains the basic 
options for executing an ab initio calculation.

Advanced 
Options...

Click on this button to bring up the Ab Initio 
Advanced Options dialog box, which contains 
options affecting the performance of ab initio cal-
culations.

Apply Basis 
Set...

Click on this button to apply the current basis set 
selection to the current selection of atoms (if any) 
or to all the atoms in HyperChem.

OK Click on this button to save the current settings, 
apply the basis set selection, and close this dialog 
box.

Cancel Click on this button to close this dialog box with-
out saving the current setting or applying the cur-
rent basis set selection.

You can apply different basis sets to different parts of a molecular 
system. HyperChem can use different basis sets for different atoms.

Assign Other Basis Set Dialog Box

Use this dialog box to get a full list of basis sets, except for the basis 
sets explicitly specified in the Ab Initio Method dialog box. You 
can click on any one of these basis sets to select one. HyperChem 
will bring your selection of basis set to the text box in the Ab Initio 
Method dialog box, when you click on the OK button.
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HyperChem lists all the basis sets in this dialog box, except for the 
basis sets already listed in the Ab Initio Method dialog box. These 
basis sets can be one of the standard basis sets or your own basis 
set saved in a file ending with .BAS. To have your own basis set 
appear in this dialog box, an entry must be made for it in the 
[basisset] section of the Registry or the CHEM.INI file.

Ab Initio Options Dialog Box

Use this dialog box to choose the basic options for executing ab 
initio calculations. The basic options are similar to the basic 
options in the Semi-empirical Option dialog box.

“Gradient” specifies the calculation of gradients (the first deriva-
tives of the total energy with respect to the nuclear positions). The 
RMS gradient gives an indication of the deviation from an opti-
mized structure. The computations of two-electron integrals and 
their derivatives are time-consuming, because of the huge number 
of the two-electron integrals even for a medium size of molecule. 
You may not be interested in gradients for single point calcula-
tions, so you can turn off (not check) gradient calculation to speed 
up your task. This option applies to single point calculations only. 
HyperGauss always computes the gradients during geometry opti-
mization, molecular dynamics, and vibration calculations.

“MP2 Correlation Energy” specifies the calculation of electron cor-
relation energy using the Møller-Plesset second order perturbation 
theory (MP2). This option can only be applied to Single Point cal-
culations. MP2 correlation energy calculations may increase the 
computational time because a two-electron integral transforma-
tion from atomic orbitals (AOs) to molecular orbitals (MOs) is 
required. HyperChem may also need additional main memory 
and/or extra disk space to store the two-electron integrals of the 
MOs.
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This dialog box has the following components:

Charge and 
spin

Use this area to specify the net charge on the cur-
rent molecular system and whether the system is a 
singlet, doublet, etc.

Total charge This is the net excess of nuclear charge 
over the electronic charge. It is zero for a 
neutral system, a positive integer for a 
cation, and a negative integer for an anion.

Spin 
multiplicity

This lists the electronic spin multiplicity 
that will be used for the current molecular 
system. A closed-shell system has a spin 
multiplicity of 1 (singlet). An open-shell 
system can have a multiplicity of 2, 3, 4 
(doublet, triplet, quartet), or higher. Use 
integers from 1 to 4.

SCF controls This section is used to specify the desired accuracy 
for the SCF wave function, and the maximum 
number of iterations that are allowed for reaching 
that accuracy.

Convergence 
limit

An SCF calculation ends when the 
difference in energy between any two 
consecutive iterations is less than this 
amount, in kcal/mol. The default value is 
0.00001. The practical range is 1 to 10-8. 
The calculation might not reach values less 
than 10-10 because of round-off errors. It is 
better to use relatively small values for 
transition state searches (see page 263).
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Iteration limit This sets the maximum number of 
iterations for an SCF calculation. The 
calculation ends after this number of 
iterations, even if it has not reached the 
Convergence limit. The results may not be 
correct if the calculation was far from con-
vergence or the energy of the system is 
oscillating. The default of 50 should be cor-
rect for most cases, though larger values 
may be appropriate for transition state 
searches (see page 263). The practical range 
is 50 to 200. If the calculation exceeds the 
default iteration limit before it reaches the 
convergence limit, then most likely there 
is a convergence failure; simply increasing 
this limit is unlikely to help. The conver-
gence accelerator (below) may help in 
some cases.

Accelerate 
convergence

With this box checked (✓), HyperGauss 
will apply the Direct Inversion of Iterative 
Subspace (DIIS) procedure to speed up the 
SCF calculation at the expense of requiring 
much more memory. This option may 
increase the computational time for indi-
vidual iterations because the Fock matrix 
has to be calculated as a linear combina-
tion of the current Fock matrix and Fock 
matrices from previous iterations. It is 
likely to decrease the actual number of iter-
ations required.

Single Point 
only

Specifies whether or not the calculation of gradient 
and MP2 correlation energy are required. These 
options are only used in Single Point calculations 
and ignored in any other type of computations.

Gradient Check this box (✓) to compute the gradi-
ent (the first derivatives of the total energy 
with respect to the nuclear positions).

MP2 
correlation 
energy

Check this box (✓) to compute the correla-
tion energy by second order perturbation 
methods (MP2).
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Spin pairing This sets the method for calculating spin interac-
tions, of which there are two:

UHF The Unrestricted Hartree-Fock method 
provides separate spatial orbitals (alpha 
and beta) for electrons with each type of 
spin. This method is useful for both open- 
and closed-shell systems. For closed-shell 
systems, it can be useful for studying disso-
ciation of molecular systems. A UHF calcu-
lation takes longer than an RHF calcula-
tion. ROHF (spin Restricted Open-shell 
Hartree-Fock) is not supported in the cur-
rent version of HyperChem for ab initio cal-
culations. Use UHF for open-shell doublets 
and triplets.

RHF The spin-Restricted Hartree-Fock method 
requires that spin-paired electrons reside in 
each occupied spatial orbital. One would 
normally use RHF for closed-shell singlets.

CI... Click on this button to bring up the Configuration 
Interaction dialog box.

OK Accept any changes made and close the dialog box.

Cancel Close the dialog box without accepting any 
changes made.

Note: HyperChem doesn't support the spin Restricted Open-shell 
Hartree-Fock (ROHF) methods when using ab initio methods.

Ab Initio Advanced Options Dialog Box

You can use the advanced options dialog box to tune the perfor-
mance of your ab initio calculations.

“Regular Integral Format” specifies the use of a “regular” format 
for saving the two-electron integrals. HyperChem uses 16 bytes to 
store every integral. The first 8 bytes store the four indices of an 
integral and the second 8 bytes store its value. HyperChem only 
stores an integral and its associated indices when the integral’s 
absolute value is greater than or equal to the two-electron integral 
cutoff. The two-electron integral and its indices are stored without 
any modification when you choose this regular two-electron 
integral format. These two-electron integrals and their indices can 
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be printed out to a log file by choosing a proper setting for 
QuantumPrintLevel in the Start Log dialog box.

“Raffenetti Integral Format” specifies the use of the Raffenetti two-
electron integral format [R.C. Raffenetti, Chem. Phys. Letters, 20, 
335 (1973)]. HyperChem can calculate all two-electron integrals 
and store them in a special form that makes it easier to generate a 
Fock matrix during the SCF iterations. The Raffenetti two-electron 
integral format may take more main memory or disk space for the 
two-electron integrals, particularly in a UHF calculation, but may 
still be faster than the regular two-electron integral format for the 
same calculation. The Raffenetti format is not available when per-
forming MP2 calculations.

This dialog box contains the following components:

Two-electron 
integral con-
trol

Controls the two-electron integral calculation and 
storage.

Cutoff Keep only the two-electron integrals with 
an absolute value greater than or equal to 
this value. The default value is 10-10 Har-
tree. This option controls the performance 
of the SCF iterations and the accuracy of 
the wave function and energies since it can 
decrease the number of calculated two-
electron integrals.

Buffer size Gives the size of computer main memory 
in double-precision words (8 bytes for each 
double precision word) for storing the two-
electron integrals prior to saving them to 
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the hard drive. Once this buffer is full, 
these two-electron integrals are written to 
a temporary file on a disk (the selected disk 
can be set in the File/Preferences/Path prop-
erty sheet). A large buffer may reduce the 
processing time through fewer disk 
accesses. If the two-electron integral buffer 
size is big enough to hold all the integrals, 
HyperChem does not use the disk.

Note: If an ab initio calculation is stopped before 
completion by a power failure or other abnormal 
termination, these temporary files will not be 
deleted automatically. In this case you must man-
ually delete the files to release the disk space. (The 
files are deleted automatically when a calculation 
ends, or is cancelled normally.) The files are stored 
in the directory specified in the Preferences/Paths 
dialog box.

Integral
format

Specifies the format to store the two-elec-
tron integrals.

Regular Store the two-electron integrals 
and their indices in their original 
format.

Raffenetti Store the two-electron integrals 
and indices in the Raffenetti for-
mat to speed up the formation of 
Fock matrix.

Direct SCF 
calculation

Check this box (✓) to use a direct SCF 
calculation. The two-electron integrals are 
computed in each iteration, rather than 
computed and stored on a hard drive prior 
to the SCF calculation. This calculation 
will be considerably slower than a regular 
SCF calculation, but avoids using disk 
space or a large amount of main memory. 
This option may be practical for large 
molecular systems run on a computer 
which has little available space on the disk.

Ghost-atoms 
control

Controls the use of a “ghost-atoms” selection.
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Use “ghost-
atoms” 
selection

Check this box (✓) to use a “ghost-atoms” 
selection. This option is available only 
when a named “ghost-atoms” selection is 
present in HyperChem.

MO initial 
guess

Specifies an initial guess for the MO coefficients.

Core 
Hamiltonian

Choose this radio button to use the MO 
coefficients obtained from diagonalizing 
the core Hamiltonian.

Projected 
Hückel

Choose this radio button to use the pro-
jected MO coefficients generated by the 
Hückel method.

Projected 
CNDO

Choose this radio button to use the pro-
jected MO coefficients generated by a 
CNDO calculation.

Projected 
INDO

Choose this radio button to use the pro-
jected MO coefficients generated by an 
INDO calculation.

Number of d 
orbitals

Specifies using Cartesian Gaussians (6) or Hermite 
Gaussians (5).

Five Choose this box to use Hermite Gaussians, 
which consist of five d orbitals, i.e., d0, d+1, 
d-1, d+2, and d-2.

Six Choose this box to use Cartesian Gauss-
ians, which consist of six d orbitals, i.e., 
dxx, dyy, dzz, dxy, dxz, and dyz.

OK Accept the changes made and close the dialog box.

Cancel Close the dialog box without accepting the 
changes made.

Initial Guess of MO Coefficients

An initial guess at the molecular orbital coefficients is necessary for 
an SCF calculation. Usually, the initial guess is obtained by solving 
the Hartree-Fock-Roothaan equations with the replacement of the 
Fock matrix by the core Hamiltonian. This initial guess of the MO 
coefficients is usually acceptable. However, in some cases, the core 
Hamiltonian leads to incorrect occupied orbitals or the initial 
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guess may be far from the final converged SCF MO coefficients. 
Hence, HyperChem supports a few alternative methods for gener-
ating an initial guess at the MO coefficients. These alternative 
methods are:

• Projected Hückel: the initial guess at the MO coefficients is 
obtained from an extended Hückel calculation;

• Projected CNDO: the initial guess at the MO coefficients is 
obtained from a CNDO calculation;

• Projected INDO: the initial guess at the MO coefficients is 
obtained from an INDO calculation.

However, these alternative methods can be only applied to certain 
elements. For example, the projected CNDO/INDO may be used 
only for molecular systems with atomic numbers less than or equal 
to 18 (Ar). Elements beyond 18 are not available in the projected 
CNDO/INDO initial guess.

Number of d Orbitals

There are two different sets of d-type functions (d orbitals) used in 
ab initio calculations. One 3d set consists of five 3d functions — 
3d0, 3d+1, 3d-1, 3d+2, and 3d-2, and is normally used in STO-NG 
basis sets. The other is a set of six 3d functions — 3dxx, 3dyy, 3dzz, 
3dxy, 3dxz, and 3dyz, and is used in the split-valence basis sets, such 
as, 3-21G, 4-31G, 6-31G, etc.

The contraction exponents and coefficients of the d-type func-
tions were optimized using five d-primitives (the first set of d-type 
functions) for the STO-NG basis sets and six d-primitives (the sec-
ond set of d-type functions) for the split-valence basis sets. Thus, 
five d orbitals are recommended for the STO-NG basis sets and six 
d orbitals for the split-valence basis sets.

Ghost-Atoms

With HyperChem you can always name a selection of atoms using 
the Name Selection item of the Select menu. A named selection 
called “ghost-atoms” has a special meaning, however. In most sit-
uations any atom that is a “ghost” atom, (i.e., is a member of the 
ghost-atom set) is treated just like any other atom and the named 
selection “ghost-atoms” is treated like any other named selection. 
However, HyperChem may treat the ghost atoms differently from 
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the regular atoms when performing certain ab initio calculations. 
If you have specified the use of “ghost-atoms” in the Ab Initio 
Advanced Options dialog box, then a ghost atom is represented in 
ab initio calculations by its basis set only and does not have any 
nucleus or electrons associated with it. Since there are atomic 
orbitals (basis functions) belonging to a ghost atom, there will be 
Mulliken charges attached to the ghost atoms after performing an 
ab initio calculation.

The concept of “ghost-atoms” only applies to Single Point calcula-
tions in the current version of HyperChem.

A major use of ghost atoms is to be able to offset the effect of basis 
set superposition effects (BSSE). For example, as two monomers 
come together the basis set of one monomer extends the basis set 
of the other, lowering the dimer energy more than just from the 
physical monomer-monomer interaction. A way to offset this in 
computing the dimerization energy is to use the same basis set in 
both monomer and dimer calculations. That is, the monomer 
energy is the energy of the dimer with ghost-atoms for the atoms 
of one of the monomers and “real” atoms for the other monomer.

Configuration Interaction

Use Configuration Interaction to predict the electronic spectra of 
molecules. The Configuration Interaction wave function com-
putes a ground state plus low lying excited states. You can obtain 
electronic absorption frequencies from the differences between 
the energy of the ground state and the excited states.

A configuration interaction calculation is available only for single 
points when the reference ground state is obtained from an RHF 
calculation.

The calculation mixes all single determinant wavefunctions that 
can be obtained from the ground state by exciting electrons from 
a subset of the occupied orbitals (of the ground state) to a subset of 
the unoccupied orbitals.   The subsets are specified as a fixed num-
ber (highest occupied or lowest unoccupied) or by an energy crite-
rion associated with the energy difference between the occupied 
orbital and the unoccupied orbital. 

Configuration Interaction Dialog Box

This dialog box can be used to invoke CI calculations in order to 
obtain an electronic spectrum. For details, please see the informa-
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tion about the same box as used in semi-empirical calculations, on 
page 200. You cannot use an ab initio method with the CI option 
turned on for geometry optimizations, molecular dynamics simu-
lations, or vibrational calculations, in the current version of 
HyperChem.

Extra Basis Function Dialog Box

This dialog box offers an easy way to modify an existing basis set 
by adding extra basis functions to atoms. You may want to add a 
polarization function to hydrogen or diffuse functions to heavy 
atoms. An alternative way to add extra basis functions to the exist-
ing basis sets is to edit an existing basis set file, make your own 
changes, and create a new basis set.

One and only one extra shell (of type S, P, D, SP, or SPD) can be 
applied to any atom in the current version of HyperChem. Differ-
ent extra shells can be applied to different atoms but any atom can 
receive only one extra shell. If you would like to add more than 
one extra shell to any atom, you will need to modify a basis set file 
and create a new basis set. To use this new basis set you will need 
to include it in the [basisset] section of the Registry or the 
CHEM.INI file.

A basis set for an atom thus consists of a standard basis set (3-21G, 
for example) and an optional extra shell.

This dialog box contains the following items:

Shell type Specifies the type of shell to be added to the 
selected atoms (if any) or to the whole molecular 
system.
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None Choose None if you do not want to add 
extra basis function(s) to the atoms.

S Add an extra basis function associated with 
an S-type shell to the selected atoms.

P Add extra basis functions associated with a 
P-type shell to the selected atoms.

D Add extra basis functions associated with a 
D-type shell to the selected atoms.

SP Add extra basis functions associated with 
an SP-type shell to the selected atoms.

SPD Add extra basis functions associated with 
an SPD-type shell to the selected atoms.

Exponent Give the exponent for the selected type of 
Gaussian function (shell).

OK Accept the changes made and close the dialog box.

Cancel Close the dialog box without accepting the 
changes made.

Mixed Mode Calculations

You can perform quantum mechanical calculations on a part of a 
molecular system, such as a solute, while using molecular mechan-
ics for the rest of the system, such as the solvent surrounding the 
solute. This boundary technique is available in HyperChem for all 
quantum mechanical methods. It is somewhat less complete with 
ab initio calculations than with semi-empirical calculations, how-
ever. With ab initio calculations the boundary must occur between 
molecules rather than inside a molecule.

Choose the region (single or multiple molecules) of interest for an 
ab initio calculation from the total molecular system. HyperChem 
performs the ab initio calculation for the selected region using the 
perturbation of an electrostatic potential arising from the net 
charges on the atoms of the unselected part. (For further details of 
this electrostatic potential perturbation implemented in Hyper-
Chem, please see the Computational Chemistry manual.)

The algorithms of the mixed classical-quantum model used in 
HyperChem are different for semi-empirical and ab initio methods. 
The semi-empirical methods in HyperChem treat boundary atoms 
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(atoms that are used to terminate a subset quantum mechanical 
region inside a single molecule) as specially parameterized pseudo-
fluorine atoms. However, HyperChem will not carry on mixed 
model calculations, using ab initio quantum mechanical methods, 
if there are any boundary atoms in the molecular system. Thus, if 
you would like to compute a wavefunction for only a portion of a 
molecular system using ab initio methods, you must select single 
or multiple isolated molecules as your selected quantum mechan-
ical region, without any boundary atoms.

Semi-empirical methods could thus treat the receptor portion 
of a single protein molecule as a quantum mechanical region 
but ab initio methods cannot. However, both semi-empirical 
and ab initio methods could treat solvents as a perturbation on 
a quantum mechanical solute. In the future, HyperChem may 
have an algorithm for correctly treating the boundary between 
a classical region and an ab initio quantum mechanical region 
in the same molecule. For the time being it does not.

Periodic Box 

This item places the molecular system in a periodic box containing 
water molecules. 

A periodic box imposes periodic boundary conditions on calcula-
tions. Periodic boundary conditions provide identical molecular 
systems (virtual images), identical to the one in the periodic box, 
surrounding the periodic box. For the purposes of calculations, 
molecules can move in a constant-density environment, similar to 
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being in a liquid. The box also prevents solvent molecules from 
diffusing away or evaporating during a simulation (for example, 
during a molecular dynamics calculation). 

Note: Periodic boundary conditions apply only for molecular 
mechanics calculations. The quantum mechanics calculation 
methods disregard the periodic effects.

Periodic Box adds to a molecular system TIP3P models of water 
molecules (Jorgenson et al., 1983, see page 430), equilibrated at 
300 K (25°C) and one atmosphere. Without a periodic box, 
HyperChem assumes that molecules are in a vacuum. 

Caution: Do not use the Model Builder (see “Converting 2D Draw-
ings into 3D Structures” on page 304) for the water molecules in a 
periodic box. The Model Builder removes the conformational 
information that comes with these molecules.

Selecting a periodic box makes these changes to the molecular sys-
tem:

• First, HyperChem changes the orientation of the molecular 
system to align the inertial axes with a box that has one face 
parallel to the screen. HyperChem chooses the size and shape 
of the box to minimize the number of water molecules 
required. The standard size box is a cube 18.70 Ångstroms on 
a side. Boxes with dimensions 1, 2, or 3 times the standard box 
minimize bad contacts. HyperChem does not accept box 
dimensions larger than three times the standard box (56.10 
Ångstroms).

• HyperChem fills the box with water molecules. The number of 
water molecules depends on the size of the box that you 
choose. At the edges of the box, HyperChem places water mol-
ecules only if their oxygens fall within the box, and excludes 
water molecules from a specified distance of solute atoms.

• The solute molecules remain in their original conformation. 
The geometry of solvent molecules come from the database 
files of equilibrated TIP3P water molecules.

• HyperChem displays the new molecular system in a box. The 
periodic box appears 3D if you turn on Perspective View on the 
Display menu. You can remove or replace the appearance of 
this box, but not the boundary conditions, by choosing Show 
Periodic Box on the Display menu.
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When you choose Periodic Box, HyperChem shows you the Peri-
odic Box Options dialog box for setting the solvation conditions. 
You can choose the size of the box and the smallest distance 
between the solute and water molecules. 

Periodic Boundary Conditions

Periodic boundary conditions and solvation are separate features 
of HyperChem. After you set up a periodic box, you can select and 
remove the water molecules, but keep the boundary conditions 
and the periodic box. You can turn off established periodic bound-
ary conditions during a molecular dynamics calculation by choos-
ing In vacuo (see the next section). The water molecules remain in 
the molecular system.

HyperChem’s periodic boundary conditions provide a sharp, rect-
angular cutoff of the distance for calculating interactions between 
nonbonded atoms. An atom interacts only with one nearest image 
of other atoms and never with an image of itself. This sharp cutoff 
can cause discontinuities in the potential surface that interfere 
with geometry optimization and molecular dynamics calculations. 
To avoid this, HyperChem automatically changes the cutoff con-
dition to Switched (see “Force Field Options Dialog Box” on page 
188) for a molecular system in a periodic box. You can also choose 
Shifted cutoffs. These options gradually decrease nonbonded inter-
actions over a specified distance.

Periodic Box Options Dialog Box
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Smallest box
enclosing
solute

For information only. X, Y, and Z give the smallest 
box size, in Ångstroms, that can completely 
enclose the molecular system (solute). This mini-
mal-sized box cannot accommodate the appropri-
ate number of water molecules and is for reference 
only. 

Periodic box
size

These are the recommended dimensions, in Ång-
stroms, of the periodic box. HyperChem recom-
mends dimensions (X, Y, and Z) for a cube at least 
twice the largest dimension for Smallest box enclos-
ing solute, or the standard size box, whichever is 
greater. A standard size box is a cube 18.70 Ång-
stroms on a side. Boxes with dimensions 1, 2, or 3 
times the standard box minimize bad contacts. 
Larger boxes prevent the solute from interacting 
with its images, but require more computing time. 
Do not use box dimensions larger than three times 
the standard box (56.10 Å). HyperChem accepts 
noncubic dimensions.

Maximum 
number of 
water 
molecules

For information only. This reports the maximum 
number of water molecules that HyperChem can 
add. This number depends on the periodic box 
size. The actual number added is usually less than 
the maximum, because of the volume that the sol-
ute occupies.

Minimum
distance
between
solvent 
and solute
atoms

This is the minimum separation between water 
atoms and atoms already in the system to avoid 
bad contacts. The default is 2.3 Ångstroms. A dis-
tance larger than half the largest box dimension 
(shown for Smallest box enclosing solute) excludes 
all solvent molecules. HyperChem does not draw a 
periodic box but turns on periodic boundary con-
ditions. Practical range: 1–5 Ångstroms.

If you need a specific number of water molecules in the box, you 
can select water molecules and use Cut, Copy, and Paste on the Edit 
menu to change the number of molecules.

Changing periodic box size

HyperChem considers the entire system when the Setup/Periodic 
Box option is used. If you wish to change the size of an existing 
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periodic box it is usually best to remove any solvent water mole-
cules first.

To Remove solvent:

1. Choose molecule selection via Select/Molecules.

2. Select the solute molecule(s).

3. Use Select/Complement Selection to select the solvent.

4. Use Edit/Clear to delete the selected solvent.

You can hide or display the periodic box by choosing Show Periodic 
Box on the Display menu. The boundary conditions remain as part 
of the molecular system when you turn off the appearance of the 
box.

Removing the periodic box

To remove an existing periodic box from a molecular system, the 
easiest method is to open the Periodic Box dialog box, and then 
click on the Cancel button. Alternately, you can edit the HIN file 
containing the information for this molecular system (see “box” 
on page 519), deleting the record beginning with box. This will 
remove the box but not the solvent molecules; to delete the sol-
vent molecules, see the previous section.

Solvents other than water

Pre-defined files for periodic boxes of solvents other than water are 
not distributed with HyperChem, but creating your own solvent 
boxes is relatively straightforward. To find the number of solvent 
molecules appropriate for your box, you will need the box volume 
(length × width × height) and the molecular weight and density of 
your solvent. Then:

For example, for a periodic box 18.62 Å in each dimension, filled 
with water at 25°C, the density is 1.00 g/cm3 and the molecular 
weight is 18.02 g/mol. Substituting into the above, and including 
the conversion from Å to cm:

# molecules
volume density× Avogadro′s number×

molecular weight
------------------------------------------------------------------------------------------------=
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which matches the 216 water molecules found in the standard 
periodic box.

The solvent molecules should be oriented randomly in the box 
and the entire system equilibrated. You can do this by running 
Molecular Dynamics on the system. You can then add a solute 
molecule to the system; you will probably want to delete one or 
more solvent molecules to make space for it, as HyperChem does 
with its standard water boxes. An equilibrated box of solvent mol-
ecules can be saved as a file, and re-used as you wish.

Restraints 

Use this menu item to add harmonic restoring forces to atoms, 
interatomic distances, angles and torsion angles during a molecu-
lar mechanics or quantum-mechanical calculation. You must first 
set up the atoms that you want to restrain as named selections (see 
“Name Selection” on page 147). A named selection of one atom 
can be tethered to a point. Named selections of two, three or four 
atoms can be restrained to specific atomic separations, angles or 
torsions respectively.

Restraint Forces Dialog Box

Use this dialog box to restrain selected atomic geometries during a 
geometry optimization. These restraints apply to tethering (one 
atom), atomic distances (two atoms), angles (three atoms), and tor-
sion angles (four atoms).

In this dialog box, you must give the Restrained Value (length, 
angle, or torsion angle) for a restraint and a harmonic Force Con-
stant. To tether an atom, you must specify the value that you want 
the atom restrained to (Tether to).

HyperChem stores the restraints along with the molecular system 
in a HIN file.

# molecules

18.62Å( )3 1 cm

108Å
------------- 

 3
1.00 g/cm3×× 6.023 10× 23mol-1×

18.02 g/mol
--------------------------------------------------------------------------------------------------------------------------------------=

215.8=
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Caution: If you apply a Restraint to your system, then any energy 
calculations that you perform will include contributions from it 
that are not part of the force field. To get an accurate calculation 
of the energy of your system, your should remove all applied 
restraints and calculate a single-point energy. You can do this with 
a structure that was optimized with restraints, to determine the 
energy of the system in its current configuration.

Selections Lists the named selections for the molecular sys-
tem in the workspace. The selections that appear 
here include only 1, 2, 3, or 4 atom selections. The 
selection names have a prefix that shows the num-
ber of atoms in the selection. For example, 4-tor-
sion means that the named selection, torsion, con-
tains four atoms.

Restraints Lists the named selections that you chose from the 
Selections list. These provide restraints during a 
molecular mechanics or semi-empirical (except 
Extended Hückel) calculation.

Add Moves highlighted name from the Selections list to 
the Restraints list.

Remove Removes highlighted name from the Restraints list 
to the Selections list.
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Restrained
Value

Shows the restrained value for the named distance, 
angle or torsion selection highlighted in the 
Restraints list.

Computed Uses the current value for the selected 
atoms and shows this value in the text box 
below. 

Other Enter a value for Length (in Ångstroms), 
Angle, or Torsion (in degrees). The value 
should be greater than zero for Length.

Tether to Shows the location that the named selection (one 
atom) highlighted in the Restraints list will be teth-
ered to.

POINT Active only if you have defined a named 
selection called POINT (see page 147). 
Select this to tether the named atom to the 
Cartesian coordinates of the center of mass 
of the atoms used to define POINT. When 
selected, the Cartesian coordinates of 
POINT are shown in the X, Y and Z text 
boxes.

Computed Uses the current Cartesian coordinates for 
the named atom and shows the coordi-
nates in the X, Y and Z text boxes. 

Other Enter the Cartesian coordinates for the 
location that you want to tether the named 
atom to.

Force
Constant

This constant regulates the strength of the 
restraint. Larger values give a stronger restraint. 
The Default values are appropriate for molecular 
dynamics calculations. Much larger values (for 
example, 105) are appropriate for geometry opti-
mization, but these values might require more 
optimization cycles.

Default The defaults are Length, 7 kcal mol–1Å–2; 
Angle, 125 kcal mol–1degree–2; and 
Torsion, 16 kcal mol–1degree–2.

Other Enter a number for the force constant.
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Setting Up Restraints

To set up restraints for a molecular mechanics calculation:

1. Turn on Multiple Selections on the Select menu.

2. With the Selection tool, select 1, 2, 3, or 4 atoms that define an 
atom, length, angle, or torsion angle that you want to restrain

3. Choose Name Selection on the Select menu. Enter a name for 
the selected atom(s).

4. Repeat steps 2 and 3 as needed.

5. Choose Restraints on the Setup menu. The Restraint Forces dia-
log box appears.

6. Choose your restraints (see the next section).

7. L-click on OK.

Applying Restraints

To use selections for restraints:

• Choosing a name: L-click on a name (for example, 
2-Distance1). HyperChem highlights the name, indicating an 
active choice. 

• Canceling a choice: L-click on a highlighted name.

• Moving a choice to the Restraints list: L-click on Add. Active 
choices (highlighted) in the Selections list move to the 
Restraints list. 

• Moving a choice to the Selections list: L-click on Remove. 
Active choices in the Restraints list (highlighted) move to the 
Selections list.

“Dummy atoms” and Conformational Restraint

You can apply Restraints to atoms that are not connected to a struc-
ture. If an atom does not interact with a structure apart from 
applied restraint forces, you can use it as a “dummy” atom or 
pseudo-atom to force a structure to maintain a particular confor-
mation. For example, an uncharged unbonded atom whose van 
der Waals ε parameter has been set to 0 has no interaction with 
other atoms in a molecular mechanics calculation; a “lone pair” 
atom does not interact in a semi-empirical or ab initio calculation. 
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You could, for example, add a “lone pair” near the middle of a ben-
zene ring, and restrain several C–lone-pair–C angles to be 120°. 
This forces the lone pair to stay at the center of the ring. Then you 
can add restraints involving a ring atom, the lone pair, and other 
atoms, to control the orientation of the benzene ring.

For a five-membered ring (see right), one 
might restrain angles 1–x–3 and 1–x–4 to 
144° and angle 3–x–4 to 72°. When the 
dummy atom x is in the proper location, 
there are no net forces acting on the ring 
atoms, so the ring is not distorted. One could 
then restrain the distance x–M, or one of the 
angles 1–x–M or x–M–L, or the torsion angle 
1–x–M–L.

Set Velocity . . .

Use Set Velocity to specify the velocities of the selected atoms (or 
all atoms, if none are selected).

Set Velocity Dialog Box
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Present
Values

Shows the current average vector (magnitude and 
direction cosines) of the selected atoms

Direction Input the desired direction to be set for the selec-
tion

At POINT Sets the direction of motion towards the 
selection named POINT

Along LINE Sets the direction of motion along the vec-
tor of the selection named LINE

Relative 
Components

Sets the direction of motion as specified by 
the relative x, y, and z components

Magnitude Input the desired magnitude of the velocity vector.

Network . . .

Use Network to specify a remote server to perform molecular 
mechanics and quantum mechanical calculations.

Network Options Dialog Box

Compute on 
host 
workstation

Calculations are performed on the local worksta-
tion.

Networked 
Unix Host

Calculations are performed on a remote server.

Host name Enter the server name.

Userid Enter your login id on the remote server.

Password Enter your login password on the remote server. 
(What you type will not be displayed.)
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Number of 
Processes

Number of parallel processes to run. Ignored in the 
current version of HyperChem, which will use ‘1’ 
regardless of the value entered.

Select Parameter Set

Use Select Parameter Set to choose a set of constants (parameter set) 
for a chosen force field. You see a Force Field Parameters dialog box 
with a list of choices. Force Field can be MM+, AMBER, BIO+, or 
OPLS, depending on your choice in the Molecular Mechanics 
Force Field dialog box (see page 185). 

A “parameter set” is a set of files that includes information about 
bond lengths and angles, torsional angles, and electrostatic inter-
actions. The exact contents are different for each force field (see 
page 471). A force field can have more than one parameter set.

You receive HyperChem with several standard sets of parameter 
files. These are text or database files with .txt or .dbf extensions (see 
“Parameter Files” on page 470). HyperChem uses compiled, binary 
versions of these standard parameter files (see page 231), with the 
extension .par. Each PAR file, for example amber2.par, includes all 
information from the parameter files amber*.txt or amber*.dbf.

Before you use a new or modified parameter set for a molecular 
mechanics calculation, choose Compile Parameter File on the Setup 
menu (see “Compile Parameter File” later). This converts the 
parameter files to one binary PAR file.

Note: The Registry or the chem.ini file lists files for each force field 
that make up a parameter set. The parameter files are in the direc-
tory specified by the ChemParmPath setting in the File/Prefer-
ences/Path property sheet.

To modify existing parameter files or to set up alternate parameter 
files, see “Force Field Parameters” on page 469.
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Force field Parameters Dialog Box

L-click on the parameter set that you want to use for a force field.

Compile Parameter File

Compile Parameter File combines and converts a set of parameter 
files (chosen with Select Parameter Set, described in the previous 
section) to one binary file (with the extension .par) that Hyper-
Chem needs for molecular mechanics calculations. The Registry or 
the chem.ini file (see page 541) lists the parameter sets available to 
compile into PAR files and specifies the use of text or dBase®-type 
files.

Each force field uses a different PAR file. For each force field, you 
can have more than one PAR file to choose from. Use Select Param-
eter Set (see the previous section) to choose a PAR file. The uncom-
piled parameter files used for each PAR file (or parameter set) are 
defined by settings in the Registry or in chem.ini.

Uncompiled parameter files can be either text files (.txt) or dBase 
type files (.dbf). You can create or modify these files with either a 
text editor (like Windows Notepad, for TXT files) or a database pro-
gram (like dBase, for DBF files). For more information about 
uncompiled parameter files, see “Force Field Parameters” on 
page 469.

Reaction Map . . .

After you have defined the named selections REACTANT and 
PRODUCT (see “Name Selection” on page 147), you can use this 
dialog box to set up a starting point for a Synchronous Transit 
transition state search (see “Transition State” on page 263). The 
menu item is gray and unavailable unless both REACTANT and 
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PRODUCT have been defined and contain the same numbers of 
atoms. If REACTANT and PRODUCT do not contain the same 
numbers of the same kinds of atoms, you will not be able to map 
all the atoms, and you will have to exit this dialog box with Cancel.

Important: For good results in a Synchronous Transit transition 
state search, both the reactants and products should be minimized 
(separately) to give local minima before the reaction mapping is 
done. One good procedure for doing this is to set up the reactant 
state, minimize it, and save it as a file; then rearrange the atoms to 
the product state, and minimize again; then use Merge (see 
page 56) to add the reactant state back to the workspace.

Lambda This value describes the position of the initial 
guess of the transition state along the reaction 
coordinate between the reactant configuration and 
the product configuration. Lambda must be 
between 0 (the reactant state) and 1 (the product 
state).

Note: For symmetrical transition states, a lambda 
value of 0.5 may give poor results because the 
search algorithm looks for an optimal saddle point 
in the potential energy surface, but the perfectly 
symmetrical starting point for the search is already 
close to a saddle point. For such symmetrical tran-
232 Chapter 7



Setup Menu
sition states, a lambda value of 0.49 or 0.51 will 
probably give better results.

Reactant This list box shows the atoms of the Reactant 
named selection that have not yet been matched 
with corresponding Product atoms. When you 
select one of the Reactant atoms from this list, it is 
selected in the workspace as a visual aid. Atoms are 
listed as (molecule number, atom number, ele-
ment).

Product This list box shows the atoms of the Product 
named selection that have not yet been matched 
with corresponding Reactant atoms. When you 
select one of the Product atoms from this list, it is 
selected in the workspace as a visual aid. Atoms are 
listed as (molecule number, atom number, ele-
ment).

Map This list box shows the currently-defined pairs of 
reactant and product atoms. In principle, as the 
configuration of atoms changes from the Reactant 
state to the Product state, each reactant atom 
“becomes” the corresponding product atom.

Add This button becomes active when an atom has 
been selected from the Reactant list box and an 
atom has been selected from the Product list box, 
and they are both the same element. It allows you 
to move the selected atoms as a matched set to the 
Map list box.

Remove This button becomes active when you select a reac-
tant/product atom pair in the Map list box. It 
allows you to unpair the atoms, and returns them 
to the Reactant and Product list boxes.

OK This button becomes active only when all of the 
reactant and product atoms have been mapped — 
that is, when the Reactant and Product list boxes 
are empty and all of the atoms are in the Map list 
box. It sets up the atom pairs for use in the Syn-
chronous Transit transition state search. The Prod-
uct atoms are deleted (along with any information 
attached to them, such as named selections and 
charges) and the Reactant atoms are repositioned 
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according to the coordinates from the interpola-
tion between the two sets.

Cancel This aborts the mapping procedure and returns 
you to the HyperChem window. All mapping 
information will be lost; if you open the Reaction 
Map dialog box again, all of the atoms will have 
been returned to the Reactant and Product list 
boxes.
234 Chapter 7



Compute Menu
Compute Menu

The Compute menu directs chemical calculations using the molec-
ular system in the workspace and the method you choose on the 
Setup menu. You can use the MM+, AMBER, BIO+, and OPLS force 
fields and the various semi-empirical and ab initio quantum 
mechanical methods for calculations. 

Using your choice of calculation method in the Setup menu, 
HyperChem automatically carries out a calculation. 

The Compute menu has these items:

Single Point Calculates the total energy and the root-mean-
square (RMS) gradient for selected atoms or, if there 
is no selection, for all atoms. For a semi-empirical 
calculation, Single Point also calculates wave func-
tions for the selected atoms

Geometry 
Optimization . . .a 

Calculates an optimum molecular structure (lowest 
energy and smallest RMS gradient) for selected 
atoms or, if there is no selection, for all atoms. Use 
either a molecular mechanics or semi-empirical or 
ab initio method

Molecular 
Dynamics . . .a 

Calculates the motion of selected atoms or all 
atoms in a molecular system, over picosecond time 
intervals. Demonstrates stable conformations, tran-
sition states, and thermodynamic properties. Use 
either a molecular mechanics or semi-empirical or 
ab initio  method. Can use periodic boundaries with 
explicit solvent molecules

Langevin 
Dynamics . . .

Calculates the motion of selected atoms or all 
atoms in a molecular system, over picosecond time 
intervals. Demonstrates stable conformations, tran-
sition states, and thermodynamic properties. Use 
either a molecular mechanics or semi-empirical or 
ab initio  method. Uses frictional effects to simulate 
the presence of a solvent
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Many chemical calculations are time-consuming. Once you start a 
calculation, you can stop it before completion by L-clicking on 
Cancel on the menu bar or by pressing [Esc]. 

Important: You can store atomic charge information from a calcu-
lation by saving the molecular system in a HIN file. Use Save or 
Save As on the File menu. To store the energy or gradient values 
from a calculation, use the log file (see “Start Log . . .” on page 60). 

a. These items are gray and unavailable when you choose the Extended
Hückel method for a calculation or when CI is turned on.

b. This item is gray and unavailable until after you have performed a semi-
empirical or ab initio calculation on the current system.

Monte Carlo . . . Calculates ensemble averages for selected atoms or 
all atoms in a molecular system. Use either a molec-
ular mechanics or semi-empirical or ab initio  
method

Vibrations Calculates the vibrational motions of selected atoms 
or all atoms in a molecular system. Use an ab initio 
or semi-empirical method other than Extended 
Hückel

Transition 
State . . .

Searches for transition states for the current system, 
or for a set of reactant and product atoms that have 
been defined with Setup/Reaction Map. Use an ab 
initio or semi-empirical method other than 
Extended Hückel

Plot Molecular 
Properties . . .

Use this to choose to display the electrostatic poten-
tial, total spin density, or total charge density after a 
semi-empirical or ab initio calculationb

Orbitals . . . Use this to choose to display orbitals and their 
energy levels after a semi-empirical or ab initio cal-
culationb

Vibrational 
Spectrum . . .

Use this to analyze and display the vibrational fre-
quencies and normal modes calculated by a Vibra-
tions calculation

Electronic 
Spectrum . . .

Use this to analyze and display the ultraviolet-visible 
spectra calculated from a Single Point calculation 
using singly-excited configuration interaction.
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The QuantumPrintLevel and MechanicsPrintLevel settings in the 
Start Log dialog box affect the amount of information stored in the 
log file. To save results from quantum calculations, use File/Export. 
You can also record an image of the molecular system by choosing 
Print on the File menu or Setup Image in File/Preferences, and then 
choosing Copy Image on the Edit menu.

Warning Messages

When HyperChem begins a calculation using a molecular 
mechanics force field and cannot find appropriate parameters (see 
“Parameter Files” on page 470) for the molecular system, it shows 
warning messages in a dialog box that tell you the type of force 
constant that is missing and the atoms involved. You have these 
choices:

Abort Stops the calculation.

Continue Accepts the warning and proceeds to the next 
warning message or begins the calculation. With 
the MM+ force field, HyperChem attempts to sup-
ply force constants using two methods. Warning 
messages show you the progress of this process. 
With other force fields, HyperChem proceeds to 
the calculation after assigning force constants of 
0.0. These warning messages go to a log file, if 
active.

Ignore HyperChem begins the calculation without show-
ing you additional warning messages. A calcula-
tion either assigns default force constants (for 
MM+) or no force constants (for other force fields). 
Warning messages go to a log file, if active. 

You can eliminate these warnings or send them 
only to a log file by setting WarningType in the 
Registry or in chem.ini (see page 555).

Single Point 

A single point calculation determines the total energy and RMS 
gradient of a molecular system or of selected atoms. With a semi-
empirical or ab initio method, Single Point also calculates the elec-
tron and charge distribution in the system. Single point means the 
calculation is for the present molecular conformation, a single 
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point on the potential energy surface for the molecular system. At 
the end of a calculation, HyperChem reports values for Energy and 
Gradient on the status line:

Energy The total energy (in kcal/mol). 

Gradient The RMS value of all forces on all atoms. The gra-
dient, or force, is the rate of change (first deriva-
tive) of the total energy with respect to displace-
ment in the x, y, or z direction. Since the forces are 
a derivative of energy with respect to atomic posi-
tion, the units are kcal/mol/Ångstrom. A value 
close to zero indicates a molecular system close to 
a conformation with a minimal energy. This mini-
mum is usually one of several possible low energy 
conformations (local minima) and not necessarily 
the lowest possible state (global minimum).

Caution: Since each calculation method uses different assump-
tions, you should compare numerical results from the same 
method only.

Caution: If you apply a Restraint to your system, then any energy 
calculations that you perform will include contributions from it 
that are not part of the force field. To get an accurate calculation 
of the energy of your system, your should remove all applied 
restraints and calculate a single-point energy.

Using a Molecular Mechanics Method

If you are doing a molecular mechanics calculation on a selected 
set of atoms in a molecular system, HyperChem calculates the 
interactions between the selected atoms, between selected atoms 
and the set of unselected atoms, but not among the unselected 
atoms.

To use a molecular mechanics method:

1. Select the atoms you want to include in the calculation, or 
deselect all atoms to compute the energy of the whole molec-
ular system.

2. Optionally you can choose Types in the Labels dialog box (see 
page 177) to be certain that each atom has an atom type.

3. Choose Molecular Mechanics on the Setup menu.
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4. From the Molecular Mechanics Force Field dialog box, choose 
a force field. L-click on Options to change the way the force 
field works. See page 185.

5. Choose Single Point on the Compute menu.

Using a Semi-empirical or Ab Initio Method

If you are using a quantum-mechanical method for the single 
point calculation, HyperChem determines the distribution of elec-
trons along with the energy and gradient values. You can plot 
these results on top of the molecular system in the workspace 
using the Contour Plot menu item. You can inspect the individual 
molecular orbitals using the Orbitals menu item, including display 
of orbital isosurfaces.

If you want a single point calculation for a selected part of a mol-
ecule and you are using a semi-empirical method, first use Extend 
to sp3 on the Select menu. This option selects additional atoms, in 
all directions, until it reaches sp3–sp3 single bonds or singly 
bonded atoms (see page 152). HyperChem incorporates the effects 
of all unselected atoms (their charges) into an electrostatic poten-
tial and uses this (as an electric field effect) in the calculation (see 
“Mixed Mode Calculations” on page 203). Ab initio calculations 
can work only on complete molecules, though you can select one 
or more molecules from the workspace and omit others from the 
calculations.

To perform a single point calculation:

1. Select atoms for the computation, or deselect all atoms for the 
whole molecular system.

2. Choose Semi-empirical or Ab Initio on the Setup menu.

3. From the Semi-empirical Method or Ab Initio Method dialog 
box, choose a method. L-click on Options to change the way 
the calculation method works.

4. Choose Single Point on the Compute menu.

Geometry Optimization 

Geometry Optimization calculates and displays a structure with a 
minimum energy and minimal atomic forces (Gradient). This is 
usually a local minimum. You can do this calculation for selected 
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atoms or, if there is no selection, for all atoms in a molecular sys-
tem. Use either a molecular mechanics or quantum-mechanical 
method.

If you select atoms from the molecular system, unselected atoms 
do not move (no geometry optimization), but the calculation uses 
the forces that unselected atoms exert on selected atoms. In a semi-
empirical calculation with selected atoms, HyperChem treats only 
selected atoms quantum mechanically (see “Extend to sp3” on 
page 152).

Note: To save the results of these calculations, choose Start Log on 
the File menu. You can also record an image of the molecular sys-
tem by choosing Print on the File menu or Setup Image from 
File/Preferences, then choosing Copy Image on the Edit menu.

For more information about this calculation and its applications, 
see HyperChem Computational Chemistry, Practical Guide.

To perform a geometry optimization calculation:

1. Select atoms for the computation, or deselect all atoms to opti-
mize the whole molecular system.

2. Choose Molecular Mechanics or Semi-empirical or Ab Initio on 
the Setup menu. Choose a calculation method from the dialog 
box that appears next.

3. Choose Geometry Optimization on the Compute menu.

4. Choose an algorithm in the Molecular Mechanics Optimiza-
tion dialog box. You can also choose Options for the calcula-
tion. L-click OK.

During a geometry optimization calculation, HyperChem shows 
you small adjustments to the molecules in the workspace. The sta-
tus line reports this information:

Energy The total energy (in kcal/mol) relative to the same 
atoms that are not interacting. 

Gradient The RMS value of forces on atoms. The gradient, or 
force, is the rate of change (first derivative) of the 
total energy with respect to displacement in the x, 
y, or z direction. Since the forces are a derivative of 
energy with respect to atomic position, the units 
are kcal/(mol⋅Ångstrom). A value close to zero indi-
cates a molecular system close to a conformation 
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with a minimal energy. This minimum is usually 
one of several possible low energy conformations 
(local minima) and not necessarily the lowest pos-
sible state (global minimum).

Converged HyperChem reports YES when the calculation 
reaches the gradient criterion you set in the Opti-
mization dialog box (see the next section) for 
reaching a minimum.

cycles The number of search directions (see the next sec-
tion) in reaching a minimum.

points The number of single point calculations (energy 
and gradient) performed while calculating a mini-
mum structure.

iter For a semi-empirical or ab initio calculation: The 
iteration number of the SCF calculation.

diff For a semi-empirical or ab initio calculation: The 
difference in energy (kcal/mol) between the results 
of the last two SCF cycles.

Molecular Mechanics/Semi-empirical/Ab Initio 
Optimization Dialog Box

You see this dialog box if you choose Geometry Optimization on the 
Compute menu. The title bar contains Molecular Mechanics Opti-
mization or Semi-empirical Optimization or Ab Initio Optimization, 
depending on the calculation method you are using (see page 185, 
page 190, and page 204).
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Algorithm HyperChem uses these algorithms to calculate, for 
the molecular system or for selected atoms, a 
geometry with a minimum potential energy. These 
methods attempt to lower the energy of a molecu-
lar system by adjusting its geometry.

Steepest 
Descent

Moves directly down the steepest slope (of 
interatomic forces) on the potential energy 
surface. If the energy of the molecular sys-
tem decreases, it continues in the same 
direction, but by a larger step (by an incre-
ment of 1.2 times larger). If the energy 
increases after a step, the rate of adjusting 
the geometry decreases: the next step size 
is half of the last step. 

This method makes limited changes to the 
molecular structure. It is useful for quickly 
correcting bad starting geometries or for 
removing bad contacts; it is most effective 
when the molecular system is far from a 
minimum. The calculation does not 
readily converge and can oscillate.

Fletcher-
Reeves

This is a conjugate gradient method, which 
means that it chooses a descent direction 
(to lower energy) by considering the 
current gradient, its conjugate (initially the 
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negative of the current gradient), and the 
gradient for the previous step. For each 
descent direction, a one-dimensional 
search attempts to locate a minimum. 
There are at least two evaluations (points) 
of the energy and gradient for each direc-
tion (cycle). To reduce cumulative errors in 
the calculation, when the number of direc-
tions is three times the number of atoms, 
this procedure resets the conjugate direc-
tion to the negative of the gradient. This 
method has super-linear convergence; it 
converges better than the Steepest descent 
method.

Polak-Ribiere This is a conjugate gradient method using 
one-dimensional searches (see above). It 
improves on the Fletcher-Reeves method 
by also considering the previous conjugate 
direction. This method does not require 
resetting the conjugate direction. It 
requires slightly more memory but tends 
to converge more quickly than the 
Fletcher-Reeves method.

Eigenvector-
Follow

Available for semi-empirical or ab initio 
optimizations; not available for molecular 
mechanics optimizations. It uses eigenvec-
tors from a diagonalized Hessian matrix 
(second derivatives of total energy with 
respect to atomic displacements) to deter-
mine the optimal directions for atomic 
motion. The initial guess is computed 
empirically.

Block
Diagonal
Newton-
Raphson

Available only for the MM+ force field. 
This is the only method offered that 
directly calculates second derivatives, or 
force constants. Second derivatives indi-
cate the curvature of the potential energy 
surface and can assist in locating minima. 
The method computes the second deriva-
tive matrix for one atom at a time, avoid-
ing second derivatives with respect to two 
atoms. It cycles through each atom until 
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the RMS gradient for all atoms is near zero. 
Where atoms are in an area of negative cur-
vature, the calculation uses a steepest-
descent step. This method is efficient in 
locating a minimum but requires a reason-
able starting geometry. The result some-
times oscillates because the calculation 
neglects coupling between atoms.

Termination
condition

Use these text boxes to set conditions for ending a 
calculation. When the calculation reaches either of 
these criteria, the calculation ends.

RMS gradient When the RMS gradient of the energy is 
less than this value, the calculation ends. 
The practical range is 10–3 to 0.1 (the 
default). Values less than 10–3 might not be 
possible due to the numerical round-off 
error. You can use values greater than 0.1 
for quick, approximate calculations.

max.
Cycles

If the calculation uses this number of 
search directions before converging, the 
calculation ends. The default is 15 times 
the number of atoms. The practical range is 
100 to 1000.

In vacuo This removes periodic boundary conditions from 
the calculation. In vacuo is the only choice if the 
molecular system is in a periodic box (either visible 
or hidden).

Periodic
boundary 
conditions

This uses the periodic boundary conditions already 
established in the molecular system (see “Periodic 
Box” on page 219) for the calculation. This is only 
available if the molecular system is in a periodic 
box (either visible or hidden).

Screen
refresh 
period

This is the frequency, in optimization cycles, of 
showing the results of a calculation on screen. 
Screen refresh period can be any number of data 
collection periods (an integer) from 1 to 32,767.

Note: Changing the Screen refresh period also 
changes the Data collection period in the Molecular 
Dynamics dialog box.
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Molecular Dynamics

Molecular dynamics calculations simulate the movement of mole-
cules. These calculations have various uses, including studying 
equilibrium properties (motion around a minimum on the energy 
surface) and kinetic behavior (motion involving change from one 
state to another). Equilibrium simulations (at one temperature) 
can predict thermodynamic properties of a molecular system. 
Kinetic simulations (with controlled heating and cooling) help to 
find an energy minimum (simulated annealing). By setting two 
molecules to collide, it is possible to model chemical reactions at 
the molecular level. (Molecular Dynamics simulations using ab ini-
tio methods take much longer than with molecular mechanics or 
semi-empirical methods, but they may model bond breaking and 
bond formation more accurately. See comments in Computational 
Chemistry about bond breaking and formation.)

HyperChem provides records of molecular dynamics calculations. 
You can take snapshots of the molecular system during a 
simulation and store these in a file for later analysis. You can also 
calculate and graph values for structural or energy variables.

Use this calculation on selected atoms or on all atoms in a molec-
ular system. If you select atoms from the molecular system, unse-
lected atoms do not move (no geometry optimization), but the cal-
culation uses the forces that unselected atoms exert on selected 
atoms. In a semi-empirical calculation with selected atoms, Hyper-
Chem treats only selected atoms quantum mechanically (see 
“Extend to sp3” on page 152).

To perform a molecular dynamics calculation:

1. Select the atoms for the computation or deselect all atoms to 
run the dynamics calculation on the whole molecular system.

2. Choose Molecular Mechanics, Semi-empirical, or Ab Initio on the 
Setup menu. From the next dialog box that appears, choose 
the calculation method. Set up the calculation options that 
you wish. (In order to conserve the total energy in molecular 
dynamics calculations, using an ab initio quantum mechanical 
method, the gradient needs to be very accurate. Although the 
gradient is calculated analytically, it is a function of the SCF 
accuracy of a wave function. Tests for H2O show that the con-
vergence limit needs to be at least at 10-5.)

3. Choose Molecular Dynamics on the Compute menu.
Chemical Calculations 245



Compute Menu
4. In the Molecular Dynamics Options dialog box, you can 
choose times and temperatures for heating, equilibration, and 
cooling. You can also choose data analysis options. 

5. L-click on Proceed.

This information appears on the status line during a calculation:

Time The total elapsed time of the molecular dynamics 
simulation, in picoseconds.

Total Energy The total energy (potential and kinetic) of this 
molecular system.

T The temperature of the molecular system in 
Kelvin.

iter For a semi-empirical or ab initio calculation: The 
iteration number of the SCF calculation.

diff For a semi-empirical or ab initio calculation: The 
difference in energy (kcal/mol) between the results 
of the last two SCF cycles.

For more information about this calculation and its applications, 
see HyperChem Computational Chemistry, Practical Guide.

Changing the Initial Velocity for Calculations

If you want to perform a molecular dynamics simulation using a 
different set of initial atom velocities, you can change the value of 
the HyperChem variable, called dynamics-seed, that is used for the 
random number generator. For details see “Scripts and DDE” on 
page 325.

Molecular Dynamics Options Dialog Box

Essentially the same dialog box is used for Molecular Dynamics, 
Langevin Dynamics, and Monte Carlo. Each of these calculations 
can have up to three phases: heating, running, and cooling. The 
running phase of a dynamics calculation may involve constant 
temperature control (coupling to a “water bath”) or no tempera-
ture control (“free” dynamics).

The options you choose for a molecular or Langevin dynamics cal-
culation depend on the type of simulation. If you want to deter-
mine the thermodynamic properties of a system, the system must 
reach equilibrium, indicated by a stable temperature, without a 
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temperature bath. Reaching equilibrium might require long simu-
lation times. For most equilibrium simulations, you should have a 
long simulation period to reach equilibrium, then start the simu-
lation again (see Restart, below) to collect data.

If you want to find a minimum energy conformation, equilibrium 
is not required. The simulation can use high temperatures to aid in 
crossing barriers on the potential surface. For example, you can 
heat a system, maintain it at a high temperature, and then cool it.

Times For Molecular Dynamics and Langevin Dynamics, 
the lengths of time periods and the size of the time 
steps in the simulation. For Monte Carlo, the num-
ber of steps in each phase, and the maximum 
atomic movement at each step. Each time period 
starts and ends at a Temperature.

For Molecular Dynamics and Langevin Dynamics, the 
options are:

Heat time The time in picoseconds (ps) for changing 
the temperature from Starting to Simula-
tion. Suggested range: 0 to 10 ps.

Run time The time in picoseconds for holding the 
system at the Simulation temperature. Sug-
gested range: 0 to 103 ps.
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Cool time The time in picoseconds for changing the 
temperature from Simulation to Final. Sug-
gested range: 0 to 10 ps.

Step size This is the time interval, in picoseconds, 
between evaluations of the total energy 
and temperature of a molecular system 
Suggested range: 10–4 to 10–3 ps, and 
greater than zero. For molecular systems 
with explicit hydrogens (All Atom), try 
5x10–4.

For Monte Carlo, the options are:

Heat The number of steps for changing the tem-
perature from Starting to Simulation.

Run steps The number of steps for doing the calcula-
tion at the Simulation temperature.

Cool The number of steps for changing the tem-
perature from Simulation to Final.

Max delta This is the maximum distance (in Å) that 
any atom in the system will be moved at 
each step in the calculation. Suggested 
range: 0.01 to 0.1 Å; the default is 0.05 Å.

Note: For dynamics calculations, step size is critical. If the simula-
tion is unstable (atoms move erratically or bonds increase in 
length beyond reasonable limits), try a smaller step size. In gen-
eral, the step size should be an order of magnitude smaller than the 
shortest period of a characteristic system oscillation. For systems 
including individual hydrogen atoms, use a step size of about 
5x10-4 ps, or less.

Temperature The temperature levels for the simulation. During 
Heat time and Cool time, HyperChem sets the tem-
perature by periodically adjusting velocities (see 
HyperChem Computational Chemistry, Theory and 
Methods). During Run time with Constant tempera-
ture on, HyperChem adjusts velocities at each time 
step. If Constant temperature is off, adjustment 
occurs once at the beginning of the simulation.

Starting 
temperature

If Heat time is greater than zero, initial 
atomic velocities are adjusted to give this 
temperature. Suggested range: 0 to 300 K.
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Simulation
temperature

At the start of Run time, atomic velocities 
are adjusted to give this temperature. If 
you want initial heating in the simulation, 
this temperature should be larger than 
Starting temperature. Suggested range: 0 to 
400 K.

Final 
temperature

If Cool time is greater than zero, atomic 
velocities are adjusted to approach this 
temperature at the end of Cool time. If you 
want cooling to occur in this simulation, 
this temperature should be less than Simu-
lation temperature. Suggested range: 0 to 
300 K.

Temperature 
step

This sets the size of the steps, in Kelvin, for 
heating or cooling. Suggested range: 0 to 
100 K.

Options 

In vacuo This removes periodic boundary condi-
tions from the calculation. In vacuo is the 
only choice if the molecular system is not 
in a periodic box (either visible or hidden).

Periodic
boundary 
conditions

This includes periodic boundary condi-
tions in the calculation. The system must 
be in a defined Periodic Box (see page 219).

Constant 
temperature

Tends to regulate the temperature of the 
molecular system about the Simulation 
temperature, only during Run time. This 
creates a non-equilibrium condition; the 
simulation adjusts atomic velocities to 
control the temperature. The amount 
(severity) of temperature regulation 
depends on the Bath relaxation setting 
(below). This option is inactive for Monte 
Carlo.

Bath
relaxation

A time constant (in picoseconds) for Con-
stant temperature regulation during Run 
time (see above). The Bath relaxation con-
stant affects the amount of regulation. 
Constants similar to the Step size (see 
above) give better regulation, but take the 
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system further from equilibrium. Larger 
time constants give less regulation, but are 
often useful for counteracting round-off 
errors that accumulate during the long 
simulations. Suggested range: Step size to 
0.1 ps (the default).

Random seed This number is the starting point for the 
random-number generator used for the 
simulations. It is used to determine the 
starting velocities for atoms in a Molecular 
Dynamics calculation if Restart is not 
checked, and the random motions and 
interactions in Monte Carlo and Langevin 
Dynamics. The value is saved in a HIN file. 
Acceptable values: integers from -32768 to 
32767.

Friction 
coefficient

This option is used for Langevin Dynamics, 
and is gray and inactive for Molecular 
Dynamics and Monte Carlo. It describes 
the coefficient of friction which is used to 
simulate solvent interactions. Acceptable 
values: from 0 to infinity.

Data
collection
period

This is the frequency, in time steps, that the molec-
ular dynamics simulation sends new calculated 
values to HyperChem. Step size, also in this dialog 
box, sets the length of time steps. Data collection 
period can be any number of time steps (an integer) 
from 1 to 32,767. 

Note: Changing the Data collection period also 
changes the Screen refresh period in the Molecular 
Mechanics, Semi-empirical, and Ab Initio Optimi-
zation dialog boxes.

Screen
refresh 
period

This is the frequency, in data steps, of showing the 
results of a calculation on screen. Data collection 
period, above, sets the length of a data step. Screen 
refresh period can be any number of data collection 
periods (an integer) from 1 to 32,767.

Playback Check (✓) this option to run a dynamics or Monte 
Carlo simulation stored in a HIN and a snapshot 
(SNP) file. To use Playback, the molecular system 
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from the HIN file must be in the workspace. The 
molecular system is in the workspace if you just 
completed a dynamics or Monte Carlo calculation, 
or if you use Open on the File menu to display a 
system stored with snapshots. 

With Playback on (✓), only Data collection period, 
Screen refresh period, Snapshots, and Averages are 
available in this dialog box. L-click on Snapshots to 
see the Molecular Dynamics Playback dialog box 
(see page 252). L-click on Averages to calculate 
averages or plot values during the playback (see 
“Molecular Dynamics Playback Dialog Box” on 
page 252).

Restart With Restart on (✓), the calculation sets the initial 
velocities of atoms to previously determined 
values. The initial velocities are either from the last 
molecular dynamics calculation with the current 
molecular system, from a HIN file saved with 
velocities (see “Save File Dialog Box” on page 57), 
or set in the Set Velocity dialog box (see page 228). 
With Restart off, the calculation creates initial 
velocities, using a random number generator, 
which provide a Gaussian distribution associated 
with the starting temperature.

Snapshots With Playback off, this option shows the Molecular 
Dynamics Snapshots dialog box (see the next sec-
tion). With Playback on, Snapshots shows the 
Molecular Dynamics Playback dialog box (see 
page 252). 

Averages Displays the Molecular Dynamics Averages dialog 
box (see page 254), so that you can calculate aver-
ages and graph results of a dynamics calculation. 
Use this option after a calculation or playing back 
a snapshots file (see Playback, earlier). Averages are 
available only in the Molecular Dynamics Averages 
dialog box. Graphs appear in the Molecular 
Dynamics Results dialog box.

Proceed Starts the dynamics or Monte Carlo calculation or 
starts the playback of a snapshots file.
Chemical Calculations 251



Compute Menu
Molecular Dynamics Snapshots Dialog Box

Use this dialog box to store data into two files, a HIN file that stores 
the system information and a binary snapshot file (with the exten-
sion .snp) that cumulatively stores the system coordinates and 
velocities at regular intervals during a molecular dynamics calcula-
tion. You specify the name for the HIN file in a slightly modified 
version of the standard Save File dialog box (see “Save File Dialog 
Box” on page 57), the only difference being an additional Snapshot 
Period text box (described below) for specifying the frequency of 
saving snapshots. The snapshot binary file will have the same 
name as the HIN file that you specify, except the extension will be 
SNP instead of HIN. You can later open the HIN file and use Play-
back in the Molecular Dynamics Options dialog box (see page 246) 
to review the molecular dynamics simulation.

Snapshot 
period

This is the interval, in data steps, between snap-
shots. A data step occurs every time a calculation 
reports new data (see “Time Periods in a Molecular 
Dynamics Simulation” on page 259).

Molecular Dynamics Playback Dialog Box

This dialog box is available only when the molecular system in the 
workspace includes snapshots of a previous molecular dynamics 
simulation. This is true if you just completed a molecular dynam-
ics calculation and collected snapshots, or if you use Open on the 
File menu (see “Open” on page 52) to display a system stored with 
snapshots. The snapshot file contains information about the kind 
of calculation that created it: Molecular Dynamics, Langevin 
Dynamics, or Monte Carlo. It can be played back only from the 
playback menu of the kind of calculation that created it.

To display the dialog box:

1. L-click on Playback in the Molecular Dynamics Options dialog 
box.

2. L-click on Snapshots in the same dialog box.
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Trajectory This section gives you information about the snap-
shot file, and allows you to specify that all or part 
of it should be replayed.

Snapshot file For display only. The path and name of the 
SNP file containing molecular dynamics 
snapshots. 

Step count For display only. The number of snapshots 
stored during a simulation.

Step size For display only. The time interval, in pico-
seconds, between snapshots.

Start time The time in the simulation to begin the 
playback. Enter a number from 0.000 (the 
default) to End time.

End time The time in the simulation to end the play-
back. Enter a number from Start time to the 
default (total simulation time).

AVI Movie This section contains options for generating an 
AVI movie from a snapshot file. The AVI movie can 
be played back using the Multimedia Player or 
comparable application (different versions are 
available as shareware).

Warning: If you change the size of the HyperChem window while 
you are generating an AVI movie, HyperChem may crash.
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Create Movie If this option is turned on (✓), an AVI 
movie will be generated.

Movie file Enter the name of the AVI file to be created 
in this area.

Frame rate Enter the frames-per-second rate of the 
movie in this text box.

Molecular Dynamics Averages Dialog Box

Use this dialog box to average and plot data from a molecular 
dynamics calculation or from the playback of a recorded calcula-
tion (see “Molecular Dynamics Playback Dialog Box” on page 252). 
Choose from these variables:

• Four standard measurements of energy and temperature.

• Bond lengths, bond angles, and torsion angles for named 
selections of 2, 3, or 4 atoms (see “Name Selection” on page 
147).

• Acceptance ratio (available only for Monte Carlo simulations).

• Deviations from the mean for each of these values (with a pre-
fix “D”).

HyperChem plots the instantaneous value of each quantity during 
the calculation and calculates the average of a value over the 
whole simulation.

You can reach this dialog box by choosing Averages in the Molec-
ular Dynamics Options dialog box.
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Selection This lists ten predefined choices, plus named selec-
tions, which HyperChem can plot and average:

EKIN Kinetic energy (kcal/mol).

EPOT Potential energy (kcal/mol). 

ETOT Total energy (kcal/mol).

TEMP Temperature (Kelvin).

ACCR Acceptance ratio (available only for Monte 
Carlo simulations)

Named
selections 

These are interatomic distances, angles, 
and torsion angles for named selections of 
any 2, 3, or 4 atoms in a molecular system. 
These also appear in the Select dialog box 
(see page 145). HyperChem reports these 
values:

• Distance in Ångstroms between any 
two atoms.

• Bond angle in degrees for any three 
atoms.

• Torsion angle (proper or improper) in 
degrees for any four atoms.
Chemical Calculations 255



Compute Menu
D EKIN The RMS deviation from the mean for the 
kinetic energy.1

D EPOT The RMS deviation from the mean for the 
potential energy.1

D ETOT The RMS deviation from the mean for the 
total energy.1

D TEMP The RMS deviation from the mean for the 
temperature.1

ACCR The RMS deviation from the mean for the 
acceptance ratio (available only for Monte 
Carlo simulations).1

D Named
selections

The RMS deviation from the mean for the 
named selections.1

Average only This lists the values that HyperChem averages at 
the end of a molecular dynamics calculation. 
HyperChem saves the instantaneous values in a 
file with the same name as the HIN file, but with 
the extension .csv (see “Plot and Averages Files” on 
page 439). If the molecular system is not yet asso-
ciated with a HIN file, HyperChem stores the val-
ues in chem.csv.

Avg. & Graph This lists up to four values that HyperChem aver-
ages and graphs during a molecular dynamics sim-
ulation. Graphs appear in the Molecular Dynamics 
Results dialog box (see page 257). HyperChem 
saves the instantaneous values and averages in a 
file with the same name as the HIN file, but with 
the extension .csv (see “Plot and Averages Files” on 
page 439). If the molecular system does not yet 
have a file name, HyperChem stores the values in 
chem.csv. The .csv file is stored in the current 
working directory, which you must be able to write 
to (e.g., not on a CD-ROM.)

1. , where x = instantaneous value of EKIN, ETOT, and so on.
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Value The average that appears here is for the last value 
that you highlighted in one of the lists (Average 
only or Avg.& Graph). na means no average yet 
available. For a value x, the average over time is 

. For the RMS deviation of x, the 

reported average is .

Average/
graph period

This sets the interval for averaging data or plotting 
it. Enter a number from 1 to the maximum 
number of Data steps. A data step occurs whenever 
the calculation reports new data (see “Time Periods 
in a Molecular Dynamics Simulation” on page 
259). 

To choose values for averages and plots:

• Choosing a value: L-click on a value (for example, TEMP). A 
highlight appears, indicating an active choice. L-click on addi-
tional values to add them to the active choices. 

• Canceling a choice: L-click on a value that has a highlight.

• Moving a choice to the right: L-click on Add. Active choices 
(highlighted) move to the list on the right.

• Moving a choice to the left: L-click on Del. Active choices 
(highlighted) move to the list on the left.

Molecular Dynamics Results Dialog Box

This dialog box graphs instantaneous values (either x or D x) from 
a molecular dynamics simulation. A plot of x shows instantaneous 
values of x with time. A plot of D x shows the current value of the 
RMS deviation for x, with the computed value of D x converging 

to its final value of . HyperChem computes the value of 

D x from running averages of x and x2. A CSV file records the exact 
values of x and D x used for the graphs (see “Plot and Averages 
Files” on page 439).

The dialog box is available when you are doing a molecular 
dynamics simulation or are playing back a previous simulation. To 
see the averages of values from a simulation, you must return to 
the Molecular Dynamics Averages dialog box.
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To activate this dialog box:

1. In the Molecular Dynamics Options dialog box (see “Molecu-
lar Dynamics Options Dialog Box” on page 246), L-click on 
Averages.

2. In the Molecular Dynamics Averages dialog box (see “Molecu-
lar Dynamics Averages Dialog Box” on page 254), choose the 
values to average and graph. You can graph up to four quanti-
ties or their deviations.

3. L-click OK to return to the Molecular Dynamics Options dialog 
box. 

4. L-click Proceed to start the simulation or a playback of snap-
shots from a previous simulation.

You see the Molecular Dynamics Results dialog box on top of a 
HyperChem window. To temporarily remove this dialog box, L-
click on the Minimize button in the upper-right corner. This turns 
the dialog box into an icon. Double-click on the icon to see this 
dialog box again.

minimize 
button
reduces 
window 
to icon
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Rescale L-click to change the y axis to show all data. Use 
this option if a plot goes off scale. Pressing the 
[Spacebar] is equivalent to L-clicking on Rescale.

Done Ends plotting and removes this dialog box. Dou-
ble-clicking on the Control-menu box is equiva-
lent.

Minimize 
button

Reduces the dialog box to an icon.

Time Periods in a Molecular Dynamics Simulation

Because of the frequencies of molecular motions, molecular 
dynamics simulations run over a picosecond time scale. For 
example, it takes about 4 ps at 300 K to break a hydrogen bond and 
make a new bond. 

The total length of a simulation is the sum of Heat, Run, and Cool 
times, though some simulations might use only one or two of 
these simulation periods. HyperChem uses four timing periods 
during a molecular dynamics simulation:

Heat time Run time Cool timeSimulation period

Time steps1

Data collection period = 
n time steps

Screen refresh period = 
n data (collection) steps

Average/Graph period = 
n data (collection) steps

1. To adjust the length of Time steps, set Step size in the Molecular 
Dynamics Options dialog box.

Snapshot period = 
n data (collection) steps
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A molecular dynamics simulation calculates the energy and gradi-
ent of a molecular system after each time step (see HyperChem 
Computational Chemistry, Practical Guide). Step size determines the 
interval (period) between time steps. Timing of all other events in 
the simulation is related to time steps. The simulation reports 
information at the end of each Data collection period. HyperChem 
stores this data in a log file, a snapshots file, a plot (CSV) file (see 
“Plot and Averages Files” on page 439), or uses it for a molecular 
dynamics graph, if you choose those options. 

Langevin Dynamics

Langevin dynamics is similar in principle to regular molecular 
dynamics. It includes frictional effects to simulate the presence of 
a solvent implicitly, where regular molecular dynamics requires 
inclusion of explicit solvent molecules. Please see the description 
in HyperChem Computational Chemistry.

You perform Langevin Dynamics calculations with HyperChem in 
the same way as you do Molecular Dynamics calculations. All of 
the dialog boxes for Langevin Dynamics are the same as for Molec-
ular Dynamics except that a few of the available options are differ-
ent. The Langevin Dynamics Options dialog box allows you to 
specify a Friction coefficient which describes the effects of the sim-
ulated solvent, and a Random seed which is the starting point for 
the random number generator. Please see “Molecular Dynamics 
Options Dialog Box” on page 246, and the subsequent sections on 
its dialog boxes, for information about setting up Langevin 
Dynamics calculations.

Monte Carlo

The Monte Carlo method samples phase space by generating ran-
dom configurations from a Boltzmann distribution at a given tem-
perature. Averages computed from a properly equilibrated Monte 
Carlo simulation correspond to thermodynamic ensemble aver-
ages. Thus, the Monte Carlo method can be used to find average 
energies and equilibrium structural properties of complex interact-
ing systems.

A sequence of successive configurations from a Monte Carlo simu-
lation constitutes a trajectory in phase space; with HyperChem, 
this trajectory may be saved and played back in the same way as a 
260 Chapter 7



Compute Menu
dynamics trajectory. With appropriate choices of setup parame-
ters, the Monte Carlo method may achieve equilibration more rap-
idly than molecular dynamics. For some systems, then, Monte 
Carlo provides a more direct route to equilibrium structural and 
thermodynamic properties. However, these calculations can be 
quite long, depending upon the system studied.

You perform Monte Carlo calculations with HyperChem in the 
same way as you do Molecular Dynamics calculations. All of the 
dialog boxes for Monte Carlo are the same as for Molecular 
Dynamics except that a few of the available options are different. 
The Monte Carlo Options dialog box allows you to specify num-
bers of steps for running instead of time periods, and a Random 
seed which is the starting point for the random number generator. 
The Monte Carlo Averaging dialog box allows you to average (and 
optionally plot) the acceptance ratio and its RMS deviation, along 
with the other averaging values. Please see “Molecular Dynamics 
Options Dialog Box” on page 246, and the subsequent sections on 
its dialog boxes, for information about setting up Monte Carlo cal-
culations.

Vibrations

Use Vibrations to compute the vibrational motions of the nuclei, 
and use Vibrational Spectrum to display graphically the normal 
modes associated with individual vibrations, as well as to display a 
graphical representation of an infrared (IR) vibrational spectrum. 
You can calculate vibrations using any of the ab initio or semi-
empirical methods except Extended Hückel.

Use Vibrational Spectrum on the Compute menu to view the results 
of the computation.

Use vibrational analysis to perform the following tasks:

• Provide insight into the rigidity of the molecular framework.

• Visualize normal modes corresponding to lines in the IR spec-
trum.

• Help identify unknown compounds by correlating predicted 
versus experimental vibrational frequencies.

• Differentiate minima from saddle points on a potential energy 
surface.
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To calculate vibrations:

1. Create or load the system that you wish to calculate vibrations 
for.

2. Choose a semi-empirical method other than Extended Hückel. 
Make sure that None is selected as the CI Method and that the 
Convergence limit is 0.01 or smaller. 

3. Choose Geometry Optimization on the Compute menu, set the 
termination condition to 0.01 and choose OK to start the opti-
mization.

Important: For a valid vibrational analysis the system must be opti-
mized. Extra tight convergence criteria should be used for geome-
try optimization (<0.01 kcal/mol Ångstrom) because a the har-
monic analysis is based upon a zero gradient. You must use the 
same semi-empirical method for both the vibrational analysis and 
the geometry optimization. 

4. After the calculation finishes, choose Vibrations on the 
Compute menu.

HyperChem computes the SCF wavefunction and evaluates the 
gradient analytically at the optimized geometry. The second deriv-
atives of the energy with respect to the atomic Cartesian coordi-
nates are computed using a finite differencing of the analytical gra-
dients. 

The evaluation of second derivatives, by finite difference of ana-
lytic gradients, is the most time consuming step. The result is a 
matrix of mixed partial second derivatives (force constants), which 
is diagonalized to yield normal modes of vibration and their cor-
responding energies. The status bar shows the extent to which the 
matrix is completed. 

You may then choose Vibrational Spectrum from the Compute 
menu to analyze the results. 

To store vibrational spectra:

If you wish to save vibrational results, see “Export . . .” on page 63. 
Alternately, you can run the sample script saveir.scr (see “Open 
Script” on page 75 for information on running scripts). This will 
create another script file that you can later open to restore the 
saved vibrational results into HyperChem.
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Transition State

This command allows you to find transition states of chemical sys-
tems with any kind of semi-empirical (except Extended Hückel) or 
ab initio method. Several different search algorithms are available.

The semi-empirical methods were optimized for stable structures, 
not for transition states. You are likely to get better results for a 
transition state search from an ab initio calculation than from a 
semi-empirical calculation. When you set up the options for the 
SCF calculation, you should specify a relatively good convergence 
(SCF convergence around 0.001) and a larger number of cycles 
than usual (perhaps 150 cycles). It is a good idea to have the con-
vergence acceleration turned on for transition state searching.

Eigenvector 
following

This method follows an eigenvector of a vibra-
tional mode to find a transition state. If you select 
this option and click on “OK”, HyperChem will 
perform a vibrational calculation and open the 
Transition State Search dialog box (below) to allow 
you to specify which vibrational mode to follow. 
This method is especially useful if one of the natu-
ral vibrational modes of the system leads to a tran-
sition state (for example, the “breathing” mode of 
a pyramidal structure leading to its inversion).

Synchronous 
transit

This method is used to search for a transition state 
after you have defined a “Reactant” state and a 
“Product” state, and have used Reaction Map (see 
page 231) to define a starting point for the search. 
From that information, HyperChem is able to 
determine the best eigenvector to search along 
without further user intervention.
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Linear HyperChem uses a linear interpolation 
between the reactant and product states.

Quadratic HyperChem uses a quadratic interpolation 
between the reactant and product states.

Synchronous 
Transit 
Termination 
Condition

Use these text boxes to set conditions for ending 
the transition state search. When the calculation 
reaches either of these criteria, the search ends.

RMS gradient When the RMS gradient of the energy is 
less than this value, the calculation ends. 
The practical range is 10–2 to 0.1 (the 
default). Values less than 10–2 might not be 
possible due to the numerical round-off 
error. You can use values greater than 0.1 
for quick, approximate calculations. If you 
want a very small RMS gradient criterion, 
you should change the options for the SCF 
calculation to a smaller convergence limit 
and a larger number of SCF cycles.

max.
Cycles

If the calculation uses this number of 
search directions before converging, the 
calculation ends. The default is 15 times 
the number of atoms. The practical range is 
100 to 1000.

Transition State Search Dialog Box

This dialog box opens after you Click on OK after specifying Eigen-
vector Following in the Transition State Options dialog box. Hyper-
Chem performs a vibrational calculation and then displays this 
box.
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Most of the features of this dialog box are the same as in the Vibra-
tional Spectrum dialog box (see page 280). You can select a vibra-
tional mode by clicking on its line, or by entering the mode num-
ber in the Mode text box. You can use the Zoom and Pan slider bars 
to focus on part of the spectrum at a time.

Usually, the vibrational mode with the lowest frequency (Mode 
#1, at the right side of the box) is the one that will lead to a tran-
sition state.

The options for Termination Condition are as described in the Tran-
sition State Options dialog box, above.

Plot Molecular Properties

Use this command if you want to display electrostatic potential, 
total spin density, or total charge density results of a semi-empiri-
cal or ab initio calculation. It displays the Plot Molecular Properties 
property sheet. This command is unavailable unless a quantum-
mechanical wavefunction has been calculated, via Single Point, 
Geometry Optimization, Molecular Dynamics or Vibrations.

Plot Molecular Properties Property Sheet

Use the Plot Molecular Properties property sheet to display electro-
static potential, total spin density, and total charge density. Plot 
Molecular Properties is activated on the Compute menu only after 
Chemical Calculations 265



Compute Menu
you complete a semi-empirical or ab initio calculation. The prop-
erty sheet has several “pages” which you can select with the tab 
controls.

Plot Molecular Properties

Property This lets you select the property that you are dis-
playing.

Electrostatic 
potential

This plots the electrostatic potential field 
due to the electronic charge distribution 
and nuclear charges, in units of e/a0. Not 
available for Extended Hückel. Selecting 
Electrostatic Potential makes the 3D Mapped 
Isosurface option available under Represen-
tation; otherwise that option is grayed out.

Total spin
density

This plots the probability of finding more 
spin-up electrons than spin-down elec-
trons at any point in space, in units of 
e/a0

3. 

Total 
charge 
density

This plots the electron density function for 
the molecular valence electrons, in units of 
e/a0

3. It is often associated with the surface 
of a molecule. It describes the probability 
of finding an electron at a point in space. 
The value is the sum for each electron of 
ψi

2, where ψi is the molecular orbital occu-
pied by the ith electron. For a closed-shell 
266 Chapter 7



Compute Menu
system this is 2ψi
2, summed over the occu-

pied orbitals.

Represen-
tation

In this section you specify how you wish the prop-
erty to be displayed.

2D Contours Use this option to draw a two-dimensional 
contour plot of the selected property.

3D Isosurface Use this option to draw a three-dimen-
sional surface which maps out a specified 
value of the selected property.

3D Mapped 
Isosurface

Use this option to draw a three-dimen-
sional surface which is colored according 
to the values of the selected property. This 
option is available only when Electrostatic 
Potential has been chosen as the property 
to be displayed.

If you have a monochrome monitor or you chose black bonds on 
a white workspace (see “Using Black-and-white Output” on page 
74), positive contour lines are solid and negative contour lines are 
dashed.

Note: You cannot display a contour plot or isosurface if Stereo or 
Perspective of the Sticks rendering are turned on. If you display an 
isosurface and the Wedges option of the Sticks rendering is on, the 
wedges will not be shown while the isosurface is displayed.

Isosurface Grid Dialog Box

Use these options to specify values for the 3D grid used to render 
an isosurface.
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Grid Mesh  
Size

Select a Coarse, Medium, or Fine grid mesh, or select 
User defined and then specify the grid details that 
you wish. Selecting User defined makes the other 
sections of this page active.

Grid Layout Use these options to specify the options for the 3D 
grid.

Grid point 
step size

The distance between data points in the 3D 
grid, in units of Å. The same spacing is used 
for all three coordinate axes.

Grid point
counts

The size of the 3D grid in each of the coor-
dinate directions, in units of the number of 
grid points. At the top is the total number 
of grid points, which is the product of the 
three values below it. If you change any of 
these values, you must click on Adjust 
Extents in order to have the change 
accepted.

Spatial extents The size of the 3D grid in each of the coor-
dinate directions, in units of Å. The num-
bers to the right of these values give the 
spatial extent of the nuclear framework. If 
you change any of these values, you must 
click on Adjust Points in order to have the 
change accepted.
268 Chapter 7



Compute Menu
Adjust points Use the Grid point step size and the given Spatial 
extents values to recalculate the values of the Grid 
point counts

Adjust Extents Use the Grid point step size and the given Grid 
point counts values to recalculate the values of the 
Spatial extents

Contour Grid

Use these options to specify values for the 2D grid used to render 
a contour plot. If you have specified black-and-white output set-
tings the positive contours will be drawn as solid lines and the neg-
ative contour lines will be drawn as dashed lines.

Horizontal
grid points

Enter a number for the horizontal resolution of the 
contour lines. The default of 45 means that Hyper-
Chem calculates 45 values in each horizontal line 
and interpolates contour lines between grid points. 
Range: 2 to 8,172.

Vertical
grid points

Enter a number for the vertical resolution of the 
contour lines. The default of 45 means that Hyper-
Chem calculates 45 values in each vertical line and 
interpolates contour lines between grid points. 
Range: 2 to 8,172.

Contour
levels

Enter a value for the number of contour lines to 
plot. The default is 15 lines. Range: 1 to 32,767.

Plane 
offset

The default plane of a set of contour lines is per-
pendicular to the viewer’s z axis (in the plane of 
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the screen) and through the center of mass of 
selected atoms or, if there is no selection, the 
whole molecular system. This offset moves the 
plane of contour lines, in Ångstroms, along the 
viewer’s z axis: a positive offset is outward from the 
screen, a negative offset is inward. 

Starting
value

The value of the lowest contour line.

Default The starting value that HyperChem calcu-
lates from the grid points and Contour lev-
els settings, or the value you entered for 
the last contour plot.

Other Enter a new value. When you L-click Other, 
HyperChem shows the present Default 
value.

Increment The interval between two adjacent contour lines.

Default The starting value that HyperChem calcu-
lates from the grid points and Contour lev-
els settings, or the value you entered for 
the last contour plot.

Other Enter a new value. When you L-click Other, 
HyperChem shows the present Default 
value.

Isosurface Rendering

These options specify how the isosurface should be drawn.
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Contour Level The isosurface shows where, in 3D space, the 
property that you have specified has this value.

Rendering In this section, you specify which rendering mode 
you wish the isosurface drawn with. In general, the 
modes at the beginning of the list are simpler and 
more quickly drawn than the modes at the end of 
the list.

Wire mesh The isosurface is drawn as a transparent 
pattern of crossed lines. This mode is the 
fastest to calculate and display.

Jorgensen-
Salem

The isosurface is drawn as Lines, below, 
except that while parts of the isosurface 
can hide other parts of the isosurface, the 
molecular structure is not hidden. (See The 
Organic Chemist's Book of Orbitals, by Will-
iam L. Jorgensen and Lionel Salem, New 
York, Academic Press, 1973.) If you have 
set the bond and window colors for black 
and white (see “Using Black-and-white 
Output” on page 74), the positive parts of 
the isosurface are drawn with solid lines 
and the negative parts are drawn with dot-
ted lines when you print the structure.

Lines The isosurface is drawn as a pattern of 
crossed lines; objects close to the user’s 
point of view will hide objects farther 
away.
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Flat surface The isosurface is drawn as a solid surface, 
without shading.

Shaded
surface

The isosurface is drawn as a solid surface 
with shading to enhance the three-
dimensional appearance. The surface is 
divided into small segments for coloring; 
this gives a reasonably good appearance at 
moderate speed.

Gouraud 
shaded 
surface

The isosurface is drawn as a smooth shaded 
surface for optimal three-dimensional 
appearance. This mode is the slowest to 
calculate and display of the simple opaque 
surfaces.

Translucent 
surface

The isosurface is drawn as a smooth, semi-
transparent surface. The molecular struc-
ture, and far-away parts of the isosurface, 
can be seen showing through the nearer 
parts of the surface. The degree of transpar-
ency can be specified in Transparency Level 
(below). The extra calculations required for 
this display make it slower than Gouraud 
shaded surface.

Hide molecule If this option is selected (✓), the molecule will be 
hidden when the isosurface is displayed.

Transparency Level
272 Chapter 7



Compute Menu
Use this slider to control the transparency level of an isosurface 
rendered as a Translucent Surface. The setting can be anywhere 
from completely transparent (isosurface will be invisible) to com-
pletely opaque. If you want a completely opaque surface, you 
should use a Gouraud Shaded Surface instead; the appearance will 
be the same but the Gouraud surface is drawn more quickly. If you 
want a completely transparent isosurface, you can simulate it 
quickly by turning the isosurface display off.

The Default button restores the default transparency level.

Mapped Function Options

These options control the appearance of an isosurface drawn as a 
3D Mapped Isosurface.

Mapped 
Function 
Range

These boxes show the minimum and maximum 
values used to render the color range of the isosur-
face.

Display Range 
Legend

If this option is selected (✓), a legend bar will be 
drawn on the workspace, showing the range of 
colors used and the function values that they rep-
resent.

Plotting Results

HyperChem can plot the results of semi-empirical or ab initio cal-
culations as 2D contour plots or 3D isosurfaces and show the con-
tour lines or isosurfaces on top of the molecular system in the 
workspace. If you have a color monitor, the contour colors are as 
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specified in the Preferences dialog box (page 65). If you have a 
monochrome monitor or you chose black bonds on a white work-
space (see “Using Black-and-white Output” on page 74), positive 
contour lines are solid and negative contour lines are dashed.

Contour plots are always created parallel to the plane of the screen. 
To see different aspects of the value in the plot, you can change the 
view (move molecules in the Viewer’s Coordinate system) and cal-
culate a plot again. If the atomic coordinates change (because of 
movement in the Molecular Coordinate system), you must repeat 
the calculation with Single Point, Geometry Optimization, Molecular 
Dynamics or Vibrations. 

Contour plots are temporary and disappear whenever HyperChem 
revises the display of a molecular system. For example, when you 
use a HyperChem tool, such as the Selection tool, contour lines 
disappear. Isosurfaces can persist if the workspace is not actually 
altered; one can, for example, rotate a structure and isosurface.

To produce a printed record of the plotted wave functions, use 
Print (see “Print” on page 64) to send the image directly to a 
printer. Use Copy Image (see “Copy Image” on page 118) to send 
the image to the Clipboard or a file (or both). You can then use 
another program to print this image. 

total charge density 
with charge Labels

electrostatic potential total spin density
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Orbitals 

Once you have performed a semi-empirical or ab initio calculation 
you can choose Orbitals to display the energy levels of all the orbit-
als, or the contours or isosurfaces for an orbital you specify. Use 
the Orbitals dialog box to see degeneracies and near degeneracies, 
HOMO-LUMO gaps, symmetries, orbital occupation scheme, 
alpha and beta spin manifolds separately (for UHF calculations of 
open shell systems), or d-d splittings (for transition metals).

Orbitals Dialog Box

After you complete a single point semi-empirical or ab initio calcu-
lation, use this dialog box to display the contours or isosurfaces of 
a user-specified orbital or the energy levels of all the orbitals. You 
can display the relative energy levels of both the occupied and vir-
tual set of orbitals. You can label each orbital in the energy-level 
diagram according to its occupation (empty, singly occupied, dou-
bly occupied). This dialog box allows you to see the following:

• degeneracies and near degeneracies

• symmetries

• HOMO-LUMO gaps

• orbital occupation scheme

• alpha and beta spin manifolds separately (for UHF calculations 
of open shell systems)

• d-d splittings (for transition metals) 

To display this dialog box, choose Orbitals on the Compute menu. 
Orbitals is activated on the Compute menu only after you com-
plete a single point calculation using a quantum-mechanical 
method.

Note: To zoom in on the orbital energy diagram, L-drag a rectangle 
around the vertical region that you want to zoom in on. When you 
release the mouse button the energy levels will be redrawn. Use the 
Zoom Out button to see all the energy levels again.

The orbital energy levels in an ab initio calculation may look differ-
ent from those in semi-empirical calculations. The ab initio quan-
tum mechanical methods are all-electron methods, as compared to 
the valence-electron only methods of the semi-empirical quantum 
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systems, the molecular orbitals consist of two sets. The first set of 
molecular orbitals are core orbitals and the second set of molecular 
orbitals are valence orbitals. The first set of orbitals have much 
lower energies than the second set of orbitals. Thus, the core orbit-
als are shown at the bottom of this dialog box and the valence 
orbitals are displayed at the top of this dialog box. If you would 
like to examine the valence-orbital splitting closely, you can use 
the mouse to Zoom and Pan to get a proper picture.

Pan Scroll up or down in orbital energy.

Orbital Reports information on the selected orbital. Each 
of the options in this area may also be used to spec-
ify which orbital is to be selected. Orbital selections 
are nominally done by L-clicking with the mouse 
on the desired orbital in the display window. An 
alternative is to select the orbital by number by 
entering a value into the text box adjacent to the 
LUMO+, HOMO-, or Number options.

Alpha Indicates whether the selected orbital has 
alpha spin. If the selected orbital has beta 
spin, L-clicking on Alpha changes the selec-
tion to an alpha orbital. This option is 
active only after a UHF semi-empirical cal-
culation has been done.
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Beta Indicates whether the selected orbital has 
beta spin. If the selected orbital has alpha 
spin, L-clicking on Beta changes the selec-
tion to a beta orbital. This option is active 
only after a UHF semi-empirical calcula-
tion has been done.

LUMO+ Reports the location of the selected orbital 
relative to the LUMO. For example, when 
you select the orbital that is just above the 
LUMO in energy, +1 appears in the text 
box, whereas if you selected the orbital just 
below the LUMO (i.e., HOMO), -1 is 
reported in the text box.

HOMO- Reports the location of the selected orbital 
relative to the HOMO. For example, the 
orbital just above (in energy) the HOMO 
reports -1 in the text box, whereas the 
orbital just below the HOMO is reported as 
1.

Number Reports the absolute number of the 
selected orbital starting from the lowest 
energy orbital (bottom). For UHF calcula-
tions where both alpha and beta columns 
of orbitals are displayed, the numbering is 
done separately within each group. This is 
also true for the HOMO- and LUMO+ 
options.

Energy Reports the energy of the selected orbital in 
units of electron volts (eV).

Symmetry Reports the irreducible representation of 
the selected orbital.

Labels Displays the electron occupation of each                
orbital in the orbital display window. By conven-
tion, up arrows represent electrons with alpha 
spin, and down arrows represent electrons with 
beta spin. For RHF calculations the maximum 
orbital occupancy is 2, whereas for UHF calcula-
tions the maximum occupancy is one. This is a 
consequence of the Pauli Exclusion Principle. 
Labels also displays the energy of each orbital.
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Zoom Out After you zoom in (by L-dragging the mouse over a 
selected group of orbitals), this option displays the 
entire range of orbitals in one screen.

Orbital Display Provides you with options for setting the display 
options and displaying contour plots or isosur-
faces.

2D Contours Use this option to draw a two-dimensional 
contour plot of the selected orbital.

3D Isosurface Use this option to draw a three-dimen-
sional surface which maps out a specified 
value of the selected orbital.

Orbital 
squared

When selected, plot displays the square of 
the orbital value in a specified plane. This 
corresponds to a probability density rather 
than a probability amplitude. 

Options . . . This displays the Orbital Isosurface 
Options property sheet. It is the same as 
the “Plot Molecular Properties Property 
Sheet” on page 265 except that the “Molec-
ular Properties” and “Mapped Function” 
pages are not available.

Plot Displays a contour plot or isosurface of the 
selected orbital with the specified options.

Copy Copy the orbital energy diagram to the Windows 
clipboard. To get solid and dashed black lines on a 
white background for the energy levels, set 
Window to White and Bond to Black in the Prefer-
ences dialog box (see page 65).

Note: You cannot display a contour plot or isosurface if Stereo or 
Perspective of the Sticks rendering are turned on. If you display an 
isosurface and the Wedges option of the Sticks rendering is on, the 
wedges will not be shown while the isosurface is displayed.

Describing Orbitals

Molecular orbitals are numbered from 1 to M, where 1 is the lowest 
energy orbital and M is the total number of orbitals involved in the 
calculation for the current system. In semi-empirical quantum 
mechanics methods, the contribution to M is 1 for hydrogen and 
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helium atoms (1s), 4 for all main-group atoms (ns, np), and 9 for 
all the transition metals. For the Extended Hückel method, which 
can calculate d orbitals for Si, P, S, and Cl, use 9. The number of 
occupied orbitals, N, is half the number of valence electrons for 
closed-shell molecules.

In addition to using a number from 1 to M, HyperChem can iden-
tify orbitals by reference to the HOMO or the LUMO. You can 
describe an orbital by HOMO–d or LUMO+d, where d = 0 to max. 
For HOMO, max is the number of occupied orbitals minus 1 (N–1). 
For LUMO, max is M–N–1.

Practical Guidelines for Orbitals

For transition metals the splitting of the d orbitals in a ligand field 
is most readily done using EHT. In all other semi-empirical meth-
ods, the orbital energies depend on the electron occupation.

HyperChem’s molecular orbital calculations give orbital energy 
spacings that differ from simple crystal field theory predictions. 

The total molecular wavefunction is an antisymmetrized product 
of the occupied molecular orbitals.

The virtual set of orbitals are the residue of SCF calculations, in 
that they are deemed least suitable to describe the molecular wave-
function. 

Normally, you would expects all 2p orbitals in a given first row 
atom to be identical, regardless of their occupancy. This is only 
true when you perform calculations using Extended Hückel. The 
orbitals derived from SCF calculations depend sensitively on their 
occupation. For example, the 2px, 2py, and 2pz orbitals are not 
degenerate for a CNDO calculation of atomic oxygen. This is espe-
cially important when you look at d orbital splittings in transition 
metals. To see a clear delineation between t2u and eg levels you 
must use EHT, rather than other SE methods.

The orbital phases are denoted by the colors of the orbital lobes. 
Two lobes with the same color are in phase, and those of different 
color are said to be out of phase. It is important to note the colors 
have nothing to do with charge. 
Chemical Calculations 279



Compute Menu
Vibrational Spectrum 

Use Vibrational Spectrum to display graphically the normal modes 
associated with individual vibrations, as well as to display a graph-
ical representation of an infrared (IR) vibrational spectrum. Vibra-
tional Spectrum is only available after you have used Vibrations to 
compute the vibrational motions of the nuclei (see page 261).

In HyperChem, you can calculate IR vibrational spectra using any 
of the semi-empirical methods except Extended Hückel.

Vibrations represent the intrinsic rhythmic motions of the atoms 
within a molecule. Whereas translations and rotations correspond 
to motions of atoms relative to an external frame of reference, 
vibrations correspond to motions of atoms relative to each other.

The seemingly complex and chaotic trajectories of the nuclei 
undergoing vibratory motion can be conceived of as a superposi-
tion of simpler motions called normal modes of vibration, which 
generally fall into one of the following classes: stretching, bend-
ing, rocking, or wagging.

Even at 0 Kelvin vibrational motions exist as a consequence of the 
Heisenberg Uncertainty Principle. Every molecule contains 3N-6 
vibrational modes (or 3N-5 if it is linear), where N is the number 
of atoms. Each mode can be IR active, Raman active, IR and Raman 
active, or inactive.

Each mode is quantized in energy and collectively (all modes) 
result in a spectrum of discrete frequencies. There is a one-to-one 
relationship between a normal mode of vibration and a funda-
mental vibrational frequency. 

Once you have calculated Vibrations, you can use the Vibrational 
Spectrum dialog box to do the following:

• Provide insight into the rigidity of the molecular framework

• Visualize normal modes corresponding to lines in the IR spec-
trum

• Help identify unknown compounds by correlating predicted 
versus experimental vibrational frequencies

• Differentiate minima from saddle points on a potential energy 
surface.
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To analyze vibrations:

1. Perform a Vibrations calculation (see “Vibrations” on page 261) 
for your optimized system.

You may wish to rearrange your screen so that you will be able 
to see the system in the workspace and the Orbitals dialog box 
at the same time. You cannot resize or move the main window 
when the Vibrational Spectrum dialog box is active.

2. Choose Vibrational Spectrum from the Compute menu. 

This opens the Vibrational Spectrum dialog box, which shows 
the spectrum of frequencies corresponding to each normal 
mode. The vertical lines at the top represent all the vibrational 
fundamental frequencies. The spectrum at the bottom corre-
sponds to IR-active vibrations. The frequency increases from 
the right side to the left side of the dialog box. The height of 
the bottom row of lines corresponds to their IR intensities. 

3. L-click on a line.

The highlighted line is now violet. Information (normal mode 
sequence number, degeneracy, frequency, and intensity) on 
this line is shown beneath the spectrum at the bottom of the 
dialog box. 

With large molecules, the spectrum will have many lines, and 
you may not be able to easily select a given line of interest. To 
focus in on a line you can use the Zoom and Pan slider bars. 
Zoom compresses and expands the displayed range of frequen-
cies. Pan translates or shifts a given range of frequencies.

If you zoom in on the spectrum, the lowest frequency con-
verges toward the upper frequency, which remains constant.

4. Move the dialog box to try and see the system in the work-
space.

This allows you to see the structure and the dialog box simul-
taneously.

5. To visualize the vibrational motions (normal mode) for the 
selected line, turn on Animate vibrations, and choose Apply.

HyperChem animates the normal mode that corresponds to 
the frequency that you have selected. 

6. L-click on a different line or use the [1] and [2] keys to select a 
different line and choose Apply.
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A different mode will be animated. 

To store vibrational spectra:

If you wish to save vibrational results after closing the Vibrational 
Spectrum dialog box, see “Export . . .” on page 63. Alternately, you 
can run the sample script saveir.scr (see “Open Script” on page 75 
for information on running scripts). This will create another script 
file that you can later open to restore the saved vibrational results 
into HyperChem.

Vibrational Spectrum Dialog Box

To perform vibrational analysis, choose Vibrations on the Compute 
menu to invoke a vibrational analysis calculation, and then 
choose Vibrational Spectrum to visualize the results.

Suggestion: You can capture an image of the Vibrational Spectrum 
dialog box by using Setup Image on the Tools/Preferences menu to 
set Window to Top level (see page 69), activating the Vibrational 
Spectrum dialog box and then pressing [F9] to capture the image. To 
get black lines on white background for the spectrum, set Window 
to White and Bond to Black in the Preferences dialog box (see 
page 65). You can also use the Copy button in this dialog box; see 
below.
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Normal Mode Sequence number of normal mode in order of 
ascending frequency. In the case of degeneracy, 
the number begins with the last identical mode.

Degeneracy The number of modes that have the same fre-
quency.

Frequency The number of oscillations per unit time, 
expressed in units of reciprocal centimeters. 
Frequency relates to energy by E=hν, where ν is the 
frequency. Imaginary frequencies are shown as 
negative numbers; their presence indicates that 
the structure is not at a local minimum.

Intensity The height of the IR absorption line. Related to the 
dipole derivative with respect to normal coordi-
nate displacement. Low intensities correspond to 
forbidden frequencies.

Animate 
vibrations

Controls the display of animated vibrations.

Animation 
Cycle

Sets the distance in Ångstroms to move the fastest 
atom during vibrational animations.

Frames Specifies the number of steps to use in each 
cycle while animating vibrations.

Amplitude Sets the distance in Ångstroms to move the 
fastest atom during vibrational anima-
tions.

Apply The specified vibrational mode is animated in the 
workspace, leaving this dialog box active

Copy This copies a bitmap picture of the Vibrational 
Spectrum dialog box to the Clipboard. See also the 
“Suggestion” just before the picture of the dialog 
box.

If you want to vary the speed and the range of motion of the ani-
mation, try changing the values for Frames and Amplitude. The 
speed of the animation slows down as the number of frames 
increases. 

Practical Guidelines

The quality of the vibrational frequencies varies widely with the 
semi-empirical method that is used. Generally, AM1, and PM3 are 
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in closer agreement with experiment than methods based on 
CNDO or INDO.

The vibrational frequencies are derived from the harmonic 
approximation, which assumes that the potential surface has a 
quadratic form. 

Large amplitude (floppy) vibrational modes often exhibit signifi-
cant anharmonicity that may increase errors in computed frequen-
cies. In addition to anharmonicity, usually there is coupling 
between vibrational modes in reality which is not accounted for in 
the computational model.

If there are negative frequencies in an IR spectrum, it is a sign that 
you are not at a minimum energy structure. A valid minimum 
energy structure possesses only positive frequencies.

Results of a recent literature study indicate that frequencies com-
puted using semi-empirical PM3, AM1, and MNDO methods com-
pare well to values obtained at the ab initio level using medium size 
basis sets. Of these three methods, PM3 showed the closest corre-
spondence to experimental values, which is generally about 10 
percent too high in value from stretches (Seeger, D.M.; Korze-
niewski, C.; Kowalchyk, W., J. Phys.Chem. 95:68-71, 1991).

The following table shows the accuracy of computed fundamental 
frequencies for CO2 (cm-1):

Comparing Computed Results with Experiment

After you compute an IR spectrum with HyperChem, you can refer 
to the table in HyperChem Computational Chemistry, Practical 
Guide, to assign computed IR lines and qualitatively assess the 
accuracy of the computation. 

Normal 
Mode

CNDO INDO AM1 PM3 Experiment

bend 571 553 525 521 667

asymmetric 
stretch

1888 2080 1480 1406 1340

symmetric 
stretch

6427 5737 2565 2386 2349
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Electronic Spectrum 

Use this command to calculate an ultraviolet-visible (UV-visible) 
or “electronic” spectrum following a semi-empirical Single Point 
calculation with singly excited configuration interaction (CI). 
ZINDO/S is specifically parameterized to reproduce ultraviolet-vis-
ible spectra. However, you can use any of the ab initio or semi-
empirical methods, except Extended Hückel. To generate a UV-vis-
ible spectrum, you must first perform a singly excited CI calcula-
tion with the semi-empirical method you choose. This menu item 
is unavailable unless a CI calculation has been performed for the 
current system.

Applications of UV-visible spectroscopy include diverse topics in 
photochemistry, photobiology, photophysics, and analytical spec-
troscopy. Examples include:

• Studying changes in long wave absorption of dye molecules 
upon modification of substituent groups

• Studying metal-ligand charge-transfer spectra

• Assigning UV-visible absorption transitions in terms of the 
orbitals involved in the transition

• Predicting triplet-triplet absorption spectra

• Calculating S1 - T1 energy gap to assess rate of intersystem 
crossing.

To compute UV visible spectra:

1. Choose a semi-empirical or ab initio method and select Singly 
Excited as the option for CI.

You will need to specify at least one occupied and at least one 
unoccupied orbital, or an energy criterion that is at least as 
large as the HOMO-LUMO gap, in the CI Options dialog box. 
Otherwise you will get no spectrum. In general, as you include 
more orbitals or increase the energy criterion, the calculation 
will take longer but the spectrum will be more accurate.

2. Choose Single Point on the Compute menu.

HyperChem performs an SCF calculation to obtain the refer-
ence electronic configuration associated with the singlet 
ground state of your molecule. Next, HyperChem generates a 
series of singly excited configurations, computes the Hamilto-
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nian matrix elements between them, and then diagonalizes 
the matrix to get the spectrum of electronic states.

3. When the calculation finishes, choose Electronic Spectrum on 
the Compute menu.

This opens the Electronic Spectrum dialog box. Two sets of 
lines (transitions) appear in the dialog box. The top set shows 
all the excited electronic states (both singlet and triplet); the 
bottom set shows only states that are spectroscopically active 
and their relative intensities.

4. L-click on a different line or use the [1] and [2] keys to cycle 
through the transitions.

To store UV visible spectra:

If you wish to save UV-visible results after closing the Electronic 
Spectrum dialog box, see “Export . . .” on page 63. Alternately, you 
can run the sample script saveuv.scr (see “Open Script” on page 75 
for information on running scripts). This will create another script 
file that you can later open to restore the saved UV-visible results 
into HyperChem.

Note: Some guidelines for CI singlet calculations are provided in 
“Configuration Interaction Dialog Box” on page 200 and in Hyper-
Chem Computational Chemistry. We suggest that you review those 
guidelines before computing UV visible spectra.

Once the spectrum has been calculated it will be shown in the 
Electronic Spectrum dialog box. 

Electronic Spectrum Dialog Box

Use the Electronic Spectrum dialog box to display and analyze the 
UV-visible spectrum produced by a singly excited CI calculation. 
This dialog box is available only after you do a single point CI 
semi-empirical or ab initio calculation. Electronic Spectrum is then 
activated on the Compute menu.

Transitions in the spectrum are represented as vertical lines con-
tained in a spectral display, with the wavelengths marked along the 
top of the display. The top set of lines represents all the excited 
electronic states (both singlet and triplet), and the bottom set rep-
resents only states that are spectroscopically active. 

Suggestion: You can capture an image of the Electronic Spectrum 
dialog box by using Setup Image on the Tool/Preferences menu to 
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set Window to Top level (see page 69), activating the Electronic 
Spectrum dialog box and then pressing [F9] to capture the image. To 
get black lines on white background for the spectrum, set Window 
to White and Bond to Black in the Preferences dialog box (see 
page 65). You can also use the “Copy” button (described below) in 
this dialog box.

.

Wavelength Numbers in the upper left- and right-hand corners 
of the display show the limits of the currently dis-
played spectrum.

Zoom Moving the Zoom scroll button to the right nar-
rows the wavelength range of the display. The 
value at the left-hand edge of the display remains 
fixed regardless of the Zoom position.

Oscillator
Strength

The scale of the oscillator strength (intensity) is 
indicated at the upper and lower left-hand corners 
of the spectral box.

Pan Scrolls the display left or right. You can pan the 
display by L-clicking on the Pan scroll button, or 
by L-clicking on the scroll bar and pressing the left 
or right arrow keys.

Transition Shows the transition number of the currently 
selected transition. Transitions are ordered from 
longest wavelength to shortest wavelength (left to 
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right). You can select a transition by entering the 
number of the transition in this box. 

Degeneracy Specifies the degeneracy of the excited state corre-
sponding to the selected transition.

Spin
multiplicity

This is the total spin multiplicity, 2S+1, where S is 
the total electron spin of the system. Each 
unpaired electron counts for 1/2. A closed-shell 
system (singlet) has a multiplicity of 1. A doublet 
or triplet state has a multiplicity of 2 and 3, respec-
tively. 

Wavelength The wavelength (nm) of the selected transition.

Oscillator
Strength

A dimensionless quantity that is proportional to 
the intensity of the selected transition.

Copy This copies a bitmap picture of the Electronic Spec-
trum dialog box to the Clipboard. See also the 
“Suggestion” just before the picture of the dialog 
box.

To show various characteristics of individual transitions, L-click 
inside the display and the spectral box is highlighted with a violet 
line. Then select individual transitions by L-clicking on a line or by 
using the arrow keys on the keyboard. The options in the dialog 
box show the characteristics of the selected line.

Practical Guidelines

If you are studying the electronic spectra of conjugated organic 
molecules, such as dyes, it is often sufficient to include only a few 
orbitals in the CI. For instance, if you are calculating the UV visible 
spectrum of p-amino-benzoic acid, the wavelength of the two 
intense lines in the UV spectroscopic range (approximately 200 
nm to 350 nm) is calculated just as accurately using two occupied 
and two unoccupied orbitals as using 10 of each. The extra orbitals 
yield more lines in the high-energy region (beyond the range of 
UV spectrometers) but do not affect the lines of interest, which are 
those at longer wavelengths. As with many computational meth-
ods, trends and differences are given more accurately than abso-
lute values. ZINDO/S calculations on several substituted benzenes 
underestimate the wavelength of the major UV absorption by 
about 20 nm, but the relative values are very well reproduced.
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Absorption lines for transitions that are electronically forbidden— 
but vibrationally allowed—do not appear in the Electronic Spectra 
dialog box. For example, d-d transitions in metals do not show 
intensity in HyperChem’s UV visible calculations. 

A CI singlet calculation using a singlet state as a reference yields 
both singlet and triplet eigenstates as output. If a doublet reference 
state is used, then both doublet and quartet eigenstates are output.

The accuracy of the computed spectrum depends on the size (i.e., 
orbital active space) of the configuration interaction singlet calcu-
lation.

Since CI calculations are longer than SCF level calculations, the 
size of molecules may be a limiting factor.

Saving Information in a Log File

When you compute UV-visible spectra, you can obtain additional 
information about the excited state properties by using Start log on 
the File menu. When QuantumPrintLevel=0 in the Start Log dialog 
box, the log file saves the following information for UV-visible 
spectra calculations:

• Absolute energy in eV for the reference configuration

• Excitation energy in cm-1 for the excited states

• Dipole moments in Debyes

• Transition dipole for each possible excitation

• Intensities for each possible excitation

• Energies and gradient

• Eigenvalues of the reference configuration 
(the orbital energies)

• Atomic orbital electron populations

• Net charges and coordinates

Cancel 

You can choose Cancel on the menu bar or press [Esc] when Hyper-
Chem is directing a chemical calculation or when it is reading in a 
structure from a file. When you L-click on Cancel, there might be 
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a short delay before the process ends and HyperChem is fully 
active again.

During a calculation or reading a file, all menu items are gray and 
inactive except for Cancel. You can use only the HyperChem tool 
icons to translate or rotate molecules, to zoom, or to adjust the 
clipping slab. 
290



Drawing Molecules
Chapter 8

Constructing Molecules

HyperChem provides two methods for constructing new mole-
cules:

• The Drawing tool sketches molecules from individual atoms. 
Use this tool to position atoms, choose elements, and connect 
atoms by covalent bonds. The HyperChem Model Builder can 
then convert these drawings into 3D molecular structures.

• HyperChem provides databases of residues for constructing 
proteins, polynucleotides (including RNA and DNA), and 
equilibrated water environments.

You can also use molecular structures from other sources, stored in 
files. For example, HyperChem interprets and displays PDB files 
(see page 319) that contain detailed structures of proteins and 
nucleic acids.

Drawing Molecules

Using the HyperChem Drawing tool (see “Drawing Tool” on page 
28), you can sketch the atoms in a molecule, connecting them 
with covalent bonds. You can then use HyperChem’s Model 
Builder to convert a 2D drawing into a 3D model, with realistic 
bond lengths, bond angles, and torsion angles. 

To draw a new molecule, you can either start with an empty work-
space or add the new molecules to a molecular system already in 
the workspace. 
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Adding Atoms and Bonds

To draw a molecule:

1. Choose Default Element on the Build menu. In the Element 
Table dialog box (see page 83), L-click on the element for draw-
ing. For example, you can start to draw with carbon atoms, 
then change to another element when needed.

2. From the Element Table dialog box, turn on Allow ions (3) if 
you need to add more than the normal number of bonds to an 
atom. You can add up to twelve bonds per atom. Turn on 
Explicit hydrogens (3) if you want to add hydrogen atoms while 
drawing. If not, HyperChem can automatically add hydrogens 
later, when you use the Model Builder.

3. L-click on the Drawing icon and move the Drawing tool into 
the workspace.

4. To create individual atoms, L-click anywhere in the workspace.

5. To remove an atom, R-click near the atom. 

6. To create two singly bonded atoms, L-drag, then release the 
mouse button.

drawing tool icon

drawing tool
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7. To add another bond and atom, L-click near any atom, L-drag, 
and release the mouse button.

8. While adding atoms, change the default element as needed. 
You can also change the element after adding an atom (see 
“After Drawing” on page 294).

9. To specify the chirality or local conformation of an atom, 
[Shift]+L-click on one of its bonds (see “Using Wedges to Display 
and Specify Stereobonds” on page 300). You can also 
[Shift]+L-click on an atom to change the chirality of that atom 
after model building (see “Changing Chirality” on page 303).

Note: The maximum number of atoms that you can add is 32,767 
less the number of molecules and residues., structural restraints, 
etc.

Removing Atoms

To remove atoms and bonds:

1. L-click on the Drawing tool icon to activate the tool.

2. Position the Drawing tool on a bond or atom that you want to 
remove.

3. R-click on an atom. This removes the atom and its bonds to 
other atoms. If you R-click on a single bond, HyperChem 
removes the bond and any atoms connected only through this 
bond.

Changing the Drawing Element

Normally, the Drawing tool places only heavy (nonhydrogen) 
atoms in a molecule. You choose the heavy atom (from helium 
through lawrencium) from the Element Table dialog box. Your 
choice is the default element. To see the Element Table dialog box, 
double-click on the Drawing icon or choose Default Element on the 
Build menu.

Caution: You can use any elements from the periodic table for 
drawing. However, the Model Builder (see page 85) might not pro-
vide appropriate bond lengths or angles for all atoms.
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While Drawing

You can change the default element any time while drawing by 
changing the choice in the Element Table dialog box: 

To change the default element:

1. Double-click on the Drawing icon, choose a new element from 
the Element Table dialog box.

2. Move the Drawing tool into the workspace and continue draw-
ing. The next atoms you add are the new default element.

Note: Single clicking on an element in the Element Table dialog 
box will change the default element and leave the dialog box 
open. Double clicking on an element will change the default ele-
ment and dismiss the dialog box. Shift-clicking on an element will 
bring up the Element Properties display for that element. Clicking 
on the Properties button will display the properties of the default 
element.

After Drawing

To change an element after drawing a molecule:

1. From the Element Table dialog box, choose a different ele-
ment. For example, if you drew your molecule with carbon as 
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the default element and you want to change a carbon to an 
oxygen, click on oxygen in the dialog box.

2. With the Drawing tool, L-click on the atom to change. The 
atom changes to the new default element.

Note: You can change atoms in 2D drawings or, after using the 
Model Builder, in 3D structures.

Element Properties

If you shift-click on an element button in the Element Table dialog 
box, the Element Properties box will appear. This shows physical 
properties of the element that you selected. Alternately, if you click 
on the Properties button of the Default Element dialog box, the 
properties of the default element will be displayed.

This does not change the default drawing element.

Changing the Bond Order

HyperChem first draws single, covalent bonds. Using the Drawing 
tool, you can change these bonds to double, triple, or aromatic 
bonds. 

To change the order of individual bonds:

• To create a double bond, L-click on any single bond with the 
Drawing tool.

• To create a triple bond, L-click on a double bond. 

• To create a conjugated bond, double-click on any bond.

• To create an aromatic ring, double-click on any bond in the 
ring.
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• To decrease the order of any bond (conjugated to single; 
triple to double; double to single), R-click on it. 

• To remove a single bond and any atom connected only 
through that bond, R-click on the bond. 

To change bonds by using your mouse:

Note: You can change the order of bonds in 2D drawings or, after 
using the Model Builder, in 3D structures.

If Show Multiple Bonds on the Display menu is on (3), you see the 
order of the bonds in the molecular structure as single, double, tri-
ple, or dotted lines. If Show Multiple Bonds is off, all bonds appear 
as single lines. If you change the bond order, the new bond order 
appears on the status line.

Adding Hydrogen Atoms

You can draw hydrogen atoms or let HyperChem do this for you. 

To add hydrogens during drawing, turn on Explicit Hydrogens in 
the Element Table dialog box (3) or on the Build menu (3). As you 
use the Drawing tool, the first two atoms appear, as hydrogens. 

single bond

double bond

triple bond

no bond

R-clickL-click

conjugated
 

 R-click

any
 

double-click

bond

bond

single
bond
296 Chapter 8



Drawing Molecules
When you add a third atom, the second atom changes to the 
default element. The Drawing tool, with Explicit Hydrogens on, fol-
lows this simple rule: singly bonded atoms appear as hydrogens; 
multiply bonded atoms appear as the default element. 

With Explicit Hydrogens on, Add H & Model Build (on the Build 
menu) changes to Model Build. The Model Builder does not auto-
matically add more hydrogens. 

Note: To draw a hydrogen with more than one bond, choose 
hydrogen as the default element and turn on Allow Ions.

If you draw atoms with Explicit Hydrogens on, you can later choose 
Add Hydrogens on the Build menu to fill in the hydrogens you did 
not add manually. 

To draw only heavy atoms, use the Drawing tool with Explicit 
Hydrogens off. HyperChem automatically adds hydrogens and 
then creates a 3D chemical structure when you use the Model 
Builder (Add H & Model Build on the Build menu).

Cutting and Pasting Atoms

Use Cut, Paste, and Copy on the Edit menu to move or duplicate 
atoms (see “Build Menu” on page 79). You can move atoms within 
a HyperChem window or between different HyperChem windows.

Cut

Cut moves the selected atoms from the workspace to the Clip-
board, replacing previous contents of the Clipboard. You can then 
use Paste to copy the atoms back to the workspace. 

draw with

Explicit 
Hydrogens on

draw with

Explicit 
Hydrogens off
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Note: Cut removes selected atoms and all bonds connecting these 
atoms to each other and to the rest of the molecular system. 

Copy

Copy places a duplicate of selected atoms onto the Clipboard, 
replacing the previous contents of the Clipboard. You can use 
Paste to copy the atoms back to the workspace. 

Note: Copy duplicates selected atoms and the bonds connecting 
these atoms. It does not remember the bonds between this selec-
tion and the rest of the molecular system.

Paste

Paste copies the contents of the Clipboard to the workspace. The 
atoms from the Clipboard appear a few Ångstroms away from the 
center of mass of the molecular system previously in the work-
space.

Cut

selected atoms
(appear in Thick line)
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Note: Paste is not the exact reverse of Cut. Cut removes selected 
atoms and all bonds connecting these atoms to each other and to 
the molecular system. Paste provides only the atoms and the 
bonds connecting these atoms to each other.

Changing Molecular Conformation

HyperChem provides several ways of changing the conformation 
of a molecule, either before or after using the Model Builder:

• The Set items on the Edit menu (see “Build Menu” on page 79) 
change a selected bond length, bond angle, or torsion angle 
(see “Selecting” on page 32). These changes are immediate 
when you L-click on OK. The Model Builder or a geometry 
optimization calculation might change these adjustments.

• The Constraints items on the Build menu (see “Build Menu” on 
page 79) provide instructions to the Model Builder to produce 
these configurations. The Model Builder adds these constraints 
to its list of rules as it constructs a 3D structure.

• The Restraints options for molecular mechanics calculations 
(see “Restraint Forces Dialog Box” on page 224) limit the con-
formation of selected atoms during a molecular mechanics cal-
culation.

• The Drawing Tool can be used to turn bonds into dashed or 
solid wedges (for “bond down” or “bond up”) by [Shift]+L-click-
ing on them. The Model Builder uses these wedges to help it 

Paste Paste
again

selected atoms
appear in 
Thick lines
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determine positions for atoms (see “Using Wedges to Display 
and Specify Stereobonds” on page 300).

• The Drawing tool can also be used to change chirality of atoms 
after model building by [Shift]+L-clicking on them.

• Invert and Reflect on the Edit menu can transform a molecule 
or a set of atoms.

Using Wedges to Display and Specify Stereobonds

The stereochemistry feature of HyperChem lets you display bonds 
as wedges. Wedges always correspond to stereochemistry builder 
constraints used to enforce a specific arrangement of neighbors 
about a center when the Model Builder is invoked. However, 
wedges can be used for purely visual purposes as well. Wedges 
serve two functions: 

• To provide you with 3D depth perspective information about 
bonding arrangements.

• To allow you to assign builder constraints so that you can 
build the structure with a specified stereochemistry or confor-
mation.

In the first case you can simply display the wedges to show the cur-
rent stereochemical bonding relationships. You do not modify the 
structure.

In the second case you use the wedges to assign a constraint, and 
you invoke the Model Builder to build (or rebuild) the structure 
with the assigned stereochemistry or conformation. An exclama-
tion mark is shown on a wedge when the current conformation is 
different than the restraint that you have specified with the wedge.

To use wedges:

1. Choose Rendering on the Display menu to open the Rendering 
dialog box. Choose Sticks and check Wedges, then L-click on 
OK.

2. L-click on the Drawing tool icon to get into Drawing mode.

3. Place the Drawing Tool over a bond between two atoms each 
with at least three neighbors, hold down the [Shift] key, and L-
click.
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If one of the atoms has two or less neighbors only two types of 
wedges are possible. If both bonded atoms have two or less 
neighbors, wedges cannot be used on that bond.

4. Continue [Shift]+L-clicking to cycle through the four possible 
wedges. 

As you cycle through the wedges, notice that at least two have 
exclamation marks. At this point if you want to change the ste-
reochemistry to correspond with the wedge, you must invoke 
the Model Builder. Otherwise, if you’re satisfied with the ste-
reo-chemistry of the bond, cycle to either of the two wedges 
that appear without exclamation marks; these refer to the cur-
rent stereochemistry. (If your system is planar, all wedges will 
be shown with exclamation marks.)

5. Double-click on the Select Tool icon to invoke the model 
builder. Notice that any exclamation marks have disappeared 
because the restraints have now been satisfied by the Model 
Builder.

If you rotate the molecule, the dashed wedges become solid 
wedges and vice versa. Their appearance changes according to 
their orientation with respect to the viewer (the plane of the work-
space).

Wedges Explained

HyperChem displays two types of stereochemistry wedges: solid 
and dashed. A stereo wedge, which is drawn between two atoms 
instead of the normal rendering of a bond, specifies a stereochem-
istry builder constraint describing the arrangement of neighbors 
about one of the atoms. In every case, the atom at the “point” of 
the wedge is the atom whose stereochemistry is being specified. 
Thus the wedge 

out in out in

A B
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specifies the stereochemistry about atom A. It does not describe 
the arrangement of neighbors about atom B. This would be 
expressed by some other wedge whose point was at atom B. If a 
wedge (either solid or dashed) is displayed with an exclamation 
mark “!”, the stereochemistry constraint is not currently satisfied. 
It will be satisfied after invoking the model builder.

Solid wedges mean “bond up” (out of the screen), while dashed 
wedges mean “bond down” (behind the screen).

For Atoms with Four Neighbors

Start by looking at the central atom and its four neighbors as dis-
played on screen (these five atoms are displayed in the plane of the 
screen). If one of the bonds is a solid wedge with its point at the 
central atom, imagine that

• the central atom is in the plane of the screen, 

• the wedge neighbor is coming out of the screen, and

• the three other (nonwedge) neighbors are back, behind the 
screen. 

This imagined arrangement specifies the stereochemistry. Remem-
ber, if the wedge is annotated with an “!”, the constraint is not cur-
rently satisfied (perhaps because the current geometry is planar).

Of course, for a dashed wedge, you must imagine that the wedge 
bond points back behind the screen, while the others point out of 
the screen (toward you).

For Atoms with Three Neighbors

Once again, start with the planar screen coordinates displayed for 
the central atom and its three neighbors. In this case of only three 
neighbors, there is some yet-to-be-provided fourth neighbor—
probably a hydrogen, or a lone pair in the case of a central nitro-
gen. To visualize the meaning of a wedge with its point directed at 
this central atom, imagine that this missing fourth neighbor has 
exactly the same screen position as the wedge neighbor. That is, 
this missing atom is directly in front of or directly behind the 
wedge neighbor. Now, there are four neighbors, including one 
that is imaginary. Apply the procedure in the previous section for 
four neighbors.
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Changing Chirality

HyperChem can interactively change the chirality of an atom if 
two of its neighbors can be freely swapped.

To interactively change chirality:

1. L-click on the Drawing tool icon to get into Drawing mode.

2. Place the Drawing Tool over the atom whose chirality you 
wish to change, hold down the [Shift] key, and L-click.

This rotates two of the neighbors around the axis midway between 
their bonds to the atom. This rotation will occur even if the center 
atom is not chiral. You can check this by using colors or displaying 
atom indexes (by selecting Numbers for Atoms in the Labels dialog 
box) and noting that neighbors swap when you [Shift]+L-click on 
the central atom.

If the neighbors cannot be swapped, with fused rings for instance, 
you must use wedges and the model builder to change chirality.

To change chirality using wedges:

1. Choose Rendering on the Display menu to open the Rendering 
dialog box. Choose the Sticks property sheet and check Wedges, 
then L-click on OK.

2. L-click on the Drawing tool icon to get into Drawing mode.

3. Place the Drawing Tool over a bond involving the atom whose 
chirality you wish to change, hold down the [Shift] key, and L-
click until a wedge with an exclamation mark appears.

4. Double-click on the Selection tool to invoke the Model 
Builder.

The Model Builder will try to preserve any existing chirality of 
other centers when you use it.

Both Invert and Reflect on the Edit menu can also be used to change 
the chirality of atoms, but you cannot always change atoms inde-
pendently. Inversion takes place through a selection that you 
name as POINT and reflection takes place through a selection that 
you call PLANE. You define POINT or PLANE by using Name Selec-
tion on the Select menu (see page 147). 
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To change chirality using Invert or Reflect:

1. Select atoms in a molecular system.

2. Choose Name Selection on the Select menu and name this 
selection either POINT or PLANE.

3. Deselect all atoms.

4. Select the atoms to invert or reflect. Without a selection, 
HyperChem acts on the whole molecular system.

5. Choose Invert or Reflect on the Edit menu.

Converting 2D Drawings into 3D Structures

HyperChem’s Model Builder uses predetermined bond lengths, 
bond angles, and torsion angles to estimate the 3D structure of a 
molecular system or of selected atoms.

While building a 3D structure, the Model Builder evaluates the 
chirality of every atom. You can label chiral centers R or S by using 
Labels on the Display menu.

The Model Builder gives you approximate structures. It cannot 
anticipate the diversity of all chemical compounds and might pro-
duce inaccurate structures for some ring systems, or for com-
pounds containing less common elements. In these cases, use the 
Model Builder first to construct an approximate structure. Then do 
a geometry optimization calculation to find a better conforma-
tion. 

POINT selection

chiral atom (S)

chiral atom (R)

deselect POINT

and Invert
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The Model Builder does not add charges (ionic or partial) to mole-
cules. You can add charges to selected atoms by using Set Charge 
on the Build menu. Or, you can use a semi-empirical or ab initio 
quantum mechanical calculation to determine atomic charges (see 
“Single Point” on page 237).

Incremental Model Building

The Model Builder works on selected atoms. You can use this fea-
ture to Model Build only part of a molecular system. For example, 
you can add a group or a separate molecule to a system that already 
has an optimized structure (for example, a molecule after a geom-
etry optimization calculation or a residue from a database) and 
then Model Build only the new atoms.

Caution: Select only functional groups or larger units to reduce the 
possibility of building stressed or abnormal configurations.

Building Inorganic Structures

The maximum number of neighbors that the Model Builder can 
handle is 12. This is particularly useful for building inorganic 
structures, such as ferrocene. 

To see this modeling capability, try the following exercise:

1. On the Build menu, turn on Allow Ions.

Model Builder
Constructing Molecules 305



Converting 2D Drawings into 3D Structures
2. Draw the following 2D structure:

3. Connect all remaining carbon atoms to the central carbon 
atom and add two more carbon atoms, as shown in the follow-
ing illustration:
306 Chapter 8



Converting 2D Drawings into 3D Structures
4. Make sure the two newly added C—C bonds are double bonds.

5. Change the central carbon atom to iron, and change the two 
nonring carbons to sulfur atoms. The 2D structure should now 
look like this:

6. Double-click on the Selection tool to invoke the Model Builder.

HyperChem builds the following 3D structure:
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(If your 3D structure doesn’t appear as shown in the previous illus-
tration, use the Rotation tool to reorient the molecule.)

If you wish to include the hydrogen atoms, you must draw them 
onto the rings explicitly before or after you use the Model Builder.

This demonstrates how easily HyperChem can build a molecule 
with a highly coordinated metal center.

Building Molecules from Residues

HyperChem provides databases containing residues for construct-
ing proteins, polynucleotides, and water environments (solva-
tion). The Databases menu (“Databases Menu” on page 98) con-
tains items for constructing polypeptides and polynucleotides. 
Periodic Box on the Setup menu (see “Periodic Box” on page 219) 
supplies equilibrated water molecules to fill a periodic box.

Residues with standard geometries are stored in database files (TPL 
files for amino and nucleic acids, and BIN files for water). As you 
construct polymers, you can automatically incorporate standard 
secondary and tertiary structures, or use your own specifications 
for conformations. 
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Proteins and nucleic acids from PDB files are also composed of res-
idues. You can use the methods described in this section to modify 
those molecules.

The Databases Menu

Use the items on the Databases menu to construct or modify pro-
teins and nucleic acids. 

The first three items, Amino Acids, Make Zwitterion, and Remove 
Ionic Ends control the building of proteins. The second group of 
items, Nucleic Acids and Add Counter Ions, provide the tools for 
constructing polynucleotides, both single and double stranded. 
The last item, Mutate, changes a residue in an existing protein or 
polynucleotide.

See “Databases Menu” on page 98 and the corresponding dialog 
boxes in chapter 3 for more information on using these menu 
items.

Proteins

To construct a protein, choose Amino Acids on the Databases 
menu. You see the Amino Acids dialog box with choices of resi-
dues.

For a definition of each residue in this dialog box, see “Amino 
Acids Dialog Box” on page 100.

The Amino Acids dialog box also gives you choices for the second-
ary conformation of each residue that you add. You can choose 
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from standard conformations (Alpha or Beta) or devise your own 
conformation (Other) with specific torsional angles. You can also 
add D-amino acids instead of normal L-amino acids.

Constructing a Protein

Proteins are constructed from the N-terminus to the C-terminus. 
To build a new protein, you must start with one of these condi-
tions: 

• An empty workspace.

• A workspace containing proteins with a C-terminal blocking 
group or in the zwitterionic form. Both conditions block elon-
gation of the existing proteins and force HyperChem to start a 
new polymer.

• A workspace containing any molecules except unblocked pro-
teins (see above) constructed from a database or from a PDB 
file. 

To build a new protein:

1. Choose Amino Acids on the Databases menu. You see the 
Amino Acids dialog box. You can move this dialog box to one 
side of the workspace so that you can watch HyperChem 
construct a new polymer. While this dialog box is on screen, 
you can use menu items and tools.

2. From the Conformation side of the dialog box, L-click on Alpha, 
Beta, or Other. L-click on Isomer: D or L. These choices affect 
each added amino acid until you make new choices. Once you 
add a residue, you cannot use this dialog box to change its con-
formation. 

3. L-click on Ace if you want an N-terminal cap. If not, go to 
step 4.

4. L-click on the first amino acid residue. 

5. L-click on the rest of the residues. You can get ahead of 
HyperChem, but it will catch up with you. Remember to 
change the conformation of each amino acid before you choose 
it.

6. L-click on Nme if you want a C-terminal cap. This cap prevents 
you from adding more residues.
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Cross-linking with Cyx

HyperChem provides half-cystine residues (Cyx) for disulfide 
cross-links. As you construct a polypeptide, place the Cyx residues 
in the correct primary sequence. Then use the Drawing tool to 
form a disulfide bond between the Cyx residues. To adjust the 
length of this bond and the conformation of the polypeptide, use 
a geometry optimization calculation.

Choosing Conformations

Each amino acid that you add to a polypeptide can have a different 
secondary conformation. In this way, the polypeptide can have 
stretches of alpha-helical structure, beta-pleated sheet structure, 
and other transitional conformations. 

For Other, you can use angles from –180 to +180 degrees. Omega, 
the torsion around the peptide bond, is usually close to 180 
degrees, or trans.

You can also choose D-amino acids instead of the usual L-isomer.

Creating Zwitterions

At neutral pH, polypeptides exist in solution as zwitterions, with
–NH3

+ and –COO– terminal groups. When you construct polypep-
tides with HyperChem, the ends are incomplete (–N–H and –C–O). 
Make Zwitterion on the Databases menu completes the ends 
(–NH3

+ and –COO–). 

If the ends of a polypeptide are modified or capped, you cannot 
convert it into a zwitterion. If a polypeptide exists as a zwitterion, 

geometry

optimization

bond drawn to connect CYX 
residues (about 11Å)

optimized disulfide bond 
(about 2Å)
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you cannot add more amino acid residues to an existing polypep-
tide or start new polypeptides in the same molecular system.

Use Remove Ionic Ends on the Databases menu to reverse Make 
Zwitterion.

Mutating Amino Acids

Use Mutate on the Databases menu to change one amino acid to 
another in a polypeptide. The polypeptide must come from the 
Databases menu, or a PDB or MOL2 file.

To mutate an amino acid:

1. Choose Residues on the Select menu. This lets the Selection 
tool act on whole residues if they are present in a molecular 
system.

2. Select one residue in a protein. 

3. Choose Mutate on the Databases menu. 

4. From the Mutate dialog box (see “Mutate Dialog Box” on page 
110), choose a new residue. Then L-click on OK. HyperChem 
substitutes the new residue for the selected residue.

To change the conformation of amino acids after they are in a 
polypeptide, you must select individual torsional angles (see 
“Selecting” on page 32) or restrain the torsion to a new angle (see 
“Restraint Forces Dialog Box” on page 224). Alternatively, you can 
use Set Bond Torsion on the Edit menu (see page 132), and calculate 
a new optimal geometry (see “Geometry Optimization” on page 
239).

Adding Unusual Residues

You can add more residues to the Amino Acids dialog box. The 
information for a residue comes from a template (TPL) file (see 
“Residue Template Files” on page 527). Whenever you use a resi-
due in this dialog box or when you open a PDB file, HyperChem 
interprets the structure of residues by using information in a TPL 
file. See page 538 for how to write a new entry. The new residue 
can appear as a choice (a button) in the Amino Acids dialog box.
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Nucleic Acids

To construct a polynucleotide, choose Nucleic Acids on the Data-
bases menu. You see the Nucleic Acids dialog box with a choice of 
nucleic acid residues. For a definition of each residue in this dialog 
box, see “Nucleic Acids Dialog Box” on page 106.

The Nucleic Acids dialog box also has choices for the secondary 
conformation of each residue that you add. You can choose from 
standard conformations (A, B, or Z) or devise your own conforma-
tion with specific torsional angles. You can also change the pucker 
of the furanose ring in each residue (Sugar Form), and the number 
of strands (single or double). 

At the start of polymerization, you can choose to begin at the 3′ 
end (Backward), to add nucleotides to the 5′ end, or to begin at the 
5′ end (normal direction of biosynthesis).

Constructing a Polynucleotide

To build a new polynucleotide, you must start with one of these 
conditions: 

• An empty workspace.

• A workspace containing polynucleotides with a 3′ or a 5′ block-
ing group (3CAP or 5CAP). Either of these groups block elonga-
tion of the existing nucleic acid (depending on the direction of 
polymerization) and force HyperChem to start a new polymer.
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• A workspace containing any molecules except unblocked 
nucleic acids (see above) constructed from a database or from 
a PDB file. 

To build a new polynucleotide:

1. Choose Nucleic Acids on the Databases menu. You see the 
Nucleic Acids dialog box. You can move this dialog box to a 
side of the workspace to watch HyperChem construct the new 
polymer. While this dialog box is on screen, you can use any 
menu items or tools.

2. Choose the direction of polymerization before you begin a 
molecule: L-click on Backward (5) to begin from the 3′ end. No 
check mark means that HyperChem starts at the 5′ end. If you 
change the direction of polymerization after you start a mole-
cule, HyperChem begins a new molecule.

3. From the Conformation side of this dialog box, you can make 
these choices for each residue before you add it:

•  A Form, B Form, Z Form, or Other. 

• HyperChem automatically chooses 3′ Endo (Sugar Form) 
for A Form, or 2′ Endo for B and Z Forms. You can choose 
the alternate sugar pucker. 

• Double Stranded (3) for adding the next residue plus its 
hydrogen-bonded complement.

These choices affect each added nucleic acid until you make 
new choices. Once you add a residue, you cannot use this dia-
log box to change its conformation. 

4. L-click on the first nucleic acid residue.

5. L-click on the other residues. You can get ahead of 
HyperChem, but it will catch up with you. Remember to 
change the conformation of each residue before you choose it.

Note: You can mix deoxyribose and ribose nucleotides. You can 
also mix single- and double-strand structures to form partially 
base-paired molecules.

6. L-click on 3CAP or 5CAP if you want to block further polymer-
ization at the growing end of this polymer.
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Choosing Conformations

Each nucleic acid residue that you add to a polynucleotide can 
have a different conformation. In this way, the polynucleotide can 
have stretches of A form DNA, B form, Z form, or another confor-
mation that you choose. 

A and B forms of DNA are normally right-hand helices, while the 
Z form is a left-hand helix. To change the direction of a helix after 
constructing it, use Reflect on the Edit menu to connect the helix 
into its mirror image. You can reflect around any PLANE in the 
molecular system.

You can also change the conformation of the deoxyribose or the 
ribose sugar in each residue. The A form of DNA normally contains 
deoxyribose sugar in the more stable C2′–endo form. The B form 
of DNA form contains the C3′–endo sugar. 

Adding Counter Ions

HyperChem can supply sodium counter ions to balance the posi-
tive charge on each phosphate group in a polynucleotide. When 
you choose Add Counter Ions on the Databases menu, HyperChem 
places one Na+ ion 1.688 Ångstroms equidistant from each oxygen 
atom in a phosphate group (see page 109).

Use counter ions for chemical calculations of polynucleotides in 
water (see “Periodic Box” on page 219).

If you choose Add Counter Ions and then add more residues, only 
the original residues have counter ions. Choose Add Counter Ions 
again to add Na+ ions to the new residues.

Use Clear or Cut on the Edit menu to remove Na+ ions.

If you store the system in a HIN file, the file also contains the 
counter ions. The Na+ ions appear at the end of the HIN file as sep-
arate molecules, with mol and atom records for each Na+ ion.

Mutating Nucleic Acid Residues

Use Mutate on the Databases menu to change one residue to 
another in a polynucleotide from the Databases menu, or from a 
PDB or MOL2 file.
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To mutate a nucleic acid residue:

1. Choose Residues on the Select menu. The Selection tool acts on 
whole residues if they are present in a molecular system.

2. Select one residue in a polynucleotide. 

3. Choose Mutate on the Databases menu. 

4. From the Mutate dialog box (see “Mutate Dialog Box” on page 
110), choose a new residue. Then L-click on OK. HyperChem 
substitutes the new residue for the selected residue.

Note: The Mutate dialog box provides nucleotide residues in addi-
tion to those in the Nucleic Acids dialog box. These additional res-
idues have optimized structures but lack atomic charge informa-
tion.

To change the conformation of nucleic acid residues after they are 
in a polymer, you select individual torsional angles (see “Select-
ing” on page 32), restrain the torsion to a new angle (see “Restraint 
Forces Dialog Box” on page 224), and calculate a new optimal 
geometry (see “Geometry Optimization” on page 239). 

Creating Unusual Base Pairs

To build a polynucleotide with unusual base pairing:

1. Choose Double Stranded in the Nucleic Acids dialog box.

2. Choose one of the residues in the pair. For example, choose rU. 
This adds rU-rA.

3. Set the Selection tool to the Residues level. 

4. Select the incorrect residue. For example, select rA. To help 
find rA, you can turn on Residue Name labels in the Labels dia-
log box.

5. Choose Mutate on the Databases menu and then choose a res-
idue to replace the incorrect residue. For example, choose rU 
to replace rA. This produces an rU–rU pair.
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Adding Unusual Residues

You can add more residues to the Nucleic Acids dialog box. The 
information about residue comes from TPL files. Whenever you 
use a residue in this dialog box or open a PDB file, HyperChem 
interprets the structure of residues using information in a TPL file. 
See page 538 for how to write a new entry. The new residue can 
appear as a choice (a button) in the Nucleic Acids dialog box.

Water Molecules

HyperChem can place a molecular system in a periodic box con-
taining water molecules. These are standard TIP3P models of water 
molecules equilibrated at 300 K (25°C) and one atmosphere. With-
out the periodic box, HyperChem assumes that molecules are in a 
vacuum. You can use a distance-dependent dielectric constant in 
calculations to simulate the effect of a solvent (see “Force field 
Parameters Dialog Box” on page 231). 

Since these water molecules have special properties and come from 
a database, HyperChem treats them like residues. You can select 
individual water molecules with the Selection tool, which you 
should set to Residues (see “Residues” on page 137).

Choose Periodic Box on the Setup menu to add water molecules, 
along with periodic boundary conditions (see “Periodic Box” on 
page 219), to a molecular system.

If you apply a label to these residues (see “Labels” on page 176), it 
might appear as HOH or WAT, depending on the source of the 
molecular system.
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Chapter 9

Protein Data Bank Files

Structures of proteins and nucleic acids are available in PDB files.1 
These structures are derived from physical studies of molecules (for 
example, x-ray diffraction or nuclear magnetic resonance (NMR) 
analyses). HyperChem can interpret and display structures stored 
in all PDB files that contain atomic coordinates, and can also store 
new molecular structures in PDB-type files.

Obtaining PDB Files

The HyperChem distribution disks contain several sample PDB 
files. You can obtain the complete PDB collection, containing 
about 700 structures, from the Brookhaven National Laboratory, 
or one of its 10 affiliated distribution centers. For information, 
contact:

Protein Data Bank
Brookhaven National Laboratory
Chemistry Department, Bldg. 555
Upton, NY, USA
Telephone: 516-282-3629
FAX: 516-282-5815

The complete data bank requires about 150 MB of disk storage 
space. It is supplied on a 150 MB, 1/4-inch tape in compressed 
UNIX® tar format. To use these files on your PC, you must read the 
tapes on a suitable UNIX workstation (for example, a Sun™ or a 
Silicon Graphics® IRIS™) and then transfer the files to your PC.

The PDB database is also available via anonymous ftp from: 
ftp.pdb.bnl.gov  .

1. PDB files are compiled at the Brookhaven National Laboratory with support from the United States
National Science Foundation, the United States Public Health Service, and the United States Depart-
ment of Energy. 
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Reading PDB Files

HyperChem can read all PDB files that contain atomic coordi-
nates, up to the limit of the computer memory. HyperChem uses 
the PDB information on atomic coordinates, plus the information 
in its own TPL files (see page 527), to reconstruct standard amino 
acid and nucleic acid residues. For HETATM records and atoms 
that are not included in TPL files, HyperChem uses atomic coordi-
nates and CONECT records from the PDB file to reconstruct a 
molecular system. 

HyperChem expects that PDB files will follow the formatting stan-
dards described by the maintainers of the PDB archive. Some soft-
ware creates “PDB” files that do not follow this format properly; 
for example, the data entries on a line of the file may be in the 
wrong columns, or shifted left or right within a section. If you use 
the script command “non-standard-pdb-names = yes ”, 
HyperChem will attempt to make allowances for incorrect format-
ting. Use of this command may prevent correct reading of files 
which do conform to the standards.

Most PDB files contain all the information that is necessary for 
HyperChem to regenerate the structure. However, if a PDB file 
includes non-standard residues which are not in HyperChem’s 
template files, but does not include information about bonding 
and/or hydrogen atoms, then HyperChem will not be able to pro-
cess the structure properly. If the file does not have bonding infor-
mation, you will probably end up with a number of disconnected 
atoms in the workspace which you will have to connect to form 
molecules. (See “Using the Z-Matrix File Filter” on page 55.) If the 
file does not include hydrogen atoms, you can add them with 
Build/Add Hydrogens (see page 84).

Warning: HyperChem’s internal storage of structures requires that 
residues within molecules be numbered sequentially starting from 
1. Many PDB files include structures whose residue numbers start 
with values other than 1, and/or have gaps in the numbering. 
Therefore, the residue numbering in the original file may be differ-
ent from the numbering in HyperChem when a PDB file is read in. 
If you save the structure in the PDB format, the residue numbering 
will correspond to HyperChem’s internal storage numbering, and 
so may not be the same as the numbering in the original file.
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Creating PDB-type Files

You can save any molecular system in the workspace as a PDB-type 
file. Choose Save As on the File menu and L-click on PDB in the 
Save File dialog box. 

HyperChem provides the filename extension .ent, but you have to 
enter a new filename in the File Name text box. The PDB file can 
contain 13 types of records (each record has a title and takes up 
one line in the file):

HEADER
COMPND
SOURCE
AUTHOR
REVDAT
JRNL

These are all comment records from a PDB file that 
you can enter or edit in the Save File dialog box. 

Caution: Comments must adhere to the format 
described in the PDB document, Atomic Coordi-
nates and Bibliographic Entry Format Description, 
July, 1989.

REMARK Comments from a HIN file, entered in the Save File 
dialog box.

SSBOND Residues involved in disulphide bridges.

ATOM The identity and coordinates of each heavy atom 
in the molecular system. These atoms must be part 
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of the standard set of residues that HyperChem 
recognizes (see page 534 and page 536).

HETATM The identity and coordinates of all heavy atoms 
that are not part of standard residues. Standard res-
idues belong to the set that HyperChem recognizes 
(see page 534 and page 536).

CONECT The numbers of atoms directly bonded to each 
other. These numbers come from the ATOM or 
HETATM records. The Numbers label (Choose 
Labels on the Display menu) also uses these num-
bers. CONECT records appear for HETATMs and for 
all atoms if you choose the Connectivity option (see 
below).

TER A record marking the end of a chain.

END The end of the file.

HyperChem has two options for storing PDB-type files. If you store 
files with both options off (no 3), the file contains only REMARK, 
ATOM, HETATM, and END records for heavy atoms. These are the 
options:

Hydrogens With this option on (3), the file also contains 
ATOM records for all hydrogen atoms.

Connectivity With this option on (3), the file also contains 
CONECT records.

The FillPDBRecords setting in the Registry or in chem.ini can 
require HyperChem to fill each record with spaces, to a total of 70 
characters (see “Ab Initio Settings” on page 544).

Sample PDB Files

HyperChem provides these sample PDB files1:

1. These files are for public use, courtesy of the Protein Data Bank. To obtain other files, see “Obtaining
PDB Files” on page 319.

Filename Molecule

PDB1BNA DNA, B form, single stranded, 290K Daltons
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PDB1CRN Crambin

PDB3CYT Cytochrome C, albacore, oxidized

PDB2EST Elastase-TFAP complex, porcine

PDB1F19 IGG, FAB portion, mouse

PDB1FDX Ferredoxin

PDB1GCN Glucagon

PDB2PTC Trypsin-trypsin inhibitor complex

PDB5PTI Pancreatic trypsin inhibitor

PDB4RHV Rhinovirus 14, human

PDB6TNA Transfer RNA, yeast phenylalanine

PDB1XY1 Deamino-oxytocin, wet form

Filename Molecule
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Chapter 10

Scripts and DDE

HyperChem provides facilities for these tasks: 

• Running HyperChem automatically, with scripts, to easily 
repeat functions and analyses.

• Integrating HyperChem with your own software and with 
other commercial software. 

Automatic Operation with Scripts

You can use a small program, called a script, to send instructions 
to HyperChem. These instructions automatically run specific 
HyperChem activities. For example, you can automate a molecular 
dynamics calculation so that you can repeat it easily. 

A script reproduces most interactive HyperChem functions, plus a 
few functions that are not yet available with HyperChem.

You write the instructions in a script file using a text editor, like 
Windows Notepad. You start a script by using the Script menu in 
HyperChem. 

Integrating HyperChem with DDE

You can easily integrate other programs that also run with 
Microsoft Windows with HyperChem. HyperChem retains its 
integrity and functions, while other programs can request infor-
mation, send instructions, and collect HyperChem results for their 
own use.

Programs communicate with HyperChem using the Windows 
Dynamic Data Exchange (DDE).
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Using HyperChem Messages

HyperChem has a unified set of messages for directing its internal 
operations and for communicating with other programs. When 
you use HyperChem menus and dialog boxes, HyperChem selects 
and uses the correct message. 

When you use a script file, HyperChem reads the messages in that 
file and acts on them. If you are communicating with another pro-
gram, the DDE commands use some HyperChem messages as argu-
ments and generate other HyperChem messages.

HyperChem uses two classes of messages for scripts and DDE com-
mands:

IMSG An input message is a request to HyperChem to 
change a variable, carry out a function, or respond 
with information.

OMSG An output message is a response that HyperChem 
provides, including information on settings, calcu-
lation results, and error messages. An OMSG goes 
to the screen (by default), to a file, or to the pro-
gram requesting the information via DDE.

Types of Input Messages

HyperChem has three types of input messages (IMSG):

Variable A variable (also known as a HyperChem State Vari-
able, or HSV) describes a setting in HyperChem. 
Variables usually have arguments (see page 327). 
There are two subtypes of variable messages:

Set HSV Changes (writes) a variable.

Get HSV Requests (reads) the current setting for a 
variable. HyperChem responds with an 
OMSG.

Command This starts a HyperChem function. A Command 
message includes arguments (see page 332). This is 
usually equivalent to using a Menu Activator, 
choosing options in a dialog box, and then L-click-
ing on OK.
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Menu 
Activator

This is equivalent to choosing an item on a 
HyperChem menu. It often produces an on-screen 
dialog box for choosing options.

Message Syntax

Messages are not case-sensitive; use any combination of upper- 
and lowercase letters. Where the syntax shows a space, use one or 
more spaces or a comma. Parentheses and quotes are optional.

Variables

Set HSV and Get HSV messages have slightly different syntax:

Set HSV <Variable-name> = <argument>

argument = string, integer, float, Boolean, enum, or 
a combination of these. If there are spaces or com-
mas in string arguments, you can enclose them in 
quotes or parentheses. The equals sign is optional.

Get HSV <Variable-name> ?
or
query-value <Variable-name>

These two statements are equivalent. However, a 
variable name with arguments can use only a 
query-value statement.

Separate a variable-name and ? with a space.

Important: Define all variables before the commands that require 
these variables. If you do not set a required variable, HyperChem 
uses the last value for that variable. 

Examples:

optim-algorithm steepestdescents

This sets the algorithm for a geometry optimization calculation to 
steepest descent.

show-perspective ?

or

query-value show-perspective
Scripts and DDE 327



Using HyperChem Messages
These both request the setting for Show Perspective: on or off? 
HyperChem sends a response, yes or no, to the screen (by default), 
to a file, or to the program requesting the information via DDE.

query-value coordinates(2, 1)

This requests the Cartesian coordinates for atom 2 in molecule 1. 
Notice that you cannot use a question mark instead of the query-
value statement, since this variable requires arguments. 

coordinates (2, 1) =0.0,0.0,0.0

This changes (writes) the x, y, and z coordinates of atom 2 in mol-
ecule 1 to 0.0, 0.0, and 0.0. 

file-format hin
open-file benzene.hin

These two lines from a script file set the file format variable to hin, 
then use the open-file command to read the file, benzene.hin. 

multiple-selections yes
selection-target atoms
select-atom 7 1
select-atom 8 1

The first two lines from this script set variables for selection. The 
next two lines are commands that select atoms 7 and 8 in 
molecule 1.

selection-target molecules
 select-atom 3 1

The first line sets the selection level to molecules. This takes prior-
ity over the atom selection command in the next line. HyperChem 
selects the entire molecule 1 instead of only atom 3 in molecule 1.

Behavior of array variables

Array variables are those specified by indices, such as 
coordinates(i,j), the coordinates of atom i in molecule j, or 
ir-intensity(i), the intensity of peak i. Arrays are handled rather 
differently in HyperChem scripts and require care in their use.

Atom Indices

First, an array index is commonly the index of an atom. In Hyper-
Chem, these indices, which would normally be a single index, i, 
become a pair of indices — molecule index and atom index. For 
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simplicity here, we denote these two indices — the atom index in 
a particular molecule and the particular molecule index — as a sin-
gle index, [i], although these must always be written in an actual 
script as two indices,

[i] ≡ k,l

Two-dimensional Arrays

Thus, for example, the coordinates of an atom ought perhaps to be 
assigned as:

coordinates( [i], 1 ) = 10.0
coordinates( [i], 2 ) = -5.0
coordinates( [i], 3 ) = 20.0

where coordinates is a two-dimensional array with the first index 
being the atom index and the second index being the direction = 
1 ... 3 for x, y, z. In HyperChem, however, two-dimensional arrays 
are never assigned or queried with two such indices. One always 
leaves off the second pre-defined index and instead assigns or que-
ries with a list,

coordinates( [i] ) = 10.0, -5.0, 20.0
coordinates( [i] ) ?

Two-dimensional arrays, such as coordinates, can be queried all at 
once,

coordinates ?

They may also be assigned without an index as in the following 
assignment for a two atom molecule, such as H2,

coordinates = 0.0, 0.0, 0.0, 0.0, 0.0, 0.74

One-dimensional Arrays

One-dimensional arrays have a single index with a range that may 
be pre-defined to a read-only value, such as atom-count, or with a 
range that is assignable (read/write), such as the one dimensional 
array, ir-frequency, with a range, ir-band-count.

Both types of one-dimensional arrays are assignable using an 
index,

atom-charge( [3] ) = 0.5
ir-frequency(2) = 2076
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or without an index using a list with a required length determined 
by the range,

atom-charge = 0.0, 0.0, 0.5, -0.5
ir-frequency = 1723, 2076

One-dimensional arrays with assignable ranges are referred to by 
the script command print-variable-list as vectors.

The vectors in HyperChem are:

range: ir-band-count

ir-frequency
ir-intensity
ir-intensity-components
ir-normal-mode

range: uv-band-count

uv-dipole-components
uv-energy
uv-oscillator-strength
uv-spin
uv-total-dipole
uv-transition-dipole

range: named-selection-count

named-selection-name
named-selection-value

range: selected-atom-count

selected-atom

range: orbital-count

alpha-scf-eigenvector
beta-scf-eigenvector
scf-orbital-energy

range: graph-horizontal-grid-size

graph-data-row

range: molecule-count

residue-count
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range: 10

script-menu-caption
script-menu-checked
script-menu-command
script-menu-enabled
script-menu-help-file
script-menu-help-id
script-menu-in-use
script-menu-message

The following is an example of the usage and syntax for a vector.

Example:

First declare the size of the vector:

ir-band-count = 5

Next, assignment can be performed using one of the following 
three methods:

Method 1:

ir-frequency(1) = 100
ir-frequency(2) = 170
ir-frequency(3) = 200
ir-frequency(4) = 210
ir-frequency(5) = 213

Method 2:

ir-frequency = 100, 170, 200, 210, 213

Method 3:

ir-frequency = 100 170 200 210 213

Values for a vector variable can be obtained in the following man-
ner:

query-value ir-frequency

ir-frequency ?

Both the above inquiries will yield the following results based on 
the previous assignments.

ir-frequency(1) = 100
ir-frequency(2) = 170
ir-frequency(3) = 200
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ir-frequency(4) = 210
ir-frequency(5) = 213

Individual vector components can be queried in the following 
manner:

query-value ir-frequency(2)

ir-frequency(2) ?

Both the above inquiries will yield the 2nd component of the ir-
frequency vector.

You can obtain continual notification of all coordinates in a script 
by sending the command “notify-on-update coordinates”, but 
you cannot notify-on-update for a single atom’s coordinates. The 
DDE equivalent of notify-on-update is a hot, or automatic link, 
and only the whole array may be addressed in these links. Beware, 
however: in some cases the output may be voluminous.

Commands

Command messages can have one or more arguments, each sepa-
rated by at least one space or a comma:

<request-name> <argument> <argument> . . . 

argument = string, integer, float, Boolean, enum, or a combina-
tion of these. Enclose a string in quotes (“ “) when there are 
spaces between arguments.

request-name = command name

Examples:

open-file benzene.hin

This request opens the file benzene.hin.

execute-client graph.exe Graph Form1

This is a request to start and run another DDE application. 
Graph.exe is the filename for the DDE application. “Graph” is the 
name of the application. “Form1” is the topic, either a filename or 
some unit of information, that the application recognizes.

Arguments

The types of arguments for variables or commands are the follow-
ing:
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Boolean Yes or no, true or false, 0 or 1.

string Text (letters, characters, or symbols, in upper- or 
lowercase, unlimited number of characters). 
Enclose a string in quotes (“ ”) if it contains 
spaces, tabs, or newline characters. If a string with 
quotes includes a backslash (“\”), you must double 
the backslash (“\\”). Thus, a path might be speci-
fied as ”C:\\Program Files\\Hypercube” . 
(You do not need to double the backslash if the 
string is not enclosed in quotes.) In a string with 
quotes, you can designate a newline character as 
“\n”.

filename A type of string requiring a DOS filename.

enum A type of string requiring one of a limited set of 
possibilities.

int An integer.

float A floating point (decimal) number. For an angle, 
the number is in degrees.

Some Get HSV statements (requesting a variable) require only a 
subset of the possible arguments. For example, setting the atom-
name variable requires all arguments (atom number, molecule 
number, and atom name), but requesting the variable requires 
only the atom number and molecule number. HyperChem 
responds with all three variables.

Menu Activators

Menu activators are text strings with hyphens between each word. 
Every menu activator starts with “menu-.”

menu-<menu-name>-<item-name>

Example:

menu-edit-zoom

This requests the Zoom item on the Edit menu. You see the result 
of choosing this item, the Zoom dialog box, on screen.
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HyperChem Messages

The following tables list all variables, commands, and menu acti-
vators organized according to menu item, dialog box, and func-
tion. Use these messages to write scripts or as arguments in DDE 
commands.

The numbers in the first column of each table are used in an alpha-
betic cross-reference to all messages (see “Message Cross-Refer-
ence” on page 397).

For specific discussions of scripts and DDE, with examples, see 
page 413 and page 415.
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File Menu

# File Variable Type R/Wa Use 

1 current-file-name filename R The filename corresponding to the 
molecular system displayed in the 
workspace

2 path string R, W Current directory

3 file-format enum 
(hin, pdb, skc, 
ml2, zmt, 
mol, chm)

R,W The file format for a molecular sys-
tem 

4 file-needs-saved Boolean R,W Yes to save the molecular system if 
it contains changes since it was read 
in or if it is new

5 velocities-in-hin-file Boolean R,W Yes to store atom velocities in a HIN 
file

6 view-in-hin-file Boolean R, W Should view be written into a HIN 
file? (Useful for comparing HIN files)

7 hydrogens-in-pdb-
file

Boolean R,W Yes to include hydrogen coordi-
nates in a PDB file

8 connectivity-in-pdb-
file

Boolean R,W Yes to include connectivity informa-
tion (CONECT records) in a PDB file

9 non-standard-pdb-
names

Boolean R,W Enables HyperChem to read some 
PDB files, produced by other pro-
grams, which do not properly con-
form to the PDB specifications.  In 
particular, it allows the use of left-
justified atom names. This may pre-
vent correct reading of standard-
conforming files.

10 window-color enum 
(mono-
chrome or a 
colorb)

R,W The background color for the 
HyperChem workspace; mono-
chrome results in a white back-
ground with bonds in color or black
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11 bond-color enum 
(byelement or 
a colorb)

R,W The color used for drawing all 
atoms (and bonds). Byelement uses 
a color based on the atomic num-
ber set in the Element Color dialog 
box (on the Display menu)

12 selection-color enum 
(thickline or 
a colorb)

R,W Assigns a color or bond appearance 
to differentiate atoms while they are 
selected

13 positives-color (a colorb) R, W Color for positive orbital lobes, con-
tour lines, occupied orbitals, etc.

14 negatives-color (a colorb) R, W Color for negative orbital lobes, 
contour lines, unoccupied orbitals, 
etc.

15 x-y-rotation-cursor float 
(>0 . . ≤3600)

R,W The amount of XY rotation, in 
degrees, for a drag from one edge 
of the workspace to the other

16 reorder-
selections

Boolean R, W Yes to reorder atoms in selections to 
create proper angles; no to give 
user direct control over atom order

17 translate-merged-
systems

Boolean R, W Yes to translate newly 
merged/pasted structures so that 
they do not overlap

18 z-rotation-cursor float 
(>0 . . ≤3600)

R,W The amount of Z rotation, in 
degrees, for a horizontal drag from 
one edge of the workspace to the 
other

19 export-dipole Boolean R, W Whether or not to export dipole 
moment data to .EXT file.

20 export-ir Boolean R, W Whether or not to export IR spectral 
data to .EXT file.

21 export-orbitals Boolean R, W Whether or not to export orbital 
data to .EXT file.

# File Variable Type R/Wa Use 
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22 export-uv Boolean R, W Whether or not to export UV spec-
tral data to .EXT file.

23 import-dipole Boolean R, W Whether or not to import dipole 
moment data from .EXT file.

24 import-ir Boolean R, W Whether or not to import IR spec-
tral data from .EXT file.

25 import-orbitals Boolean R, W Whether or not to import orbital 
data from .EXT file.

26 import-uv Boolean R, W Whether or not to import UV spec-
tral data from .EXT file.

27 z-translation-cursor float 
(>0 . . ≤1000)

R,W The amount of Z translation, in 
Ångstroms, for a horizontal drag 
from one edge of the workspace to 
the other

28 zoom-cursor float 
(>1 . . ≤1000)

R,W The amount of magnification for a 
vertical drag across the workspace

29 clip-cursor float 
(>0 . . ≤1000)

R,W The amount of clipping plane 
movement, in Ångstroms, for a 
drag vertically across the workspace

30 x-y-rotation-icon-
step

float 
(>0 . . ≤3600)

R,W The amount of XY rotation, in 
degrees, from a shift-click at the 
extreme edge of the Tool icon

31 z-rotation-icon-step float 
(>0 . . ≤3600) 

R,W The amount of Z rotation, in 
degrees, from a shift-click at the 
extreme edge of the Tool icon

32 x-y-translation-icon-
step

float 
(>0 . . ≤1000)

R,W The amount of XY translation, in 
Ångstroms, from a shift-click at the 
extreme edge of the Tool icon

33 z-translation-icon-
step

float 
(>0 . . ≤1000)

R,W The amount of Z translation, in 
Ångstroms, from a shift-click at the 
extreme edge of the Tool icon

# File Variable Type R/Wa Use 
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34 zoom-icon-step float 
(>1 . . ≤1000)

R,W The amount of magnification from 
a shift-click at the extreme edge of 
the Tool icon

35 clip-icon-step float 
(>0 . . ≤1000)

R,W The amount of clipping plane 
movement, in Ångstroms, from a 
shift-click at the extreme edge of 
the Tool icon

36 translate-whole-
molecules

Boolean R,W Yes to translate only whole mole-
cules. This prevents translating indi-
vidual atoms of a molecule and 
distorting the structure. No lets you 
translate selected atoms in larger 
molecules

37 use-fast-
translation

Boolean R,W Yes to increase the speed of XY 
translation by temporarily substitut-
ing a bitmapped image of the 
molecular system

38 printer-background-
white

Boolean R,W Yes to force printer background 
color to white. No to use the cur-
rent window color

39 image-source-
window

enum 
(toplevel, 
workspace, 
hyperchem, 
fullscreen)

R,W Sets the extent of the image cap-
tured with “edit-menu-copy-
image”

40 image-file-bitmap Boolean R,W Yes to save an image in bitmapped 
format

41 image-file-
bitmapRGB

Boolean R, W Yes to save bitmap pictures in 24-
bit color instead of 8-bit color

42 image-file-metafile Boolean R,W Yes to save an image in metafile for-
mat

# File Variable Type R/Wa Use 
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a. R = read only. R,W = read and write.
b. Choose one for color: black, blue, green, cyan, red, violet, yellow, white.

43 image-destination-
file

Boolean R,W Yes to save an image in chem.bmp 
and/or chem.wmf, depending on 
the settings of the previous two 
variables

44 image-destination-
clipboard

Boolean R,W Yes to save an image to the 
Clipboard

45 image-include-
cursor

Boolean R,W Yes to include the cursor in an 
image

46 image-color Boolean R,W Yes to save an image in color

File Command Arguments Use

47 open-file filename Opens a file containing a molecular system

48 merge-file filename Opens a file containing a molecular system 
and adds this system to a molecular system 
already in the workspace

49 write-file filename Stores the current molecular system in a 
file

50 print none Print to default printer

51 start-logging filename, Boolean Starts recording HyperChem results in log 
filename. Yes = append data to file of the 
same name. No = replace file

52 stop-logging none Stops recording HyperChem results in a log 
file

53 log-comment string Stores comment (string) in an active log 
file

# File Variable Type R/Wa Use 
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54 import-property-file filename Reads quantum mechanics data (dipole 
moment, orbital data, IR and/or UV/vis 
spectra) from the named file

55 export-property-file filename Wrties quantum mechanics data (dipole 
moment, orbital data, IR and/or UV/vis 
spectra) to the named file

56 delete-file filename Delete the file specified by filename with-
out giving any warning message

57 file-diff-message filename1, 
filename2, 
string1, string2

Compare the contents of filename1 with 
those of filename2; report string1 if the 
files are the same and string2 if they are 
different

# File Menu Activator Use Dialog Box

58  menu-file-new Clears the workspace —

59  menu-file-open Opens a file Open File

60  menu-file-merge Merges a file into the workspace Merge File

61  menu-file-save Updates the file the system was read 
from

Save File, if cur-
rent system is 
untitled; other-
wise, saves file 
without show-
ing dialog box

62  menu-file-save-as Saves the system in a different file Save As...

63  menu-file-start-log Starts logging computation results in 
a file

Open Log

64  menu-file-stop-log Stops logging —

65  menu-file-log-comments Stores a comment in the active log file Log Comments

File Command Arguments Use
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66 menu-file-export Saves the results of quantum 
calculations, including IR and 
UV/visible spectra

Export 
Properties

67 menu-file-import Imports values of quantum 
calculations, including IR and 
UV/visible spectra

Import 
Properties

68  menu-file-print Prints an image of the system Print

69  menu-file-preferences Customizes the program Preferences

70 menu-file-exit Exits HyperChem —

# File Menu Activator Use Dialog Box
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Edit Menu

a. R = read only. R,W = read and write.

# Edit Variable Type R/W a Use 

71 front-clip float 
(≥0 . . ≤3200)

R, W The distance in Ångstroms of the 
front clipping plane from the 
viewer. Must be at least 1 less than 
back-clip value

72 back-clip float 
(≥0 . . ≤3200)

R, W The distance in Ångstroms of the 
back clipping plane from the 
viewer. Must be at least 1 more 
than front clip value

73 mouse-mode enum (draw-
ing, selecting, 
rotating, 
zrotating, 
translating, 
ztranslating, 
zooming, 
clipping)

R, W The function of the cursor (tool) in 
the workspace

# Edit Command Arguments Use

74 align-molecule enum1, enum2, 
enum3, enum4
(enum1 and 3 = 
primary, 
secondary, 
tertiary;
enum2 and 4 =
x, y, z, line)

Aligns the inertial axes of selected atoms or 
a whole molecular system with the 
Viewer’s Coordinate System, or with a LINE 
in the Molecular Coordinate System. 
Enum1 and enum2 describe the major 
alignment. Enum3 and enum4 describe 
the optional minor alignment

75 align-viewer enum 
(x, y, z, line)

Aligns a viewer’s z coordinate with an axis 
or with a LINE in the Molecular Coordinate 
System

76 delete-selected-
atoms 

none Deletes selected atoms. Equivalent to 
menu-edit-clear
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77 rotate-viewer enum, float
(enum = x, y, z, 
line)

Rotates the viewer around (axis = x, y, z, or 
LINE) by angle in degrees

78 rotate-molecules enum, float
(enum = x, y, z, 
line)

Rotates molecules around (axis = x, y, z, or 
LINE) by angle in degrees

79 translate-view float1, float2, 
float3
(≥0 . . ≤3200)

Translates the viewer (in the Viewer’s Coor-
dinate System) by a change in coordinates 
(dx, dy, dz), in Ångstroms

80 translate-selection float1, float2, 
float3
(≥0 . . ≤3200)

Translates the selection in the Molecular 
Coordinate System to coordinates x, y, and 
z 

81 zoom float
(≥0.01. . ≤50)

Sets the magnification of the current 
molecular system. A value of 1.0 fits the 
whole molecular system into the work-
space and corresponds to Scale to Fit (on 
the Display menu)

82 set-bond-length float
(>0 . . ≤3200)

Sets the bond length for the selected bond

83 set-bond-angle float
(≥0 . . ≤180)

Sets the bond angle for the selected angle

84 set-bond-torsion float
(≥–360 . . ≤360)

Sets the torsion angle for the selected 
torsion

# Edit Menu Activator Use Dialog Box

85 menu-edit-clear Deletes the selection —

86 menu-edit-cut Deletes the selection and places a copy 
of the molecular structure on the Clip-
board

—

# Edit Command Arguments Use
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87 menu-edit-copy Copies the selection to the Clipboard —

88 menu-edit-copy-isis-
sketch

Copies the selection to the Clipboard in 
ISIS Sketch format

—

89 menu-edit-paste Copies the Clipboard’s contents to the 
workspace

—

90 menu-edit-copy-image Copies the image of the molecular sys-
tem to the Clipboard

—

91 menu-edit-setup-image Sets up the image copying process 
(type of image)

Setup Image

92 menu-edit-invert Inverts the selection through POINT —

93 menu-edit-reflect Reflects the selection through PLANE —

94 menu-edit-rotate Rotates the selection or the viewer Rotate

95 menu-edit-translate Translates the selection or the viewer Translate

96 menu-edit-zoom Changes the magnification Zoom

97 menu-edit-z-clip Changes the Z clipping Z Clip

98 menu-edit-align-viewer Aligns the viewer’s z axis Align Viewer

99 menu-edit-align-
molecules 

Aligns the inertial axis of a molecule(s) Align Molecules

100 menu-edit-set-bond-
length 

Changes a bond length Set Bond Length

101 menu-edit-set-bond-
angle 

Changes a bond angle Set Bond Angle

102 menu-edit-set-bond-
torsion 

Changes a torsion angle Set Bond Torsion

# Edit Menu Activator Use Dialog Box
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Build Menu

a. R = read only. R,W = read and write.

# Build Variable Type R/W a Use 

103 explicit-
hydrogens

Boolean R, W Allows the Drawing tool to add hydro-
gens. If yes, all single bonded atoms 
are hydrogens. If no, Drawing tool 
places only the default element (usu-
ally a heavy atom)

104 default-element int 
(0 . . 103) 

R, W The atomic number of the default ele-
ment for drawing. 0 = lone pair

105 allow-ions Boolean R, W Allows excess valence on atoms. If yes, 
you can add up to12 bonds to any 
atom. If no, each element has its nor-
mal limit of valence electrons

106 builder-enforces-
stereo

Boolean R, W Specifies whether the Model Builder 
implicitly enforces existing stere-
ochemistry.

# Build Command Arguments Use

107 set-atom-type string Provides the type (string) for a selected set of 
atoms in the active force field. Use only a type 
that the force field recognizes. Use the correct 
upper- and lowercase characters for atom 
types (for example CA, not ca or Ca)

108 set-atom-charge float
(≥-100 . .≤ 100)

Provides the charge (float) for a selected set of 
atoms

109 create-atom int
(0 . . 103)

Draws an atom, with atomic number int, at the 
origin of the Molecular Coordinate System

110 delete-atom int1, int2 Deletes atom int1 from molecule int2
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111 set-bond int1, int2, int3, 
int4, enum 
(n, h, s, d, t, a)

Draws a bond between atom int1 in molecule 
int2 and atom int3 in molecule int4. The bond 
order is n = none (deletes an existing bond), h 
= hydrogen, s = single, d = double, t = triple, 
and a = aromatic

112 constrain-
geometry

enum (none, 
linear, trigonal, 
tetrahedral, 
square-planar,
bipyramidal, 
octahedral) or 
computed

Constrains the bonding to a selected atom 
during model building. None removes existing 
constraints

113 constrain-bond-
length

float 
(>0 . . ≤100)
or computed

Constrains a bond length between two 
selected atoms during model building. 
Computed removes a constraint and uses 
the Model Builder’s default bond length

114 constrain-bond-
angle

float 
(≥–360 . . ≤360) 
or computed

Constrains a bond angle between three 
selected atoms during model building. 
Computed removes a constraint and uses 
the Model Builder’s default bond angle

115 constrain-bond-
torsion

float 
(≥–360 . . ≤360) 
or computed

Constrains a bond torsion angle between four 
selected atoms during model building. 
Computed removes a constraint and uses the 
Model Builder’s default torsion angle

116 unconstrain-
bond-length

none Remove any length constraint on the two 
currently selected atoms

117 unconstrain-
bond-angle

none Remove any angle constraint on the three 
currently selected atoms

118 unconstrain-
bond-torsion

none Remove any torsion constraint on the four 
currently selected atoms

119 remove-stereo-
constraint

int1, int2 Removes any stereo constraints from atom 
number int1 into molecule int2

# Build Command Arguments Use
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120 remove-all-
stereo-
constraints

int1, int2 Removes all stereo constraints

121 constrain-bond-
up

int1, int2,
int3, int4

Constrains a bond to be up. The bond is the 
one from atom int1 in molecule int2 to atom 
int3 in molecule int4

122 constrain-bond-
down

int1, int2,
int3, int4

Constrains a bond to be down. The bond is the 
one from atom int1 in molecule int2 to atom 
int3 in molecule int4

123 constrain-fix-
stereo

int1, int2 Constrains atom to enforce the current stere-
ochemistry about atom int1 in molecule int2

124 constrain-change-
stereo

int1, int2 Constrains atom to change the current stere-
ochemistry about atom int1 in molecule int2

125 cycle-bond-
stereo

int1, int2,
int3, int4

Advances the stereo constraint along a bond. 
The bond is the one from atom int1 in mole-
cule int2 to atom int3 in molecule int4

126 cycle-atom-
stereo

int1, int2 Advances the stereo constraint about atom 
int1 in molecule int2

127 change-
stereochem

int1, int2 Immediately change the existing stereochemis-
try about atom int1 in molecule int2

# Build Menu Activator Use Dialog Box

128 menu-build-explicit-
hydrogens 

Toggles explicit hydrogens for 
drawing

—

129 menu-build-default-
element 

Changes the default element for 
drawing atoms

Default Element

130 menu-build-
add-hydrogens 

Adds hydrogens to fill the atoms’ 
valences 

—

# Build Command Arguments Use
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131 menu-build-model-build Transforms a 2D drawing into a 3D 
chemical structure

—

132 menu-build-allow-ions Toggles restrictions on excess 
valence

—

133 menu-build-united-
atoms 

Removes hydrogens to form united 
atoms

—

134 menu-build-all-atoms Restores hydrogens to united 
atoms

—

135 menu-build-calculate-
types 

Assigns atom types for the chosen 
force field

—

136 menu-build-
compile-type-rules 

Compiles the chem.rul file into a 
binary file (typerule.bin)

—

137 menu-build-set-atom-
type 

Sets the atom type for selected 
atoms

Set Atom Type

138 menu-build-set-charge Sets the charge on selected atom Set Atom Charge

139 menu-build-set-mass Sets the mass of selected atom Set Atom Mass

140 menu-build-constrain-
geometry 

Constrains the geometry for bonds 
to a selected atom

Constrain 
Geometry

141 menu-build-constrain-
bond-length 

Constrains the distance between 
two selected atoms

Constrain Bond 
Length

142 menu-build-constrain-
bond-angle 

Constrains the bond angle 
between three selected atoms

Constrain Bond 
Angle

143 menu-build-constrain-
bond-torsion 

Constrains the torsion angle of four 
selected atoms

Constrain Bond 
Torsion

# Build Menu Activator Use Dialog Box
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Select Menu

a. R = read only. R,W = read and write.

# Select Variable Type R/W a Use 

144 selection-target enum 
(molecules, 
residues, atoms)

R, W The level of selection or the 
smallest unit of selection

145 selected-atom-
count

int R Reports the number of atoms 
selected

146 selected-atom int1, int2, int3 R When you give the number of 
the selected atom (int1), using 
this variable reports the 
sequence number of this atom 
(int2) in molecule number int3

147 multiple-selections Boolean R, W Yes to accumulate selections, or 
no to cancel the previous selec-
tion with each new selection

148 select-sphere Boolean R, W Yes for group selection with a 
3D sphere, or no for group 
selection with a 2D rectangle

149 named-selection-
count

int R The count of the named 
selections

150 named-selection-
name

int, string R When you give the number of a 
named selection (int), using this 
variable gives the name of that 
selection

151 named-selection-
value

int1, float R The (read only) “value” of num-
ber int1 named selection. The 
“value” is the x, y, and z coordi-
nates for 1-atom selections, the 
distance for 2-atom selections, 
angle for 3, torsion for 4, and 
“(nil)” for anything else

152 selection-value float R The value of the current selec-
tion (bond, angle, etc.)
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a. Honors multiple-selections (variable) value (yes or no).
b. To select a molecule—for example; molecule 3—use selection-target molecules, and then select-
atom. Use a similar procedure with un-select-atom to deselect a molecule.

# Select Command Arguments Use

153 select-none none Deselects all atomsa

154 select-name string Selects the atoms with the selection name = 
stringa, where string has at least one lowercase 
character (up to 19 total) and no spaces

155 select-atom int1, int2 Selects atom int1 in molecule int2. Honors cur-
rent selection level (see selection-target vari-
able)a,b

156 un-select-atom int1, int2 Deselects atom int1 in molecule int2. Honors 
current selection level (see selection-target 
variable)a,b

157 select-residue int1, int2 Selects residue int1 in molecule int2. Disregards 
current selection level, always selecting a residue 
if present. If there is no residue, reports an error 
(see selection-target variable)a

158 un-select-residue Int1, int2 Deselects residue int1 in molecule int2. Disre-
gards current selection level and always deselects 
a residue if present. If there is no residue, reports 
an error (see selection-target variable)a

159 name-selection string Gives a name to the current selection. String = 
POINT, LINE, PLANE (in all uppercase) or any set 
of characters (not all uppercase) up to 19 charac-
ters long

160 delete-named-
selection 

string Removes a named selection from the list of 
named selections

# Select Menu Activator Use Dialog Box

161 menu-select-atoms Sets selection level to “Atoms” —
350 Chapter 10



HyperChem Messages
162 menu-select-residues Sets selection level to “Residues” —

163 menu-select-molecules Sets selection level to “Molecules” —

164 menu-select-multiple-
selections

Toggles accumulation of selections —

165 menu-select-select-sphere Toggles between 2D and 3D group 
selection

—

166 menu-select-select-all Selects all visible atoms in the molec-
ular system

—

167 menu-select-complement-
selection

Complements the current selection —

168 menu-select-select Selects atoms by an assigned name 
or number

Select

169 menu-select-name-
selection

Assigns a name to the current selec-
tion

Name Selection

170 menu-select-extend-ring Extends selection to an entire ring —

171 menu-select-extend-side-
chain

Extends a selection to a side chain —

172 menu-select-extend-to-sp3 Extends a selection to sp3-sp3 single 
bonds and singly bonded atoms

—

173 menu-select-select-
backbone

Selects all atoms in the backbone of 
a polymer built from residues

—

# Select Menu Activator Use Dialog Box
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Display Menu

# Display Variable Type R/W a Use 

174 show-perspective Boolean R, W Yes to display molecules in 
perspective, or no for a planar 
projection

175 show-stereo Boolean R, W Yes to display molecules as a ste-
reo pair, or no for a single model

176 wall-eyed-stereo Boolean R, W Yes sets the stereo pair for wall-
eyed viewing; select no for 
crosseyed viewing

177 show-ribbons Boolean R, W Yes displays a protein backbone 
with ribbons

178 render-method enum (sticks, 
balls, balls-and-
cylinders, 
spheres, dots, 
sticks-and-dots)

R, W The rendering method for the 
display

179 balls-shaded Boolean R, W Whether balls and balls-and-cyl-
inders should be shaded instead 
of being solidly colored

180 balls-highlighted Boolean R, W Whether balls and balls-and-cyl-
inders should be highlighted 
when shaded

181 balls-radius-ratio float (0 . . 1) R, W Size of the balls relative to the 
maximum value

182 spheres-shaded Boolean R, W Whether spheres should be 
shaded instead of being solidly 
colored (as disks)

183 spheres-highlighted Boolean R, W Whether spheres should be 
highlighted when shaded

184 sticks-width integer (0 . . 25) R, W Sticks rendering width in pixels
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185 cylinders-width-
ratio

float (0 . . 1) R, W Size of the cylinders relative to 
the maximum value

186 cylinders-color-by-
element

Boolean R, W Color cylinders using element 
colors (yes) or gray (no).

187 grid-min-value real R The minimum value in the grid 
of quantum mechanical data

188 grid-max-value real R The maximum value in the grid 
of quantum mechanical data

189 isosurface-threshold real
(grid-min-value 
≤ isosurface-
threshold ≤ 
grid-max-value)

R, W Sets the value of the isosurface 
of the quantum mechanical 
grid data to render

190 isosurface-render-
method

enum (wire-
mesh, 
Jorgensen-
Salem, lines, 
flat-surface, 
shaded-surface, 
Gouraud-
shaded-surface, 
translucent-
surface)

R, W Rendering method used to draw 
isosurfaces

191 isosurface-
transparency-level

float (0 . . 1) R, W The level of transparency of the 
isosurface (0 = opaque, 1 = 
transparent)

192 isosurface-hide-
molecule

Boolean R, W Hide the structure while an isos-
urface is being displayed

193 dot-surface-angle float angle 
(≥–90 . . ≤90)

R, W The angle of planes in a dot ren-
dering relative to the XZ plane 
of the Viewer’s Coordinate Sys-
tem

# Display Variable Type R/W a Use 
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194 double-buffered-
display

Boolean R, W Yes sets up two copies of the dis-
play in memory. HyperChem 
then draws molecules off screen 
and shows them when com-
plete. No sets HyperChem to 
display one atom at a time

195 cpk-max-double-
buffer-atoms

int 
(0 . . 32767)

R,W If double-buffered display is on, 
HyperChem limits double buff-
ering of a spheres rendering to 
this number of atoms (int), but 
turns off double buffering if the 
number of atoms exceeds this 
number

196 show-hydrogens Boolean R, W Toggles the display of hydrogen 
atoms on (yes) or off (no)

197 show-periodic-box Boolean R, W Toggles the display of an exist-
ing periodic box on (yes) or off 
(no). Does not create the box or 
periodic conditions

198 show-multiple-
bonds

Boolean R, W Toggles the display of double, 
triple, and aromatic bonds with 
multiple lines on (yes) or off (no)

199 bond-spacing-
display-ratio

float 
(≥0 . . ≤1)

R, W The distance between lines in 
multiple bonds. This affects only 
nonraster devices, like printers, 
and metafile images

200 show-hydrogen-
bonds

Boolean R, W Toggles the display of hydrogen 
bonds on (yes) or off (no)

201 show-isosurface Boolean R, W Toggles the display of a calcu-
lated isosurface on (yes) or off 
(no)

202 show-axes Boolean R, W Toggles the display of inertial 
axes on (yes) or off (no)

# Display Variable Type R/W a Use 
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a. R = read only. R,W = read and write.

203 show-dipoles Boolean R, W Toggles the display of dipoles on 
(yes) or off (not)

204 hide-toolbar Boolean R, W Toggles whether the toolbar 
should be hidden (yes) or visible 
(no)

205 atom-labels enum (none, 
symbol, name, 
number, type, 
basisset, mass, 
charge, 
chirality)

R, W Labels apply to visible, selected 
atoms. If there is no selection, 
applies specified label to all 
newly created atoms or atoms 
read in from a file

206 residue-labels enum (none, 
name, 
sequence, 
namesequence)

R, W The label for visible, selected res-
idues. If there is no selection, 
applies specified label to all 
newly created residues or to resi-
dues read in from a file

207 show-stereochem-
wedges

Boolean R, W Yes displays stereochemistry 
constraints on the screen

208 periodic-box-size float1, float2, 
float3

R Returns the size of the periodic 
box in x, y, z

209 moments-of-inertia float1, float2, 
float3

R Returns the x, y, z moments of 
inertia of selection or of entire 
workspace

# Display Command Arguments Use

210 color-selection  enum
(byelement or 
colora)

Sets the persistent color applied to 
selected atoms when they are deselected. 
by element uses the colors defined by 
color-element

# Display Variable Type R/W a Use 
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a. Choose one for color: black, blue, green, cyan, red, violet, yellow, white.

211 color-element int1, enum
(default or colora)

Assigns a new color (enum) to element 
int1. Int1 = 1–103. Default = reverts to 
the color in the HyperChem element 
color table (not available to user)

212 revert-element-
colors

none Applies default colors to all elements. 
Same as the default argument for color-
element, but applies color for all elements

# Display Menu Activator Use Dialog Box

213 menu-display-scale-to-fit Positions and changes the magnification 
of the selection to fit it in the center of 
the workspace

—

214 menu-display-overlay Superimposes two selected molecules 
based on a selected bond angle in each

—

215 menu-display-show-all Shows all atoms —

216 menu-display-show-
selection-only

Shows only those atoms in the current 
selection

—

217 menu-display-hide-
selection

Hides all atoms in the current selection —

218 menu-display-rendering Provides six choices of a molecular model Rendering

219 menu-display-last-rendering Render using last rendering options —

220 menu-display-isosurface Allows user to select a new rendering 
mode for an isosurface

Plot Molec-
ular Proper-
ties, Plot 
Orbitals

221 menu-display-show-
isosurface

Toggles the display of an isosurface —

# Display Command Arguments Use
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222 menu-display-show-
hydrogens

Toggles the display of hydrogen atoms —

223 menu-display-show-
periodic-box

Toggles the display of an existing peri-
odic box. Does not create the box or 
periodic conditions

—

224 menu-display-show-
multiple-bonds

Toggles the display of multiple bonds —

225 menu-display-show-
hydrogen-bonds

Toggles the display of hydrogen bonds —

226 menu-display-recompute-
h-bonds

Recomputes hydrogen bonds between 
the selected atoms

—

227 menu-display-show-
inertial-axes

Toggles the displays of inertial axes for 
selected atoms or the whole molecular 
system

—

228 menu-display-show-dipole-
moment

Toggles display of the dipole moment 
after it has been calculated for selected 
atoms or the whole molecular system

—

229 menu-display-labels Provides a choice of labeling options for 
selected atoms and residues

Labels

230 menu-display-color Provides a persistent color to differentiate 
selected atoms when they are deselected

Selection 
Color

231 menu-display-element-color Provides alternative default colors for 
each element

Element 
Color

# Display Menu Activator Use Dialog Box
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# Databases 
Variable

Type R/W a Use 

232 amino-phi float
(≥–360 . . ≤360)

R, W Phi (ϕ) torsion angle of an amino 
acid residue

233 amino-psi float 
(≥–360 . . ≤360)

R, W Psi (ψ) torsion angle of an amino 
acid residue

234 amino-omega float 
(≥–360 . . ≤360)

R, W Omega (ω) torsion angle of an 
amino acid residue—the peptide 
bond angle

235 amino-isomer enum 
(l, d)

R, W The isomer of an amino acid resi-
due, d or l

236 nucleic-sugar-
pucker

enum 
(2-endo, 3-endo)

R, W Pucker of ribose sugar in nucleic 
acid residue

237 nucleic-alpha float 
(≥–360 . . ≤360)

R, W Alpha (α) torsion angle in a 
nucleic acid backbone

238 nucleic-beta float 
(≥–360 . . ≤360)

R, W Beta (β) torsion angle in a nucleic 
acid residue

239 nucleic-gamma float 
(≥–360 . . ≤360)

R, W Gamma (γ) torsion angle in a 
nucleic acid residue

240 nucleic-delta float 
(≥–360 . . ≤360)

R, W Delta (δ) torsion angle in a 
nucleic acid residue

241 nucleic-epsilon float 
(≥–360 . . ≤360)

R, W Epsilon (ε) torsion angle in a 
nucleic acid residue

242 nucleic-zeta float 
(≥–360 . . ≤360)

R, W Zeta (ζ) torsion angle in a nucleic 
acid backbone

243 nucleic-chi float 
(≥–360 . . ≤360)

R, W Chi (χ) torsion angle for base 
(twist angle) in a nucleic acid res-
idue
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a. R = read only. R,W = read and write.

244 nucleic-backwards Boolean R, W Toggles direction for building a 
strand; yes for backwards, from 
3′ to 5′

245 nucleic-double-
strand

Boolean R, W Toggles number of strands to 
build into a polynucleotide; yes 
for double, no for single

# Databases 
Variable

Type R/W a Use 
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# Databases
Command

Arguments Use

246 add-amino-acid string Chooses the next amino acid residue to add. Use 
the three-character residue name (e.g., ala)

247 amino-alpha-helix none Uses alpha-helical torsion angles for the next 
amino acid residue added

248 amino-beta-sheet none Uses beta-sheet torsion angles for the next amino 
acid residue added

249 add-nucleic-acid string Chooses the next nucleic acid residue to add. 
Use the two-to-four-character residue name 
(e.g., da)

250 nucleic-a-form none Uses A-form torsion angles for the next nucleic 
acid residue added

251 nucleic-b-form none Uses B-form torsion angles for the next nucleic 
acid residue added

252 nucleic-z-form none Uses Z-form torsion angles for the next nucleic 
acid residue added

253 mutate-residue string Changes the selected residue into residue string, 
where string = residue name (2–3 characters). 
Select one residue, not a cap. Residues must be 
of the same type, N or A

# Databases Menu
Activator

Use Dialog Box

254 menu-databases-
amino-acids

Constructs a sequence of amino acids Amino Acids

255 menu-databases-make-
zwitterion

Changes a polypeptide into a zwitterion —

256 menu-databases-
remove-ionic-ends

Changes a zwitterion back to a neutral 
polypeptide

—
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257 menu-databases-nucleic-
acids

Constructs a sequence of nucleotides Nucleic Acids

258 menu-databases-add-
counter-ions

Adds a sodium ion near each phosphate in 
a polynucleotide

—

259 menu-databases-mutate Changes one residue into another Mutate

# Setup Variable Type R/W a Use 

260 calculation-
method

enum 
(molecular-
mechanics, 
semi-empirical, 
abinitio)

R, W A molecular mechanics, or semi-
empirical or ab initio quantum 
mechanics method for calcula-
tions

261 molecular-
mechanics-
method

enum 
(mm+, amber, 
bio+, opls)

R, W The type of molecular mechanics 
force field for calculations

262 semi-empirical-
method

enum 
(extendedhuckel, 
cndo, indo, 
mindo3, mndo, 
am1, pm3, zindo1, 
zindos)

R, W The type of semi-empirical quan-
tum mechanics method for calcu-
lations

263 keep-atom-
charges

Boolean R, W Keep atom charges when 
changing calculation methods.

264 mechanics-
dielectric

enum1, enum2, 
enum3, enum4b

(constant, 
distancedependent)

R,W The method for calculating 
dielectric permittivity

# Databases Menu
Activator

Use Dialog Box
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265 mechanics-
dielectric-scale-
factor

float1, float2, 
float3, float4b

(≥1 . . ≤1000)

R,W The multiplier for dielectric per-
mittivity (see “Force field Parame-
ters Dialog Box” on page 231)

266 mechanics-
electrostatic-
scale-factor

float1, float2, 
float3, float4b

(≥0 . . ≤1)

R,W Scale factor for 1–4 electrostatic 
interactions

267 mechanics-van-
der-waals-scale-
factor

float1, float2, 
float3, float4b

(≥0 . . ≤1)

R,W Scale factor for 1–4 van der Waals 
interactions

268 mechanics-
mmp-
electrostatics

enum 
(bonddipoles, 
connectedbond-
dipoles, 
atomiccharges, 
none)

R, W Specifies the type of electrostatic 
interaction to use in MM+ calcu-
lations

269 cutoff-type enum (none, 
switched, shifted)

R, W The type of cutoff to apply to all 
molecular mechanics calculations

270 cutoff-inner-
radius

float 
(≥0 . . < 1e10)

R, W The distance (in Ångstroms) to 
begin a switched cutoff

271 cutoff-outer-
radius

float 
(>0 . . < 1e10)

R, W The distance (in Ångstroms) to 
end a switched cutoff, or the limit 
for a shifted cutoff

272 huckel-constant float 
(>0 . . ≤10)

R, W The proportionality factor to use 
in a Extended Hückel calculation. 
Usually 1.75

273 huckel-scaling-
factor

float 
(>0 . . ≤100000)

R, W Scale factor for Coulomb-Cou-
lomb interactions between quan-
tum and 
classical parts in a mixed model 
calculation

# Setup Variable Type R/W a Use 
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274 huckel-weighted Boolean R, W A toggle for using a simple Hückel 
constant (yes), or a constant 
including a weighting factor for 
orbital diffuseness (no)

275 d-orbitals-on-
second-row

Boolean R, W Yes to include d orbitals from the 
basis set for the second long row 
of atoms (Si to Cl), or no to 
ignore d orbitals (and shorten the 
calculation). For Extended Hückel 
only

276 scf-convergence float 
(>0 . . ≤100)

R, W Sets the convergence limit (the 
difference in electronic energy, in 
kcal/mol, after two consecutive 
iterations) for an SCF quantum 
mechanics calculation

277 max-iterations int 
(1 . . 32767)

R, W Sets the maximum number of 
SCF iterations allowed in a quan-
tum mechanics calculation

278 accelerate-scf-
convergence

Boolean R, W Yes uses the DIIS procedure to 
accelerate a calculation with a 
quantum-mechanical calculation

279 quantum-total-
charge

int 
(–32767 . . 
≤ 32767)

R, W The total charge of a molecular 
system for a quantum mechanics 
calculation. For Extended Hückel 
or semi-empirical or ab initio SCF 
calculations, this variable must 
precede multiplicity (see the next 
variable)

280 multiplicity int 
(1 . . 6)

R, W The spin multiplicity (1 = singlet, 
2 = doublet, 3 = triplet, 4 = quar-
tet, etc.) of an electronic state to 
compute in a quantum mechan-
ics calculation. For Extended 
Hückel or semi-empirical or ab ini-
tio SCF calculations, this variable 
must follow quantum-total-
charge (see the previous variable)

# Setup Variable Type R/W a Use 
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281 uhf Boolean R, W Yes sets a quantum mechanics 
calculation to Unrestricted Har-
tree Fock, or no for Restricted 
Hartree Fock

282 excited-state Boolean R, W Yes directs an SCF quantum 
mechanics calculation for the 
next lowest electronic state of a 
given spin multiplicity, No for the 
lowest state of the given spin 
multiplicity

283 zindo-1-
sigma-sigma

float
(≥0 . . ≤1010)

R, W Weight (float) assigned 
to sigma-sigma overlap 
integral into ZINDO/1 
calculations

284 zindo-1-
pi-pi

float
(≥0 . . ≤1010)

R, W Weight (float) assigned 
to pi-pi overlap integral into 
ZINDO/1 calculations

285 zindo-s-
sigma-sigma

float
(≥0 . . ≤1010)

R, W Weight (float) assigned 
to sigma-sigma overlap 
integral into ZINDO/S 
calculations

286 zindo-s-
pi-pi

float
(≥0 . . ≤1010)

R, W Weight (float) assigned to pi-pi 
overlap integral into
ZINDO/S calculations

287 abinitio-mo-
initial-guess

enum 
(core-hamiltonian, 
projected-huckel, 
projected-cndo, 
projected-indo)

R, W Specify a method to produce an 
initial guess of the MO 
coefficients

288 abinitio-cutoff float (>0) R, W Specify a cutoff threshold for two-
electron integrals in an ab initio 
calculation

289 abinitio-buffer-
size

int (>50 ... 32000) R, W Specify a buffer size to store the 
two-electron integrals in an ab 
initio calculation

# Setup Variable Type R/W a Use 
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290 abinitio-integral-
format

enum (regular, 
raffenetti)

R, W Specify a format to store the two-
electron integrals in an ab initio 
calculation

291 abinitio-integral-
path

string R, W Specify a full path, including disk 
drive and directory (e.g., 
C:\HYPER), to store the two-
electron integrals in an ab initio 
calculation

292 abinitio-direct-scf Boolean R, W Yes uses Direct SCF calculation to 
avoid using disk space to store 
the two-electron integrals in an 
ab initio calculation

293 abinitio-use-
ghost-atoms

Boolean R, W Yes uses the “ghost-atoms” 
selection and treats them as ghost 
atoms

294 abinitio-scf-
convergence

float (>0 ... ≤100) R,W Sets the convergence limit (the 
difference in electronic energy, in 
kcal/mol, between two successive 
iterations) for an ab initio 
calculation

295 abinitio-d-
orbitals

Boolean R, W Yes uses 6 d orbitals (i.e., dxx, dyy, 
dzz, dxy, dxz, dyz).

No uses 5 d orbitals (i.e., d0, d+1, 
d-1, d+2, d-2)

296 abinitio-
calculate-
gradient

Boolean R, W Yes computes the first derivatives 
of the total energy with respect to 
the coordinates of the atoms. This 
option applies to single-point cal-
culations only

297 abinitio-mp2-
correlation-
energy

Boolean R, W Yes computes the second order 
Møller-Plesset perturbation 
energy. This option apples to 
single-point calculations only

# Setup Variable Type R/W a Use 
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298 abinitio-mp2-
frozen-core

Boolean R, W Yes uses the frozen-core approxi-
mation in computing the MP2 
correlation energy

299 configuration int R, W Specifies the current selected line 
in a UV spectrum 

300 configuration-
interaction

enum (NoCI, 
SinglyExcited, or 
Microstate)

R, W NoCI = no CI calculation 
requested; SinglyExcited = per-
form singly excited CI 
calculation; Microstate = 
perform a microstate CI 
calculation

301 ci-occupied-
orbitals

int R, W The number of molecular orbitals 
from which electrons are excited 
to produce excited configuration

302 ci-unoccupied-
orbitals

int R, W The number of unoccupied 
molecular orbitals to which elec-
trons are excited to produce 
excited configurations

303 ci-excitation-
energy

float(≥0..≤1e5) R, W Maximum MO orbital energy (in 
eV) between the virtual and occu-
pied orbitals which form an active 
space in a singly excited CI calcu-
lation.  (This option is only avail-
able for singly excited CI, and 
only applies when the ci-criterion 
is set to energy)

304 ci-criterion enum (energy, 
orbital)

R, W Use energy criterion or
orbital criterion

305 parameter-set-
changed

Boolean R, W Toggles the state of the backend 
parameters

306 backend-active Boolean R Yes if calculations are in progress 
(at backend)

# Setup Variable Type R/W a Use 
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a. R = read only. R,W = read and write.
b. enum1/float1 for MM+, enum2/float2 for AMBER, enum3/float3 for BIO+, and enum4/float4
for OPLS. This release of HyperChem does not use the MM+ values.

307 backend-
communications

enum (remote, 
local)

R, W Location of chemical calculations 
(local: current machine; remote: 
backend-host-name)

308 backend-host-
name

string R, W Name of ethernet host to run 
back-end jobs

309 backend-user-id string R, W Specifies the user’s id

310 backend-user-
password

string R, W Specifies the password to access 
the remote computer using the 
specified user id

311 backend-process-
count

int R, W Specifies the number of processes 
running on the remote computer. 
The current version of Hyper-
Chem ignores this option and 
always uses 1.

# Setup Command Arguments Use

312 restraint string, float1
(>0 . . >106 for 
stretch, >0 . . 
<180 for bend, 
≥–180 . . ≤180 
for torsion)
or computed, 
float2 (≥0 . . 
≤106) or default

Adds a restraint (string = selection-name, 
float1 = length or angle, float2 = force con-
stant) to molecular mechanics or quantum 
mechanics calculations. Computed and 
default are the values that HyperChem sup-
plies

# Setup Variable Type R/W a Use 
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313 restraint-tether string, enum or 
float*3 (≥0 . . 
≤106), float 
(>0 . . >106)

Tethers a selection to a desired position in 
space.  String refers to a named selection 
containing a single atom.  Enum is either 
COMPUTED to use the current value for the 
position of the selection, or POINT to tether 
the selection to the coordinates of a selection 
saved as the named selection POINT.  A point 
in space can be used as a tether point by 
replacing this enum with the x, y, and z coor-
dinates of a point in space (float * 3).  The last 
argument is the force constant

314 use-restraint string, Boolean Controls whether a restraint associated with a 
named selection is used; requires that you 
specify the name of a selection and “yes” or 
“no” 

315 use-no-restraints none Ignores all restraints

316 use-parameter-set string Chooses a parameter set (string) for the cur-
rent molecular mechanics method. Parameter 
set must be a CustomName defined in Regis-
try or in chem.ini 

317 solvate-system none Adds a periodic box and water molecules to a 
molecular system, using the last default set-
tings

318 solvate-system-in-
this-box

float1, float2, 
float3

Adds a periodic box—with dimensions x, y, 
and z Ångstroms—and water molecules to a 
molecular system

319 set-velocity enum (POINT, 
LINE or OTHER), 
float, float, float 
(if OTHER speci-
fied), float 
(required)

Sets the velocity for the molecular system or 
selected atoms. The last argument is the 
velocity (Ångstrom/ps) and the direction is 
denoted by POINT (towards the named 
selection POINT), LINE (parallel to the named 
selection LINE) or OTHER (with three floats 
specifying the velocity vector). 

320 assign-basisset enum (STO-3G, 
STO-3G*, 3-
21G*, ...)

Assign a basis set to the selected atom(s) or 
to all the atoms in ab initio calculations

# Setup Command Arguments Use
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# Setup Menu Activator Use Dialog Box

321 menu-setup-molecular-
mechanics

Chooses a molecular mechanics force 
field, options, and constraints

Molecular 
Mechanics Force 
Field

322 menu-setup-semi-
empirical

Chooses a semi-empirical method Semi-empirical 
Method

323 menu-setup-ab-initio Chooses an ab initio method Ab Initio Method

324 menu-setup-network Chooses backend calculations running on 
the local computer or a remote computer

Network

325 menu-setup-periodic-
box

Provides a water environment and peri-
odic boundary conditions for a molecular 
system

Periodic Box 
Options

326 menu-setup-restraints Adds computational restraints to named 
selections

Restraint Forces

327 menu-setup-set-
velocity

Sets the velocity vectors for the selected 
atoms

Set Velocity

328 menu-setup-select-
parameter-set

Chooses a new parameter file for molecu-
lar mechanics calculations

Force Field 
Parameters

329 menu-setup-compile-
parameter-file

Converts a text parameter file to a binary 
file

—

330 menu-setup-reaction-
map

Map reactants and products in prepara-
tion for a transition state search

Reaction Map
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# Compute 
Variable

Type R/W a Use 

331 do-qm-
calculation

Boolean R, W Yes to compute the wave function 
for a single point quantum 
mechanics calculation

332 do-qm-graph Boolean R, W Yes graphs a 2D contour plot of 
the current quantum mechanics 
property, and sets do-qm-isosur-
face to false

333 do-qm-isosurface Boolean R, W Yes plots the isosurface of the 
quantum mechanical property 
and sets do-qm-graph to false

334 isosurface-map-
function

Boolean R, W Yes plots the mapped function iso-
surface of the quantum mechanical 
property

335 isosurface-grid-
step-size

real (> 0) R, W Distance (in Ångstroms) between 
data points in the grid. Resets the 
x,y,z nodes

336 isosurface-x-
nodes

int (1 < int ≤ 128) R, W Number of data grid points to 
accumulate in the X direction

337 isosurface-y-
nodes

int (1 < int ≤ 128) R, W Number of data grid points to 
accumulate in the Y direction

338 isosurface-z-
nodes

int (1 < int ≤ 128) R, W Number of data grid points to 
accumulate in the Z direction

339 isosurface-x-min float (-1e+010 . . 
1e+010)

R, W Smallest x coordinate of the grid 
data

340 isosurface-y-min float (-1e+010 . . 
1e+010)

R, W Smallest y coordinate of the grid 
data

341 isosurface-z-min float (-1e+010 . . 
1e+010)

R, W Smallest z coordinate of the grid 
data
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342 isosurface-map-
function-display-
legend

Boolean R, W Yes to display a legend for the 
mapped function isosurface

343 isosurface-map-
function-range

float1, float2 (If 
neither of these is 
0, float2 = -1 * 
float1)

R, W Minimum and maximum values for 
the display of a mapped function 
isosurface.

344 graph-data-type enum 
(electrostatic, 
spin-density 
charge-density, 
orbital, 
orbital-squared)

R, W Type of data to plot with 
do-qm-graph or do-qm-isosurface

345 graph-data-row int, float list R The values of the ith row of the 
data graph

346 graph-orbital-
selection-type

enum 
(lumo-plus, 
homo-minus, 
orbital-number)

R, W The procedure for indicating which 
orbital to plot, either relative to an 
HOMO/LUMO orbital or an abso-
lute number

347 graph-beta Boolean R, W Yes to plot beta orbital; no to plot 
alpha orbitals in an Unrestricted 
Hartree Fock calculation

348 graph-horizontal-
grid-size

int 
(1 . . 16384)

R, W Number of data grid points for 
plotting 2D contours in the hori-
zontal direction

349 graph-vertical-
grid-size

int 
(1 . . 16384)

R, W Number of data grid points for 
plotting 2D contours in the vertical 
direction

# Compute 
Variable

Type R/W a Use 
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350 graph-orbital-
offset

int 
(0 . . 32767)

R, W The number to use as an offset in 
describing which orbital to plot. 
The meaning depends on graph-
orbital-selection-type. For orbital-
number, it starts at 1 and indicates 
the orbital number. For homo-
minus, it starts at 0 and indicates 
offset down from HOMO orbital. 
For lumo-plus, it starts at 0 and 
indicates offset up from LUMO 
orbital

351 basisset-count int R Number of coefficients required to 
describe a molecular orbital

352 graph-contour-
levels

int 
(1 . . 32767)

R, W The number of contour lines in a 
plot

353 graph-plane-
offset

float
(≥–1010. . ≤1010)

R, W Offset along the viewer’s z axis of 
the plane containing contour 
lines. Without an offset, contours 
pass through the center of the 
selection

354 graph-contour-
start

float
(≥–1010. . ≤1010)

R, W Value for the first contour line, if 
graph-contour-start-other is yes

355 graph-contour-
increment

float
(≥–1010. . ≤1010)

R, W Increment for contour lines, if 
graph-contour-increment-other is 
yes

356 graph-contour-
start-other

Boolean R,W No to use default contouring; yes 
to use value from graph-contour-
start

357 graph-contour-
increment-other

Boolean R,W No to use default contouring; yes 
to use value for graph-contour-
increment

# Compute 
Variable

Type R/W a Use 
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358 optim-algorithm enum 
(steepestdes-
cents, fletcher-
reeves, 
polakribiere, 
newtonraphson)

R, W The algorithm to use for geometry 
optimization

359 optim-
convergence

float 
(>0 . . ≤100)

R, W For geometry optimization, the 
RMS gradient to use as a conver-
gence criterion

360 optim-max-
cycles

int 
(1 . . 32767)

R, W Maximum number of optimization 
steps

361 periodic-
boundaries

Boolean R, W Yes to use periodic boundary con-
ditions; no to turn off these condi-
tions. Set up periodic conditions 
with the Setup variables solvate-
system-in-this-box or solvate-sys-
tem

362 screen-refresh-
period

int 
(1 . . 32767)

R, W Frequency for updating the dis-
play during a molecular dynamics 
calculation, in units of data steps.

363 optim-converged Boolean R Yes means geometry optimization 
has converged

364 dynamics-heat-
time

float 
(≥0. . ≤1010)

R, W Time to change from dynamics-
starting-temp to dynamics-simula-
tion-temp

365 dynamics-run-
time

float 
(≥0. . ≤1010)

R, W Total time at dynamics-simulation-
temp

366 dynamics-cool-
time

float 
(≥0. . ≤1010)

R, W Time to change from dynamics-
simulation-temp to dynamics-final-
temp

367 dynamics-time-
step

float 
(>0. . ≤1010)

R, W Step size, in picoseconds, for the 
dynamics calculation

# Compute 
Variable
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368 monte-carlo-
heat-steps

float 
(0 < . . ≤1010)

R, W Number of steps to change from 
dynamics-starting-temp to dynam-
ics-simulation-temp

369 monte-carlo-run-
steps

float 
(0 < . . ≤1010)

R, W Number of steps at dynamics-sim-
ulation-temp

370 monte-carlo-
cool-steps

float 
(0 < . . ≤1010)

R, W Number of steps to change from 
dynamics-simulation-temp to 
dynamics-final-temp

371 monte-carlo-
max-delta

float 
(0 < . . ≤1010)

R, W Maximum allowed size of the dis-
placement step in Ångstroms.

372 dynamics-
starting-temp

float 
(≥0. . ≤1010)

R, W Starting temperature for a dynam-
ics simulation

373 dynamics-
simulation-temp

float 
(≥0. . ≤1010)

R, W Run-time temperature for a 
dynamics simulation

374 dynamics-
final-temp

float 
(≥0. . ≤1010)

R, W Final temperature for a dynamics 
simulation

375 dynamics-temp-
step

float 
(>0. . ≤1010)

R, W Temperature step size (degrees K) 
for heating and cooling (anneal-
ing)

376 dynamics-restart Boolean R, W Yes to restart a dynamics calcula-
tion using velocities stored in a file; 
no to use new equilibrated veloci-
ties

377 dynamics-
playback

enum (record, 
playback, none)

R, W Record = store dynamics simulation 
in a snapshots file; playback = use 
dynamics simulation stored in a 
snapshots file; none = calculate a 
new trajectory (without snapshots 
or playback of snapshots)

378 dynamics-
playback-start

int
(0 . . 32767)

R, W The snapshot number to begin the 
playback

# Compute 
Variable

Type R/W a Use 
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379 dynamics-
playback-end

int 
(0 . . 32767)

R, W The snapshot number to end the 
playback

380 dynamics-
playback-period

int 
(0 . . 32767)

R, W The length of the playback period 
in numbers of snapshots

381 dynamics-
constant-temp

Boolean R, W Yes to apply temperature regula-
tion during a dynamics simulation

382 dynamics-bath-
relaxation-time

float 
(>0. . ≤1010)

R, W The time constant in picoseconds 
for constant temperature regula-
tion

383 dynamics-
friction-
coefficient

float
(0 . . 1000000)

R, W Friction coefficient for Langevin 
dynamics

384 dynamics-
collection-period

int 
(1 . . 32767)

R, W The period for collecting data from 
the molecular dynamics calculation 
in time steps

385 dynamics-
snapshot-
filename

filename R, W The name of a snapshot file, with 
the extension .snp

386 dynamics-
snapshot-period

int 
(1 . . 32767)

R, W The period between snapshots, in 
units of data steps

387 dynamics-
average-period

int 
(1 . . 32767)

R, W The period, in units of data steps, 
for storing data from a molecular 
dynamics run in a CSV file

388 dynamics-seed int
(-32768 . . 32767)

R, W Seed for dynamics initialization 
random number generator

389 mechanics-print-
level

int
(0 . . 9)

R,W Sets the level of information that 
appears in an active log file for a 
molecular mechanics calculation. 
0 = no results, 9 = maximum infor-
mation

# Compute 
Variable
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390 quantum-print-
level

int
(0 . . 9)

R,W Sets the level of information that 
appears in an active log file for a 
semi-empirical or ab initio calcula-
tion. 0 = no results, 9 = maximum 
information

391 warning-type enum (none, log, 
message)

R/W Sets the use of warning messages 
from backend calculations. None 
= discard all warning messages; log 
= place warning messages in the 
log file if one is active; message = 
display the warning on screen

392 show-
vibrational-vec-
tors

Boolean R, W Yes to display vibrational mode dis-
placement vectors

393 animate-
vibrations

Boolean R, W Controls display of animated vibra-
tions

394 ir-animate-ampli-
tude

float
(≥1 . . ≤1010)

R, W Sets distances in Ångstroms to 
move the fastest atom during 
vibrational animations

395 ir-animate-steps int
(3 . . 32767)

R, W Number of steps to use in each 
cycle while animating vibrations

396 ir-animate-cycles int
(1 . . 32767)

R, W Controls how many cycles an ani-
mation of a vibrational mode will 
show before terminating.
Caution: If this variable is not set 
before the animate-vibrations com-
mand, the animation will run on 
without continuing to further 
script commands until the Cancel 
item is selected on the menu

397 vibrational-mode int
(1 . . 
(3 * natoms - 6))

R, W The index of the current vibrational 
mode

# Compute 
Variable

Type R/W a Use 
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398 ir-band-count int.
(0. . 2685)

R, W The number of IR bands. Setting 
this variable discards existing IR 
data

399 ir-frequency vector of floats R, W When you give the index (int) of 
an IR band, this variable specifies 
its frequency

400 ir-intensity vector of floats R, W When you give the index (int) of 
an IR band, this variable specifies 
its intensity

401 ir-intensity-com-
ponents

vector of floats R, W When you give the index (int) of 
an IR band, this variable specifies 
the x, y, and z components of its 
intensity

402 ir-normal-mode vector of floats R, W When you give the index (int) of 
an IR band, this variable specifies 
for each atom the x, y, and z dis-
placements for the normal mode

403 uv-band-count int
(0 . . 32766)

R, W The number of UV bands. Chang-
ing this value discards any existing 
UV data

404 uv-energy vector of floats R, W When you give the index (int) of 
an UV band, this variable specifies 
the energy of the transition

405 uv-spin vector of floats R, W When you give the index (int) of 
an UV band, this variable specifies 
the spin multiplicity of the state

406 uv-total-dipole vector of floats R, W The total dipole moment of excited 
state (int)

407 uv-dipole-
components

vector of floats R, W The x, y, and z components of 
excited state (int)

408 uv-transition-
dipole

vector of floats R, W The transition dipole between the 
ground state and excited state (int)

# Compute 
Variable
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409 uv-oscillator-
strength

vector of floats R, W The oscillator strength for excited 
state (int)

410 scf-orbital-energy vector of floats R Gives the energy of orbital (int), in 
eV.  For UHF, the set of beta orbitals 
are numbered following the alpha

411 alpha-scf-
eigenvector

vector of floats R When you give the index of 
an SCF eigenvector, this variable 
gives the coefficients of the corre-
sponding molecular orbital. In an 
RHF calculation this variable is used 
to specify the indices of the SCF 
eigenvectors.  In a UHF calculation 
this variable is only used to specify 
the indices of the alpha SCF eigen-
vectors

412 beta-scf-
eigenvector

vector of floats R When you give the index of 
an SCF eigenvector, this variable 
gives the coefficients of the corre-
sponding molecular orbital. Avail-
able only after UHF computations

413 alpha-orbital-
occupancy

vector of floats R/W Number of electrons in the i-th MO

414 beta-orbital-
occupancy

vector of floats R/W Number of electrons in the i-th MO

415 dipole-moment float R Gives the dipole moment (Debyes) 
from a quantum-mechanical or 
MM+ calculation

416 dipole-moment-
components

float, float, float R Gives dipole moment (Debyes) x, 
y, and z components from a quan-
tum-mechanical or MM+ calcula-
tion

417 scf-atom-energy float R Gives the isolated atom energy 
(kcal/mol) from a semi-empirical 
calculation

# Compute 
Variable

Type R/W a Use 
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a. R = read only. R,W = read and write.

418 scf-binding-
energy

float R Gives the energy, relative to iso-
lated atoms (kcal/mol), from a 
quantum-mechanical calculation. 
This is the value reported on the 
status line following a quantum-
mechanical calculation

419 scf-core-energy float R Gives the core-core interaction 
energy (kcal/mol) from a quantum-
mechanical calculation

420 scf-electronic-
energy

float R Gives the electronic energy 
(kcal/mol) from a quantum-
mechanical calculation

421 heat-of-forma-
tion

float R Gives the heat of formation 
(kcal/mol) from a Semi-empirical 
calculation

# Compute 
Command

Arguments Use

422 do-single-point none Performs a single point calculation on a 
molecular system with the current calculation 
method

423 do-optimization none Performs a structure optimization on a molec-
ular system with the current calculation 
method

424 do-vibrational-
analysis

none Performs a vibrational analysis on a molecular 
system with the current calculation method

425 do-molecular-
dynamics

none Performs a molecular dynamics computation 
on a molecular system with the current calcu-
lation method

# Compute 
Variable
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426 do-langevin-
dynamics

none Performs a Langevin dynamics computation 
on a molecular system with the current calcu-
lation method

427 do-monte-carlo none Performs a Monte Carlo computation on a 
molecular system with the current calculation 
method

428 append-dynamics-
average

enum
(none, EKIN, 
EPOT, ETOT, 
TEMP, D EKIN, 
D EPOT, D ETOT, 
D TEMP, 
selection name, 
D selection 
name)

Names one selection (containing 2 to 4 
atoms) or energetic quantity to average or 
graph during a molecular dynamics simula-
tion. The prefix D indicates the deviation of 
the average. One command adds one value 
to the list of values to average, the other to 
the list to graph. Use all uppercase as shown 
here. Use double quotes around arguments 
containing spaces; for example “D EKIN”

429 append-dynamics-
graph

430 isosurface-mesh-
quality

enum (coarse, 
medium, fine)

Sets variables for isosurface grid to default val-
ues

# Compute Menu 
Activator

Use Dialog Box

431 menu-compute-single-
point

Calculates the energy and gradient for 
the current conformation

—

432 menu-compute-
geometry-optimization

Finds an optimal conformation for the 
molecular system

Molecular 
Mechanics or
Semi-empirical or 
Ab Initio Optimi-
zation 

433 menu-compute-
molecular-dynamics

Runs a molecular dynamics simulation Molecular 
Dynamics 
Options

434 menu-compute-
langevin-dynamics

Perform a Langevin Dynamics simulation Langevin Dynam-
ics Options

# Compute 
Command

Arguments Use
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Script Menu

435 menu-compute-
monte-carlo

Perform a Monte Carlo simulation Monte Carlo 
Options

436 menu-compute-
vibrations

Performs a vibrational analysis 
computation

—

437 menu-compute-
transition-state

Perform a transition state computation Transition State 
Options

438 menu-compute-plot-
molecular-properties

Draws contour plots and isosurfaces of 
quantum mechanics results

Molecular 
Properties

439 menu-compute-
orbitals

Selects an orbital to graph Orbitals

440 menu-compute-
vibrational-spectrum

Displays vibrational transitions 
and normal modes

Vibrational 
Spectrum

441 menu-compute-
electronic-spectrum

Displays UV visible spectrum Electronic 
Spectrum

# Script Variable Type R/W a Use 

442 notify-with-text Boolean R, W For DDE channels, are notifications 
to be text (instead of binary)

443 query-response-has-
tag

Boolean R, W Yes means response to a query is a 
value x plus a tag (<variable> = x). 
No means response is just the value 
x. Tag is a variable name (HSV)

# Compute Menu 
Activator

Use Dialog Box
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444 ignore-script-errors Boolean R, W Yes to proceed with a script when 
an error occurs; no to stop 
HyperChem and show a message 
box on screen. 
Caution: Ignoring script errors can 
produce incorrect results. If you 
choose this option, use errors-are-
omsgs and omsgs-to-file to save 
error messages for later review

445 script-menu-
caption

vector of 
strings

R, W Captions for menu buttons

446 script-menu-
checked

vector of 
Booleans

R, W If checked

447 script-menu-
command

vector of 
strings

R, W Commands for menu buttons

448 script-menu-
enabled

vector of 
Booleans

R, W If grayed

449 script-menu-help-
file

vector of 
strings

R, W Help files for menu items

450 script-menu-help-id vector of 
integers

R, W Context ids for help on buttons

451 script-menu-in-use vector of 
Booleans

R, W Is somebody claiming this menu 
item?

452 script-menu-
message

vector of 
strings

R, W Status messages displayed when 
script menu items clicked with 
mouse

453 script-refs-in-errors Boolean R, W Whether to include script file line 
numbers in errors

# Script Variable Type R/W a Use 
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a. R = read only. R,W = read and write.

454 inhibit-
redisplay

Boolean R, W Determines whether redisplay of the 
system is inhibited.  Caution:  If 
inhibit-redisplay is not reset to No, 
the HyperChem workspace will not 
be updated, even after the termina-
tion of the script where it is set to 
Yes

455 global-inhibit-
redisplay

Boolean R Whether redisplay of the system is 
inhibited

456 status-message string R, W Displays a message (string) on the 
status line. When queried, returns 
the last status message displayed.

457 omsg-file filename R, W Name of file to append OMSGs to

# Script Command Arguments Use

458 pause-for int 
(1 . . . 32767)

Pause the script for a number (int) of seconds

459 notify-on-update string Requests a response when there is a change in 
value for this variable name (string). Use only 
for scripts to return variable as OMSG; use 
WM_DDE_ADVISE for DDE communications

460 cancel-notify string Cancels notify-on-update for variable (string)

461 omsgs-to-file filename Deletes file contents and then sends omsg’s to 
this file while the script is running. Do not use 
for DDE. See the previous and following com-
mands

462 omsgs-not-to-file none Sends omsgs to an OMSG box on screen 
instead of recording it in a file (see the next 
command)

# Script Variable Type R/W a Use 
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463 append-omsgs-to-
file

filename Sends omsg’s to this file, adding them to previ-
ous messages. See the previous two commands

464 errors-are-omsgs none Treats error messages like omsg’s: sends them 
to a file or to an OMSG box on screen

465 errors-are-not-
omsgs

none Sends error messages to screen

466 warnings-are-
omsgs

none Treats warning messages like omsg’s: sends 
them to a file or to an OMSG box on screen

467 warnings-are-not-
omsgs

none Sends warning messages to screen

468 message string Treats string like an omsg: sends it to a file or to 
an OMSG box on screen

469 error string Treats string like an omsg: sends it to a file or to 
an Error box on screen

470 warning string Treats string like a warning message: sends it to 
a file or to a Warning box on screen

471 source-refs-in-
errors

none Controls presentation of filename, line number 
in error messages

472 no-source-refs-in-
errors

none Controls presentation of filename, line number 
in error messages

473 read-script filename Names a script file to read. Use this to start 
another script from a script

474 read-tcl-script filename Names a tcl script file to read.

475 query-value string HyperChem treats the value of a variable 
(string) like an omsg

476 request string Displays string in a dialog box until you L-click 
on OK. Allows keyboard and mouse input while 
the script is executing. The script resumes when 
you L-click OK

# Script Command Arguments Use
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477 execute-client filename, 
string1, string2

Runs a DDE application. Filename = .exe file for 
the application, string1 = DDE application (pro-
gram) name, and string2 = DDE topic (a file-
name or other string that the client application 
recognizes). Must have three arguments, even if 
the last two are null (“ “)

478 execute-
hyperchem-client

filename Runs a client application specified by filename 
that is a Windows executable application. This 
application should be able to reliably connect 
to an instance of HyperChem

479 change-user-
menuitem

int, string1, 
filename

Changes the text and script associated with a 
menu item (Script One, etc.) on the Script 
menu. int = number of the Script menu item to 
place text in (1, 2, etc.), string1 = text to place 
in the menu item (characters limit depends on 
your display resolution), and filename = name 
of the script file associated with this menu item

480 exit-script none Ends the script. This is usually the last line in a 
script file, but is not required

481 compile-script-file filename1, 
filename2

Compile a script (filename1), convert it to 
binary format, and write it to a file (filename2)

482 read-binary-script filename Execute a compiled binary script file filename

483 execute-string string Execute the string variable as a script

# Script Menu Activator Use Dialog Box

484 menu-script-open-
script

Opens a script file and runs the script Open Script

485 menu-script-one . . . 
menu-script-ten

Selects script program one . . . ten —

# Script Command Arguments Use
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Cancel

Data Variables

# Cancel Activator Use Dialog Box

486 menu-cancel Ends a calculation and returns control to user —

# Data Variable Type R/W Use 

487 atom-name int1, int2, stringa R, W If you give int1 = atom number and 
int2 = molecule number, reports string 
= atom name

488 atomic-number int1, int2, int3a R, W If you give atom number (int1) and 
molecule number (int2), reports 
atomic number (int3)

489 atomic-symbol int1, int2, stringa R If you give atom number (int1) and 
molecule number (int2), reports 
atomic symbol (string)

490 atom-type int1, int2, stringa R, W If you give atom number (int1) and 
molecule number (int2), reports atom 
type (string)

491 atom-charge int1, int2, floata R, W If you give atom number (int1) and 
molecule number (int2), reports 
atomic charge (float)

492 atom-mass int1, int2, floata R, W If you give atom number (int1) and 
molecule number (int2), reports 
atomic mass (float)

493 atom-basisset int1, int2, stringa R, W If you give atom number (int1) and 
molecule number (int2), reports basis 
set for this atom
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494 atom-extra-
basisset

int1, int2, string, 
floata

R, W If you give atom number (int1) and 
molecule number (int2), reports the 
shell type (string) of an extra basis 
function and the exponent value (float) 
of this extra basis function for this 
atom

495 atom-color int1, int2, stringa R, W If you give atom number (int1) and 
molecule number (int2), reports the 
atom’s current color (string)

496 atom-label-text int1, int2, stringa R If you give atom number (int1) and 
molecule number (int2), reports the 
atom’s label text (string)

497 residue-label-
text

int1, int2, stringa R If you give residue number (int1) and 
molecule number (int2), reports the 
residue’s label text (string)

498 is-ring-atom int1, int2, 
Booleana

R If you give atom number (int1) and 
molecule number (int2), reports true if 
the atom is in a ring (Boolean)

499 is-extended-
hydrogen

int1, int2, 
Booleana

R If you give atom number (int1) and 
molecule number (int2), reports if the 
atom is an extended hydrogen (Bool-
ean)

500 coordinates int1, int2, float1, 
float2, float3a

R, W If you give atom number (int1) and 
molecule number (int2), reports the x, 
y, and z coordinates (float1, 2, and 3)

501 neighbors int1, int2, int3, 
int4, enum
(s, d, t, h, a)a

R If you give atom number (int1) and 
molecule number (int2), reports the 
atoms bonded to this atom through 
either covalent or hydrogen bonds: 
int3 = number of neighbor atom, int4 
= molecule containing neighbor atom 
and bond type (enum, s = single, d = 
double, t = triple, a = aromatic, h = 
hydrogen). Repeats “int3, int4, enum” 
for each neighbor atom

# Data Variable Type R/W Use 
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502 residue-charge (i,j)
int, int, float

R Net charge on residue i in molecule j

503 residue-name (i,j)
int, int, string

R Name of residue i in molecule j

504 residue-
coordinates

(i,j)
int, int, f, f, f

R Coordinates of center of mass of resi-
due in i molecule j

505 molecule-count int R The number of molecules (int) in the 
molecular system

506 atom-count int1, int2 R If you give the molecule number (int1), 
reports the number of atoms (int2) in 
this molecule

507 residue-count int1, int2 R If you give the molecule number (int1), 
reports the number of residues (int2) in 
this molecule

508 orbital-count int R Show the number of molecular orbitals 
used in quantum mechanical 
calculations

509 coordination int1, int2, int3 R,W If you give atom number (int1) and 
molecule number (int2), reports (int3) 
the number (from 1 to 12) of bonded 
neighbors

510 chirality int1, int2, enum R, W If you give atom number (int1) and 
molecule number (int2), reports 
(enum) one of A, R, S, or ?, giving the 
chirality (“A” achiral atom, “R” rectus 
or right chirality, “S” sinister or left 
chirality and “?” for 5 or 6 coordinated 
systems)

511 dynamics-info-
total-energy

float R Reports the sum of the potential and 
kinetic energies for a molecular 
dynamics simulation or its playback

# Data Variable Type R/W Use 
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512 dynamics-info-
potential-
energy

float R Reports the potential energy for a 
molecular dynamics simulation or its 
playback

513 dynamics-info-
kinetic-energy

float R Reports the kinetic energy for a molec-
ular dynamics simulation or its play-
back

514 dynamics-info-
temperature

float R Reports the temperature value corre-
sponding to the current velocities in a 
molecular dynamics simulation or its 
playback.

515 dynamics-info-
elapsed-time

float R Reports the elapsed running time, in 
picoseconds, of a molecular dynamics 
simulation or its playback

516 dynamics-info-
last-update

Boolean R Yes if the last step of a molecular 
dynamics simulation or its playback has 
occurred; no if the simulation is still in 
progress

517 monte-carlo-
info-
acceptance-
ratio

float (0 . . 1) R Computation result from Monte Carlo 
run

518 velocities int1, int2, float1, 
float2, float3

R, W If you give int1 = atom number and 
int2 = molecule number, reports float1, 
2, and 3, the vx, vy, and vz values (in 
Ångstroms/picosecond) for this atom

519 rms-gradient float R The RMS gradient, in kcal/Å, derived 
from a single point or geometry opti-
mization calculation

520 total-energy float R The total energy of a molecular system, 
in kcal/mol (energy on a potential 
energy surface), either from a molecu-
lar mechanics or quantum mechanics 
calculation

# Data Variable Type R/W Use 
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a. For a read from HyperChem, use int1 and int2. To write, use all arguments.

521 stretch-energy float R The bond stretching contribution to 
the molecular mechanics total energy

522 bend-energy float R The bond angle bending contribution 
to the molecular mechanics total 
energy

523 torsion-energy float R Reports the bond torsion contribution 
to the molecular mechanics total 
energy

524 nonbond-
energy

float R Reports the nonbonded interaction 
contribution to the molecular mechan-
ics total energy

525 hbond-energy float R Reports the hydrogen bonding contri-
bution to the molecular mechanics 
total energy

526 estatic-energy float R Reports the electrostatic interaction 
contribution to the molecular mechan-
ics total energy. For MM+, this reports 
the stretch-bend energy

527 mp2-energy float R The MP2 correlation energy, in 
kcal/mol, in ab initio calculations

# Data Variable Type R/W Use 
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Help Menu

# Help Variable Type R/W Use 

528 version string R The version of HyperChem

529 serial-number string R The serial number of the copy of 
HyperChem in use

# Help Command Arguments Use

530 help string Displays help for the topic string

# Help Menu Activator Use Dialog Box

531 menu-help-index Displays help index HyperChem Help

532 menu-help-keyboard Displays keyboard information HyperChem Help

533 menu-help-commands Displays instructions about using 
HyperChem commands

HyperChem Help 

534 menu-help-tools Displays instructions about using 
HyperChem tools

HyperChem Help

535 menu-help-scripts-
and-dde

Displays instructions on how to use 
HyperChem script messages

HyperChem Help

536 menu-help-on-context Displays context sensitive help 
cursor

HyperChem Help

537 menu-help-glossary Displays definitions of HyperChem terms HyperChem Help

538 menu-help-using-help Displays instructions about using Help HyperChem Help
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539 menu-help-about-
hyperchem

Displays information about HyperChem HyperChem Help

# Help Menu Activator Use Dialog Box
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Miscellaneous Commands

Command Arguments Use

540 write-atom-map filename Writes a mapping of backend atom num-
bers to HyperChem

541 variable-changed variable name Causes HyperChem to operate as if the 
provided variable changed in value, notify-
ing all “watchers” of its current value.

542 declare-integer string Declare a new integer variable

543 declare-string string Declare a new string variable

544 push string Push copy of current value onto stack

545 pop-value string Restore pushed value

546 pop-no-value string Pop stack, don’t restore value

547 toggle string Invert value of Boolean variable named in 
string

548 print-variable-list filename Write a summary of the state variables to 
the filename

549 factory-settings none Reset all the options of HyperChem to its 
out-of-the-box state

550 load-user-menu filename Load a customized menu from this file-
name

551 switch-to-user-
menu

none Use a customized menu

552 load-default-menu none Use the default menus
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Miscellaneous Variables

# Miscellaneous 
Variable

Type R/W Use 

553 mechanics-
data

special R Contains the following information to 
support a back-end calculation:

(a) type of calculation [single-point (0), 
geometry optimization (1), molecu-
lar dynamics (2), or vibrations (4)];

(b) using restraints [true (1) or false 
(0)];

(c) optimization algorithm [steepest 
descent (0), Fletcher-Reeves (1), 
Polak-Ribiere (2), or Block-diagonal 
Newton-Raphson (3)];

(d) (reserved for future use);
(e) maximum number of cycles of 

optimization;
(f) desired RMS gradient in 

optimization;
(g) (reserved for future use);
(h) whether or not fix the non-selected 

atoms;
(i) whether or not using periodic 

boundary conditions;
(j) whether or not using constant 

temperature;
(k) relaxation time;
(l) (reserved for future use);
(m) whether or not using restart;
(n) random number seed;
(o) x, y, z dimensions of the periodic 

box;
(p) α, β, γ angles of the periodic box 

(must all be 90° in this version);
(q) starting temperature for heating 

time (T1);
(r) starting temperature for running 

time (T2);
(s) final temperature for cooling time 

(T3);
(t) time for the T1→T2 temperature 

change;
(u) time at temperature T2;
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mechanics-
data 
(continued)

(v) time for the T2→T3 temperature 
change;

(w) size of the time step for 
integration;

(x) size of temperature steps;
(y) Langevin Dynamics friction coeffi-

cient
(z, aa, bb, cc, dd, ee, ff) (reserved for 

future use);
(gg) data collection period (in time 

steps);
(hh) warning level [none (0), log file 

(1), or log file and message box (2)]

554 mechanics-info special R Contains the following information to 
support a molecular-mechanics back-
end calculation:

(a–d) (reserved for future use);
(e) whether or not to use a distance-

dependent dielectric;
(f) (reserved for future use);
(g) electrostatic option for MM+ [bond 

dipoles (0) or atomic charges (1)];
(h) inverse of dielectric constant;
(i–j) (reserved for future use);
(k) scale for 1–4 van der Waals;
(l) scale for 1–4 electrostatic;
(m) type of cutoff;
(n) inside cutoff radius;
(o) outside cutoff radius;
(p–u) reserved for future use;
(v) level of detail for printing to log file

555 atom-info vectors of array R Atom information that supports back-
end calculations. Each atom 
corresponds to one vector that 
contains the following items: index, 
atomic number, atom type, atom flag, 
selection flag, ring flag, coordination, 
bonded atom indices (up to 12), atom 
charge, x coordinate, y coordinate, z 
coordinate, and atom mass

# Miscellaneous 
Variable
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556 cancel-menu Boolean R, W Whether the ‘Cancel’ menu is up 
(other items grayed out) instead of the 
normal menu

557 info-variable-
target

string R, W Variable for which info is required

558 one-line-arrays Boolean R, W Whether to emit arrays all on one line.

559 info-access string R Access (R, W, RW) for info-variable-
target

560 info-enum-id-
of

string R Binary id of info-enum-target value for 
info-variable-target

561 info-enum-list string R If enumerated type, list of enumerated 
values for info-variable-target

562 info-factory-
setting

string R Factory setting value for info-variable-
target

563 info-id-of int R Binary id of info-variable-target

564 info-type-of int R Type of info-variable-target

565 info-type-of-
element

int R If info-type-of is array or vector, type of 
elements

566 custom-title string R, W Appends string to title in program win-
dow title bar

567 window-height int R, W Height of program window in pixels

568 window-width int R, W Width of program window in pixels

# Miscellaneous 
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Cross Reference of HyperChem Messages

The numbers that appear in the first column of each of the previ-
ous tables are used in the following alphabetic cross-reference. Use 
this cross-reference as an index to help you locate the message you 
want to use.

Message Cross-Reference

This alphabetic cross-reference applies to the previous tables con-
taining HyperChem message variables, commands, and menu acti-
vators. The numbers listed are the message numbers for the pre-
ceding pages; they are not page numbers. 

You can use the on-line help Search function to find any message 
by searching for part of the message. For example, you can display 
a list of all messages that include a word (such as “hin” or “atom”), 
and then display the definition of the specific message that you 
want.

Caution: Use this cross-reference only for finding messages in the 
tables. The syntax of a cross-reference might not match the origi-
nal script message.
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Message Cross-Reference
Numerics

3D surface display toggle  . . . . . . . . . . . #221
3D surface, display type  . . . . . . . . . . . . #220

A

ab initio results, export  . . . . . . . . . . . . . . #21
ab initio results, import . . . . . . . . . . . . . . #25
ab initio setup . . . . . . . . . . . . . . . . . . . . #323
abinitio-buffer-size . . . . . . . . . . . . . . . . . #289
abinitio-calculate-gradient . . . . . . . . . . . #296
abinitio-cutoff . . . . . . . . . . . . . . . . . . . . #288
abinitio-direct-scf  . . . . . . . . . . . . . . . . . #292
abinitio-d-orbitals  . . . . . . . . . . . . . . . . . #295
abinitio-integral-format . . . . . . . . . . . . . #290
abinitio-integral-path  . . . . . . . . . . . . . . #291
abinitio-mo-initial-guess  . . . . . . . . . . . . #287
abinitio-mp2-correlation-energy  . . . . . . #297
abinitio-mp2-frozen-core . . . . . . . . . . . . #298
abinitio-scf-convergence . . . . . . . . . . . . #294
abinitio-use-ghost-atoms . . . . . . . . . . . . #293
about-hyperchem . . . . . . . . . . . . . . . . . #539
accelerate-scf-convergence  . . . . . . . . . . #278
acceptance ratio, Monte Carlo  . . . . . . . #517
add hydrogens  . . . . . . . . . . . . . . . . . . . #130
add-amino-acid . . . . . . . . . . . . . . . . . . . #246
add-nucleic-acid  . . . . . . . . . . . . . . . . . . #249
a-form, DNA . . . . . . . . . . . . . . . . . . . . . #250
algorithm, geometry optimization . . . . . #358
align molecule . . . . . . . . . . . . . . . . . . . . . #99
align viewer . . . . . . . . . . . . . . . . . . . #75, #98
align-molecule  . . . . . . . . . . . . . . . . . . . . #74
all atoms . . . . . . . . . . . . . . . . . . . . . . . . #134
allow-ions  . . . . . . . . . . . . . . . . . . #105, #132
alpha helix  . . . . . . . . . . . . . . . . . . . . . . #247
alpha orbital  . . . . . . . . . . . . . . . . . . . . . #347
alpha torsion angle, nucleic acid . . . . . . #237
alpha-orbital-occupancy  . . . . . . . . . . . . #413
alpha-scf-eigenvector  . . . . . . . . . . . . . . #411
amino acid, add  . . . . . . . . . . . . . #246, #254
amino-alpha-helix . . . . . . . . . . . . . . . . . #247
amino-beta-sheet  . . . . . . . . . . . . . . . . . #248
amino-isomer  . . . . . . . . . . . . . . . . . . . . #235
amino-omega  . . . . . . . . . . . . . . . . . . . . #234

amino-phi . . . . . . . . . . . . . . . . . . . . . . . .#232
amino-psi  . . . . . . . . . . . . . . . . . . . . . . . .#233
angle, bond  . . . . . . . . . . . . . . . . . .#83, #101
angle, constrain bond . . . . . . . . . . . . . . .#142
angle, constrain torsion . . . . . . . . . . . . . .#143
animate, amplitude . . . . . . . . . . . . . . . . .#394
animate, number of cycles  . . . . . . . . . . .#396
animate, number of steps . . . . . . . . . . . .#395
animate-vibrations  . . . . . . . . . . . . . . . . .#393
append-dynamics-average  . . . . . . . . . . .#428
append-dynamics-graph . . . . . . . . . . . . .#429
append-omsgs-to-file  . . . . . . . . . . . . . . .#463
array type . . . . . . . . . . . . . . . . . . . . . . . .#565
arrays, format  . . . . . . . . . . . . . . . . . . . . .#558
assign-basisset . . . . . . . . . . . . . . . . . . . . .#320
atom charge, set . . . . . . . . . . . . . . . . . . .#108
atom coordinates  . . . . . . . . . . . . . . . . . .#500
atom count, selected  . . . . . . . . . . . . . . .#145
atom map, write . . . . . . . . . . . . . . . . . . .#540
ATOM records, PDB file . . . . . . . . . . . . . . . .#9
atom type, set . . . . . . . . . . . . . . . .#107, #137
atom types, calculate  . . . . . . . . . . . . . . .#135
atom, create . . . . . . . . . . . . . . . . . . . . . .#109
atom, cycle stereo . . . . . . . . . . . . . . . . . .#126
atom, delete . . . . . . . . . . . . . . . . . . . . . .#110
atom, deselect  . . . . . . . . . . . . . . . . . . . .#156
atom, select  . . . . . . . . . . . . . . . . .#155, #161
atom, selected  . . . . . . . . . . . . . . . . . . . .#146
atom, stereo . . . . . . . . . . . . . . . . . . . . . .#127
atom-basisset  . . . . . . . . . . . . . . . . . . . . .#493
atom-charge . . . . . . . . . . . . . . . . . . . . . .#491
atom-color  . . . . . . . . . . . . . . . . . . . . . . .#495
atom-count . . . . . . . . . . . . . . . . . . . . . . .#506
atom-extra-basisset . . . . . . . . . . . . . . . . .#494
atomic motion, maximum, Monte Carlo .#371
atomic velocity, set . . . . . . . . . . . . . . . . .#319
atomic-number . . . . . . . . . . . . . . . . . . . .#488
atomic-symbol  . . . . . . . . . . . . . . . . . . . .#489
atom-info  . . . . . . . . . . . . . . . . . . . . . . . .#555
atom-labels . . . . . . . . . . . . . . . . . . . . . . .#205
atom-label-text . . . . . . . . . . . . . . . . . . . .#496
atom-mass  . . . . . . . . . . . . . . . . . . . . . . .#492
atom-name . . . . . . . . . . . . . . . . . . . . . . .#487
atoms, all  . . . . . . . . . . . . . . . . . . . . . . . .#134
atoms, cut . . . . . . . . . . . . . . . . . . . . . . . . .#86
atoms, delete  . . . . . . . . . . . . . . . . . . . . . .#76
atoms, number selected  . . . . . . . . . . . . .#145
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atoms, paste . . . . . . . . . . . . . . . . . . . . . . . #89
atoms, united . . . . . . . . . . . . . . . . . . . . . #133
atom-type  . . . . . . . . . . . . . . . . . . . . . . . #490
attached atoms  . . . . . . . . . . . . . . . . . . . #501
attachments, count  . . . . . . . . . . . . . . . . #509
averages period, dynamics . . . . . . . . . . . #387
axes, show . . . . . . . . . . . . . . . . . . #202, #227

B

backbone, select  . . . . . . . . . . . . . . . . . . #173
back-clip  . . . . . . . . . . . . . . . . . . . . . . . . . #72
back-end support . . . . . . . . #553, #554, #555
backend-active . . . . . . . . . . . . . . . . . . . . #306
backend-communications  . . . . . . . . . . . #307
backend-host-name . . . . . . . . . . . . . . . . #308
backend-process-count  . . . . . . . . . . . . . #311
backend-user-id  . . . . . . . . . . . . . . . . . . . #309
backend-user-password  . . . . . . . . . . . . . #310
background, printer page color  . . . . . . . . #38
backwards, nucleic acid construction  . . . #244
balls-highlighted  . . . . . . . . . . . . . . . . . . #180
balls-radius-ratio . . . . . . . . . . . . . . . . . . . #181
balls-shaded . . . . . . . . . . . . . . . . . . . . . . #179
band count, uv . . . . . . . . . . . . . . . . . . . . #403
band, ir count  . . . . . . . . . . . . . . . . . . . . #398
basis set, assign  . . . . . . . . . . . . . . . . . . . #320
basis set, atom . . . . . . . . . . . . . . . . . . . . #493
basis set, extra atom . . . . . . . . . . . . . . . . #494
basisset-count  . . . . . . . . . . . . . . . . . . . . #351
bath relaxation time, dynamics  . . . . . . . #382
bend-energy  . . . . . . . . . . . . . . . . . . . . . #522
beta orbital  . . . . . . . . . . . . . . . . . . . . . . #347
beta sheet  . . . . . . . . . . . . . . . . . . . . . . . #248
beta torsion angle, nucleic acid  . . . . . . . #238
beta-orbital-occupancy . . . . . . . . . . . . . . #414
beta-scf-eigenvector . . . . . . . . . . . . . . . . #412
b-form, DNA  . . . . . . . . . . . . . . . . . . . . . #251
bitmap image . . . . . . . . . . . . . . . . . . #40, #41
black & white, image . . . . . . . . . . . . . . . . #46
bond angle, constrain  . . . . #114, #117, #142
bond angle, set  . . . . . . . . . . . . . . . #83, #101
bond color . . . . . . . . . . . . . . . . . . . . . . . #186
bond functions, ab initio  . . . . . . . . . . . . #293
bond length, constrain . . . . #113, #116, #141
bond length, set . . . . . . . . . . . . . . . #82, #100

bond order  . . . . . . . . . . . . . . . . . . . . . . #111
bond torsion  . . . . . . . . . . . . . . . . . . . . . #102
bond torsion, constrain  . . . . . . . . . . . . . #118
bond, bond-down constraint . . . . . . . . . #122
bond, bond-up constraint  . . . . . . . . . . . #121
bond, create or delete  . . . . . . . . . . . . . . #111
bond, cycle stereo  . . . . . . . . . . . . . . . . . #125
bond-color . . . . . . . . . . . . . . . . . . . . . . . . #11
bonded atoms . . . . . . . . . . . . . . . . . . . . #501
bond-spacing-display-ratio . . . . . . . . . . . #199
Boolean variable, toggle . . . . . . . . . . . . . #547
boundary conditions, periodic . . . . . . . . #361
buffer size, ab initio  . . . . . . . . . . . . . . . . #289
build, model  . . . . . . . . . . . . . . . . . . . . . #131
builder-enforces-stereo . . . . . . . . . . . . . . #106
buttons, hide . . . . . . . . . . . . . . . . . . . . . #204

C

calculate types . . . . . . . . . . . . . . . . . . . . #135
calculation-method  . . . . . . . . . . . . . . . . #260
cancel  . . . . . . . . . . . . . . . . . . . . . . . . . . #486
cancel-menu  . . . . . . . . . . . . . . . . . . . . . #556
cancel-notify  . . . . . . . . . . . . . . . . . . . . . #460
change-stereochem . . . . . . . . . . . . . . . . #127
change-user-menuitem  . . . . . . . . . . . . . #479
charge density . . . . . . . . . . . . . . . . . . . . #438
charge, atom . . . . . . . . . . . . . . . . #108, #491
charge, residue  . . . . . . . . . . . . . . . . . . . #502
charge, set . . . . . . . . . . . . . . . . . . #108, #138
chi torsion angle, nucleic acid  . . . . . . . . #243
chirality  . . . . . . . . . . . . . . . . . . . . . . . . . #510
CI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . #300
ci-criterion . . . . . . . . . . . . . . . . . . . . . . . #304
ci-excitation-energy . . . . . . . . . . . . . . . . #303
ci-occupied-orbitals  . . . . . . . . . . . . . . . . #301
ci-unoccupied-orbitals  . . . . . . . . . . . . . . #302
clear selection  . . . . . . . . . . . . . . . . . . . . . #85
clear workspace . . . . . . . . . . . . . . . . . . . . #58
client, execute  . . . . . . . . . . . . . . . #477, #478
clip z  . . . . . . . . . . . . . . . . . . . . . . . . . . . . #97
clip, back . . . . . . . . . . . . . . . . . . . . . . . . . #72
clip, front . . . . . . . . . . . . . . . . . . . . . . . . . #71
clipboard . . . . . . . . . . . . . . . . . . . . . . . . . #44
clipboard destination, image  . . . . . . . . . . #44
clip-cursor  . . . . . . . . . . . . . . . . . . . . . . . . #29
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Message Cross-Reference
clip-icon-step  . . . . . . . . . . . . . . . . . . . . . #35
color, 24-bit  . . . . . . . . . . . . . . . . . . . . . . #41
color, atom . . . . . . . . . . . . . . . . . . . . . . #495
color, bond . . . . . . . . . . . . . . . . . . . . . . . #11
color, cylinders  . . . . . . . . . . . . . . . . . . . #186
color, element . . . . . . . . . . #211, #212, #231
color, image  . . . . . . . . . . . . . . . . . . . . . . #46
color, negative orbitals  . . . . . . . . . . . . . . #14
color, positive orbitals . . . . . . . . . . . . . . . #13
color, selection  . . . . . . . . . . . . . . . #12, #230
color, window . . . . . . . . . . . . . . . . . . . . . #10
color-selection . . . . . . . . . . . . . . . . . . . . #210
commands, help . . . . . . . . . . . . . . . . . . #533
comments, log  . . . . . . . . . . . . . . . . #53, #65
compare files . . . . . . . . . . . . . . . . . . . . . . #57
compile parameter file  . . . . . . . . . . . . . #329
compile type rules . . . . . . . . . . . . . . . . . #136
compile-script-file  . . . . . . . . . . . . . . . . . #481
complement selection . . . . . . . . . . . . . . #167
CONECT records, PDB file . . . . . . . . . . . . . #8
configuration  . . . . . . . . . . . . . . . . . . . . #299
configuration-interaction . . . . . . . . . . . . #300
connectivity-in-pdb-file . . . . . . . . . . . . . . . #8
constant temp, dynamics  . . . . . . . . . . . #381
constant, huckel  . . . . . . . . . . . . . . . . . . #272
constant, huckel, weighted . . . . . . . . . . #274
constrain bond angle  . . . . . . . . . #114, #142
constrain bond length . . . . . . . . . #113, #141
constrain bond torsion  . . . . . . . . #115, #143
constrain geometry . . . . . . . . . . . #112, #140
constrain stereochemistry  . #121, #122, #123, 

#124, #125, #126, #127
constrain torsion . . . . . . . . . . . . . . . . . . #143
constrain-bond-up  . . . . . . . . . . . . . . . . #121
constrain-change-stereo  . . . . . . . . . . . . #124
constrain-fix-stereo  . . . . . . . . . . . . . . . . #123
constraint, remove  . . . . . . #116, #117, #118
constraint, remove all stereo constraints  #120
constraint, remove stereo  . . . . . . . . . . . #119
constraint-bond-down  . . . . . . . . . . . . . #122
contour color  . . . . . . . . . . . . . . . . . #13, #14
contour graph increment  . . . . . . . . . . . #355
contour graph levels  . . . . . . . . . . . . . . . #352
contour graph, data type  . . . . . . . . . . . #344
contour graph, offset  . . . . . . . . . . . . . . #353
contour graph, orbital selection  . . . . . . #346
contour graph, start value . . . . . . #354, #356

contour increment  . . . . . . . . . . . . . . . . .#357
contour plot  . . . . . . . . . . . . . . . . . . . . . .#438
convergence limit, optimization  . . . . . . .#359
convergence report, optimization . . . . . .#363
convergence, ab initio SCF  . . . . . . . . . . .#294
convergence, accelerate  . . . . . . . . . . . . .#278
convergence, SCF . . . . . . . . . . . . . . . . . .#276
cool steps, monte carlo . . . . . . . . . . . . . .#370
cool time, dynamics  . . . . . . . . . . . . . . . .#366
coordinate, residue . . . . . . . . . . . . . . . . .#504
coordinates . . . . . . . . . . . . . . . . . . . . . . .#500
coordination . . . . . . . . . . . . . . . . . . . . . .#509
copy image . . . . . . . . . . . . . . . . . . . . . . . .#90
copy selection . . . . . . . . . . . . . . . . . . . . . .#87
correlation energy . . . . . . . . . . . . . . . . . .#527
correlation energy, MP2  . . . . . . . . . . . . .#297
count atoms  . . . . . . . . . . . . . . . . . . . . . .#506
count molecules  . . . . . . . . . . . . . . . . . . .#505
count orbitals  . . . . . . . . . . . . . . . . . . . . .#508
count residues . . . . . . . . . . . . . . . . . . . . .#507
count, neighbors . . . . . . . . . . . . . . . . . . .#509
counter ions, add  . . . . . . . . . . . . . . . . . .#258
CPK rendering, display buffering . . . . . . .#195
cpk-max-double-buffer-atoms . . . . . . . . .#195
create-atom  . . . . . . . . . . . . . . . . . . . . . .#109
current-file-name  . . . . . . . . . . . . . . . . . . . .#1
cursor, include in image  . . . . . . . . . . . . . .#45
cursor, xy rotation . . . . . . . . . . . . . . . . . . .#15
cursor, z clip . . . . . . . . . . . . . . . . . . . . . . .#29
cursor, z rotation . . . . . . . . . . . . . . . . . . . .#18
cursor, z translation . . . . . . . . . . . . . . . . . .#27
cursor, zoom . . . . . . . . . . . . . . . . . . . . . . .#28
custom-title . . . . . . . . . . . . . . . . . . . . . . .#566
cut selection . . . . . . . . . . . . . . . . . . . . . . .#86
cutoff, ab initio . . . . . . . . . . . . . . . . . . . .#288
cutoff-inner-radius  . . . . . . . . . . . . . . . . .#270
cutoff-outer-radius  . . . . . . . . . . . . . . . . .#271
cutoff-type  . . . . . . . . . . . . . . . . . . . . . . .#269
cycle-atom-stereo . . . . . . . . . . . . . . . . . .#126
cycle-bond-stereo . . . . . . . . . . . . . . . . . .#125
cylinders-color-by-element  . . . . . . . . . . .#186
cylinders-width-ratio . . . . . . . . . . . . . . . .#185

D

d orbitals, ab initio  . . . . . . . . . . . . . . . . .#295
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Message Cross-Reference
data collection period, dynamics  . . . . . . #384
data, graph  . . . . . . . . . . . . . . . . . . . . . . #345
data, mechanics . . . . . . . . . . . . . . #553, #554
DDE, help . . . . . . . . . . . . . . . . . . . . . . . . #535
declare-integer . . . . . . . . . . . . . . . . . . . . #542
declare-string . . . . . . . . . . . . . . . . . . . . . #543
default element  . . . . . . . . . . . . . . #104, #129
default menu, use  . . . . . . . . . . . . . . . . . #552
default setting, info  . . . . . . . . . . . . . . . . #562
defaults, restore  . . . . . . . . . . . . . . . . . . . #549
delete-atom . . . . . . . . . . . . . . . . . . . . . . #110
delete-file . . . . . . . . . . . . . . . . . . . . . . . . . #56
delete-named-selection  . . . . . . . . . . . . . #160
delete-selected-atoms . . . . . . . . . . . . . . . . #76
delta torsion angle, nucleic acid . . . . . . . #240
delta, maximum, Monte Carlo . . . . . . . . #371
deselect all . . . . . . . . . . . . . . . . . . . . . . . #153
diameter, cylinders . . . . . . . . . . . . . . . . . #185
diameters, balls  . . . . . . . . . . . . . . . . . . . #181
dielectric constant, method for . . . . . . . . #264
dielectric constant, scale factor . . . . . . . . #265
DIIS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . #278
dipole moment  . . . . . . . . . . . . . . #415, #416
dipole moment, display  . . . . . . . . . . . . . #228
dipole, export  . . . . . . . . . . . . . . . . . #19, #55
dipole, import  . . . . . . . . . . . . . . . . . #23, #54
dipole, uv components . . . . . . . . . . . . . . #407
dipole, uv total . . . . . . . . . . . . . . . . . . . . #406
dipole, uv transition . . . . . . . . . . . . . . . . #408
dipole-moment  . . . . . . . . . . . . . . . . . . . #415
dipole-moment-components  . . . . . . . . . #416
dipoles, show . . . . . . . . . . . . . . . . . . . . . #203
direct scf calculation, ab initio  . . . . . . . . #292
directory, current . . . . . . . . . . . . . . . . . . . . #2
display buffering  . . . . . . . . . . . . . #194, #195
DNA, A form  . . . . . . . . . . . . . . . . . . . . . #250
DNA, B form  . . . . . . . . . . . . . . . . . . . . . #251
DNA, Z form  . . . . . . . . . . . . . . . . . . . . . #252
do-langevin-dynamics  . . . . . . . . . . . . . . #426
do-molecular-dynamics  . . . . . . . . . . . . . #425
do-monte-carlo  . . . . . . . . . . . . . . . . . . . #427
do-optimization . . . . . . . . . . . . . . . . . . . #423
do-qm-calculation  . . . . . . . . . . . . . . . . . #331
do-qm-graph . . . . . . . . . . . . . . . . . . . . . #332
do-qm-isosurface  . . . . . . . . . . . . . . . . . . #333
d-orbitals-on-second-row (huckel)  . . . . . #275
do-single-point . . . . . . . . . . . . . . . . . . . . #422

dot-surface-angle . . . . . . . . . . . . . . . . . . #193
double buffered atoms . . . . . . . . . . . . . . #195
double strand, nucleic acid  . . . . . . . . . . #245
double-buffered-display . . . . . . . . . . . . . #194
do-vibrational-analysis  . . . . . . . . . . . . . . #424
draw atom . . . . . . . . . . . . . . . . . . . . . . . #109
dynamics average, append . . . . . . . . . . . #428
dynamics graph, append . . . . . . . . . . . . #429
dynamics screen refresh period  . . . . . . . #362
dynamics, Langevin, calculate  . . . . . . . . #426
dynamics-average-period . . . . . . . . . . . . #387
dynamics-bath-relaxation-time . . . . . . . . #382
dynamics-collection-period  . . . . . . . . . . #384
dynamics-constant-temp  . . . . . . . . . . . . #381
dynamics-cool-time  . . . . . . . . . . . . . . . . #366
dynamics-final-temp  . . . . . . . . . . . . . . . #374
dynamics-friction-coefficient  . . . . . . . . . #383
dynamics-heat-time . . . . . . . . . . . . . . . . #364
dynamics-info-elapsed-time . . . . . . . . . . #515
dynamics-info-kinetic-energy . . . . . . . . . #513
dynamics-info-last-update  . . . . . . . . . . . #516
dynamics-info-potential-energy  . . . . . . . #512
dynamics-info-temperature  . . . . . . . . . . #514
dynamics-info-total-energy  . . . . . . . . . . #511
dynamics-playback . . . . . . . . . . . . . . . . . #377
dynamics-playback-end  . . . . . . . . . . . . . #379
dynamics-playback-period . . . . . . . . . . . #380
dynamics-playback-start . . . . . . . . . . . . . #378
dynamics-restart  . . . . . . . . . . . . . . . . . . #376
dynamics-run-time . . . . . . . . . . . . . . . . . #365
dynamics-seed . . . . . . . . . . . . . . . . . . . . #388
dynamics-simulation-temp . . . . . . . . . . . #373
dynamics-snapshot-filename  . . . . . . . . . #385
dynamics-snapshot-period . . . . . . . . . . . #386
dynamics-starting-temp . . . . . . . . . . . . . #372
dynamics-temp-step  . . . . . . . . . . . . . . . #375
dynamics-time-step  . . . . . . . . . . . . . . . . #367

E

eigenvalue, scf . . . . . . . . . . . . . . . . . . . . #410
eigenvector, scf alpha  . . . . . . . . . . . . . . #411
eigenvector, scf beta  . . . . . . . . . . . . . . . #412
elapsed time, molecular dynamics  . . . . . #515
electronic spectrum, compute  . . . . . . . . #441
electrostatic potential . . . . . . . . . . . . . . . #438
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Message Cross-Reference
electrostatic scale factor  . . . . . . . . . . . . #266
electrostatics, mechanics mmp  . . . . . . . #268
element color  . . . . . . . . . . . . . . . #211, #231
element color, revert . . . . . . . . . . . . . . . #212
element, default  . . . . . . . . . . . . . #104, #129
element, symbol . . . . . . . . . . . . . . . . . . #489
energy, bend . . . . . . . . . . . . . . . . . . . . . #522
energy, ci excitation  . . . . . . . . . . . . . . . #303
energy, electrostatic  . . . . . . . . . . . . . . . #526
energy, hydrogen bond  . . . . . . . . . . . . #525
energy, MP2 . . . . . . . . . . . . . . . . . . . . . #527
energy, nonbonded  . . . . . . . . . . . . . . . #524
energy, scf  . . .#417, #418, #419, #420, #421
energy, stretch  . . . . . . . . . . . . . . . . . . . #521
energy, torsion  . . . . . . . . . . . . . . . . . . . #523
energy, total  . . . . . . . . . . . . . . . . . . . . . #520
energy, uv . . . . . . . . . . . . . . . . . . . . . . . #404
enlarge  . . . . . . . . . . . . . . . . . . . . . . #34, #96
ensemble averaging, calculate . . . . . . . . #427
enum id, info  . . . . . . . . . . . . . . . . . . . . #560
enum list, info . . . . . . . . . . . . . . . . . . . . #561
epsilon torsion angle, nucleic acid . . . . . #241
erase atom  . . . . . . . . . . . . . . . . . . . . . . #110
erase atoms . . . . . . . . . . . . . . . . . . . #76, #85
erase file  . . . . . . . . . . . . . . . . . . . . . . . . . #56
error  . . . . . . . . . . . . . . . . . . . . . . . . . . . #469
error message format  . . . . . . . . . #471, #472
errors-are-not-omsgs . . . . . . . . . . . . . . . #465
errors-are-omsgs . . . . . . . . . . . . . . . . . . #464
estatic-energy  . . . . . . . . . . . . . . . . . . . . #526
excited state, electronic . . . . . . . . . . . . . #300
excited-state  . . . . . . . . . . . . . . . . . . . . . #282
execute-client  . . . . . . . . . . . . . . . . . . . . #477
execute-hyperchem-client . . . . . . . . . . . #478
execute-string . . . . . . . . . . . . . . . . . . . . #483
exit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . #70
exit-script  . . . . . . . . . . . . . . . . . . . . . . . #480
expand  . . . . . . . . . . . . . . . . . . . . . . . . . . #81
explicit hydrogens . . . . . . . . . . . . #103, #128
export quantum results . . . . . . . . . . . . . . #66
export-dipole  . . . . . . . . . . . . . . . . . . . . . #19
export-ir  . . . . . . . . . . . . . . . . . . . . . . . . . #20
export-orbitals . . . . . . . . . . . . . . . . . . . . . #21
export-property-file . . . . . . . . . . . . . . . . . #55
export-uv  . . . . . . . . . . . . . . . . . . . . . . . . #22
extend ring . . . . . . . . . . . . . . . . . . . . . . #170
extend side chain  . . . . . . . . . . . . . . . . . #171

extend to sp3  . . . . . . . . . . . . . . . . . . . . .#172
extended atom . . . . . . . . . . . . . . . . . . . .#499
extra basis set, atom . . . . . . . . . . . . . . . .#494

F

factory setting, info . . . . . . . . . . . . . . . . .#562
factory-settings . . . . . . . . . . . . . . . . . . . .#549
file comparison . . . . . . . . . . . . . . . . . . . . .#57
file destination, image . . . . . . . . . . . . . . . .#43
file merging  . . . . . . . . . . . . . . . . . . . . . . .#17
file path  . . . . . . . . . . . . . . . . . . . . . . . . . . .#2
file, delete . . . . . . . . . . . . . . . . . . . . . . . . .#56
file, hin . . . . . . . . . . . . . . . . . . . . . . . . . . . .#5
file, merge  . . . . . . . . . . . . . . . . . . . .#48, #60
file, new  . . . . . . . . . . . . . . . . . . . . . . . . . .#58
file, open  . . . . . . . . . . . . . . . . . . . . .#47, #59
file, save  . . . . . . . . . . . . . . . . . . . . . . . . . .#61
file, save-as  . . . . . . . . . . . . . . . . . . . . . . . .#62
file, write . . . . . . . . . . . . . . . . . . . . . . . . . .#49
file-diff-message  . . . . . . . . . . . . . . . . . . . .#57
file-format . . . . . . . . . . . . . . . . . . . . . . . . . .#3
filename for current system . . . . . . . . . . . . .#1
filename, snapshots . . . . . . . . . . . . . . . . .#385
file-needs-saved  . . . . . . . . . . . . . . . . . . . . .#4
final temp, dynamics . . . . . . . . . . . . . . . .#374
force field parameters changed . . . . . . . .#305
format, file (HIN, ENT, etc.)  . . . . . . . . . . . .#3
frequency, ir . . . . . . . . . . . . . . . . . . . . . .#399
friction coefficient, dynamics . . . . . . . . . .#383
front-clip . . . . . . . . . . . . . . . . . . . . . . . . . .#71
frozen core, MP2  . . . . . . . . . . . . . . . . . .#298

G

gamma torsion angle, nucleic acid  . . . . .#239
geometry optimization, algorithm . . . . . .#358
geometry optimization, compute  .#423, #432
geometry, constrain  . . . . . . . . . . .#112, #140
ghost atoms, ab initio . . . . . . . . . . . . . . .#293
global-inhibit-redisplay  . . . . . . . . . . . . . .#455
glossary, help  . . . . . . . . . . . . . . . . . . . . .#537
gradient, calculate ab initio . . . . . . . . . . .#296
gradient, rms  . . . . . . . . . . . . . . . . . . . . .#519
graph contours . . . . . . . . . . . . . . . . . . . .#332
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Message Cross-Reference
graph-beta . . . . . . . . . . . . . . . . . . . . . . . #347
graph-contour-increment . . . . . . . . . . . . #355
graph-contour-increment-other . . . . . . . #357
graph-contour-levels  . . . . . . . . . . . . . . . #352
graph-contour-start  . . . . . . . . . . . . . . . . #354
graph-contour-start-other  . . . . . . . . . . . #356
graph-data-row  . . . . . . . . . . . . . . . . . . . #345
graph-data-type . . . . . . . . . . . . . . . . . . . #344
graph-horizontal-grid-size  . . . . . . . . . . . #348
graph-orbital-offset  . . . . . . . . . . . . . . . . #350
graph-orbital-selection-type . . . . . . . . . . #346
graph-plane-offset  . . . . . . . . . . . . . . . . . #353
graph-vertical-grid-size . . . . . . . . . . . . . . #349
greyscale, image  . . . . . . . . . . . . . . . . . . . #46
grid data, isosurface .#336, #337, #338, #339, 

#340, #341
grid step size, isosurface . . . . . . . . . . . . . #335
grid, contour graph  . . . . . . . . . . . #348, #349
grid, isosurface . . . . . . . . . . . . . . . . . . . . #430
grid-max-value . . . . . . . . . . . . . . . . . . . . #188
grid-min-value  . . . . . . . . . . . . . . . . . . . . #187

H

hbond-energy  . . . . . . . . . . . . . . . . . . . . #525
heat steps, Monte Carlo . . . . . . . . . . . . . #368
heat time, dynamics . . . . . . . . . . . . . . . . #364
heat-of-formation . . . . . . . . . . . . . . . . . . #421
height, window  . . . . . . . . . . . . . . . . . . . #567
help . . . . . . . . . . . . . . . . . . . . . . . . . . . . #530
help, using . . . . . . . . . . . . . . . . . . . . . . . #538
help-commands . . . . . . . . . . . . . . . . . . . #533
help-glossary  . . . . . . . . . . . . . . . . . . . . . #537
help-index  . . . . . . . . . . . . . . . . . . . . . . . #531
help-keyboard  . . . . . . . . . . . . . . . . . . . . #532
help-tools . . . . . . . . . . . . . . . . . . . . . . . . #534
hide selection . . . . . . . . . . . . . . . . . . . . . #217
hide-toolbar . . . . . . . . . . . . . . . . . . . . . . #204
highlights, balls  . . . . . . . . . . . . . . . . . . . #180
highlights, spheres . . . . . . . . . . . . . . . . . #183
hin file contents . . . . . . . . . . . . . . . . . . #5, #6
hin file, velocities  . . . . . . . . . . . . . . . . . . . . #5
horizontal grid size, contour . . . . . . . . . . #348
host name, backend . . . . . . . . . . . . . . . . #308
huckel method, d-orbitals  . . . . . . . . . . . #275
huckel-constant  . . . . . . . . . . . . . . . . . . . #272

huckel-scaling-factor  . . . . . . . . . . . . . . . #273
huckel-weighted  . . . . . . . . . . . . . . . . . . #274
hydrogen bonds, recompute  . . . . . . . . . #226
hydrogen bonds, show  . . . . . . . . #200, #225
hydrogen, extended atom . . . . . . . . . . . #499
hydrogens, add  . . . . . . . . . . . . . . . . . . . #130
hydrogens, explicit . . . . . . . . . . . . #103, #128
hydrogens, show . . . . . . . . . . . . . #196, #222
hydrogens-in-pdb-file . . . . . . . . . . . . . . . . . #7
HyperChem, about  . . . . . . . . . . . . . . . . #539

I

icon, xy rotation . . . . . . . . . . . . . . . . . . . . #30
icon, xy translation . . . . . . . . . . . . . . . . . . #32
icon, z clip . . . . . . . . . . . . . . . . . . . . . . . . #35
icon, z rotation . . . . . . . . . . . . . . . . . . . . . #31
icon, z translation . . . . . . . . . . . . . . . . . . . #33
icon, zoom . . . . . . . . . . . . . . . . . . . . . . . . #34
icons, hide . . . . . . . . . . . . . . . . . . . . . . . #204
id, info . . . . . . . . . . . . . . . . . . . . . . . . . . #563
ignore-script-errors  . . . . . . . . . . . . . . . . #444
image file . . . . . . . . . . . . . . . . . . . . . . . . . #43
image, copy . . . . . . . . . . . . . . . . . . . . . . . #90
image, setup  . . . . . . . . . . . . . . . . . . #39, #91
image-color . . . . . . . . . . . . . . . . . . . . . . . #46
image-destination-clipboard  . . . . . . . . . . #44
image-destination-file  . . . . . . . . . . . . . . . #43
image-file-bitmap . . . . . . . . . . . . . . . . . . . #40
image-file-bitmapRGB  . . . . . . . . . . . . . . . #41
image-file-metafile . . . . . . . . . . . . . . . . . . #42
image-include-cursor . . . . . . . . . . . . . . . . #45
image-source-window  . . . . . . . . . . . . . . . #39
import quantum results  . . . . . . . . . . . . . . #67
import-dipole . . . . . . . . . . . . . . . . . . . . . . #23
import-ir  . . . . . . . . . . . . . . . . . . . . . . . . . #24
import-orbitals . . . . . . . . . . . . . . . . . . . . . #25
import-property-file . . . . . . . . . . . . . . . . . #54
import-uv . . . . . . . . . . . . . . . . . . . . . . . . . #26
include file . . . . . . . . . . . . . . . . . . . . . . . . #60
include structure  . . . . . . . . . . . . . . . . . . . #48
index, help . . . . . . . . . . . . . . . . . . . . . . . #531
inertial axes  . . . . . . . . . . . . . . . . . . . . . . #202
inertial axes, show  . . . . . . . . . . . . . . . . . #227
info, atom  . . . . . . . . . . . . . . . . . . . . . . . #555
info, mechanics  . . . . . . . . . . . . . . #553, #554
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info-access  . . . . . . . . . . . . . . . . . . . . . . #559
info-enum-id-of . . . . . . . . . . . . . . . . . . . #560
info-enum-list  . . . . . . . . . . . . . . . . . . . . #561
info-factory-setting  . . . . . . . . . . . . . . . . #562
info-id-of . . . . . . . . . . . . . . . . . . . . . . . . #563
info-type-of . . . . . . . . . . . . . . . . . . . . . . #564
info-type-of-element . . . . . . . . . . . . . . . #565
info-variable-target  . . . . . . . . . . . . . . . . #557
inhibit-redisplay  . . . . . . . . . . . . . . . . . . #454
inner radius, cutoff  . . . . . . . . . . . . . . . . #270
integer, declare . . . . . . . . . . . . . . . . . . . #542
integral buffer, ab initio . . . . . . . . . . . . . #289
integral format, ab initio  . . . . . . . . . . . . #290
integral storage path, ab initio  . . #291, #292
integral threshold, ab initio . . . . . . . . . . #288
intensity, ir  . . . . . . . . . . . . . . . . . . . . . . #400
intensity, ir components  . . . . . . . . . . . . #401
invert  . . . . . . . . . . . . . . . . . . . . . . . . . . . #92
ionic ends, remove  . . . . . . . . . . . . . . . . #256
ions, allow . . . . . . . . . . . . . . . . . . #105, #132
IR spectra, export  . . . . . . . . . . . . . . . . . . #55
IR spectra, import  . . . . . . . . . . . . . . . . . . #54
IR spectrum, export . . . . . . . . . . . . . . . . . #20
IR spectrum, import  . . . . . . . . . . . . . . . . #24
IR spectrum, read  . . . . . . . . . . . . . . . . . . #67
IR spectrum, save  . . . . . . . . . . . . . . . . . . #66
ir-animate-amplitude . . . . . . . . . . . . . . . #394
ir-animate-cycles . . . . . . . . . . . . . . . . . . #396
ir-animate-steps . . . . . . . . . . . . . . . . . . . #395
ir-band-count  . . . . . . . . . . . . . . . . . . . . #398
ir-frequency . . . . . . . . . . . . . . . . . . . . . . #399
ir-intensity . . . . . . . . . . . . . . . . . . . . . . . #400
ir-intensity-components  . . . . . . . . . . . . #401
ir-normal-modes . . . . . . . . . . . . . . . . . . #402
is-extended-hydrogen . . . . . . . . . . . . . . #499
isis, copy sketch format . . . . . . . . . . . . . . #88
isomer, amino acid  . . . . . . . . . . . . . . . . #235
isosurface  . . . . . . . . . . . . . . . . . . . . . . . #438
isosurface display toggle  . . . . . . . . . . . . #221
isosurface, display type  . . . . . . . . . . . . . #220
isosurface, plot  . . . . . . . . . . . . . . . . . . . #333
isosurface, show  . . . . . . . . . . . . . . . . . . #201
isosurface-grid-step-size . . . . . . . . . . . . . #335
isosurface-hide-molecule . . . . . . . . . . . . #192
isosurface-map-function  . . . . . . . . . . . . #334
isosurface-map-function-display-legend . #342
isosurface-map-function-range  . . . . . . . #343

isosurface-mesh-quality . . . . . . . . . . . . . .#430
isosurface-render-method . . . . . . . . . . . .#190
isosurface-threshold  . . . . . . . . . . . . . . . .#189
isosurface-transparency-level . . . . . . . . . .#191
isosurface-x-min  . . . . . . . . . . . . . . . . . . .#339
isosurface-x-nodes . . . . . . . . . . . . . . . . . .#336
isosurface-y-min  . . . . . . . . . . . . . . . . . . .#340
isosurface-y-nodes . . . . . . . . . . . . . . . . . .#337
isosurface-z-min  . . . . . . . . . . . . . . . . . . .#341
isosurface-z-nodes . . . . . . . . . . . . . . . . . .#338
is-ring-atom  . . . . . . . . . . . . . . . . . . . . . .#498
iterations, scf . . . . . . . . . . . . . . . . . . . . . .#277

K

keyboard, help  . . . . . . . . . . . . . . . . . . . .#532
kinetic energy, molecular dynamics . . . . .#513

L

label, atom  . . . . . . . . . . . . . . . . . . . . . . .#496
labels  . . . . . . . . . . . . . . . . . . . . . . . . . . .#229
labels, atom  . . . . . . . . . . . . . . . . . . . . . .#205
labels, residue . . . . . . . . . . . . . . . . . . . . .#206
Langevin dynamics, calculate  . . . . . . . . .#426
Langevin dynamics, compute  . . . . . . . . .#434
last update, molecular dynamics . . . . . . .#516
legend, isosurface . . . . . . . . . . . . . . . . . .#342
length, bond . . . . . . . . . . . . . . . . . .#82, #100
length, constrain bond  . . . . . . . . . . . . . .#141
level, selection  . . . . . . . . . . . . . . . . . . . .#144
line width, bonds  . . . . . . . . . . . . . . . . . .#184
load structure  . . . . . . . . . . . . . . . . . .#47, #48
load-default-menu  . . . . . . . . . . . . . . . . .#552
load-user-menu . . . . . . . . . . . . . . . . . . . .#550
log comment  . . . . . . . . . . . . . . . . . .#53, #65
log, mechanics print level . . . . . . . . . . . .#389
log, quantum print level  . . . . . . . . . . . . .#390
log, start . . . . . . . . . . . . . . . . . . . . . .#51, #63
log, stop . . . . . . . . . . . . . . . . . . . . . .#52, #64

M

magnify  . . . . . . . . . . . . . . . . . . . . . .#81, #96
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mapped function display range  . . . . . . . #343
mapped function legend  . . . . . . . . . . . . #342
mapped function, isosurface  . . . . . . . . . #334
mass, atom  . . . . . . . . . . . . . . . . . . . . . . #492
mass, set  . . . . . . . . . . . . . . . . . . . . . . . . #139
max cycles, geometry optimization  . . . . #360
max-iterations, scf calculation  . . . . . . . . #277
mechanics-data  . . . . . . . . . . . . . . . . . . . #553
mechanics-dielectric . . . . . . . . . . . . . . . . #264
mechanics-dielectric-scale-factor  . . . . . . #265
mechanics-electrostatic-scale-factor  . . . . #266
mechanics-info . . . . . . . . . . . . . . . . . . . . #554
mechanics-mmp-electrostatics . . . . . . . . #268
mechanics-print-level . . . . . . . . . . . . . . . #389
mechanics-van-der-waals-scale-factor . . . #267
menu, load custom  . . . . . . . . . . . . . . . . #550
menu, use custom  . . . . . . . . . . . . . . . . . #551
menu, use default  . . . . . . . . . . . . . . . . . #552
menu-build-add-hydrogens  . . . . . . . . . . #130
menu-build-all-atoms . . . . . . . . . . . . . . . #134
menu-build-allow-ions  . . . . . . . . . . . . . . #132
menu-build-calculate-types  . . . . . . . . . . #135
menu-build-compile-type-rules . . . . . . . . #136
menu-build-constrain-bond-angle  . . . . . #142
menu-build-constrain-bond-length . . . . . #141
menu-build-constrain-bond-torsion  . . . . #143
menu-build-constrain-geometry . . . . . . . #140
menu-build-default-element . . . . . . . . . . #129
menu-build-explicit-hydrogen  . . . . . . . . #128
menu-build-model-build  . . . . . . . . . . . . #131
menu-build-set-atom-type  . . . . . . . . . . . #137
menu-build-set-charge . . . . . . . . . . . . . . #138
menu-build-set-mass  . . . . . . . . . . . . . . . #139
menu-build-united-atoms . . . . . . . . . . . . #133
menu-cancel  . . . . . . . . . . . . . . . . . . . . . #486
menu-compute-electronic-spectrum  . . . #441
menu-compute-geometry-optimization  . #432
menu-compute-langevin-dynamics  . . . . #434
menu-compute-molecular-dynamics  . . . #433
menu-compute-monte-carlo  . . . . . . . . . #435
menu-compute-orbitals  . . . . . . . . . . . . . #439
menu-compute-plot-molecular-properties #438
menu-compute-single-point . . . . . . . . . . #431
menu-compute-transition-state  . . . . . . . #437
menu-compute-vibrational-spectrum . . . #440
menu-compute-vibrations  . . . . . . . . . . . #436
menu-databases-add-counter-ions  . . . . . #258

menu-databases-amino-acids . . . . . . . . . #254
menu-databases-make-zwitterion . . . . . . #255
menu-databases-mutate . . . . . . . . . . . . . #259
menu-databases-nucleic-acids  . . . . . . . . #257
menu-databases-remove-ionic-ends . . . . #256
menu-display-color  . . . . . . . . . . . . . . . . #230
menu-display-element-color . . . . . . . . . . #231
menu-display-hide-selection . . . . . . . . . . #217
menu-display-isosurface . . . . . . . . . . . . . #220
menu-display-labels . . . . . . . . . . . . . . . . #229
menu-display-last-rendering . . . . . . . . . . #219
menu-display-overlay . . . . . . . . . . . . . . . #214
menu-display-recompute-h-bonds . . . . . #226
menu-display-rendering . . . . . . . . . . . . . #218
menu-display-scale-to-fit  . . . . . . . . . . . . #213
menu-display-show-all . . . . . . . . . . . . . . #215
menu-display-show-dipole-moment . . . . #228
menu-display-show-hydrogen-bonds . . . #225
menu-display-show-hydrogens  . . . . . . . #222
menu-display-show-inertial-axes  . . . . . . #227
menu-display-show-isosurface  . . . . . . . . #221
menu-display-show-multiple-bonds . . . . #224
menu-display-show-periodic-box . . . . . . #223
menu-display-show-selection-only  . . . . . #216
menu-edit-align-molecules . . . . . . . . . . . . #99
menu-edit-align-viewer  . . . . . . . . . . . . . . #98
menu-edit-clear  . . . . . . . . . . . . . . . . . . . . #85
menu-edit-copy . . . . . . . . . . . . . . . . . . . . #87
menu-edit-copy-image . . . . . . . . . . . . . . . #90
menu-edit-copy-isis-sketch . . . . . . . . . . . . #88
menu-edit-cut  . . . . . . . . . . . . . . . . . . . . . #86
menu-edit-invert  . . . . . . . . . . . . . . . . . . . #92
menu-edit-paste . . . . . . . . . . . . . . . . . . . . #89
menu-edit-reflect . . . . . . . . . . . . . . . . . . . #93
menu-edit-rotate  . . . . . . . . . . . . . . . . . . . #94
menu-edit-set-bond-angle . . . . . . . . . . . #101
menu-edit-set-bond-length  . . . . . . . . . . #100
menu-edit-set-bond-torsion . . . . . . . . . . #102
menu-edit-setup-image  . . . . . . . . . . . . . . #91
menu-edit-translate  . . . . . . . . . . . . . . . . . #95
menu-edit-z-clip . . . . . . . . . . . . . . . . . . . . #97
menu-edit-zoom  . . . . . . . . . . . . . . . . . . . #96
menu-file-exit . . . . . . . . . . . . . . . . . . . . . . #70
menu-file-export  . . . . . . . . . . . . . . . . . . . #66
menu-file-import  . . . . . . . . . . . . . . . . . . . #67
menu-file-log-comments  . . . . . . . . . . . . . #65
menu-file-merge  . . . . . . . . . . . . . . . . . . . #60
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menu-file-new . . . . . . . . . . . . . . . . . . . . . #58
menu-file-open  . . . . . . . . . . . . . . . . . . . . #59
menu-file-preferences  . . . . . . . . . . . . . . . #69
menu-file-print  . . . . . . . . . . . . . . . . . . . . #68
menu-file-quit . . . . . . . . . . . . . . . . . . . . . #70
menu-file-save . . . . . . . . . . . . . . . . . . . . . #61
menu-file-save-as . . . . . . . . . . . . . . . . . . . #62
menu-file-start-log . . . . . . . . . . . . . . . . . . #63
menu-file-stop-log . . . . . . . . . . . . . . . . . . #64
menu-help-about-hyperchem  . . . . . . . . #539
menu-help-commands  . . . . . . . . . . . . . #533
menu-help-glossary . . . . . . . . . . . . . . . . #537
menu-help-index . . . . . . . . . . . . . . . . . . #531
menu-help-keyboard . . . . . . . . . . . . . . . #532
menu-help-on-scripts  . . . . . . . . . . . . . . #536
menu-help-scripts-and-dde . . . . . . . . . . #535
menu-help-tools  . . . . . . . . . . . . . . . . . . #534
menu-help-using-help . . . . . . . . . . . . . . #538
menu-script-one . . . ten  . . . . . . . . . . . . #485
menu-script-open-script  . . . . . . . . . . . . #484
menu-select-atoms  . . . . . . . . . . . . . . . . #161
menu-select-complement-selection . . . . #167
menu-select-extend-ring . . . . . . . . . . . . #170
menu-select-extend-side-chain  . . . . . . . #171
menu-select-extend-to-sp3  . . . . . . . . . . #172
menu-select-molecules  . . . . . . . . . . . . . #163
menu-select-multiple-selections . . . . . . . #164
menu-select-name-selection  . . . . . . . . . #169
menu-select-residues . . . . . . . . . . . . . . . #162
menu-select-select . . . . . . . . . . . . . . . . . #168
menu-select-select-all  . . . . . . . . . . . . . . #166
menu-select-select-backbone  . . . . . . . . #173
menu-select-select-sphere . . . . . . . . . . . #165
menu-setup-ab-initio . . . . . . . . . . . . . . . #323
menu-setup-compile-parameter-file . . . . #329
menu-setup-molecular-mechanics . . . . . #321
menu-setup-network . . . . . . . . . . . . . . . #324
menu-setup-parameter-set  . . . . . . . . . . #328
menu-setup-periodic-box  . . . . . . . . . . . #325
menu-setup-reaction-map . . . . . . . . . . . #330
menu-setup-restraints  . . . . . . . . . . . . . . #326
menu-setup-semi-empirical . . . . . . . . . . #322
menu-setup-set-velocity  . . . . . . . . . . . . #327
merge file  . . . . . . . . . . . . . . . . . . . . #48, #60
merged systems, translate . . . . . . . . . . . . #17
mesh, isosurface  . . . . . . . . . . . . . . . . . . #430
message  . . . . . . . . . . . . . . . . . . . . . . . . #468

metafile image  . . . . . . . . . . . . . . . . . . . . .#42
method, calculation  . . . . . . . . . . . . . . . .#260
method, molecular mechanics  . . . . . . . .#261
method, semi-empirical  . . . . . . . . . . . . .#262
microstate, CI . . . . . . . . . . . . . . . . . . . . .#300
mmp, electrostatics . . . . . . . . . . . . . . . . .#268
mo initial guess, ab initio  . . . . . . . . . . . .#287
mode, vibrational  . . . . . . . . . . . . . . . . . .#397
model build  . . . . . . . . . . . . . . . . . . . . . .#131
molecular dynamics, compute  . . .#425, #433
molecular mechanics, setup  . . . . . . . . . .#321
molecular orbital, number of coefficients #351
molecular properties, compute . . . . . . . .#438
molecular-mechanics-method . . . . . . . . .#261
molecule hide . . . . . . . . . . . . . . . . . . . . .#192
molecule, align . . . . . . . . . . . . . . . . .#74, #99
molecule-count . . . . . . . . . . . . . . . . . . . .#505
molecules, rotate  . . . . . . . . . . . . . . . . . . .#78
Monte Carlo, calculate  . . . . . . . . . . . . . .#427
Monte Carlo, compute  . . . . . . . . . . . . . .#435
monte-carlo-cool-steps  . . . . . . . . . . . . . .#370
monte-carlo-heat-steps . . . . . . . . . . . . . .#368
monte-carlo-info-acceptance-ratio  . . . . .#517
monte-carlo-max-delta . . . . . . . . . . . . . .#371
monte-carlo-run-steps . . . . . . . . . . . . . . .#369
mouse-mode  . . . . . . . . . . . . . . . . . . . . . .#73
move molecules  . . . . . . . . . . . . . . . .#80, #95
move viewer . . . . . . . . . . . . . . . . . . . #79, #95
MP2 correlation energy . . . . . . . . . . . . . .#297
MP2 frozen core . . . . . . . . . . . . . . . . . . .#298
mp2-energy  . . . . . . . . . . . . . . . . . . . . . .#527
multiple bonds display  . . . . . . . . . . . . . .#199
multiple bonds, show  . . . . . . . . . .#198, #224
multiple selections  . . . . . . . . . . . . . . . . .#164
multiple-selections  . . . . . . . . . . . . . . . . .#147
multiplicity  . . . . . . . . . . . . . . . . . . . . . . .#280
mutate residue  . . . . . . . . . . . . . . .#253, #259

N

name selection  . . . . . . . . . . . . . . . . . . . .#169
name, atom  . . . . . . . . . . . . . . . . . . . . . .#487
name, residue . . . . . . . . . . . . . . . . . . . . .#503
named selection, delete  . . . . . . . . . . . . .#160
named selection, select . . . . . . . . . . . . . .#154
named-selection-count . . . . . . . . . . . . . .#149
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named-selection-name . . . . . . . . . . . . . . #150
named-selection-value  . . . . . . . . . . . . . . #151
name-selection . . . . . . . . . . . . . . . . . . . . #159
negatives-color . . . . . . . . . . . . . . . . . . . . . #14
neighbors . . . . . . . . . . . . . . . . . . . . . . . . #501
neighbors, count  . . . . . . . . . . . . . . . . . . #509
network setup  . . . . . . . . . . . . . . . . . . . . #324
nonbond-energy  . . . . . . . . . . . . . . . . . . #524
non-standard-pdb-names . . . . . . . . . . . . . . #9
normal modes, ir  . . . . . . . . . . . . . . . . . . #402
no-source-refs-in-errors  . . . . . . . . . . . . . #472
notify variable  . . . . . . . . . . . . . . . . . . . . #541
notify-on-update  . . . . . . . . . . . . . . . . . . #459
nucleic acids, add . . . . . . . . . . . . . #249, #257
nucleic-a-form  . . . . . . . . . . . . . . . . . . . . #250
nucleic-alpha  . . . . . . . . . . . . . . . . . . . . . #237
nucleic-backwards  . . . . . . . . . . . . . . . . . #244
nucleic-beta . . . . . . . . . . . . . . . . . . . . . . #238
nucleic-b-form  . . . . . . . . . . . . . . . . . . . . #251
nucleic-chi  . . . . . . . . . . . . . . . . . . . . . . . #243
nucleic-delta . . . . . . . . . . . . . . . . . . . . . . #240
nucleic-double-strand . . . . . . . . . . . . . . . #245
nucleic-epsilon . . . . . . . . . . . . . . . . . . . . #241
nucleic-gamma  . . . . . . . . . . . . . . . . . . . #239
nucleic-sugar-pucker  . . . . . . . . . . . . . . . #236
nucleic-zeta  . . . . . . . . . . . . . . . . . . . . . . #242
nucleic-z-form  . . . . . . . . . . . . . . . . . . . . #252
number of selected atoms  . . . . . . . . . . . #145
number, atomic . . . . . . . . . . . . . . . . . . . #488
number, selected atom  . . . . . . . . . . . . . #146
number, serial  . . . . . . . . . . . . . . . . . . . . #529

O

occupancy, alpha orbital  . . . . . . . . . . . . #413
occupancy, beta orbital  . . . . . . . . . . . . . #414
omega torsion angle, amino acid . . . . . . #234
omsg string  . . . . . . . . . . . . . . . . . . . . . . #468
omsg to file, append  . . . . . . . . . . . . . . . #463
omsg-file  . . . . . . . . . . . . . . . . . . . . . . . . #457
omsgs-not-to-file  . . . . . . . . . . . . . . . . . . #462
omsgs-to-file  . . . . . . . . . . . . . . . . . . . . . #461
one-line-arrays  . . . . . . . . . . . . . . . . . . . . #558
opacity, isosurface  . . . . . . . . . . . . . . . . . #191
open file . . . . . . . . . . . . . . . . . . . . . . #47, #59
open script . . . . . . . . . . . . . . . . . . . . . . . #484

optim-algorithm  . . . . . . . . . . . . . . . . . . #358
optim-converged . . . . . . . . . . . . . . . . . . #363
optim-convergence  . . . . . . . . . . . . . . . . #359
optimization convergence limit, cycles . . #360
optimization, compute . . . . . . . . . #423, #432
optim-max-cycles . . . . . . . . . . . . . . . . . . #360
orbital color . . . . . . . . . . . . . . . . . . . #13, #14
orbital data, export  . . . . . . . . . . . . . . . . . #55
orbital data, export, quantum calculations, 

export  . . . . . . . . . . . . . . . . . . . . #21
orbital data, import  . . . . . . . . . . . . . . . . . #54
orbital data, import, quantum calculations, 

import . . . . . . . . . . . . . . . . . . . . #25
orbital occupancy  . . . . . . . . . . . . #413, #414
orbital offset, contour graph  . . . . . . . . . #350
orbital selection  . . . . . . . . . . . . . . . . . . . #346
orbital, beta or alpha  . . . . . . . . . . . . . . . #347
orbital, type to graph . . . . . . . . . . . . . . . #346
orbital-count  . . . . . . . . . . . . . . . . . . . . . #508
orbitals, ci occupied . . . . . . . . . . . . . . . . #301
orbitals, ci unoccupied . . . . . . . . . . . . . . #302
orbitals, compute . . . . . . . . . . . . . . . . . . #439
orbitals, read  . . . . . . . . . . . . . . . . . . . . . . #67
orbitals, save  . . . . . . . . . . . . . . . . . . . . . . #66
orient molecule  . . . . . . . . . . . . . . . . . . . . #74
orient molecules  . . . . . . . . . . . #78, #94, #99
orient viewer  . . . . . . . . . . #75, #77, #79, #98
oscillator, uv strength . . . . . . . . . . . . . . . #409
outer radius, cutoff . . . . . . . . . . . . . . . . . #271
overlay . . . . . . . . . . . . . . . . . . . . . . . . . . #214

P

parameter file, compile  . . . . . . . . . . . . . #329
parameter set, select  . . . . . . . . . . . . . . . #328
parameter set, use  . . . . . . . . . . . . . . . . . #316
parameter-set-changed  . . . . . . . . . . . . . #305
password, backend user . . . . . . . . . . . . . #310
paste  . . . . . . . . . . . . . . . . . . . . . . . . . . . . #89
path . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . #2
path, file  . . . . . . . . . . . . . . . . . . . . . . . . . . #2
pause-for  . . . . . . . . . . . . . . . . . . . . . . . . #458
pdb file, connectivity . . . . . . . . . . . . . . . . . #8
pdb file, hydrogens  . . . . . . . . . . . . . . . . . . #7
pdb file, non-standard names  . . . . . . . . . . #9
periodic boundaries, use conditions . . . .#317, 
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#318, #325, #361
periodic box, add  . . . . . . . . . . . . . . . . . #317
periodic box, setup . . . . . . . . . . . . . . . . #325
periodic box, show  . . . . . . . . . . . #197, #223
periodic box, size  . . . . . . . . . . . . . . . . . #318
perspective  . . . . . . . . . . . . . . . . . . . . . . #174
phi torsion angle, amino acid  . . . . . . . . #232
pi-pi, zindo/1 overlap weighting factor . #284
pi-pi, zindo/s overlap weighting factor  . #286
plane offset, contour graph . . . . . . . . . . #353
playback end, dynamics  . . . . . . . . . . . . #379
playback period, dynamics  . . . . . . . . . . #380
playback start, dynamics . . . . . . . . . . . . #378
playback, dynamics snaphots  . . . . . . . . #377
pop-no-value . . . . . . . . . . . . . . . . . . . . . #546
pop-value  . . . . . . . . . . . . . . . . . . . . . . . #545
positives-color . . . . . . . . . . . . . . . . . . . . . #13
potential energy, molecular dynamics . . #512
preferences . . . . . . . . . . . . . . . . . . . . . . . #69
print image . . . . . . . . . . . . . . . . . . . . . . . #68
print level, mechanics  . . . . . . . . . . . . . . #389
print level, quantum  . . . . . . . . . . . . . . . #390
printer-background-white . . . . . . . . . . . . #38
print-variable-list . . . . . . . . . . . . . . . . . . #548
process count, backend . . . . . . . . . . . . . #311
properties, molecular, compute . . . . . . . #438
property file, export  . . . . . . . . . . . . . . . . #55
property file, import  . . . . . . . . . . . . . . . . #54
psi torsion angle, amino acid . . . . . . . . . #233
pucker, nucleotide sugar . . . . . . . . . . . . #236
push  . . . . . . . . . . . . . . . . . . . . . . . . . . . #544

Q

qm isosurface, plot  . . . . . . . . . . . . . . . . #333
quantum calculation, do . . . . . . . . . . . . #331
quantum data, export . . . . . . . . . . . . . . . #55
quantum data, import . . . . . . . . . . . . . . . #54
quantum-print-level  . . . . . . . . . . . . . . . #390
quantum-total-charge . . . . . . . . . . . . . . #279
query-response-has-tag . . . . . . . . . . . . . #443
query-value . . . . . . . . . . . . . . . . . . . . . . #475
quit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . #70

R

radii, balls . . . . . . . . . . . . . . . . . . . . . . . .#181
radius, cylinders  . . . . . . . . . . . . . . . . . . .#185
Raffenetti integral format  . . . . . . . . . . . .#290
random seed, dynamics  . . . . . . . . . . . . .#388
reaction map setup . . . . . . . . . . . . . . . . .#330
read file . . . . . . . . . . . . . . . . . . . . . . . . . . .#59
read quantum results  . . . . . . . . . . . . . . . .#67
read structure . . . . . . . . . . . . . . . . . .#47, #48
read/write variables . . . . . . . . . . . . . . . . .#559
read-binary-script  . . . . . . . . . . . . . . . . . .#482
read-script . . . . . . . . . . . . . . . . . . . . . . . .#473
read-tcl-script  . . . . . . . . . . . . . . . . . . . . .#474
recompute hydrogen bonds  . . . . . . . . . .#226
rectangle, group select  . . . . . . . . . . . . . .#165
redisplay, inhibit . . . . . . . . . . . . . . . . . . .#454
reflect . . . . . . . . . . . . . . . . . . . . . . . . . . . .#93
refresh period . . . . . . . . . . . . . . . . . . . . .#362
relaxation time  . . . . . . . . . . . . . . . . . . . .#382
remove-all-stereo-constraints  . . . . . . . . .#120
remove-stereo-constraint  . . . . . . . . . . . .#119
rendering method, isosurface  . . . . . . . . .#190
rendering type  . . . . . . . . . . . . . . . . . . . .#218
rendering, restore last mode . . . . . . . . . .#219
render-method . . . . . . . . . . . . . . . . . . . .#178
reorder-selections  . . . . . . . . . . . . . . . . . . .#16
request . . . . . . . . . . . . . . . . . . . . . . . . . .#476
residue labels  . . . . . . . . . . . . . . . . . . . . .#206
residue, deselect . . . . . . . . . . . . . . . . . . .#158
residue, mutate . . . . . . . . . . . . . . . . . . . .#253
residue-charge  . . . . . . . . . . . . . . . . . . . .#502
residue-coordinate  . . . . . . . . . . . . . . . . .#504
residue-count  . . . . . . . . . . . . . . . . . . . . .#507
residue-label-text  . . . . . . . . . . . . . . . . . .#497
residue-name  . . . . . . . . . . . . . . . . . . . . .#503
residues, select  . . . . . . . . . . . . . . .#157, #162
response tag, query  . . . . . . . . . . . . . . . .#443
response to query has tag . . . . . . . . . . . .#443
restart, dynamics . . . . . . . . . . . . . . . . . . .#376
restraint, use . . . . . . . . . . . . . . . . . . . . . .#314
restraints . . . . . . . . . . . . . . . . . . . .#312, #313
restraints, ignore . . . . . . . . . . . . . . . . . . .#315
restraints, setup . . . . . . . . . . . . . . . . . . . .#326
restraint-tether  . . . . . . . . . . . . . . . . . . . .#313
revert-element-colors  . . . . . . . . . . . . . . .#212
rhf/uhf  . . . . . . . . . . . . . . . . . . . . . . . . . .#281
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ribbons, rendering  . . . . . . . . . . . . . . . . . #177
ring, atom  . . . . . . . . . . . . . . . . . . . . . . . #498
ring, extend selection . . . . . . . . . . . . . . . #170
rms gradient  . . . . . . . . . . . . . . . . . . . . . #519
rotate molecules . . . . . . . . . . . . . . . . #78, #94
rotate-viewer  . . . . . . . . . . . . . . . . . . . . . . #77
rotation  . . . . . . . . . . . . . . . . . . . . . . . . . . #15
run steps, monte carlo  . . . . . . . . . . . . . . #369
run time, dynamics  . . . . . . . . . . . . . . . . #365

S

save as, file . . . . . . . . . . . . . . . . . . . . . . . . #62
save file  . . . . . . . . . . . . . . . . . . . . . . . #4, #61
save quantum results  . . . . . . . . . . . . . . . . #66
save/save as, file . . . . . . . . . . . . . . . . . . . . #49
scale factor, dielectric constant . . . . . . . . #265
scale factor, electrostatic  . . . . . . . . . . . . #266
scale factor, van der Waals . . . . . . . . . . . #267
scale to fit  . . . . . . . . . . . . . . . . . . . . . . . #213
scaling, huckel factor  . . . . . . . . . . . . . . . #273
scf convergence, ab initio . . . . . . . . . . . . #294
scf convergence, accelerate  . . . . . . . . . . #278
scf iterations . . . . . . . . . . . . . . . . . . . . . . #277
scf-atom-energy . . . . . . . . . . . . . . . . . . . #417
scf-binding-energy . . . . . . . . . . . . . . . . . #418
scf-convergence . . . . . . . . . . . . . . . . . . . #276
scf-core-energy  . . . . . . . . . . . . . . . . . . . #419
scf-electronic-energy  . . . . . . . . . . . . . . . #420
scf-orbital-energy . . . . . . . . . . . . . . . . . . #410
screen-refresh-period  . . . . . . . . . . . . . . . #362
script errors  . . . . . . . . . . . . . . . . . . . . . . #444
script errors, ignore  . . . . . . . . . . . . . . . . #444
script file, compile  . . . . . . . . . . . . . . . . . #481
script menu item, change . . . . . . . . . . . . #479
script, execute string variable as . . . . . . . #483
script, exit  . . . . . . . . . . . . . . . . . . . . . . . #480
script, one . . .ten . . . . . . . . . . . . . . . . . . #485
script, open  . . . . . . . . . . . . . . . . . . . . . . #484
script, pause in . . . . . . . . . . . . . . . . . . . . #458
script, read . . . . . . . . . . . . . . . . . . #473, #474
script, read binary  . . . . . . . . . . . . . . . . . #482
script, run from menu item  . . . . . . . . . . #485
script-menu-caption . . . . . . . . . . . . . . . . #445
script-menu-checked  . . . . . . . . . . . . . . . #446
script-menu-command . . . . . . . . . . . . . . #447

script-menu-enabled  . . . . . . . . . . . . . . . #448
script-menu-help-file  . . . . . . . . . . . . . . . #449
script-menu-help-id . . . . . . . . . . . . . . . . #450
script-menu-in-use . . . . . . . . . . . . . . . . . #451
script-menu-message . . . . . . . . . . . . . . . #452
script-refs-in-errors . . . . . . . . . . . . . . . . . #453
scripts, help . . . . . . . . . . . . . . . . . . . . . . #535
scripts, help on context sensitive  . . . . . . #536
select all . . . . . . . . . . . . . . . . . . . . . . . . . #166
select atoms . . . . . . . . . . . . . . . . . . . . . . #161
select backbone . . . . . . . . . . . . . . . . . . . #173
select by name . . . . . . . . . . . . . . . . . . . . #154
select by name or number . . . . . . . . . . . #168
select by named selection  . . . . . . . . . . . #154
select molecules . . . . . . . . . . . . . . . . . . . #163
select residues  . . . . . . . . . . . . . . . . . . . . #162
select sphere  . . . . . . . . . . . . . . . . . . . . . #165
select-atom  . . . . . . . . . . . . . . . . . . . . . . #155
selected atoms, delete  . . . . . . . . . . . . . . . #76
selected-atom, sequence number . . . . . . #146
selected-atom-count  . . . . . . . . . . . . . . . #145
selection color  . . . . . . . . . . . . . . . . . . . . #210
selection level  . . . . . #144, #161, #162, #163
selection, complement . . . . . . . . . . . . . . #167
selection, delete named . . . . . . . . . . . . . #160
selection, hide  . . . . . . . . . . . . . . . . . . . . #217
selection, name  . . . . . . . . . . . . . . . . . . . #159
selection, named count  . . . . . . . . . . . . . #149
selection, named selection . . . . . . . . . . . #150
selection, named value . . . . . . . . . . . . . . #151
selection, show only . . . . . . . . . . . . . . . . #216
selection, translate . . . . . . . . . . . . . . . . . . #80
selection-color  . . . . . . . . . . . . . . . . . . . . . #12
selections, multiple  . . . . . . . . . . . #147, #164
selections, reorder  . . . . . . . . . . . . . . . . . . #16
selection-target  . . . . . . . . . . . . . . . . . . . #144
selection-value . . . . . . . . . . . . . . . . . . . . #152
select-name . . . . . . . . . . . . . . . . . . . . . . #154
select-none  . . . . . . . . . . . . . . . . . . . . . . #153
select-residue . . . . . . . . . . . . . . . . . . . . . #157
select-sphere  . . . . . . . . . . . . . . . . . . . . . #148
semi-empirical calculation  . . . . . . . . . . . #331
semi-empirical data, export  . . . . . . . . . . . #55
semi-empirical data, import . . . . . . . . . . . #54
semi-empirical results, export . . . . . . . . . . #21
semi-empirical results, import  . . . . . . . . . #25
semi-empirical setup  . . . . . . . . . . . . . . . #322
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semi-empirical-method . . . . . . . . . . . . . #262
sequence number, selected atom  . . . . . #146
serial-number  . . . . . . . . . . . . . . . . . . . . #529
set atom charge  . . . . . . . . . . . . . #108, #138
set atom type  . . . . . . . . . . . . . . . #107, #137
set bond angle  . . . . . . . . . . . . . . . #83, #101
set bond length . . . . . . . . . . . . . . . . . . . #100
set bond torsion  . . . . . . . . . . . . . . . . . . #102
set mess  . . . . . . . . . . . . . . . . . . . . . . . . #139
set velocity, setup  . . . . . . . . . . . . . . . . . #327
set-atom-charge  . . . . . . . . . . . . . . . . . . #108
set-atom-type  . . . . . . . . . . . . . . . . . . . . #107
set-bond . . . . . . . . . . . . . . . . . . . . . . . . #111
set-bond-length  . . . . . . . . . . . . . . . . . . . #82
set-bond-torsion  . . . . . . . . . . . . . . . . . . . #84
settings, restore default . . . . . . . . . . . . . #549
setup image  . . . . . . . . . . . . . . . . . . .#39, #91
set-velocity  . . . . . . . . . . . . . . . . . . . . . . #319
shading, balls  . . . . . . . . . . . . . . . . . . . . #179
shading, spheres . . . . . . . . . . . . . . . . . . #182
shifted cutoff . . . . . . . . . . . . . . . . . . . . . #269
show all . . . . . . . . . . . . . . . . . . . . . . . . . #215
show axes . . . . . . . . . . . . . . . . . . #202, #227
show hydrogen bonds . . . . . . . . . #200, #225
show hydrogens  . . . . . . . . . . . . . #196, #222
show inertial axes  . . . . . . . . . . . . . . . . . #227
show multiple bonds . . . . . . . . . . #198, #224
show periodic box . . . . . . . . . . . . #197, #223
show perspective . . . . . . . . . . . . . . . . . . #174
show selection . . . . . . . . . . . . . . . . . . . . #216
show-dipoles . . . . . . . . . . . . . . . . . . . . . #203
show-isosurface . . . . . . . . . . . . . . . . . . . #201
show-ribbons  . . . . . . . . . . . . . . . . . . . . #177
show-stereo . . . . . . . . . . . . . . . . . . . . . . #175
show-stereochem-wedges . . . . . . . . . . . #207
show-vibrational-vectors  . . . . . . . . . . . . #392
shrink  . . . . . . . . . . . . . . . . . . . #34, #81, #96
side chain, extend selection . . . . . . . . . . #171
sigma-sigma, zindo/1 overlap weighting factor 

#283
sigma-sigma, zindo/s overlap weighting factor 

#285
simulation temp, dynamics . . . . . . . . . . #373
single point, compute . . . . . . . . . . . . . . #422
single-point, compute . . . . . . . . . . . . . . #431
size, balls . . . . . . . . . . . . . . . . . . . . . . . . #181
size, window . . . . . . . . . . . . . . . . #567, #568

sketch, copy format to clipboard . . . . . . . .#88
snaphots, store . . . . . . . . . . . . . . . . . . . .#377
snapshot filename, dynamics  . . . . . . . . .#385
snapshot period, dynamics  . . . . . . . . . . .#386
snapshot playback period  . . . . . . . . . . . .#380
snapshots, playback  . . . . . . . . . . . . . . . .#377
solvate-system . . . . . . . . . . . . . . . . . . . . .#317
solvate-system-in-this-box . . . . . . . . . . . .#318
source-refs-in-errors  . . . . . . . . . . . . . . . .#471
sp3, extend selection  . . . . . . . . . . . . . . .#172
spectra, IR, export . . . . . . . . . . . . . . . . . . .#55
spectra, IR, import  . . . . . . . . . . . . . . . . . .#54
spectra, UV, export . . . . . . . . . . . . . . . . . .#55
spectra, UV, import . . . . . . . . . . . . . . . . . .#54
spectrum, compute electronic . . . . . . . . .#441
spectrum, compute vibrational . . . . . . . .#440
spectrum, IR, export  . . . . . . . . . . . . . . . . .#20
spectrum, IR, import . . . . . . . . . . . . . . . . .#24
spectrum, UV, export  . . . . . . . . . . . . . . . .#22
spectrum, UV, import  . . . . . . . . . . . . . . . .#26
sphere, group select  . . . . . . . . . . . . . . . .#165
sphere, select  . . . . . . . . . . . . . . . . . . . . .#148
spheres-highlighted  . . . . . . . . . . . . . . . .#183
spheres-shaded . . . . . . . . . . . . . . . . . . . .#182
spin density . . . . . . . . . . . . . . . . . . . . . . .#438
spin, uv . . . . . . . . . . . . . . . . . . . . . . . . . .#405
stack, pop . . . . . . . . . . . . . . . . . . .#545, #546
stack, push  . . . . . . . . . . . . . . . . . . . . . . .#544
starting temp, dynamics . . . . . . . . . . . . .#372
start-logging . . . . . . . . . . . . . . . . . . .#51, #63
status-message  . . . . . . . . . . . . . . . . . . . .#456
stereo, change constraint  . . . . . . . . . . . .#124
stereo, change stereo chemistry  . . . . . . .#127
stereo, cycle atom . . . . . . . . . . . . . . . . . .#126
stereo, cycle bond . . . . . . . . . . . . . . . . . .#125
stereo, fix stereo constraint . . . . . . . . . . .#123
stereo, remove all constraints  . . . . . . . . .#120
stereo, remove constraints  . . . . . . . . . . .#119
stereo, show . . . . . . . . . . . . . . . . . . . . . .#175
stereo, show wedges . . . . . . . . . . . . . . . .#207
stereo, wall-eyed or crosseyed . . . . . . . . .#176
stereochemistry, atom . . . . . . . . . . . . . . .#510
stereochemistry, constrain . #121, #122, #123, 

#124, #125, #126, #127
stereochemistry, enforced by Model Builder  . .

#106
sticks-width . . . . . . . . . . . . . . . . . . . . . . .#184
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stop-logging  . . . . . . . . . . . . . . . . . . #52, #64
stretch-energy  . . . . . . . . . . . . . . . . . . . . #521
string, declare  . . . . . . . . . . . . . . . . . . . . #543
structural optimization, algorithm  . . . . . #358
structure hide . . . . . . . . . . . . . . . . . . . . . #192
structure merging  . . . . . . . . . . . . . . . . . . #17
sugar-pucker  . . . . . . . . . . . . . . . . . . . . . #236
switched cutoff . . . . . . . . . . . . . . . . . . . . #269
switch-to-user-menu  . . . . . . . . . . . . . . . #551
system altered, save file  . . . . . . . . . . . . . . . #4

T

tcl script, read  . . . . . . . . . . . . . . . . . . . . #474
temperature step, dynamics . . . . . . . . . . #375
temperature, molecular dynamics  . . . . . #514
threshold, ab initio . . . . . . . . . . . . . . . . . #288
threshold, isosurface . . . . . . . . . . . . . . . . #189
time step, dynamics . . . . . . . . . . . . . . . . #367
title, customized . . . . . . . . . . . . . . . . . . . #566
toggle  . . . . . . . . . . . . . . . . . . . . . . . . . . #547
tool selection  . . . . . . . . . . . . . . . . . . . . . . #73
tool, xy rotation . . . . . . . . . . . . #15, #30, #32
tool, z clip  . . . . . . . . . . . . . . . . . . . . #29, #35
tool, z rotation . . . . . . . . . . . . . . . . . #18, #31
tool, z translation . . . . . . . . . . . . . . . #27, #33
tool, zoom . . . . . . . . . . . . . . . . . . . . #28, #34
toolbar, hide  . . . . . . . . . . . . . . . . . . . . . #204
tools, help  . . . . . . . . . . . . . . . . . . . . . . . #534
torsion angle omega  . . . . . . . . . . . . . . . #234
torsion angle phi  . . . . . . . . . . . . . . . . . . #232
torsion angle psi . . . . . . . . . . . . . . . . . . . #233
torsion angle, constrain  . . . . . . . . #115, #143
torsion angle, set  . . . . . . . . . . . . . . #84, #102
torsion, bond . . . . . . . . . . . . . . . . . . . . . . #84
torsion-energy  . . . . . . . . . . . . . . . . . . . . #523
total charge, quantum . . . . . . . . . . . . . . #279
total energy, dynamics . . . . . . . . . . . . . . #511
total-energy, any calculation  . . . . . . . . . #520
transition state setup  . . . . . . . . . . . . . . . #330
transition state, compute  . . . . . . . . . . . . #437
translate . . . . . . . . . . . . . . . . . . . . . . . . . . #95
translate-merged-systems . . . . . . . . . . . . . #17
translate-selection  . . . . . . . . . . . . . . . . . . #80
translate-view . . . . . . . . . . . . . . . . . . . . . . #79
translate-whole-molecules  . . . . . . . . . . . . #36

translation  . . . . . . . . . . . . . . . . . . . . . . . . #37
transparency, isosurface . . . . . . . . . . . . . #191
type rules, compile . . . . . . . . . . . . . . . . . #136
type, atom . . . . . . . . . . . . . . . . . . #107, #490
type, set atom  . . . . . . . . . . . . . . . . . . . . #137
types, calculate atom . . . . . . . . . . . . . . . #135

U

uhf . . . . . . . . . . . . . . . . . . . . . . . . . . . . . #281
uhf orbitals . . . . . . . . . . . . . . . . . . . . . . . #347
unconstrain-bond-angle . . . . . . . . . . . . . #117
unconstrain-bond-length . . . . . . . . . . . . #116
unconstrain-bond-torsion . . . . . . . . . . . . #118
united atom . . . . . . . . . . . . . . . . . . . . . . #499
united atoms  . . . . . . . . . . . . . . . . . . . . . #133
unselect all . . . . . . . . . . . . . . . . . . . . . . . #153
un-select-atom . . . . . . . . . . . . . . . . . . . . #156
un-select-residue  . . . . . . . . . . . . . . . . . . #158
update dynamics, last step . . . . . . . . . . . #516
update variable  . . . . . . . . . . . . . . . . . . . #459
update variable, cancel  . . . . . . . . . . . . . #460
use-fast-translation . . . . . . . . . . . . . . . . . . #37
use-no-restraints  . . . . . . . . . . . . . . . . . . #315
use-parameter-set  . . . . . . . . . . . . . . . . . #316
user id, backend . . . . . . . . . . . . . . . . . . . #309
user menu, load . . . . . . . . . . . . . . . . . . . #550
user menu, use . . . . . . . . . . . . . . . . . . . . #551
user menuitem (for scripts)  . . . . . . . . . . #479
user password, backend . . . . . . . . . . . . . #310
use-restraint . . . . . . . . . . . . . . . . . . . . . . #314
using-help  . . . . . . . . . . . . . . . . . . . . . . . #538
UV spectra, export . . . . . . . . . . . . . . . . . . #55
UV spectra, import . . . . . . . . . . . . . . . . . . #54
UV spectrum  . . . . . . . . . . . . . . . . . . . . . #299
UV spectrum, export  . . . . . . . . . . . . . . . . #22
UV spectrum, import  . . . . . . . . . . . . . . . . #26
UV/visible spectrum, read  . . . . . . . . . . . . #67
UV/visible spectrum, save . . . . . . . . . . . . . #66
uv-band-count . . . . . . . . . . . . . . . . . . . . #403
uv-dipole-components . . . . . . . . . . . . . . #407
uv-energy  . . . . . . . . . . . . . . . . . . . . . . . #404
uv-oscillator-strength . . . . . . . . . . . . . . . #409
uv-spin . . . . . . . . . . . . . . . . . . . . . . . . . . #405
uv-total-dipole . . . . . . . . . . . . . . . . . . . . #406
uv-transition-dipole  . . . . . . . . . . . . . . . . #408
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Message Cross-Reference
V

value, named selection  . . . . . . . . . . . . . #151
value, query  . . . . . . . . . . . . . . . . . . . . . #475
value, selection  . . . . . . . . . . . . . . . . . . . #152
van der Waals scale factor . . . . . . . . . . . #267
variable list, print . . . . . . . . . . . . . . . . . . #548
variable, declare  . . . . . . . . . . . . . #542, #543
variable, info . . . . . . . . . . . . . . . . . . . . . #557
variable, toggle . . . . . . . . . . . . . . . . . . . #547
variable-changed . . . . . . . . . . . . . . . . . . #541
vector, type . . . . . . . . . . . . . . . . . . . . . . #565
vectors, show vibrations  . . . . . . . . . . . . #392
velocities, atom . . . . . . . . . . . . . . . . . . . #518
velocities-in-hin-file . . . . . . . . . . . . . . . . . . #5
velocity, set atomic . . . . . . . . . . . .#319, #327
version  . . . . . . . . . . . . . . . . . . . . . . . . . #528
vertical grid size, contour  . . . . . . . . . . . #349
vibrational anaysis, compute . . . . . . . . . #424
vibrational spectrum, compute  . . . . . . . #440
vibrational, show vectors . . . . . . . . . . . . #392
vibrational-mode . . . . . . . . . . . . . . . . . . #397
vibrations, animate  . . . . . . . . . . . . . . . . #393
vibrations, compute  . . . . . . . . . . . . . . . #436
view, enlarge or shrink  . . . . . . . . . . . . . . #34
viewer, align  . . . . . . . . . . . . . . . . . . #75, #98
viewer, rotate  . . . . . . . . . . . . . . . . . . . . . #77
viewer, translate  . . . . . . . . . . . . . . . . . . . #79
view-in-hin-file  . . . . . . . . . . . . . . . . . . . . . #6

W

wall-eyed-stereo  . . . . . . . . . . . . . . . . . . #176
warning  . . . . . . . . . . . . . . . . . . . . . . . . #470
warning messages, backend  . . . . . . . . . #391
warnings-are-not-omsgs  . . . . . . . . . . . . #467
warnings-are-omsgs  . . . . . . . . . . . . . . . #466
warning-type  . . . . . . . . . . . . . . . . . . . . #391
wedges, stereochemistry . . . . . . . . . . . . #207
whole molecules, translate  . . . . . . . . . . . #36
width, sticks  . . . . . . . . . . . . . . . . . . . . . #184
width, window  . . . . . . . . . . . . . . . . . . . #568
window-color  . . . . . . . . . . . . . . . . . . . . . #10
window-height  . . . . . . . . . . . . . . . . . . . #567
window-width . . . . . . . . . . . . . . . . . . . . #568

workspace clear  . . . . . . . . . . . . . . . . . . . .#58
write-atom-map  . . . . . . . . . . . . . . . . . . .#540
write-file . . . . . . . . . . . . . . . . . . . . . . . . . .#49

X

x-y-rotation-cursor  . . . . . . . . . . . . . . . . . .#15
x-y-rotation-icon-step . . . . . . . . . . . . . . . .#30
x-y-translation-icon-step  . . . . . . . . . . . . . .#32

Z

z clipping  . . . . . . . . . . . . . . . . . . . . . . . . .#29
Z form, DNA . . . . . . . . . . . . . . . . . . . . . .#252
z-clip . . . . . . . . . . . . . . . . . . . . . . . . . . . . .#97
zeta torsion angle, nucleic acid . . . . . . . .#242
zindo-1-pi-pi . . . . . . . . . . . . . . . . . . . . . .#284
zindo-1-sigma-sigma . . . . . . . . . . . . . . . .#283
zindo-s-pi-pi  . . . . . . . . . . . . . . . . . . . . . .#286
zindo-s-sigma-sigma . . . . . . . . . . . . . . . .#285
zoom  . . . . . . . . . . . . . . . . . . . . . . . . . . . .#81
zoom, set factor  . . . . . . . . . . . . . . . . . . . .#96
zoom-cursor  . . . . . . . . . . . . . . . . . . . . . . .#28
zoom-icon-step . . . . . . . . . . . . . . . . . . . . .#34
z-rotation-cursor . . . . . . . . . . . . . . . . . . . .#18
z-rotation-icon-step . . . . . . . . . . . . . . . . . .#31
z-translation-cursor . . . . . . . . . . . . . . . . . .#27
z-translation-icon-step . . . . . . . . . . . . . . . .#33
zwitterion, make . . . . . . . . . . . . . . . . . . .#255
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Scripts
Scripts

Scripts are text files containing a set of statements that generate 
input messages (IMSGs) to run HyperChem. Scripts replace 
HyperChem mouse and keyboard operations, so that you can run 
HyperChem unattended. You can also interrupt a script to interact 
manually with HyperChem. Use scripts to repeat HyperChem 
operations that you do frequently, to do batch analyses, and to set 
up HyperChem conditions. 

Write scripts using a text editor, like Windows Notepad. These files 
should be unformatted text files, with the extension .scr. When 
you open a script file, using the Script menu in HyperChem, 
HyperChem automatically executes the instructions in the file.

A script runs to completion, unless it finds an error (you should 
include the instructions in the script to report errors to screen). It 
responds to a menu activator by displaying a dialog box, or you use 
the Abort option in the Running Script . . . message box.

Example:

This script performs a geometry optimization of anthracene. The 
numbers ¬,, and ® and so on do not belong to the script, but 
are present for this discussion.

; Test amber optimization of anthracene. ¬

calculation-method molecularmechanics 

molecular-mechanics-method amber ®

optim-max-cycles 200 ¯

optim-convergence 0.1 ¯

optim-algorithm polakribiere ¯

start-logging  test.log no °

open-file anth.hin ±

do-optimization ²
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write-file test.hin ³

append-omsgs-to-file test.log ´

query-value stretch-energy µ

omsgs-not-to-file

stop-logging 

exit-script

¬ A comment. All comment lines must start with a semicolon. 
Comments appear in the Comments section of the Open Script dia-
log box.

 Sets the calculation method (variable) to molecular mechanics.

® Chooses the AMBER force field (variable) for the calculation.

¯ Sets parameters (variables) for the calculation. If you do not set 
these variables, HyperChem uses the last settings.

° Starts a log file, named test.log, to record results of the calcula-
tion. No instructs HyperChem to replace the contents of any exist-
ing log file having the name test.log. Quotes can surround individ-
ual arguments, for clarity. You could also use the menu activator 
“menu-file-start-log”, but it requires that you respond to the Open 
Log dialog box.

± Opens the file anth.hin and displays the anthracene molecule 
in the workspace.

² Performs the geometry optimization calculation.

³ Stores the optimized molecule in a file, test.hin.

´ Adds error or warning messages, plus the results of the query-
value command to the log file. Without this command, these mes-
sages go to a dialog box and can interrupt the script.

µ Requests the final value of bond stretching energy (a compo-
nent of total energy) for the optimized molecule. Query values are 
OMSGs, so they go into the log file. An equivalent statement is 
stretch-energy ?.

Stops sending OMSGs to the log file.

Closes the log file. You could also use the menu activator 
menu-file-stop-log.

Ends the script. This is optional.
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Dynamic Data Exchange (DDE)

DDE is a communications system available to all programs (appli-
cations) running under Microsoft Windows. Applications can use 
DDE messages for these functions:

• To start another application

• To establish a communications channel with another 
application

• To send information

• To request and receive information

• To receive information automatically, when it is updated

In any DDE interaction between two Windows applications, one 
application initiates the conversation, taking on the role of the 
“client”; the responding application is the “server.” HyperChem 
can act only as a server: it can supply information when the client 
application asks for it or, by pre-arrangement, when it updates the 
information. 

DDE conversations use messages that can include HyperChem 
messages as arguments. HyperChem converts DDE messages to 
IMSGs and responds with an action or with data.

Other Applications to HyperChem

HyperChem can respond to six types of DDE messages from client 
applications:

DDE_INITIATE Establishes a communications channel with 
HyperChem. The arguments to this command 
must be the DDE Application name 
(“HyperChem”) and Topic (“System”).

DDE_EXECUTE Tells HyperChem to carry out a function, for exam-
ple, turning on Multiple Selections. The arguments 
are the same as HyperChem script variables (Set 
HSV, see “Variables” on page 327), commands (see 
“Commands” on page 332), and menu activators 
(see “Menu Activators” on page 333).
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DDE_REQUEST Requests information from HyperChem. The argu-
ments are the same as the request variables (Get 
HSV) for HyperChem scripts (see “Variables” on 
page 327). HyperChem responds using a 
DDE_DATA message.

DDE_
TERMINATE

Ends the conversation with HyperChem.

DDE_ADVISE Requests HyperChem to supply, through a “hot” 
data link, an update of data whenever it changes. 
The argument is a variable (HSV) name.

DDE_UNADVISE Removes the hot link for the HSV name in the 
argument.

Each application can have its own version of these DDE messages. 
For example, Microsoft Excel can use =Execute (Channel, “[mes-
sage (argument)]”) and Microsoft Visual Basic™ can use 
Textn.LinkExecute “[message (argument)]” for a DDE_EXECUTE 
message. HyperChem can recognize any version of these DDE mes-
sages. 

To write DDE conversations with HyperChem, consult the refer-
ence manuals for applications. 

HyperChem to Other Applications

HyperChem responds to DDE messages from applications by car-
rying out functions or by returning information. Information 
returns to an application in DDE_DATA messages. 

HyperChem has one special way of using a script to initiate com-
munication with a DDE application. The script command execute-
client (see message cross-reference number 297) can start another 
application and initiate a communications channel for a particular 
“Topic.” The other application then controls the DDE conversa-
tion.
416 Chapter 10



HyperChem and Excel
HyperChem and Excel

Microsoft Excel is a spreadsheet program available for Windows. It 
provides a macro language for writing DDE messages, which pro-
vides for looping, conditional statements, batch calculations, and 
other programming conveniences. Macro files have the extension 
.xlm.

Excel spreadsheets (with the extension .xls) can hold the input 
information for HyperChem calculations and receive output data. 
Excel provides tools for analyzing and plotting this data.

Excel uses these messages for communicating with HyperChem:

INITIATE Opens a communications channel between Excel 
and HyperChem. The only acceptable argument is 
“HyperChem”, “System”.

REQUEST Asks for information from HyperChem. The argu-
ments are Channel (the channel opened by INI-
TIATE) and “request string” (the same as a Get HSV 
message for a HyperChem script). 

EXECUTE Starts a process in HyperChem. The arguments are 
requests that include variables (Set HSV), com-
mands, and menu activators.

TERMINATE Closes a DDE channel at the end of a communica-
tion. The only argument is Channel (the channel 
opened by INITIATE).

In addition to these commands, Excel also provides various com-
mands for managing data and programming the interaction with 
HyperChem.

For more information about writing and using Excel command 
macros, see the Microsoft Excel User’s Guide and the Microsoft Excel 
Functions Reference. Several important aspects of the example 
macro below cannot be seen in a simple printout. For example, 
simply typing the text that you see below into a macro sheet will 
not give a working macro; you must also Define Names for some 
of the cells (as indicated in Column A).

Example:

This example does single point calculations on a related set of mol-
ecules and stores the results in an Excel spreadsheet file (plot.xls). 
This macro is supplied with HyperChem; the file is plot.xlm .
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The Excel macro contains these instructions:

Line Comment

1 Press [Ctrl]+ [R] or choose Run on Excel’s Macro menu to start 
this macro

3 Uses the subroutine, OpenFile, starting on line 25

4 - 5 If there is a problem opening a DDE channel (an error 
returns from the OpenFile subroutine), the macro ends. If 
the subroutine reports the number of the open channel, 
Excel goes to the next step (line 6)

6 Ends the conditional (If) statement

8 Instructs HyperChem to send back data without the name 
of each variable (tag)
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9 Instructs HyperChem that the files are in HIN format

11 Starts this conditional loop (While statement): while there is 
still a molecule to calculate, do steps (lines) 12-19

12 Opens the HIN file indicated by the highlighted cell in the 
spreadsheet plot.xls; runs a single point calculation with 
the present HyperChem settings

13-17 Requests the indicated information from HyperChem and 
puts it in columns 1–5 (cells B–F) of plot.xls

18 Selects the molecule in the next row of the spreadsheet

19 Returns to step (line) 11

21 Closes the DDE channel

22 Ends the macro

24 Names the subroutine, OpenFile

25 Opens a DDE channel to HyperChem

26 If the macro cannot open a channel to HyperChem, it goes 
to the next line (27) to first open a HyperChem window. If 
a channel opens, it goes to line 32

27-28 Opens a HyperChem program and a HyperChem window. 
Line 27 specifies the full directory path for HyperChem; you 
will need to change this path if you installed HyperChem in 
a different directory than the one that is specified. If this 
attempt to start HyperChem does not work, the macro 
returns an error message

29 Ends the second If statement

30 Opens a DDE channel to the new HyperChem window

31 Ends the first If statement

Line Comment
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To use this Excel macro:

1. Start Excel and open plot.xlm.

2. Open the spreadsheet file plot.xls.

3. Choose cell 2A (benzene) in plot.xls.

4. Press [Ctrl]+ [R] or choose Run on Excel’s Macro menu to start the 
macro.

As the macro runs, you can see the molecules in the HyperChem 
window and the values from the single point calculations in 
plot.xls.

Note: For this calculation, HyperChem uses the most recent set-
tings for calculation method, and so on. The results in this exam-
ple use a molecular mechanics calculation, the MM+ force field 
(set by opening the files), no cutoffs, and bond dipoles.

32 Returns the number of the open DDE channel to the main 
program

Line Comment
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Using HyperChem Results

You can use results from HyperChem sessions with other pro-
grams. For example, you could do the following:

• Prepare illustrations for publications, presentations, and 
reports. You can transfer images of molecular models, through 
the Windows Clipboard or through files, to other programs. 

• Analyze the results of HyperChem calculations in other pro-
grams that run with Windows (Windows “applications”).

• Save the results of quantum mechanics calculations in an 
Export file with File/Export, and then process those data with 
other software.

• Save molecular structures in PDB files for viewing or analysis 
by using other software that can read this type of file.

Setting Display Conditions

Before you copy a HyperChem graphic to the Clipboard or a file, 
you might want to change the appearance of the HyperChem 
workspace. For example, you can choose Preferences on the File 
menu (see page 65) to change the HyperChem window color to 
improve the quality of illustrations. You can also change how 
selected atoms look so that they have a distinctive appearance.

For reproduction in black and white, use White for Window, Black 
for Bond, and Thick line for Selection. With these choices, Hyper-
Chem substitutes dotted lines for solid lines where it uses color for 
special information (for example, negative versus positive contour 
lines in density plots of electronic values).
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Transferring Graphics

Use [F9] or Copy Image on the Edit menu to copy a HyperChem dis-
play to the Clipboard or a file. The Clipboard is a temporary stor-
age place that can hold one graphic at a time. You can then use this 
graphic in a publication, presentation, or report.

Setting Up a Graphics Transfer

Choose Setup Image on the Edit menu to set up the conditions for 
transferring graphics from HyperChem to the Windows Clipboard 
or to a file. In the Setup Image dialog box, you can choose part of 
the screen to copy, the type of image (bitmap or metafile), and the 
destination (Clipboard or file).

The settings in this dialog box regulate the results of pressing [F9], 
Copy Image.

Choosing the Extent of the Image

To adjust the extent of the image, choose one of these from the 
Setup Image dialog box:

Top level This copies the active HyperChem window, any 
active pull-down menu, or any visible dialog box. 
You must use [F9] instead of Copy Image to save 
images of menus and dialog boxes.

Workspace This copies only the workspace of the active 
HyperChem window.

HyperChem This copies the entire, active HyperChem window, 
including its borders.

Full screen This copies everything on screen, including any 
other windows.

This setting also affects the content of the image:

Cursor Check this box (5) to include the cursor in the 
image. The cursor can be the mouse pointer, a 
HyperChem tool, or a text cursor (in a dialog box).
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Choosing File Formats

HyperChem can store images in two types of files, either bit-
mapped (BMP) or Windows metafile (WMF), or both. These are 
standard Windows file types that many other programs can use. 
Check the manual for each program to see if it can accept BMP or 
WMF graphics files. The commands in other programs for incorpo-
rating these files are often called Import or Place.

Choose from the following file formats:

Bitmap This saves the graphic as a reproduction of the pix-
els on screen, in the file chem.bmp. The resolution 
of this image matches the resolution of your mon-
itor, which you determine when setting up Win-
dows. Use Bitmap to save Spheres renderings or 
contour plots from a single point, semi-empirical 
calculation (see page 273).

Metafile This saves the graphic as a line drawing, in the file 
chem.wmf. Metafile is best for Sticks, Disks, Dots, 
and Sticks & Dots renderings. Metafiles require 
about 10 times less storage space than bitmap files 
containing the same renderings. The resolution of 
a metafile graphic does not depend on the moni-
tor, but on the resolution of the output device. For 
example, if you print a metafile on a standard laser 
printer, the resolution might be 300dpi.

If you choose both Bitmap and Metafile, HyperChem saves the 
graphic in both types of file.

Choosing the Destination

You can choose to store a graphic on the Windows Clipboard, in a 
file, or both:

File HyperChem stores the graphic in the files 
chem.bmp and chem.wmf, or both. Each file can 
hold only one image at a time.
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Clipboard HyperChem stores the graphic either as a bitmap, 
or as a metafile on the Windows Clipboard. The 
Display menu in the Windows Clipboard program 
refers to Metafile as Picture. The Clipboard can 
hold only one graphic of each type at a time.

Saving Color Images

Check the Color box (5) to store a graphic in full color. Turn Color 
off to produce a black-and-white picture and to substitute dotted 
lines for certain colored lines (see “Using Black-and-white Output” 
on page 74). For a BMP file format, color results in a file at least 
four times as large. For a WMF file, Color produces only a small dif-
ference in file size.

Note: If you are storing a bitmap image in the Windows Cardfile, 
turn off Color.

Using Copy Image (or [F9])

After you set up the graphic that you want to save (see the previous 
section), press the function key [F9] or choose Copy Image on the 
Edit menu. Use [F9] if you want a graphic of a visible pull-down 
menu or dialog box. Since pulling down a menu or opening a dia-
log box usually requires the cursor, you cannot use the cursor to 
choose Copy Image.

Using the Clipboard

HyperChem shares the Clipboard with other programs that work 
with Windows. From HyperChem you can copy a graphic to the 
Clipboard. Using the Paste command in another program, like 
Microsoft Word®, you can transfer graphics from the Clipboard 
into documents. 

Caution: You cannot transfer HyperChem graphics to the Clip-
board by using Cut or Copy on the HyperChem Edit menu. You 
must use [F9] or Copy Image. Using Cut or Copy places a text 
description of the molecular system on the Clipboard.
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Some programs that share the Clipboard with HyperChem (these 
are Windows Applications and Non-Windows Applications in the 
Windows Program Manager) might not be able to use either bit-
map or metafile graphics directly from the Clipboard. These pro-
grams might require that you store graphics first in a BMP or WMF 
file (see the next section). For specific requirements, see the user 
manuals for each program.

Remember that HyperChem can store only one metafile and bit-
map graphic at a time on the Clipboard. The next time you press 
[F9] to store graphics, you replace the previous graphic. 

To collect several graphics, paste each one from the Clipboard into 
a file, using another program that accepts metafile or bitmap 
images. For example, a Windows Write file can store both bitmap 
and metafile graphics.

To see the contents of the Clipboard, double-click on the Clipboard 
icon in the Windows Program manager (Main Group). If you cop-
ied both metafile and bitmap images to the Clipboard, you see the 
metafile version. To see the bitmap version, choose Bitmap on the 
Clipboard Display menu.

Using BMP or WMF Files

Most Windows Applications and many other programs can use 
graphics from metafiles (WMF files) by importing or placing them. 
An increasing number of programs can also use bitmap graphics 
from BMP files. For specific requirements, see the user manuals for 
each program.

Remember that HyperChem can store only one WMF and BMP 
graphic at a time, in the files chem.wmf and chem.bmp. The next 
time you press [F9] to store graphics in these files, you replace the 
previous graphic. 

To collect several graphics, copy the contents of chem.wmf or 
chem.bmp to another file. For example, you can rename 
chem.wmf or chem.bmp by using the Windows File Manager, and 
then store a new graphic in the original files.
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Printing a Molecular System

To print the molecular system in the workspace, choose Print on 
the File menu.

Microsoft Windows controls the type of printer and its connec-
tions. To check these settings, open the Main icon in the Windows 
Program Manager. Then open the Control Panel and Printers 
icons.

Be sure that your printer is on and ready. HyperChem does not 
inform you of printer problems, but relies on Windows to manage 
printing.

Note: You can speed up printing by choosing Sticks for the Render-
ing option on the Display menu.

Storing Results in a Log File

You can store the detailed results of chemical calculations in log 
files. The file stores all results that appear on the status line during 
and after the calculation, plus many of the initial conditions. 

Choose Start Log on the File menu to name a log file and begin 
recording results. The default filename is chem.log. If you use a 
name for an existing log file, HyperChem lets you add on to the 
same file (Append) or replace the contents of the file. 

You can start only one log file at a time, but you can store any 
number of files with different names. When you start a log file, 
you can have available two new items on the File menu, Stop Log 
and Log Comments.

Stopping a Log

Stop Log turns off the recording of a log file and adds the date and 
time you stopped recording. 

To see or print the contents of a log, you can use a text editor such 
as Windows Write. Enter the filename (for example, 
\hyper\chem.log), L-click on OK, and then choose No conversion 
in the next dialog box that appears.
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Adding Comments to a Log

Use Log Comments to add notes to a log file. You can use this item 
anytime a log file is open and recording results.

You see the Log Comments dialog box (see page 61) to enter your 
comments. 

To add or change text:

• L-click with the text cursor (I-shaped) anywhere in the text to 
move the insertion point.

• L-click-drag across text to select text that you want to delete or 
replace.

• To delete text, select it and press [Del].

• To replace text, select it and start entering new text. 

You can use these keys for editing:

[Return] Moves the text cursor to the next line.

[Backspace] Erases the character (or selected text) to the left of 
the insertion point (text cursor).

[Delete] Erases the character (or selected text) to the right of 
the insertion point (text cursor). 

[3] [4]
[1] [2]

Moves the insertion point (text cursor).

Storing Results of a Molecular Dynamics Simulation

You can store the progress of a molecular dynamics simulation in 
a snapshots file (see “Molecular Mechanics/Semi-empirical/Ab Ini-
tio Optimization Dialog Box” on page 241). This file contains a 
complete description of the molecular system for each snapshot. 
You can request snapshots at regular time intervals through the 
simulation. The snapshot file has the same name as the current 
HIN file. HyperChem also creates another file with the same name, 
but with the extension .snp. If the HIN file is still untitled, Hyper-
Chem uses chem.snp.

When you run a molecular dynamics simulation, you can average 
up to eight values (see “Molecular Dynamics Averages Dialog Box” 
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Analyzing HyperChem Results
on page 254). The instantaneous values and averages are stored in 
a file that has the extension .csv (see “Plot and Averages Files” on 
page 439). You can use a text editor to view these files or you can 
transfer these values to another program for analysis. The file has 
the same name as the current HIN file, or chem.csv if the HIN file 
is still untitled.

Analyzing HyperChem Results

You can transfer the results of HyperChem calculations to other 
Windows applications; for example, to Microsoft Excel for analysis 
and plotting results. You can do this transfer by using the Win-
dows Clipboard, usually by selecting text by dragging the mouse 
cursor over it and pressing [Ctrl]+[C] to copy to the Clipboard, and 
then moving to the new application and pressing [Ctrl]+ [V] or Paste 
on an Edit menu to add the information to it or by Windows 
Dynamic Data Exchange (see“Dynamic Data Exchange (DDE)” on 
page 415. 
428 Chapter 11



Appendix A

HyperChem Files

HyperChem includes these files:

File Type Filenames Refer to:

Force field calculations chem.rul 
typerule.bin 
*.txt 
*.dbf 
*.par

Appendix B

Semi-empirical calculation *.abp Appendix C

Ab initio calculation *.bas Appendix C

HyperChem Input (data storage) *.hin Appendix D

Residue templates chem.tpl 
chemct.tpl 
chemnt.tpl

Appendix E

HyperChem default settings, for 
Windows 3.1x

chem.ini
chembin.ini

Appendix F

Water for periodic boxes wat216c.bin 
wat5832c.bin

This chapter

HyperChem program files chem.exe 
mmplus.exe 
newton.exe 
eht.exe 
ndo.exe
gauss.exe

This chapter
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Water Files
Water Files

HyperChem uses TIP3P models of water molecules (Jorgenson et 
al., J. Chem. Phys. 79(2):926-935, 1983) equilibrated at 300 K 
(25°C) and one atmosphere to solvate a molecular system in a peri-
odic box. The binary file wat216c.bin provides up to 216 water 
molecules, enough to fill a standard-sized periodic box 18.622 
Ångstroms on a side. The file wat5832c.bin provides up to 5832 
water molecules, enough to fill a box three times the standard size 
(55.866 Ångstroms on a side). Wat5832c.bin contains the same 
contents as wat216c.bin, repeated 27 times. 

Program Files

These are the HyperChem program files:

chem.exe Code for the HyperChem user interface, including 
the Model Builder, all display functions, and prep-
arations for chemical calculations. This is the 
HyperChem “frontend,” designed to run under 
Windows on a PC. The other program files consti-

Help text chem.hlp This chapter

Script files chem.scr
*.scr

This chapter

Snapshot Files chem.snp
*.snp

This chapter

Plot files chem.csv
*.csv

This chapter

Graphics files chem.wmf chem.bmp This chapter

Log files chem.log
*.log

This chapter

File Type Filenames Refer to:
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tute the “backend,” which can run on a PC or 
another processor.

mmplus.exe Code for calculations using the MM+ force field.

newton.exe Code for calculations using AMBER, BIO+, and 
OPLS force fields.

eht.exe Code for calculations using the Extended Hückel 
method.

ndo.exe Code for calculations using CNDO, INDO, 
MINDO3, MNDO, AM1, PM3, ZINDO/1, and 
ZINDO/S methods. 

gauss.exe Code for calculations using ab initio methods.

You cannot modify HyperChem program files. You can comple-
ment HyperChem functions by developing programs that interact 
with HyperChem through DDE links (see “Dynamic Data 
Exchange (DDE)” on page 415).

Variable Sized Header

The following header information is repeated for each atom. This 
data is sequential. Offsets are given relative to the start of each 
atom’s header.

Type Address Description

int 0-3 Index of atom (starting from 0)

int 4-7 Atomic number (0-103, 0 for lone pair)

int 8-11 Atom type index

12-15 Reserved

int 16-19 True if atom is fixed

20-23 Reserved

int 24-27 Coordination (1 to 12 neighbors)
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int  28-31 Index of first neighbor (–1 for none)

int 32-35 Index of second neighbor (–1 for none)

int 36-39 Index of third neighbor (–1 for none)

int 40-43 Index of fourth neighbor (–1 for none)

int 44-47 Index of fifth neighbor (–1 for none)

int 48-51 Index of sixth neighbor (–1 for none)

int 52-55 Index of seventh neighbor (–1 for none)

int 56-59 Index of eighth neighbor (–1 for none)

int 60-63 Index of ninth neighbor (–1 for none)

int 64-67 Index of tenth neighbor (–1 for none)

int 68-71 Index of eleventh neighbor (–1 for none)

int 72-75 Index of twelfth neighbor (–1 for none)

real 76-79 Charge

real 80-83 X coordinate

real 84-87 Y coordinate

real 88-91 Z coordinate

real 92-95 Mass

Type Address Description
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Help Text File

All Help text available on screen is in one file, chem.hlp. You can 
read this text using the Help menu, by activating the Help window 
with [F1], or by activating the Help cursor (context-sensitive help) 
with [Shift]+ [F1].

Script Files

Script files contain instructions for running HyperChem. You must 
write Script files (see “Scripts” on page 413) using a text editor, like 
Windows Notepad. These files can have any filename or extension, 
but .scr is recommended. You can run scripts using the Open Script 
command on the Script menu (see page 75).

Snapshot Files

During a molecular dynamics simulation, HyperChem can store 
the trajectory of a molecular system at regular, timed intervals, as 
snapshots. These results go into both the HIN file and an SNP file, 
with the extension .snp. The SNP file normally has the same name 
as the HIN file. If there is not yet a HIN file, the filename is 
chem.snp.

You can playback the snapshots using HyperChem, to continue 
analysis of the simulation. You can also use other applications to 
modify or analyze the data in the SNP file.

A binary SNP file is composed of three sections:

1. Fixed sized header that contains calculation parameters

2. Variable sized header that contains atom information

3. Coordinate and velocity data.

Note: Boolean values are 1 for true, 0 for false. All values are four 
bytes long.
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Fixed Sized Header

Type Address Description

int 0-3 Number of snapshots taken

int 4-7 File offset (in bytes) to first record of coordi-
nate and velocity data

int 8-11 Number of atoms in snapshot

int 12-15 Snapshot period (in data collection units)

16-19 Reserved

Boolean 20-23 True if restraints were used

int 24-27 Optimizer type:
0: Steepest Descent
1: Fletcher-Reeves
2: Polak-Ribiere
3: Newton-Raphson

28-47 Reserved

Boolean 48-51 True if periodic boundary conditions were used

Boolean 52-55 Constant temperature?

real 56-59 Temperature relaxation time for coupling to 
bath (picoseconds)

 60-63 Reserved

Boolean 64-67 Previously saved velocities used (for restart)?

int 68-71 Random number seed

real 72-75 X dimension of periodic box (Ångstroms)
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Variable Sized Header

The following header information is repeated for each atom. This 
data is sequential. Offsets are given relative to the start of each 
atom’s header.

real 76-79 Y dimension of periodic box (Ångstroms)

real 80-83 Z dimension of periodic box (Ångstroms)

84-95 Reserved

real 96-99 Starting temperature (K)

real 100-103 Peak temperature (K)

real 104-107 Low temperature (K)

real 108-111 Heat time (picoseconds)

real 112-115 Run time (picoseconds)

real 116-119 Cool time (picoseconds)

real 120-123 Time step (picoseconds)

real 124-127 Temperature step (K)

128-159 Reserved

int 160-163 Data collection period (in time steps)

int 164-167 Warning level:
0: None
1: Log file
2: Log file and message box

int 168-171 Number of atoms in snapshot

Type Address Description
HyperChem Files 435



Snapshot Files
Type Address Description

int 0-3 Index of atom (starting from 0)

int 4-7 Atomic number (0-103, 0 for lone pair)

int 8-11 Atom type index

12-15 Reserved

int 16-19 True if atom is fixed

20-23 Reserved

int 24-27 Coordination (1 to 12 neighbors)

int  28-31 Index of first neighbor (–1 for none)

int 32-35 Index of second neighbor (–1 for none)

int 36-39 Index of third neighbor (–1 for none)

int 40-43 Index of fourth neighbor (–1 for none)

int 44-47 Index of fifth neighbor (–1 for none)

int 48-51 Index of sixth neighbor (–1 for none)

int 52-55 Index of seventh neighbor (–1 for none)

int 56-59 Index of eighth neighbor (–1 for none)

int 60-63 Index of ninth neighbor (–1 for none)

int 64-67 Index of tenth neighbor (–1 for none)

int 68-71 Index of eleventh neighbor (–1 for none)

int 72-75 Index of twelfth neighbor (–1 for none)
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Coordinate and Velocity Data

The data from the simulation follows immediately after the vari-
able sized header, as a series of records with one record per 
recorded timestep. Each record contains the coordinates of each 
atom (sequentially), the components of the atom’s velocity, and a 
fixed sized trailer containing dynamics information.

The information repeated for each atom follow. Offsets are relative 
to each atom’s data.

real 76-79 Charge

real 80-83 X coordinate

real 84-87 Y coordinate

real 88-91 Z coordinate

real 92-95 Mass

Type Address Description

real 0-3 X coordinate

real 4-7 Y coordinate

real 8-11 Z coordinate

real 12-15 X component of velocity (Ångstroms/picosecond)

real 6-19 Y component of velocity (Ångstroms/picosecond)

real 20-23 Z component of velocity (Ångstroms/picosecond)

Type Address Description
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The trailer for each record follows. Offsets are relative to the start 
of the trailer.

Type Address Description

real 0-3 Total energy

real 4-7 Stretching energy

real 8-11 Bending energy

real 12-15 Torsional energy

real 16-19 Van der Waals energy

20-23 Reserved

real 24-27 Electrostatic energy

28-35 Reserved

real 36-39 1-4 van der Waals energy

real 40-43 1-4 electrostatic energy

44-63 Reserved

real 64-67 Semi-empirical binding energy

real 68-71 Semi-empirical atomic energy

real 72-75 Semi-empirical electronic energy

real 76-79 Semi-empirical core energy

real 80-83 Semi-empirical heat of formation

84-103 Reserved

real 104-107 Total dipole moment
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Plot and Averages Files
If you choose to average (or average and plot) values during a 
molecular dynamics calculation (see “Molecular Dynamics Aver-
ages Dialog Box” on page 254), HyperChem saves the instanta-
neous values and RMS deviations (D x)1 in a file with the same 
name as the HIN file, but with the extension .csv. If the molecular 
system is not yet associated with a HIN file, HyperChem stores the 
values in chem.csv. The file is saved to the current working direc-
tory, which you must be able to write to (e.g., not on a CD-ROM).

CSV files provide the information for recreating a plot of the stored 
values. To do this, you must run the molecular dynamics calcula-

1. , where xi =instantaneous value of EKIN, ETOT, EPOT, or TEMP,

, and .

real 108-111 X component of dipole moment

real 112-115 Y component of dipole moment

real 116-119 Z component of dipole moment

real 120-123 RMS gradient

real 124-127 Temperature (K)

real 128-131 Potential energy

real 132-135 Kinetic energy

136-143 Reserved

real 144-147 Elapsed time (picoseconds)

148-171 Reserved

Type Address Description

Dx xi
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tion with Snapshots on (see “Molecular Dynamics Options Dialog 
Box” on page 246). When you “Playback” the snapshots (see 
page 246), you can plot the stored values or choose, from the 
Molecular Dynamics Averages dialog box (see page 254), a subset 
of the original values or their deviations. 

Example:

If you average total energy (ETOT) and the RMS deviation for total 
energy (D ETOT), the CSV file contains this type of data:

time, ETOT, D ETOT
0,10.3854,5.19271
0.001,9.73882,6.70808
0.002,9.23686,7.34028
0.003,8.96351,7.34028
 . . . 
0.999,10.0421,10.5366
1,10.3975,10.5365

The first line is the header, then there is a line for each time point. 
ETOT (in the second column) contains the instantaneous values of 
ETOT. D ETOT (in the third column) contains the instantaneous 
RMS deviations.

You can read these files into another program, like a spreadsheet 
or plotting program, that can use data in a comma-separated-value 
(csv) format.

Graphics Files

The graphics files chem.wmf and chem.bmp contain images of the 
screen obtained with Copy Image on the Edit menu (see page 118).

Metafile Graphics

Chem.wmf stores an image as instructions for a line drawing. 
Metafile is best for Sticks, Disks, Dots, and Sticks & Dots renderings. 
Metafiles require about 10 times less storage space than bitmap 
files containing the same renderings. The resolution of a metafile 
image does not depend on the monitor, but on the resolution of 
the output device. For example, if you print a metafile on a laser 
printer, the resolution might be 300 dpi.
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Bitmapped Graphics

Chem.bmp stores an image as a reproduction of the pixels on 
screen. The image resolution is the same as the resolution of your 
monitor, which you choose when setting up Windows. Use Bitmap 
to save Spheres renderings or contour plots from a single point, 
semi-empirical calculation (see “Single Point” on page 237).

Log Files

HyperChem accumulates the results of calculations in a log file if 
you choose Start Log on the File menu. In the Open Log dialog box 
(see page 60), you can give a log file any filename or extension, but 
the extension .log is recommended.

You can save information about a calculation by opening a log file 
using Start Log on the File Menu. The content and amount of 
information saved in the log file is determined by settings that you 
use for the Mechanics Print Level and Quantum Print Level entries in 
the Start Log dialog box or in the Registry or in chem.ini.

This appendix describes the information that is saved when you 
use different settings for these entries. The settings range from 
0–9. Generally, we recommend that you use a setting of 1–3. If you 
use a setting of 4–9 for either entry, a large amount of information 
is written into the log file. The log file can take up many megabytes 
of disk space if you use a setting of 4–9 during a geometry optimi-
zation.
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Log Files
Extended Hückel Calculations 

QuantumPrintLevel Information saved in log file

0 start log time stamp
type of calculation
total number of electrons
total number of orbitals
doubly and singly occupied orbitals
total energy (kcal/mol and a.u.)
eigenvalues
atomic orbital electron populations
net charges and coordinates

1 All information when QuantumPrintLevel=0
orbital eigenvalues (energies), occupancies and 
eigenvectors (wavefunctions)

2 All information when QuantumPrintLevel=0
total density matrix

3 All information when QuantumPrintLevel is 
0, 1, or 2

4, 5, 6, 7, 8,or 9 All information when QuantumPrintLevel is 
0, 1, or 2

overlap matrix
core Hamiltonian matrix
product of density matrix and overlap matrix
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NDO Calculations

The following table shows the information saved in the log file 
when you run calculations using NDO methods (all methods in 
the Semi-empirical Method dialog box, except Extended Hückel).

QuantumPrintLevel Information saved in log file

0 start log time stamp
type of calculation
total number of electrons
total number of orbitals
double and single occupied orbitals in RHF, or 

occupied alpha and beta orbitals in UHF
occupied and unoccupied orbitals when using 

orbital criteriona

maximum excitation energy when using energy 
criteriona

iteration list
total energy (kcal/mol and eV)
binding energy
isolated atomic energy
electronic energy
core-core interaction
number of configurations
heat of formation
gradient of reference configuration
eigenvalues of reference configuration
atomic orbital electron populations
net charges and coordinates
dipoles
lowest 10 state energies, multiplicities, and 

spinsb

CI energyb

UV spectra (frequencies, intensities, state dipole 
moments, etc.)a

IR spectra (frequencies, intensities, etc.)c

1 All information when QuantumPrintLevel=0
orbital eigenvalues (energies), occupancies and 

eigenvectors (wavefunctions)

2 All information when QuantumPrintLevel=0
density matrix in RHF or density matrices in UHF
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Log Files
Ab initio calculations

This section describes the information that is saved when you use 
the ab initio quantum mechanics method.

a. Applies only when you do a singly excited CI calculation.
b. Applies only when you do a microstate CI calculation.
c. Applies only when you do a vibrational analysis calcula-
tion.

3 All information when QuantumPrintLevel is 0, 1, 
and 2

4 All information when QuantumPrintLevel=0
overlap Hamiltonian matrix
Fock matrices, eigenvalues, eigenvectors, den-

sity matrices for each interaction

5 All information when QuantumPrintLevel=0
Slater determinants (microstates)a

6 All information when QuantumPrintLevel=0
eigenvalues and eigenvectors of CI secular equa-

tion

7 All information when QuantumPrintLevel is 
0, 5, and 6

8 All information when QuantumPrintLevel is 
0, 3, 5, and 6

9 All information when QuantumPrintLevel is 
0 and 3

frequencies and eigenvectors of mass-weighted 
force matrix (normal modes)c

QuantumPrintLevel Information saved in log file
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Quantum 
PrintLevel

Information saved in log file

0 start log time stamp;
starting options:

convergence limit
iteration limit
accelerate convergence flag
method for initial guess of MO
basis set type
RHF or UHF
spin-multiplicity
extra charge on the system

total number of electrons;
total number of orbitals (basis functions);
total number of primitive Gaussians;
double and single occupied orbitals in RHF, or occupied 

alpha and beta orbitals in UHF;
occupied and unoccupied orbitals when using orbital 

criterion;a

iteration list;
total energy (kcal/mol and a.u.);
total kinetic energy (kcal/mol and a.u.);
the Virial factor;
electron-electron and electron nuclear interaction energy;
nuclear repulsion energy;
number of configurations;
gradient or gradient of reference configuration; a

eigenvalues or eigenvalues of reference configuration; a

atomic orbital electron populations
net charges and coordinates;
dipole moments;
quadrupole moments;
octapole moments;
hexadecapole moments;
components of first derivatives;
UV spectra (frequencies, intensities, state dipole moments, 

etc.); a

IR spectra (frequencies, intensities, etc.)b
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1 All information when QuantumPrintLevel=0;
input basis function information;
orbital eigenvalues (energies) and eigenvectors (wavefunc-

tions);
Mulliken population analysis.

2 All information when QuantumPrintLevel=0;
input basis function information;
density matrix in RHF or density matrices in UHF;
Mulliken population analysis.

3 All information when QuantumPrintLevel is 0, 1, and 2;
initial guess of MO coefficients.

4 All information when QuantumPrintLevel=0;
core Hamiltonian matrix;
initial guess of MO coefficients;
Fock matrices, eigenvalues, eigenvectors, density matrices for 

each interaction;
Mulliken population analysis.

5 All information when QuantumPrintLevel=0;
input basis function information;
all the two-electron repulsion integrals;
Mulliken population analysis.

6 All information when QuantumPrintLevel=0;
input basis function information;
initial guess of MO coefficients;
Slater determinants; a

Mulliken population analysis.

7 All information when QuantumPrintLevel=0;
input basis function information;
initial guess of MO coefficients;
eigenvalues and eigenvectors of singly excited CI matrix; a

Mulliken population analysis.

Quantum 
PrintLevel

Information saved in log file
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a. Applies only when you do a singly-excited CI calculation
b. Applies only when you do vibrational analysis calculation

8 All information when QuantumPrintLevel=0;
input basis function information;
initial guess of MO coefficients;
Slater determinants; a

eigenvalues and eigenvectors of singly excited CI matrix; a

eigenvalues, eigenvectors and density matrix of the reference 
configuration in the SCF;

Mulliken population analysis.

9 All information when QuantumPrintLevel=0;
input basis function information;
initial guess of MO coefficients;
eigenvalues, eigenvectors, and density matrix;
Mulliken population analysis;
frequencies and eigenvectors of mass-weighted force matrix 

(normal modes) b

Quantum 
PrintLevel

Information saved in log file
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Molecular Mechanics Calculations

The following table shows the information saved in the log file 
when you run a Single Point calculation using the MM+ force field.

The following table shows the information saved in the log file 
when you run other molecular mechanics calculations.

MechanicsPrintLevel Information saved in log file

0 start log time stamp
type of calculation
energy components

1 All information when MechanicsPrintLevel is 0
center of mass
force-field coordinates
principal moments of inertia
bond length and stretching energy
bond angles and bending energy
bond torsions and torsional energy
cubic stretch constant
stretching parameters
equilibrium bond length
force constant
dipole interaction energy

2 All information when MechanicsPrintLevel is 1
dielectric constant
dipole moment

3 All information when MechanicsPrintLevel is 2
van der Waals energy

MechanicsPrintLevel Information saved in log file

0-9 start log time stamp
type of calculation
energy components
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Annotated Example Log File Output

A user can get extra information about a calculation by saving and 
reading a log file. Below we describe the information that is put in 
the log file for representative calculations with MM+, AMBER, 
Extended Hückel and CNDO. The example is an ethane molecule 
calculation with single point, optimization, and five times steps of 
dynamics where appropriate. For CNDO a configuration interac-
tion calculation is also shown.

Annotations to the log files are shown in brackets, as in <annota-
tion>.

MM+

<A time stamp for the beginning of logging is added automatically 
to the log file.>

HyperChem log start -- Sat Jan 25 22:45:54 1992

<The following comments below were added via the File/Log 
Comments command.>

Begin comments added by user prior to calculations 
1.  Single point 
2.  Geometry Optimization 
3.  0.005 picoseconds of MD 
End comments 

<Log file entries below were triggered by performing a single point 
calculation using MM+ as the force field.>

Single Point, MolecularMechanics, molecule = ETHANE.HIN.

<The following section of output is consistent with the usual MM+ 
output. HyperChem does not make use of these coordinates and 
they are given only for comparison with MM2 output from 
Allinger’s program. The molecule is aligned and translated to the 
center of mass to give the following coordinates and to calculate 
the principal moments of inertia. HyperChem retains the coordi-
nates as they are on the screen for continuity purposes and the fol-
lowing coordinates are not those used by HyperChem. The inter-
nal coordinates are, of course, identical to those used by Hyper-
Chem. The units here for the principal moments of inertia are also 
different than those used by HyperChem, associated with request-
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ing the display of the principal inertial axes. There, moments of 
inertia are given in amu-Ångstroms2.>

Center of Mass
x =  -0.53797  y =   0.29747  z =   0.00000
MM+ coordinates of an aligned molecule at center of mass.
C4( 1)     -0.77000      0.00000      0.00000  ( 1)    <last column is

 the MM+ type>
C4( 2)      0.77000      0.00000      0.00000  ( 1)
 H( 3)     -1.13333     -0.01367      1.02757  ( 5)
 H( 4)     -1.13333      0.89674     -0.50194  ( 5)
 H( 5)     -1.13334     -0.88306     -0.52563  ( 5)
 H( 6)      1.13333      0.01367     -1.02757  ( 5)
 H( 7)      1.13333      0.88307      0.52562  ( 5)
 H( 8)      1.13334     -0.89674      0.50195  ( 5)
Principal moments of inertia 
(units = 10**(-39)*gm*cm**2)
ix =    1.0605  iy =    4.1827  iz =    4.1827.

<Below, the results of bond stretching calculations are reported.>

Bond lengths and stretching energy (7 bonds)
Energy = 71.94(Kr)(dr)(dr)(1+(cs)(dr))
dr = R-R0
cs = -2.000    <cubic stretch constant>

<The values below are all the stretches. R0 and Kr are the stretching 
parameters — equilibrium bond length and force constant.>

Bond                  R         R0        Kr        Energy
C4(  1) - C4(  2)     1.5400    1.5230    4.4000    0.0884
C4(  1) -  H(  3)     1.0900    1.1130    4.6000    0.1831
C4(  1) -  H(  4)     1.0900    1.1130    4.6000    0.1831
C4(  1) -  H(  5)     1.0900    1.1130    4.6000    0.1831
C4(  2) -  H(  6)     1.0900    1.1130    4.6000    0.1831
C4(  2) -  H(  7)     1.0900    1.1130    4.6000    0.1831
C4(  2) -  H(  8)     1.0900    1.1130    4.6000    0.1831
Dipole Interaction energy (Dielectric constant = 1.500000)
Dipole(1)          Mu(1)    Dipole(2)        Mu(2)  R12     E(kcal)

<These are no dipole terms for ethane so no output appears here. 
Normally, the individual dipole interaction terms appear.>

Dipole Moment: x=0.000000 y=0.000000 z=0.000000 total=0.000000

<The Van der Waals calculations start here.>

Van der Waals energy
9 vdw interactions (1,3 excluded)
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Energy = Kv*(2.90(10**5)exp(-12.50/P) - 2.25(P**6))
Rv = Rvdw(i) + Rvdw(j)
Kv = sqrt(Eps(i)*Eps(j))
P = (Rv/R) or (Rv/R#)
(if P.gt.3.311, Energy = Kv(336.176)(P**2))
# in the vdw calculations the hydrogen atoms are relocated
so that the attached hydrogen distance is reduced by 0.915

<Asterisk denotes a vicinal interaction, R# is the distance between 
the relocated centers. The parameters are Rv and Kv.>

Atom Pair         R        R#       Rv     Kv         Energy  (1,4)
 H(  3), H(  6)   3.0598   2.8980   3.000  0.0470    -0.0524    *
 H(  3), H(  7)   2.4887   2.3970   3.000  0.0470     0.2201    *
 H(  3), H(  8)   2.4887   2.3970   3.000  0.0470     0.2201    *
 H(  4), H(  6)   2.4887   2.3970   3.000  0.0470     0.2201    *
 H(  4), H(  7)   2.4887   2.3970   3.000  0.0470     0.2201    *
 H(  4), H(  8)   3.0598   2.8980   3.000  0.0470    -0.0524    *
 H(  5), H(  6)   2.4887   2.3970   3.000  0.0470     0.2201    *
 H(  5), H(  7)   3.0598   2.8980   3.000  0.0470    -0.0524    *
 H(  5), H(  8)   2.4888   2.3970   3.000  0.0470     0.2201    *

<Bending calculations start here, including stretch-bend interac-
tions.>

Bond angles, bending and stretch-bend energies ( 12 angles)
Eb = 0.043828(Kb/2)(dt)(dt)(1+sf*dt**4)
dt = Theta-Theta0
sf =  0.00700e-5 <the sextic scale factor>
Esb = 2.51118 (Ksb)(dt)(dr1+dr2)
dr(i) = R(i) - R0(i) <the two bond deformations involved in the angle>
(x,y) = f or s

<Four built-in stretch-bend interactions.>

Ksb(1) =   0.120   x-f-y  f = 1st row atom
Ksb(2) =   0.250   x-s-y  s = 2nd row atom
Ksb(3) =   0.090   x-f-h  (dr2 = 0)
Ksb(4) =  -0.400   x-s-h  (dr2 = 0)

<The bending interactions are listed below.>

Atoms                   Theta   Theta0    Kb     Eb       Ksb    Esb
C4(  2)-C4(  1)- H(3) 109.471 110.0000.090 -0.0020 0.360 0.0022
C4(  2)-C4(  1)- H(4) 109.471 110.0000.090 -0.0020 0.360 0.0022
C4(  2)-C4(  1)- H(5) 109.471 110.0000.090 -0.0020 0.360 0.0022
 H(  3)-C4(  1)- H(4) 109.471 109.0000.320 0.0016
 H(  3)-C4(  1)- H(5) 109.471 109.0000.320 0.0016
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 H(  4)-C4(  1)- H(5) 109.471 109.0000.320 0.0016
C4(  1)-C4(  2)- H(6) 109.471 110.0000.090 -0.0020 0.360 0.0022
C4(  1)-C4(  2)- H(7) 109.471 110.0000.090 -0.0020 0.360 0.0022
C4(  1)-C4(  2)- H(8) 109.471 110.0000.090 -0.0020 0.360 0.0022
 H(  6)-C4(  2)- H(7) 109.471 109.0000.320 0.0016
 H(  6)-C4(  2)- H(8) 109.471 109.0000.320 0.0016
 H(  7)-C4(  2)- H(8) 109.471 109.0000.320 0.0016

<Torsion calculations start here.>

Dihedral angles, torsional energy (Et) (  9 angles)
Et = (V1/2)(1+cos(w))+(V2/2)(1-cos(2w))+(V3/2)(1+cos(3w))
Sign of angle a-b-c-d is negative, when looking through b toward c,
if d is counterclockwise from a.

<The torsional interactions are listed below.>

Atoms                         omega     V1     V2     V3      et
 H(  3)C4(  1)C4(  2) H(  6) 180.000  0.000  0.000  0.237   0.000
 H(  3)C4(  1)C4(  2) H(  7)  60.001  0.000  0.000  0.237   0.000
 H(  3)C4(  1)C4(  2) H(  8)  60.000  0.000  0.000  0.237   0.000
 H(  4)C4(  1)C4(  2) H(  6)  60.001  0.000  0.000  0.237   0.000
 H(  4)C4(  1)C4(  2) H(  7)  59.999  0.000  0.000  0.237   0.000
 H(  4)C4(  1)C4(  2) H(  8) 179.999  0.000  0.000  0.237   0.000
 H(  5)C4(  1)C4(  2) H(  6)  60.000  0.000  0.000  0.237   0.000
 H(  5)C4(  1)C4(  2) H(  7) 179.999  0.000  0.000  0.237   0.000
 H(  5)C4(  1)C4(  2) H(  8)  60.001  0.000  0.000  0.237   0.000
Total Energy=2.360644 Gradient=11.839364.

<Below is a summary of the interaction terms in a single point cal-
culation.>

Bond=1.18704   Angle=0.0225845   Dihedral=5.607e-010 Vdw=1.16321   
Stretch-bend=-0.0121913   Electrostatic=0.

<Log file entries below were triggered by a geometry optimization 
calculation.>

Geometry optimization, MolecularMechanics, molecule = ETHANE.HIN.
mm+
NewtonRaphson optimizer

<First line comes from back end, second from front end. Gradi-
entSquared is the sum of the squares of all gradient components, 
while Gradient reported below is the RMS gradient (first number 
divided by 24 for ethane and the square root taken).>

Iter=   1 Energy=1.13315 AvgMovement= 0.01131 
GradientSquared=1858.67369.
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Energy=1.133152 Gradient=8.800269 Converged=NO (1 cycles 1 points).
Iter=   2 Energy=0.81988 AvgMovement= 0.00485 GradientSquared= 
571.54119.
Energy=0.819878 Gradient=4.879981 Converged=NO (2 cycles 2 points).
Iter=   3 Energy=0.81615 AvgMovement= 0.00074 GradientSquared=   
6.27436.
Energy=0.816150 Gradient=0.511304 Converged=NO (3 cycles 3 points).
Energy converged.
Energy=0.816150 Gradient=0.061118 Converged=YES (4 cycles 4 points).
Bond=0.027583   Angle=0.0991741   Dihedral=0.000255269 Vdw=0.677749   
Stretch-bend=0.0113892   Electrostatic=0.

<Log file entries below were triggered by molecular dynamics cal-
culation.>

Molecular dynamics, MolecularMechanics, molecule = ETHANE.HIN.
mm+
MechanicsData: RunTime=0.005000 ps   SimulationTemperature=300.000000 K 
TimeStep=0.001000 ps  StepsToRefresh=1.
Time=0 ps  Potential=0.815953  Kinetic=7.15412  TotalEnergy=7.97008 
kcal/mol  T=300.01 K.
Time=0.001 ps  Potential=1.93134  Kinetic=6.17928  TotalEnergy=8.11062 
kcal/mol  T=259.13 K.
Time=0.002 ps  Potential=4.17453  Kinetic=4.30619  TotalEnergy=8.48072 
kcal/mol  T=180.581 K.
Time=0.003 ps  Potential=5.00905  Kinetic=3.58626  TotalEnergy=8.59531 
kcal/mol  T=150.391 K.
Time=0.004 ps  Potential=3.82956  Kinetic=4.4882  TotalEnergy=8.31776 
kcal/mol  T=188.214 K.
Time=0.005 ps  Potential=2.8143  Kinetic=5.29967  TotalEnergy=8.11396 
kcal/mol  T=222.243 K.

<Time stamp triggered by Stop Log menu item.>

HyperChem
log stop -- Sat Jan 25 22:48:44 1992

AMBER

<The log file of a HyperNewton calculation contains basically the 
same information as that of a HyperMM+ calculation except that 
the detailed description of individual interactions given for MM+, 
for consistency with Allinger’s MM2, are not given here.>

HyperChem log start -- Tue Dec 17 23:54:09 1991
Single Point, MolecularMechanics, molecule = 'ETHANE.HIN'
amber
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Total Energy=0.217552  Gradient=2.514611
bond=0.060759   angle=0.000105982   dihedral=6.86196e-010 vdw=0.156687   
H-bond=0   electrostatic=0
Geometry optimization, MolecularMechanics, molecule = 'ETHANE.HIN'
amber
PolakRibiere optimizer
Energy=0.176069 Gradient=0.465800 Converged=NO (1 cycles 4 points)
Energy=0.171165 Gradient=0.120952 Converged=NO (2 cycles 7 points)
Energy=0.169494 Gradient=0.013383 Converged=NO (3 cycles 12 points)
Energy=0.169494 Gradient=0.013383 Converged=YES (3 cycles 12 points)
bond=0.00150512   angle=0.00357023   dihedral=4.23819e-010 vdw=0.164419   
H-bond=0   electrostatic=0
Molecular dynamics, MolecularMechanics, molecule = 'ETHANE.HIN'
amber
MechanicsData: RunTime=0.005000 ps   SimulationTemperature=300.000000 K 
TimeStep=0.001000 ps  StepsToRefresh=1
Time=0 ps  Potential=0.169494  Kinetic=7.15408  TotalEnergy=7.32357 
kcal/mol  T=300.008 K
Time=0.001 ps  Potential=1.23804  Kinetic=6.2294  TotalEnergy=7.46744 
kcal/mol  T=261.231 K
Time=0.002 ps  Potential=3.37796  Kinetic=4.36028  TotalEnergy=7.73824 
kcal/mol  T=182.849 K
Time=0.003 ps  Potential=4.56812  Kinetic=3.28064  TotalEnergy=7.84877 
kcal/mol  T=137.574 K
Time=0.004 ps  Potential=3.9793  Kinetic=3.71141  TotalEnergy=7.69071 
kcal/mol  T=155.639 K
Time=0.005 ps  Potential=2.77903  Kinetic=4.66901  TotalEnergy=7.44804 
kcal/mol  T=195.796 K
HyperChem
log stop -- Tue Dec 17 23:55:48 1991

Extended Hückel

<The results from Extended Hückel Theory calculations on model-
built ethane appear below. Only a single point calculation is per-
formed as geometry optimization and molecular dynamics are 
undefined for EHT.>

HyperChem log start -- Sun Jan 26 19:39:04 1992
Single Point, SemiEmpirical, molecule = ETHANE.HIN.
ExtendedHuckel
Extended-Huckel Calculation:
Singlet State Calculation
Number of Electrons = 14
Starting Extended-Huckel calculation with 14 orbitals
Charge on the System = 0
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Total Orbitals = 14
Number of Double Occupied Levels = 7
Unweighted Huckel Constant = 1.7500000
d Orbitals on Si...Cl If Any Not Included
Energy=-5724.018299

<The logging of results corresponds to the smallest PrintLevel=0.>

----------------- RESULTS -----------------

<Total energies in EHT are sums of occupied orbital energies.>

Sum of One-Electron Energies =   -5724.0182994 (kcal/mol)
Sum of One-Electron Energies =    -9.122089647 (a.u.)

EIGENVALUES(eV)  <These are the orbital energies, lowest energy orbitals occupied 
first.>
 -26.485626   -21.621887   -16.121031   -16.121025   -14.782691
 -14.782681   -14.191090     2.383136     3.373500     3.373533
   7.076813     7.076891    24.606670    40.313354

ATOMIC ORBITAL ELECTRON POPULATIONS  <Number of electrons occupying each 
atomic orbital>
   1.224238     0.950610     0.951825     0.950609     1.224237
   0.950609     0.951825     0.950609     0.974238     0.974227
   0.974254     0.974242     0.974225     0.974252

NET CHARGES AND COORDINATES  <Charge is total charge on an atom>
Atom  Z     Charge             Coordinates(a.u.)
                            x           y           z
  1   6    -0.077281      -1.01663    -0.89296     0.00000
  2   6    -0.077281      -1.01663     2.01722     0.00000
  3   1     0.025762       0.92538    -1.57955     0.00000
  4   1     0.025773      -1.98761    -1.57955     1.68183
  5   1     0.025746      -1.98763    -1.57956    -1.68182
  6   1     0.025758      -2.95863     2.70382     0.00000
  7   1     0.025775      -0.04564     2.70381     1.68183
  8   1     0.025748      -0.04562     2.70383    -1.68182
HyperChem
log stop -- Sun Jan 26 19:39:54 1992

CNDO

<The following is the result for a successive single point calcula-
tion, a geometry optimization and .005 picoseconds of molecular 
dynamics, for CNDO ethane starting at model builder geometry.>
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These HyperChem log start -- Sun Jan 26 19:58:41 1992
Single Point, SemiEmpirical, molecule = ETHANE.HIN.
CNDO
Convergence limit = 0.0100000  Iteration limit = 50
RHF Calculation:
Singlet state calculation
Number of electrons = 14
Number of Double Occupied Levels = 7
Charge on the System = 0
Total Orbitals = 14
Starting CNDO calculation with 14 orbitals

<SCF iterations show differences in energy (kcal/mol) at this itera-
tion from previous iteration.  First iteration describes the second 
calculation so that a Difference is defined.>

Iteration = 1 Difference = 4413.32086
Iteration = 2 Difference = 2.12419
Iteration = 3 Difference = 0.24927
Iteration = 4 Difference = 0.10723
Iteration = 5 Difference = 0.00046
Energy=-1659.715468 Gradient=64.939762  <Gradient is RMS value>

<The isolated atomic energies below come from CINDO.ABP 
parameter file.  Binding energies defined as differences between 
total energy and value for isolated atoms.>

ENERGIES AND GRADIENT  Total Energy                        =  -11801.4373094 

(kcal/mol)

Total Energy                        =   -18.807376823 (a.u.)
Binding Energy                      =   -1659.7154677 (kcal/mol)
Isolated Atomic Energy              =  -10141.7218417 (kcal/mol)
Electronic Energy                   =  -28492.2957749 (kcal/mol)
Core-Core Interaction               =   16690.8584655 (kcal/mol)
Gradient                            =   64.9397615 (kcal/mol/Ang)

EIGENVALUES(eV)
 -40.386066   -29.239080   -23.532267   -23.532249   -18.191881
 -16.373669   -16.373646     7.900207     7.900218     8.076718
   8.596774    10.167131    10.167147    10.711308

ATOMIC ORBITAL ELECTRON POPULATIONS
   1.014663     0.977262     1.038487     0.977262     1.014663
   0.977262     1.038487     0.977262     0.997442     0.997442
   0.997442     0.997442     0.997442     0.997442

NET CHARGES AND COORDINATES
Atom  Z     Charge             Coordinates(a.u.)
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                            x           y           z
  1   6    -0.007673      -1.01663    -0.89296     0.00000
  2   6    -0.007673      -1.01663     2.01722     0.00000
  3   1     0.002558       0.92538    -1.57955     0.00000
  4   1     0.002558      -1.98761    -1.57955     1.68183
  5   1     0.002558      -1.98763    -1.57956    -1.68182
  6   1     0.002558      -2.95863     2.70382     0.00000
  7   1     0.002558      -0.04564     2.70381     1.68183
  8   1     0.002558      -0.04562     2.70383    -1.68182

<Dipole moment has a point charge contribution as well as a con-
tribution for sp polarization (hybridization).>

Dipole (Debyes)  x         y         z          Total
Point-Chg.       0.000     0.000     0.000     0.000
Hybrid           0.000     0.000     0.000     0.000
Sum              0.000     0.000     0.000     0.000
Geometry optimization, SemiEmpirical, molecule = ETHANE.HIN.
CNDO

PolakRibiere optimizer

Convergence limit = 0.0100000  Iteration limit = 50
Optimization algorithm = Polak-Ribiere
Criterion of RMS gradient = 0.1000 kcal/(A mol)  Maximum cycles = 120
RHF Calculation:

Singlet state calculation
Number of electrons = 14
Number of Double Occupied Levels = 7
Charge on the System = 0
Total Orbitals = 14
Starting CNDO calculation with 14 orbitals

<The square brackets describe the inner iteration of the outer iter-
ation.>

E=0.0000 Grad=0.000 Conv=NO(0 cycles 0 points) [Iter=1 Diff=4413.32086]
E=0.0000 Grad=0.000 Conv=NO(0 cycles 0 points) [Iter=2 Diff=2.12419]
E=0.0000 Grad=0.000 Conv=NO(0 cycles 0 points) [Iter=3 Diff=0.24927]
E=0.0000 Grad=0.000 Conv=NO(0 cycles 0 points) [Iter=4 Diff=0.10723]
E=0.0000 Grad=0.000 Conv=NO(0 cycles 0 points) [Iter=5 Diff=0.00046]
E=-1659.7155 Grad=64.940 Conv=NO(0 cycles 1 points) [Iter=1 Diff=6.28550]
E=-1659.7155 Grad=64.940 Conv=NO(0 cycles 1 points) [Iter=2 Diff=0.48315]
E=-1659.7155 Grad=64.940 Conv=NO(0 cycles 1 points) [Iter=3 Diff=0.05823]
E=-1659.7155 Grad=64.940 Conv=NO(0 cycles 1 points) [Iter=4 Diff=0.01519]
E=-1659.7155 Grad=64.940 Conv=NO(0 cycles 1 points) [Iter=5 Diff=0.00003]
E=-1669.7328 Grad=24.582 Conv=NO(0 cycles 2 points) [Iter=1 Diff=0.38656]
HyperChem Files 457



Log Files
E=-1669.7328 Grad=24.582 Conv=NO(0 cycles 2 points) [Iter=2 Diff=0.02926]
E=-1669.7328 Grad=24.582 Conv=NO(0 cycles 2 points) [Iter=3 Diff=0.00232]
E=-1670.9449 Grad=3.839 Conv=NO(1 cycles 3 points) [Iter=1 Diff=0.00153]
E=-1671.0237 Grad=2.292 Conv=NO(1 cycles 4 points) [Iter=1 Diff=0.00154]
E=-1671.0615 Grad=1.155 Conv=NO(1 cycles 5 points) [Iter=1 Diff=0.00597]
E=-1671.0162 Grad=3.123 Conv=NO(1 cycles 6 points) [Iter=1 Diff=0.00339]
E=-1671.0653 Grad=1.143 Conv=NO(2 cycles 7 points) [Iter=1 Diff=0.01133]
E=-1671.0653 Grad=1.143 Conv=NO(2 cycles 7 points) [Iter=2 Diff=0.00096]
E=-1671.0725 Grad=2.754 Conv=NO(2 cycles 8 points) [Iter=1 Diff=0.00140]
E=-1671.0762 Grad=1.680 Conv=NO(3 cycles 9 points) [Iter=1 Diff=0.00172]
E=-1671.1079 Grad=0.968 Conv=NO(3 cycles 10 points) [Iter=1 Diff=0.00199]
E=-1671.1213 Grad=0.275 Conv=NO(3 cycles 11 points) [Iter=1 Diff=0.00756]
E=-1671.0930 Grad=1.184 Conv=NO(3 cycles 12 points) [Iter=1 Diff=0.00488]
E=-1671.1215 Grad=0.153 Conv=NO(4 cycles 13 points) [Iter=1 Diff=0.00084]
E=-1671.1133 Grad=1.515 Conv=NO(4 cycles 14 points) [Iter=1 Diff=0.00057]
E=-1671.1223 Grad=0.102 Conv=NO(5 cycles 15 points) [Iter=1 Diff=0.00014]
E=-1671.1222 Grad=0.281 Conv=NO(5 cycles 16 points) [Iter=1 Diff=0.00006]
E=-1671.1224 Grad=0.024 Conv=YES(6 cycles 17 points)[Iter=1 Diff=0.00000]

<Values for optimized structure are given below.>

ENERGIES AND GRADIENT
Total Energy                        =  -11812.8442711 (kcal/mol)
Total Energy                        =   -18.825555543 (a.u.)
Binding Energy                      =   -1671.1224294 (kcal/mol)
Isolated Atomic Energy              =  -10141.7218417 (kcal/mol)
Electronic Energy                   =  -28505.2114559 (kcal/mol)
Core-Core Interaction               =   16692.3671848 (kcal/mol)
Gradient                            =   0.0248510 (kcal/mol/Ang)

EIGENVALUES(eV)
 -40.735325   -29.079802   -23.688864   -23.688860   -18.800158
 -15.713195   -15.713187     7.124108     7.124109     7.752248
   8.381527    10.037412    10.037416    11.649177

ATOMIC ORBITAL ELECTRON POPULATIONS
   1.010628     0.971429     1.035717     0.971429     1.010628
   0.971429     1.035717     0.971429     1.003599     1.003599
   1.003599     1.003599     1.003599     1.003599

NET CHARGES AND COORDINATES
Atom  Z     Charge             Coordinates(a.u.)
                            x           y           z
  1   6     0.010797      -1.01662    -0.81492     0.00000
  2   6     0.010797      -1.01663     1.93919     0.00000
  3   1    -0.003599       0.94470    -1.61103    -0.00001
  4   1    -0.003599      -1.99728    -1.61103     1.69856
  5   1    -0.003599      -1.99729    -1.61104    -1.69855
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  6   1    -0.003599      -2.97795     2.73530    -0.00001
  7   1    -0.003599      -0.03597     2.73530     1.69856
  8   1    -0.003599      -0.03596     2.73530    -1.69855

Dipole (Debyes)  x         y         z          Total
Point-Chg.       0.000     0.000     0.000     0.000
Hybrid           0.000     0.000     0.000     0.000
Sum              0.000     0.000     0.000     0.000

<Beginning of molecular dynamics calculation.>

Molecular dynamics, SemiEmpirical, molecule = ETHANE.HIN.
CNDO

Convergence limit = 0.0100000  Iteration limit = 50
Heat time = 0.0000 ps  Run time = 0.0050 ps
Cool time = 0.0000 ps  Time step = 0.0010 ps
Starting temperature = 0.0000 K  Simulation temperature = 300.0000 K
Final temperature = 0.0000 K  Temperature step = 0.0000 K
RHF Calculation:

Singlet state calculation
Number of electrons = 14
Number of Double Occupied Levels = 7
Charge on the System = 0
Total Orbitals = 14
Starting CNDO calculation with 14 orbitals

<Square brackets show inner iteration of trajectory.>

Time=0.0000 ps Total Energy=0.0000 kcal/mol T=0.00 K [Iter=1 
Diff=4387.33259]
Time=0.0000 ps Total Energy=0.0000 kcal/mol T=0.00 K [Iter=2 
Diff=2.77043]
Time=0.0000 ps Total Energy=0.0000 kcal/mol T=0.00 K [Iter=3 
Diff=0.23693]
Time=0.0000 ps Total Energy=0.0000 kcal/mol T=0.00 K [Iter=4 
Diff=0.02929]
Time=0.0000 ps Total Energy=0.0000 kcal/mol T=0.00 K [Iter=5 
Diff=0.00029]
Time=0.0000 ps Total Energy=-1663.9692 kcal/mol T=299.97 K [Iter=1 
Diff=0.02540]
Time=0.0000 ps Total Energy=-1663.9692 kcal/mol T=299.97 K [Iter=2 
Diff=0.00253]
Time=0.0010 ps Total Energy=-1664.2238 kcal/mol T=284.66 K [Iter=1 
Diff=0.02273]
Time=0.0010 ps Total Energy=-1664.2238 kcal/mol T=284.66 K [Iter=2 
Diff=0.00229]
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Time=0.0020 ps Total Energy=-1664.8376 kcal/mol T=247.75 K [Iter=1 
Diff=0.01758]
Time=0.0020 ps Total Energy=-1664.8376 kcal/mol T=247.75 K [Iter=2 
Diff=0.00178]
Time=0.0030 ps Total Energy=-1665.4801 kcal/mol T=209.23 K [Iter=1 
Diff=0.01282]
Time=0.0030 ps Total Energy=-1665.4801 kcal/mol T=209.23 K [Iter=2 
Diff=0.00130]
Time=0.0040 ps Total Energy=-1665.8840 kcal/mol T=185.31 K [Iter=1 
Diff=0.00989]

<Values for termination of trajectory are shown below.>

ENERGIES AND GRADIENT
Potential Energy                    =  -11811.9756909 (kcal/mol)
Potential Energy                    =   -18.824171329 (a.u.)
Binding Energy                      =   -1670.2538492 (kcal/mol)
Isolated Atomic Energy              =  -10141.7218417 (kcal/mol)
Electronic Energy                   =  -28579.1119570 (kcal/mol)
Core-Core Interaction               =   16767.1362662 (kcal/mol)
Gradient                            =      15.9022448 (kcal/mol/Ang)

EIGENVALUES(eV)
 -40.993458   -29.136822   -23.837172   -23.772387   -18.899385
 -15.648407   -15.521277     7.007665     7.054772     7.770212
   8.417984    10.039606    10.131248    11.863716

ATOMIC ORBITAL ELECTRON POPULATIONS
   1.007651     0.969464     1.035971     0.972535     1.006693
   0.972557     1.037679     0.969771     1.001260     1.007314
   1.006463     1.004401     1.002980     1.005261

NET CHARGES AND COORDINATES
Atom  Z     Charge             Coordinates(a.u.)
                            x           y           z
  1   6     0.014380      -0.98866    -0.79542    -0.01013
  2   6     0.013300      -1.03241     1.92194     0.01288
  3   1    -0.001260       0.93860    -1.62845    -0.00970
  4   1    -0.007314      -2.01437    -1.60907     1.66915
  5   1    -0.006463      -2.01617    -1.59763    -1.69357
  6   1    -0.004401      -2.99806     2.73141    -0.00538
  7   1    -0.002980      -0.07517     2.72392     1.70330
  8   1    -0.005261      -0.07984     2.72577    -1.69653

Dipole (Debyes)  x         y         z          Total
Point-Chg.       0.032     0.010     0.007     0.034
Hybrid          -0.021    -0.006    -0.004     0.022
Sum              0.011     0.003     0.002     0.012
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 Time = 0.0050 ps
 Kinetic Energy = 4.2293 kcal/mol
 Total Energy = -1666.0245 kcal/mol
 Temperature = 177.36 K
Time=0.0050 ps TotalEnergy=-1666.0245 kcal/mol T=177.36 K [final]]
HyperChem
log stop -- Sun Jan 26 20:01:15 1992

CNDO Configuration Interaction

<Below are the results of a microstate configuration interaction 
(CI) calculation.>

HyperChem log start -- Sun Jan 26 20:31:04 1992
Single Point, SemiEmpirical, molecule = ETHANE.HIN.
CNDO
Convergence limit = 0.0100000  Iteration limit = 50
RHF Calculation:
Singlet state calculation
Configuration interaction will be used
Number of electrons = 14
Number of Double Occupied Levels = 7
Charge on the System = 0
Total Orbitals = 14
Starting CNDO calculation with 14 orbitals

<First of all perform an SCF calculation to obtain a reference configuration.>

Iteration = 1 Difference = 4413.32086
Iteration = 2 Difference = 2.12419
Iteration = 3 Difference = 0.24927
Iteration = 4 Difference = 0.10723
Iteration = 5 Difference = 0.00046

<Now perform a configuration interaction calculation with the 
lowest 100 microstates (single determinants).  Report results for 
only the 10 lowest resulting configurations.>

CONFIGURATION INTERACTION
The Lowest Ten State Energies, Expectation Values of S(S+1) and S

State  Absolute E(kcal/mol) Relative E(kcal/mol)   S(S+1)      S
   1       -11803.7234927            0.0000000      0.00     0.00
   2       -11480.3053185          323.4181742      2.00     1.00
   3       -11466.9040318          336.8194609      2.00     1.00
   4       -11466.9025478          336.8209449      2.00     1.00
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   5       -11449.3794912          354.3440015      2.00     1.00
   6       -11449.3682000          354.3552927      0.00     0.00
   7       -11440.2197333          363.5037594      0.00     0.00
   8       -11440.2196214          363.5038713      0.00     0.00
   9       -11437.3047164          366.4187763      2.00     1.00
  10       -11437.3046177          366.4188750      2.00     1.00
Energy=-1662.001651 Gradient=65.321671

ENERGIES AND GRADIENT
Total Energy                        =  -11803.7234927 (kcal/mol)
Total Energy                        =   -18.811020202 (a.u.)
Binding Energy                      =   -1662.0016510 (kcal/mol)
Isolated Atomic Energy              =  -10141.7218417 (kcal/mol)
Electronic Energy                   =  -28494.5819582 (kcal/mol)
Core-Core Interaction               =   16690.8584655 (kcal/mol)
CI Energy                           =      -2.2861833 (kcal/mol)
Number of Configurations Used       =             100
Gradient of Reference Configuration =      65.3216714 (kcal/mol/Ang)

EIGENVALUES OF THE REFERENCE CONFIGURATION(eV)
 -40.386066   -29.239080   -23.532267   -23.532249   -18.191881
 -16.373669   -16.373646     7.900207     7.900218     8.076718
   8.596774    10.167131    10.167147    10.711308

ATOMIC ORBITAL ELECTRON POPULATIONS
   1.014662     0.977380     1.038151     0.977380     1.014662
   0.977380     1.038151     0.977380     0.997476     0.997476
   0.997476     0.997476     0.997476     0.997476

NET CHARGES AND COORDINATES
Atom  Z     Charge             Coordinates(a.u.)
                            x           y           z
  1   6    -0.007572      -1.01663    -0.89296     0.00000
  2   6    -0.007572      -1.01663     2.01722     0.00000
  3   1     0.002524       0.92538    -1.57955     0.00000
  4   1     0.002524      -1.98761    -1.57955     1.68183
  5   1     0.002524      -1.98763    -1.57956    -1.68182
  6   1     0.002524      -2.95863     2.70382     0.00000
  7   1     0.002524      -0.04564     2.70381     1.68183
  8   1     0.002524      -0.04562     2.70383    -1.68182

Dipole (Debyes)  x         y         z          Total
Point-Chg.       0.000     0.000     0.000     0.000
Hybrid           0.000     0.000     0.000     0.000
Sum              0.000     0.000     0.000     0.000
HyperChem
log stop -- Sun Jan 26 20:32:17 1992
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Force Field Files

HyperChem provides several files that you need for chemical cal-
culations with molecular mechanics force fields (MM+, AMBER, 
BIO+, and OPLS):

chem.rul A text file containing a set of rules for assigning 
atom types for each force field. HyperChem 
requires the binary version of this file, 
typerule.bin.

typerule.bin The binary version of chem.rul. HyperChem uses 
this file to assign atom types to atoms.

*.txt Force field parameter files in text format. You can 
change these files with most text editors. There is 
at least one set of TXT files for each force field.

*.dbf Force field parameter files in dBase (III or IV) for-
mat. You can change these files with most database 
programs. There is at least one set of DBF files for 
each force field. 

*.par The binary version of parameter files. HyperChem 
uses these files to direct molecular mechanics cal-
culations. HyperChem combines a complete set of 
parameter files for any force field into one PAR file. 
For the molecular mechanics force field MM+, the 
name of the binary parameter file is mmplus.par.

Note: You can use any filenames and extensions for parameter 
files. The settings in chem.ini (see Appendix F) direct HyperChem 
to the correct parameter files.
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Atom Types

For molecular mechanics calculations, each atom in a molecular 
system should have an atom type. Atom types represent sets of 
atoms of the same element that have similar chemical environ-
ments. Molecular mechanics calculations treat all atoms of the 
same type in similar ways. Each force field has a different set of 
atom types.

Atom types are generally required for molecular mechanics calcu-
lations, but not for semi-empirical calculations. The text file 
chem.rul contains rules that assign atom types to atoms, depend-
ing on the environment of the atoms. Each atom type has a name 
that might be different for each force field. Force fields require 
atom types to assign calculation parameters. The MM+ force field 
can deal with atoms that lack types (with the unknown type **) by 
using an alternative method for assigning parameters. This can be 
a useful feature for working around limitations of force fields that 
determine bonding characteristics on the basis of atom types. For 
example, MM+ makes the single bond in butadiene too short, 
since by default a bond between two C3-type atoms should have 
the length of a double bond. Similarly, MM+ tries to make biphe-
nyl planar, though experimentally the rings are not coplanar. By 
setting the two carbon atoms that are singly bonded to type **, 
these problems are avoided.

When you draw a new molecule, HyperChem gives each atom the 
type name **, indicating no atom type is yet assigned. When you 
choose Model Build or Calculate Types on the Build menu, or 
change the force field (using Molecular Mechanics on the Setup 
menu), HyperChem assigns appropriate atom types, using the 
force field that you chose in the Molecular Mechanics Force Field 
dialog box. After assigning types, a remaining ** means that there 
is no appropriate atom type available.

If you open a HIN file, HyperChem uses the force field that was in 
effect when you saved the file and assigns atom types stored in the 
file.

HyperChem requires a binary version of chem.rul, named 
typerule.bin, both of which come with HyperChem. If you alter 
the text file chem.rul, choose Compile Type Rules on the Build 
menu to convert the new chem.rul to a new typerule.bin file.
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Atom Typing Rules

You can add or modify the atom typing rules found in chem.rul, 
which contains rules for all force fields. The file has a hierarchical 
decision structure, including these levels:

• Force field

• Element

• Clause and tests

• Assignment statement

For each atom in a molecular structure, HyperChem scans this file 
and makes these decisions:

• What is the force field?

• What is the element?

• For this element, does the atom satisfy the tests in the first 
clause? If not, in the second clause, and so on? 

• When the atom satisfies the tests in a clause, HyperChem 
assigns the atom type.

• HyperChem goes to the next atom.

Caution: Changes to chem.rul can cause fatal errors in Hyper-
Chem. Make a backup copy of chem.rul before you change it.

Example:

S: connected to (H)?

=SH.

=S.

In this example for a sulphur atom (S), from the OPLS force field, 
the first clause contains one test: is the sulfur atom connected to a 
hydrogen? If true, the atom type is SH. If false, HyperChem goes to 
the next clause, which has no tests, only a statement that assigns 
S as the atom type.
Force Field Files 465



Atom Types
Syntax

This is the structure of chem.rul:

forcefield(<force-field-name>)

<element-symbol>:

; <comment>

<clause> 

<test>?

<test>?

. . .

=<assignment-statement>.

<clause>

. . . 

Note: Entries in chem.rul are not case-sensitive, except for element 
symbols. HyperChem recognizes, for example, the difference 
between SI and Si. Spaces between words are optional.

forcefield

<force-field-name> is amber, opls, bio+, or mm+.

<element-symbol>:

This is the chemical symbol for an element, for example, S, Cl, and 
Na.

A colon must follow the symbol. Each element can have only one 
symbol. Element symbols include LP for lone pair and HX for 
extended hydrogen.

;<comment>

Comments can occur anywhere in the file. A comment begins with 
a semicolon and ends at the end of a line.

<clause>

A clause is a set of tests applied to each atom plus an atom type 
assignment. Each clause ends with an assignment statement. 
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Note: HyperChem checks clauses from top to bottom, so their 
order is important. Place more specific clauses before general ones.

If one test in a clause fails, HyperChem goes to the next clause. If 
all the tests in a clause are evaluated as true, HyperChem assigns 
an atom type. Some elements have a final clause without tests. 
This assigns an atom type if all previous clauses failed. If the force 
field does not have a clause without tests and if all clauses failed, 
HyperChem assigns the atom type **, meaning unknown. 

<test>?

A question mark must follow each test. A clause can contain these 
tests:

Connected to Expressions

Connected to expressions include the type of connecting bond, 
the connected atoms, and bonds between the connected atoms. 
These symbols represent bonds:

– single bond

= double bond

Test To pass test

Is it sp3? True if the atom has no double, triple, or aromatic 
bonds

Is it sp2? True if the atom has one double or two or more 
aromatic bonds

Is it sp? True if the atom has one triple or two double 
bonds

In 5 ring? True if the atom is part of a five-membered ring

In 6 ring? True if the atom is part of a six-membered ring

Has aromatic bond? True if the atom has at least one aromatic bond

Connected to 
<expression>?

True if the atom is bonded to atoms described in 
<expression>. See the next section
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# triple bond

~ aromatic bond 

no symbol any bond type

Connected to expressions use element symbols to represent con-
nected atoms. You can use any standard symbols from the periodic 
table, plus these:

Lp Lone pair

Hx Extended hydrogen 

R Any element, including Lp, except H

X Any halogen (F, Cl, Br, I)

* Any element except Lp

Note: Keep connected to expressions as short as possible. Atom 
types are usually unaffected by atoms more than two or three 
bonds away. Also, longer expressions increase the time required to 
assign types.

Example:

C

The atom is connected to a carbon through any type of bond.

–C=N–C

The atom is connected to the CNC group through a single bond. 
The group contains a double and single bond.

–CH3

The atom is connected to a methyl group through a single bond.

–C(–CH3)–N

The atom is connected to a carbon through a single bond. The car-
bon has a methyl side chain (in parentheses) and a singly bonded 
nitrogen.

(–CH3)–N

The atom is connected to a methyl group by a single bond and a 
nitrogen by a single bond.

Note: HyperChem compares atom by atom the environment 
around an atom to the terms on a connected to expression. It does 
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not retrace its path. This prevents a simple carbon-carbon bond 
from satisfying expressions like –C–C–C–C–C. 

Side Groups

Specify side chains either by placing them in parentheses or by 
using numbers. For example:

–CH2 or –C(H)H

–CH2Cl or –C(H)(H)Cl

Rings

The atom being typed can be connected to or part of a ring. Pairs 
of tags (@1 to @9) placed after atoms in the ring describe closure 
points, for example: 

–C@1CCCCCC@1

This describes a connection to a six-membered ring, with the tag 
@1 after C1 and C7. C1 and C7 represent the same atom in the ring.

–@1CCC@1

This describes a cyclopropane ring, with the atom being typed as 
the first atom (C1) in the ring (@1 at the beginning of the expres-
sion modifies the atom being typed). C1 and C4 are the same atom.

<assignment-statement>.

A clause must end with an assignment statement that contains an 
atom type belonging to the force field. These types appear in the 
files *typ.txt (see the next section). The assignment statement 
must end with a period.

Force Field Parameters

Each force field can have several parameter sets. Each parameter 
set has a set of parameter files that define the interactions between 
atoms and the force constants for these interactions. HyperChem 
supplies each file in two formats, text (ASCII) and dBase III or IV. 
You can use either a text editor (like Windows Notepad) or a data-
base program (like Excel Q+E) to view and edit these files. The type 
of file that HyperChem uses can be different for each force field 
and parameter set, either TXT or DBF. The Registry, or the 
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chem.ini file (see, for example, “MM+ Settings” on page 563) 
defines the file type for each force field and parameter set in this 
record:

FileFormat=Text (or DBF for DBASE)

Parameter Files

HyperChem supplies the following parameter files for the force 
fields:

*typ.txt
*typ.dbf

List of atom types and atomic masses.

*str.txt
str.dbf

Parameters for bond stretching.

ben.txt
ben.dbf

Parameters for bond angle bending.

mmpben3.txt
mmpben3.dbf

For MM+ only, bond angle parameters for three-
membered rings.

mmpben4.txt
mmpben4.dbf

For MM+ only, bond angle parameters for four-
membered rings.

tor.txt
tor.dbf

Parameters for torsion angle rotation.

mmptor3.txt
mmptor3.dbf

For MM+ only, bond torsion parameters for three-
membered rings.

mmptor4.txt
mmptor4.dbf

For MM+ only, bond torsion parameters for four-
membered rings.

*imp.txt
*imp.dbf

For AMBER, BIO+, or OPLS, parameters for 
improper torsion angles (see the Glossary) involv-
ing planarity constraints.

mmpoop.txt
mmpoop.dbf

For MM+ only, out-of-plane bending parameters 
for an sp2 hybridized atom. Other force fields use 
improper torsion angles (see the Glossary) for these 
cases.

nbd.txt
nbd.dbf

Parameters for nonbonded interactions between 
pairs of atoms (atom types).

*npr.txt
*npr.dbf

Parameters for nonbonded, 1–4 interactions 
between specific pairs of atoms. At this time, only 
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the bio85 parameter set (see the next section) 
includes this file.

am*hbd.txt
am*hbd.dbf

For AMBER only, parameters for hydrogen
bonding.

.par A binary file combining the parameters files for 
one parameter set. A force field can have one PAR 
file for each parameter set (see the next section). 

HyperChem requires at least one binary (PAR) file for each force 
field. All PAR files are supplied on the HyperChem release disks. If 
you alter the parameter files (TXT or DBF), choose the parameter 
set (using Select Parameter Set on the Setup menu), and then 
choose Compile Parameter Set on the Setup menu to convert this 
parameter set to a PAR file.

To add a new parameter set, enter the information using a text edi-
tor or a database program. Then add to the Registry or to chem.ini 
(see Appendix F) a description of the parameter set.

Parameter Sets

Each force field can have more than one parameter set and a cor-
responding PAR file. This version of HyperChem has the following 
parameter sets available:

Parameter Set Parameter 
Files Included

Reference

mm+ mmp*.* Allinger, N.L., J. Am.Chem. 
Soc. 99:8127-8134, 1977

Quantum Chemistry Program 
Exchange (QCPE) Program #395 
(MM2), Indiana University 
Department of Chemistry, 
Bloomington, IN

amber2 amber*.* Weiner, S.J., et al., J. Comp. Chem. 
7:230-252, 1986
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The Registry, or the file chem.ini, lists the alternative parameter 
sets in the record CustomNames; for example: Custom-
Names=amber2, amber3. This file also gives the default conditions 
for each parameter set (see, for example, “AMBER Settings” on 
page 546).

amber3 am89a*.* Kollman, P.A., Department of Phar-
maceutical Chemistry, University of 
California, San Francisco, by 
request. For AMBER Release 3.0A

ambers am90s*.* Hohmans, S.W., Biochemistry 
29:9110 (1990). A force field opti-
mized for polysaccharide simulation

bio83 bio83*.* Brooks, B.R., et al. J. Comp. Chem. 
4:187-217, 1983. Since this version 
of CHARMM does not consider all 
dihedral angles, torsion force con-
stants for the missing angles are set 
to zero in BIO+

bio85 bio85*.* Reiher, W.E., III, Theoretical Studies 
of Hydrogen Bonding, Ph.D. thesis, 
Harvard University, 1985. Since this 
version of CHARMM does not con-
sider all dihedral angles, torsion 
force constants are scaled to include 
all dihedral angles

opls opls*.* Jorgensen, W.L. and Tirado-Rives, J. 
J. Am. Chem. Soc.110:1657-1666, 
1988

Pranata, J. et al., J. Am. Chem. Soc. 
113:2810-2819, 1991

Jorgensen, W.L. and Severance, D.L. 
J. Am. Chem. Soc. 112:4768-4774, 
1980

Parameter Set Parameter 
Files Included

Reference
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To choose a parameter set:

1. Choose Molecular Mechanics on the Setup menu, then choose 
a force field.

2. Choose Select Parameter Set on the Setup menu, then choose a 
parameter set for the chosen force field.

If you change the contents of a parameter file or add a new set of 
parameters, choose the parameter set (using Select Parameter Set 
on the Setup menu), and then choose Compile Parameter Set on the 
Setup menu to convert this parameter set to a PAR file.

Type Parameter File (*typ)

This file contains all atom types, and corresponding atomic 
masses, for a force field. The Registry, or the chem.ini file, specifies 
the names of these parameter files in AtomTypeMass records. The 
parameter file has three columns, separated by single tabs (in text 
files):

Example: MG 24.3050 magnesium

Bond Length Parameter File (str)

This file contains the bond stretch parameters for AMBER, BIO+,
or OPLS. The Registry, or the chem.ini file, specifies the names of 
these parameter files in QuadraticStretch records. The parameter 
file has five 
columns: 

a. C = four-character string, N = number, R = character string.

Column Content Field Typea

ATOM Atom type C

MASS Mass in grams/mol N

REFERENCE Comments and literature references R
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Example: A B 469.0000 1.4000 TYR

MM+ Bond Length Parameter file

The chem.ini file specifies the name of this parameter file in the 
MM+Stretch record. The parameter file has seven columns: 

a. C = four-character string, N = number, R = character string.

Column Content Field Typea

B1 Atom 1 (atom type) involved in bond C

B2 Atom 2 (atom type) involved in bond C

KR Stretching force constant in 
kcal/mol Å2

N

REQ Equilibrium distance in Ångstroms N

REFERENCE Comments and literature references R

Column Content Field Typea

T1 Atom 1 (atom type) involved in bond C

T2 Atom 2 (atom type) involved in bond C

KS Stretching force constant in 
millidynes/Å

N

L0 Minimum energy bond length in Å N

L1 Alternative minimum energy bond 
length in Å, used only if atoms1 and 2 
have less than two hydrogens attached 
to each

N

DIPOLE Bond dipole moment in Debyes N

REMARK Comments and literature
references

R
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Example: c4 c3 4.300 1.522 0.000 0.300 “my test parameter”

Bond Angle Parameter File (ben)

This file contains all bending (bond angle) parameters for the 
AMBER, BIO+, and OPLS force fields. The chem.ini file specifies the 
names of these parameter files in the QuadraticBend records. The 
parameter file has six columns:

Example: C2 C2 NT 80.0000 111.2000 pro jpc 76, 1439

MM+ Bond Angle Parameter Files

For MM+, there are three bend parameter files, the files mmpben.* 
for most bond angles and mmpben3.* and mmpben4.* for three- 
and four-membered rings. The Registry, or the chem.ini file, spec-
ifies the names of these parameter files in the records MMPBend, 
MMPBend3, and MMPBend4, respectively. The parameter files 
have eight columns:

a. C = four-character string, N = number, R = character string.

a. C = four-character string, N = number, R = character string.

Column Content Field Typea

A1 Atom 1 (atom type) involved in angle C

A2 Atom 2 (atom type), the central atom, 
involved in angle

C

A3 Atom 3 (atom type) involved in angle C

KTHETA Bending force constant in 
kcal/mol rad2

N

THETAEQ Equilibrium angle in degrees N

REFERENCE Comments and literature references R
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Example: c4 c3 c4 0.440 118.20 0.00 0.00 “my test parameter” 

Torsion Parameter File (tor)

This file contains torsional parameters for the AMBER, BIO+, 
and OPLS force fields. The Registry, or the chem.ini file, specifies 
the names of these parameter files in FourierTorsion records. The 
file has nine columns:

a. C = four-character string, N = number, R = character string.

Column Content Field Typea

Τ1 Atom type for end atom of bond angle C

Τ2 Atom type for central atom of bond angle C

Τ3 Atom type for other end atom of bond angle C

KS Bending force constant in millidyne Å/rad2 N

TYPE1 Standard bond angle. MM+ uses this angle 
unless TYPE2 and TYPE3 are nonzero and 
their conditions are satisfied

N

TYPE2 Bond angle if one end atom is hydrogen N

TYPE3 Bond angle if both end atoms are hydrogens N

REMARKS Comments and literature references R

Field Name Content Field Typea

T1 Atom 1 (atom type) involved in torsion C

T2 Atom 2 (atom type), a central atom, 
involved in torsion

C

T3 Atom 3 (atom type), a central atom, 
involved in torsion

C
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Note: If there are multiple parameters for the same T1, T2, T3, and 
T4 that differ in N (periodicity), the Fourier series uses all of them.

Example: N* CM CM CA 1 9.5100 180.000 2

MM+ Torsion Angle Parameter Files

For MM+, there are two torsion parameter files, mmptor.* for most 
torsions and mmptor4.* for torsions involving four-membered 
rings. The Registry, or the chem.ini file, specifies the names of 
these parameter files in the MMPTorsion and MMPTorsion4 
records. The parameter files have eight columns:

a. C = four-character string, N = number, R = character string.

T4 Atom 4 (atom type) involved in torsion C

MULT Multiplicity N

HALF_VN (Energy of torsional barrier N)/2, in 
kcal/mol

N

GAMMA Phase offset in degrees N

N Periodicity of the Fourier term, from 1 
to 6

N

REFERENCE Comments and literature references R

Column Content Field Typea

T1 Atom 1 (atom type) involved in torsion C

T2 Atom 2 (atom type), a central atom, 
involved in torsion 

C

T3 Atom 3 (atom type), a central atom, 
involved in torsion

C

T4 Atom 4 (atom type) involved in torsion C

Field Name Content Field Typea
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Example: o1 co o2 c4 –1.650 8.880 0.000 “my test parameter” 

Improper Torsion Parameter File (*imp)

This file contains all improper torsional parameters for AMBER or 
OPLS force fields. The Registry, or the chem.ini file, specifies the 
names of these parameter files in the FourierImpTorsion records. 
The central atom in an improper torsion is either atom 2 or atom 
3. The parameter file has eight columns:

a. C = four-character string, N = number, R = character string.

V1 Energy of torsional barrier V1, in 
kcal/mol

N

V2 Energy of torsional barrier V2, in 
kcal/mol

N

V3 Energy of torsional barrier V3, in 
kcal/mol

N

REMARK Comments and literature references R

Column Content Field Typea

T1 Atom 1 (atom type) involved in torsion C

T2 Atom 2 (atom type) involved in torsion C

T3 Atom 3 (atom type) involved in torsion C

T4 Atom 4 (atom type) involved in torsion C

HALF_VN (Energy of torsional barrier N)/2, in 
kcal/mol

N

GAMMA Phase offset in degrees N

N Periodicity of the Fourier term, from 1 to 
6

N

Column Content Field Typea
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Example: C3 CH NT C 114.00 180.00 3

BIO+ Improper Torsion Parameter File

The BIO+ force field uses a quadratic form for improper torsions. 
The Registry, or the chem.ini file, gives the names of this parame-
ter file in the QuadraticImpTorsion record. The parameter file has 
seven columns:

Example: N CH1E CH2E C 45.00 0.00 “J. Comput. Chem. 4, 
187 (1983)”

Out-of-plane Bending Parameter File (mmpoop)

This file contains parameters for the MM+ force field only, describ-
ing the planar arrangement of atoms bonded to an sp2 atom.

a. C = four-character string, N = number, R = character string.

a. C = four-character string, N = number, R l= character string.

REFERENCE Comments and literature references R

Column Content Field Typea

T1 Atom 1 (atom type) involved in torsion C

T2 Atom 2 (atom type) involved in torsion C

T3 Atom 3 (atom type) involved in torsion C

T4 Atom 4 (atom type) involved in torsion C

KOMEGA Improper torsion force constant in 
kcal/mol rad2

N

OMEGA0 Equilibrium improper torsion angle in 
degrees

N

REFERENCE Comments and literature references R

Column Content Field Typea
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If X is an sp2 hybridized atom, the attached atoms A, B, and C tend 
to be in the same plane as X. Y is the projection of X onto the plane 
ABC. The out-of-plane parameters involve the angles XAY, XBY, 
and XCY. The MM+ calculation also uses standard bond angle 
parameters (see page 475) for angles AYB, AYC, and BYC, where 
the atom type for Y is the same as X. 

The Registry, or the chem.ini file, gives the name of this parameter 
file in the MMPOOPBend record. The parameter file has four col-
umns:

Example: c3 c4 0.050 “my test parameter”

Nonbonded Parameter Files (nbd)

HyperChem calculates nonbonded interactions (which include 
van der Waals attractions) between pairs of atoms (actually, atom 

a. C = four-character string, N = number, R = character string.

Column Content Field Typea

C Atom type for central, sp2 hybridized 
atom (atom X in diagram)

C

A Atom type for one of the atoms bonded 
to atom C (atom A, B, or C in diagram)

C

COPB Out-of-plane bending force constant, in 
millidyne Å/rad2 (for angle XAY, XBY, or 
XCY in the diagram)

N

REMARK Comments and literature references R
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Force Field Parameters
types). The Registry, or the chem.ini file, specifies the names of 
these parameter files in the 6-12AtomVDW records.

There are three methods for calculating pair-wise interactions of 
atom types: R Star Epsilon, Sigma Epsilon, or Slater-Kirkwood (see 
HyperChem Computational Chemistry for a discussion of these meth-
ods). The contents of a parameter file depend on the combination 
method that you specify in the 6-12AtomVDWFormat records in 
Registry, or chem.ini, for AMBER, BIO+, and OPLS parameter sets. 

The default combination method for MM+ and AMBER is R Star 
Epsilon. You cannot change the combination method for MM+. 
The default methods for BIO+ and OPLS are R Star Epsilon and 
Sigma Epsilon, respectively. 

This is the format of a *NBD file using an R Star Epsilon calculation 
(four columns): 

Example: CA 1.8500 0.1200 Equivalent to C

This is the format of a *NBD file using a Sigma Epsilon calculation 
(four columns): 

a. C = four-character string, N = number, R = character string.

Column Content Field Typea

ATOM Atom type C

R_STAR Half the minimum energy nuclear sepa-
ration, in Ångstroms (van der Waals 
radius, r¡*). Uses an arithmetic mean for 
pair values

N

EPS Well depth in kcal/mol (minimum 
energy)

N

REFERENCE Comments and literature references R

Column Content Field Typea

ATOM Atom type C
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Force Field Parameters
This is the format of a *NBD file using a Slater-Kirkwood calcula-
tion (five columns): 

Pair-based Nonbonded Parameter Files

Each parameter set (except for MM+) can have an optional file 
containing parameters for nonbonded interactions between spe-
cific pairs of atoms. If these parameters are present, HyperChem 
uses them instead of calculating pair-wise interactions for specific 
atom types (see the previous section on *NBD files). In the present 
release of HyperChem, only BIO+ and OPLS have pair-based non-
bonded parameter files, charmnpr and oplsnpr. The Registry, or 
the chem.ini file, specifies the names of these parameter files in 6-
12PairVDW records. 

There are three methods for calculating parameters using the data 
in these files: R Star Epsilon, Sigma Epsilon, or AijBij (see HyperChem 

a. C = four-character string, N = number, R = character string.

a. C = four-character string, N = number, R = character string.

SIGMA Nuclear separation where energy is 
zero. Uses a geometric mean for pair 
values

N

EPS Well depth in kcal/mol (minimum 
energy)

N

REFERENCE Comments and literature references R

Column Content Field Typea

TYPE Atom type C

ALPHA Atomic polarizability N

NEFF Effective number of valence electrons N

RVDW van der Waals radius in Ångstroms N

REFERENCE Comments and literature references R

Column Content Field Typea
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Computational Chemistry for a discussion of these methods). The 
contents of a parameter file depend on the calculation method 
that you specify in the 6-12AtomVDWFormat records in Registry, 
or chem.ini, for AMBER, BIO+, and OPLS parameter sets. 
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This is the format of a *NPR file using an R Star Epsilon calculation 
(five columns):

This is the format of a *NPR file using a Sigma Epsilon calculation 
(five columns):

This is the format of a *NPR file using an AijBij calculation (five col-
umns): 

a. C = four-character string, N = number, R = character string.

a. C = four-character string, N = number, R = character string.

Field Name Content Field Typea

A1 Atom type of atom 1 C

A2 Atom type of atom 2 C

RMIN The minimum energy separation in Å N

EPSILON Well depth in kcal/mol N

REFERENCE Comments and literature references R

Field Name Content Field Typea

A1 Atom type of atom 1 C

A2 Atom type of atom 2 C

SIGMA The separation where energy is zero N

EPSILON Well depth in kcal/mol N

REFERENCE Comments and literature references R

Field Name Content Field Typea

A1 Atom type of atom 1 C
484 Appendix B



Force Field Parameters
BIO+ can use an additional pair-based nonbonded parameter file 
for 1–4, nonbonded interactions. The chem.ini file specifies the 
name of this parameter file in the 6-12Atom14VDW record. This 
file is not supplied in this release of HyperChem.

Hydrogen Bond Parameter File (am*hbd)

This file contains the hydrogen bonding parameters for the 
AMBER force field. The chem.ini file specifies the name of this 
parameter file in the 10-12PairHBond record. The file has five col-
umns:

Example: H NB 7557.00 2385.000 “Raphael”

a. C = four-character string, N = number, R = character string.

a. C = four-character string, N = number, R = character string.

b. , where i and j represent the interacting atoms.

A2 Atom type of atom 2 C

Aij The coefficient for the r –12 term 
(kcal/mol Å12)

N

Bij The coefficient for the r –6 term 
(kcal/mol Å6)

N

REFERENCE Comments and literature references R

Field Name Content Field Typea

ACC Atom type of acceptor C

DON Atom type of donor C

C Parameterb N

D Parameterb N

REFERENCE Comments and literature references R

Field Name Content Field Typea

EHBOND

Cij

r 12
i j

---------
Dij

r ij
10

-------–=
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Appendix C

Quantum Mechanics Files

Semi-Empirical Files

HyperChem provides several files that are necessary for semi-
empirical quantum mechanics calculations (Extended Hückel, 
CNDO, INDO, MINDO3, MNDO, AM1, PM3, ZINDO/1, and 
ZINDO/S). These files contain parameters that simplify solutions 
of the wave equations:

Method Filename Contents Reference

Extended 
Hückel

exhuckel.abp Alpha and beta parameters, 
orbital exponents

Howell, J. et al., QCPE #344a; see 
also following table

CNDO 
and INDO

cindo.abp Alpha and beta parameters, 
orbital exponents 

Pople, J. A. and Beveridge, D.L., 
Approximate Molecular Orbital 
Theory, McGraw-Hill, 1970.

MINDO3 mindo3_1.abp

mindo3_2.abp 

mindo3_3.abp

Core-electron attraction 
parameters, orbital exponents 
Electron repulsion parameters 
and ionization potentials 
Core-core repulsion and reso-
nance parameter

Dewar, M.J.S. et al., J. Am. Chem. 
Soc. 97:1285, 1975.

Dewar, M.J.S. et al., QCPE #506a.

MNDO mndo_1.abp

mndo_2.abp

Alpha and beta parameters, 
orbital exponents 
Electron repulsion parameters

Dewar, M.J.S. and Theil, W.,
 J. Am. Chem. Soc. 
99:4899, 1977.

Dewar, M.J.S. et al., QCPE #506a.
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Semi-Empirical Files
You may want to modify the parameter files when new and better 
parameters become available or you might add some new parame-
ters for testing purposes. The current parameter files include most 
of the parameters published in the literature. The contents of the 
files are described on the following pages.

a. Quantum Chemistry Program Exchange, Indiana University, Bloomington, IN

AM1 am1_1.abp

am1_2.abp 
am1_3.abp

Core-electron attraction and 
resonance parameters, orbital 
exponents 
Electron repulsion parameters 
Core-core repulsion parame-
ters

Dewar, M.J.S., et al., J. Am. Chem. 
Soc. 107:3902, 1985; Dewar, 
M.J.S., et al., QCPE #506a.

PM3 PM3_1.abp

PM3_2.abp 

PM3_3.abp

Core-electron attraction 
parameters, orbital 
exponents 
Electron repulsion parameters 
and ionization potentials 
Core-core repulsion and reso-
nance parameters

Stewart, J.J.P., J. Comp. Chem. 
12:320,1991; Stewart, J.J.P., et al., 
QCPE #506a.

ZINDO/1 zindo1_1.abp

zindo1_2.abp

zindo1_3.abp

Orbital exponents, ionization 
potentials, etc.
Slater-Condon parameters, 
total electronic energies, and 
heat of formation of free atoms
Ionization potentials and 
valence bond mixing 
coefficients

Bacon, A.D.; Zerner, M.C., Theor. 
Chim. Acta 53: 21-54, 1979 and 
Anderson, W.P.; Edwards, W.D.; 
Zerner, M.C., Inorgan. Chem. 25: 
2728, 1986

ZINDO/S zindos_1.abp

zindos_2.abp

zindos_3.abp

zindos_4.abp

Orbital exponents, ionization 
potentials, etc.
Slater-Condon parameters, 
total electronic energies, and 
heat of formation of free atoms
Ionization potentials and 
valence bond mixing 
coefficients
Empirical coulomb integrals

Ridley, J.; Zerner, M.C., 
Theor. Chim. Acta 32:111-134, 
1973; 42: 223-236, 1976; Zerner, 
et al., J. Am. Chem. Soc. 102:589, 
1980

Method Filename Contents Reference
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Extended Hückel Parameter File

The parameter file, exhuckel.abp, includes the parameters of 105 
real elements and 105 phoney fluorines. Each line in the file cor-
responds to the parameters for a particular element indexed by its 
atom number. The phoney fluorines are used in mixed mode cal-
culations. To distinguish phoney fluorines from the real elements, 
the phoney fluorines are labeled with negative atomic numbers.

The parameters for each element have also been extended and 
include nine data items because of the use of double-ζ for the 
Slater d-orbitals for the transition metals. 

exhuckel.abp File Format

The description of each column in the exhuckel.abp parameter file 
is shown in the following table. 

Column Symbol Content

1 Z Atomic number, negative values correspond 
to capping atoms

2 ζs s orbital Slater exponent (a.u.)

3 ζp p orbital Slater exponent (a.u.)

4 ζd d orbital Slater exponent (a.u.)

5 Is s orbital ionization potential (eV)

6 Ip p orbital ionization potential (eV)

7 Id d orbital ionization potential (eV)

8 C1 coefficient of Slater exponent ζd

9 ζd2 d orbital Slater exponent (a.u.)

10 C2 coefficient of Slater exponent ζd2
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References for Parameters in exhuckel.abp

1. R.Hoffmann, J. Chem. Phys. 39 (1963), 1397.

2. A.B.Anderson, R.Hoffmann, J. Chem. Phys. 60 (1974), 4271.

3. A.R.Rossi, R.Hoffmann, Inorg. Chem. 14 (1975), 365.

4. P.J.Hay, J.C.Thibeault, R.Hoffmann, J. Am. Chem. Soc. 97 
(1975), 4884.

5. M.Elian, R.Hoffmann, Inorg. Chem. 14 (1975), 1058.

6. R.H.Summerzille, R.Hoffmann, J. Am. Chem. Soc. 98 (1976), 
7240.

7. J.W.Lauher, R.Hoffmann, J. Am. Chem. Soc. 98 (1976), 1729.

8. M.M.L.Chen, R.Hoffmann, J. Am. Chem. Soc. 98 (1976), 1647.

9. J.W.Lauher, M.Elian, R.H.Summerville, R.Hoffmann, J. Am. 
Chem. Soc. 98 (1976), 3219.

10. T.A.Albright, P.Hofmann, R.Hoffmann, J. Am. Chem. Soc. 99 
(1977), 7546.

11. D.L.Dubois, R.Hoffmann, Nouv. J. Chim. 1 (1977), 479.

12. S.Komiya, T.A.Albright, R.Hoffmann, J.K.Kochi, J. Am. Chem. 
Soc. 99 (1977), 8440.

13. D.L.Thorn, R.Hoffmann, Inorg. Chem. 17 (1978), 126.

14. N.Trong Anh, M.Elian, Hoffmann, J. Am. Chem. Soc. 100 
(1978), 110.

15. L.L.Lohr, P.Pykko, Chem. Phys. Lett. 62 (1979), 333.

16. A.Dedieu, T.A.Albright, R.Hoffmann, J. Am. Chem. Soc. 101 
(1979), 3141.

17. R.Hoffmann, S.Shaik, J.C.Scott, M.-H.Whangbo, M.J.Foshee, 
J. Solid State Chem. 34 (1980), 263.

18. K.Tatsummi, R.Hoffmann, Inorg. Chem. 19 (1980), 2656.

19. K.Tatsumi, R.Hoffmann, A.Yamamoto, J.K.Stille, Bull. Chem. 
Soc. Jpn. 54 (1981), 1857.

20. J.Hinze. H.H.Jaffe, J. Chem. Phys. 67 (1963), 1501.

21. K.Tatsumi, R.Hoffmann, J. Am. Chem. Soc. 103 (1981), 3340.
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22. P.Kubacek, R.Hoffmann, Z.Havlas, Organometallics 1 (1982), 
180.

23. D.M.Hoffman, R.Hoffmann, C.R.Fiesel, J. Am. Chem. Soc. 104 
(1982) 3856.

24. T.Hughbanks, R.Hoffmann, M.-H.Whangbo, K.R.Stewart, 
O. Eisenstein, E.Canadell, J. Am. Chem. Soc. 104 (1982) 3876.

25. E.Canadell, O.Eisenstein, Inorg. Chem. 22 (1983) 2398.

26. J.Silvestre. T.A.Albright, Isr. J. Chem. 23 (1983), 139.

27. E.Canadell, O.Eisenstein, Inorg. Chem. 22 (1983), 3856.

28. G.Trinquier, R.Hoffmann, J. Phys. Chem. 88 (1984), 6696.

29. M.Kertesz, R.Hoffmann, J. Am. Chem. Soc. 106 (1984), 3453.

30. R.Hoffmann, C.Minot, H.B.Gray, J. Am. Chem. Soc. 106 (1984), 
2001.

31. M.-H.Whangbo, P.Gressier, Inorg. Chem. 23 (1984), 1228.

32. J.-Y Saillard, R.Hoffmann, J. Am. Chem. Soc. 106 (1984), 2006.

33. E.Canadell, O.Eisenstein, J.Rubio, Organometallics 3 (1984), 
759.

34. E.Canadell, O.Eisenstein, T.Hughbanks, Inorg. Chem. 23 
(1984), 2435.

35. M.-H.Whangbo, W.M.Walsh, R.C.Haddon, F.Wudl, Solid State 
Comm. 43 (1982), 637.

36. O.P.Charkin, Russ. J. Inorg. Chem. (Engl. Transl.) 19 (1974), 
1590.

37. S.P.McGlynn, L.G.Vanquickenborne, M.Kinoshita, D.G.Car-
roll, Introduction to Applied Quantum Chemistry, Holt, Rinehart 
and Winston, Inc. New York, 1977, pp. 423-431.

38. W.A.Harrison, Electronic Structure and the Properties of Solids, 
W.Freeman and Co., San Francisco, 1980, p. 551.

CNDO and INDO Parameter File

This parameter file, cindo.abp, includes the parameters of 54 real 
elements and 54 phoney fluorines. The phoney fluorines are used 
in mixed mode calculations. The number of parameters for each 
element is 12.
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Each line in cindo.abp corresponds to the parameters for a partic-
ular element indexed by its atom number. The parameters with 
negative atomic numbers correspond to the parameters for the 
capping atoms.

cindo.abp File Format

The description of each column of the parameter file is shown in 
the following table.

Column Symbol Content

1 Z Atomic number, negative atomic numbers for 
capping atomsa

2 ζs s orbital Slater exponent (a.u.)

3 ζp p orbital Slater exponent (a.u.)

4 ζd d orbital Slater exponent (a.u.)

5 Negative of averaged ionization potential and 
electron affinity of s orbital (eV)

6 Negative of averaged ionization potential and 
electron affinity of p orbital (eV)

7 Negative of averaged ionization potential and 
electron affinity of d orbital (eV)

8 b Bonding parameters (eV)

9 F2 Slater-Condon parameters F2 (p,p) (a.u.)

10 G1 Slater-Condon parameters G1(s,p) (a.u.)

11 Eatom Electron energy of isolated atom for CNDOb 
(eV)

12 Eatom Electron energy of isolated atom for INDOb

(eV)

1
2
---– Is As+( )

1
2
---– Ip Ap+( )

1
2
---– Id Ad+( )
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The electronic energy of isolated atoms depends on the parameters 
in both CNDO and INDO. The electronic energies of isolated 
atoms in the cindo.abp file were calculated in terms of the param-
eters listed in this parameter file for the corresponding ground 
states, that is, the spin multiplicities are 1 for Be, 2 for H, Li, B, F, 
Na, Al, and Cl, 3 for C, O, Si, and S, and 4 for N in the RHF method 
in both CNDO and INDO.

MINDO/3 Parameter Files

The parameter files for this method include 54 real elements and 
54 phoney fluorines. The phoney fluorines are used in mixed 
mode calculations. 

The third parameter file mindo3_3.abp, only includes the bond 
parameters in the MINDO3 approximation level published in the 
literature. The first two entries in mindo3_3.abp define a pair of 
elements corresponding to the bond parameters. Negative num-
bers define phoney fluorines.

If the bond parameters appear more than once in this parameter 
file for the same pair of atoms, the parameters that appear last are 
used in MINDO3 calculations. The maximum number of pairs of 
atoms can be 108 * (108 - 1) / 2 + 107. The absolute value of the 
atomic number must be larger than zero and less than or equal to 
54. 

a. Parameterized fluorine atoms that represent atoms bonded to the at-
oms selected for the calculation (see HyperChem Computational Chemis-
try, Theory and Methods).

b. Calculated from the parameters listed in this file for the corresponding
ground states.

13 Hatom Heat of formation of free atom (kcal/mol)

Column Symbol Content
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mindo3_1.abp File Format

The description of each column of this parameter file is shown in 
the following table.

Column Symbol Content

1 Z Atomic number, negative values denote cap-
ping atoms

2 Uss One-center core-electron attraction, plus 
kinetic energy

3 Upp One-center core-electron attraction, plus 
kinetic energy

4 Udd One-center core-electron attraction, plus 
kinetic energy

5 reserved

6 reserved

7 reserved

8 ζs s orbital Slater exponent

9 ζp p orbital Slater exponent

10 ζd d orbital Slater exponent

11 reserved

12 Eatom Ground state electronic energy of isolated 
atom

13 Hatom Heat of formation of free atom
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mindo3_2.abp File Format

The description of each column of this parameter file is shown in 
the following table.

Column Symbol Content

1 Z Atomic number, negative values denote cap-
ping atoms

2 Gss One-center electron repulsion integral, 
Gss = (ss | ss)

3 Gsp One-center electron repulsion integral, 
Gsp = (ss | pp)

4 Gpp One-center electron repulsion integral, 
Gpp = (pp | pp)

5 Gp2 One-center electron repulsion integral, 
Gp2 = (pp | p’p’)

6 Hsp One-center electron repulsion integral, 
Hsp = (sp | sp)

7 reserved

8 reserved

9 reserved

10 Is s orbital ionization potential

11 Ip p orbital ionization potential

12 Id d orbital ionization potential

13 A Averaged one center, two electron integral 
used in calculating two center, two electron 
integral

14 reserved
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mindo3_3.abp File Format

The description of each column of this parameter file is shown in 
the following table.

MNDO Parameter Files

mndo_1.abp File Format

The description of each column of this parameter file is shown in 
the following table.

Column Symbol Content

1, 2 Z1, Z2 Atomic numbers defining pair of elements; 
negative value denotes capping atom

3 αAB Bond parameter used in calculating 
core-core repulsion integral

4 βAB Bond parameter used in calculating 
resonance integral

Column Symbol Content

1 Z Atomic number

2 Uss One-center core-electron attraction, plus 
kinetic energy

3 Upp One-center core-electron attraction, plus 
kinetic energy

4 Udd One-center core-electron attraction, plus 
kinetic energy

5 βs s orbital bond parameter used in calculating 
resonance integral

6 βp p orbital bond parameter used in calculating 
resonance integral
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mndo_2.abp File Format

The description of each column of this parameter file is shown in 
the following table.

7 βd d orbital bond parameter used in calculating 
resonance integral

8 ζs s orbital Slater exponent

9 ζp p orbital Slater exponent

10 ζd d orbital Slater exponent

11 a Parameter used in core-core repulsion integral

12 Eatom Ground state electronic energy of isolated 
atom

13 Hatom Heat of formation of free atom

Column Symbol Content

1 Z Atomic number

2 Gss One-center electron repulsion integral, 
Gss = (ss | ss)

3 Gsp One-center electron repulsion integral, 
Gsp = (ss | pp)

4 Gpp One-center electron repulsion integral, 
Gpp = (pp | pp)

5 Gp2 One-center electron repulsion integral, 
Gp2 = (pp | p’p’)

Column Symbol Content
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AM1 and PM3 Parameter Files

AM1 and PM3 parameter files share a common format, described 
below. The AM1 file names start with “am1_” and the PM3 file 
names start with “pm3_”.

am1_1.abp and pm3_1.abp File Format

The description of each column of these parameter files is shown 
in the following table.

6 Hsp One-center electron repulsion integral, 
Hsp = (sp | sp)

7 reserved

8 reserved

9 reserved

10 D1 Distance of a dipole charge from its nucleus

11 D2 Half the distance of a linear quadrupole charge 
from its nucleus

12 AM Monopole-monopole interaction parameter

13 AD Dipole-dipole interaction parameter

14 AQ Quadrupole-quadrupole interaction parameter

Column Symbol Content

1 Z Atomic number

2 Uss One-center core-electron attraction, plus 
kinetic energy

Column Symbol Content
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am1_2.abp and pm3_2.abp File Format

The description of each column of these parameter files is shown 
in the following table.

3 Upp One-center core-electron attraction, plus 
kinetic energy

4 Udd One-center core-electron attraction, plus 
kinetic energy

5 βs s orbital bond parameter used in calculating 
resonance integral

6 βp p orbital bond parameter used in calculating 
resonance integral

7 βd d orbital bond parameter used in calculating 
resonance integral

8 ζs s orbital Slater exponent

9 ζp p orbital Slater exponent

10 ζd d orbital Slater exponent

11 α Parameter used in core-core repulsion integral

12 Eatom Ground state electronic energy of isolated 
atom

13 Hatom Heat of formation of free atom

Column Symbol Content

1 Z Atomic number

Column Symbol Content
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2 Gss One-center electron repulsion integral, 
Gss = (ss | ss)

3 Gsp One-center electron repulsion integral, 
Gsp = (ss | pp)

4 Gpp One-center electron repulsion integral, 
Gpp = (pp | pp)

5 Gp2 One-center electron repulsion integral, 
Gp2 = (pp | p’p’)

6 Hsp One-center electron repulsion integral, 
Hsp = (sp | sp)

7 reserved

8 reserved

9 reserved

10 D1 Distance of a dipole charge from its nucleus

11 D2 Half the distance of a linear quadrupole charge 
from its nucleus

12 AM Monopole-monopole interaction parameter

13 AD Dipole-dipole interaction parameter

14 AQ Quadrupole-quadrupole interaction parameter

Column Symbol Content
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am1_3.abp and pm3_3.abp File Format

In these files, the parameters in three successive (referred to as line 
1-3 in the next table) lines apply only to one element. Each line 
contains 11 columns.

ZINDO/1 Parameter Files

zindo1_1.abp File Format

The description of each column of this parameter file is shown in 
the following table.

Column Line Symbol Content

1 1-3 Z Atomic number

2-11 1 ak (k = 1, 2 . . . 10) Parameters used in cal-
culating core-core inter-
actions2 bk (k = 1, 2 . . . 10)

3 ck (k = 1, 2 . . . 10)

Column Symbol Content

1 Z Atomic number (negative value corresponds 
to the capping atom)

2 s-orbital Slater exponent for computing the 
overlap and coulomb integrals (a.u.)

3 p-orbital Slater exponent for computing the 
overlap and coulomb integrals (a.u.)

4 d-orbital Slater exponent for computing the 
coulomb integrals only (a.u.)

5 Is Ionization potential of s orbital (eV)

6 Ip Ionization potential of p orbital (eV)

ζs

ζp

ζd
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zindo1_2.abp File Format

The description of each column of this parameter file is shown in 
the following table.

7 Id Ionization potential of d orbital (eV)

8 s-orbital bond parameter used in calculating 
resonance integral (eV)

9 p-orbital bond parameter used in calculating 
resonance integral (eV)

10 d-orbital bond parameter used in calculating 
resonance integral (eV)

11 d-orbital Slater exponent 1 for computing the 
overlap integrals (a.u.)

12 C1 coefficient corresponding to the Slater expo-
nent 

13 d-orbital Slater exponent 2 for computing the 
overlap integrals (a.u.)

14 C2 coefficient corresponding to the Slater expo-
nent 

Column Symbol Content

1 Z Atomic number (negative value corresponding 
to the capping atom)

2 F2 Slater-Condon parameter F2(p,p) (a.u.)

3 G1 Slater-Condon parameter G1(s,p) (a.u.)

Column Symbol Content

βs

βp

βd

ζd1

ζd1

ζd2

ζd2
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zindo1_3.abp File Format

The description of each column of this parameter file is shown in 
the following table.

4 F2 Slater-Condon parameter F2(p,d) (a.u.)

5 F2 Slater-Condon parameter F2(d,d) (a.u.)

6 F4 Slater-Condon parameter F4(d,d) (a.u.)

7 G1 Slater-Condon parameter G1(p,d) (a.u.)

8 G2 Slater-Condon parameter G2(s,d) (a.u.)

9 G3 Slater-Condon parameter G3(p,d) (a.u.)

10 Eatom Electronic energy of isolated atom (eV)

11 Hatom Heat of formation of free atom (kcal/mol)

Column Symbol Content

1 Z Atomic number (negative value corresponding 
to the capping atom)

2 Is
a Second set of ionization potential of s-orbital, 

3d n-1 4s -> 3d n-1 in (eV)

3 Ip
a Second set of ionization potential of p-orbital, 

3d n-1 4p -> 3d n-1 in (eV)

4 Id
a Second set of ionization potential of d-orbital, 

3d n-1 4s -> 3d n-2 4s in (eV)

5 reserved

6 reserved

Column Symbol Content
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ZINDO/S Parameter Files

zindos_1.abp File Format

The description of each column of this parameter file is shown in 
the following table.

a. Applies only to the first row transition metals. Only one set of ioniza-
tion potentials has been used in HyperChem for the second row transi-
tion metals. This set is obtained by averaging the ionization potentials
from different configurations of the ground state of the corresponding at-
oms (see e.g., Anderson, W.P.; Cundari, T.R.;Zerner, M.C., Int. J. Quantum
Chem. 39: 31-45, 1991.

7 reserved

8 C1
a Fractional contribution of the d n-2s2 

configuration to the core integral

9 C2
a Fractional contribution of the d n-1s(p) 

configuration to the core integral

10 C3
a Fractional contribution of the d n

configuration to the core integral

Column Symbol Content

1 Z Atomic number, negative value corresponding 
to the capping atom

2 s-orbital Slater exponent for computing the 
overlap integrals (a.u.)

3 p-orbital Slater exponent for computing the 
overlap integrals (a.u.)

4 reserved

5 Is Ionization potential of s orbital (eV)

Column Symbol Content

ζs

ζp
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zindos_2.abp File Format

The description of each column of this parameter file is shown in 
the following table.

6 Ip Ionization potential of p orbital (eV)

7 Id Ionization potential of d orbital (eV)

8 s-orbital bond parameter used in calculating 
resonance integral (eV)

9 p-orbital bond parameter used in calculating 
resonance integral (eV)

10 d-orbital bond parameter used in calculating 
resonance integral (eV)

11 d-orbital Slater exponent 1 for computing the 
overlap integrals (a.u.)

12 C1 coefficient corresponding to the Slater 
exponent 

13 d-orbital Slater exponent 2 for computing the 
overlap integrals

14 C2
coefficient corresponding to the Slater 
exponent 

Column Symbol Content

1 Z Atomic number (negative value corresponding 
to the capping atom)

2 F2 Slater-Condon parameter F2(p,p) (a.u.)

3 G1 Slater-Condon parameter G1(s,p) (a.u.)

4 F2 Slater-Condon parameter F2(p,d) (a.u.)

Column Symbol Content

βs

βp

βd

ζd1

ζd1

ζd2

ζd2
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zindos_3.abp File Format

The description of each column of this parameter file is shown in 
the following table.

5 F2 Slater-Condon parameter F2(d,d) (a.u.)

6 F4 Slater-Condon parameter F4(d,d) (a.u.)

7 G1 Slater-Condon parameter G1(p,d) (a.u.)

8 G2 Slater-Condon parameter G2(s,d) (a.u.)

9 G3 Slater-Condon parameter G3(p,d) (a.u.)

10 Eatom Electronic energy of isolated atom (eV)

11 Hatom Heat of formation of free atom (kcal/mol)

Column Symbol Content

1 Z Atomic number (negative value corresponding 
to the capping atom)

2 Is
a Second set of ionization potential of s-orbital, 

3d n-1 4s -> 3d n-1 in (eV)

3 Ip
a Second set of ionization potential of p-orbital, 

3d n-1 4p -> 3d n-1 in (eV)

4 Id
a Second set of ionization potential of d-orbital, 

3d n-1 4s -> 3d n-2 4s in (eV)

5 reserved

6 reserved

7 reserved

Column Symbol Content
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zindos_4.abp File Format

The description of each column of this parameter file is shown in 
the following table.

a. Applies only to the first row transition metals. Only one set of ioniza-
tion potentials has been used in HyperChem for the second row transi-
tion metals. This set is obtained by averaging the ionization potentials
from different configurations of the ground state of the corresponding at-
oms (see e.g., Anderson, W.P.; Cundari, T.R.; Zerner, M.C., Int. J. Quantum
Chem. 39:31-45, 1991).

8 C1 Fractional contribution of the d n-2s2 

configuration to the core integral

9 C2 Fractional contribution of the d n-1s(p) 
configuration to the core integral

10 C3
a Fractional contribution of the d n

configuration to the core integral

Column Symbol Content

1 Z Atomic number (negative value corresponding 
to the capping atom)

2 Two-electron one-center coulomb integral, 
in eV

3 Two-electron one-center coulomb integral, 
in eV

4 Two-electron one-center coulomb integral, 
in eV

Column Symbol Content

γss

γσδ

γdd
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Basis Set Files

The file name of a basis set file in HyperChem can be any name 
acceptable by MS-Windows that ends in ‘.BAS’.

Basis Set File Format

HyperChem uses its own format to define a basis set. All the stan-
dard and commonly used basis sets can be fitted into this basis set 
format. Users can also define their own basis sets by using the 
HyperChem basis set format.

Basis Set

A basis function for a element includes the following items:

• Element symbol

• Number of shells

• Shell types

• Number of primitive Gaussians for each shell

• Scaling factor for each shell

• Exponent and contraction coefficients for each primitive 
Gaussian.

Example:

C:

;

Shells = 3

Shell1 =[ S   3   1.00 ]

   1    0.172256E+03    0.617669E-01

   2    0.259109E+02    0.358794E+00

   3    0.553335E+01    0.700713E+00

Shell2 =[ SP  2   1.00 ]

   1    0.366498E+01   -0.395897E+00    0.236460E+00

   2    0.770545E+00    0.121584E+01    0.860619E+00
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Shell3 =[ SP  1   1.00 ]

   1    0.195857E+00    0.100000E+01    0.100000E+01

This example defines a 3-21G basis function for carbon. There are 
3 shells. The first shell is a S type and contracted using 3 primitive 
Gaussians with a scaling factor of 1.0; the second shell is an SP type 
and contracted using 2 primitive Gaussians with a scaling factor of 
1.0; and the third shell is a SP type and contracted using only 1 
primitive Gaussian with a scaling factor of 1.0.

The types of shells are supported in HyperChem Release 5 are S, P, 
D, SP, and SPD.

Syntax

This is the structure for defining a basis for a element:

<element-symbol>:

; <comment>

shells = <# number of shells for this element>

shell1 = [ <Ta>   <##b>   <sc>  ]

<primitive 1>  <exponent>  <coefficientsd>

<primitive 2>  <exponent>  <coefficientsd>

... (repeat ## times for the primitives for this shell)

... (repeat # times for all the shells for this element)

a. Shell type
b. Number of primitive Gaussians for this shell
c. Scaling factor for this shell
d. Coefficients for this primitive Gaussian.  The number of coefficients is one for a S, P, or D type of

primitive Gaussian, two for a SP, type of primitive Gaussian, and three for a SPD type of primitive
Gaussian
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List of Basis Set Files

HyperChem includes many standard and commonly used basis set 
files. The following table is an overview of these files:

Filename Contents Reference

3-21g.bas Definitions and 
contractions for 3-21G 
basis set

J. S. Binkley, J. A. Pople, and W. J. Hehre, J. Am. 
Chem. Soc., 102, 939 (1980).
M. S. Gordon, J. S. Binkley, J. A. Pople, W. J. Pietro, 
and W. J. Hehre, J. Am. Chem. Soc., 104, 2797 
(1982).
W. J. Pietro, M. M. Francl, W. J. Hehre, D. J. Defrees, 
J. A. Pople, and J. S Binkley, J. Am. Chem. Soc., 104, 
5039 (1982).

3-21gs.bas Definitions and 
contractions for 3-21G* 
basis set

3-21gss.bas Definitions and 
contractions for 3-21G** 
basis set

4-21g.bas Definitions and 
contractions for 4-21G 
basis set

W. J. Hehre, R. Ditchfield, and J. A. Pople, J. Chem. 
Phys., 56, 2257 (1972).
P. C. Hariharan and J. A. Pople, Theor. Chim. Acta, 
28, 213 (1973).
M. S. Gordon, Chem. Phys. Lett., 76, 163 (1980).4-21gs.bas Definitions and 

contractions for 4-21G* 
basis set

4-21gss.bas Definitions and 
contractions for 4-21G** 
basis set

4-31g.bas Definitions and 
contractions for 4-31G 
basis set

W. J. Hehre, R. Ditchfield, and J. A. Pople, J. Chem. 
Phys., 56, 2257 (1972).
P. C. Hariharan and J. A. Pople, Theor. Chim. Acta, 
28, 213 (1973).
M. S. Gordon, Chem. Phys. Lett., 76, 163 (1980).4-31gs.bas Definitions and 

contractions for 4-31G* 
basis set

4-31gss.bas Definitions and 
contractions for 4-31G** 
basis set
510 Appendix C



Basis Set Files
5-31g.bas Definitions and 
contractions for 5-31G 
basis set

W. J. Hehre, R. Ditchfield, and J. A. Pople, J. Chem. 
Phys., 56, 2257 (1972).
P. C. Hariharan and J. A. Pople, Theor. Chim. Acta, 
28, 213 (1973).
M. S. Gordon, Chem. Phys. Lett., 76, 163 (1980).5-31gs.bas Definitions and 

contractions for 5-31G* 
basis set

5-31gss.bas Definitions and 
contractions for 5-31G** 
basis set

6-21g.bas Definitions and 
contractions for 6-21G 
basis set

J. S. Binkley, J. A. Pople, and W. J. Hehre, J. Am. 
Chem. Soc., 102, 939 (1980).
M. S. Gordon, J. S. Binkley, J. A. Pople, W. J. Pietro, 
and W. J. Hehre, J. Am. Chem. Soc., 104, 2797 
(1982).
W. J. Pietro, M. M. Francl, W. J. Hehre, D. J. Defrees, 
J. A. Pople, and J. S Binkley, J. Am. Chem. Soc., 104, 
5039 (1982).

6-21gs.bas Definitions and 
contractions for 6-21G* 
basis set

6-21gss.bas Definitions and 
contractions for 6-21G** 
basis set

6-31g.bas Definitions and 
contractions for 6-31G 
basis set

W. J. Hehre, R. Ditchfield, and J. A. Pople, J. Chem. 
Phys., 56, 2257 (1972).
P. C. Hariharan and J. A. Pople, Theor. Chim. Acta, 
28, 213 (1973).
M. S. Gordon, Chem. Phys. Lett., 76, 163 (1980).6-31gs.bas Definitions and 

contractions for 6-31G* 
basis set

6-31gss.bas Definitions and 
contractions for 6-31G** 
basis set

Filename Contents Reference
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6-311g.bas Definitions and 
contractions for 6-311G 
basis set

R. Krishnan, J. S. Binkley, R. Seeger, and J. A. Pople, 
J. Chem. Phys., 72, 650 (1980).
A. D. McLean and G. S. Chandler, J. Chem. Phys., 
72, 5639 (1980).

6-311gs.bas Definitions and 
contractions for 
6-311G* basis set

6-311gss.bas Definitions and 
contractions for 
6-311G** basis set

sto-1g.bas Definitions and 
contractions for 
STO-1G basis set

W. J. Hehre, R. F. Stewart, and J. A. Pople, J. Chem. 
Phys., 51, 2657 (1969).
J. B. Collins, P. V. Schleyer, J. S. Binkley, and J. A. 
Pople, J. Chem. Phys., 64, 5142 (1976).
R. F. Stewart, J. Chem. Phys., 52, 431 (1970).sto-1gs.bas Definitions and 

contractions for 
STO-1G* basis set

sto-2g.bas Definitions and 
contractions for 
STO-2G basis set

sto-2gs.bas Definitions and 
contractions for 
STO-2G* basis set

sto-3g.bas Definitions and 
contractions for 
STO-3G basis set

W. J. Hehre, R. F. Stewart, and J. A. Pople, J. Chem. 
Phys., 51, 2657 (1969).
J. B. Collins, P. V. Schleyer, J. S. Binkley, and J. A. 
Pople, J. Chem. Phys., 64, 5142 (1976).
R. F. Stewart, J. Chem. Phys., 52, 431 (1970).sto-3gs.bas Definitions and 

contractions for 
STO-3G* basis set

Filename Contents Reference
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sto-4g.bas Definitions and 
contractions for 
STO-4G basis set

W. J. Hehre, R. F. Stewart, and J. A. Pople, J. Chem. 
Phys., 51, 2657 (1969).
J. B. Collins, P. V. Schleyer, J. S. Binkley, and J. A. 
Pople, J. Chem. Phys., 64, 5142 (1976).
R. F. Stewart, J. Chem. Phys., 52, 431 (1970).sto-4gs.bas Definitions and 

contractions for 
STO-4G* basis set

sto-5g.bas Definitions and 
contractions for 
STO-5G basis set

sto-5gs.bas Definitions and 
contractions for 
STO-5G* basis set

sto-6g.bas Definitions and 
contractions for 
STO-6G basis set

sto-6gs.bas Definitions and 
contractions for 
STO-6G* basis set

d95.bas Definitions and 
contractions for D95 
basis set

T.H. Dunning and P.J. Hay, in Modern Theoretical 
Chemistry, Plenum, New York, 1976.

d95s.bas Definitions and 
contractions for D95* 
basis set

d95ss.bas Definitions and 
contractions for D95** 
basis set

Filename Contents Reference
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Creating a New Basis Set

The procedure for creating a new basis set and adding to the list of 
basis sets in HyperChem is relatively straightforward.

To create a new basis set:

1. Create a file with the extension .BAS (e.g., MY.BAS) in the 
HyperChem Runfiles directory.

2. Edit this file with a text editor such as the Windows Notepad 
or Wordpad, and type in the information about the basis set: 
element symbols, number of shells for each element, shell 
types, number of primitives, scaling factors, and exponents 
and coefficients for each primitive.

For more information about the format for the basis set files, 
see the preceding sections.

3. Add an entry for your file in the section [BasisSet] in the Reg-
istry (for Windows 95 or Windows NT) or CHEM.INI (for Win-
dows 3.1x). In the Registry, this entry will have a name (e.g., 
mybasis) and a value which is the name of your file. In 
CHEM.INI, the entry is a line of the form ‘name=filename’, 
e.g., mybasis=my.bas .

After you restart HyperChem, you can use this new basis set.

To use this new basis set:

1. Create or read in a molecular system.

2. Set up the ab initio calculation as usual.

3. In the Ab Initio Method dialog box, use Assign Other Basis Set 
to select your new basis set for the Other text box.

You can now apply this basis set to the selected atoms, or if no 
atoms are selected, to all atoms in the workspace.
514 Appendix C



Appendix D

HIN Files

HyperChem can store a molecular system from the workspace, 
plus information about this system and display conditions, in a 
HIN file. HyperChem can also store a molecular system in a PDB 
file, but HIN files offer more options and greater convenience. 

HIN files are text files. You can edit these files with any text editor, 
like Windows Notepad or Write. If you use an editor that can 
impose its own format, keep the HIN file in its original text format. 
For example, with Windows Write, choose the No conversion 
option when you open a HIN text file.

Structure of a HIN File

A HIN file contains several records, each on a separate line. Each 
line, except for a comment, begins with a keyword (for example, 
atom). Comment lines begin with a semicolon (;).

This is an example of a minimal HIN file for a methane molecule:

;This sample HIN file contains one methane molecule.
forcefield amber
sys  0
view 40 1.03211 40 4.44992 1 0 0 0 1 0 0 0 1 0.0 848873 –0.669469 –40
mol  1 methane
atom 1 – C CT – 0 –0.341802 0.309469 –6.05498e–007 4 2 s 3 s 4 s 5 s
atom 2 – H HC – 0 –0.341802 1.39947 –6.05498e–00 7 1 1 s
atom 3 – H HC – 0 0.685861 –0.0538608 –6.05498e–007 1 1 s
atom 4 – H HC – 0 –0.855625 –0.0538608 0.889987 1 1 s
atom 5 – H HC – 0 –0.855636 –0.0538687 –0.889978 1 1 s
endmol 1

For a description of the records in this example and other possible 
records, see the following sections.
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File Syntax

This is the complete syntax of a HIN file. o indicates an optional 
record. Each record must begin on a separate line.

; <comment>o

forcefield <force-field-name>

syso <temperature>

seedo <random seed>

viewo <view-distance> <view-scale> <slab-distance> <slab-
thickness> <viewing-transform> . . . <viewing-transform>

boxo <x> <y> <z>

mol <mol#> <mol-name>

reso <res#> <res-name> <PDB#> <previous-res#> <next-res#>

atom <at#> <atom-name> <element> <type> 
<flags> <at-charge> <x> <y> <z> <cn> <nbor# nbor-bond>1

velo <at#> <x> <y> <z>

masso <at#> <mass>

basisseto <at#> <basis set>

atom . . . 

velo . . . 

masso . . .

basisseto . . .

atom . . . 

velo . . . 

masso . . .

basisseto . . .

. . . 

endreso <res#>

endmol <mol#>

selectiono <sel-name> <atoms>

selectrestrainto <flag> <force-constant> <restr-value>

1. This variable can be repeated up to twelve times.
516 Appendix D



File Syntax
selectatomo <at#> <mol#>

selectatomo . . . 

selectatomo . . . 

. . . 

endselectiono <sel-name>

dynamicso <snap-shot-file-name>

; comment

Each line of comments must have a semicolon at the beginning of 
the line. You can add and review comments from HyperChem by 
using the Open File and Save File dialog boxes; you can also add 
and review comments by using any text editor.

Add comment lines anywhere in a HIN file. When you save the file 
in HyperChem, all comments move to the start of the file.

forcefield

Syntax: forcefield <mm+, amber, bio+, or opls>

HyperChem assigns a force field and the corresponding atom types 
to any molecular system in the workspace. You choose the force 
field from the Molecular Mechanics Force Field dialog box (choose 
Molecular Mechanics on the Setup menu). 

HyperChem needs atom types for all molecular mechanics calcu-
lations, but not for semi-empirical quantum mechanics calcula-
tions.

When you draw a new molecule, HyperChem assigns ** as the 
“type” for each atom, indicating no atom type. When you choose 
Model Build or Calculate Types on the Build menu, or when you 
change force fields, HyperChem assigns appropriate atom types for 
the force field you chose. If you open a HIN file, HyperChem uses 
the force field and atom types that were in effect when you saved 
the file.

The variables for the forcefield keyword are mm+, amber, bio+, or 
opls. If you do not assign a force field to a molecular system, Hyper-
Chem uses the last forcefield that you chose. However, atom type 
assignment is not automatic when you open the file.
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sys

Syntax: sys <temperature>

The system record gives the temperature of the molecular system 
in Kelvin. 

temperature The default is 0 Kelvin. If you save the molecular 
system in a HIN file after a molecular dynamics cal-
culation, this record stores the final temperature of 
the system corresponding to the atomic velocities.

seed

Syntax: seed <random seed>

The random seed used for Molecular Dynamics, Langevin Dynam-
ics, and Monte Carlo. After any use of the random seed, a new ran-
dom seed is generated.

random seed An integer in the range -32768 to 32767.

view

Syntax: view <view-distance> <view-scale> <slab-distance>
<slab-thickness> <viewing-transform> . . . <viewing-transform>

A view record gives instructions for transforming a 3D structure 
into 2D space.

view-distance The distance, in Ångstroms, from the viewer to the 
origin of the molecular system.

view-scale The magnification factor.

slab-distance The distance, in Ångstroms, from the viewer to the 
middle of the clipping slab.

slab-thickness The distance between the front and back clipping 
planes, in Ångstroms.

viewing-
transform

These 12 fields describe a 3 by 4 viewing transfor-
mation matrix, with four rows and three columns. 
The fields appear row by row. A fourth column, 
normally describing perspective, is not present.
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box

Syntax: box <x> <y> <z>

A box record reports the presence and x, y, and z dimensions of a 
periodic box, in Ångstroms, in the molecular system. 

mol

Syntax: mol <mol#> <mol-name>

A mol record starts the description of each molecule in the molec-
ular system. An endmol record must end each molecule.

mol# The number of the molecule in the molecular sys-
tem, starting with 1. The number reflects the order 
the molecules were added to the system. Default = 
1.

mol-name Up to 19 characters describing a molecule. This 
name appears on the status line when you select 
the molecule. You can assign this name only by 
adding it directly to the HIN file.

res

Syntax: res <res#> <res-name> <PDB#> <previous-res#> <next-
res#>

A res record starts the description of each residue in a molecule. An 
endres record must end each residue.

res# The number of the residue in the molecule, start-
ing with 1 for the first residue added to a molecule.

res-name The residue name (up to four characters) as it 
appears in the TPL file for residue-name.

PDB# Preserves information found in a PDB file.

previous-res# Preserves information found in a PDB file.

next-res# Preserves information found in a PDB file.
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atom

Syntax: atom <at#> <atom-name> <element> <type> 
<flags> <at-charge> <x> <y> <z> <cn> <nbor# nbor-bond>

An atom record starts the description of each atom in a molecule.

 at# The number of an atom in a molecule, starting 
with 1. Atom numbers are continuous through a 
molecule. A combination of atom number and 
molecule number (see mol, above) uniquely iden-
tifies an atom in a molecular system. 

atom-name This name (up to four characters) usually comes 
from a Brookhaven PDB or HyperChem template 
file. It cannot contain spaces or quotes.

element The chemical symbol (up to three characters) for 
the described atom.

type The atom type (up to four characters) assigned by 
a force field to the described atom.

flags Single letter codes that describe this atom (see the 
next section). “–” indicates no flag. Multiple flags 
appear as one “word,” without spaces. See the 
description of available flags in the next section.

at-charge The formal charge on the atom, from a quantum 
mechanics calculation, from using Set Charge on 
the Build menu or from a TPL file. You can also 
add charges to an atom by editing the HIN file.

x y z The coordinates of the atom in the Molecular 
Coordinate System.

cn The number of atoms covalently bonded to this 
atom, or coordination number. cn is an integer 
from 0 to 12.

nbor#
nbor-bond

This describes the bonded atoms and the type of 
bond for each. nbor# and nbor-bond occur as a pair 
of values. nbor# is the same as at# for bonded 
atoms. nbor-bond is a bond type: s, d, t, or a, for 
single, double, triple, or aromatic (conjugated) 
bonds. This set of values, nbor# nbor-bond, repeats 
to describe all bonded atoms (up to twelve times).
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Atom Flags

HyperChem uses these symbols for the flag variable in the atom 
record.

h A heteroatom as defined in PDB files.

i This atom is part of an improper torsion.

x A united atom.

s A selected atom.

– No flag.

vel

Syntax: vel <at#> <x> <y> <z>

If you save the molecular system with velocities (choose Velocities 
in the Save File dialog box), a vel record appears after each atom 
record, reporting the atomic velocities generated at the end of a 
molecular dynamics calculation. A velocity record applies to the 
preceding atom record and must follow immediately after that 
record.

at# The number of an atom in a molecule, starting 
with 1. Atom numbers are continuous through 
each molecule. This is the same as “at#” that 
appears in the atom record.

x y z The x, y, and z components of the atomic velocity, 
in Ångstroms/picosecond. The default is 0 0 0.

mass

Syntax: mass <at#> <mass>

If you change the mass of an atom, a mass record is added follow-
ing that atom’s record in the HIN file. This mass record applies to 
the preceding atom record.

at# The number of an atom in a molecule, starting 
with 1. Atom numbers are continuous through 
each molecule. This is the same as “at#” that 
appears in the atom record.
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mass The mass of the atom, in atomic mass units. The 
default is the mass of the atom type as defined in 
the type file for the specified force field.

basisset

Syntax: basisset <at#> <basis set>

If you apply a basis set to an atom for ab initio calculations, a basis 
set record is added following that atom’s record in the HIN file. 
This basis set record applies to the preceding atom’s record.

at# The number of an atom in a molecule, starting 
with 1. Atom numbers are continuous through 
each molecule. This is the same as “at#” that 
appears in the atom record.

basis set The basis set applied to the atom, for example 
“STO-3G”. The default is “None”.

endres

Syntax: endres <res#>

An endres record appears after the last atom in a residue. 

res# The number of the residue in the molecule, start-
ing with 1 for the first residue added to a molecule.

endmol

Syntax: endmol <mol#>

An endmol record appears after the last atom in a molecule. 

mol# The number of the molecule in the molecular sys-
tem, starting with 1. The number reflects the order 
of adding molecules to the system. Default = 1.

selection

Syntax: selection <sel-name> <atoms>

A selection record plus the following selectrestraint, selectatom, 
and endselection records appear if you save a molecular system 
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containing a named selection (see “Name Selection . . .” on page 
139).

sel-name The name of a selection, either a predefined name, 
POINT, LINE, PLANE, or a name that you supply 
(Other),  up to 19 characters long.

atoms The number of atoms in a selection.

selectrestraint

Syntax: selectrestraint <flag> <force-constant> <restr-value>

A selectrestraint record contains information needed to use the 
selection (see the previous section) as a restraint in an energy cal-
culation (see “Restraints” on page 224). This record appears for 
every named selection, even though it might contain too many 
atoms for use as a restraint (more than four) and you did not apply 
the selection as a restraint. The flag value determines whether to 
use this named selection as a restraint (see the next section). 

flag This is a numeric field with a value from 0 to 15. A 
four-bit number (see the next section) determines 
the use, if any, of this restraint.

force-constant The force constant for a possible restraint. This can 
be computed or user defined.

restr-value Four numbers. The first is a length, angle, or tor-
sion angle for a 2, 3 or 4-atom restraint. The last 
three define cartesian coordinates of a tether point 
for a 1-atom restraint.

Setting Flag Bits for selectrestraint

The selectrestraint flag is the decimal value of seven bits:
:

bit 0 1 = restraint not chosen in Restraint Forces dialog 
box; 0 = restraint selected.

bit 1 Reserved, always 2.

bit 6 5 4 3

32,064,0 16,0 8,0 2,04,0 1,0

2 1 0
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bit 2 4 = Computed (the default) for non-tether Value;
0 = Other (user defined) for non-tether Value.

bit 3 8 = Default for Force Constant;
0 = Other (user defined) for Force Constant.

bit 4 16 = Restraint is a one-atom tether;
0 = Restraint is not a tether.

bit 5 Reserved, always 0.

bit 6 64 = Computed for tether Value;
0 = Other (user defined) for non-tether Value.

These are typical values for the selectrestraint flag:

26 Tether restraint with Default for Force Constant and 
Other (user-defined) for Value.

18 Tether restraint with Other (user-defined) for Value 
and Force Constant.

14 Non-tether restraint with Computed for Value and 
Default for Force Constant.

10 Non-tether restraint with Computed for Value and 
Other (user defined) for Force Constant.

6 Non-tether restraint with Default for Force Constant 
and Other (user-defined) for Value.

2 Non-tether restraint with Other (user-defined) for 
Value and Force Constant.

Any odd Named selection not used as a restraint.

selectatom

Syntax: selectatom <at#> molecule <mol#>

Selectatom records define the atoms in a named selection. There is 
one record for each atom.

at# The number of an atom in a molecule, starting 
with 1.

mol# The number of the molecule, in creation order, in 
the molecular system, starting with 1. Default = 
molecule 1.
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endselection

syntax: endselection <sel-name>

The endselection record ends the description of each named selec-
tion.

sel-name The name you gave a selection, either POINT, LINE, 
PLANE, or another name (Other).

dynamics 

syntax: dynamics <snap-shot-file-name>

The dynamics record gives the path and name of the SNP file con-
taining snapshot data (see “Snapshot Files” on page 433). If Hyper-
Chem cannot find the SNP file at the indicated path location, it 
searches for the filename in the current directory.

snap-shot-
file-name

The snapshot filename includes the drive and path 
specification. The filename is often the same as the 
HIN filename, but with an .snp extension.
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Residue Template Files

Template (TPL) files describe amino acid and nucleic acid residues 
that you can choose on the Databases menu to construct poly-
meric molecules. HyperChem uses these files when you construct 
a new polymer, when you open a HIN file that contains a polymer 
constructed this way, when you open a PDB file, or when you 
mutate one residue into another. The TPL files interpret standard 
residues by providing atom types, charges, connectivity informa-
tion, and internal coordinates. 

HyperChem supplies three TPL files:

chem.tpl Contains internal (nonterminal) amino acid 
residues, nucleic acid residues, and residues for 
reading PDB files.

chemct.tpl Contains C-terminal forms of all amino acid 
residues. These residues supply anionic carboxyl-
terminal groups if you choose Make Zwitterion on 
the Databases menu.

chemnt.tpl Contains N-terminal forms of all amino acid 
residues. These residues supply cationic amino-ter-
minal groups if you choose Make Zwitterion on the 
Databases menu.

Structure of a TPL File

You can examine the contents of the TPL files by using a word pro-
cessor, like Windows Write. Make sure that your editor does not 
convert the file to its own format nor add formatting such as page 
breaks. Most editors, such as Windows Notepad, allow this option.

TPL files describe a residue atom by atom. They can also provide 
information needed in molecular mechanics calculations.
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This is part of a typical residue entry in a template file (the high-
lighted numbers, for example ³, are not part of the file): 

; ALANINE¬

[ALA]ÁA®

N:¯ N±1² (HN s –3 s CA s)³  \
opls N –0.5700 imp –3 CA N HN \´

amber N –0.4630 imp –3 CA N NH \´

bio+ NH1 –0.3500 imp N –3 CA NH \´

internal –3 1.335 –2 116.60µ

HN¯ H° : H± (N s) \
opls H 0.3700 \
amber H 0.2520 \
bio+ H 0.2500 \
int N 1.010

CA:¯ C± 2 ² (N s HA s C s CB s) \
opls CH 0.29000 imp CB CA N C \
amber CT 0.0350 \
bio+  CH1E 0.1000 imp CA N C CB \
int N 1.449 –3 121.90

. . . .

¬ Comment record with the full name of a residue. Comment 
records must start with a semicolon. Write as many comments as 
you need.
 The residue name. The name should be from one to four char-
acters long, in square brackets. The limit is 256 characters. This 
name appears in the appropriate Databases dialog box (for exam-
ple, the Amino Acids dialog box), unless a * follows the Residue 
type (see ®). Also, within these brackets, you can have one or more 
aliases (alternative names) for the residue, each separated by a 
space. These can be up to four characters long. HyperChem uses 
aliases when it reads PDB files.

® Residue type. This is A for amino acid, N for nucleic acid, or * 
for some other type of residue. An * in addition to A or N prevents 
HyperChem from showing this residue as a choice in the Amino 
Acids or Nucleic Acids dialog box. 

¯ An atom description starts here. This is the name of an atom 
in the residue (see below). These are the atom names used in 
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Brookhaven PDB files (see page 319) and the names HyperChem 
uses for Name labels (choose Labels on the Display menu, then 
Atoms: Name). The atom name or name plus optional alias must 
end with a colon.

° The optional aliases (alternative names) for an atom. There 
must be at least one space between the atom name and each of its 
aliases. The name and alias must end with a colon.

± The chemical symbol for the element.

² An optional atom tag (see below).

³ Bonding information for this atom (see below).

´ Force field information (see below). A back slash (\) at the end 
of a line indicates that this entry continues on the next line.

µ Atomic coordinates (see below).

Template Syntax

This section contains a formal syntax for describing a residue in a 
template file. The text in angle brackets and italics represents vari-
ables that you provide. o means optional.

This describes the overall structure of a residue:

; <comment>o

[<–>o<residue-name> <alias>o <alias>o . . .] <A|N|*><*>o

<atom-description>

<atom-description>

<atom-description>

<atom-description>

. . . 

;<comment>

Each line of comment must begin with a semicolon. These lines 
can occur anywhere in the file, but cannot interrupt another line.
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[<residue-name>]

[<–>o<residue-
name>

A string containing no spaces or quotes. Use one to 
four characters. Enclose residue-name plus optional 
aliases in square brackets. The optional – indicates 
a complementary nucleic acid residue used to 
build in reverse order or double-stranded struc-
tures.

<alias>o

<alias>o . . .] 
Any number of alternative names for a residue, up 
to four characters long. Each alias is separated from 
the others and from residue-name by a space. 
HyperChem uses aliases to recognize residues in 
PDB files, for example ASX for ASN, and DOD for 
HOH.

<A|N|*> A for amino acid, N for nucleic acid, or an asterisk 
(*) for unknown. This assigns the residue to the 
correct dialog box. * after A or N (see the next item) 
overrides the assignment to a dialog box.

<*>o If it appears after A or N, it turns off this residue as 
a choice in the Amino Acids or Nucleic Acids dia-
log box. 

<atom-description>

Each atom in a residue should have an atom-description in a single 
record. The record can occupy more than one line if each line ends 
with a \.

<atom-description> =

<atom-name> <aliases>o : <element> <tag>o (bonding-info) \

<force-field>o <atom-type>o <charge>o <imp-torsion>o \

<force-field>o <atom-type>o <charge>o <imp-torsion>o \

. . . 

internalo <at1> <distance> <at2>o <angle>o <at3>o <torsion>o
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<atom-name> <aliases>

Atom names follow standards defined by the Brookhaven Protein 
Data Bank for atoms in amino acid and nucleic acid residues. In an 
atom name, for example C3*, an * replaces the usual prime symbol 
(C3′). It cannot contain spaces or quotes.

Note: Do not use numbers for atom names to avoid confusion 
with atom tags (see next section).

For a complete list of atom names in amino acid side chains, nucle-
otide bases, and other molecules, see the Protein Data Bank docu-
ment, Atomic Coordinates and Bibliographic Entry Format Description, 
July, 1989 (see page 319 for the source of this document).

<aliases>

An atom-name can have one or more optional names (aliases). 
Separate each with at least one space.

<element>

The chemical symbol for the described atom.

<tag>

An optional number describing the atom to neighboring residues.

Atom tags (numbers 1 to 9) describe connections to atoms in other 
residues. HyperChem assigns tags to specific terminal atoms in 
amino acid and nucleic acid residues. A minus sign preceding a tag 
number indicates the previous residue (lower sequence number).

Atom Name Tag Number Residue Typea

N 1 A

CA 2 A

C 3 A

O 4 A

P 4 N
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(bonding-info)

Bonding information indicates the presence and describes the type 
of covalent bonds between atoms. The bonding information con-
sists of an atom name or tag, followed by the type of bond:

(Atom-name/tag bond-type Atom-name/tag bond-type . . . )

This sequence repeats until it describes each bond to an atom.

Atom-name/
tag

The name of a bonded atom in the same residue, 
or the tag of an atom if it is in an adjacent residue.

bond-type s, d, t, or a, for single, double, triple, or aromatic 
(conjugated) bonds.

Caution: Parentheses must enclose bonding information. Separate 
each entry within parentheses with white space. Make sure the 
entries occur in pairs: atom-name, then bond-type.

Example: (HN s –3 s CA s)

HN s: A single bond to hydrogen HN.

–3 s: A single bond to the atom with tag 3 in the previous 
residue.

CA s: A single bond to atom CA.

<force-field>

Force field information describes the properties of an atom in 
terms of a molecular mechanics force field (see “Molecular 
Mechanics” on page 185). HyperChem can use these properties 

a. A = amino acid, N = nucleic acid.

O5* 5 N

C5* 6 N

C4* 7 N

C3* 8 N

O3* 9 N

Atom Name Tag Number Residue Typea
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during a molecular mechanics calculation. An atom description 
can contain from zero to four force field entries, or none. A force 
field description of “none” indicates a hydrogen that is part of a 
united atom representation.

Force field information includes this data, separated by spaces:

Force-field Atom-type Charge [imp At#1 At#2 At#3 At#4]1

Force-fieldo mm+, opls, amber, or bio+.

Atom-typeo Type of atom used during a molecular mechanics 
calculation. Atom types are specific to a force field.

Chargeo Charge on the atom.

impo An improper torsion involving the atom being 
described and three other atoms bonded to it. The 
order of the At#n (atom name or tag number) 
determines the improper torsion angle. This infor-
mation is optional.

Example: bio+  HN1 -0.3500 imp N –3 CA NH

bio+: This information applies to the BIO+ force field.

HN1: The atom type for the described hydrogen.

–0.3500: The negative charge on this atom.

imp N –3 CA NH: An improper torsion involving this atom 
(N) and its three bonded neighbors: atom tagged –3 in the 
previous residue, atom CA, and atom NH. 

internal

HyperChem describes the position of an atom in terms of internal 
coordinates, or the relationship to its bonded neighbors. The 
description of atomic coordinates begins with the keyword inter-
nal, for internal coordinates. Atomic coordinates consist of names 
or tags for the neighboring atoms, each followed by a value for the 
relationship:

internal Atom-name/tag distance Atom-name/tag angle Atom-
name/tag torsion-angle

1. Brackets indicate optional information.
Residue Template Files 533



Amino Acid Residues
into The keyword introducing the atomic coordinates. 
Only the first two letters of this keyword are neces-
sary.

Atom-name/
tago

The name of a bonded atom in the same residue, 
or the tag of an atom if it is in an adjacent residue.

distanceo The length of the bond, in Ångstroms, to the 
neighbor.

angleo The bond angle formed by the described atom, 
Atom1, and Atom 2. Atom 2 and angle are optional 
in this record.

torsion-angleo The torsion angle formed by the described atom, 
Atom 1, Atom 2, and Atom 3. Atom 3 and torsion-
angle are optional in this record.

The minimum internal coordinate record must contain Atom1 
(atom-name/tag) and distance. If it does not contain Atom 3 and 
torsion-angle, the record must be last in an atom description.

Example: int CA 1.525 N 111.10 –3

Remember, atom tag “–3” represents an atom in the previous resi-
due.

Amino Acid Residues

Each amino acid residue requires an entry in each of the TPL files:

• Chem.tpl for internal amino acids.

• Chemct.tpl for the residue in the C-terminal position. 
HyperChem uses this residue for the C-terminal residue when 
you request a zwitterion. The terminal carbon in this residue 
has two bonded oxygens instead of one. The charge on the res-
idue is –1.0.

• Chemnt.tpl for the residue in the N-terminal position. 
HyperChem uses this residue for the N-terminal residue when 
you request a zwitterion. The terminal nitrogen in this residue 
has three hydrogens instead of one. The charge on the residue 
is +1.0.
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For this release of HyperChem, the template files contain tem-
plates for these residues:

Residue Name/Alias Residue Name/Alias

Alanine ALA Phenylalanine PHE

Glycine GLY Tyrosine TYR

Serine SER Glutamic acid GLU

Threonine THR Aspartic acid ASP

Leucine LEU Lysine LYS

Isoleucine ILE Proline PRO

Valine VAL Cysteine CYS,CYH, CSH

Asparagine ASN, ASX Cystine (S–S bridge) CYX, CSS

Glutamine GLN, GLX Methionine MET

Arginine ARG Acetyl beginning 
group

ACE

Histidine, delta H HID N-methylamine end-
ing group

NME

Histidine, epsilon H HIE Amine ending groupa NH2

Histidine plus 
(protonated)

HIP Oxygen ending groupa OME

Histidine generic (same 
as histidine protonated)

HIS Dummy for building 
the first residuea

DUM

Tryptophan TRP Heme-histidinea HEM, HEME

Methotrexatea MTX 4-Hydroxyprolinea HYP

Gamma-amino butyric 
acida

ABU Ornithinea ORN
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Nucleic Acid Residues

Each nucleic acid residue has a primary entry in the chem.tpl file 
and might have a secondary entry used to construct a complemen-
tary nucleotide residue during double-stranded synthesis or for 
backwards synthesis. 

Secondary entries have residue names starting with a minus sign. 
For example, the residue dA pairs with –dT, and dT pairs with –dA. 
An * immediately after the residue name suppresses display of the 
residue in dialog boxes.

For this release of HyperChem, the templates files contain tem-
plates for these residues:

a. This residue does not appear in the Amino Acids dialog box; HyperChem uses the residue tem-
plate to read residues from a PDB file.

Beta-alaninea ALB Pyrrolidone carboxylic 
acid (pyroglutamate)a

PCA

Betainea BET Sarcosinea SAR

Homoserinea HSE Taurinea TAU

5-Hydroxylysinea HYL Thyroxinea THY

Formyl beginning 
groupa

FOR

Residue Name/Alias Residue Name/Alias

Dummy for building the 
first residuea

DUP Phosphate ending 
group, 3´ 

3CAP

Dummy for building the 
first residue, backward 
stranda

DUX D-adenosinea, b –DA

D-adenosine DA D-cytosinea, b –DC

Residue Name/Alias Residue Name/Alias
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a. This residue does not appear in the Nucleic Acids dialog box. HyperChem uses the residue for con-
structing the complementary strand of a polynucleotide or for reading these residues from a PDB file.
b. For the negative strand or backwards synthesis.
c. This residue supplies atom bonding information only [<atom-name> <aliases> : <element> <tag>
(bonding-info)], without force field, charge, or internal coordinate information.
d. For reading water molecules in a PDB file.

Thymidine DT, T d-guanosinea, b –DG

D-cytosine DC Thymidinea, b –DT

D-guanosine DG R-adenosinea, b –RA

R-adenosine RA, A, +A Uracila, b –RU

Uracil RU, U R-guanosinea, b –RG

R-guanosine RG, G R-cytosinea, b –RC

R-cytosine RC, C, +C H beginning, 5´ a, b HB

Beginning group, 5´ 5CAP H end, 3´ a HE

Coenzyme Aa, c CoA 7-methylguanosinea, c 7MG

Flavin mononucleotide a, c FMN 2´-O-methylgua-
nosinea, c

OMG

Adenosine triphosphatea, c (ATP) Inosinea, c I

1-methyladenosinea, c 1MA Dihydrouridinea, c H2U

5-methylcytosinea, c 5MC 5-methyluridinea, c

(ribosylthymidine)
5MU

2´-O-methylcytidinea, c OMC Pseudouridinea, c PSU

1-methylguanosinea, c 1MG Base Ya, c (Wybutosine) YG, Y

N(2)-methylguanosinea, c 2MG Nicotinamide adenine 
dinucleotidea, c

NAD

N(2)-dimethylguanosinea, c M2G TIP3P waterd HOH, DOD, WAT

Residue Name/Alias Residue Name/Alias
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Adding New Residues
In this version of HyperChem, you cannot add TPL files; you can 
only add entries to the existing files.

Adding New Residues

You can add new residues to the Amino Acids and Nucleic Acids 
dialog boxes, up to a total of 36 amino acids and 24 nucleic acids 
for each dialog box. HyperChem uses this information to interpret 
data files (HIN or PDB) and to construct the molecular system in 
the workspace.

All residues must be in the file chem.tpl, chemct.tpl, and 
chemnt.tpl (see the introduction to this chapter). Before you add 
residues to these files, make backup copies of the original files.

New residues must supply this minimal information:

[<residue-name>]<N|A|*> 

<atom-name> : <element> (bonding-info)

<atom-name> : <element> (bonding-info)

. . . 

To add a residue to a TPL file but suppress its appearance in the 
Amino Acids or Nucleic Acids dialog box, add an * to the end of 
the residue-name record. HyperChem can still use this information 
to read files containing these residues.

New residues are available in the dialog boxes the next time you 
run HyperChem. 

General Requirements

To build a new residue, you must have its chemical structure (ele-
ments and bonding). It is also useful, but not necessary, to have 
bond lengths, bond angles, and torsion angles. You can get this 
information from published reports, by building a residue from 
atom and optimizing it with HyperChem, and by using parts of 
residues already in the TPL file.

To perform molecular mechanics calculations on molecules con-
taining these residues, it is useful, but not necessary, to have atom 
types and charges for each atom. You can find this information in 
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published reports of a force field. You can also calculate charges by 
using a semi-empirical quantum mechanics calculations.

Example:

This example adds the ribonucleotide residue 5-methylcytidine 
(5MC) to the Nucleic Acids dialog box. This residue has a methyl 
group, not hydrogen, on the 5′ carbon of the pyrimidine ring. 

This residue is simple to construct, because the pyrimidine ring is 
the same as in deoxythymidine (dT).

Follow these steps:

1. Using a text editor, like Windows Notepad, or a word proces-
sor, like Windows Write, open the file chem.tpl. Be sure to 
choose the No conversion option in Windows Write to main-
tain the file in its original format.

2. Use the Find command to locate R-CYTOSINE.

Note: If you are using Windows Write, you can choose Repag-
inate on the File menu. This divides the file into pages so that 
you can move easily through it; the pagination does not inter-
fere with HyperChem.

3. Copy the entire entry for R-CYTOSINE to another location. If 
you put the copy immediately after R-CYTOSINE, 5MC appears 
below rC in the dialog box.

4. Scroll up to the beginning of the pasted text. Then change the 
first three lines to this text:

; R-5-METHYL CYTIDINE

;

[5MC]N

5. Use the Find command to locate [DT T]N.

6. Copy the four entries for the methyl group atoms. They start 
with these atom names:

C5M C7: 

1H5M 1D5M H71 1H19:

2H5M 2D5M H72 2H19:

3H5M 3D5M H73 3H19:
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7. Return to the entry for 5MC and paste these four atoms after 
atom H5 D5 H19.

8. Delete the entire entry for atom H5 D5 H19

9. Edit the first line for atom C5 to show the bond to atom C7 
instead of H5:

C5: C (C6 d C7 s C4 s) \

10. Save the file and leave the text editor.

11. Start HyperChem. If HyperChem is already open, choose Exit 
on the File menu and start it again.

12. Choose Nucleic Acids on the Databases menu. The dialog box 
now contains the residue 5MC.

Note: An alternative way to construct this residue is to change the 
deoxyribose sugar in dT to a ribose.
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Appendix F

Default Settings in
Registry or Chem.ini

The file chem.ini contains all default settings for HyperChem for 
Windows; the settings are stored in the Registry in Windows 95 or 
Windows NT. HyperChem uses this information to remember 
your settings from the previous session. HyperChem reads the set-
tings when you start a session.

During a HyperChem session you can change some of these set-
tings from dialog boxes (for example, see “Preferences” on page 
65). When you leave HyperChem, the file is updated to the recent 
settings. The Registry, or Chem.ini, stores and then supplies the 
last choices you made in a HyperChem menu or the last values you 
entered in a dialog box. HyperChem uses these setting for each ses-
sion until you change them.

Some settings are available only in the Registry or chem.ini. You 
can change these settings, or any other settings in this file, by 
using Start/Run/regedit from the Windows 95/Window NT taskbar 
to edit the Registry, or a text editor like Windows Notepad to edit 
chem.ini. 

Note: HyperChem converts the text file chem.ini to a binary file 
chembin.ini. Reading the binary file instead of the text file saves 
time on starting up HyperChem.

File Structure

You can see and edit the contents of the Windows 95 and Win-
dows NT Registry by running the regedit Registry Editor. The 
HyperChem settings are in the section under 
HKEY_CURRENT_USER / Software / Hypercube. The settings are as 
described below.
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In Windows, you can find chem.ini and chembin.ini in the direc-
tory defined in the DOS environment variable or in the directory 
that contains HyperChem (normally the hyper directory). 

Default settings are in text records, one on each line. This example 
includes the first six text lines in the AbInitio section:

[AbInitio]

“CalculateGradient”=”No”

“DirectSCF”=”No”

“2ElectronCutoff”=”1e-010”

“GaussSCFConvergence”=”1e-005”

“2ElectronBufferSize”=”3200”

. . . .

In CHEM.INI, each record contains a keyword, an equals sign, and 
a value that can be Yes or No (Boolean), an integer (Int), a floating 
point number (Real), or one of a limited set of possibilities (Enum). 
In the Registry, each record has a keyword and a value (as above) 
stored as a text string, enclosed in quotation marks.

Note: Keywords and values in chem.ini are not case-sensitive.

The CHEM.INI file supplied with HyperChem contains 19 sec-
tions, each with a section title in brackets. In the Registry, the set-
tings for the different versions of the force fields are saved as sub-
sections under the main force field sections, and there are 13 main 
sections in all.

AbInitio Settings for ab initio calculations

amber Settings for the AMBER force field

amber, 
amber2

Settings for the amber2 parameter set
(subsection in the Registry)

amber, 
amber3

Settings for the amber3 parameter set
(subsection in the Registry)

amber, 
ambers

Settings for the ambers parameter set
(subsection in the Registry)

Basisset List of the basis set files (*.BAS) in the Hyper-
Chem/Lite directory

bio+ Settings for the BIO+ force field
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bio+,
bio85

Settings for the bio85 parameter set
(subsection in the Registry)

bio+,
bio83

Settings for the bio83 parameter set
(subsection in the Registry)

colors Colors assigned to elements (optional)

Compute Settings for computational options

Filter Information about input/output file filters

mm+ General settings for the MM+ force field

mm+,mmplus Additional settings for the MM+ parameter set
(subsection in the Registry)

Network Settings for network licensing

opls Settings for the OPLS force field

opls, opls Settings for OPLS parameter set

Path Information about paths for parameter files, data 
storage, etc.

Preferences Settings for key operations, display options, etc.

Registration Registration data for the software
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Ab Initio Settings

[AbInitio]

Keyword Value 
Type

Value How to Set Use

CalculateGradient Boolean Yes, No Ab initio 
Advanced 
Options 
dialog box

Specify whether or not the gradi-
ent calculation is needed. This 
option applies only to single-
point calculations.

DirectSCF Boolean Yes, No Ab initio 
Advanced 
Options 
dialog box

Specify whether or not to use 
direct SCF calculation.

2ElectronCutoff Real > 0 Ab initio 
Advanced 
Options 
dialog box

Eliminate the two-electron 
integrals with values less than this 
cutoff.

GaussSCFConver-
gence

Real 0.0-100 Ab initio 
Options 
dialog box

This is the limit which the energy 
difference between two 
consecutive iterations in an SCF 
calculations should reach.

2ElectronBuffer-
Size

Int > 50, < 32000 Ab initio 
Advanced 
Options 
dialog box

Specify the buffer size to store the 
two-electron integrals before 
sending them to a hard disk.

FiveDOrbitals Boolean Yes, No Ab initio 
Advanced 
Options 
dialog box

Specify the type of d orbitals. Yes 
uses 6 d orbitals (i.e., dxx, dyy, 
dzz, dxy, dxz, dyz). No uses 5 d 
orbitals (i.e., d0, d+1, d-1, d+2, 
d-2).
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MOInitialGuess enum Core-
Hamiltonian, 
Projected-
Huckel, 
Projected-
CNDO, 
Projected-
INDO

Ab initio 
Advanced 
Options 
dialog box

Specify a method to produce an 
initial guess of MO coefficients.

IntegralFormat enum Regular or 
Raffenetti

Ab initio 
Advanced 
Options 
dialog box

Specify the format to save the 
two-electron integrals

MP2Correlation-
Energy

Boolean Yes, No Ab initio 
Advanced 
Options 
dialog box

Specify whether MP2 correlation 
energy should be calculated with 
an ab initio single-point 
calculation

MP2FrozenCore Boolean Yes, No This file Specify whether MP2 correlation 
calculation should use a frozen 
core

IntegralPath string File/Prefer-
ences/Paths 
property 
sheet

Specify the hard disk (drive) and 
the path to save the two-electron 
integrals

UseGhostAtom-
Selection

Boolean Yes, No Ab initio 
Advanced 
Options 
dialog box

Specify whether or not to use a 
ghost-atom selection.

Keyword Value 
Type

Value How to Set Use
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AMBER Settings

[amber]

[amber,CustomName]

These are the settings supplied for the parameter sets with the Cus-
tom Names amber2, amber3, and ambers:

a. Use a text editor, like Wordpad, to change this record in chem.ini.

Keyword Value 
Type

Value How to Set Use

CurrentFiles Int 0 to (number 
of Custom-
Names–1)

Force field 
Parameters 
dialog box

The index of the AMBER parame-
ter set to use. Default = 0 for first 
CustomName; 1 = second, and 
so on. Default = 1

AtomTypeMass Enum Filename: 
*typ.txt
*typ.dbf
or any other

This filea Directs HyperChem to the file 
containing the atom types for 
this force field.
Default = ambertyp.txt

FileFormat Enum Text
Dbf 

This filea Sets the type of file containing 
AtomTypeMass parameters. 
Default = Text

CustomNames Enum Names 
separated by 
commas

This filea The names of parameter sets 
associated with the AMBER force 
field. Default = amber2, 
amber3, ambers

Keyword Value 
Type

Value How to Set Use

FileFormat Enum Text
Dbf 

This filea Sets the type for the following 
files. Default = Text
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Dielectric Enum Constant or
DistanceDepend

Force Field 
Options 
dialog box

Sets the dielectric permittivity for 
calculating electrostatic interac-
tions as either constant or dis-
tance dependent (see 
DielectricScale, below).
Default = DistanceDepend

DielectricScale Real 1–1000 Force Field 
Options 
dialog box

Sets the scale factor for dielectric 
permittivity (see previous entry).
Default = 1

1–4Electrostatic- 
Scale

Real 0–1 Force Field 
Options 
dialog box

Sets the scale factor for calculat-
ing charge interactions between 
atoms separated by three bonds.
Default = 0.5

1–4vanderWaals-
Scale

Real 0–1 Force Field 
Options 
dialog box

Sets the scale factor for calculat-
ing van der Waals interactions 
between atoms separated by 
three bonds.
Default = 0.5

6–12AtomVDW-
Format

Enum RStarEpsilon
SigmaEpsilon
SlaterKirkwood

This filea Sets the method for calculating 
atom-based van der Waals inter-
actions from data in the file spec-
ified in 6–12AtomVDW (see 
below).b

Default = RStarEpsilon

6–12PairVDW-
Format

Enum RStarEpsilon
SigmaEpsilon
AijBij

This filea Sets the method for calculating 
pair-based van der Waals interac-
tions from data in the file speci-
fied in 6–12PairVDW (see 
below).b

Default = RStarEpsilon

QuadraticStretch Enum Filename This filea Directs HyperChem to the file 
containing bond stretch parame-
ters for this parameter set. 
Default = am89astr.txt

Keyword Value 
Type

Value How to Set Use
Default Settings in Registry or Chem.ini 547



AMBER Settings
a. Use a text editor, like , to change this record in chem.ini.
b. See HyperChem Computational Chemistry, Theory and Methods.

QuadraticBend Enum Filename This filea Directs HyperChem to the file 
containing bond angle parame-
ters for this parameter set. 
Default = am89aben.txt

FourierTorsion Enum Filename This filea Directs HyperChem to the file 
containing torsion parameters 
for this parameter set.
Default = am89ator.txt

FourierImpTorsion Enum Filename This filea Directs HyperChem to the file 
containing improper torsion 
parameters for this parameter 
set. Default =am89aimp.txt

6–12AtomVDW Enum Filename This filea Directs HyperChem to the file 
containing van der Waals param-
eters for individual atom types. 
Default = am89anbd.txt

6–12PairVDW
(optional)

Enum Filename This filea Directs HyperChem to the file 
containing van der Waals param-
eters for specific pairs of atom 
types.b Default = none

10–12PairHBond
(optional)

Enum Filename This filea Directs HyperChem to the file 
containing the hydrogen bond-
ing parameters.b

Default = am89ahbd.txt

Keyword Value 
Type

Value How to Set Use
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Basis Set Settings

[BasisSet]

This section differs from all other sections in CHEM.INI and the 
Registry.  All the entries in other sections are fixed.  However, the 
entries (keywords) in this section depend on the files ending with 
.BAS in the HyperChem directory. Thus, you can modify the basis 
set files and create your own basis set files.  To use a new basis set 
you will need to include it in this section of the CHEM.INI file or 
Registry.

The following contains all the standard and commonly used basis 
sets.  All these basis sets are included in HyperChem distribution 
disks.  This section may look different if you deleted some .BAS 
files or added some other .BAS files to the HyperChem directory.

Keyword Value 
Type

Value How to Set Use

3-21G enum 3-21g.bas This file Define 3-21G basis set.

3-21G* enum 3-21gs.bas This file Define 3-21G* basis set.

3-21G** enum 3-21gss.bas This file Define 3-21G** basis set.

4-21G enum 4-21g.bas This file Define 4-21G basis set.

4-21G* enum 4-21gs.bas This file Define 4-21G* basis set.

4-21G** enum 4-21gss.bas This file Define 4-21G** basis set.

4-31G enum 4-31g.bas This file Define 4-31G basis set.

4-31G* enum 4-31gs.bas This file Define 4-31G* basis set.

4-31G** enum 4-31gss.bas This file Define 4-31G** basis set.

5-31G enum 5-31g.bas This file Define 5-31G basis set.

5-31G* enum 5-31gs.bas This file Define 5-31G* basis set.

5-31G** enum 5-31gss.bas This file Define 5-31G** basis set.
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6-21G enum 6-21g.bas This file Define 6-21G basis set.

6-21G* enum 6-21gs.bas This file Define 6-21G* basis set.

6-21G** enum 6-21gss.bas This file Define 6-21G** basis set.

6-31G enum 6-31g.bas This file Define 6-31G basis set.

6-31G* enum 6-31gs.bas This file Define 6-31G* basis set.

6-31G** enum 6-31gss.bas This file Define 6-31G** basis set.

6-311G enum 6-311g.bas This file Define 6-311G basis set.

6-311G* enum 6-311gs.bas This file Define 6-311G* basis set.

6-311G** enum 6-311gss.bas This file Define 6-311G** basis set.

STO-1G enum sto-1g.bas This file Define STO-1G basis set.

STO-1G* enum sto-1gs.bas This file Define STO-1G* basis set.

STO-2G enum sto-2g.bas This file Define STO-2G basis set.

STO-2G* enum sto-2gs.bas This file Define STO-2G* basis set.

STO-3G enum sto-3g.bas This file Define STO-3G basis set.

STO-3G* enum sto-3gs.bas This file Define STO-3G* basis set.

STO-4G enum sto-4g.bas This file Define STO-4G basis set.

STO-4G* enum sto-4gs.bas This file Define STO-4G* basis set.

STO-5G enum sto-5g.bas This file Define STO-5G basis set.

STO-5G* enum sto-5gs.bas This file Define STO-5G* basis set.

STO-6G enum sto-6g.bas This file Define STO-6G basis set.

STO-6G* enum sto-6gs.bas This file Define STO-6G* basis set.

Keyword Value 
Type

Value How to Set Use
550 Appendix F



BIO+ Settings
BIO+ Settings

[bio+]

[bio+,CustomName]

These are the settings supplied for the parameter sets with the Cus-
tom Names bio85 and bio83:

a. Use a text editor, like Wordpad, to change this record in chem.ini.

D95 enum d95.bas This file Define D95 basis set.

D95* enum d95s.bas This file Define D95* basis set.

D95** enum g95ss.bas This file Define D95** basis set.

Keyword Value 
Type

Value How to Set Use

CurrentFiles Int 0 to (number 
of Custom-
Names–1)

Force field 
Parameters 
dialog box

The index of the BIO+ 
parameter set to use. 
0 = first CustomName; 
1 = second, and so on. 
Default = 0

AtomTypeMass Enum Filename: 
*typ.txt
*typ.dbf
or any other

This filea Directs HyperChem to the file 
containing the atom types for 
this force field.
Default = biotyp.txt

FileFormat Enum Text
Dbf 

This filea Sets the type of file containing 
AtomTypeMass parameters. 
Default = Text

CustomNames Enum Names 
separated by 
commas

This filea The names of parameter sets 
associated with the CHARMM 
force field. Default = bio85,bio83

Keyword Value 
Type

Value How to Set Use
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Keyword Value 
Type

Value How to Set Use

FileFormat Enum Text
Dbf 

This filea Sets the type for the following 
files. Default = Text

Dielectric Enum Constant or
DistanceDepend

Force Field 
Options 
dialog box

Sets the dielectric permittivity for 
calculating electrostatic interac-
tions as either constant or dis-
tance dependent (see 
DielectricScale, below).
Default = DistanceDepend for 
85, Constant for 83

DielectricScale Real 1–1000 Force Field 
Options 
dialog box

Sets the scale factor for dielectric 
permittivity (see previous entry).
Default = 1 for 85, 2.5 for 83

1–4Electrostatic- 
Scale

Real 0–1 Force Field 
Options 
dialog box

Sets the scale factor for calculat-
ing charge interactions between 
atoms separated by three bonds.
Default = 1

6–12AtomVDW-
Format

Enum RStarEpsilon
SigmaEpsilon
SlaterKirkwood

This filea Sets the method for calculating 
atom-based van der Waals inter-
actions from data in the file spec-
ified in 6–12AtomVDW (see 
below).b Default = RStarEpsilon 
for 85, SlaterKirkwood for 83

6–12PairVDF-
Format

Enum RStarEpsilon
SigmaEpsilon
AijBij

This filea Sets the method for calculating 
pair-based van der Waals interac-
tions from data in the file speci-
fied in 6–12PairVDW (see 
below).b Default = RStarEpsilon

QuadraticStretch Enum Filename This filea Directs HyperChem to the file 
containing bond stretch parame-
ters for this parameter set. 
Default = biostr.txt for 85, 
bio83str.txt for 83
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a. Use a text editor, like Wordpad, to change this record in chem.ini.
b. See HyperChem Computational Chemistry, Theory and Methods.

QuadraticBend Enum Filename This filea Directs HyperChem to the file 
containing bond angle parame-
ters for this parameter set. 
Default = bio85ben.txt for 85, 
bio83ben.txt for 83

FourierTorsion Enum Filename This filea Directs HyperChem to the file 
containing torsion parameters 
for this parameter set.
Default = bio85tor.txt for 85, 
bio83tor.txt for 83

QuadraticImp-
Torsion

Enum Filename This filea Directs HyperChem to the file 
containing improper torsion 
parameters for this parameter 
set. Default = bio85imp.txt for 
85, bio83imp.txt for 83

6–12AtomVDW Enum Filename This filea Directs HyperChem to the file 
containing van der Waals param-
eters for individual atom types. 
Default = bio85nbd.txt for 85, 
bio83nbd.txt for 83

6–12PairVDW
(optional)

Enum Filename This filea Directs HyperChem to the file 
containing van der Waals param-
eters for specific pairs of atom 
types.b Default = bio85npr.txt 
for 85, none for 83

6–12Atom14VDW
(optional)

Enum Filename This filea Directs HyperChem to the file 
containing atom-based van der 
Waals parameters for atoms sep-
arated by three bonds.b 
Default = none

Keyword Value 
Type

Value How to Set Use
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Colors

[colors]

These records contain color assignments for each element if they 
are different than the default colors in the Element Color dialog 
box. Each element uses a separate record.

a. Any element in the Default Element or Element Color dialog box.
b. Color: one of black, blue, cyan, green, red, violet, white, yellow.

Keyword Value 
Type

Value How to Set Use

Elementa Enum Colorb Element 
Color 
dialog box

Sets alternative colors for 
individual elements.
Default = none
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Computational Settings

[Compute]

Keyword Value 
Type

Value How to Set Use

Optimizer Enum SteepestDescent 
FletcherReeves 
PolakRibiere 
NewtonRaph-
son

Molecular 
Mechanics, 
Ab Initio, or 
Semi-empiri-
cal Optimiza-
tion dialog 
box

Sets the algorithm for geometry 
optimization.
Default = PolakRibiere

RMSGradient-
Criterion

Real 0–1e+10 Molecular 
Mechanics, 
Ab Initio, or 
Semi-empiri-
cal Optimiza-
tion dialog 
box

Sets the RMS gradient termina-
tion condition for a geometry 
optimization calculation.
Default = 0.1

HeatTime Real 0–1e+10 Molecular 
Dynamics 
Options 
dialog box

Sets the time, in picoseconds, 
to change the temperature 
from Starting to Simulation. 
Default = 0

RunTime Real 0–1e+10 Molecular 
Dynamics 
Options 
dialog box

Sets the length of the period, in 
picoseconds, when the temper-
ature is not changed.
Default = 1

CoolTime Real 0–1e+10 Molecular 
Dynamics 
Options 
dialog box

Sets the time, in picoseconds, 
to change the temperature 
from Simulation to Final.
Default = 0

TimeStep Real 0–1e+10 Molecular 
Dynamics 
Options 
dialog box

Sets the Step size, in picosec-
onds, between evaluations of 
the total energy and forces for a 
molecular system.
Default = 0.001
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Starting-
Temperature

Real 0–1e+10 Molecular 
Dynamics 
Options 
dialog box

Sets the temperature of the sys-
tem at the beginning of Heat 
Time.
Default = 0 Kelvin

Simulation-
Temperature

Real 0–1e+10 Molecular 
Dynamics 
Options 
dialog box

Sets the temperature of the sys-
tem at the beginning of Run 
Time.
Default = 300 Kelvin

FinalTemperature Real 0–1e+10 Molecular 
Dynamics 
Options 
dialog box

Sets the temperature of the sys-
tem at the end of Cool Time.
Default = 0 Kelvin

TemperatureStep Real 0–1e+10 Molecular 
Dynamics 
Options 
dialog box

Sets the increments of tempera-
ture change, if any, during the 
calculation.
Default = 0 Kelvin

Constant-
Temperature

Bool. Yes, No Molecular 
Dynamics 
Options 
dialog box

Turns on or off Constant tem-
perature during a molecular 
dynamics simulation. 
Default = Yes

Temperature-
RelaxationTime

Real 0–1e+10
(> TimeStep)

Molecular 
Dynamics 
Options 
dialog box

Sets the Bath relaxation time 
constant, in picoseconds, for 
constant temperature regula-
tion. Default = 0.1

Restart Bool. Yes or No Molecular 
Dynamics 
Options 
dialog box

Sets the initial velocities of 
atoms to previously determined 
values. Default = No

DataFrequency Int 1–max. 
number of time 
steps or 32767

Molecular 
Dynamics 
Options 
dialog box

Sets the interval, in time steps, 
for the molecular dynamics cal-
culation to send new values to 
HyperChem. Same as Data col-
lection period. 
Default = 1

Keyword Value 
Type

Value How to Set Use
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RefreshFrequency Int 1–max. 
number of data 
steps or 32767

Molecular 
Dynamics 
Options 
dialog box

This sets the interval, in data 
steps (see DataFrequency) for 
updating the display (same as 
Screen refresh period). 
Default = 1

SnapShot-
Frequency

Int 1–max. 
number of data 
steps or 32767

Molecular 
Dynamics 
Snapshots 
dialog box

Sets the interval, in data steps, 
between snapshots of a molec-
ular dynamics simulation. 
Same as Snapshot period. 
Default = 1

AveragesFrequency Int 1–max. 
number of data 
steps or 32767

Molecular 
Dynamics 
Averages 
dialog box

Sets the interval, in data steps, 
between averaging values in a 
molecular dynamics simula-
tion. Same as Average/graph 
period. Default = 1

SCFConvergence Real 0.0–100.0 Semi-
empirical 
Options
dialog box

This is the limit to which the 
difference of SCF calculations 
should be calculated.

SCFIteration int 1–32767 Semi-
empirical 
Options
dialog box

The maximum number of 
iterations to extend an SCF 
calculation.

Qpt Enum Orbital, 
OrbitalSquared

Orbitals 
dialog box 
(orbital 
squared 
checkbox)

This controls the appearance of 
the orbital plots.

Orbital Enum Homo, Lumo, 
Number

Orbitals 
dialog box

This controls the type of 
information displayed in the 
orbital number field when an 
orbital is selected.

HorizontalGrid int 2–32767 Grid dialog 
box

Number of grid points in the x 
dimension.

Keyword Value 
Type

Value How to Set Use
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VerticalGrid Int 2–32767 Grid dialog 
box

Number of grid points in the y 
dimension

GraphContours Int 1–32767 Grid Dialog 
Box

Determines the number of con-
tour level in a contour plot.

UHF Bool-
ean

Yes, No Semi-
empirical 
Options 
dialog Box

Selects whether a semi-empiri-
cal calculation will use the 
Unrestricted or restricted Har-
tree-Fock approximations.

ExcitedState Bool-
ean

Yes, No Semi-
empirical 
Options 
dialog Box  

Determines whether the cur-
rent configuration No is of the 
ground state or the first excited 
state.

Accelerate
Convergence

Bool-
ean

Yes, No Semi-
empirical 
Options 
dialog Box

If Yes, then uses DIIS procedure 
to accelerate

HuckelConstant Real 0–10.0 Extended 
Hückel 
Options 
dialog box

The proportionality factor to use 
in an Extended Hückel 
calculation. Usually 1.75

HuckelScaling
Factor

Real 0–100000 Extended 
Hückel 
Options 
dialog box

Scaling factor for interaction 
between classical and quantum 
portions of a system when using 
mixed mode calculation.

Weight Bool-
ean

Yes, No Extended 
Hückel 
Options 
dialog box

A toggle for using a simple 
Hückel constant (No) or a 
constant including a weighting 
factor for orbital diffuseness 
(Yes).

DOrbitalsSecond
Row

Bool-
ean

Yes, No Extended 
Hückel 
Options 
dialog box

Yes to include d orbitals from 
the basis set for the second long 
row of atoms, (Si to Cl), or no to 
ignore d orbitals (and shorten 
the calculation)

Keyword Value 
Type

Value How to Set Use
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BetaOrbitals Bool-
ean

Yes, No Orbital 
Options 
dialog box

When using the UHF 
approximation, toggles the plot 
of alpha (no) or Beta (yes) 
orbitals on a contour plot.

Configuration
Interaction

enum NoCI, 
SinglyExcited, 
Microstate

Configuration 
Interaction 
dialog box

Determines which type of 
configuration interaction is 
performed.

QuantumLevel
Shift

int 0–32767 This filea This is the number of SCF 
iterations to perform a level 
shift, which separates the 
HOMO and LUMO levels during 
an SCF calculation in order to 
accelerate convergence.

CICriterion enum Orbital, Energy Configuration 
Interaction 
dialog box

This determines whether the 
criterion for the number of 
orbitals to include in a 
configuration interaction is 
based upon the lowest and 
highest orbitals, or the 
maximum excitation energy of 
an electronic transition.

CIUnoccupied int 0–32767 Configuration 
Interaction 
dialog box

This is the number of 
unoccupied orbitals to include 
in a CI calculation.

CIOccupied int 0–32767 Configuration 
Interaction 
dialog box

This is the number of occupied 
orbitals to include in a CI 
calculation.

CIExcitation
Energy

Real 0–10000.0 Configuration 
Interaction 
dialog box

This is the maximum excitation 
energy to use as a limit for the 
number of configurations to use 
in a CI calculation.

QuantumMultiplicity Int 1–6 Extended 
Hückel 
Options 
dialog box

The spin multipicity of the sys-
tem in the workspace

Keyword Value 
Type

Value How to Set Use
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Molecular-
Mechanics-
Method

Enum mm+
amber
bio+
opls

Molecular 
Mechanics-
Force Field 
dialog box

Sets the force field for a molec-
ular mechanics calculation. The 
force field stored in a HIN file 
changes this setting. 
Default = mm+

SemiEmpirical-
Method

Enum Extended-
Huckel
CNDO
INDO
MINDO3
MNDO
AM1
PM3
ZINDO1
ZINDOS

Semi-empiri-
cal Method 
dialog box

Sets the method for a semi-
empirical calculation.
Default = ExtendedHuckel 

CalculationMethod Enum Molecular-
Mechanics
SemiEmpiricall
AbInitio

Choose on 
the Setup 
menu

Sets the type of calculation 
method. Default = 
MolecularMechanics

MechanicsPrint
Level

Int 0–9 Start Log dia-
log box

The level of information output 
to a log file for molecular 
mechanics calculations.

QuantumPrint
Level

Int 0–9 Start Log dia-
log box

The level of information output 
to a log file for quantum 
mechanics calculations.

WarningType Enum None, Log, 
Message

This filea Determines the destination of 
warning messages for calcula-
tions: None = no warnings, Log 
= messages to log file only, 
Message = messages to screen 
and log file. Default = Message

DynamicsGraph-
Onset

Int 3–max. num-
ber of averag-
ing steps or 
32767

This filea Sets the number of averaging 
steps (see AveragesFrequency) 
to compute before plotting 
instantaneous values. 
Default = 3

Keyword Value 
Type

Value How to Set Use
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Filters Settings

This section describes the file filters in HyperChem.

[Filters]

a. Use a text editor, like Windows Notepad, to change this record in chem.ini.

Animate
Vibrations

Bool-
ean

Yes, No Vibrational 
Spectrum Dia-
log Box

Determines whether a vibra-
tional normal mode will be dis-
played as vectors or as a 
molecular animation.

IRAnimate
Amplitude

Real 0.0–10.0 Vibrational 
Spectrum Dia-
log Box

The amplitude of the vibrations 
of a normal mode.

IRAnimateSteps Int 3–32767 Vibrational 
Spectrum Dia-
log Box

The number of steps during 
each half cycle of a vibration 
animation.

Keyword Value 
Type

Value How to Set Use

MDL MOL String <descrip-
tion>|<filter>|
<ddlfile-
name>|<file 
type>

This file Directs HyperChem to the .DLL 
file that converts between .HIN 
files and MDL .MOL files. 
Default=*.mol|molhin.dll|MOL

MOPAC Z-Matrix String <descrip-
tion>|<filter>|
<ddlfile-
name>|<file 
type>

This file Directs HyperChem to the .DLL 
file that converts between .HIN 
files and MOPAC Z-Matrix files.
Default=*.zmt|zmathin.dll|ZMT

Keyword Value 
Type

Value How to Set Use
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Tripos MOL2 String <descrip-
tion>|<filter>|
<ddlfile-
name>|<file 
type>

This file Directs HyperChem to the .DLL 
file that converts between .HIN 
files and Tripos MOL2 files.
Default=*.ml2|ml2hin.dll|ML2

ChemDraw String <descrip-
tion>|<filter>|
<ddlfile-
name>|<file 
type>

This file Directs HyperChem to the .DLL 
file that converts between .HIN 
files and ChemDraw files.
Default= 
*.chm|chemdrw.dll|CHM

Keyword Value 
Type

Value How to Set Use
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MM+ Settings

[mm+]

[mm+,CustomName]

These are the settings supplied for the MM+ parameter set with the 
CustomName mmplus:

a. Use a text editor, like Windows Notepad, to change this record in chem.ini.

Keyword Value 
Type

Value How to Set Use

CurrentFiles Int 0 to (number 
of Custom-
Names–1)

Force field 
Parameters 
dialog box

The index of the MM+ parame-
ter set to use. 0 for first Custom-
Name, 1= second, and so on.
Default = 0

AtomTypeMass Enum Filename: 
*typ.txt
*typ.dbf 
or any other

This filea Directs HyperChem to the file 
containing the atom types and 
masses for this force field.
Default = mmptyp.txt

FileFormat Enum Text
Dbf 

This filea Sets the type of file containing 
MM+ AtomTypeMass 
parameters. Default = Text

CustomNames Enum Names 
separated by 
commas

This filea The names of parameter sets 
associated with the MM+ force 
field. Default = mmplus

Keyword Value 
Type

Value How to Set Use

FileFormat Enum Text
Dbf 

This filea Sets the type for the following 
files. Default = Text

MMPElectrostatics Enum BondDipoles, 
AtomicChar-
ges

MM+ 
Options 
dialog box

Specifies the form of electrostatic 
interactions used for MM+ calcu-
lations. Default = BondDipoles
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MMPStretch Enum Filename This filea Directs HyperChem to the file 
containing bond stretch parame-
ters for this parameter set. 
Default = mmpstr.txt

MMPBend Enum Filename This filea Directs HyperChem to the file 
containing bond angle bending 
parameters for this parameter 
set. Default = mmpben.txt

MMPBend4 Enum Filename This filea Directs HyperChem to the file 
containing bond angle bending 
parameters for four-membered 
rings, for this parameter set. 
Default = mmpben4.txt

MMPBend3 Enum Filename This filea Directs HyperChem to the file 
containing bond angle bending 
parameters for three-membered 
rings, for this parameter set. 
Default = mmpben3.txt

MMPOOPBend Enum Filename This filea Directs HyperChem to the file 
containing the out-of-plane 
bending parameters for this 
parameter set.
Default = mmpoop.txt

MMPStretchBend Enum Filename This filea Directs HyperChem to the file 
containing parameters coupling 
bond stretching and bond angle 
bending for this parameter set. 
In this release, stretch-bend con-
stants are internal to HyperChem 
and not available in a parameter 
file. Default = none

MMPTorsion Enum Filename This filea Directs HyperChem to the file 
containing bond torsion parame-
ters for this parameter set. 
Default = mmptor.txt

Keyword Value 
Type

Value How to Set Use
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MM+ Settings
a. Use a text editor, like Windows Notepad, to change this record in chem.ini.

MMPTorsion4 Enum Filename This filea Directs HyperChem to the file 
containing bond torsion parame-
ters for four-membered rings, for 
this parameter set. Default = 
mmptor4.txt

MMPAtomVDW Enum Filename This filea Directs HyperChem to the file 
containing atom-based van der 
Waals interaction parameters for 
this parameter set.
Default = mmpnbd.txt

MMPPairVDW Enum Filename This filea Directs HyperChem to the file 
containing pair-based van der 
Waals interaction values for this 
parameter set. In this release, 
pair-based VDW constants are 
internal to HyperChem and not 
available in a parameter file. 
Default = none

MMPCubicStretch Real Any negative 
real number

This filea The MM+ cubic stretch coeffi-
cient for calculating bond stretch 
energies. Default = –2

Keyword Value 
Type

Value How to Set Use
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Network Settings
Network Settings

[Network]

In this section you can specify options for running your calcula-
tions on different machines on your network with HyperChem’s 
remote calculation modules.

a. Use a text editor, like Windows Notepad, to change this record in chem.ini.

Keyword Value 
Type

Value How to Set Use

Networking Boolean Yes, No This filea Whether you have one or more 
backend modules (Yes) or not 
(No)

BackendCommu-
nications

Enum Local, Remote Network 
Options dia-
log box

Whether calculations should be 
run remotely or on the local 
machine

BackendEthernet-
Server

String Any string Network 
Options dia-
log box

Specifies the name of the remote 
machine that the backend will 
run on

BackendUserId String Any string Network 
Options dia-
log box

Specifies the login name that 
should be used on the remote 
machine

BackendNodes Int 1 Network 
Options dia-
log box

Specifies the number of parallel 
processes to run. Ignored in the 
current version of HyperChem, 
which will use 1
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OPLS Settings

[opls]

[opls,CustomName]

These are the settings supplied for the parameter set with the Cus-
tom Name opls:

a. Use a text editor, like , to change this record in chem.ini.

Keyword Value 
Type

Value How to Set Use

CurrentFiles Int 0 to 
(number of 
CustomNames
–1)

Force field 
Parameters 
dialog box

The index of the OPLS parameter 
set to use. Default = 0 for first 
CustomName; 1= second, and 
so on. Default = 0

AtomTypeMass Enum Filename: 
*typ.txt
*typ.dbf
or any other

This filea Directs HyperChem to the file 
containing the atom types for 
this force field.
Default = oplstyp.txt

FileFormat Enum Text
Dbf 

This filea Sets the type of file containing 
OPLS AtomTypeMass 
parameters. Default = Text

CustomNames Enum Names 
separated by 
commas

This filea The names of parameter sets 
associated with the OPLS 
force field. Default = opls

Keyword Value 
Type

Value How to Set Use

FileFormat Enum Text
Dbf 

This filea Sets the type for the following 
files. Default = Text
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OPLS Settings
Dielectric Enum Constant Force Field 
Options 
dialog box

Sets the dielectric permittivity for 
calculating electrostatic interac-
tions to Constant. There are no 
other choices.
Default = Constant

DielectricScale Real 1–1000 Force Field 
Options 
dialog box

Sets the scale factor for dielectric 
permittivity (see previous entry). 
Default = 1

1–4Electrostatic- 
Scale

Real 0–1 Force Field 
Options 
dialog box

Sets the scale factor for calculat-
ing charge interactions between 
atoms separated by three bonds.
Default = 0.5

1–4vanderWaals-
Scale

Real 0–1 Force Field 
Options 
dialog box

Sets the scale factor for calculat-
ing charge interactions between 
atoms separated by three bonds.
Default = 0.125

6–12AtomVDW-
Format

Enum RStarEpsilon
SigmaEpsilon
SlaterKirkwood

This filea Sets the method for calculating 
atom-based van der Waals inter-
actions from data in the file spec-
ified in 6–12AtomVDW (see 
below).b

Default = SigmaEpsilon

6–12PairVDW-
Format

Enum RStarEpsilon
SigmaEpsilon
AijBij

This filea Sets the method for calculating 
pair-based van der Waals interac-
tions from data in the file speci-
fied in 6–12PairVDW (see 
below).b

Default = SigmaEpsilon

QuadraticStretch Enum Filename This filea Directs HyperChem to the file 
containing bond stretch parame-
ters for this force field.
Default = oplsstr.txt

Keyword Value 
Type

Value How to Set Use
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OPLS Settings
a. Use a text editor, like , to change this record in chem.ini.
b. See HyperChem Computational Chemistry, Theory and Methods.

QuadraticBend Enum Filename This filea Directs HyperChem to the file 
containing bond angle parame-
ters for this parameter set. 
Default = oplsben.txt

FourierTorsion Enum Filename This filea Directs HyperChem to the file 
containing torsion parameters 
for this parameter set.
Default = oplstor.txt

FourierImpTorsion Enum Filename This filea Directs HyperChem to the file 
containing improper torsion 
parameters for this parameter 
set. Default = oplsimp.txt

6–12AtomVDW Enum Filename This filea Directs HyperChem to the file 
containing van der Waals param-
eters for individual atom types.b 
Default = oplsnbd.txt

6–12PairVDW
(optional)

Enum Filename This filea Directs HyperChem to the file 
containing van der Waals param-
eters for specific pairs of atom 
types.b 
Default = none

Keyword Value 
Type

Value How to Set Use
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Path Settings

[Path]

In this section you can specify where HyperChem should find its 
program files, parameter files, etc.

Keyword Value 
Type

Value How to Set Use

ChemExePath string Any path name File/Prefer-
ences/Paths 
property 
sheet

The directory which contains the 
HyperChem program files

ChemParmPath string Any path name File/Prefer-
ences/Paths 
property 
sheet

The directory which contains the 
parameter files for molecular 
mechanics and semi-empirical 
calculations.

ChemLogPath string Any path name File/Prefer-
ences/Paths 
property 
sheet

The directory that log files will be 
stored in

ChemScriptPath string Any path name File/Prefer-
ences/Paths 
property 
sheet

The directory that script files are 
read from
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Preference Settings

[Preferences]

Keyword Value 
Type

Value How to Set Use

ButtonRotation-
Angle

Real 0–3600° Key 
Preferences 
dialog box

The maximum step size for XY 
rotation using the [3]/[4]/[2]/[1] 
keys.
Default = 7.5 degrees

ButtonZRotation-
Angle

Real 0–3600° Key 
Preferences 
dialog box

The maximum step size for Z 
rotation using the [Home]/[End] 
keys. 
Default = 7.5 degrees

DraggingRotation
Angle

Real 0–3600° Tool 
Preferences 
dialog box

The maximum XY rotation by 
moving the XY rotation tool 
across the screen once. 
Default = 360 degrees

DraggingZRotation-
Angle

Real 0–3600° Tool 
Preferences 
dialog box

The maximum Z rotation by 
moving the Z rotation tool 
across the screen once. 
Default = 360 degrees

ButtonTranslate-
Step

Int 0–1000Å Key 
Preferences 
dialog box

The maximum step size for XY 
translation using the [Shift]+ 
[3]/[4]/[2]/[1] keys. 
Default = 1 Ångstrom

ButtonZTranslate-
Step

Int 0–1000Å Key 
Preferences 
dialog box

The maximum step size for Z 
translation using the [Shift]+ 
[Help] /[End] keys. 
Default = 1 Ångstrom

DraggingZ-
TranslateStep

Int 0–1000Å Tool 
Preferences 
dialog box

The maximum Z translation by 
moving the Z translation tool 
across the screen once. 
Default = 10 Ångstroms
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ButtonClipping-
Step

Int 0–1000Å Key 
Preferences 
dialog box

The maximum clipping plane 
movement using the 
[Shift]/[Ctrl]+ [PgDn]/[PgUp] keys. 
Default=1 Ångstrom

DraggingClipping-
Step

Int 0–1000Å Tool 
Preferences 
dialog box

The maximum clipping plane 
movement by moving the Z 
clipping tool across screen 
once. Default=10 Ångstroms

ButtonZoomStep Int >1–1000Å Key 
Preferences 
dialog box

The maximum step size for 
magnification using the 
[PgDn]/[PgUp] keys. Default= 2

DraggingZoom-
Step

Int >1–1000 Tool 
Preferences 
dialog box

The maximum magnification 
by moving the Zoom tool 
across screen once. Default=10

MouseMode Enum Drawing 
Selecting 
Rotating
ZRotating
Translating
ZTranslating
Zooming
Clipping

Choose a Tool 
with the 
mouse

Sets the default tool and cursor. 
Default = Drawing

MultipleSelections Bool. Yes, No Select menu Sets Multiple Selections on or 
off. Default = No

SelectSphere Bool. Yes, No Select menu Sets Select Sphere on or off. 
Default = No

SelectLevel Enum Atoms
Residues
Molecules

Select menu Sets the selection level. 
Default = Atoms

FastTranslate Bool. Yes, No Tool 
Preferences 
dialog box

Sets Fast translation on or off. 
Default = Yes

Keyword Value 
Type

Value How to Set Use
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TranslateMolecules Bool. Yes, No Tool 
Preferences 
dialog box

Sets Whole molecule translation 
on or off. Default = Yes

DefaultAtomic-
Number

Int 0–103 Element Table 
dialog box

Sets the default element for 
drawing. 0 = lone pair.
Default = 6

ExplicitHydrogens Bool. Yes, No Build menu Sets Explicit Hydrogens to on or 
off. Default = No

AllowIons Bool. Yes, No Build menu Sets Allow Ions to on or off.
Default = No

HydrogenBond-
Distance

Real Positive real 
number

This filea Sets the maximum length for 
an H bond.
Default = 3.2 Ångstroms

HydrogenBond-
Angle

Real 0–180° This filea Sets the minimum angle for an 
H bond. Default = 150 degrees

Perspective Bool. Yes, No Display menu Sets Perspective View on or off. 
Default = No

HydrogenShown Bool. Yes, No Display menu Set the display of hydrogens on 
or off. Default = Yes

MultipleBond-
Shown

Bool. Yes, No Display menu Sets the display of multiple 
bonds on or off. Default = Yes

HBondShown Bool. Yes, No Display menu Sets the display of hydrogen 
bonds on or off. Does not 
calculate bonds. Default = Yes

Keyword Value 
Type

Value How to Set Use
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IsosurfaceType Enum wire-mesh, 
Jorgensen-
Salem, lines, 
flat-surface, 
shaded-sur-
face, Gouraud-
shaded-sur-
face, translu-
cent-surface

Isosurface 
Options dia-
log box

Specify the rendering mode for 
isosurfaces

StickPixelWidth int 0 to 25 Sticks prop-
erty sheet

Specify width of bonds drawn 
as sticks, in units of pixels

BallsRadius float 0 to 1 Balls property 
sheet

Size of the balls relative to the 
maximum value, in balls ren-
dering

BallsCylindersRadius float 0 to 1 Balls property 
sheet

Size of the balls relative to the 
maximum value, in balls and 
cylinders rendering

CylindersRadius float 0 to 1 Cylinders 
property sheet

Size of cylinders relative to the 
maximum value, in balls and 
cylinders rendering

BackgroundColor Enum Colorb Preferences 
dialog box

Sets the color of the Hyper-
Chem workspace 
(window). Default = Black

AtomColor Enum ByElement or 
colorb

Preferences 
dialog box

Sets the color of all bonds. 
Default = ByElement

SelectionColor Enum ThickLine or 
colorb

Preferences 
dialog box

Sets the display for selected 
atoms and bonds.
Default = Green

Keyword Value 
Type

Value How to Set Use
574 Appendix F



Preference Settings
DefaultAtomLabels Enum None 
AtomSymbol 
AtomName 
AtomNumber 
AtomType 
BasisSet
Mass
Charge 
Chirality

Labels 
dialog box

Sets the type of label for an 
atom. Default = None

DefaultResidue-
Labels

Enum None 
ResidueName
Sequence 
Name-
Sequence

Labels 
dialog box

Sets the type of label for a 
residue. Default = none

CPKNumberOf-
Rings

Int 0–32767 This filea Sets the number of concentric 
disks used in a Spheres render-
ing. Higher numbers improve 
the appearance but increase 
computing time. Default = 20

CPKMaxDouble-
BufferAtoms

Int 0–number of 
atoms

This filea If DoubleBuffered is on (Yes) 
and there is enough memory, 
HyperChem displays a com-
plete rendering containing up 
to this number of atoms. More 
atoms or lack of memory turns 
off double buffering and 
HyperChem shows the 
rendering atom-by-atom.
Default = 50

DotSurfaceAngle Real –90 to +90° This filea This is the angle of dot planes 
relative to the XZ plane of the 
Viewer’s Coordinate System. A 
value of 0 sets the dot planes 
perpendicular to the screen.
Default = 25 degrees

Keyword Value 
Type

Value How to Set Use
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BondSpacing-
DisplayRatio

Real 0–0.1 This filea This setting determines the line 
spacing of double, triple, and 
aromatic bonds for printing 
Sticks renderings. The spacing 
is the product of this value and 
the smallest dimension of a 
rectangle (width or height) that 
encloses the molecular system.
Default = 0.01

WallEyedStereo Bool. Yes or No This filea This setting turns on either 
walleyed stereo (Yes) or cross-
eyed stereo (No).
Default = Yes

FillPDBRecords Bool. Yes or No This filea Adds blank spaces to each 
record to 70 characters. Some 
programs reading PDB files 
might require this. 
Default = No

WritePDB-
Hydrogens

Bool. Yes or No Save File 
dialog box

Includes ATOM or HETATM 
records for hydrogen atoms in 
PDB files. 
Default = No

WritePDBConnect Bool. Yes or No Save File 
dialog box

Includes all CONECT records, 
with bonding information, in a 
PDB file. Default = No

SaveVelocities Bool. Yes or No Save File 
dialog box

Includes Vel records in a HIN 
file, with the velocity for each 
atom. Default = No

PrinterBack-
groundWhite

Bool-
ean

Yes, No This filea Controls whether the printer 
background color is white

ToolHelpPopup Bool. Yes, No This filea Enables popup help messages 
when cursor pauses over tool 
icons. Default = Yes

Keyword Value 
Type

Value How to Set Use
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FileFormat Enum HIN
SKC
PDB
ML2
ZMT

Save File 
dialog box

Sets the type of file for storing a 
molecular system. 
Default = HIN

UseCustomMenu Bool. Yes, No This filea Specifies whether a custom 
menu should be used (Yes) or 
the default menu used (No)

CustomMenuFile File-
name

Any filename This filea Specifies the name of the file 
containing the custom menu

ShadedBalls Bool. Yes, No Balls property 
sheet

Specifies if shading should be 
used in Balls rendering

ShadedCPK Bool. Yes, No Spheres prop-
erty sheet

Specifies if shading should be 
used in Spheres rendering

HighlightedBalls Bool. Yes, No Balls property 
sheet

Specifies if highlighting should 
be used in Balls rendering

HighlightedCPK Bool. Yes, No Spheres prop-
erty sheet

Specifies if highlighting should 
be used in Spheres rendering

ColorCylindersByEle-
ment

Bool. Yes, No Cylinders 
property sheet

Specifies if cylinders should be 
colored according to the atoms 
that they join (Yes) or drawn in 
gray (No)

NetLicense Int 0 to 15 Network Pref-
erences prop-
erty sheet

Specifies which networks to 
request a network license from. 
The setting is the sum of the 
following values: 8 if TCP/IP is 
enabled, 0 otherwise; 4 if 
IPX/SPX is enabled, 0 other-
wise; 2 if NETBIOS/NETBEUI/ 
NETAP is enabled, 0 otherwise; 
1 if Local access is enabled, 0 
otherwise

Keyword Value 
Type

Value How to Set Use
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Registration Settings

[Registration]

This section stores information about the registered user.

a. Use a text editor, like Windows Notepad, to change this record in chem.ini.
b. Color: black, blue, green, cyan, red, violet, yellow, white

NetTimeoutLicense Int 0 to 32767 Network Pref-
erences prop-
erty sheet

Specifies the time in minutes 
without the user activating a 
menu itembefore a network 
license will time out.

TCPNetMask String Four integers 
(each 0 to 255) 
separated by 
periods

Network Pref-
erences prop-
erty sheet

Specifies the mask used for 
TCP/IP addressing

TCPTimeout Int 0 to 32767 Network Pref-
erences prop-
erty sheet

Specifies the maximum time in 
seconds to allow for a response 
from the TCP/IP network 
request

TCPRetry Int 0 to 32767 Network Pref-
erences prop-
erty sheet

Specifies the maximum number 
of times to try to get a response 
to a TCP/IP network request

Keyword Value 
Type

Value How to Set Use

User string Any string Installation The name of the registered user

Organization string Any string Installation The company or organization of 
the registered user

SerialNo string Valid serial 
number

Installation The serial number of the product

Keyword Value 
Type

Value How to Set Use
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Registration Settings
Dealer string Any string Installation The name of the product dealer

Keyword Value 
Type

Value How to Set Use
Default Settings in Registry or Chem.ini 579
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Glossary

In this Glossary, terms in bold have their own entries.

Ab initio. A form of quantum mechanics calculation in which 
each orbital is computed as the sum of a set of primitive geometric 
functions (the basis set). By computing the interaction of many 
orbital wave functions, ab initio calculations can give very accurate 
results, at the cost of requiring large amounts of storage space and 
relatively long computation times.

AM1. Austin Model 1. A semi-empirical, SCF method for chemical 
calculations. One of the MOPAC methods [Stewart, J.J.P., J. Comp.-
Aided Molec. Design 4(1):1-108, 1990]. An improvement of the 
MNDO method. Useful for organic molecules containing elements 
from long rows 1 and 2 of the periodic table, but not transition 
metals. Generally the most accurate method included in 
HyperChem. Calculates electronic properties, optimized geome-
tries, total energy, and heat of formation. Reference: Dewar, M.J.S., 
et al., J. Am. Chem. Soc. 107:3902, 1985.

All atom. A molecular mechanics calculation that represents each 
atom as an individual particle. Contrast to united atom.

AMBER. Assisted Model Building and Energy Refinement. A 
molecular mechanics method, or force field, for chemical calcula-
tions. Developed for proteins and nucleic acids. This force field 
provides both an all atom and a united atom representation. Ref-
erence: Weiner, S.J., et al., J. Comp. Chem. 7:230-252, 1986.

Atom type. Atom types represent classes of chemical environ-
ments assigned to each atom used in a force field calculation. The 
characteristics of an environment include hybridization, formal 
charge, and immediate bonded neighbors. For example, the 
AMBER atom type C represents an sp2 carbonyl carbon, CT repre-
sents a tetrahedral carbon, and CH is a united atom representation 
of an sp3 carbon including one hydrogen. Each force field has a 
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different set of atom types. HyperChem can assign atom types to a 
molecular system, using rules in chem.rul. 

Backbone. The continuous covalent path through a molecule. 
For polypeptides, the backbone includes all peptide bonds, alter-
nating with alpha carbons, plus disulphide bonds. For 
polynucleotides, the backbone includes all phosphodiester bonds, 
alternating with the C3′–C4′ carbons in the sugar (ribose or deox-
yribose).

Back end.  HyperChem computational software. HyperChem is 
constructed in modules, with front-end software running on a PC 
and back-end software running on the same PC or another com-
puter. Back-end software includes HyperNewton (AMBER, BIO+, 
and OPLS), HyperMM+ (MM+), HyperGauss (ab initio), HyperEHT 
(Extended Hückel), and HyperNDO (CNDO, INDO, MINDO/3, 
MNDO, AM1, and PM3).

BIO+. An implementation of the CHARMM (Chemistry at 
HARvard Macromolecular Mechanics) force field, developed 
in the group of Martin Karplus at Harvard University. A molecular 
mechanics method, or force field, for chemical calculations. 
Developed for proteins. References: Brooks, B.R., et al., J. Comp. 
Chem. 4:187-217, 1983; Reiher, W.E., II, Theoretical Studies of Hydro-
gen Bonding, Ph.D. thesis, Harvard University, 1985.

Bitmap. A screen image composed of individual pixels (dots). A 
bitmapped image has the same resolution as the monitor.

Brookhaven Protein Data Bank (PDB). A database of protein 
and nucleic acid structures. Information for each molecular struc-
ture includes atomic coordinates, atomic connectivity, and refer-
ences. HyperChem can read in and correctly interpret all PDB files 
with atomic coordinate or connectivity information. PDB files 
have the extension .ent.

Charge density. Distribution of electronic charge density for a 
molecule. The shape of a molecule is often associated with a sur-
face of constant charge density. HyperChem calculates charge den-
sity as a sum of molecular orbital densities, each the square of the 
orbital wave function.

Clipboard. The temporary storage area for data and graphics pro-
vided by Windows. Cut and Copy in HyperChem place a text 
description of atoms onto the Clipboard. Copy Image in Hyper-
Chem places graphic images (both metafile and bitmapped) onto 
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the Clipboard. You can view the Clipboard contents directly using 
the Clipboard program in the Windows Main Applications group.

Click. Press and release a mouse button quickly.

Clipping. Displaying a section through a molecular system in the 
HyperChem workspace. Hides unwanted foreground and back-
ground atoms so you can focus on an area of interest. The section 
is called a clipping slab. This is a rectangular box with adjustable 
depth, and with height and width equal to the height and width 
of the HyperChem workspace. See clipping planes.

Clipping planes. The front and back boundaries of a clipping 
slab, individually adjustable from 0 Ångstroms (the viewer’s posi-
tion) to a number of Ångstroms depending on the size and magni-
fication (Zoom factor) of the molecular system.

Clipping slab. A rectangular section through a molecular system 
bounded by two adjustable clipping planes.

Closed-shell. A molecule with no unpaired electrons.

CNDO. Complete Neglect of Differential Overlap (see NDO). This 
is the simplest of the SCF methods for semi-empirical quantum 
mechanics calculations. It is useful for calculating ground-state 
electronic properties of open- and closed-shell systems, geometry 
optimization, and total energy. HyperChem uses CNDO/2. Refer-
ence: Pople, J. A. and Beveridge, D.L., Approximate Molecular Orbital 
Theory, McGraw-Hill, 1970.

Connectivity. Information on the covalent bonding of an atom 
to each of its neighbors. PDB files can include this information in 
CONECT records. HIN files have this information at the end of 
Atom records, in <nbor# nbor-bonds> statements.

Constraint. Constraints for the Model Builder fix values of struc-
tural entities when an approximate 3D structure is being built. 
These constraints are a high priority for the Model Builder. How-
ever, adding excessive constraints can result in some being 
dropped.

Convergence. The criterion for ending a chemical calculation. A 
semi-empirical SCF mechanics calculation converges (ends) when 
the difference in energy after two consecutive iterations is less 
than a convergence limit (default of 0.01 kcal/mol) or the calcula-
tion reaches an iteration limit (default of 50). For geometry opti-
mization calculations, the convergence limit is either a number of 
calculation cycles (the default number is 15 times the number of 
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atoms) or an RMS gradient for the molecular system (default of 
0.1 kcal/Ångstrom mol).

Coordinate system. A three-dimensional (3D) space containing 
x, y, and z Cartesian coordinates for each atom in a molecular 
system. HyperChem has a Viewer’s Coordinate System and a 
Molecular Coordinate System. From the Viewer’s Coordinate Sys-
tem, you can translate and rotate your viewpoint relative to a fixed 
molecular system, giving the appearance of a moving molecular 
system. Rotation or translation in the Molecular Coordinate Sys-
tem changes the positions of individual atoms.

CPK. Acronym for Corey-Pauling-Koltun; refers to a popular set of 
atomic ‘radii’ used for depicting space-filling pictures or building 
plastic models.

Cursor keys. The [1] [2] [3] [4] [Home] [End] keys. Use these keys alone, 
with [Shift], or with [Ctrl]+ [Shift] to rotate or translate molecules in the 
workspace.

Cursor. The pointer or tool on screen that you move using the 
mouse. Use a cursor to choose items from menus, to draw and 
move molecules, to make choices in dialog boxes, and to edit text.

Cycle. During a geometry optimization calculation, the number 
of cycles indicates the number of times a calculation takes a new 
direction on the potential surface to locate a minimum. Each cycle 
includes one or more points, which are calculations to evaluate the 
energy and gradient in this direction. HyperChem reports the 
cycle number and number of points on the status line.

DDE. Dynamic Data Exchange. A system for exchanging data 
between HyperChem and other Windows applications. 
HyperChem acts as a server: it supplies information only when a 
client application asks for specific data. 

Default element. The element the HyperChem Drawing tool uses 
to construct molecules. There can be only one default element at 
a time, but you can change it as needed.

Desktop. The screen display that Microsoft Windows uses to 
present windows and icons. 

Dialog box. A type of Window for accepting information or dis-
playing a message. The presence of most dialog boxes blocks other 
HyperChem functions. You must close these dialog boxes to re-
activate HyperChem. Persistent dialog boxes (for example, the 
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Amino Acids dialog box) do not interfere with HyperChem func-
tions.

Dielectric constant. A factor (epsilon) that modifies charge-
charge interactions during molecular mechanics calculations. In 
the absence of solvent molecules, a distance-dependent dielectric 
constant or a “constant” dielectric constant greater than 1 
simulates the presence of solvent. In the presence of solvent, as in 
a hydrated periodic box, the dielectric constant should be Con-
stant, rather than Distance dependent. For a constant dielectric, 
epsilon= (permittivity of free space) × (scale factor). For a distance-
dependent dielectric, epsilon= (permittivity of free space) × (scale 
factor) × (interatomic separation). See electrostatic potential. 

Drag. Move an object on screen by holding down a mouse button 
while moving the mouse. Objects can be molecules or highlight 
bars in a menu. When you complete the movement, release the 
mouse button. For example, you can move a selected molecule by 
dragging a translation tool across the HyperChem workspace 
while holding the right mouse button. You can hold the left 
mouse button and move the mouse pointer through a menu to 
highlight a menu item. Release the mouse button to choose the 
item.

Dynamic Data Exchange. See DDE.

Electrostatic potential. The potential energy at every point in 
space arising from a distribution of charged atoms. The electro-
static potential (U) at a distance r from a point charge is given by 
Coulomb’s law: , where C is a constant (dependent on 

units) and ε is the dielectric constant (or epsilon). For multiple 
charges in 3D space (both nuclear charges and electrons in molec-
ular orbitals), this equation becomes appropriately complex. 
HyperChem calculates electrostatic potential as the potential 
energy of a unit positive charge interacting with the molecular sys-
tem. In calculating the interaction with electrons in molecular 
orbitals, HyperChem neglects components due to diatomic differ-
ential overlap (see NDO). HyperChem calculates and plots electro-
static potential from the results of single point, semi-empirical 
quantum mechanics calculations. You can use these results to pre-
dict initial attack positions of protons and other ions during reac-
tions.

Explicit hydrogens. When Explicit hydrogens is active during 
drawing, HyperChem expects all hydrogen atoms to be drawn. 

U Cq εr( )⁄=
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Atoms with only one bond are drawn as hydrogen, rather than as 
the default element. This is in contrast to hydrogen atoms added 
by the Model Builder after drawing with only heavy atoms.

Force constant. A term in each equation for a force field that 
transforms data on atomic coordinates into a potential energy 
measurement. For example, for bond stretching energy: 

, where E is potential energy, r is bond length, 

r0 is equilibrium (“strain-free”) bond length, and Kr is the force 
constant. For each force field, one or more parameter sets define 
the force constants and equilibrium geometries (for example, r0).

Force field. A molecular mechanics method for chemical calcula-
tions. These calculations can be single point, geometry optimiza-
tion, or molecular dynamics. HyperChem provides four force 
fields: MM+, AMBER, BIO+, and OPLS. A force field has three com-
ponents: equations defining the potential energy of a molecular 
system as a function of atomic coordinates, atom types, and 
parameter sets that fit the equations to experimental data. See the 
separate entries for atom type and parameter set.

Front end. See back end.

Geometry optimization. A calculation, using either a molecular 
mechanics or quantum-mechanical method, to find a minimum 
energy (stable) configuration for a molecular system. The calcula-
tion adjusts atomic coordinates in steps to find a configuration in 
which net forces on each atom are reduced to zero. This is usually 
a local minimum on the potential surface, which may not neces-
sarily be the global minimum.

Global minimum. The configuration of a molecular system with 
the lowest potential energy. 

Gradient. The rate of change (first derivative) of the energy of a 
molecular system as a function of atomic positions. A gradient of 
zero indicates a configuration with minimum energy a (local or 
global minimum or a transition state). When HyperChem reports 
a single value for Gradient, this is the RMS gradient of the forces 
on all atoms.

Ground state. The lowest energy electronic state. See lowest 
state.

Group selection. A selection of a subset of atoms, residues, or 
molecules in a molecular system. The choice of Atoms, Residues, or 

E
bond

Kr r r 0–( )2

bonds

∑=
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Molecules on the Select menu regulates the level of group selection. 
With the Selection tool active, you group-select by dragging a 
boundary around the molecular structures, with both left and 
right mouse buttons pressed (press left before right). Select Sphere 
on the Select menu toggles group selection between a 2D and 3D 
process. 2D selection involves all atoms projecting onto a 2D 
selection rectangle. 3D selection involves all atoms within a sphere 
centered on an atom.

HIN. HyperChem Input file. This is the principal file type Hyper-
Chem uses to store molecular systems. The files have the extension 
.hin.

HOMO. Highest Occupied Molecular Orbital. This is used as a ref-
erence point for describing the position of any molecular orbital as 
being at or below this orbital. Molecular orbitals are a linear com-
bination of atomic orbitals (LCAO).

Hückel method. A simple and approximate method for semi-
empirical quantum mechanics calculations. The Extended Hückel 
method used in HyperChem is useful only for single point calcu-
lations, not for geometry optimization or molecular dynamic cal-
culations. Extended Hückel calculations produce qualitative or 
semi-quantitative descriptions of molecular orbitals and electronic 
properties (for example, net atomic charges and spin distribu-
tions). This is not a Self-Consistent Field (SCF) method. Reference: 
Hoffman, R., J. Chem. Phys. 39(6):1397-1412, 1963.

Icon. A small graphic symbol representing a tool or application 
program.

INDO. Intermediate Neglect of Differential Overlap (see NDO). 
An SCF method for semi-empirical quantum mechanics calcula-
tions. It improves on CNDO by accounting for certain one-center 
repulsions between electrons on the same atom. Useful for calcu-
lating ground-state electronic properties of open- and closed-shell 
systems, geometry optimization, and total energy. Reference: 
Pople, J. A. and Beveridge, D.L., Approximate Molecular Orbital The-
ory, McGraw-Hill, 1970.

Improper torsion. A torsion (dihedral) angle not formed by a 
sequence of three bonds. Some molecular mechanics force fields 
use such angles in energy terms to maintain planarity or to prevent 
inversion of tetrahedral carbons that have one hydrogen in a 
united atom representation.
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Inertial axes. The three axes (primary, secondary, and tertiary) 
associated with moments of inertia for a molecular system or 
selected subsystem. The axes are functions of the location and 
mass of atoms. They belong to the system and are independent of 
the Viewer’s or Molecular Coordinate Systems. The primary iner-
tial axis usually marks the longest distance through a molecular 
system, and the tertiary axis usually marks the shortest distance.

Isosurface. A three-dimensional surface which shows where in 
three-dimensional space the specified property has a given value; 
it is like the skin of a solid object. For example, for the mathemat-
ical function s = x2 + y2 +z2, an isosurface plot for s = 1 would give 
a spherical surface of radius 1; isosurface plots for other values of s 
would give spherical surfaces of other sizes.

Iteration. In an SCF quantum mechanics method, a calculation 
of molecular orbitals starts with a guess about the form of the 
orbitals. Each trial (or iteration) refines the guess for the next trial. 
When the difference between two successive iterations is less than 
a convergence limit (that you can set), the SCF calculation has 
reached convergence.

Label. Information about the components of a molecular system 
HyperChem can display with the system. Labels apply either to 
atoms or residues. Atom labels are Symbol (chemical), Name 
(according to PDB file conventions), Number (sequence), Type 
(atom type), Basis Set, Mass, Charge, or Chirality (R or S). Residue 
labels are Name, Sequence, or Name+Sequence. HyperChem 
applies labels to the current selection.

LINE. A predefined, named selection identifying atoms in the 
selection, plus the primary inertial axis of selected atoms. (The pri-
mary inertial axis corresponds to the smallest eigenvalue of the 
moment of inertia matrix.) A molecular system can have only one 
LINE selection at a time. 

Local minimum. A minimum on the energy surface for a molec-
ular system representing a low potential energy conformation. 
Molecular energy surfaces can have many minima, the lowest 
being the global minimum. Geometry optimization calculations 
can result in a structure at a local minimum.

Log. A file containing the results of a chemical calculation and 
comments. HyperChem automatically collects this information if 
you choose Start Log on the File menu (see Start Log). The default 
filename is chem.log and the file usually has the extension .log. 
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Lowest state. The lowest electronic state of a particular spin mul-
tiplicity; not necessarily the ground state.

LUMO. Lowest Unoccupied Molecular Orbital. This is used as a 
reference point for describing the position of any molecular orbital 
as being at or above this orbital. Molecular orbitals are a linear 
combination of atomic orbitals (LCAO).

Metafile. An image composed of drawing commands. The resolu-
tion of a metafile image does not depend on the monitor, but is 
the resolution of the output device. For example, if you print a 
metafile on a laser printer, the resolution may be 300 dpi.

MINDO/3. Modified Intermediate Neglect of Differential Over-
lap, version 3. This is an SCF method for semi-empirical quantum 
mechanics calculations. An extension of INDO, MINDO/3 uses 
parameters fit to experimental results, instead of accurate 
calculations. Useful for large organic molecules, cations, and 
polynitro compounds. Calculates electronic properties, geometry 
optimizations, and total energy. Reference: Dewar, M.J.S. et al., J. 
Am. Chem. Soc. 97:1285, 1975.

MM+. The most general method for molecular mechanics calcula-
tions, developed for organic molecules. This is an all atom force 
field. MM+ is based on the MM2 (77) functional form, authored by 
Dr. Norman Allinger of the University of Georgia. HyperChem 
assigns atom types and parameters not normally available to 
MM2, extending the range of chemical compounds that this force 
field can accommodate. MM+ extends MM2 to allow options such 
as periodic boundary conditions and molecular dynamics com-
mon to other force fields. Reference: Allinger, N.L., J. Am. Chem. 
Soc. 99:8127-8134, 1977. 

MNDO. Modified Neglect of Diatomic Overlap. This is an SCF 
method for semi-empirical quantum mechanics calculations. Use-
ful for various organic molecules containing elements from long 
rows 1 and 2 of the periodic table, but not transition metals. Elim-
inates some errors in MINDO/3. Calculates electronic properties, 
optimized geometries, total energy, and heat of formation. Refer-
ence: Dewar, M.J.S. and Theil, W., J. Am. Chem. Soc. 99:4899, 1977.

Model Builder. The facility in HyperChem that constructs 3D 
models of chemical structures from 2D drawings. HyperChem uses 
built-in rules to assign standard bond lengths, bond angles, torsion 
angles, and stereochemistry. The Model Builder also assigns atom 
types for the currently active force field, and can automatically 
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add hydrogens to satisfy valence requirements. These are approxi-
mate structures and might require refinement by geometry 
optimization. 

Molecular dynamics. Calculations simulating the motion of 
each atom in a molecular system at a fixed energy, fixed tempera-
ture, or with controlled temperature changes. The result of molec-
ular dynamics calculation is called a trajectory. HyperChem can 
use either a molecular mechanics or semi-empirical quantum 
mechanics method for a molecular dynamics trajectory. You can 
use this calculation to derive a large number of structural and ther-
modynamic properties, including alternative local minima, 
energy differences between different configurations, and reaction 
mechanisms and pathways.

Molecular mechanics. Various methods for calculating the 
potential energy of molecular systems as a function of the coordi-
nates of their atomic nuclei, neglecting explicit treatment of elec-
trons. Electronic effects are implicit in the analytic functional 
forms and parameterization. All methods use empirical data to 
determine individual force constants (for example, bond stretch 
constants) and equilibrium (“strain-free”) values for each geomet-
ric quantity (for example, bond lengths). HyperChem provides 
these methods: MM+, AMBER, BIO+, and OPLS.

Multiplicity. The total spin multiplicity is 2S+1, where S is the 
total electron spin of the system. Each unpaired electron counts 
for a spin of +1/2. Paired electrons have a net spin of zero
(+1/2 – 1/2 = 0). A closed-shell system has a multiplicity of 1 (sin-
glet). An open-shell system can have a multiplicity of 2, 3, 4 (dou-
blet, triplet, quartet, respectively), or higher. Use integers from 1 
to 6 in HyperChem.

Named selection. A set of atoms that have an assigned name, 
either predefined (POINT, LINE, or PLANE) or any other name up 
to 19 characters long. You can use named selections to repeat a 
selection or to carry out specific operations (for example, inver-
sion, reflection, rotation, averaging and graphing during molecu-
lar dynamics, or setting restraints during a calculation).

NDO. Neglect of Differential Overlap. For semi-empirical quan-
tum mechanics calculations, this is a simplification eliminating 
many integrals describing the interactions of electrons. The CNDO 
method neglects the calculation of all differential overlap inte-
grals. Other NDO methods (INDO, MNDO/3, MNDO, and AM1) 
neglect some integrals.
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Open shell. A molecular system containing unpaired electrons.

OPLS. Optimized Potentials for Liquid Simulations. A molecular 
mechanics method, or force field, for chemical calculations. 
Developed for proteins and nucleic acids. It is similar to AMBER 
but treats nonbonded interactions more accurately. This force field 
provides only a united atom representation.

Orbital. The function describing the spatial distribution of an 
electron. Atomic orbitals describe the electrons in atoms. Molecu-
lar orbitals, derived as a linear combination of atomic orbitals 
(LCAO), describe electrons in molecules. 

Parameter set. For molecular mechanics force fields, empirically 
or theoretically derived force constants and structural values 
applying to specific bonded combinations of atoms (each 
described by an atom type). Each force field might have more 
than one parameter set, but you can use only one set at a time. For 
MM+, HyperChem supplies parameters when they are not avail-
able in the MM2 parameter set. 

For semi-empirical calculations, parameter files (with the exten-
sion .abp) contain empirical values for the integrals in the calcula-
tion.

PDB. See Brookhaven Protein Data Bank.

Periodic box/ boundary conditions. A periodic box is a cube sur-
rounding a molecular system. HyperChem adds standard water 
molecules (TIP3P, equilibrated at 300K and one atmosphere) to the 
box, providing a constant-density solvent. In molecular mechan-
ics calculations, the box is treated as if it were surrounded by 26 
identical boxes (images), each containing the identical molecules. 
Atoms in each image experience the same forces (exhibit the same 
motions) as the molecules in the central box. If, during a calcula-
tion, molecules move out of the box, an identical particle “enters” 
from the neighboring image. These periodic boundary conditions 
simulate a continuous system with a constant density of mole-
cules. You can remove the water molecules, but retain the periodic 
box and boundary conditions, simulating a crystal lattice. 

With the HyperChem periodic boundary conditions, an atom 
interacts only with one nearest image of other atoms and never 
with an image of itself in molecular mechanics calculations. 

PLANE. A predefined, named selection identifying the atoms in 
the selection, plus the plane formed by the primary and secondary 
Glossary 593



inertial axes of the selected atoms. A molecular system can have 
only one PLANE selection at a time. 

POINT. A predefined, named selection identifying the atoms in 
the selection, plus the center of mass of the selected atoms. A 
molecular system can have only one POINT selection at a time.

Potential (energy) surface. A multidimensional plot of the 
potential energy of a molecular system as a function of all variables 
(degrees of freedom) in the system (for example, bond angles). The 
potential surface for a nonlinear molecule with N atoms (greater 
than 2) has 3N–6 independent degrees of freedom (6 = three 
degrees reserved for rotation and three reserved for translation of 
the whole molecular system). Potential energy surfaces are usually 
diagrammed in only one or two dimensions. A 1D potential sur-
face might show a bond energy versus length. A 2D potential 
surface might show a contour plot of energy as a function of two 
torsion angles. 

Important features on a potential surface are minima—which 
HyperChem can locate with geometry optimization and molecular 
dynamics calculations—and saddle points, which represent struc-
tural transition states. 

Quantum mechanics. The theory that energy is absorbed or radi-
ated in discrete packets, known as quanta. A consequence of this 
is that electrons travel in a limited number of orbitals around an 
atomic nucleus, and that each orbital is characterized by a specific 
energy. Moving electrons have the properties of particles and 
waves. The SchrÖdinger equation and its derivatives describe com-
pletely the behavior of electrons and nuclei, and hence the behav-
ior of chemical compounds. 

Semi-empirical calculations in HyperChem assume fixed nuclei 
and use approximate solutions of the Schrödinger equation, plus 
empirical data (parameters), to predict electronic properties of 
molecular systems.

HyperChem’s ab initio calculations solve the Roothaan equations 
(see the Computational Chemistry reference manual) without any 
further approximation apart from the use of a specific finite basis 
set. They involve a more fundamental approach to solving the 
Schrödinger equation than the semi-empirical methods do.

Rendering. The visual representation of a molecular system. This 
version of HyperChem provides five types of rendering: Sticks, 
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Disks, Spheres (CPK-type models), Dots, and Sticks & Dots. Space-
filling renderings use standard CPK radii for the atoms.

RHF. Restricted Hartree-Fock theory. The representation of a wave 
function with spin-paired electrons (up-spin and down-spin) 
restricted to occupy the same spatial molecular orbitals. Each spa-
tial orbital can also contain single (spin-up or spin-down) elec-
trons.

RMS gradient. Total energy gradient calculated as a root mean 
square value. The gradient (G) is the rate of change (first deriva-
tive) of total energy (E) with respect to displacement of each atom 
in the x, y, and z directions. For atoms 1 to n, 

The units are kcal/mol Ångstrom. HyperChem reports this value 
for geometry optimization and single point calculations. An 
RMS gradient of zero means the structure is at a local minimum 
or saddle point in the potential energy surface, not necessarily at 
the structure and state of lowest energy (global minimum).

Restraint. Restraints for energetic calculations add restoring 
forces to selected atoms. Restraints apply to atomic distances (one 
or two atoms), bond angles (three atoms), and torsion angles (four 
atoms). 

Scale to fit. An item on the Display menu that scales the visible 
atoms or molecules to fit into the workspace. If there is a selec-
tion, the selected atoms fill the workspace. Without a selection, 
HyperChem scales the whole molecular system to fit the work-
space.

SCF. Self-Consistent Field. This is an iterative method, used in all 
NDO, semi-empirical quantum mechanics calculations. It 
accounts for electron repulsion energies in solutions of the 
SchrÖdinger equation. The SCF or Hartree-Fock method simplifies 
this task by assuming the movements of electrons are independent 
and that an electron interacts with the mean field of other elec-
trons in a molecule. In HyperChem, all semi-empirical quantum 
mechanics methods, except Extended Hückel, are SCF methods.

An SCF calculation begins by estimating the wave function 
describing the electron orbitals and electron repulsions. Based on 
this guess, HyperChem calculates a new wave function and com-
pares the result with the estimate. HyperChem repeats this process 

GRMS
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xi∂------- 
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until the estimate and the result converge or become “self-consis-
tent.” Each iteration improves the orbitals until the result reaches 
a convergence limit.

Script. A set of instructions, stored in a file with a .scr extension, 
to run HyperChem. Similar to a macro program in other applica-
tions. HyperChem scripts set or read variables, give commands, 
and activate menu items. Use a text editor to create a script file, 
then use the Script menu in HyperChem to run a script.

Self-consistent field method. See SCF.

Semi-empirical. A type of quantum mechanics chemical calcula-
tion that uses parameters derived from experiments to simplify the 
calculation process. 

Single point. A calculation that determines the total energy (in 
kcal/mol) and gradient of a molecular system or of selected atoms. 
With a quantum-mechanical method, a single point calculation 
also determines the electron (charge) distribution in the system. 
The calculation represents only the present molecular configura-
tion, a single point on the energy surface for the molecular system. 

Snapshot. A record of a single time point in a molecular dynam-
ics simulation. You can instruct HyperChem to take snapshots at 
regular intervals during the simulation. Coordinates and velocities 
for the molecular system are stored in SNP files. You can later play 
back the snapshots to view the changes in configuration of the sys-
tem, plot data values, and obtain averages of data values. Data for 
chosen variables (like total energy or a bond torsion) are stored in 
a CSV file.

Spin density. The probability of finding more spin-up electrons 
than spin-down electrons at a point in space. For a closed-shell sys-
tem, spin density is zero at every point. HyperChem can plot total 
spin density for a molecular system after it performs a single point, 
semi-empirical or ab initio quantum mechanics calculation. You 
can use plots of spin density at the nucleus to predict the results of 
electron spin resonance (ESR) spectra. See spin pairing and mul-
tiplicity. 

Spin multiplicity. See multiplicity

Spin pairing. Two electrons occupying the same orbital must be 
paired and have opposite spins, one up spin and one down spin. 
Closed-shell systems contain only paired electrons. Open-shell 
systems contain unpaired electrons.
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Status line. The line at the bottom of a HyperChem window dis-
playing messages and data.

3D surface. See isosurface.

Tool. A cursor for performing tasks, like drawing or translation, in 
the HyperChem workspace. Tool icons are in a column at the left 
side of the workspace. L-clicking on a tool icon converts the cursor 
into a tool.

Trajectory. The history of atomic motion over time. This term is 
often applied to a molecular dynamics simulation. It can be saved 
in a snapshot file.

Translation. Movement of a molecule without rotation.

Type rules. Rules for each force field, found in the file chem.rul 
(or its binary equivalent, typerule.bin), for assigning atom types to 
individual atoms or atom groups.

UHF. Unrestricted Hartree-Fock method. A representation of a 
wave function providing separate spatial orbitals for spin-up (α) 
and spin-down (β) electrons. Each α or β orbital can accommodate 
zero or one electron. You can use UHF calculations for calculating 
dissociation reactions of closed-shell systems.

United atom. A simplification of a force field that treats certain 
atom groups (heavy atoms like C or N atoms and their bonded 
hydrogens) as a single atom. United atom treatment requires spe-
cial atom types incorporating the properties of the constituent 
atoms and type rules for assigning these types. United atom repre-
sentation is optional with AMBER and MM+, automatically 
assigned to many atoms with OPLS, and is the present default for 
BIO+. Another term for united atom is extended atom. The alter-
native to united atom is “all atom,” which represents each atom 
separately, with a distinct atom type.

Wave function. See orbital.

Window. A working area on the desktop containing a software 
program (like HyperChem). A window has a title bar at the top, 
containing the name of the program. Only one window can be 
active at a time. The active window receives input from the mouse 
and keyboard. A dialog box is a type of window.

Workspace. The region of a Window that contains data; for 
HyperChem, a molecular system.

Z Clipping. See clipping. 
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Zoom. The HyperChem function that magnifies or reduces the 
size of the molecular system in the workspace.

Zwitterion. A molecule with regions of formal positive and nega-
tive charge. This is the usual state of polypeptides at neutral pH in 
solution, with –NH3

+ and –COO– terminal groups. A polypeptide 
constructed from a HyperChem database has incomplete, 
uncharged termini (–N–H and –C–O), unless terminal groups were 
used. 
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Master Index
* and ** in basis set name, CC–261
*ben parameter file, RM–470
*imp parameter file, RM–470
*nbd parameter file, RM–470
*tor parameter files, RM–470
*typ parameter files, RM–470
? — Product support, GS–13
’**’ atom type, CC–205
10–12 potential, CC–26
1–4 electrostatic interactions, CC–104
1–4 interactions, CC–182, CC–195
1–4 van der Waals interactions, CC–104
24-bit color, RM–70
2D Contours, RM–267
2-electron integral storage, RM–72
3D Isosurface, RM–267
3D isosurface, RM–271
3D Rendering, RM–164, RM–165
4-31G scale factors, table, CC–260
6–12 function, CC–26
6–12 potential, CC–176

A

A form, polynucleotide strand 
conformation, RM–107

Ab Initio
dialog box, RM–15

Ab initio
basis set files, RM–507 to RM–514

Ab initio calculations, HyperChem 
tutorial, GS–211

ab initio d orbitals, RM–215
ab initio ghost atoms, RM–215

ab initio integral storage, RM–72
ab initio method, CC–251 to CC–268
Ab Initio options, RM–208
ab initio quantum mechanics, CC–31
Abort warning message, RM–237
About HyperChem, Help menu, RM–77
absolute energy, CC–22
absorption, infrared, CC–336
Accelerate convergence, Semi-empirical 

Options dialog box, RM–199
acceleration, convergence, CC–48, CC–112, 

CC–230
acceptance ratio, 98
ACCR, Selection, Molecular Dynamics Averages 

dialog box, RM–255, RM–256
accumulate selections, Selection tool, RM–139
accuracy

atomic charges, CC–137
dipole moments, CC–134
heats of formation, CC–130
proton affinities, CC–132
rotational barriers, CC–133
UV-visible spectra, CC–147
vibrational frequencies, CC–144

Acetyl (Ace), amino acid residues, RM–101
Activation energies, CC–307
activation energy, CC–17, CC–133
Add

Counter Ions, RM–109, RM–315
Databases menu, RM–98

Hydrogens, RM–84
Build menu, RM–79

Restraint Forces dialog box, RM–225
Add H & Model Build, changes to Model 

Build, RM–297
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adding atoms/bonds, RM–292
adding comments to Log file, RM–427
adding hydrogen atoms, RM–30, RM–296
adding new residues, RM–538 to RM–540
adding unusual residues, RM–312, RM–317
affinities, proton, CC–132
Alanine (Ala), amino acid residues, RM–100
alanine zwitterion

creating isolated structure, GS–140 to 
GS–149

minimized structure, GS–155
optimizing solvated structure, GS–154
solvating, GS–150

Algorithm, Compute menu, RM–242
Align Molecules

dialog box, RM–128 to RM–130
Edit menu, RM–114

Align Molecules on Edit menu, GS–172
Align Viewer, RM–19

dialog box, RM–127 to RM–128
Edit menu, RM–114

All Atom force fields, CC–28
All Atoms, RM–88

Build menu, RM–80
all atoms, CC–170, CC–189, CC–193
Allow Ions, RM–86

Build menu, RM–80
Element Table dialog box, RM–83

Allow ions option, GS–39
Alpha

polynucleotide torsion angle, RM–107
alpha electrons, CC–37
alpha helix

creating, GS–91
displaying, GS–110 to GS–111

Alpha helix, residues conformation, RM–101
alpha spins, CC–44
Alpha, Orbitals dialog box, RM–276
am*hbd parameter file, RM–471
AM1, CC–119, CC–128, CC–150, CC–239, 

CC–292 to CC–294
elements treated by, RM–195
parameter files, RM–498 to RM–501
Semi-empirical Method dialog 

box, RM–193
AMBER, CC–101, CC–106, CC–168, CC–188

file structure, RM–542

force field, GS–121, GS–122 to GS–123
Molecular Mechanics Force Field dialog 

box, RM–186
settings, RM–546 to RM–548

amber,amber2, file structure, RM–542, 
RM–546 to RM–548

amber,amber3, file structure, RM–546 to 
RM–548

amber,ambers, file structure, RM–546 to 
RM–548

Amino Acids
dialog box, RM–15

amino acids
building peptides from, GS–84
conformation changes, RM–312
mutation, RM–312
for polypeptide construction, RM–99 to 

RM–100
Amino Acids dialog box, GS–83, RM–98, 

RM–100 to RM–103, RM–320
residues, RM–99

Amino Acids, Databases menu, RM–98 to 
RM–99, RM–310

residues, RM–100 to RM–103, RM–534 to 
RM–536

amount of Z Translation, RM–44
analyzing HyperChem results, RM–428
Anderson, W.P., Edwards, W.D., Zerner, M.C.

and ZINDO/1, RM–488
angle bending, CC–174, CC–185, CC–189, 

CC–194, CC–211
angle bending, sextic, CC–185
angle, atomic coordinates for TPL file, RM–533 

to RM–534
Angle, Rotate dialog box, RM–122
anharmonicity, CC–144
Animations, See AVI
annealing time, molecular dynamics, CC–89
annealing, simulated, CC–79, CC–327
annealing, trajectory, CC–313
anti-parallel spins, CC–277
applications, RM–415 to RM–416

DDE, RM–415 to RM–416
applying restraints, RM–227
architecture, HyperChem, CC–155
Arginine (Arg), amino acid residues, RM–100
argument
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command line, RM–4
arguments, for variables and 

commands, RM–332 to RM–333
aromatic rings, torsion angles and 

multiple, RM–90
array, RM–395
Asparagine (Asn), amino acid residues, RM–100
Aspartic acid (Asp), amino acid 

residues, RM–101
Assistance, product, GS–13
asterisk in basis set name, CC–261
Atom number, Select menu, RM–135
atom types, CC–168, CC–169

displaying, GS–147
atom types, new or changed, CC–172
atom velocities, CC–73
atom, HIN file syntax, RM–520
Atom, Numbers, Select dialog box, RM–145
ATOM, record in PDB-type files, RM–321
atomic charges, CC–137, CC–184

assigning, GS–143 to GS–144
calculating, GS–194
displaying, GS–174

Atomic charges, MM+ Options dialog 
box, RM–187

atomic coordinates, RM–533 to RM–534
See also files, syntax for HIN; Molecular 

Coordinate System
atomic mass, CC–170
atomic movement, Monte Carlo, RM–248
atomic orbital electron populations

in log file, RM–442, RM–443
Atom-name# (TPL file)

atomic coordinate, RM–534
bonding information, RM–532

atoms, RM–30, RM–134 to RM–136
adding hydrogen, RM–296
boundary, GS–205
characteristics, GS–76 to GS–77
deleting/deselecting, GS–46
drawing, GS–38 to GS–39
editing, GS–74
group selection, GS–45 to GS–47
individuals edited, GS–56 to GS–57
labeling, GS–55 to GS–56

by number, GS–73
by symbol, GS–75

name, Select menu, RM–135
names for TPL file, RM–531
numbering, RM–147
pseudo-atoms, GS–205 to GS–206
selected by name, RM–146
selecting, GS–43 to GS–45
selecting by number, RM–147
selecting in 3D rectangle, GS–99
Selection level, RM–32
spherical selection, GS–100 to GS–102
tag numbers in TPL file, RM–531 to 

RM–532
types, RM–464
typing rules, RM–465

atoms, fixed, CC–83
Atoms, Labels dialog box, RM–177
Atoms, Select menu, RM–133
atoms, unknown type, CC–205
Atom-type

in TPL file, RM–533
Select menu, RM–136

Aufbau principle, CC–41, CC–49
Austin Model 1 See AM1
automatic operation with scripts, RM–325
Average/graph period, Molecular Dynamics 

Averages dialog box, RM–257
Averages

averages files. See also Molecular Dynamics
Molecular Dynamics Averages dialog 

box, RM–257
Molecular Dynamics Options dialog 

box, RM–246 to RM–251
averages, molecular dynamics results, CC–85
averaging, dynamics data, CC–319
averaging, dynamics, deviations, CC–321
Avg. & Graph, Molecular Dynamics Averages 

dialog box, RM–256
AVI Movie, RM–253
axial hydrogens, GS–133

measuring, GS–131

B

B form, polynucleotide strand 
conformation, RM–107

back end, CC–155
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backbone
coloring, GS–96
displaying, GS–96, GS–109
selecting, GS–94 to GS–95

backbone display, RM–162
background color, RM–65
Backward, polynucleotide strand 

formation, RM–109
Bacon, A.D. and Zerner, M.C.

and ZINDO/1, RM–488
Ball Radius, Balls Options dialog box, RM–164
Balls and Cylinders, Rendering dialog 

box, RM–160
Balls options, RM–163
Balls, Rendering dialog box, RM–160
barrier, rotational, CC–133
barriers, potential, CC–82
barriers, reaction, CC–32
base pairs, unusual, RM–316
basics, HyperChem, RM–17 to RM–25
Basis function, extra, RM–206
basis functions, extra, RM–217
basis functions, non-nuclear, CC–116
Basis set

Atoms, Labels dialog box, RM–178
basis set, CC–43
Basis set assignment, RM–206, RM–207
basis set superposition effects, CC–116
basis set superposition error (BSSE), CC–268
basis set, creating, RM–514
basis set, HIN file syntax, RM–522
basis set, minimal, CC–254
basis set, split-valence, table of KLM 

values, CC–258
basis sets

references, CC–110
selection, CC–109

basis sets, references, CC–216
basis sets, split-valence, CC–257
bath relaxation constant, CC–72
Bath relaxation, Molecular Dynamics Options 

dialog box, RM–249
Beta

polynucleotide torsion angle, RM–108
sheet, amino acid residue 

conformation, RM–102
beta electrons, CC–37

beta spins, CC–44
Beta, Orbitals dialog box, RM–276
bibliography, computational chemistry, CC–2
binding energy, CC–130

in log file, RM–443
BIO+, CC–101, CC–168, CC–193

force field, RM–186
Molecular Mechanics Force Field dialog 

box, RM–186
biphenyl, RM–90, RM–464
Bipyramidal, Constrain Geometry dialog 

box, RM–94
biradicals, CC–45
bitmap, RM–423

graphics, RM–441
use, RM–425

Bitmap file format, Setup Image, RM–70
bitmap preferences, RM–69
black box — not, CC–157
block diagonal method, CC–60
block diagonal Newton-Raphson 

optimization, CC–306
block diagonal Newton-Raphson optimization 

method, RM–243 to RM–244
BMP. See bitmap
boat cyclohexane

geometry optimization, GS–132
Boltzmann distribution, CC–19, 91, CC–310, 

RM–260
bond angle bending, CC–175
bond angles, CC–23

measuring, GS–78 to GS–79
bond angles and bending energy

in log file, RM–448
bond breaking, CC–46
bond breaking/formation, simulation, CC–90
Bond Color, RM–66
bond dipoles, CC–103, CC–184
Bond dipoles, MM+ Options dialog 

box, RM–187
bond dissociation, CC–37
bond distances

measuring, GS–77
bond formation and breaking, CC–22
bond length and stretching energy

in log file, RM–448
bond order
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changing, GS–52 to GS–54
bond rotation, RM–38, RM–39
bond stretch, CC–174
bond stretching, CC–175, CC–183, CC–189, 

CC–193, CC–209
bond torsions and torsional energy

in log file, RM–448
bond-centered basis functions, see ghost atoms
bond-centered orbitals, CC–267
bonded neighbors, CC–169
bonding information. See HyperChem Input 

files; template files
bonding interactions, CC–174
bonds, CC–23

angle in parameter file, RM–475 to 
RM–476

changing the order, RM–295 to RM–296
hydrogen, GS–81, GS–114 to GS–115
length in parameter file, RM–473 to 

RM–475
measuring distances, GS–77
See also Constrain entries
torsion constraint, rebuilding 

molecule, GS–134
bonds, automatic generation, RM–56
bond-type, bonding information for TPL 

file, RM–532
Boolean arguments, RM–333
Born-Oppenheimer approximation, CC–11, 

CC–32, CC–161
boundary atoms, GS–205
boundary conditions, periodic, theory, CC–201
bovine pancreatic trypsin inhibitor, GS–201 to 

GS–202
box, HIN file syntax, RM–519
box, removing periodic, RM–223
BPTI See bovine pancreatic trypsin inhibitor
breaking bonds, simulation, CC–90
Brillouin’s Theorem, CC–39, RM–202
Brookhaven PDB See Brookhaven Protein Data 

Bank
Brookhaven Protein Data Bank, GS–105, 

RM–54, RM–58, RM–319 to RM–323
format, GS–25
opening files from, GS–106 to GS–107
reading files from, GS–202 to GS–203
Save File dialog box, RM–57

BSSE, CC–116, CC–268
bug or error reporting, GS–13
Build menu, RM–79 to RM–81

Calculate Types, GS–144
Constrain Bond Torsion, GS–193
Constrain Geometry, GS–77
Default Element, RM–29
Explicit Hydrogens, RM–30
script messages, RM–345 to RM–348
Set Atom Type, GS–77
Set Charges, GS–77, GS–174

building
polypeptides, GS–84

building 3D structure, GS–75 to GS–76, 
GS–145 to GS–147

building chair cyclohexane, GS–124 to GS–125
building molecules

menu items, RM–79 to RM–111
from residues, RM–308 to RM–317

butadiene, RM–464
butadiene, modeling, CC–210
By name, Select dialog box, RM–145
By number, Select dialog box, RM–145

C

Calculate Types, RM–88
Build menu, RM–80

Calculate Types on Build menu, GS–144
calculation methods

molecular mechanics, RM–185
calculation types, CC–16
calculations

mixed, GS–203
calculations, ab initio, RM–208
calculations, HyperChem tutorial, GS–119 to 

GS–120
calculations, mixed mode, CC–246, RM–218
CambridgeSoft ChemDraw Files

open, RM–54
Cancel, RM–289

script messages, RM–386
canonical ensemble, CC–72
capping atoms, CC–246, CC–248 to CC–250
caps for residues, RM–105, RM–107
carboxyl group solvation, GS–195 to GS–196
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Cartesian Gaussians, CC–261
case

preferences, RM–16
sensitivity, RM–327, RM–466

center of mass
in log file, RM–448

centering molecules, GS–66
chair to boat cyclohexane 

transformation, GS–129 to GS–130
changing chirality, RM–303
changing molecular conformation, RM–299 to 

RM–304
changing/choosing drawing elements, RM–29
Charge

Atoms, Labels dialog box, RM–177
on status line, RM–136
in TPL file, RM–533

Charge density, RM–266
charge density, CC–134
charge, formal, CC–169
charge-charge interaction, CC–192
charges, atomic, CC–137, CC–184
charges, keep atom, RM–361
charges, point, CC–103
CHARMM, CC–101, CC–106, CC–193

file structure, RM–542
force field, RM–472
settings, RM–551 to RM–553

charmm, charmm85, file structure, RM–543
charmnpr parameter file, RM–470
check a box, using keyboard 

alternatives, RM–11
chem.exe, program file, RM–430
chem.ini/Registry, default settings in, RM–541 

to RM–579
chem.rul, CC–170
chem.rul, atom typing file, RM–463
chem.tpl, HyperChem TPL file, RM–527
chemct.tpl, HyperChem TPL file, RM–527
ChemDraw files

open, RM–54
ChemDraw files, reading, RM–55
chemical calculations, RM–183 to RM–289
chemical environment, CC–169
chemical equilibrium, CC–131
chemical reactions, CC–32, CC–327 to 

CC–330

chemical reactivity, CC–138
chemnt.tpl, HyperChem TPL file, RM–527
Chi, polynucleotide torsion angle, RM–108
chirality, RM–29, RM–119, RM–120, RM–300

changes, RM–303
evaluated with Model Builder, RM–304 to 

RM–305
chirality, changing, GS–227
Chirality, Labels dialog box, RM–178
choice, RM–30
choosing a dialog box option, using keyboard 

alternatives, RM–11
choosing a menu item, using keyboard 

alternatives, RM–10
choosing conformations, amino acid 

residues, RM–311
CI, CC–233, CC–235
CI energy

in log file, RM–443
CI Method, Configuration Interaction dialog 

box, RM–201
CI singles calculations, RM–193, RM–286, 

RM–288
Cis, Constrain Bond Torsion dialog box, RM–98
clamped-nuclei approximation, CC–161
classical mechanics, CC–165
classical perturbation, CC–267
classical trajectory analysis, CC–328
classical-quantum boundary, GS–205 to 

GS–206
Clear

removes atoms from workspace, RM–113, 
RM–115

Clear on Edit menu, GS–47
click definition, RM–31
clip increment, RM–67, RM–68
Clipboard, RM–71

See also Cut
choosing image destination, RM–423
destination, Setup Image, RM–71
graphics stored, RM–71, RM–115 to 

RM–117, RM–423 to RM–424
use, RM–423 to RM–424

clipboard
copying to, GS–48

clipping slab, RM–46
changing, GS–68 to GS–71
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default, GS–68
close a dialog box, using keyboard 

alternatives, RM–11
close a menu, using keyboard 

alternatives, RM–10
closed-shell singlet ground states, CC–38
CNDO, CC–119, CC–127, CC–149, CC–239, 

CC–242, CC–273 to CC–277
elements treated by, RM–194
parameter files, RM–487, RM–491 to 

RM–493
CNDO computation method, GS–174
CNDO mixed model, CC–276
coefficients, MO, initial guess, RM–214
Color

Display menu, RM–156
Selection Color dialog box, RM–178 to 

RM–179
color, bond, RM–66
color, selection, RM–66
color, window, RM–65
colors

default, RM–188
element assignments, RM–554
Element Color dialog box, RM–180 to 

RM–181
saving images, RM–424

colors, isosurface settings, RM–72
command line argument, RM–4
Commands

Help menu, RM–77
script message syntax, RM–332

comma-separated values file, CC–322
Comments

Log Comments dialog box, RM–62
Open File dialog box, RM–54
Run Script dialog box, RM–75
Save File dialog box, RM–57, RM–59

Compile Type Rules, RM–89
Build menu, RM–80

Complement Selection, RM–144
Select menu, RM–133
Selection tool, RM–34

Complement Selection on Select 
menu, GS–98, GS–107, GS–158

complementing a subset, GS–98

Complete Neglect of Differential Overlap 
(CNDO), CC–239

Complete Neglect of Differential Overlap. See 
CNDO

computational modules, CC–155
Compute menu, RM–235 to RM–289

Geometry Optimization, GS–127, 
GS–132, GS–135, GS–148, 
GS–166

Molecular Dynamics, GS–160
script messages, RM–370 to RM–381
Single Point, GS–126

Computed
Restraint Forces dialog box, RM–226

Computed values
Constrain Bond Angle dialog box, RM–96
Constrain Bond Length dialog box, RM–95
Constrain Bond Torsion dialog 

box, RM–97
Constrain Geometry dialog box, RM–93

CONECT
connectivity records, RM–59
Creating PDB-type files, RM–322

configuration interaction, RM–216
Configuration Interaction (CI), CC–37, 

CC–233, CC–235
configuration interaction (CI)

practical applications, RM–202 to RM–203
Configuration Interaction dialog box, RM–200 

to RM–202
Configuration interaction, Semi-empirical 

Options dialog box, RM–200
configurations

number of in log file, RM–443
conformation, Beta sheet, GS–84
conformational searching, CC–78, CC–87
conformations for residues, RM–311, RM–315
conjugate gradient, CC–59
conjugate gradient optimization, CC–122, 

CC–304
connected to expressions, type rules 

syntax, RM–467
Connectivity

CONECT records, RM–59
Creating PDB-type files, RM–322

conservation, energy, CC–71, CC–123
constant energy, CC–86
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constant temperature, CC–72, CC–87
Constant temperature, Molecular Dynamics 

Options dialog box, RM–249
constant temperature/energy, CC–77
Constrain Bond Angle, RM–96

Build menu, RM–80
dialog box, RM–96

Constrain Bond Length, RM–95
Build menu, RM–80
dialog box, RM–95

Constrain Bond Torsion, RM–97
Build menu, RM–81
dialog box, RM–97

Constrain Bond Torsion on Build 
menu, GS–193

Constrain Geometry, RM–92 to RM–95
Build menu, RM–80
dialog box, RM–93 to RM–95

Constrain Geometry on Build menu, GS–77
constraints

Model Builder, RM–299
constructing molecules, RM–291 to RM–317
Continue warning message, RM–237
Contour Grid, RM–269
Contour Grid property sheet, RM–269 to 

RM–270
Contour Level, isosurface, RM–271
Contour levels, RM–269
contour plots, CC–243
contours, 2D, RM–267
contracted Gaussian functions, CC–253, 

CC–254
Control menu button, GS–21
Control-menu box, HyperChem 

windows, RM–5
Converged, status line, geometry 

optimization, RM–241
convergence, CC–229
convergence acceleration, CC–48, CC–112
convergence criteria, CC–60
convergence limit, CC–112
Convergence limit, Semi-empirical Options 

dialog box, RM–199
convergence, SCF, CC–47
converting 2D structures to 3D, RM–304 to 

RM–305
Cool steps, Monte Carlo, RM–248

Cool time, Molecular Dynamics Options dialog 
box, RM–248

cooling time, molecular dynamics, CC–89
cooling, dynamics, CC–73
cooling, trajectory, CC–313
coordinate data, RM–433

HIN file, RM–520
SNP (snapshot) files, RM–437 to RM–439
TPL file, RM–533

coordinate systems, RM–18 to RM–19
coordinated ring, orientation 

restraint, RM–227
coordinates

in log file, RM–442, RM–443
Copy Image, RM–118, RM–424

for the Clipboard, RM–118
CPK (spheres) rendering settings in 

chem.ini/Registry, RM–575
Edit menu, RM–113
for a file, RM–118

Copy structures
onto Clipboard, RM–115, RM–298
Edit menu, RM–113
onto Clipboard in ISIS format, RM–116

core Hamiltonian matrix
in log file, RM–442

core Hamiltonian MO coefficients, CC–266
core orbitals, CC–43
core-core interaction

in log file, RM–443
correlation energy, CC–38
coulomb field, external, CC–246
covalent radii, CC–209
CPK spheres, RM–160
Crambin, sample PDB file, RM–323
creating

2D sketch, GS–73
a Visual Basic form, GS–262 to GS–264
alpha helix, GS–91
isolated alanine zwitterion, GS–140 to 

GS–150
polypeptides, GS–83 to GS–90
small molecules, 2D/3D, GS–49 to GS–59
water molecule, GS–171 to GS–172
zwitterion, GS–85 to GS–86

creating PDB-type files, RM–321 to RM–322
creating unusual base pairs, RM–316
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creating zwitterions, RM–311
cross-eyed stereo viewing, RM–169

setting in chem.ini/Registry, RM–576
cross-linking with Cyx, RM–311
cross-references to scripts messages, RM–397
CSV file, CC–322
cubic stretch, CC–168, CC–183
cubic stretch constant

in log file, RM–448
current-file, RM–335
Cursor, Setup Image, RM–72
cut

cutting and pasting atoms, RM–297
moves atoms from workspace to 

Clipboard, RM–115, RM–297 to 
RM–299

Cut, Edit menu, RM–113
cutoff, two-electron integral, CC–265
Cutoffs

Force Field Options dialog box, RM–190
MM+ Options dialog box, RM–187

cutoffs with periodic boundary 
conditions, RM–221

cutoffs, nonbonded, CC–64, CC–104, CC–181
cutoffs, nonbonded potential, CC–29
cutting and pasting atoms, RM–297 to 

RM–299
Cycles, geometry optimization

status line report, RM–241
Termination condition, RM–244

cycles, optimization, CC–60
Cycles, transition state search

Termination condition, RM–264
cyclohexane

building chair form, GS–124
building twist boat form, GS–133
chair to boat transformation, GS–129 to 

GS–130
geometry optimization, GS–121
structural properties of chair form, GS–125

Cylinders options, RM–162
Cylinders rendering, RM–163
Cysteine (Cys), amino acid residue, RM–101
Cystine (Cyx)

amino acid residue, RM–101
cross-linking, RM–311

Cytochrome C (3CYT), sample PDB 
files, RM–323

D

D EKIN, Selection, Molecular Dynamics 
Averages dialog box, RM–255

D EPOT, Selection, Molecular Dynamics 
Averages dialog box, RM–256

D ETOT, Selection, Molecular Dynamics 
Averages dialog box, RM–256

D Named selections, RMS deviation, Molecular 
Dynamics Averages dialog 
box, RM–256

d orbital sets, RM–215
d orbitals, ab initio, CC–115
d Orbitals, Hückel method, CC–118
d orbitals, Semi-empirical Options (Hückel) 

dialog box, RM–198
D TEMP, Selection, Molecular Dynamics 

Averages dialog box, RM–256
dA, nucleotide residue, RM–106
Data collection period, Molecular Dynamics 

Options dialog box, RM–250
data variable messages, RM–386 to RM–390
Databases menu, RM–98 to RM–99, RM–309 

to RM–312
Amino Acids, RM–309 to RM–312
Nucleic Acids, RM–313 to RM–315
script messages, RM–358 to RM–361

DBF files, parameters, CC–197
dbf force field parameter files, RM–463
dC, nucleotide residue, RM–106
DDE, RM–325 to RM–420
DDE. See also Dynamic Data Exchange
DDE_ADVISE, data update request, RM–416
DDE_EXECUTE, executes HyperChem, RM–415
DDE_INITIATE, starts HyperChem, RM–415
DDE_REQUEST, information from 

HyperChem, RM–416
DDE_TERMINATE, ends conversation with 

HyperChem, RM–416
DDE_UNADVISE, data value to 

HyperChem, RM–416
Deamino-oxytocin, sample PDB file, RM–323
Default
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colors, RM–188
Restraint Forces dialog box, RM–224 to 

RM–226
settings, in chem.ini/Registry, RM–541 to 

RM–579
Starting value, Grid Control dialog 

box, RM–269
Default (VDW), Balls Options dialog 

box, RM–164
Default Element, RM–82 to RM–84

on Build menu, RM–30, RM–79
changes, RM–294
dialog box, RM–15, RM–83

Allow ions, Build menu, RM–83
Element Table dialog box, GS–171, 

RM–30
Explicit Hydrogens, RM–30

Default force field, RM–90
default force field, CC–206
default MM+ force field, CC–204
default orbital exponents, table, CC–270
default scheme, CC–182
Degeneracy, Electronic Spectrum dialog 

box, RM–287
degenerate state, CC–39
deleting

atoms, GS–47
bonds, GS–47

Delta, polynucleotide torsion angle, RM–108
density matrices

in log file, RM–443, RM–444
density, charge, CC–134
density, electron, CC–52
density, spin, CC–52
deselect a group of atoms, Selection 

tool, RM–33
deselect backbone atoms, Selection 

tool, RM–33
deselecting

atoms, GS–46
Destination, Setup Image dialog box, RM–71
dG, nucleotide residue, RM–106
Dialog Box

Open Log, RM–60
dialog boxes

HyperChem, RM–14 to RM–15
persistent, RM–15

removal, RM–14
dielectric constant, CC–27, CC–84, CC–180

in log file, RM–448
dielectric constant, distance 

dependent, CC–180
dielectric functions, CC–103
dielectric options, GS–153 to GS–154
dielectric permittivity, CC–180
diff, status line, RM–241, RM–246
diffusion constant, solvent, 91
dihedral angle, CC–187, CC–189, CC–194
dihedral angle rotation, CC–174
dihedral angles, CC–175, CC–211
dihedral potential, CC–25
dihedrals, improper, CC–176
DIIS convergence accelerator, CC–112, 

CC–230
dipole interaction energy

in log file, RM–448
dipole moment, CC–52, CC–134, CC–240, 

CC–276
in log file, RM–448

dipole moment, displaying, RM–176
Dipole moment, importing, RM–62
Dipole moment, storing, RM–63
dipole, oscillating electric, CC–336
dipole, transition, CC–336
dipole-dipole interactions, CC–179
dipoles

in log file, RM–443
dipoles, bond, CC–103, CC–184
Direct Inversion in the Iterative Subspace 

(DIIS), CC–48, CC–230
direct SCF calculation, CC–115, CC–265
directories, changing, GS–27
Directory

Open File dialog box, RM–53 to RM–56
Save File dialog box, RM–57 to RM–59

Disks, RM–164
Disks, see Balls
dispersion forces, CC–174
Display menu, GS–29, RM–155 to RM–156

Overlay, GS–159
Recompute H Bonds, GS–198
Scale to Fit, GS–66
script messages, RM–352 to RM–357
Show All, GS–97
08 Master Index



Show Hydrogens, GS–58
Show Selection Only, GS–109

display settings
using, GS–29 to GS–35

displaying
alpha helix, GS–110 to GS–111
atom types, GS–147
atomic charges, GS–174
backbone, GS–96
disulfide bridges, GS–111 to GS–113
hydrogen bonds, GS–114 to GS–115
PDBs, GS–202 to GS–203
polypeptides, GS–84
primary structure, GS–108
ring structures, GS–113
side chains, GS–97, GS–109
solvated system, GS–152 to GS–154
subsets, GS–91 to GS–104

displays, setting conditions, RM–65 to RM–67, 
RM–421

dissociation, bond, CC–37, CC–46
Distance dependent dielectric, Force Field 

Options dialog box, RM–188
distance, atomic coordinate in TPL 

file, RM–534
distribution function, 96
disulfide bridges

displaying, GS–111 to GS–113
DNA B form, sample PDB file, RM–323
DNA backbone display, RM–162
DNA/RNA construction, RM–313 to RM–317
docking molecules, CC–83, RM–56
Done, Molecular Dynamics Results dialog 

box, RM–257 to RM–259
dongle, GS–9
Dots, Rendering dialog box, RM–160
double buffering, in 

chem.ini/Registry, RM–575
Double Strand, polynucleotide strand 

conformation, RM–109
double zeta, CC–260
double-click definition, RM–10
doublet, CC–111, CC–218, CC–232
doublet open-shell ground states, CC–38
doubly occupied orbitals

in log file, RM–442, RM–443
drag definition, RM–9

drawing
2D sketch, GS–50
atoms, GS–38 to GS–39
basic techniques, GS–37 to GS–48
bonds, GS–40 to GS–43

drawing method, RM–159
drawing mode, GS–39, GS–73
drawing molecules, RM–29, RM–291 to 

RM–299
Drawing tool, GS–50, RM–29 to RM–30, 

RM–291
changing, RM–293 to RM–295
icon, mouse clicks, RM–29
molecules creation, RM–18

Dreiding force field, CC–206
Drive names

Open File dialog box, RM–53 to RM–55
Run Script dialog box, RM–75 to RM–76
Save File dialog box, RM–57 to RM–60

driving HyperChem
from Excel, GS–245 to GS–259
from Visual Basic, GS–261 to GS–268

dT, nucleotide residue, RM–106
d-type functions, number, CC–261
dummy atoms, RM–227
Dynamic Data Exchange, RM–325 to RM–420

integrating HyperChem, RM–325
dynamics data, averages, CC–316
dynamics results file, CC–322
dynamics sampling interval, CC–80
dynamics, molecular, CC–69
dynamics, periods, CC–73
dynamics, quenched, CC–78

E

Edit menu, RM–113 to RM–132
Align molecules, GS–172
Clear, GS–47
Copy, GS–47
Reflect, GS–130
script messages, RM–342 to RM–344

editing
2D sketch, GS–74
alanine zwitterion structure, GS–141 to 

GS–142
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atoms, GS–56 to GS–57, GS–74
basic techniques, GS–37 to GS–48

editing text, RM–59, RM–61 to RM–62
EHT, CC–148, CC–268 to CC–273
eigenvalues

in log file, RM–442, RM–443, RM–444
eigenvector follow, GS–225
eigenvector following, CC–66, CC–122, 

CC–308
Eigenvector following, transition state 

search, RM–263
Eigenvector-Follow method, RM–243
eigenvectors (wavefunctions)

in log file, RM–442, RM–443
eigenvectors of CI secular equation

in log file, RM–444
EKIN, Selection, Molecular Dynamics Averages 

dialog box, RM–255
elastase-TFAP, sample PDB file, RM–323
electron density, CC–52, CC–241
electron lone pairs, CC–191
electron spin resonance (ESR), CC–243
electron-electron repulsion, CC–252
electronic density, CC–121
electronic energy

in log file, RM–443
electronic properties of proteins, GS–201 to 

GS–209
electronic spectra, CC–39
electronic spectroscopy, CC–235
Electronic Spectrum

Compute Menu, RM–284 to RM–289
Compute menu, RM–236

electronic spectrum, CC–125
Electronic Spectrum dialog box, RM–286 to 

RM–288
electronic states, CC–232
electrons

total number in log file, RM–442, RM–443
electrons, alpha and beta, CC–37
electrostatic interactions, CC–103, CC–174, 

CC–179, CC–190, CC–192, CC–196, 
CC–213

Electrostatic potential, RM–266
electrostatic potential, CC–27, CC–53, 

CC–121, CC–135, CC–244 to CC–245
electrostatic potential, plotting, GS–176

Electrostatic scale factor, Force Field Options 
dialog box, RM–189

Electrostatics, MM+ Options dialog 
box, RM–187

Element Color
dialog box, RM–180 to RM–181
Display menu, RM–156

Element name on status line, RM–135
Element Properties, RM–84, RM–295
Element Table dialog box, RM–30

changes, RM–294
Explicit Hydrogens, RM–296

E-mail support, GS–13
End time, Molecular Dynamics Playback dialog 

box, RM–253
END, record in PDB-type files, RM–322
endmol, HIN file syntax, RM–522
endres, HIN file syntax, RM–522
endselection, file syntax, RM–525
Energy

Geometry Optimization, RM–240
Single Point, RM–238

energy
CI, RM–443
excitation

in log file, RM–443
plotting vs. torsion angle, GS–255 to 

GS–259
energy barriers, CC–82
energy components

in log file, RM–448
energy conservation, CC–71, CC–123
Energy Criterion

Configuration Interaction dialog 
box, RM–202

practical application, RM–203
energy minimization, GS–121 to GS–137
energy, activation, CC–17, CC–133
energy, binding, CC–130
energy, constant, CC–77, CC–86
Energy, Orbitals dialog box, RM–277
ensemble averaging, 91
ensemble averaging, dynamics, CC–311
ensemble, isokinetic vs. isothermal, CC–72
ENT. See Brookhaven Protein Data Bank
enthalpies, CC–22
enthalpy of formation, CC–130
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enum, script argument, RM–333
environment, chemical, CC–169
EPOT, Selection, Molecular Dynamics Averages 

dialog box, RM–255
Epsilon

Dielectric, RM–189
Epsilon, polynucleotide torsion angle, RM–108
equilibration time, molecular dynamics, CC–88
equilibration, molecular dynamics, CC–74
equilibration, trajectory, CC–313
equilibrium bond length

in log file, RM–448
equilibrium properties, CC–19, RM–260
equilibrium, chemical, CC–131
Ergodic Hypothesis, CC–311
error and bug reporting, GS–13
ESR, CC–243
ETOT, Selection, Molecular Dynamics Averages 

dialog box, RM–255
Excel

Arrange All on Window menu, GS–250
creating a worksheet, GS–256
graphing HyperChem results, GS–251
manipulating molecules, GS–252 to 

GS–254
modifying a macro, GS–252 to GS–253, 

GS–255
running a macro, GS–250, GS–254, 

GS–258
running calculations with, GS–250
setting up a calculation for use 

with, GS–248
Excel. See Microsoft
exchange integrals, one-center, CC–278
exchange phenomena, CC–277
exchange repulsion, CC–37, CC–174
excitation energy

in log file, RM–443
excited singlet states, CC–38
excited state, CC–232
Exclusion Principle, Pauli, CC–34
executable file path, RM–72
EXECUTE, Excel message, RM–417
Exit, RM–74

on File menu, RM–52
exiting HyperChem, GS–35
Explicit Hydrogens, RM–30, RM–81 to RM–82

Build menu, RM–79
Element Table dialog box, RM–83

Explicit Hydrogens option, GS–39
exploring 3D structure, GS–145 to GS–147
exponents, entering, RM–16
Export orbital data, RM–52, RM–63
Extend Ring, RM–151

Select menu, RM–133
Extend Side Chain, RM–152

Select menu, RM–134
Extend to sp3, CC–246, RM–152 to RM–153

Select menu, RM–134
Extended Hückel, RM–192

elements treated by, RM–194
parameter file, RM–489

Extended Hückel calculations, log file 
information, RM–442

Extended Hückel method, CC–34, CC–125
Extended Hückel method, options, CC–117
Extended Hückel Theory (EHT), CC–148, 

CC–219, CC–268 to CC–273
extended hydrogen (EH), RM–87

in atom typing, RM–468
external coulomb field, CC–246
extra basis functions, RM–217

F

Fast translation, RM–68
fast translation, RM–42
Ferrodoxin, sample PDB file, RM–323
file

choosing image destination, RM–423 to 
RM–424

destination, Setup Image, RM–71
format

images, RM–423
Setup Image, RM–70, RM–71

File menu, GS–25, RM–51 to RM–74
New, GS–48, GS–118
Open, GS–247
Preferences, GS–44
Save, GS–51
saving, GS–50 to GS–52
script messages, RM–335 to RM–341
Start Log, GS–122
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Stop Log, GS–136
file paths, RM–72
file, CSV, CC–322
file, dynamics results, CC–322
filename, RM–53

arguments, RM–332
case preferences, RM–16
Open File dialog box, RM–53
Save File dialog box, RM–57, RM–57 to 

RM–60
files

AM1 parameter, RM–498 to RM–501
averages, RM–439
bond angle parameter, RM–475 to 

RM–476
bond length parameter, RM–473 to 

RM–475
Brookhaven PDB format, GS–105
chem.ini/Registry, RM–541 to RM–579
CNDO/INDO parameter, RM–491 to 

RM–493
Copy Image, RM–118
extended Hückel parameter, RM–489
force field parameters, RM–469 to 

RM–471
format, RM–423
graphics, RM–440
Help text, RM–433
HIN structure, RM–515
hydrogen bond parameter, RM–485
HyperChem Input, RM–19, RM–515 to 

RM–525
HyperChem program, RM–430
improper torsion parameter, RM–478 to 

RM–479
Log, GS–126, RM–426 to RM–427, 

RM–430
Log on File menu, GS–122
management, RM–51 to RM–77
MNDO parameter, RM–496 to RM–498
nonbonded parameter, RM–480 to 

RM–485
opening a HIN file, GS–25
out-of-plane bending parameter, RM–480
parameter file compile, RM–231
PDB, GS–106 to GS–107
plot, RM–439

program, RM–430 to RM–431
Protein Data Bank, RM–319 to RM–323
reading PDB, RM–320
residue template, RM–527 to RM–540
residues, RM–538
Save File dialog box, RM–57 to RM–60
saving in HIN format, GS–51 to GS–52
saving in Visual Basic, GS–267
script, RM–326, RM–433
selecting, GS–27 to GS–29
Semi-empirical parameters, RM–487 to 

RM–500
snapshot, RM–433 to RM–439
stopping Log File, GS–136
structure

chem.ini/Registry, RM–541 to 
RM–543

chem.tpl, RM–527 to RM–534
syntax for HIN, RM–516 to RM–525
template (TPL) structure, RM–527 to 

RM–540
torsion parameter, RM–476 to RM–478
type parameter, RM–473
typing rules, RM–465
water, RM–430

files, snapshot, CC–325 to CC–326
Final temperature, Molecular Dynamics Options 

dialog box, RM–249
fixed atoms, CC–83
Flat surface isosurface, RM–271
Fletcher-Reeves, CC–59
Fletcher-Reeves conjugate gradient 

method, RM–242
Fletcher-Reeves optimization, CC–305
float, script arguments, RM–333
Fock matrices

in log file, RM–444
force constant

in log file, RM–448
Force Constant, Restraint Forces dialog 

box, RM–226
force constants, units, CC–183
force field

AMBER, GS–121, GS–122
choosing, GS–122 to GS–123, GS–144 to 

GS–145
files, RM–463 to RM–485
12 Master Index



MM+, GS–122
MM2+, GS–258, GS–262
Parameters dialog box, RM–231, RM–469
status line report, RM–136

Force Field Options dialog box, RM–188 to 
RM–190

force field options, set up, CC–199
force field parameters, CC–168
force field selection, CC–101
force fields, CC–21
force fields, distinguishing features, CC–101
force fields, limitations, CC–167
forcefield coordinates

in log file, RM–448
formal charge, CC–169
formation, heat of, CC–130
forming bonds, simulation, CC–90
free radicals, CC–232
frequencies

in log file, RM–444
frequency, dynamics sampling, CC–80
Friction coefficient, Langevin 

dynamics, RM–250
friction coefficient, solvent, 91
front end, CC–155
Frontier molecular orbitals, CC–141
Frontier Orbital theory, CC–140
Frontier orbitals, CC–42
frozen atoms, CC–83
Full screen

setting, choosing extent of Copy 
Image, RM–422

Setup Image, RM–70

G

Gamma, polynucleotide torsion 
angle, RM–108

Gauche+, Constrain Bond Torsion dialog 
box, RM–98

Gauche-, Constrain Bond Torsion dialog 
box, RM–98

Gaussian basis set, CC–252
Gaussian functions, CC–252
Gaussian Type Orbitals (GTO), CC–43, CC–252
Gaussians, Cartesian, CC–261

Gaussians, Hermite, CC–261
geminal interactions, CC–174
geometric restraints, CC–81
geometry optimization, GS–121 to GS–137

alanine zwitterion, GS–148
analyzing results, GS–135
boat cyclohexane, GS–132
molecular mechanics, GS–122
of a subset, GS–197

Geometry Optimization on Compute 
menu, GS–127, GS–132, GS–135, 
GS–148, GS–166

Geometry Optimization, Compute 
Menu, RM–235, RM–239 to RM–244

geometry optimizations, CC–16, CC–57, 
CC–132

geometry, molecular, CC–41
Get HSV

statements, RM–327
types of input messages, RM–326
variables, messages syntax, RM–327

getting started, GS–19 to GS–36
ghost atoms, RM–215
ghost-atoms, CC–116, CC–267
global minima, CC–327
global minimum, CC–301

definition, GS–122
glossary, Help menu, RM–77
Glucagon, sample PDB files, RM–323
Glutamic acid (Glu), amino acid 

residue, RM–101
Glutamine (Gln), amino acid residue, RM–100
Glycine (Gly), amino acid residue, RM–100
Gouraud shaded surface, RM–271
Gradient

Single Point, RM–238
status line report, RM–239 to RM–241

gradient
definition, GS–121

gradient of reference conformation
in log file, RM–443

gradient, RMS, CC–60
graphical user interface, CC–155
graphics

bitmap, RM–69, RM–70, RM–441
files, RM–70, RM–440
metafile, RM–71, RM–440
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RGB bitmap, RM–70
stored on Windows Clipboard, RM–71, 

RM–118, RM–423 to RM–425
transfers, RM–422 to RM–425
using Windows Applications, RM–425

graphics settings, RM–69
gray menu items, RM–14
Grid Mesh Size, isosurface, RM–268
Grid, 2D contour, RM–269
grid, isosurface, RM–267
ground state, CC–232
group rotation, RM–38, RM–39
group selection defined, RM–139 to RM–140
GTO, CC–43, CC–252
GTO primitives, CC–253

H

Half-cystine (Cyx), amino acid residue, RM–101
half-electron excited singlet states, CC–38
half-electron method, CC–233
half-electron technique, CC–46
Hamiltonian, CC–162, CC–217

electronic, CC–163
exact, CC–162
nuclear, CC–163

Hamiltonian matrix elements, CC–270
hard nucleophiles and electrophiles, CC–140
hardware lock, GS–9
hardware requirements, GS–3
harmonic approximation, CC–144
harmonic frequencies, CC–124
harmonic oscillator, CC–22
harmonic potential, CC–24
Hartree-Fock, CC–37, CC–224
Hartree-Fock approximation, CC–126, CC–251
headers, Snapshot files, RM–433 to RM–437
heat of formation, CC–130

in log file, RM–443
Heat steps, Monte Carlo, RM–248
Heat time, RM–247
heating time, molecular dynamics, CC–88
heating, dynamics, CC–73
heating, trajectory, CC–313
Helix Form, polynucleotide strand 

conformation, RM–107

help
on-line, GS–16, GS–21

Help menu, GS–21, RM–77
script messages, RM–391

Help text, file, RM–431, RM–433
Help, product, GS–13
Hermite Gaussians, CC–261
Hessian, CC–65, CC–308
Hessian matrix, CC–124
HETATOM, creating PDB-type files, RM–322
Hide Selection, RM–159

Display menu, RM–155
highest occupied molecular orbital, GS–181
Highlight, Rendering dialog box, RM–164, 

RM–165
highlighting menus, RM–13
HIN See HyperChem input file
HIN See HyperChem input file
Histidine (Hid), amino acid residue, RM–101
Histidine (Hie), amino acid residue, RM–101
Histidine (Hip His), amino acid 

residue, RM–101
HOMO, CC–141, CC–221
HOMO See highest occupied molecular orbital
HOMO-, Orbitals dialog box, RM–277
Hooke’s law, CC–22
Horizontal grid points, RM–269
HSV. See HyperChem State Variables
Hückel constant, CC–117, CC–272
Hückel Constant, Semi-empirical Options dialog 

box, RM–197
hybridization, CC–169, CC–207
hydrogen

bond parameter file, RM–485
bonds, RM–172 to RM–173
Explicit Hydrogens, RM–30, RM–81 to 

RM–82
PDB file storage, RM–58 to RM–59

hydrogen bond potential, CC–26
hydrogen bonding, CC–174, CC–179, CC–191
hydrogen bonding term, CC–196
hydrogen bonds, GS–81

calculating, GS–114 to GS–115
displaying, GS–114 to GS–115, GS–198
recomputing, GS–198

hydrogen peroxide, GS–255
hydrogens
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Show, RM–170
hydrogens, axial, GS–133
Hydrogens, creating PDB-type files, RM–322
HyperChem

About dialog box, RM–77
files, RM–429 to RM–441
program files, RM–429, RM–430 to 

RM–431
settings, RM–544 to RM–560

HyperChem architecture, CC–155
HyperChem input file (HIN), GS–25 to GS–26
HyperChem Input files, RM–53, RM–429, 

RM–515 to RM–525
atoms, RM–520 to RM–521
bonding information, RM–532
force field information, RM–517
option, RM–58
residues, RM–519
save, RM–58
saving molecular system, RM–19
selections, RM–522 to RM–525
view, RM–518

HyperChem State Variables, RM–326, RM–334 
to RM–397

Get statements, RM–327, RM–333
Set statements, RM–327

HyperChem Tools, RM–27 to RM–50
moving atoms with mouse, RM–20, 

RM–27 to RM–50
HyperChem Windows

Control menu box, RM–5
Preferences dialog box, RM–65 to RM–74
Setup Image, RM–72

hyperconjugation, mixed mode 
calculations, CC–249

HyperMM+, HyperNewton, HyperEHT, 
HyperNDO, HyperGauss, CC–156

I

icons, RM–27
IGG, sample PDB file, RM–323
Ignore warning message, RM–237
image setup preferences, RM–69
images

choosing

destination, RM–423 to RM–424
extent, RM–422

color, RM–424
file formats, RM–423

imp parameter file, RM–470, RM–478 to 
RM–479

imp, force field information in TPL file, RM–533
Import orbital data, RM–52, RM–62
improper dihedrals, CC–176, CC–190, 

CC–194
improper torsion parameter file, RM–478 to 

RM–479
IMSGs. See input messages
In vacuo

geometry optimization, Compute 
menu, RM–244, RM–249

Increment for contour plot, Grid Control dialog 
box, RM–270

incremental model building, RM–305
increments, rotation and translation, RM–67, 

RM–68
independent-electron approximation, CC–219
independent-electron method, CC–268
Index, Help menu, RM–77
individual molecular orbitals, plotting, GS–181 

to GS–187
INDO, CC–119, CC–127, CC–149, CC–239, 

CC–242, CC–277 to CC–280
elements treated by, RM–194
parameter files, RM–491 to RM–493
Semi-empirical Method dialog 

box, RM–192
INDO mixed model, CC–276
inertia, moments, RM–355
inertial axes, RM–20 to RM–25
infrared absorption, CC–336
Infrared frequencies, characteristic, CC–144
infrared spectroscopy, CC–143
infrared spectrum, negative 

frequencies, CC–144
initial conditions, dynamics, CC–310
initial guess, MO coefficients, CC–115, 

CC–266
Initialization script, GS–12, RM–4
INITIATE, Excel message, RM–417
Inner radius, MM+ Options dialog 

box, RM–188
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inorganic structures, building, RM–305
input messages, RM–326 to RM–333

int (internal) atomic coordinates, TPL 
file, RM–533 to RM–534

using HyperChem messages, RM–326 to 
RM–333

integer, arguments, RM–333
integral cutoff, two-electron, CC–113, CC–265
integral format

Raffenetti, CC–264
regular, CC–263

integral format, Raffenetti, RM–212
integral storage path, RM–72
integrating HyperChem, Dynamic Data 

Exchange, RM–325
interactions, bonding, CC–174
interactions, electrostatic, CC–174
interactions, nonbonding, CC–174
Intermediate Neglect of Differential Overlap 

(INDO), CC–239
intermediates, CC–32
intermediates, potential, CC–131
intermediates, reactive, CC–307
interval, dynamics sampling, CC–80
Invert, RM–118 to RM–119

on Edit menu, RM–114, RM–303
ionic reactivity, CC–140
ionization energy, CC–134
ionization potential, CC–41
IR spectra

in log file, RM–443
IR spectrum, importing, RM–62
IR spectrum, storing, RM–63
IR Vectors, Rendering dialog box, RM–162
ISIS Sketch files

open, RM–54
save, RM–58

ISIS/Draw
clipboard format, RM–116

isokinetic energy ensemble, CC–72
isolated atomic energy

in log file, RM–443
Isoleucine (Ile), amino acid residue, RM–100
Isomer, residue conformation, RM–102
Isosurface, 590
Isosurface Colors, RM–72
Isosurface contour level, RM–271

Isosurface Grid, RM–267
isosurface grid, RM–268
Isosurface Rendering, RM–270
Isosurface rendering, RM–155, RM–170
isosurface transparency level, RM–272
Isosurface, 3D, RM–267
Isosurface, mapped 3D, RM–267
isosurface, show, RM–155, RM–169
isosurfaces, CC–243
isothermal ensemble, CC–72
iter, status line report, RM–241, RM–246
Iteration limit, GS–175
iteration limit, CC–112
Iteration limit, Semi-empirical Options dialog 

box, RM–199

J

Jorgensen-Salem isosurface, RM–271

K

keep-atom-charges, RM–361
keyboard

alternatives
HyperChem, RM–11 to RM–13
Windows, RM–10 to RM–11

alternatives to mouse, GS–23 to GS–24
equivalents for tools, RM–49 to RM–50
shortcuts, GS–24

Keyboard rotation and translation, RM–68
keys to operate HyperChem tools, RM–49 to 

RM–50
kinetic energy integrals, CC–252
KLM values, table, split-valence basis 

set, CC–258
Klopman-Salem equation, CC–139
Koopmans’ theorem, CC–134

L

labeling, GS–30 to GS–31
atoms, GS–55 to GS–56

by number, GS–73
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by symbol, GS–75
removing labels, GS–30
subsets, GS–92 to GS–94

Labels
dialog box, RM–177 to RM–178
Display menu, RM–156

Labels dialog box, GS–30, GS–202
lambda, CC–67
Lambda, reaction map coefficient, RM–232
Langevin Dynamics, RM–260

Compute menu, RM–235
Langevin dynamics, GS–166, CC–18, 91
Last Rendering, RM–155, RM–169
LCAO, CC–34, CC–222
LCAO-MO, CC–42
leap-frog algorithm, CC–70, CC–311
Lennard-Jones function, CC–26
Lennard-Jones potential, CC–176, CC–187
Leucine (Leu), amino acid residue, RM–100
levels of molecular organization, RM–17 to 

RM–18
License Timeout Interval, RM–74
license, network, RM–73
LINE

Align Molecules dialog box, RM–130
Align Viewer dialog box, RM–128
definition, RM–21
Name Selection dialog box, RM–148
rotate about, Rotate dialog box, RM–122

Linear
Constrain Bond Angle dialog box, RM–96
Constrain Geometry dialog box, RM–93

linear combination of atomic orbitals, CC–34
Linear Combination of Atomic Orbitals-

Molecular Orbital, CC–42
Lines, isosurface, RM–271
local minima, CC–301

definition, GS–122
lock, hardware, GS–9
Log Comments

on File menu, RM–52
log file

entering comments in, GS–126
keeping information in, GS–122
stopping, GS–136

log file information, RM–441 to RM–448

for UV visible spectra 
computation, RM–289

log file path, RM–72
Log files, RM–431

HyperChem files, RM–430
results stored, RM–426 to RM–427

Log on File menu, GS–122
log, open, RM–60
London dispersion forces, CC–39
Lone pair (LP)

default color, RM–180
in atom typing, RM–468

lone pairs, CC–191
lowest excited electronic state of 

ethylene, GS–233 to GS–241
lowest state, CC–232
Lowest state, Semi-empirical Options dialog 

box, RM–199
lowest unoccupied molecular orbital, GS–181
LUMO, CC–141, CC–221
LUMO See lowest unoccupied molecular orbital
LUMO+, Orbitals dialog box, RM–277
Lysine (Lys), amino acid residue, RM–101

M

macromolecules
working with, GS–105 to GS–118

mailing list, GS–13
Make Zwitterion, RM–103

Databases menu, RM–98
Map, reaction map list box, RM–233
Mapped Isosurface, RM–267
Mass

Atoms, Labels dialog box, RM–177
mass, atomic, CC–170
mass, HIN file syntax, RM–521
Max delta, Monte Carlo, RM–248
maximize button, GS–21
maximize button, HyperChem Windows, RM–5
Maximum Excitation, Configuration Interaction 

dialog box, RM–202
Maximum number of water molecules, Periodic 

Box Options dialog box, RM–222
MDL MOL files

open, RM–54
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save, RM–58
measurements

atom identification, with Selection 
tool, RM–35

bond angles, with Selection tool, RM–36
bond lengths, with Selection tool, RM–36
distances between atoms, with Selection 

tool, RM–36
improper angles, with Selection 

tool, RM–36
improper torsion angles, with Selection 

tool, RM–36
molecule identification, with Selection 

tool, RM–36
residue identification, with Selection 

tool, RM–35
with Selection tool, RM–36
torsion angles, with Selection tool, RM–36

measuring
axial hydrogens, GS–131
nonbonded distances, GS–80
properties of minimized system, GS–128 

to GS–129
structural properties, GS–73 to GS–82
torsion angles, GS–79 to GS–80

Mechanics Print Level, RM–60
MechanicsPrintLevel, in chem.ini, RM–441
mechanisms, reaction, CC–131
Menu Activator, RM–327

types of input messages, RM–327
menu bar, GS–21
menu bar, HyperChem Windows, RM–6
menu items

Semi-empirical, GS–198, GS–207
with ellipsis, GS–25 to GS–26

menu-help, RM–331
menus

Build, GS–77, GS–144, GS–174, GS–193, 
RM–79 to RM–98

close using keyboard alternatives, RM–10
Compute, GS–126, GS–127, GS–132, 

GS–135, GS–148, GS–160, 
GS–166, RM–235 to RM–289

Control, GS–21
Databases, RM–98 to RM–111, RM–309 to 

RM–316

Display, GS–29, GS–33, GS–34, GS–66, 
GS–97, GS–108, GS–159, RM–20, 
RM–128, RM–155 to RM–181

Edit, GS–130, GS–172, RM–113 to 
RM–132, RM–303

File, GS–25, GS–50 to GS–52, GS–118, 
GS–122, GS–247, RM–51 to 
RM–74, RM–426

gray items, RM–14
Help, GS–21, RM–77
HyperChem, RM–13 to RM–14
keyboard alternatives, GS–23 to GS–24
Script, RM–75 to RM–76
Select, GS–98, GS–109, GS–158, RM–34 

to RM–35, RM–132 to RM–154, 
RM–312

Setup, GS–174, GS–193, GS–197, 
GS–198, RM–183 to RM–234

Window (Excel), GS–250
Merge

adds molecules, RM–56
on File menu, RM–51

merging two structures, GS–195 to GS–196
mesh isosurface, RM–271
mesh, isosurface grid, RM–268
messages, RM–334 to RM–397

cross references of, RM–393
messages for scripts, RM–334

arguments, RM–332
commands, RM–332
cross-references, RM–397 to RM–413
input, RM–326 to RM–333
online Help, RM–77
script file, RM–325
syntax, RM–327 to RM–333
using with HyperChem, RM–326 to 

RM–333
variable, RM–327 to RM–332
warning, RM–237

Metafile, RM–69, RM–423, RM–425
graphics, RM–440
Setup Image dialog box, RM–71

metafile preferences, RM–69
Methionine (Met), amino acid 

residue, RM–101
method, rendering, RM–159
Metropolis method, 96
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microcanonical ensemble, CC–72
Microsoft Excel, RM–417 to RM–420
Microsoft Windows, RM–4 to RM–7

controls printer, RM–64
microstate CI, CC–39
Microstate CI Method, CC–39

Configuration Interaction dialog 
box, RM–202

practical application, RM–202
microstates, CC–234
MINDO/3, CC–119, CC–127, CC–149, 

CC–239, CC–242, CC–280 to CC–284
MINDO3

elements treated by, RM–195
extension of INDO, RM–192
parameter files, RM–487, RM–493 to 

RM–495
Semi-empirical Method dialog 

box, RM–192
minima, global, CC–327
minima, local, CC–301
minimal basis set, CC–254
minimizations, geometry, CC–57
Minimize button

HyperChem Windows, RM–5
Molecular Dynamics Results dialog 

box, RM–259
Minimum distance between solvent and solute 

atoms, Periodic Box Options dialog 
box, RM–222

minimum, global, CC–301
Minor, Align Molecules dialog box, RM–130
miscellaneous variable messages, RM–394 to 

RM–396
mixed calculations

choosing an area of interest, GS–203 to 
GS–204

Mixed mode calculations, RM–203, RM–218
mixed mode calculations, CC–246, CC–267
mixed model, CNDO and INDO, CC–276
mixed model, MINDO/3, CC–283
mixed model, MNDO, AM1, and 

PM3, CC–292
MM+, CC–101, CC–168, CC–182

file structure, RM–543
force field, GS–122 to GS–123

Molecular Mechanics Force Field dialog 
box, RM–185

parameters, RM–488
settings, RM–563 to RM–565

MM+ Options dialog box, RM–186 to RM–188
mm+,mm+ file structure, RM–543
MM2, CC–106, CC–182
MM2(1977), CC–102
MM2+, GS–258, GS–262
mmpben4 parameter file, RM–470
mmplus.exe program file, RM–431
mmpoop parameter file, RM–470
mmptor4 parameter file, RM–470
MNDO, CC–119, CC–128, CC–150, CC–239, 

CC–284 to CC–292
elements treated by, RM–195
parameter files, RM–496 to RM–498
Semi-empirical Method dialog 

box, RM–193
MO coefficients, initial guess, CC–115, 

CC–266, RM–214
mode

drawing, GS–39, GS–73
Model Build, changed from Add H & Model 

Build, RM–297
Model Build/Add H & Model Build, RM–85 to 

RM–86
Build menu, RM–79

Model Builder, RM–85 to RM–86
2D drawings conversions, RM–79
adds hydrogen atoms, RM–30
assigns atom types, RM–88
creating 3D structures, GS–75 to GS–77
evaluates chirality of atoms, RM–304 to 

RM–305
incremental model building, RM–305
invoking, GS–57 to GS–58

Modified Intermediate Neglect of Differential 
Overlap See MINDO/3

modifying parameters, CC–197
mol, HIN file syntax, RM–519
MO-LCAO approximation, CC–221
Molecular Coordinate System, RM–18 to 

RM–20
Molecular Dynamics, GS–139 to GS–162

Averages dialog box, RM–254 to RM–257
Named Selections use, RM–151
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averages files, RM–439
averaging, GS–163 to GS–165
calculations, RM–245 to RM–259
Compute Menu, RM–245 to RM–260
Compute menu, RM–235
in water, GS–139 to GS–169
on Compute menu, GS–160
Options dialog box, RM–246 to RM–251
Playback dialog box, RM–252 to RM–253
playback dynamics, GS–162
results, GS–165
Results dialog box, RM–257 to RM–259
simulated annealing, GS–160 to GS–162
Simulation

storing results, RM–427 to RM–428
time periods, RM–259 to RM–260

molecular dynamics, CC–18, CC–69, CC–123, 
CC–310 to CC–326

Molecular dynamics calculations, CC–85
molecular dynamics equilibration, CC–74
Molecular Dynamics Options dialog 

box, GS–160, GS–165
molecular geometry, CC–41
Molecular Mechanics

calculations, RM–185 to RM–190
Force Field dialog box, RM–185 to 

RM–186
method use, RM–238 to RM–239
on Setup menu, RM–183
Optimization dialog box, RM–241 to 

RM–244
molecular mechanics, CC–21, CC–167
molecular mechanics calculations

log file information, RM–448
Molecular Mechanics on Setup menu, GS–193, 

GS–197
Molecular Mechanics Optimization

dialog box, GS–148
molecular mechanics, type selection, CC–101
molecular orbital calculations, GS–171 to 

GS–188
molecular orbitals, CC–121, RM–278

practical guidelines, RM–279
total number saved in log file, RM–442

molecular organization, levels, RM–17 to 
RM–18

Molecular properties, plotting, RM–266

molecular renderings
changing, GS–31 to GS–35

molecular system, RM–18 to RM–20
printing, RM–64, RM–426

Molecule, Numbers, Select dialog 
box, RM–146

molecules, RM–138
built from residues, RM–308 to RM–316
changes after drawing, RM–294
creating, GS–49 to GS–59
drawing, RM–291 to RM–304
hydrogen peroxide, GS–255
manipulating with Excel, GS–252 to 

GS–254
in Microsoft Excel macro, RM–418, 

RM–420
NMA, GS–189 to GS–191
numbering, RM–147
propene

creating, GS–49 to GS–57
reflecting one end, GS–130
residues, RM–17
saving, GS–188
selected by name, RM–146
Selection level, RM–32
translating/rotating/scaling, GS–61 to 

GS–72
unlabelling, GS–84
water, GS–196

Molecules, Apply to, Rotate dialog 
box, RM–122

Molecules, Select menu, RM–133
Møller-Plesset perturbation, RM–210
Møller-Plesset second-order perturbation 

(MP2), CC–40, CC–113, CC–236 to 
CC–238, CC–251

moments-of-inertia, RM–355
Monte Carlo, GS–166, CC–19, 91, RM–260

Compute menu, RM–236
MOPAC Z-Matrix files

open, RM–54
save, RM–58

Morse function, CC–24
mouse

in changing clipping slab, GS–71
keyboard alternatives, GS–23 to GS–24
pointer, HyperChem Windows, RM–6
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right button functions, RM–20
use, RM–7 to RM–10
using, GS–22 to GS–23

movement, atomic, Monte Carlo, RM–248
Movie, AVI, RM–253
moving in a dialog box, using keyboard 

alternatives, RM–11
moving through a list, using keyboard 

alternatives, RM–11
MP2, CC–113, CC–251
MP2 calculations, RM–210
MP2 Correlation Energy, CC–236 to CC–238
Mulliken approximation, CC–271
Mulliken atomic charges, CC–137
Multiple Selections, RM–139

Select menu, RM–133
Multiple Selections on Select menu, GS–43, 

GS–46
multiple windows use, RM–7
multiplicity, CC–218, CC–232
multiplicity, spin, CC–44, CC–111
mutagenesis, site-specific, GS–86 to GS–89, 

GS–115
Mutate

Databases menu, RM–98
dialog box, RM–110 to RM–111

mutating
amino acid residues, RM–312
nucleic acid residues, RM–315 to RM–317

N

Name
Atoms, Labels dialog box, RM–177 to 

RM–178
Residues, Labels dialog box, RM–178

Name + Seq, Residues, Labels dialog 
box, RM–178

Name Selection
dialog box, RM–147 to RM–149
Molecular Dynamics use, RM–150
for Restraints, RM–150
Select menu, RM–133

named selection, removing, RM–146

Named selections, Molecular Dynamics 
Averages dialog box, RM–255 to 
RM–256

names, assignment for selections, RM–146
Names, Select dialog box, RM–145
naming selections, RM–149 to RM–150
NDDO, CC–128, CC–239
NDO, CC–34, CC–238 to CC–239
NDO calculations

log file information, RM–443
NDO methods, CC–126
NDO methods, options, CC–118
ndo.exe program file, RM–431
negative frequencies, CC–144
Neglect of Diatomic Differential Overlap 

(NDDO), CC–128, CC–239
Neglect of Differential Overlap (NDO), CC–34, 

CC–126, CC–238 to CC–239
neighbors

maximum handled by Model 
Builder, RM–305

neighbors, bonded, CC–169
net charges

in log file, RM–442
log file, RM–443

Network License, RM–73
network license timeout, RM–74
Network options, RM–229
New

on File menu, RM–51
prepares HyperChem for new 

molecules, RM–52
residues, RM–538 to RM–540

New on File menu, GS–48, GS–118
newton.exe program file, RM–431
Newton-Raphson, CC–60
Newton-Raphson optimization, CC–306
Newton-Raphson Optimization 

Method, RM–243 to RM–244
next lowest state, CC–232
Next lowest state, Semi-empirical Options 

dialog box, RM–199
NMA See N-methylacetamide
N-methyl amino (Nme), amino acid 

residue, RM–101
N-methylacetamide
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changing from cis- to trans- form, GS–191 
to GS–193

creating, GS–189 to GS–191
geometry optimization, GS–193

NOE data, CC–82
nonbonded cutoffs, CC–64, CC–104
nonbonded distances

measuring, GS–80
non-bonded interactions, CC–26
nonbonded interactions, CC–174
nonbonded parameter files, RM–480 to 

RM–485
nonbonded potential, CC–29
None

Atoms, Labels dialog box, RM–178
Residues, Labels dialog box, RM–178

non-nuclear basis functions, CC–267
normal coordinate analysis, CC–333
normal modes

in log file, RM–444
normal modes, vibration, CC–124
notation, basis sets, CC–261
Nuclear Overhauser Effect (NOE), CC–82
nuclear-electron attraction, CC–252
Nucleic Acids, RM–104 to RM–106, RM–313 to 

RM–316
on Databases menu, RM–98, RM–313
dialog box, RM–15, RM–106 to RM–109, 

RM–111, RM–313
mutating residues, RM–111, RM–315 to 

RM–317
residues, RM–536 to RM–540

Number
Atoms, Labels dialog box, RM–177

number of d orbitals, CC–115
Number of residues selected, Select 

menu, RM–138
Number, Orbitals dialog box, RM–277
numbering atoms, residue molecules, RM–147
Numbers, Select dialog box, RM–145

O

occupancies
in log file, RM–442, RM–443

occupancy, orbital, CC–41

occupied alpha orbitals
in log file, RM–443

occupied beta orbitals in UHF
in log file, RM–443

Occupied Orbital Criterion
Configuration Interaction dialog 

box, RM–202
Octahedral, Constrain Geometry dialog 

box, RM–94
Omega, amino acid residue torsion 

angle, RM–102
OMSG, using HyperChem messages, RM–326
one-center exchange integrals, CC–278
on-line help, GS–16
opaque isosurface, RM–271
Open

File dialog box, RM–52 to RM–56
on File menu, RM–51
menu, using keyboard alternatives, RM–10
Run Script dialog box, RM–75
Script, on Script Menu, RM–75
Start Log dialog box, RM–60

Open File dialog box, GS–26
Open on File menu, GS–247
OPLS, CC–101, CC–106, CC–168, CC–191

file structure, RM–543
Molecular Mechanics Force Field dialog 

box, RM–186
settings, RM–567 to RM–569

opls, opls, file structure, RM–543
optimization cycles, CC–60
optimization methods, CC–303 to CC–307
optimization termination, CC–61
optimization variables, GS–127
optimizations, structural, CC–57, CC–132
Options

Molecular Dynamics Options dialog 
box, RM–246 to RM–251

options, force field, set up, CC–199
Orbital

described, RM–278
Orbital Criterion, CC–39

Configuration Interaction dialog 
box, RM–202

practical application, RM–203
Orbital data, export, RM–63
orbital data, export, RM–52
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Orbital data, import, RM–52, RM–62
orbital eigenvalues (energies)

in log file, RM–442, RM–443
orbital energy diagrams, CC–220
orbital exponents, default, table, CC–270
orbital occupancy, CC–41
orbital plots, CC–243
Orbital squared

Orbitals dialog box, RM–278
Orbital, Orbitals dialog box, RM–276
Orbitals

Compute Menu, RM–274 to RM–279
Compute menu, RM–236

orbitals
total number in log file, RM–443

Orbitals dialog box, RM–275 to RM–278
Orbitals, importing, RM–62
Orbitals, storing, RM–63
orientation, structure, RM–56
orienting 3D structure, GS–145
Origin, translate to, Edit menu, RM–123
oscillating electric dipole, CC–336
Oscillator Strength

Electronic Spectrum dialog box, RM–287, 
RM–288

Other
Restraint Forces dialog box, RM–226

Outer radius, MM+ Options dialog 
box, RM–188

out-of-plane bending, CC–186
out-of-plane bending parameter file, RM–480
out-of-plane bends, CC–211
overlap integrals, CC–252
overlap matrix

in log file, RM–442, RM–444
overlap weighting factors, ZINDO, CC–295
Overlapping Spheres options, RM–164
Overlapping Spheres, Rendering dialog 

box, RM–160
Overlay on Display menu, GS–159
Overlay, Display menu, RM–155
oxytocin, sample PDB file, RM–323

P

Pan

Electronic Spectrum dialog box, RM–287
Orbitals dialog box, RM–276

Pancreatic trypsin inhibitor complex, sample 
PDB file, RM–323

par parameter files, RM–463, RM–471
parallel port lock, GS–9
parallel spins, CC–277
parameter file path, RM–72
parameter files, RM–470 to RM–471

compilation, RM–231
parameter sets, CC–196, RM–471 to RM–473
parameter sets, compiling, CC–199
parameter sets, new, CC–198
parameters, changed molecular 

mechanics, CC–173
parameters, default, CC–182
parameters, force field, CC–168
parameters, missing, CC–205
parameters, modifying, CC–197
parameters, wild-card approach, CC–205
Paste

copies from Clipboard to 
workspace, RM–116 to RM–117

cutting and pasting atoms, RM–297 to 
RM–299

Edit menu, RM–113
Paths, RM–72
Pauli Exclusion Principle, CC–34
PDB Files

reading non-standard, RM–55
PDB files, non-standard, RM–320
PDB See Brookhaven Protein Data Bank
peptide

exploring alpha-helical nature of, GS–94
period, dynamics averaging, CC–318
period, dynamics data collection, CC–318
period, dynamics sampling, CC–80
period, dynamics screen refresh, CC–319
period, dynamics snapshot, CC–318
Periodic boundary conditions, RM–221
periodic boundary conditions, GS–151 to 

GS–152, CC–62, CC–200
cutoffs/dielectric adjustments, GS–153 to 

GS–154
Periodic boundary conditions, 

dyanmics, RM–249
periodic boundary conditions, theory, CC–201
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Periodic Box, RM–219 to RM–223
options, dialog box, RM–221 to RM–222
size, Periodic Box Options dialog 

box, RM–222
Periodic Box Options dialog box, GS–150 to 

GS–152
periodic box, non-aqueous, RM–223
periodic box, removing, RM–223
periodic-box-size, RM–355
permittivity, dielectric, CC–180
Perspective View

for Z translation, RM–42
Perspective View on Display menu, GS–64
Perspective, Rendering dialog box, RM–161
perturbation, classical, CC–267
perturbation, Møller-Plesset, CC–40
perturbation, second-order, RM–210
phase space, 96
phases, trajectory, CC–313
Phenylalanine (Phe), amino acid 

residue, RM–101
Phi, amino acid residue torsion angle, RM–102
picture settings, RM–69
pictures

files, RM–70
planar molecules, CC–302
PLANE

definition, RM–21
Name Selection dialog box, RM–148
Reflect through, Edit menu, RM–120

Plane offset, 2D contour grid, RM–269
playback dynamics, GS–162
Playback, Options, Compute menu, RM–250 

to RM–251
Plot files, RM–439

HyperChem files, RM–430
Plot Molecular Properties, RM–266

Compute Menu, RM–265 to RM–273, 
RM–273 to RM–274

Compute menu, RM–236
Plotting results, RM–273 to RM–274
PM3, CC–119, CC–128, CC–150, CC–239, 

CC–292 to CC–294
background, RM–196
parameter files, RM–488
Semi-empirical Method dialog 

box, RM–193

POINT
definition, RM–21
Edit menu, RM–124
Invert through, Edit menu, RM–118 to 

RM–119
Name Selection dialog box, RM–148
Translate to, Edit menu, RM–122

Point
Restraint Forces dialog box, RM–226

point charges, CC–103, CC–246
points, grid, RM–267
points, status line report, geometry 

optimization, RM–241
Polak-Ribiere, CC–59
Polak-Ribiere conjugate gradient 

method, RM–243
Polak-Ribiere optimization, CC–306
polarizability, CC–179
polarization functions, CC–260
polarized basis sets, CC–260
polynucleotide construction, RM–313 to 

RM–314
polypeptide creation, GS–83 to GS–90
polypeptide/polynucleotide backbone

Selection tool, RM–154
Pople-Nesbet equations, CC–227
Pop-up help for tool icons, RM–27
port lock, parallel, GS–9
potential

angle, CC–23
electrostatic, CC–27, CC–53
harmonic, CC–24
Morse, CC–24
non-bonded, CC–26
nonbonded, CC–29
torsional, CC–25

potential energy surfaces, CC–11, CC–12, 
CC–158

potential intermediates, CC–131
potential switching function, CC–29
potential, electrostatic, CC–135
potential, shifting, CC–30
Preferences, RM–65 to RM–74

dialog box, RM–65 to RM–74
on File menu, RM–52
settings, using multiple windows, RM–7

Preferences dialog box, GS–44
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Preferences on File menu, GS–44
Primary axis, Align Molecules dialog 

box, RM–129
primary inertial axis, RM–20
primary structure

displaying, GS–108
primitives, GTO, CC–253
principal moments of inertia

in log file, RM–448
Print

on File menu, RM–52
print, RM–339
Print Levels, Mechanics and Quantum, RM–60
Printers icons and Control Panel, RM–64
printing

molecular system, RM–426
results, RM–240

problems, product support for, GS–13
PRODUCT

Name Selection dialog box, RM–148
Product, reaction map list box, RM–233
product, transition state search, RM–263
products, reaction, CC–139
program file path, RM–72
program files, RM–430 to RM–431
Projected CNDO/INDO MO 

coefficients, CC–266
Projected Hückel MO coefficients, CC–266
Proline (Pro), amino acid residue, RM–101
propene

creating, GS–49 to GS–57
Properties

Element Table dialog box, RM–83
properties, element, RM–84, RM–295
protein backbone display, RM–162
Protein Data Bank files, RM–18, RM–319 to 

RM–323
creation, RM–321 to RM–323
open, RM–54
options, RM–58
samples, RM–322 to RM–323
save, RM–58

proteins, construction, RM–309 to RM–310
proton affinities, CC–132
protonated nitrogens, GS–206
protonation of water, GS–213 to GS–218
pseudo-atoms, GS–205 to GS–206, RM–227

pseudo-halogens, CC–248 to CC–250
Psi, amino acid residue torsion angle, RM–102

Q

quadratic stretch, CC–168, CC–183
quadruple zeta, CC–260
quantum mechanics

ab initio, CC–31
semi-empirical, CC–31

Quantum Print Level, RM–60
QuantumPrintLevel, in chem.ini, RM–289, 

RM–441
quartet, CC–232
quasi-Newton, CC–309
quenched dynamics, CC–78

R

rA, nucleotide residue, RM–106
radicals, free, CC–232
Raffenetti integral format, CC–114, CC–264, 

RM–212
Random seed, Monte Carlo and 

Langevin, RM–250
random velocities, CC–312
Rayleigh-Schrödinger many-body perturbation 

(RSPT), CC–40, CC–236
rC, nucleotide residue, RM–106
REACTANT

Name Selection dialog box, RM–148
Reactant, reaction map list box, RM–233
reactant, transition state search, RM–263
reaction barriers, CC–32
reaction coordinate, CC–14, CC–32, CC–139
reaction coordinate parameter 

(lambda), CC–67
Reaction Map, CC–67, RM–231
reaction mechanisms, CC–131, CC–307
reaction products, CC–139
reactions, chemical, CC–327 to CC–330
reactivity, chemical, CC–138
reactivity, ionic, CC–140
reading PDB files, RM–320
readme file, GS–3
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real number, script arguments for 
scripts, RM–333

Recompute H Bonds, Display menu, GS–198
Recompute Hydrogen Bonds, RM–173 to 

RM–174
Display menu, RM–156

rectangular selection, GS–99
Reflect, RM–120

on Edit menu, RM–114, RM–304
Reflect on Edit menu, GS–130
reflection plane

defining, GS–129
Registry Settings, GS–8
relaxation constant, bath, CC–72
release notes, GS–3
REMARK, creating PDB-type files, RM–321
remeasuring axial hydrogens, GS–133
Remove Ionic Ends, RM–104

Databases menu, RM–98
Remove, Restraint Forces dialog box, RM–225
removing atoms, RM–293
removing named selection, RM–146
Rendering, RM–155

Cylinders color scheme, RM–163
dialog box, GS–31 to GS–35, RM–159 to 

RM–165
rendering method, RM–159
rendering options, isosurface, RM–270
rendering, 3D, RM–164, RM–165
rendering, isosurface, RM–155, RM–170
Reopen HyperChem, GS–49
reopening

HIN file, GS–61
repulsion, exchange, CC–174
REQUEST, Excel message, RM–417
requirements, system, GS–3
res, HIN file syntax, RM–519
Rescale, Molecular Dynamics Results dialog 

box, RM–259
Residue /Atom, Select dialog box, RM–146
Residue name and number, Select 

menu, RM–138
residue template files, RM–429, RM–527 to 

RM–540
Residue, Numbers, Select dialog box, RM–145
residues, RM–137 to RM–138

amino acids, RM–534 to RM–536

bonded atoms, RM–17
conformation, RM–102
files, RM–538
molecules built from, RM–308 to RM–317
mutating nucleic acids, RM–315 to 

RM–317
nucleic acids, RM–536 to RM–537
numbering, RM–147
replacing, GS–86 to GS–90
Selection level, RM–32
template files, RM–527 to RM–540
unusual, RM–312, RM–317

Residues, Labels dialog box, RM–178
Residues, on Select menu, RM–133, RM–312
resonance integrals, CC–295
restart velocities, CC–312
Restart, Molecular Dynamics Options dialog 

box, RM–251
restore button, HyperChem Windows, RM–6
Restrained Value

Restraint Forces dialog box, RM–226
Restraint Forces dialog box, RM–224 to 

RM–227
named selections, RM–150

restraint, orientation of coordinated 
system, RM–227

Restraints, RM–224 to RM–227
restraints

calculations, RM–225 to RM–227
definition, RM–224
Restraint Forces dialog box, RM–224

restraints, structural, CC–81
restraints, theory, CC–203
Restricted Hartree-Fock (RHF), CC–37, 

CC–112, CC–230 to CC–234
Restricted Hartree-Fock calculation, GS–175
Restricted Open-shell Hartree-Fock 

(ROHF), CC–112
Results

analyzing with Excel, GS–258
results

averages (CSV) file, RM–439
from HyperChem, RM–421 to RM–428
stored in Log file, RM–426 to RM–427

rG, nucleotide residue, RM–106
RGB Bitmap file format, Setup Image, RM–70
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RHF, CC–37, CC–44, CC–112, CC–227, 
CC–230 to CC–234

RHF half-electron technique, CC–46
RHF See Restricted Hartree-Fock
RHF, Spin pairing, Semi-empirical Options 

dialog box, RM–200
rhinovirus, sample PDB file, RM–323
Ribbons, Rendering dialog box, RM–162
Ridley, J.E. and Zerner, M.C.

and ZINDO/S, RM–488
ring structures

finding and selecting, GS–113
rings

making aromatic, GS–54, GS–74
selection, GS–103

rings, atom typing syntax, RM–469
rings, multiple aromatic, RM–90
RMS Gradient, CC–300
RMS gradient, CC–60
RMS gradient, Termination condition, geometry 

optimization, RM–244
RMS gradient, Termination condition, transition 

state search, RM–264
RNA/DNA construction, RM–313 to RM–314
ROHF, CC–112
Roothaan equations, CC–225, CC–251
root-mean-square gradient, CC–60
Rotate

dialog box, RM–121 to RM–122
Edit menu, RM–114

rotating a side chain, GS–116 to GS–118
rotating molecules, GS–61 to GS–72
rotation speed, RM–67, RM–68
rotation, group, RM–38, RM–39
rotation, side chain, RM–38, RM–39
rotational barriers, CC–133
RSPT, CC–40, CC–236
rU, nucleotide residue, RM–106
rules, atom typing, CC–170
Run Script dialog box, RM–75
Run steps, Monte Carlo, RM–248
Run time, Molecular Dynamics Options dialog 

box, RM–247
running the calculation, GS–128
running, trajectory, CC–313

S

saddle point, CC–65
definition, GS–121

saddle points, CC–17, CC–32
sample PDB files, RM–322
sampling interval, CC–80
save a structure, GS–89
Save As

on File menu, RM–51
fill PDB records, setting in 

chem.ini/Registry, RM–576
stores molecular system in file, RM–56

Save File dialog box, GS–51, RM–57 to RM–59
Save on File menu, GS–51
Save, File menu, GS–50 to GS–52
Save, on File menu, RM–51
saving

color images, RM–424
files in HIN format, GS–51 to GS–52
molecular system in HIN file, RM–19
recalling selections, Selection tool, RM–34
results, RM–240
structures, GS–59
Visual Basic files, GS–267

Scale factor, Force Field Options dialog 
box, RM–189

Scale to Fit, RM–157 to RM–158
Display menu, RM–155

Scale to Fit on Display menu, GS–66
scaling molecules, GS–61 to GS–72
SCF, CC–38, CC–224
SCF calculation, direct, CC–265
SCF convergence, CC–47
SCF Technique, CC–43
SCF. See Self-Consistent Field
Schrödinger equation, CC–11, CC–164, 

CC–217
Screen refresh period, Molecular Dynamics 

Options dialog box, RM–244, 
RM–250

script file path, RM–72
Script menu, enabling menu items, RM–76
Script One . . . Script Ten, RM–76

Script Menu, RM–75
Script, startup, GS–12, RM–4
Master Index 627



6

scripts, RM–325 to RM–397, RM–413 to 
RM–420

arguments, RM–332 to RM–333
commands, RM–332
cross reference of, RM–393
input messages, RM–326 to RM–327
menu, RM–75 to RM–76
menu activators, RM–333
online Help, RM–77
syntax, RM–327 to RM–333
variables, RM–326, RM–327 to RM–332

scrolling, list of files, GS–26
second order optimizer, CC–60
Secondary axis, RM–20

Align Molecules dialog box, RM–129
second-order perturbation, RM–210
seed, HIN file syntax, RM–518
Seed, random, Monte Carlo and 

Langevin, RM–250
select, RM–144 to RM–147

a group of atoms, Selection tool, RM–34
a polypeptide/polynucleotide backbone, 

Selection tool, RM–35
a rotatable side chain, Selection 

tool, RM–35
rings, Selection tool, RM–34
side chains, Selection tool, RM–34

Select All, RM–143
atoms to the sp3-sp3 bonds, Selection 

tool, RM–35
Select menu, RM–133
structures, Selection tool, RM–35

select atom
HIN file syntax, RM–524
molecules by name/number, Selection 

tool, RM–34
Select Backbone, RM–154

in any molecule, Selection tool, RM–33
in residue polymer, RM–35, RM–154
Select menu, RM–134

Select Backbone on Select menu, GS–109
Select dialog box, RM–145 to RM–147
Select menu, RM–132 to RM–154

Complement Selection, GS–98, GS–107, 
GS–158

Multiple Selections, GS–46
Select, GS–43

Select Backbone, GS–94, GS–109
use, RM–34 to RM–35

Select on Select menu, GS–43
Select Parameter Set, RM–230 to RM–231
Select Parameter Set on Setup menu, GS–194
Select Sphere, RM–139 to RM–142

Select menu, RM–133
selecting

a file, GS–27 to GS–29
atoms, GS–43 to GS–45
backbone, GS–94 to GS–95
groups of atoms, GS–45 to GS–47
ring, GS–103
ring structures, GS–113
side chains, GS–103 to GS–104
subsets, GS–91 to GS–104

selecting by name/number, atoms, RM–146 to 
RM–147

Selection
HIN file syntax, RM–522
icon, mouse clicks, RM–31
Molecular Dynamics Averages dialog 

box, RM–254 to RM–256
Restraint Forces dialog box, RM–225

Selection Color, RM–66
Selection Color, dialog box, RM–179
selection level

setting, GS–43
Selection tool, RM–30 to RM–31

measuring, RM–35 to RM–36
selection, removing named, RM–146
selectrestraint

HIN file syntax, RM–523 to RM–524
setting flag for, RM–523 to RM–524

Self-Consistent Field
on Setup menu, RM–192

Self-Consistent Field (SCF), CC–38, CC–224, 
CC–251

Semi-empirical
Options dialog box, RM–198 to RM–200

semi-empirical
for quantum mechanical 

calculations, RM–190 to RM–191
method, RM–239
mixed mode, RM–203
parameter files, RM–487 to RM–507
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Semi-empirical dialog box, RM–192 to 
RM–193

semi-empirical method, selection, CC–128, 
CC–148

Semi-empirical on Setup menu, GS–174, 
GS–198, GS–207

Semi-empirical Options (Hückel) dialog 
box, RM–197 to RM–198

semi-empirical quantum mechanics, CC–31
sensitivity, rotation and translation, RM–67, 

RM–68
Sequence, Residues, Labels dialog 

box, RM–178
Serine (Ser), amino acid residue, RM–100
Set Atom Type, RM–89 to RM–90

Build menu, RM–80
dialog box, RM–90

Set Atom Type on Build menu, GS–77
Set Bond

Angle dialog box, RM–131 to RM–132
Length dialog box, RM–130 to RM–131
Torsion dialog box, RM–132

Set Bond Angle, Edit menu, RM–114
Set Bond Length, Edit menu, RM–114
Set Bond Torsion, Edit menu, RM–114
Set Charge, RM–91 to RM–92

Build menu, RM–80
dialog box, RM–92

Set Charges on Build menu, GS–77, GS–174
Set HSV

types of input messages, RM–326
variables, script messages syntax, RM–327 

to RM–328
Set Mass, RM–91
Set Velocity dialog, RM–228
setting up graphics transfer, RM–422 to 

RM–424
setting up restraints, RM–227
settings

AMBER, RM–546 to RM–548
CHARMM, RM–551 to RM–553
display conditions, RM–421
MM+, RM–563 to RM–565
OPLS, RM–567 to RM–569
Registry or chem.ini default, RM–541 to 

RM–579
Setup Image preferences, RM–69

Ab initio
on Setup menu, RM–184

Compile Parameter File
on Setup menu, RM–184

Network
on Setup menu, RM–184

Periodic Box
on Setup menu, RM–184

Reaction Map
on Setup menu, RM–184

Restraints
on Setup menu, RM–184

Select Parameter Set
on Setup menu, RM–184

Semi-empirical
on Setup menu, RM–183

Set Velocity
on Setup menu, RM–184

Setup menu, RM–183 to RM–234
Molecular Mechanics, GS–193, GS–197
script messages, RM–361 to RM–369
Select Parameter Set, GS–194
Semi-empirical, GS–174, GS–198, GS–207

sextic angle bending, CC–185
Shaded isosurface, RM–271
Shaded rendering, RM–164, RM–165
Shifted cutoffs, MM+ Options dialog 

box, RM–188
shifted function, CC–104
shifting function, CC–181
shifting potential, CC–30
Show All, RM–159

Display menu, RM–155
Show All on Display menu, GS–97
Show Axes on Display menu, RM–20, RM–128
Show Dipole Moment, RM–176

Display menu, RM–156
Show Hydrogens, RM–170

Bonds, RM–172 to RM–173
Display menu, RM–156

Show Hydrogens on Display menu, GS–58
Show Inertial Axes, RM–174 to RM–175

Display menu, RM–156
Show Isosurface, RM–155, RM–169
Show Multiple Bonds, RM–171 to RM–172

Display menu, RM–156
Show Periodic Box, RM–171
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Display menu, RM–156
Show Perspective, RM–328
Show Selection Only, RM–159

Display menu, RM–155
Show Selection Only on Display menu, GS–109
Show Stereo

setting in chem.ini/Registry, RM–576
WallEyed Stereo, RM–576

side chain rotation, RM–38, RM–39
side chain selection, GS–204 to GS–205
side chains

displaying, GS–97, GS–109
rotating, GS–116 to GS–118
selecting, GS–103 to GS–104

side groups syntax, atom typing, RM–469
simulated annealing, GS–160 to GS–162, 

CC–79, CC–327
Simulation temperature, Molecular Dynamics 

Options dialog box, RM–249
Single Point

calculation, RM–239
calculations, GS–126, GS–147
Compute Menu, RM–237 to RM–239
Compute menu, RM–235
on Compute menu, GS–126

single point calculation, CC–16, CC–51, 
CC–299

single point calculations, CC–121
singlet, CC–111, CC–218, CC–232
singlet ground states, CC–38
singlet molecules, CC–37
singlet-triplet splittings, CC–39
singly excited CI, CC–39
Singly Excited CI Method

Configuration Interaction dialog 
box, RM–201

practical application, RM–202
singly occupied orbitals

in log file, RM–442, RM–443
site-specific mutagenesis, GS–86 to GS–90, 

GS–115
skills

creating a polypeptide, GS–83 to GS–90
creating small molecules, GS–49
drawing/editing techniques, GS–37
driving HyperChem from Excel, GS–245 to 

GS–259

driving HyperChem from Visual 
Basic, GS–261

electronic properties of proteins, GS–201 
to GS–209

geometry optimization, GS–121
getting started, GS–19
lowest excited electronic state of 

ethylene, GS–233 to GS–241
measuring structural properties, GS–73
molecular dynamics in water, GS–139
molecular orbital calculations, GS–171 to 

GS–188
protonation of water, GS–213 to GS–218
translating/rotating/scaling 

molecules, GS–61 to GS–72
vibrations and transition states of 

ammonia, GS–219 to GS–231
water–N-methylacetamide 

interaction, GS–189
working with macromolecules, GS–105
working with subsets, GS–91

Slab, Z Clip dialog box, RM–126
Slater determinants (microstates)

in log file, RM–444
Slater Type Orbitals (STO), CC–43, CC–252
Slater-Condon parameters, CC–278
slice of molecule See clipping slab
Smallest box enclosing solute, Periodic Box 

Options dialog box, RM–222
smooth shaded isosurface, RM–271
snapshot

files, RM–433
HyperChem files, RM–430
Molecular Dynamics Playback dialog 

box, RM–253
SNP files, RM–433 to RM–439

Snapshot dialog box, RM–252
snapshot files, CC–325 to CC–326
snapshot, dynamics period, CC–318
Sodium, counter ions, RM–315
soft electrophiles and nucleophiles, CC–141
software requirements, GS–3
solid color isosurface, RM–271
solute temperature, CC–75
solute-solute interactions, CC–62
solute–solute interactions, GS–151
solvating
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alanine zwitterion, GS–150
carboxyl group, GS–195 to GS–196
molecule optimization, GS–154 to 

GS–155
solvation, CC–62
solvent effects, CC–62, CC–200
solvent friction and diffusion, 91
solvent temperature, CC–75
solvents, non-aqueous, RM–223
spacebar

for Rescale, Molecular Dynamics Results 
dialog box, RM–259

for Scale to Fit, RM–157
spectra, UV-visible, saving, RM–286
spectra, vibrational, saving, RM–262, RM–281
speed, translation and rotation, RM–67, 

RM–68
Spheres options, RM–164
Spheres rendering, GS–32 to GS–33
Spheres, Rendering dialog box

settings (CPK) in 
chem.ini/Registry, RM–575

Spheres, space-filling, RM–160
spherical selection, GS–100 to GS–102
spin couplings, CC–39
Spin density, RM–266
spin density, CC–52, CC–121, CC–243
spin density, plotting, GS–181
spin interactions, CC–279
spin multiplicities

in log file, RM–443
Spin multiplicity

Semi-empirical Options (Hückel) dialog 
box, RM–197

Semi-empirical Options dialog 
box, RM–198

spin multiplicity, CC–44, CC–111
Spin multiplicity, Electronic Spectrum dialog 

box, RM–287
spin pairing, CC–226
Spin pairing, Semi-empirical Options dialog 

box, RM–199
spin state, CC–218, CC–232
spins, parallel or anti-parallel, CC–277
spins, unpaired, CC–37
splittings, singlet-triplet, CC–39

split-valence basis set, table of KLM 
values, CC–258

split-valence basis sets, CC–257
spreadsheet program, Microsoft 

Excel, RM–417
Square Planar

Constrain Geometry dialog box, RM–94
star in basis set name, CC–261
Start Log

on File menu, RM–51
stores chemical calculations, RM–60

Start time, Molecular Dynamics Playback dialog 
box, RM–253

starting HyperChem, GS–19 to GS–20, RM–3 
to RM–4

Starting temperature, Temperature, Compute 
menu, RM–248

Starting value, 2D contour grid, RM–270
Startup script, GS–12, RM–4
state energies

in log file, RM–443
state, excited, CC–232
state, lowest, CC–232
State, Semi-empirical Options dialog 

box, RM–199
static field, classical, CC–246, CC–267
stationary point

definition, GS–121
stationary points, CC–17
statistical mechanical averages, 

dynamics, CC–312
status line, GS–21
status line report, RM–240
status line, HyperChem Windows, RM–6

atom report, RM–136
molecule report, RM–138
residue report, RM–138

steepest descent, CC–58
steepest descent on potential energy 

surface, RM–242
steepest descent optimization, CC–122, 

CC–303
Step count, Molecular Dynamics Playback 

dialog box, RM–253
Step size

Molecular Dynamics Options dialog 
box, RM–248
Master Index 631



6

Molecular Dynamics Playback dialog 
box, RM–253

step size, molecular dynamics, CC–89
Stereo, Rendering dialog box, RM–161
stereochemistry, RM–300

displaying stereobonds with 
wedges, RM–300 to RM–302

See also chirality
stereochemistry, changing, GS–227
Stewart, J.J.P.

and PM3, RM–488
Stick Width, Rendering Options dialog 

box, RM–162
Sticks & Dots, Rendering dialog box, RM–160
Sticks options, RM–161
Sticks, Rendering dialog box, RM–160
STO, CC–43, CC–252
STO-3G exponents, table, CC–256
STO-NG method, CC–255
Stop Log, RM–61, RM–426

on File menu, RM–52
storing results

in Log file, RM–426 to RM–427
Molecular Dynamics Simulation, RM–427 

to RM–428
str parameter files, RM–470
stretch-bend cross term, CC–102
stretch-bend interactions, CC–186, CC–211
stretching parameters

in log file, RM–448
string arguments, script messages, RM–333
structural optimizations, CC–132
structural properties

comparing, GS–128 to GS–129
measuring, GS–125, GS–146

structural restraints, CC–81
structure

chem.tpl, RM–527 to RM–540
HIN file, RM–515
TPL file, RM–527 to RM–534

structure alignment, GS–172 to GS–173
structures, saving, GS–59
subsets, complementing, GS–98
Sugar Form, polynucleotide strand 

conformation, RM–108
superposing

molecules, GS–155 to GS–160

Support, GS–13
Switched cutoffs, MM+ Options dialog 

box, RM–188
switching function, CC–104, CC–181
switching function, potential, CC–29
Symbol, Atoms, Labels dialog box, RM–177
symmetrical systems, CC–39
Symmetry, Orbitals dialog box, RM–277
synchronous transit, GS–226, CC–67, CC–122, 

CC–309
Synchronous transit, transition state 

search, RM–263
syntax

atom typing, RM–466 to RM–469
HIN files, RM–516 to RM–525
script messages, RM–327
TPL files, RM–529 to RM–534

sys, HIN file syntax, RM–518
system requirements, GS–3
System, Z Clip dialog box, RM–126

T

tags in TPL files, RM–531 to RM–532
tags, atomic coordinate, RM–533
TEMP, Selection, Molecular Dynamics Averages 

dialog box, RM–255
temperature regulation, CC–71
Temperature step, Molecular Dynamics Options 

dialog box, RM–249
temperature, constant, CC–72, CC–77, CC–87
temperature, constant dynamics, CC–314, 

CC–317
temperature, dynamics, CC–310
Temperature, Molecular Dynamics Options 

dialog box, RM–248
temperature, reaction simulation, CC–330
temperature, solvent, CC–75
template files, RM–527 to RM–540

bonding information, RM–532
syntax, RM–529 to RM–534

TERMINATE, Excel message, RM–417
Termination condition, geometry 

optimization, RM–244
termination condition, optimization, CC–61
tertiary axis, RM–20
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Align Molecules dialog box, RM–129
Tether to

Restraint Forces dialog box, RM–226
Tetrahedral

Constrain Bond Angle dialog box, RM–96
Constrain Geometry dialog box, RM–93 to 

RM–94
three-dimensional group selection, RM–142
three-dimensional rendering, RM–164, 

RM–165
Threonine (Thr), amino acid residue, RM–100
Time

Compute menu, RM–247
on status line, RM–250

time periods, Molecular Dynamics 
simulation, RM–259 to RM–289

time step, trajectory, CC–314
TIP3P water model, CC–62
TIP3P water molecules, RM–220
title bar, GS–20
title bar, HyperChem Windows, RM–5
tool bar, GS–21
Tool preferences, RM–67
tools, RM–27 to RM–50

Help menu, RM–77
icons

HyperChem Windows, RM–6
mouse clicks, RM–27

popup help, RM–27
XY rotation, GS–67
XY translation, GS–62 to GS–63
Z translation, GS–64
Zoom, GS–65

Top level setting, choosing extent of Copy 
Image, RM–422

Top level window, Setup Image, RM–70
torsion

bond constraint, GS–133
torsion angles

measuring, GS–79 to GS–80
plotting energy vs. angle, GS–255 to 

GS–259
torsion angles and multiple aromatic 

rings, RM–90
torsion parameter file, RM–476 to RM–478
torsional angle rotation, CC–174
torsional angles, CC–175

torsional energy, CC–187, CC–189, CC–194, 
CC–211

torsional potential, CC–25
torsion-angle, atomic coordinate in TPL 

file, RM–534
torsions, improper, CC–176
Total charge

density, RM–266
Semi-empirical Options (Hückel) dialog 

box, RM–197 to RM–198
Semi-empirical Options dialog 

box, RM–198
total charge density, plotting, GS–180
total density matrix

in log file, RM–442
total electron density, CC–52
total energy

in log file, RM–442, RM–443
Total Energy, on status line, RM–250
Total spin density, RM–266
total spin density, CC–52
total spin density, plotting, GS–181
TPL. See template files
trajectory phases, CC–313
trajectory, classical, CC–328
Trans, Constrain Bond Torsion dialog 

box, RM–98
transfer RNA, sample PDB file, RM–323
transferring graphics, RM–422 to RM–425
transforming from chair to boat 

cyclohexane, GS–129 to GS–130
transit, synchronous, transition state 

search, RM–263
transition dipole, CC–336
Transition State, RM–263

Compute menu, RM–236
transition state search, CC–17, CC–65, 

CC–122, CC–308
transition state searching, GS–225, GS–226
transition state setup, RM–231
transition states, CC–32, CC–133
Transition Structures, CC–307
Transition, Electronic Spectrum dialog 

box, RM–287
transitions, selecting in Electronic Spectrum 

dialog box, RM–288
Translate
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dialog box, RM–122 to RM–124
Edit menu, RM–114

Translate dialog box, GS–63 to GS–64
Translate Selection, Translate dialog 

box, RM–123
Translate Viewer, Translate dialog 

box, RM–123
translating molecules, GS–61 to GS–72
translation speed, RM–67, RM–68
translation, fast, RM–68
Translucent surface, RM–272
Transparency Level, isosurface, RM–272
Transparent isosurface, RM–272
Trigonal

Constrain Bond Angle dialog box, RM–96
Constrain Geometry dialog box, RM–93

triple zeta, CC–260
triplet, CC–112, CC–218, CC–232
triplet ground states, CC–45
triplet open-shell ground states, CC–38
Tripos MOL2 FIles

save, RM–58
Tripos MOL2 Files

open, RM–54
trypsin inhibitor complex, sample PDB 

file, RM–323
Trypsin, sample PDB file, RM–323
Tryptophan (Trp), amino acid residue, RM–101
tutorial

Ab Initio calculations, GS–211
HyperChem calculations, GS–119 to 

GS–120
twist boat cyclohexane, GS–133

optimization, GS–135
twist boat structure minimization, GS–135
two-dimension selection, RM–139 to RM–140
two-electron integral cutoff, CC–113
two-electron integrals, CC–262

format, CC–114
Raffenetti format, CC–114

txt files, parameters, CC–197
txt force field parameter files, RM–463
Type

Atoms, Labels dialog box, RM–177
Parameter file, RM–473

typerule.bin force field file, RM–463
types, atom, CC–168, CC–169

typing rules for atoms, RM–465
typing rules, atom, CC–170
Tyrosine (Tyr), amino acid residue, RM–101

U

UHF, CC–37, CC–44, CC–112, CC–227, 
CC–230 to CC–234

UHF, Spin pairing, Semi-empirical Options 
dialog box, RM–199

United Atom force fields, CC–28
United Atoms, RM–87 to RM–88

Build menu, RM–80
united atoms, CC–170, CC–189, CC–192, 

CC–193
units, force constants, CC–183
Unoccupied Orbital Criterion

Configuration Interaction dialog 
box, RM–202

unpaired spins, CC–37
Unrestricted Hartree-Fock (UHF), CC–37, 

CC–112, CC–230 to CC–234
Unweighted constant, Semi-empirical Options 

(Hückel) dialog box, RM–197
Urey-Bradley term, CC–102
user interface, CC–155
user interface, HyperChem, GS–17, GS–20 to 

GS–27
users list, GS–13
Using Help, Help menu, RM–77
using HyperChem script messages, RM–326 to 

RM–333
Using Stereo, RM–168 to RM–169
utilities, RM–51 to RM–52
UV spectrum, importing, RM–62
UV spectrum, storing, RM–63
UV visible spectra

and ZINDO/S, RM–193
computing

practical applications, RM–288 to 
RM–289

saving information in log file, RM–289
in log file, RM–443

UV-visible spectra, CC–39, CC–125
computing, CC–331
theory, CC–331
34 Master Index



UV-visible spectra, characteristic, CC–147
UV-visible spectra, saving, RM–286

V

valence atomic orbitals, CC–269
Valence state ionization energy (VSIE), CC–270
Valine (Val), amino acid residue, RM–100
van der Waals, CC–174, CC–176, CC–187, 

CC–190, CC–192, CC–195, CC–213
van der Waals energy

in log file, RM–448
van der Waals interactions, CC–26
van der Waals scale factor, Force Field Options 

dialog box, RM–190
variables, script messages, RM–326 to RM–327
vel, HIN file syntax, RM–521
Velocities

Molecular Dynamics Snapshots dialog 
box, RM–252

storage, RM–58
velocities, distribution of atom, CC–73
velocities, random distribution, CC–312
velocities, rescaling, CC–314
velocities, restart, CC–312
velocity, set atom, RM–228
Verlet algorithm, 93
Vertical grid points, RM–269
vibration, transition state search, RM–263
vibrational analysis, CC–124, CC–143

and IR spectroscopy, CC–332 to CC–338
vibrational spectra, saving, RM–262, RM–281
Vibrational Spectrum

Compute Menu, RM–279 to RM–284
Compute menu, RM–236

vibrational spectrum, importing, RM–62
vibrational spectrum, storing, RM–63
Vibrations

Compute Menu, RM–261 to RM–262
Compute menu, RM–236

vibrations and transition states of 
ammonia, GS–219 to GS–231

vicinal interactions, CC–174, CC–182
view, HIN file syntax, RM–518
Viewer's Coordinate System, RM–19
Viewer, Apply to, Rotate dialog box, RM–123

virtual orbitals, CC–41, CC–44
visible atoms, RM–134
Visual Basic

adding .exe file to program 
group, GS–267 to GS–268

controls as graphical objects, GS–262
creating a form, GS–262 to GS–264
creating an executable file, GS–267
customizing an interface, GS–264
driving HyperChem, GS–261 to GS–268
entering code, GS–265 to GS–267
saving files, GS–267

VSIE, CC–270
VSIE values, table, CC–271

W

walleyed stereo, RM–168 to RM–169
setting in chem.ini/Registry, RM–576

Walsh’s rules, CC–41
warning messages, RM–237

destination, in chem.ini/Registry, RM–560
water

molecular dynamics, GS–139 to GS–169
molecules

creating, GS–171 to GS–172
water box, CC–202
water model, TIP3P, CC–62
water molecules, RM–317
water template files, RM–429 to RM–430
water–N-methylacetamide 

interaction, GS–189 to GS–199
wave function, CC–36
wave function calculation, GS–174 to GS–175, 

GS–198, GS–206 to GS–208
Wavelength, Electronic Spectrum dialog 

box, RM–287, RM–288
wedges

displaying stereobonds with, RM–300
explained, RM–301
types of, RM–300

Wedges, Rendering dialog box, RM–162
Weighted diffuseness, Semi-empirical Options 

(Hückel) dialog box, RM–197
width, rendered sticks, RM–162
wild-card approach, parameters, CC–205
Master Index 635
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window
border, HyperChem Windows, RM–6
changing size of, GS–22
parts of HyperChem window, GS–20 to 

GS–22
Setup Image, RM–70

Window applications, GS–243
Window Color, RM–65
window, expanding to full screen, GS–37
Windows

HyperChem, RM–4 to RM–6
keyboard alternatives, RM–10 to RM–13

Windows Applications
graphics from WMF, RM–425
using DDE, RM–415 to RM–416

Windows Clipboard, graphics stored, RM–423 
to RM–424

Windows Program Manager, Main 
icon, RM–64

windows, keyboard alternatives, GS–23
Wire mesh isosurface, RM–271
WMF. See metafiles
Woodward-Hoffmann rules, CC–41
work, saving, GS–50 to GS–52
working in dialog boxes, RM–15
worksheet (Excel), GS–256
Workspace

HyperChem Windows, RM–6
setting, choosing extent of Copy 

Image, RM–422
window, Setup Image, RM–70

workspace, GS–21
clearing, GS–48

X

X Axis
Align Molecules dialog box, RM–129
Align Viewer dialog box, RM–127
Rotate About, Rotate dialog box, RM–122

XY rotation
right button functions, RM–20
tool, RM–36 to RM–38

XY rotation tool, GS–67
XY translation

right button functions, RM–20

step size setting, RM–42
tool, RM–40 to RM–41

XY translation tool, GS–62 to GS–64

Y

Y Axis
Align Molecules dialog box, RM–129
Align Viewer dialog box, RM–127
Rotate About, Rotate dialog box, RM–122

Z

Z Axis
Align Molecules dialog box, RM–129
Align Viewer dialog box, RM–128
Rotate About, Rotate dialog box, RM–122

Z Clip
dialog box, RM–125 to RM–127
Edit menu, RM–114

Z Clip dialog box, GS–68, GS–69
Z clipping tool, GS–68 to GS–71, RM–47 to 

RM–48
Z form, polynucleotide strand 

conformation, RM–107
Z rotation

right button functions, RM–20
setting amount, RM–40
tool, RM–39 to RM–40

Z rotation tool, GS–68
Z translation, RM–42 to RM–44

right button functions, RM–20
tool, RM–42 to RM–44

Z Translation tool, GS–64
ZDO, CC–273
Zerner, Michael

and ZINDO/1, RM–488
zero differential overlap (ZDO), CC–273
zeta, double, CC–260
Zeta, polynucleotide torsion angle, RM–108
zeta, triple and quadruple, CC–260
ZINDO/1, CC–119, CC–127, CC–151, 

CC–239, CC–242, CC–294 to CC–296
background, RM–196
parameter files, RM–488
36



Semi-empirical Method dialog 
box, RM–193

ZINDO/S, CC–119, CC–127, CC–151, 
CC–239, CC–242, CC–295 to CC–297

and UV visible spectra, RM–193
background, RM–196
parameter files, RM–488, RM–504
Semi-empirical Method dialog 

box, RM–193
Z-Matrix files

input filter, RM–55
open, RM–54
save, RM–58

Zoom
dialog box, RM–124
Edit menu, RM–114
sensitivity setting, RM–46
tool, RM–44 to RM–46

Zoom Factor, Zoom dialog box, RM–124
zoom speed, RM–67, RM–68
Zoom tool, GS–65 to GS–66
Zoom, Electronic Spectrum dialog 

box, RM–287
zwitterion

creating, GS–85 to GS–86
zwitterions creation, RM–311
Master Index 637
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